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The Release Notes contain information about Release 5.0.13 of the Lotus Notes® and Lotus DominoTM software 
products. Release Notes documentation contains the following chapters:
 
What's new? introduces you to Notes, Domino Designer, and Domino Server, tells you about the new features and 
enhancements in this release, and points you to further information.

Things you need to know describes supported platforms and environments and other information that you need to 
know before installing this release.

Troubleshooting describes limitations and issues associated with this release of Notes and Domino.

Documentation updates describes last-minute information and corrections that are not included in the Notes, Domino 
Designer, and Domino server Help databases and printed documentation.

Interoperability describes known restrictions or potential incompatibilities between different versions of Notes and 
Domino.

History of changes contains information about enhancements and new features introduced in the software in previous 
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You can edit the documents in the online version of the Release Notes database to suit the particular needs of your 
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Chapter 1 - What's new?

Welcome

Administrator Client, Client, Designer, Server

Welcome to IBM Lotus Notes, Domino, & Domino Designer R5.0.13
Welcome to Release 5.0.13 (R5.0.13) of IBM Lotus Notes, Lotus Domino Designer, and the Lotus Domino Server 
family of products. R5.0.13 is the latest release of the world's leading products for information management, 
messaging, collaboration and Web application development. The R5 product line, conceived with the qualities and 
capabilities of the Internet, delivers on the promise of enabling users to find, act upon and share information, further 
improving communication among groups, organizations and people everywhere.

These Release Notes contain information on the many new features and enhancements included in all R5 products.  
Before installing R5.0.13, please review the "Things You Need To Know" and "Troubleshooting" chapters of these 
Release Notes. 

For an overview of the features in this release, see the "What's New?" chapter.

For exhaustive online searches of the README.NSF Release Notes database, without using a full-text index, use the 
Search view.

If you want detailed information about preparing for a larger deployment of R5, browse or download the book "Moving 
to Notes and Domino Release 5" from the Lotus Developer Domain at http://www.lotus.com/ldd/doc. This book is 
available as part of the Lotus Domino Administration help.

Administrator Client, Client, Designer, Server

Domino server is numbered 5.0.13a
For this release of Notes and Domino, the Notes Client, Domino Designer Client, and the Domino Administrator Client 
are numbered 5.0.13.  The Domino server only is numbered 5.0.13a.

Administrator Client, Client, Designer, Server

License disclaimer
Any information or reference related to license terms in this document is provided to you for your information. 
However, your use of Notes and Domino, and any other IBM program referenced in this document, is solely subject to 
the terms and conditions of the IBM International Program License Agreement (IPLA) and related License Information 
(LI) document accompanying each such program.  You may not rely on this document should there be any questions 
concerning your right to use Notes and Domino. Please refer to the IPLA and (LI) for Notes and Domino that is located 
in the license.txt file.

Administrator Client, Client, Designer, Server

Notes/Domino 5.0.13 release information available on-line
Detailed information about each release of Notes and Domino 5 may be found on the "Notes/Domino MR/MU Status" 
page, on the Lotus Developer Domain website.  This page outlines the schedule, features, and fixes for both 
Maintenance Releases (MR), and Maintenance Updates (MU).

Maintenance Releases are regularly scheduled releases that contain software bug fixes and introduce some new 
features; Maintenance Updates are posted as needed, and contain critical bug fixes.  Information about the current 
R5.0.13 Maintenance Release may be found on the Lotus Developer Domain website at:

http://www-10.lotus.com/ldd/r5fixlist.nsf/.

The following information is available on the "Notes/Domino MR/MU Status" page.

Status
The release number, estimated release date, and description of the release are listed, along with a numbered status 
bar showing the current stage in the development cycle of each release.

1
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Latest Fixes
The most recent software bug fixes submitted are shown, with a link to a complete fix list for the current release.  
Fixes can be sorted by SPR (Software Problem Report) number, technical area (Calendar, Mail, Replication), or date 
modified.

Features
If applicable, a list of new features proposed for the current release is provided.  Please note that any new features 
listed are provisional, and may be removed prior to the targeted release if they do not pass quality assurance tests.

Administrator Client, Client, Designer, Server

Release Notes - usage and availability
These Release Notes are available in a variety of formats and locations.

Online Release Notes:
In 'Web-browsable' and 'Notes/Domino Database' formats

(Browsable over the Internet): View the release notes online using live web browsing (using any web browser) at l
the Domino and Notes User Assistance Web site. This is always the most up-to-date version of the Release Notes.

http://www.lotus.com/ldd/doc

(Notes Database format): You can connect to www.lotus.com/ldd/doc to download the latest version in Notes l
Database format (readme.nsf), for later viewing in a Notes client. This is the same information that appears in the 
Release Notes that are web-browsable directly from the Domino and Notes User Assistance Web site.

(Notes Database format): After client or server installation, find the Release Notes in the HELP subdirectory of l
your Notes or Domino data directory.

(Notes Database format): You will find the Release Notes on the root directory of your Notes/Domino CD-ROM.l

Portable Document Format (README.PDF)

You can read PDF files using Adobe Acrobat Reader software. Some free Acrobat Reader software is available on the 
R5 CD-ROM. See the START.TXT file on the CD-ROM for details. You can download additional readers from Adobe 
Systems Incorporated  (http://www.adobe.com).

README.PDF is available:

On the root of your Notes/Domino CD-ROMl

For download at the Domino and Notes User Assistance Web site (http://www.lotus.com/ldd/doc)l

Differences between various Release Notes published media

The NSF-online Release Notes are more up-to-date than the PDF-online Release Notes. This is primarily due to 
production schedules.  Also, after the product ships, updates are sometimes made to the Release Notes and posted 
on the Lotus Developer Domain.  You can visit the Domino and Notes User Assistance Documentation site for the very 
latest versions of the Domino and Notes Release Notes:  http://www.lotus.com/ldd/doc

Administrator Client, Client, Designer, Server

Help databases - usage and availability
R5 includes Help databases for Lotus Notes, Lotus Domino, Lotus Domino Designer, and Lotus Domino Administrator. 
If you install any of these products with the installation CD-ROM, the Help databases are installed by default in the 
HELP directory of your Notes or Domino data directory. 

Title Database file name Description

Lotus Notes 5 Help HELP5_CLIENT.NSF Lotus Notes client Help

Lotus Domino 5 
Designer Help

HELP5_DESIGNER.NSF Lotus Domino Designer and programming language 
Help

Lotus Domino 5 
Administration Help

HELP5_ADMIN.NSF Lotus Domino server and Lotjus Domino 
Administrator Help

2
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You can access Help in the following ways:

Click the link to Help on the Notes, Domino Designer, or Domino Administrator Welcome pagesl

Choose Help --> Help topicsl

Press F1l

Click the ? in the top right corner of most dialog boxesl

Choose File --> Database --> Open and browse your local directory or a Domino serverl

Visit the Domino and Notes User Assistance Web site at http://www.lotus.com/ldd/docl

PLEASE NOTE: The last update to the on-line Help files references version 5.0.3 on the Welcome Page; subsequent 
updates to the on-line Help documentation appear in these release notes in Chapter 4 - Documentation Updates.

Administrator Client, Client, Designer, Server

SPR (Software Problem Report) fix list availability
Please refer to one of the following sources for a list of SPR initiated enhancements in the Lotus Notes and Lotus 
Domino products.

Notes/Domino Fix Lists

In September 2000, we introduced the new R5 Web Fix List Application, which allows you to access all of the fix list 
entries for the 5.0.x codestream on the Lotus Developer Domain via this new delivery mechanism.  The Release 5.0.5 
fix list is contained on this new site, along with previous R5.0x fix lists.  You can access the R5 Web Fix List 
application on the Lotus Developer Domain at http://www.lotus.com/ldd/r5fixlist.nsf.  For more detailed information 
regarding the R5 Web Fix List application, refer to the Release Note entitled "R5 Web Fix Lists on Lotus Developer 
Domain". (NOTE: Fix Lists after R5.0.3 are not posted in the Release Notes, as they are also available in the new R5 
Web Fix List Application.)

Official Fix Lists of Software Problem Report (SPR) fixes and enhancements for releases previous to R5 are also 
available at the Lotus Developer Domain web site. The 4.x Fix Lists are available on the relevant Incremental Installer 
pages of the Lotus Developer Domain web site "Download" area.  View the Fix Lists online at:

http://www.lotus.com/ldd

Administrator Client, Client, Designer, Server

IBM/Lotus Support Services website
Lotus Support Services (http://www-3.ibm.com/software/lotus/support/) is the IBM Lotus customer support website 
for all Lotus products, including common questions and solutions, user discussions, downloadable files, and Lotus 
support phone numbers. You can also use this site to search the Knowledge Base for technical information on Lotus 
products. 

NOTE: This replaces the old Lotus Support site, http://www.support.lotus.com, as of January 2002. That site will now 
direct you to the new IBM Lotus site.

Administrator Client, Client, Designer, Server

IBM/Lotus websites
The following IBM/Lotus Web sites are designed to help you locate the latest information on Lotus Domino, Lotus 
Notes and other Lotus products. 

NOTE: Many of the sites' URLs have changed recently, so please check these URLs, and update your bookmarks if 
necessary.

IBM/Lotus Software (http://www.lotus.com) is the main Web site for IBM/Lotus software, and contains general 
information on all Lotus products and services, including press releases, downloadable software, support, and 
purchasing information.

Lotus Developer Domain (http://www.lotus.com/ldd) is the site brought to you by the development group for Notes 
and Domino. This site contains various Notes-related software downloads (including trial versions of Notes/Domino), a 
technical Webzine with articles for end-users, application developers and systems administrators; and an active 
discussion cafe with several discussion forums for exchanging ideas about Notes/Domino and sharing your thoughts 
with the developers.
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R5 Web Fix Lists (http://www.lotus.com/ldd/r5fixlist.nsf) is a section on the Lotus Developer Domain which will allow 
you to access all of the fix list entries for the 5.0.x codestream.

Business Partners (http://www.lotus.com/home.nsf/welcome/partners) is the central site for Lotus Business 
Partners, including development tips and techniques, innovative applications, developer discussions, and updates on 
the latest product releases. You can also use this Web site to find out information and request an application for the 
Lotus Business Partner program.

The Documentation Library -- Domino & Notes User Assistance (http://www.lotus.com/ldd/doc) provides Domino 
and Notes documentation databases and Adobe Acrobat PDF files that you can download, information on ordering 
additional documentation, product tips, and documentation feedback forms.

Lotus Education (http://www.lotus.com/services/education.nsf/wDocs/edhomepage) provides education and training 
information on all Lotus products, including course descriptions, schedules, Lotus Authorized Education Center 
locations, and Lotus certification information. You can also purchase CBTs and documentation from The Education 
Store.

Lotus Internationalization and Multilingual Technologies (http://www.lotus.com/products/dmlt.nsf) is the site for 
information on Domino Global Workbench, a comprehensive set of advanced tools and software services to easily and 
interactively create, update, synchronize and manage Domino-based multilingual Web sites.

Lotus Support Services (http://www-3.ibm.com/software/lotus/support/) is the new IBM Lotus customer support site 
for all Lotus products, including common questions and solutions, user discussions, downloadable files, and Lotus 
support phone numbers. You can also use this Web site to search the Knowledge Base for technical information on 
Lotus products.

Notes MTA (http://www.lotus.com/home.nsf/welcome/notesmta) provides information on Lotus Notes Messaging 
Services, which lets Notes administrators set up mail routing from different mail systems. These Messaging Services 
include message transfer agents (MTAs), such as the SMTP/MIME, cc:Mail, and X.400 MTAs.
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Chapter 2 - Things you need to know

Directory install and CD-ROM structure

Administrator Client, Client, Designer, Server

Incremental Installer availability
As new Incremental Installers are released, the four most recent Incremental Installers for each MR platform and 
codestream will be available from the download site. This means that when a new Incremental Installer is released, the 
oldest Incremental Installer for that platform and codestream will be removed from the list and will no longer be 
available from the download site.

You can access the Incremental Installers from the Lotus Developer Domain at http://www-10.lotus.com/ldd/down.nsf 
In addition, CD installation is also available.

Administrator Client, Client, Designer, Server

CD-ROM directory structures

Notes/Domino Designer CD-ROM directory structure

AUTORUN.INF
README.NSF
README.PDF
SETUP.BAT
START.TXT
APPS

ADOBE
WIN32

DGW
SYNCINST

DICTIONARIES
DNFS
ESB

W32INTEL
FONTS
LTC

WIN32
MENTORR5

ACROBAT
ADMIN
DOCUMENTS

QUICKCARDS
JRE
LA
LAP

WISDOM
CLIENTS

W32INTEL
TOURS
AUTORUN

CD-ROM directory structure for Notes/Domino Designer Macintosh partition  CD-ROM:

README.NSF
README.PDF
START.TXT
APPS

ADOBE
DICTIONARIES

NOTES INSTALL DISK
TOURS
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Domino Win32 Server CD-ROM directory structure

AUTORUN.INF
README.NSF
README.PDF
SETUP.BAT
START.TXT

APPS
ADOBE

WIN32
DGW

SYNCINST
DIAGS

W32
DNFS
LTC

WIN32
SYSMGMT

AGENTS
W32INTEL

SERVERS
WIN32INTEL

AUTORUN

Domino AIX/HP/Sparc Server CD-ROM directory structure

README.NSF
README.PDF
START.TXT

APPS
ADOBE

HPPA
IBMPOW
OS2
SUNSPA

DIAGS
SYSMGMT

AGENTS
AIX
HPUX
OS2
SOLARIS

LTC
IBMPOW
SUNSPA

HPPA
INSTALL
LICENSE.TXT
SCRIPT.DAT
SETS

DATA
FGINV

FGROUPS
TOOLS

BIN
HPUX

LIB
PERL5

NLS
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IBMPOW 
INSTALL
LICENSE.TXT
SCRIPT.DAT
SETS

DATA
FGINV

FGROUPS
TOOLS

BIN
AIX

LIB
PERL5

NLS
SUNSPA

INSTALL
LICENSE.TXT
SCRIPT.DAT
SETS

DATA
FGINV

FGROUPS
TOOLS

BIN
SOL

LIB
PERL5

NLS

Domino Linux/OS2 Server CD-ROM directory structure

README.NSF
README.PDF
START.TXT

APPS
ADOBE

HPPA
IBMPOW
OS2
SUNSPA

DIAGS
SYSMGMT

AGENTS
AIX
OS2
SOLARIS
HPUX

LINUX
INSTALL
LICENSE.TXT
SCRIPT.DAT
SETS

DATA
FGINV

FGROUP
TOOLS

LIB
PERL5

NLS
OS2

SERVER
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Administrator Client, Client, Designer, Server

Additional items on Notes Client and Domino Designer CD-ROMs
In addition to the Notes installation files, there are the following items on the Notes and Domino Designer CDs.  
Please note that Lotus provides support only for Lotus software in the  \APPS directory, and we support it on a 
best-effort basis.  For other, non-Lotus software applications included in the \APPS directory, please refer to the 
appropriate third-party vendor for support.

Adobe Acrobat Readers
On the root directory of the Notes, Domino Designer and Domino Server CDs,  the release notes are available in 
Adobe's Portable Document Format (PDF). To view PDF documents such as README.PDF, you can use the Adobe 
Acrobat Readers contained in the \APPS\ADOBE directory.  For platform specific instructions, refer to the START.TXT 
text file found on the root directory.  Additional information about Acrobat Reader can be found on the Adobe Web site 
at http://www.adobe.com.

Domino Global Workbench R5 [Domino Server CD only]
Domino Global WorkBench Release 5.0.7a is a point release that increases the robustness of Domino Global 
Workbench and increases your productivity while creating global eBusiness Applications.  Domino Global WorkBench 
5.0.7a is fully integrated with the Domino server and the Domino Designer development environment. Like all other 
components of the Domino IDE, it is standards-based and compatible with popular Web development tools. It helps 
application developers localize the architecture of multilingual Domino based applications, Application and Web site 
administrators manage the deployment and synchronization of Domino multilingual applications and Web sites and 
Content Managers provide, track and update the content across languages efficiently.  The application can be found 
on the Domino Designer and Domino Server (W32 only) CDs in the \APPS\DGW directory. 

Update for 5.0.7a:

Error: Unilingual databases sometimes made into multilingual databases:  In some situations, when updating 
unilingual databases in which content documents had been created, Domino Global WorkBench would mistakenly 
add extra languages, making the language database a multilingual database.  This has been corrected in Domino 
Global WorkBench 5.0.7a.

Key updates in 5.0.7 (included in 5.0.7a) are:

Error: Database already contains a document with this ID (UNID) - you may see this error in the following 1.
circumstances:

If your source database contains a design element that has only reader access and you are updating a 1.
language database on a server. The WorkBench does not see the reader access design element in the 
language database and, when you update the project, tries to add it a second time.
To overcome the problem, if you are building a language database on a server, and the database 
includes a design element that has only Reader access, always select 'Copy ACL from source' on the 
Build Options dialog.
If you are tagging a database manually, then click Stop to interrupt the process, and then choose 2.
Re-create Tagged Database.
To overcome the problem remove the tagged database and create it again from scratch: if you choose to 
tag manually do not interrupt the process.

Tagging options: change of defaults2.
The following options on the Lookup panel of the Tagging Options dialog are now selected by default:

Rich text sensitive
Context matching: Type, Type title, Subtype and Subtype title

The following option on the Tagging panel of the Tagging Options dialog is now selected by default:
Hidden design elements

Synchronization - In Release 5.0.5, documents created by users in synchronized databases were being 3.
displayed as deleted documents (red) in the WorkBench. This was because the WorkBench detected them in 
the target database, but they were not present in the source. In release 5.0.7 the problem has been fixed: the 
WorkBench no longer detects user documents in target databases.
Logging of errors and warnings - When you deselect the option 'Term ignored (exclusion list)' on the Basics 4.
panel of the Tagging Options dialog, you will no longer see messages about exclusion list entries being 
ignored.
Exclusion list defaults - On the Tagging panel of the Tagging Options dialog, the exclusion list entries 'ftp://' 5.
and 'http://' have changed. They are now 'ftp://*' and 'http://*' respectively. This prevents any URL that 
begins with these characters from being tagged.
Note:  If you install over a previous release of Domino Global WorkBench, the new exclusion list will not 
appear unless you first manually remove the registry key for the exclusion list (search for ExcludeTerms). The 
registry entry will be recreated and populated with the new list when you next create a tagged database.
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Tagging HTML - When you include text in the HTML properties tab for a hotspot, the text in the 'Other' box is 6.
now tagged. It appears under a new context subtype '<HTML> Extra Attribute'.
Note:  The entire text in the box is tagged even though part of it may not be translatable text. For example if 
the entry is Alt="Save", the whole string is tagged, even though only 'Save' is translatable.
Java - In release 5.0.5 there were two problems handling translated Java bundle files: first, some of the files 7.
were being truncated, and second, Unicode characters were not being encoded correctly. These errors have 
been fixed. If you want to process Java bundle files, you should update to this release

System Requirements

The following hardware is recommended:
A Pentium® or equivalent processor
A minimum of 32Mb of memory
Approximately 32Mb of hard disk space to install the software with all default features

Operating system:
Windows 95®, Windows 98®, Windows 2000® or Windows NT® Release 4 is required to use this product.

To use the WorkBench:
Domino Designer Release 5

To use databases built by Domino Global WorkBench:
Server: Domino Release 5
Client: Domino Release 5 or Web browser (see below)

To build Notes 4.6 language databases with the WorkBench:
Server: Notes Release 4.6
Client: Domino Release 5 

Browsers:
For Web browsers to access databases, the Notes server must be running Domino. The browser can be any 
browser capable of supporting HTTP language detection, for example Netscape Navigator® 3.0 or later, or 
Microsoft Internet Explorer® 3.0 or later.

Domino Network File Store (DNFS)  [Domino Designer CD only]
Domino Network File Store (DNFS), which provides the ability to use Domino as a file server, was first included in the 
\APPS directory on the R5.0.5 Domino CD.  DNFS R1.2 now ships in the \APPS directory on the R5.0.7 Domino CD.  
DNFS provides Domino customers secure, replicated, and indexed collaborative repository for productivity files via 
standard Windows Networking.  DNFS is a Domino server add-in task that enables users to read files from and save 
files to Domino databases from any Windows application. With DNFS, files stored in a Domino databases are 
presented to users in a traditional folder/file metaphor, and are accessed through an application's Open/Save dialog 
boxes, Windows Explorer, or any Windows file system dialog box.

Domino Network File Store blurs the boundaries between the Windows file management system and Domino servers. 
Users simply map a drive to a Domino server, similar to mapping a drive to a network server, and Domino databases, 
folders, and documents display in the familiar tree structure within existing Windows file management controls. If 
mapping a network drive is something that is unfamiliar to users, this can easily be done for them by a network 
administrator or through a logon script. 

DNFS enables users to work within a natural interface.  As users perform routine file operations such as Open, Save, 
Delete, Rename, etc. from within any Windows application DNFS seamlessly passing of files into and out of 
Domino/Notes applications.  Benefits include:

Central file repository for project teams, departments, etc.l
Enables Domino workflow on productivity filesl
Provides secure storage for productivity files where files are backed up and maintained by IT l
professionals--rather than by end users on their hard drives.
Instant enterprise-wide file distribution through Domino replicationl
Extends Domino Full Text Search capabilities to productivity filesl
Requires no end user training-- a transparent solutionl
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DNFS System Requirements: 
Languages: Global English 
Server Operating Systems: NT 4.0 SP3 and higher, or Windows 2000 
Domino Servers: Release 5.0 and higher 
Client Operating Systems: Windows 95/98/ME/2000/NT 4.0 

Networking environment: Windows Networking using one of the following transport protocols: 
TCP/IP Protocol with NetBIOS Interfacel
NetBEUI Protocol l
NWLink NetBIOSl

Lotus Enterprise Solution Builder (ESB) Client Enabler R3.0.3

Lotus ESB is a basic scripting application server that can execute LotusScript applications invoked by remote clients 
(Notes, Win32 and/or web). ESB is used as an alternative to Domino's agent manager task when a large volume of 
concurrent clients need to be supported. It is especially useful for Domino enterprise integration applications where 
both thread pooling to the ESB server and connection pooling to the backend system (like DB2 or SAP) can provide 
very high throughput. ESB is comprised of two components, a powerful Runtime component and a productive IDE ( 
called Developer).

The ESB Client Enabler, included on the Notes and Domino Designer CD-ROMs, are the lightweight files which need to 
be installed on the Notes client machine in order to establish communication to the ESB Runtime. There is no GUI for 
the Client Enabler and requires no configuration. There are sample files included in the installation with detailed 
descriptions of how the files are used.
Notes about ESB Installation:

After extracting the ZIP file, the Apps\ESB\w32intel directory is created, the installable files including Setup.exe l
are extracted, not the .nsf file.

Setup.exe in this directory should be executed to install the ESB Client Enabler.l

Before installing ESB, stop any applications that are running. Especially make sure that the Notes Client and the l
Domino Server are terminated. And be sure to reboot your machine after installing ESB.

Further information about the Client Enabler files is available in the Readme.txt file on the Notes and Domino Designer 
CD-ROMs in the App\ESB\w32intel directory, Lotus  ESB User's manual which is available when you install either the 
Runtime or Developer and IBM Redbook #SG-245405. 

Lotus Notes R5 QuickCards Preview Collection 
This desktop application is a learning support tool targeted at end users migrating to Lotus Notes R5, which can now 
be found on the Notes and Domino Designer CD-ROMs in the \APPS\QUICKCARDS directory.  The "preview collection" 
includes 25 "QuickCards" containing step-by-step instructions for using popular Notes R5 features. Launched from an 
icon on the toolbar, QuickCards appear "on top" of Notes R5, so users can see the card and refer to it while performing 
the steps required to complete a function. The complete Notes R5 QuickCard collection includes nearly 200 
QuickCards containing step-by-step instructions, weblinks, bitmaps, and captioned ScreenCam movies. 
Customization
Notes R5 QuickCards are easily customized to support your specific Notes application, using Lotus’ Desktop Support 
Factory. Create new R5 QuickCards or edit the existing ones to reflect your company’s Best Practices and focus 
support on the areas where it is needed most. Create procedure-based tasks for Notes applications, any Microsoft 
Windows applications, even your business processes and procedures. With QuickCards, you can include links to web 
pages, create definitions for your corporate vocabulary, and add Lotus ScreenCam movies to create a custom learning 
support tool for your company.
Who Should Install Notes R5 QuickCards
Install Notes R5 QuickCards "Preview Collection" for all end users migrating to Notes R5 to ensure a smooth and rapid 
transition to the newest Notes environment. Notes R5 QuickCards should also be installed for all teams responsible for 
end user IT training at either the corporate or line of business level. Install Notes R5 QuickCards for all IT support 
team members or Help Desk staffers as a simple and fast way for them to provide end user support for your Notes R5 
Migration. 
Installing Notes R5 QuickCards
Notes R5 QuickCards "Preview Collection" is easily installed by double-clicking on R5QCLV.exe. This is a client 
installation.
Additional Information
The complete Notes R5 QuickCard collection can be purchased by contacting your local Lotus Education office. Visit 
http://www.lotus.com/home.nsf/welcome/education and select the "Contact Education" link to locate the office 
nearest you.
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Language dictionary files
The language dictionary files are used for spell-checking within Notes. The following language dictionary files are 
included in a self extracting file located in the \APPS\DICTIONARIES directory.  Notes automatically installs certain 
dictionary files that correspond to your language version of Notes. If you want to use one of the dictionary files listed 
below and find that it has not been installed automatically by Notes, simply decompress the contents of the 
DICTIONARIES.EXE self extracting file on the CD-ROM to a temporary directory on your hard drive and copy the 
appropriate dictionary file (listed below) into your Notes data directory.

Language Dictionary File Name

Afrikaans AFRIKAAN.DIC

Arabic ARABIC.DIC

Catalan CATALA.DIC

Czech CZECH.DIC

Danish DANSK.DIC

Dutch
Dutch Belgian

NEDERLND.DIC

Dutch Preferred NEDPLUS.DIC

English (Australia) AUS.DIC

English (Canada)
English (Caribbean)
English (Jamaica)
English (New Zealand)
English (United States)

US.DIC

English (Ireland)
English (South Africa)
English (United Kingdom)

UK.DIC

Finnish SUOMI.DIC

French (Belgium)
French (Luxembourg)
French (Standard)
French (Switzerland)

FRANCAIS.DIC

French (Canada) CANADIEN.DIC

German (Austria)
German (Liechtenstein)
German (Luxembourg)
German (Standard)

DEUTSCH.DIC

German (Reform)

Note: This is active on Windows only; this 
dictionary is not present in R5.0.2 for the 
Macintosh client platform.

DEUTSCH2.DIC

German (Switzerland) DSCHWEIZ.DIC

Greek HELLAS.DIC
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Language Dictionary File Name

Hebrew HEBREW.DIC

Hungarian MAGYAR.DIC

Icelandic ISLENSK.DIC

Italian (Standard)
Italian (Switzerland)

ITALIANO.DIC

Medical (American)
Medical (British)
Medical (British IZE)

US.MED

Norwegian (Bokmal) NORBOK.DIC

Norwegian (Nynorsk) NORNYN.DIC

Polish POLSKA.DIC

Portuguese (Brazil) BRASIL.DIC

Portuguese (Standard) PORTUGAL.DIC

Russian
Russian (Io)

RUSSIAN.DIC

Spanish
Spanish (Argentina)
Spanish (Bolivia)
Spanish (Chile)
Spanish (Colombia)
Spanish (Costa Rica)
Spanish (Dominican Republic)
Spanish (Equador)
Spanish (Guatemala)
Spanish (Mexico)
Spanish (Modern Sort)
Spanish (Panama)
Spanish (Paraguay)
Spanish (Peru)
Spanish (Uruguay)
Spanish (Venezuela)

ESPANA.DIC

Swedish SVENSK.DIC

Thai SPELLT.GRA

Turkish TURKIYE.DIC

Monotype WorldType fonts

Monotype WorldType
TM

 fonts support Unicode-based display of multilingual text. Five different fonts are available, each 
tuned to a different multilingual environment. Subsetting the fonts-based character set usage significantly reduces the 
size of a font, thus improving performance. Information about Monotype's Unicode fonts can be found at 
http://www.monotype.com.

The following fonts are included in a self extracting file located in the \APPS\FONTS directory:

MTSANS_W.TTF -- Covers the WGL4 character set. This font is suitable for use with most uses of the Latin l
alphabet (including all diacritical marks), as well as Greek, Cyrillic, Slavic, Turkish, Arabic and Hebrew 
languages.
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MTSANS_J.TTF -- Covers the WGL4 character and the Japanese language with some support for other Asian l
languages.

MTSANS_K.TTF -- Covers the WGL4 character set and the Korean language with some support for other Asian l
languages.

MTSANS_S.TTF -- Covers the WGL4 character set and Simplified Chinese with some support for other Asian l
languages.

MTSANS_T.TTF -- Covers the WGL4 character set and Traditional Chinese with some support for other Asian l
languages.

These fonts are designed for Windows use only.  Execute the self extracting file FONTS.EXE in the \APPS\FONTS 
directory on the CD-ROM to decompress the contents to a temporary directory on your hard drive.  The fonts can 
then be installed using the normal operating system procedure for installing fonts:

Open the Control Panel.1.

Open the Fonts folder.  Choose File - Install New Font.2.

Specify the drive and directory of the temporary directory containing one the above fonts.3.

Normally only one of the above fonts should then be selected for installation.4.

Once a font has been installed, you need to enable Unicode display in your Notes User Preferences (Basics panel, 
Additional Options). You may also want to make a WorldType font your default Multilingual Font in Notes (open the 
User Preferences Basics panel and set the default Multilingual font in the Default Fonts dialog).

Mentor for Lotus Notes R5 - Preview Version 

Mentor for Lotus Notes R5-Preview Version is a subset (about 15%) of Mentor for Lotus Notes R5, a just-in-time, 
multimedia Communication, Learning, and Support resource for Notes end users.  The Preview Version contains basic 
material about R5, Setup, Bookmarks, Mail, Calendaring and Scheduling, and other topics.  The full Mentor for Lotus 
Notes R5, which delivers nearly six hours of multimedia content on all aspects of Notes R5, is a powerful enhancement 
to any R5 rollout strategy. The Preview Version can now be found on the Notes and Domino Designer CD-ROMs in the 
\APPS\MENTOR directory. To order the full Mentor for Lotus Notes R5, contact your Lotus representative or Mentor 
Communications Group at +1-203-847-5555 or email sales@trymentor.com. To learn more, visit www.trymentor.com

Features: 

· A single, integrated, always-available solution 

· A fast, natural way for users to succeed 

· Easy to follow show and tell approach 

· Accessible anywhere, anytime 

· Immediate and ongoing support 

· Multimedia demonstrations without leaving the application 

Benefits: 

· End users are more productive, more quickly; rollouts proceed faster and finish earlier 

· Greater user confidence with all of R5's facilities - without training or assistance 

· Reduces Help Desk costs by 40% or more 

· High levels of user satisfaction 

· The Preview Version has 36 of the full Mentor for Lotus Notes R5’s 265 "JITs," or "Just-In-Time," 
communication units covering the full range of Notes R5 functions and options. There are two types of 
JITs. "Conceptuals," averaging 3 1/2 minutes, deliver the big picture. Using dynamic visuals with sound, 
Conceptuals enrich users' understanding by conveying higher-level concepts and explaining the 
principles and structure of the new software. "How-To's," averaging 45 to 60 seconds, demonstrate 
step-by-step how to perform specific tasks and get things done quickly. How-To's not only cover every 
aspect of Notes R5's functions, they introduce all of R5's new features, such as bookmarks, Web 
protocols and updates to core applications. 
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System requirements: 

Client computers must meet the following minimum requirements: 

· Microsoft Windows® 95, 98, 2000 or Windows NT® operating system 

· Internet Explorer 3 or greater, Netscape Navigator 3 or greater 

· 486 66 MHz processor with 24 MB of RAM 

· 8-bit (256-color) display at 640 x 480 resolution 

· SoundBlaster® or compatible audio device 

· 28.8 Kbps modem or network connection 

Additional Information: 

· Visit www.trymentor.com, or request additional information about Mentor for Lotus Notes R5 from your 
Lotus representative or by calling Mentor Communications Group at +1-203-847-5555. 

Lotus Translation Components Release 2.1.1
The Lotus Translation Components Release 2.1.1 (LTC) are a set of programming objects and server based software 
services that allow the secure, scalable and interactive integration of a variety of  translation services into Domino, 
Sametime and WebSphere applications.  They consist of 3 main components: the Domino Translation Object (DTO), 
the Translation Services Gateway (TSG) and the Remote Configuration and Statistics database.

The DTO is an object to facilitate the communication between Domino and WebSphere applications and translation 
services such as Machine Translation Engines, Translation memory and Web based Human Translation Services, via 
Translation Connectors. The DTO provides full access to these services using the complete control and flexibility of 
object oriented programming languages: LotusScript and Java.  It consists of a set of classes for the primary 
commands necessary for machine translating text and Notes objects, a set for using Human Translation, and a set 
for using Translation Memory. Each comes with powerful properties, methods and events and are available in 
LotusScript and Java.

The Translation Services Gateway (TSG) is a secure server based set of services that acts as a center point for 
coordinating translation services. User requests are serviced and sent out to any number of translation services over 
the network using Translation Connectors connected to the TSG. Additionally it provides some simple "core 
services" to aid in translation such as word count, load/unload of translation services and file attachment 
translation to only name a few.

The Remote Configuration and Statistics database leverages the scalability of the DTO and enables administrators to 
manage the entire network of translation services from a single location. It contains an index of all possible services 
and servers connected to these services and assigns services to servers, connect servers to other servers, and 
nominate times to turn on and off connections. As large users may deploy numerous translation services throughout 
their global organization they may wish to dynamically adjust the configuration and topology of how these servers 
are connected and interact with each other over the course of time. The Remote Configuration and Statistics 
database is available for download from the web at www.lotus.com/international.

The LTC's 2.1.1 are the cross platform version of the LTC's 2.1 previously shipped in March 2001 [Domino W32 Server 
CD Only] and support the following environments: Windows 95, Windows, 98, Windows 2000, Windows NT 4.0, AIX 
and Solaris.  The application can be found on the Notes, Domino Designer and Domino Server CDs in the \APPS\LTC 
directory. 

Key features:
An enhanced DTO API - The key to automated use of Translation Memory or Human Translation systems  in a l
enterprise setting is embedding it within a workflow process. As a premier development environment for 
creating workflow applications, Domino is a natural fit to give access to Translation Memory and Human 
Translation systems to Domino programmers and end users. Using the Lotus Translation Components, Domino 
applications can now access such systems and bring their benefits to the translation efforts within your 
enterprise.
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Human Translation support - unlike Machine Translation that replies upon sending a message and getting a l
reply instantly, Human Translation (and off-line Translation) is not so. Since you are waiting for a human to 
complete an action, hours, days or weeks may pass between the submission of data, and the availability of 
translation. Additionally, where Machine Translation is usually sold in terms of the technology, Human 
Translation is sold on a job by job basis. This requires the addition of a workflow into the process of submitting 
and receiving a translation, rather than the simple transaction model of Machine Translation. LTC 2.0 
introduced the concept of Post-Query-Retrieve services. This allows for vendors to write services that decoupled 
the posting of data for translation from the retrieval of translated data, plus the ability to query the status of the 
data in-between. The Human Translation API shipping with the LTC 2.1  upon Post-Query-Retrieve and provides 
a common structures and procedure to manage the workflow around Human Translation based services. 
Domino excels at workflow applications and this becomes a natural and ideal choice for businesses wishing to 
automate the organization of their translation requirement.

Much like Human Translation, Translation Memory is a service that improves the quality of automated l
translation. While the translator works away, Translation Memory systems are busy building linguistic 
databases in the background. The Memory consists of a dictionary of known phrases and their validated, 
perfect translations within context.  Whenever the same or a similar phrase recurs, Translation Memory 
systems automatically suggests the memorized translation as a possible match. The recycled text can be 
adopted, rejected or edited by the user.  Remaining unmatched phrases can then be machine translated or 
human translated. The next possible step is for those machine translated phrases to be validated by a human, 
and added back into the Translation Memory.

Support of Sametime via the Lotus Translation Services for Sametime Release 1.0, a Sametime add-on. The l
Lotus Translation Services for Sametime is a Client/Server Java application that runs within the Sametime 
community and lets users collaborating within a Sametime community conduct state of the art multilingual 
chat sessions. Using the Lotus Translation Components as the underlying back-end architecture, the LTSS 
connect to Translation Servers via supported Translation Connectors developed by IBM or third party vendors.

LTC's System Requirements
Recommended Server Hardware Requirements

Pentium III 333 Mhz with 54 Mb of RAM, running TCP/IP.
Its installation needs 25Mb of disk space on the hard drive.

Server software requirements
Domino Server Release 4.6.x or greater
Notes client Release 4.6.x or greater
Sametime Server 1.5 or greater

The DTO and the TSG require Java runtime 1.1.6 or higher on disk. The Java runtime supported by Lotus for use 
with the Lotus Translation Components is the IBM Java Runtime Edition 1.1.7, which can be downloaded from 
http://www3.software.ibm.com/segdown?segment=AD&family=JV.
Supported operating systems
Windows 95, Windows, 98, Windows 2000, Windows NT 4.0, AIX and Solaris

Machine Translation (MT) enabled sample templates
In addition to the program files, the DTO includes two MT enabled sample templates, a mail template 
(MAIL46MT.NTF) and a discussion database template (DISC46MT.NTF), available on the Lotus Web site at 
http://www.lotus.com/international.

Wisdom for Notes
Wisdom for Notes is a just-in-time learning tool for Lotus Notes, now available on the Notes and Domino Designer 
CD-ROMs in the \APPS\WISDOM directory. Wisdom for Notes is interactive and "Lotus Notes aware". It knows where 
the user is and offers modules and tasks that are suitable for the user, given their current location in Lotus Notes. It's 
based on the latest technologies to ensure a highly functional and robust product. It offers a subset of the functionality 
(40 tasks in this version)found in the current Wisdom for Notes "Lite" (over 150 tasks) and "Full" clients (over 400 
tasks). Wisdom for Notes DevPack enables customers, developers and learning organizations to develop their own 
context-sensitive help for their own applications. 

When a user requests assistance, Wisdom for Notes determines the action being performed in Notes then provides 
context-sensitive help across Home Page, Mail, Calendar, Mobile User, Replication and many other day-to-day tasks. 
Wisdom for Notes enables rapid productivity and best practices from Notes users via powerful application modules 
that cater to the users' preferred learning methods. 
Features: 

Keeps the performer working 'live' in the Notes environment l
Provides Wizard task assistance, where required l
Is available for everyone in the corporation, from CEO to admin. Assistant. l
Incorporates a revolutionary Authoring Tool that enables BP's to provide JIT services with their applications l
and/or customers to create their own Help systems (Wisdom for Notes DevPack)over 400 tasks 
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Benefits:
Reduces costs of training in terms of capital, overhead, time and effort l
Raises novice employees to expert levels of performance across a range of day-to-day tasks l
Presents resources at the time of need l
Reduces the production costs of documentation and reference materials l
Integrates Lotus Notes without impacting development schedules. l

Server and Client Requirements: 
Server System Requirements: 
- Windows NT4 SP4 or greater 
- Windows 2000 

Client System Requirements: 
- Windows 2000 
- Windows 95/98 
- Windows NT 
- Lotus Notes R5.0.5 and beyond. 

Server

Additional items on Domino CD-ROMs
In addition to the Domino installation files, there are the following items on the Domino R5 CDs.  Please note that 
Lotus provides support only for Lotus software in the  \APPS directory, and we support it on a best-effort basis.  For 
other, non-Lotus software applications included in the \APPS directory, please refer to the appropriate third-party 
vendor for support.

Adobe Acrobat Readers 

On the root directory of the Notes, Notes Designer and Domino Server CDs, the Release Notes are available in Adobe's 
Portable Document Format (PDF). To view PDF documents such as README.PDF, you can use the Adobe Acrobat 
Readers contained in the \APPS\ADOBE directory. For platform specific instructions, refer to the START.TXT text file 
found on the root directory. Additional information can be found on the Adobe Web site at http://www.adobe.com.

Domino Global Workbench R5 [Domino W32 Server CD only]
Domino Global WorkBench Release 5.0.7a is a point release that increases the robustness of Domino Global 
Workbench and increases your productivity while creating global eBusiness Applications.  Domino Global WorkBench 
5.0.7a is fully integrated with the Domino server and the Domino Designer development environment. Like all other 
components of the Domino IDE, it is standards-based and compatible with popular Web development tools. It helps 
application developers localize the architecture of multilingual Domino based applications, Application and Web site 
administrators manage the deployment and synchronization of Domino multilingual applications and Web sites and 
Content Managers provide, track and update the content across languages efficiently.  The application can be found 
on the Domino Designer and Domino Server (W32 only) CDs in the \APPS\DGW directory. 

Update for 5.0.7a:

Error: Unilingual databases sometimes made into multilingual databases:  In some situations, when updating 
unilingual databases in which content documents had been created, Domino Global WorkBench would mistakenly 
add extra languages, making the language database a multilingual database.  This has been corrected in Domino 
Global WorkBench 5.0.7a.

Key updates in 5.0.7 (included in 5.0.7a) are:

Error: Database already contains a document with this ID (UNID) - you may see this error in the following 1.
circumstances:

If your source database contains a design element that has only reader access and you are updating a 1.
language database on a server. The WorkBench does not see the reader access design element in the 
language database and, when you update the project, tries to add it a second time.
To overcome the problem, if you are building a language database on a server, and the database 
includes a design element that has only Reader access, always select 'Copy ACL from source' on the 
Build Options dialog.
If you are tagging a database manually, then click Stop to interrupt the process, and then choose 2.
Re-create Tagged Database.
To overcome the problem remove the tagged database and create it again from scratch: if you choose to 
tag manually do not interrupt the process.
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Tagging options: change of defaults2.
The following options on the Lookup panel of the Tagging Options dialog are now selected by default:

Rich text sensitive
Context matching: Type, Type title, Subtype and Subtype title

The following option on the Tagging panel of the Tagging Options dialog is now selected by default:
Hidden design elements

Synchronization - In Release 5.0.5, documents created by users in synchronized databases were being 3.
displayed as deleted documents (red) in the WorkBench. This was because the WorkBench detected them in 
the target database, but they were not present in the source. In release 5.0.7 the problem has been fixed: the 
WorkBench no longer detects user documents in target databases.
Logging of errors and warnings - When you deselect the option 'Term ignored (exclusion list)' on the Basics 4.
panel of the Tagging Options dialog, you will no longer see messages about exclusion list entries being 
ignored.
Exclusion list defaults - On the Tagging panel of the Tagging Options dialog, the exclusion list entries 'ftp://' 5.
and 'http://' have changed. They are now 'ftp://*' and 'http://*' respectively. This prevents any URL that 
begins with these characters from being tagged.
Note:  If you install over a previous release of Domino Global WorkBench, the new exclusion list will not 
appear unless you first manually remove the registry key for the exclusion list (search for ExcludeTerms). The 
registry entry will be recreated and populated with the new list when you next create a tagged database.
Tagging HTML - When you include text in the HTML properties tab for a hotspot, the text in the 'Other' box is 6.
now tagged. It appears under a new context subtype '<HTML> Extra Attribute'.
Note:  The entire text in the box is tagged even though part of it may not be translatable text. For example if 
the entry is Alt="Save", the whole string is tagged, even though only 'Save' is translatable.
Java - In release 5.0.5 there were two problems handling translated Java bundle files: first, some of the files 7.
were being truncated, and second, Unicode characters were not being encoded correctly. These errors have 
been fixed. If you want to process Java bundle files, you should update to this release

System Requirements
The following hardware is recommended:

A Pentium® or equivalent processor
A minimum of 32Mb of memory
Approximately 32Mb of hard disk space to install the software with all default features

Operating system:
Windows 95®, Windows 98®, Windows 2000® or Windows NT® Release 4 is required to use this product.

To use the WorkBench:
Domino Designer Release 5

To use databases built by Domino Global WorkBench:
Server: Domino Release 5
Client: Domino Release 5 or Web browser (see below)

To build Notes 4.6 language databases with the WorkBench:
Server: Notes Release 4.6
Client: Domino Release 5 

Browsers:
For Web browsers to access databases, the Notes server must be running Domino. The browser can be any 
browser capable of supporting HTTP language detection, for example Netscape Navigator® 3.0 or later, or 
Microsoft Internet Explorer® 3.0 or later.

Domino Management Agents

The Domino Management Agents contain the Domino SNMP Agent and Mail Reflector and run on Domino servers. The 
SNMP agent monitors server events and automatically forwards real-time alerts back to the NotesView management 
station or any SNMP supported console. With the SNMP agent, you can collect Domino statistics, query the Domino 
server, and restart the Domino server. The Notes Mail Reflector can be used by itself to help diagnose mail problems, 
and it supports the mail prober of Lotus NotesView.

This release on the CD-ROM supports Domino 4.5x and higher and Notes R4 servers on the following operating system 
platforms: IBM AIX, Microsoft Windows NT for Intel, and Sun Solaris for SPARC. The agents can be found in the 
/APPS/AGENTS directory on the CD-ROM. The documentation can be found in 
/APPS/SYSMGMT/AGENTS/NVAGENTS.NSF. The latest versions of the agents (and the older version that supports 
Notes R3 servers) of the Domino Management Agents and documentation can always be found at the Lotus Systems 
Management Web site at: http://www.lotus.com/home.nsf/welcome/systems.
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Domino Network File Store (DNFS)  [Domino W32 Server CD only]

Domino Network File Store (DNFS), which provides the ability to use Domino as a file server, was first included in the 
\APPS directory on the R5.0.5 Domino CD.  DNFS R1.2 now ships in the \APPS directory on the R5.0.7 Domino CD.  
DNFS provides Domino customers secure, replicated, and indexed collaborative repository for productivity files via 
standard Windows Networking.  DNFS is a Domino server add-in task that enables users to read files from and save 
files to Domino databases from any Windows application. With DNFS, files stored in a Domino databases are 
presented to users in a traditional folder/file metaphor, and are accessed through an application's Open/Save dialog 
boxes, Windows Explorer, or any Windows file system dialog box.

Domino Network File Store blurs the boundaries between the Windows file management system and Domino servers. 
Users simply map a drive to a Domino server, similar to mapping a drive to a network server, and Domino databases, 
folders, and documents display in the familiar tree structure within existing Windows file management controls. If 
mapping a network drive is something that is unfamiliar to users, this can easily be done for them by a network 
administrator or through a logon script. 

DNFS enables users to work within a natural interface.  As users perform routine file operations such as Open, Save, 
Delete, Rename, etc. from within any Windows application DNFS seamlessly passing of files into and out of 
Domino/Notes applications.  Benefits include:

Central file repository for project teams, departments, etc.l
Enables Domino workflow on productivity filesl
Provides secure storage for productivity files where files are backed up and maintained by IT l
professionals--rather than by end users on their hard drives.
Instant enterprise-wide file distribution through Domino replicationl
Extends Domino Full Text Search capabilities to productivity filesl
Requires no end user training-- a transparent solutionl

DNFS System Requirements: 
Languages: Global English 
Server Operating Systems: NT 4.0 SP3 and higher, or Windows 2000 
Domino Servers: Release 5.0 and higher 
Client Operating Systems: Windows 95/98/ME/2000/NT 4.0 

Networking environment: Windows Networking using one of the following transport protocols: 
TCP/IP Protocol with NetBIOS Interfacel
NetBEUI Protocol l
NWLink NetBIOSl

Lotus Translation Components Release 2.1.1
The Lotus Translation Components Release 2.1.1 (LTC) are a set of programming objects and server based software 
services that allow the secure, scalable and interactive integration of a variety of  translation services into Domino, 
Sametime and WebSphere applications.  They consist of 3 main components: the Domino Translation Object (DTO), 
the Translation Services Gateway (TSG) and the Remote Configuration and Statistics database.

The DTO is an object to facilitate the communication between Domino and WebSphere applications and translation 
services such as Machine Translation Engines, Translation memory and Web based Human Translation Services, via 
Translation Connectors. The DTO provides full access to these services using the complete control and flexibility of 
object oriented programming languages: LotusScript and Java.  It consists of a set of classes for the primary 
commands necessary for machine translating text and Notes objects, a set for using Human Translation, and a set 
for using Translation Memory. Each comes with powerful properties, methods and events and are available in 
LotusScript and Java.

TheTranslation Services Gateway (TSG) is a secure server based set of services that acts as a center point for 
coordinating translation services. User requests are serviced and sent out to any number of translation services over 
the network using Translation Connectors connected to the TSG. Additionally it provides some simple "core 
services" to aid in translation such as word count, load/unload of translation services and file attachment 
translation to only name a few.

The Remote Configuration and Statistics database leverages the scalability of the DTO and enables administrators to 
manage the entire network of translation services from a single location. It contains an index of all possible services 
and servers connected to these services and assigns services to servers, connect servers to other servers, and 
nominate times to turn on and off connections. As large users may deploy numerous translation services throughout 
their global organization they may wish to dynamically adjust the configuration and topology of how these servers 
are connected and interact with each other over the course of time. The Remote Configuration and Statistics 
database is available for download from the web at www.lotus.com/international.
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The LTC's 2.1.1 are the cross platform version of the LTC's 2.1 [Domino W32 Server CD Only] previously shipped in 
March 2001 and support the following environments: Windows 95, Windows, 98, Windows 2000, Windows NT 4.0, AIX 
and Solaris.  The application can be found on the Notes, Domino Designer and Domino Server CDs in the \APPS\LTC 
directory. 

Key features:
An enhanced DTO API - The key to automated use of Translation Memory or Human Translation systems  in a l
enterprise setting is embedding it within a workflow process. As a premier development environment for 
creating workflow applications, Domino is a natural fit to give access to Translation Memory and Human 
Translation systems to Domino programmers and end users. Using the Lotus Translation Components, Domino 
applications can now access such systems and bring their benefits to the translation efforts within your 
enterprise.

Human Translation support - unlike Machine Translation that replies upon sending a message and getting a l
reply instantly, Human Translation (and off-line Translation) is not so. Since you are waiting for a human to 
complete an action, hours, days or weeks may pass between the submission of data, and the availability of 
translation. Additionally, where Machine Translation is usually sold in terms of the technology, Human 
Translation is sold on a job by job basis. This requires the addition of a workflow into the process of submitting 
and receiving a translation, rather than the simple transaction model of Machine Translation. LTC 2.0 
introduced the concept of Post-Query-Retrieve services. This allows for vendors to write services that decoupled 
the posting of data for translation from the retrieval of translated data, plus the ability to query the status of the 
data in-between. The Human Translation API shipping with the LTC 2.1  upon Post-Query-Retrieve and provides 
a common structures and procedure to manage the workflow around Human Translation based services. 
Domino excels at workflow applications and this becomes a natural and ideal choice for businesses wishing to 
automate the organization of their translation requirement.

Much like Human Translation, Translation Memory is a service that improves the quality of automated l
translation. While the translator works away, Translation Memory systems are busy building linguistic 
databases in the background. The Memory consists of a dictionary of known phrases and their validated, 
perfect translations within context.  Whenever the same or a similar phrase recurs, Translation Memory 
systems automatically suggests the memorized translation as a possible match. The recycled text can be 
adopted, rejected or edited by the user.  Remaining unmatched phrases can then be machine translated or 
human translated. The next possible step is for those machine translated phrases to be validated by a human, 
and added back into the Translation Memory.

Support of Sametime via the Lotus Translation Services for Sametime Release 1.0, a Sametime add-on. The l
Lotus Translation Services for Sametime is a Client/Server Java application that runs within the Sametime 
community and lets users collaborating within a Sametime community conduct state of the art multilingual 
chat sessions. Using the Lotus Translation Components as the underlying back-end architecture, the LTSS 
connect to Translation Servers via supported Translation Connectors developed by IBM or third party vendors.

LTC's System Requirements
Recommended Server Hardware Requirements

Pentium III 333 Mhz with 54 Mb of RAM, running TCP/IP.
Its installation needs 25Mb of disk space on the hard drive.

Server software requirements
Domino Server Release 4.6.x or greater
Notes client Release 4.6.x or greater
Sametime Server 1.5 or greater

The DTO and the TSG require Java runtime 1.1.6 or higher on disk. The Java runtime supported by Lotus for use 
with the Lotus Translation Components is the IBM Java Runtime Edition 1.1.7, which can be downloaded from 
http://www3.software.ibm.com/segdown?segment=AD&family=JV.
Supported operating systems
Windows 95, Windows, 98, Windows 2000, Windows NT 4.0, AIX and Solaris

Machine Translation (MT) enabled sample templates
In addition to the program files, the DTO includes two MT enabled sample templates, a mail template 
(MAIL46MT.NTF) and a discussion database template (DISC46MT.NTF), available on the Lotus Web site at 
http://www.lotus.com/international.
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Server

Tivoli Ready files will no longer be included with Domino
Beginning with Domino Release 5.0.9, Lotus will no longer include baseline Tivoli Ready files with the Domino server.  

Through release 5.0.8, in accordance with IBM's then-current Tivoli Ready program certified by the Tivoli Competency 
Center team, Domino was certified Tivoli Ready. However, the IBM Tivoli Ready Initiative and Team Tivoli programs 
converged at year-end 2000 to provide a single, consistent Tivoli Ready certification.  Under the terms of this 
convergence,  the requirements for IBM Tivoli Ready certification were raised to reflect advanced customer 
requirements using Tivoli core products (e.g. Tivoli Enterprise Console, Distributed Monitoring, Software Distribution, 
etc.).  

Accordingly, Tivoli Manager for Domino, which is developed, marketed, and sold by Tivoli under theTivoli brand, is the 
new standard for managing Domino servers within the Tivoli Framework.  The Tivoli and Domino development teams 
continue to  work closely together to provide more advanced function and increase integration in future releases of 
Tivoli Manager for Domino.

Server

No need for 'http httpsetup' on new install; just run 'server'
Once installation is completed and you run "server," the server will test to see if it has already been set up, and 
announce that it is launching "http httpsetup".  In releases prior to 5.0.9, the http launch would not occur, and 
required manual start of "http httpsetup" from the command line.

This has been corrected.  Http is truly started by the server in httpsetup mode, and is waiting for your browser to 
attach on port 8081.

You can still launch "http httpsetup" manually as before.

Server

Updated Domino SNMP Agents for Domino R5.0.13
Updated Domino SNMP Agents as of Domino R5.0.13
On Domino Server media, the directory apps/sysmgmt/agents contains a revised version of the Lotus Domino SNMP 
Agents Release 5.01.  The Lotus Domino SNMP Agents themselves are unchanged, but the PEER Networks Agents 
have been replaced with the NET-SNMP Master Agent on HP-UX and Solaris.  Customers may continue using the PEER 
Networks Agents, but they are no longer distributed or supported.

The install procedure will now offer to install the NET-SNMP Master Agent on HP-UX and Solaris if a suitable SNMP 
Master Agent is not available.  Additionally, the Domino Management Agents no longer are distributed for Microsoft 
Windows NT Alpha, or for Solaris Intel x.86, because Domino support for those platforms ended with Domino 5.0.10.

Licensing information - Excluded Components

Administrator Client, Client, Designer, Server

Excluded Components licensing information
Licensing information included in this section refers to Excluded Components; terms for Excluded Components are 
defined in the product license.

Server

DNS Resolver software information
DNS Resolver
Copyright (c) 1980, 1983, 1988, 1993
The Regents of the University of California.  All rights reserved.
 
 Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:

 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer.
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2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgement:

This product includes software developed by the University of California, Berkeley and its contributors.

4. Neither the name of the University nor the names of its contributors may be used to endorse or promote products 
derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Portions Copyright (c) 1993 by Digital Equipment Corporation.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby granted, 
provided that the above copyright notice and this permission notice appear in all copies, and that the name of Digital 
Equipment Corporation not be used in advertising or publicity pertaining to distribution of the document or software 
without specific, written prior permission.

THE SOFTWARE IS PROVIDED "AS IS" AND DIGITAL EQUIPMENT CORP. DISCLAIMS ALL WARRANTIES WITH REGARD 
TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS.   IN NO EVENT 
SHALL DIGITAL EQUIPMENT CORPORATION BE LIABLE FOR ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL 
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN 
ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH 
THE USE OR PERFORMANCE OF THIS SOFTWARE.

Administrator Client, Client, Designer

Independent JPEG Group software information
The Independent JPEG Group's JPEG software
==========================================

README for release 6 of 2-Aug-95
=============================

This distribution contains the sixth public release of the Independent JPEG Group's free JPEG software.  You are 
welcome to redistribute this software and to use it for any purpose, subject to the conditions under LEGAL ISSUES, 
below.

Serious users of this software (particularly those incorporating it into larger programs) should contact IJG at 
jpeg-info@uunet.uu.net to be added to our electronic mailing list.  Mailing list members are notified of updates and 
have a chance to participate in technical discussions, etc.

This software is the work of Tom Lane, Philip Gladstone, Luis Ortiz, Jim Boucher, Lee Crocker, Julian Minguillon, 
George Phillips, Davide Rossi, Ge' Weijers, and other members of the Independent JPEG Group.

IJG is not affiliated with the official ISO JPEG standards committee.

DOCUMENTATION ROADMAP
==========================

This file contains the following sections:

OVERVIEW    General description of JPEG and the IJG software.
LEGAL ISSUES    Copyright, lack of warranty, terms of distribution.
REFERENCES    Where to learn more about JPEG.
ARCHIVE LOCATIONS    Where to find newer versions of this software.
RELATED SOFTWARE    Other stuff you should get.
FILE FORMAT WARS    Software *not* to get.
TO DO    Plans for future IJG releases.

21



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 2 - Things you need to know

Other documentation files in the distribution are:

User documentation:
  install.doc How to configure and install the IJG software.
  usage.doc Usage instructions for cjpeg, djpeg, jpegtran, rdjpgcom, and wrjpgcom.
  *.1 Unix-style man pages for programs (same info as usage.doc).
  wizard.doc Advanced usage instructions for JPEG wizards only.
  change.log Version-to-version change highlights.
Programmer and internal documentation:
  libjpeg.doc How to use the JPEG library in your own programs.
  example.c Sample code for calling the JPEG library.
  structure.doc Overview of the JPEG library's internal structure.
  filelist.doc Road map of IJG files.
  coderules.doc Coding style rules --- please read if you contribute code.

Please read at least the files install.doc and usage.doc.  Useful information can also be found in the JPEG FAQ 
(Frequently Asked Questions) article.  See ARCHIVE LOCATIONS below to find out where to obtain the FAQ article.

If you want to understand how the JPEG code works, we suggest reading one or more of the REFERENCES, then 
looking at the documentation files (in roughly the order listed) before diving into the code.

OVERVIEW
==========

This package contains C software to implement JPEG image compression and decompression.  JPEG (pronounced 
"jay-peg") is a standardized compression method for full-color and gray-scale images.  JPEG is intended for 
compressing "real-world" scenes; line drawings, cartoons and other non-realistic images are not its strong suit.  JPEG 
is lossy, meaning that the output image is not exactly identical to the input image.  Hence you must not use JPEG if 
you have to have identical output bits.  However, on typical photographic images, very good compression levels can be 
obtained with no visible change, and remarkably high compression levels are possible if you can tolerate a low-quality 
image.  For more details, see the references, or just experiment with various compression settings.

This software implements JPEG baseline, extended-sequential, and progressive compression processes.  Provision is 
made for supporting all variants of these processes, although some uncommon parameter settings aren't 
implemented yet.  For legal reasons, we are not distributing code for the arithmetic-coding variants of JPEG; see 
LEGAL ISSUES.  We have made no provision for supporting the hierarchical or lossless processes defined in the 
standard.

We provide a set of library routines for reading and writing JPEG image files, plus two sample applications "cjpeg" and 
"djpeg", which use the library to perform conversion between JPEG and some other popular image file formats.  The 
library is intended to be reused in other applications.

In order to support file conversion and viewing software, we have included considerable functionality beyond the bare 
JPEG coding/decoding capability; for example, the color quantization modules are not strictly part of JPEG decoding, 
but they are essential for output to colormapped file formats or colormapped displays.  These extra functions can be 
compiled out of the library if not required for a particular application.  We have also included "jpegtran", a utility for 
lossless transcoding between different JPEG processes, and "rdjpgcom" and "wrjpgcom", two simple applications for
inserting and extracting textual comments in JFIF files.

The emphasis in designing this software has been on achieving portability and flexibility, while also making it fast 
enough to be useful.  In particular, the software is not intended to be read as a tutorial on JPEG.  (See the 
REFERENCES section for introductory material.)  Rather, it is intended to be reliable, portable, industrial-strength 
code.  We do not claim to have achieved that goal in every aspect of the software, but we strive for it.

We welcome the use of this software as a component of commercial products.  No royalty is required, but we do ask 
for an acknowledgement in product documentation, as described under LEGAL ISSUES.
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LEGAL ISSUES
=============

In plain English:

1. We don't promise that this software works.  (But if you find any bugs, please let us know!)
2. You can use this software for whatever you want.  You don't have to pay us.
3. You may not pretend that you wrote this software.  If you use it in a program, you must acknowledge somewhere in 
your documentation that you've used the IJG code.

In legalese:

The authors make NO WARRANTY or representation, either express or implied, with respect to this software, its 
quality, accuracy, merchantability, or fitness for a particular purpose.  This software is provided "AS IS", and you,
its user, assume the entire risk as to its quality and accuracy.

This software is copyright (C) 1991, 1992, 1993, 1994, 1995, Thomas G. Lane.
All Rights Reserved except as specified below.

Permission is hereby granted to use, copy, modify, and distribute this software (or portions thereof) for any purpose, 
without fee, subject to these conditions:
(1) If any part of the source code for this software is distributed, then this README file must be included, with this 
copyright and no-warranty notice unaltered; and any additions, deletions, or changes to the original files must be 
clearly indicated in accompanying documentation.
(2) If only executable code is distributed, then the accompanying documentation must state that "this software is 
based in part on the work of the Independent JPEG Group".
(3) Permission for use of this software is granted only if the user accepts full responsibility for any undesirable 
consequences; the authors accept NO LIABILITY for damages of any kind.

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified library.  If 
you use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author's name or company name in advertising or publicity relating 
to this software or products derived from it.  This software may be referred to only as "the Independent JPEG Group's
software".

We specifically permit and encourage the use of this software as the basis of commercial products, provided that all 
warranty or liability claims are assumed by the product vendor.

ansi2knr.c is included in this distribution by permission of L. Peter Deutsch, sole proprietor of its copyright holder, 
Aladdin Enterprises of Menlo Park, CA.  ansi2knr.c is NOT covered by the above copyright and conditions, but instead 
by the usual distribution terms of the Free Software Foundation; principally, that you must include source code if you 
redistribute it.  (See the file ansi2knr.c for full details.)  However, since ansi2knr.c is not needed as part of any 
program generated from the IJG code, this does not limit you more than the foregoing paragraphs do.

The configuration script "configure" was produced with GNU Autoconf.  It is copyright by the Free Software Foundation 
but is freely distributable.

It appears that the arithmetic coding option of the JPEG spec is covered by patents owned by IBM, AT&T, and 
Mitsubishi.  Hence arithmetic coding cannot legally be used without obtaining one or more licenses.  For this reason,
support for arithmetic coding has been removed from the free JPEG software. (Since arithmetic coding provides only a 
marginal gain over the unpatented Huffman mode, it is unlikely that very many implementations will support it.)  So 
far as we are aware, there are no patent restrictions on the remaining code.

WARNING: Unisys has begun to enforce their patent on LZW compression against GIF encoders and decoders.  You 
will need a license from Unisys to use the included rdgif.c or wrgif.c files in a commercial or shareware application.  At 
this time, Unisys is not enforcing their patent against freeware, so distribution of this package remains legal.  
However, we intend to remove GIF support from the IJG package as soon as a suitable replacement format becomes 
reasonably popular.

We are required to state that "The Graphics Interchange Format(c) is the Copyright property of CompuServe 
Incorporated.  GIF(sm) is a Service Mark property of CompuServe Incorporated."
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REFERENCES
=============

We highly recommend reading one or more of these references before trying to understand the innards of the JPEG 
software.

The best short technical introduction to the JPEG compression algorithm is
 Wallace, Gregory K.  "The JPEG Still Picture Compression Standard",
 Communications of the ACM, April 1991 (vol. 34 no. 4), pp. 30-44

(Adjacent articles in that issue discuss MPEG motion picture compression, applications of JPEG, and related topics.)  
If you don't have the CACM issue handy, a PostScript file containing a revised version of Wallace's article is available 
at ftp.uu.net, graphics/jpeg/wallace.ps.gz.  The file (actually a preprint for an article that appeared in IEEE Trans. 
Consumer Electronics) omits the sample images that appeared in CACM, but it includes corrections and some added 
material.  Note: the Wallace article is copyright ACM and IEEE, and it may not be used for commercial purposes.

A somewhat less technical, more leisurely introduction to JPEG can be found in "The Data Compression Book" by Mark 
Nelson, published by M&T Books (Redwood City, CA), 1991, ISBN 1-55851-216-0.  This book provides good 
explanations and example C code for a multitude of compression methods including JPEG.  It is an excellent source if 
you are comfortable reading C code but don't know much about data compression in general.  The book's JPEG 
sample code is far from industrial-strength, but when you are ready to look at a full implementation, you've got one 
here...

The best full description of JPEG is the textbook "JPEG Still Image Data Compression Standard" by William B. 
Pennebaker and Joan L. Mitchell, published by Van Nostrand Reinhold, 1993, ISBN 0-442-01272-1.  Price US$59.95, 
638 pp.  The book includes the complete text of the ISO JPEG standards (DIS 10918-1 and draft DIS 10918-2).  This 
is by far the most complete exposition of JPEG in existence, and we highly recommend it.

The JPEG standard itself is not available electronically; you must order a paper copy through ISO.  (Unless you feel a 
need to own a certified official copy, we recommend buying the Pennebaker and Mitchell book instead; it's much
cheaper and includes a great deal of useful explanatory material.)  In the US, copies of the standard may be ordered 
from ANSI Sales at (212) 642-4900, or from Global Engineering Documents at (800) 854-7179.  (ANSI doesn't take
credit card orders, but Global does.)  It's not cheap: as of 1992, ANSI was charging $95 for Part 1 and $47 for Part 2, 
plus 7% shipping/handling.  The standard is divided into two parts, Part 1 being the actual specification, while Part 2 
covers compliance testing methods.  Part 1 is titled "Digital Compression and Coding of Continuous-tone Still Images, 
Part 1: Requirements and guidelines" and has document number ISO/IEC IS 10918-1.  Part 2 is titled "Digital 
Compression and Coding of Continuous-tone Still Images, Part 2: Compliance testing" and has document number 
ISO/IEC IS 10918-2.

Extensions to the original JPEG standard are defined in Part 3, a new ISO document.  Part 3 is undergoing ISO 
balloting and is expected to be approved by the end of 1995.  IJG currently does not support any Part 3 extensions.

The JPEG standard does not specify all details of an interchangeable file format.  For the omitted details we follow the 
"JFIF" conventions, revision 1.02.  A copy of the JFIF spec is available from:

 Literature Department
 C-Cube Microsystems, Inc.
 1778 McCarthy Blvd.
 Milpitas, CA 95035
 phone (408) 944-6300,  fax (408) 944-6314

A PostScript version of this document is available at ftp.uu.net, file graphics/jpeg/jfif.ps.gz.  It can also be obtained by 
e-mail from the C-Cube mail server, netlib@c3.pla.ca.us.  Send the message "send jfif_ps from jpeg" to the server to 
obtain the JFIF document; send the message "help" if you have trouble.

The TIFF 6.0 file format specification can be obtained by FTP from sgi.com (192.48.153.1), file 
graphics/tiff/TIFF6.ps.Z; or you can order a printed copy from Aldus Corp. at (206) 628-6593.  The JPEG 
incorporation scheme found in the TIFF 6.0 spec of 3-June-92 has a number of serious problems.  IJG does not 
recommend use of the TIFF 6.0 design (TIFF Compression tag 6). Instead, we recommend the JPEG design proposed 
by TIFF Technical Note #2 (Compression tag 7).  Copies of this Note can be obtained from sgi.com or from 
ftp.uu.net:/graphics/jpeg/.  It is expected that the next revision of the TIFF spec will replace the 6.0 JPEG design with 
the Note's design.  Although IJG's own code does not support TIFF/JPEG, the free libtiff library uses our library to 
implement TIFF/JPEG per the Note.  libtiff is available from sgi.com:/graphics/tiff/.
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ARCHIVE LOCATIONS
====================
The "official" archive site for this software is ftp.uu.net (Internet address 192.48.96.9).  The most recent released 
version can always be found there in directory graphics/jpeg.  This particular version will be archived as 
graphics/jpeg/jpegsrc.v6.tar.gz.  If you are on the Internet, you can retrieve files from ftp.uu.net by standard 
anonymous FTP.  If you don't have FTP access, UUNET's archives are also available via UUCP; contact 
help@uunet.uu.net for information on retrieving files that way.

Numerous Internet sites maintain copies of the UUNET files; in particular, you can probably find a copy at any site 
that archives comp.sources.misc submissions.  However, only ftp.uu.net is guaranteed to have the latest official 
version.

You can also obtain this software in DOS-compatible "zip" archive format from the SimTel archives 
(ftp.coast.net:/SimTel/msdos/graphics/), or on CompuServe in the GRAPHSUPPORT forum (GO GRAPHSUP), library 
12 "JPEG Tools".  Again, these versions may sometimes lag behind the ftp.uu.net release.

The JPEG FAQ (Frequently Asked Questions) article is a useful source of general information about JPEG.  It is 
updated constantly and therefore is not included in this distribution.  The FAQ is posted every two weeks to Usenet 
newsgroups comp.graphics, news.answers, and other groups.  You can always obtain the latest version from the 
news.answers archive at rtfm.mit.edu.  By FTP, fetch /pub/usenet/news.answers/jpeg-faq/part1 and .../part2.  If you 
don't have FTP, send e-mail to mail-server@rtfm.mit.edu with body

 send usenet/news.answers/jpeg-faq/part1
 send usenet/news.answers/jpeg-faq/part2

RELATED SOFTWARE
====================
Numerous viewing and image manipulation programs now support JPEG.  (Quite a few of them use this library to do 
so.)  The JPEG FAQ described above lists some of the more popular free and shareware viewers, and tells where to
obtain them on Internet.

If you are on a Unix machine, we highly recommend Jef Poskanzer's free PBMPLUS image software, which provides 
many useful operations on PPM-format image files.  In particular, it can convert PPM images to and from a wide
range of other formats.  You can obtain this package by FTP from ftp.x.org (contrib/pbmplus*.tar.Z) or ftp.ee.lbl.gov 
(pbmplus*.tar.Z).  There is also a newer update of this package called NETPBM, available from wuarchive.wustl.edu 
under directory /graphics/graphics/packages/NetPBM/.  Unfortunately PBMPLUS/NETPBM is not nearly as portable 
as the IJG software is; you are likely to have difficulty making it work on any non-Unix machine.

A different free JPEG implementation, written by the PVRG group at Stanford, is available from havefun.stanford.edu in 
directory pub/jpeg.  This program is designed for research and experimentation rather than production use; it is 
slower, harder to use, and less portable than the IJG code, but it is easier to read and modify.  Also, the PVRG code 
supports lossless JPEG, which we do not.

FILE FORMAT WARS
===================
Some JPEG programs produce files that are not compatible with our library.  The root of the problem is that the ISO 
JPEG committee failed to specify a concrete file format.  Some vendors "filled in the blanks" on their own, creating 
proprietary formats that no one else could read.  (For example, none of the early commercial JPEG implementations 
for the Macintosh were able to exchange compressed files.)

The file format we have adopted is called JFIF (see REFERENCES).  This format has been agreed to by a number of 
major commercial JPEG vendors, and it has become the de facto standard.  JFIF is a minimal or "low end" 
representation. We recommend the use of TIFF/JPEG (TIFF revision 6.0 as modified by TIFF Technical Note #2) for 
"high end" applications that need to record a lot of additional data about an image.  TIFF/JPEG is fairly new and not 
yet widely supported, unfortunately.

The upcoming JPEG Part 3 standard defines a file format called SPIFF. SPIFF is interoperable with JFIF, in the sense 
that most JFIF decoders should be able to read the most common variant of SPIFF.  SPIFF has some technical
advantages over JFIF, but its major claim to fame is simply that it is an official standard rather than an informal one.  
At this point it is unclear whether SPIFF will supersede JFIF or whether JFIF will remain the de-facto standard.  IJG 
intends to support SPIFF once the standard is frozen, but we have not decided whether it should become our default 
output format or not. (In any case, our decoder will remain capable of reading JFIF indefinitely.)
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Various proprietary file formats incorporating JPEG compression also exist. We have little or no sympathy for the 
existence of these formats.  Indeed, one of the original reasons for developing this free software was to help
force convergence on common, open format standards for JPEG files.  Don't use a proprietary file format!

TO DO
======
In future versions, we are considering supporting some of the upcoming JPEG Part 3 extensions --- principally, 
variable quantization and the SPIFF file format.

Tuning the software for better behavior at low quality/high compression settings is also of interest.  The current 
method for scaling the quantization tables is known not to be very good at low Q values.

As always, speeding things up is high on our priority list.

Server

Net-SNMP software information

Various copyrights apply to this package, listed in 3 separate parts below.  Please make sure that you read all the 
parts. Up until 2001, the project was based at UC Davis, and the first part covers all code written during this time.  
From 2001 onwards, the project has been based at SourceForge, and Networks Associates Technology, Inc. hold the 
copyright on behalf of the wider Net-SNMP community, covering all derivative work done since then.  An additional 
copyright section has been added as Part 3 below also under a BSD license for the work contributed by Cambridge 
Broadband Ltd. to the project since 2001.

Code has been contributed to this project by many people over the years it has been in development, and a full list of 
contributors can be found in the README file under the THANKS section.

---- Part 1: CMU/UCD copyright notice: (BSD like) -----
Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000
Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is 
hereby granted, provided that the above copyright notice appears in all copies and that both that copyright notice and 
this permission notice appear in supporting documentation, and that the name of CMU and The Regents of the 
University of California not be used in advertising or publicity pertaining to distribution of the software without specific 
written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES WITH REGARD TO THIS 
SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS.  IN NO EVENT SHALL CMU 
OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR 
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR 
IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc

All rights reserved.
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:
 

Redistributions of source code must retain the above copyright notice, this list of conditions and the following l
disclaimer.

 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following l
disclaimer in the documentation and/or other materials provided with the distribution.

 
Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be used to l
endorse or promote products derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)  HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.

All rights reserved.
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:
 

Redistributions of source code must retain the above copyright notice, this list of conditions and the following l
disclaimer.

 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following l
disclaimer in the documentation and/or other materials provided with the distribution.

 
The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from this l
software without specific prior written permission.

 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDER BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Server

PERL public license information

This program is free software; you can redistribute it and/or modify it under the terms of either:

a) the GNU General Public License as published by the Free Software Foundation; either version 1, or (at your 
option) any later version, or

b) the "Artistic License" which comes with this Kit.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied 
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See either the GNU General Public 
License or the Artistic License for more details.

You should have received a copy of the Artistic License with this Kit, in the file named "Artistic".  If not, I'll be glad to 
provide one.

You should also have received a copy of the GNU General Public License along with this program; if not, write to the 
Free Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.
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Administrator Client, Client, Server

S/MIME license information
The Domino S/MIME implementation uses the S/MIME Freeware Library.  The Public License is listed below.

S/MIME FREEWARE LIBRARY (SFL) PUBLIC LICENSE
29 March 2002

The United States Government/Department of Defense/National Security Agency/Office of Network Security 
(collectively "the U.S. Government") hereby grants permission to any person obtaining a copy of the SFL source and 
object files (the "SFL Software") and associated documentation files (the "SFL Documentation"), or any portions thereof, 
to do the following, subject to the following license conditions:

1. You may, free of charge and without additional permission from the U.S. Government, use, copy, modify, sublicense 
and otherwise distribute the SFL Software or components of the SFL Software, with or without modifications developed 
by you and/or by others.

2. You may, free of charge and without additional permission from the U.S. Government, distribute copies of the SFL 
Documentation, with or without modifications developed by you and/or by others, at no charge or at a charge that 
covers the cost of reproducing such copies, provided that this SFL Public License is retained.  

3. Furthermore, if you distribute the SFL Software or parts of the SFL Software, with or without modifications 
developed by you and/or others, then you must either make available the source code to all portions of the SFL 
Software (exclusive of any modifications made by you and/or by others) upon request, or instead you may notify 
anyone requesting the SFL Software source code that it is freely available from the U.S. Government.

4. Transmission of this SFL Public License must accompany whatever portions of the SFL Software you redistribute.  

5. The SFL Software is provided without warranty or guarantee of any nature, express or implied, including without 
limitation the warranties of merchantability and fitness for a particular purpose.

6. The U.S. Government cannot be held liable for any damages either directly or indirectly caused by the use of the 
SFL Software.

7. It is not permitted to copy, sublicense, distribute or transfer any of the SFL Software except as expressly indicated 
herein.  Any attempts to do otherwise will be considered a violation of this License and your rights to the SFL Software 
will be voided. 

The SFL uses the Enhanced SNACC (eSNACC) Abstract Syntax Notation One(ASN.1) C++ Library to ASN.1 encode and 
decode security-related data objects.  The eSNACC ASN.1 C++ Library is covered by the ENHANCED SNACC 
SOFTWARE PUBLIC LICENSE.  None of the GNU public licenses apply to theeSNACC ASN.1 C++ Library.  The eSNACC 
Compiler is not distributed as part of the SFL.  

For further information, contact:
John.Pawling@GetronicsGov.com, Getronics Government Solutions
David Dalkowski, dadalko@missi.ncsc.mil, Department of Defense/V32
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Server

zlib software information
zlib.h -- interface of the 'zlib' general purpose compression library
version 1.1.4, March 11th, 2002

Copyright (C) 1995-2002 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty.  In no event will the authors be held liable 
for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter 
it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If 
you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not 
required.
2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original 
software.
3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly jloup@gzip.org
Mark Adler madler@alumni.caltech.edu

Platforms and requirements

Administrator Client, Client, Designer, Server

R5.0.13 platforms and system requirements
Operating system patches, service packs, and other updates are not specified in the certification tables that follow. 
Consult the Patch Requirements and Environment Variables sections of these Release Notes for system updates that 
should be used with each certified client or server operating system. Also note that operating system vendors 
frequently release updates. For the most recent information regarding updates, see the IBM Lotus Knowledge Base 
online at http://www-3.ibm.com/software/lotus/support/ or contact your local Lotus Support representative.

RAM requirements include the minimum required amounts specified by the operating system vendor.
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Notes, Domino Designer, and Domino Administrator clients

Platform Windows 95/98/
Millennium

Windows 2000/
Windows XP

Macintosh Windows NT

Supported operating 
system versions

Windows 95;
Windows 98;
Millennium Edition

(see "Windows Service 
Packs" Release Note for 
Service Pack information)

Windows 2000 
Professional;
Windows XP 
Professional;
Windows Office XP

Mac OS 7.61; 8.0; 
8.1; 8.5; 8.51; 8.6; & 
9.0

Windows NT 
Workstation 4.0 

(see "Windows Service 
Packs" Release Note for 
Service Pack information)

Processors supported Intel Pentium Intel Pentium PowerPC Intel Pentium

RAM 8 MB minimum

32 MB or more 
recommended

32 MB minimum
 
64 MB or more 
recommended

32 MB physical, 
64 MB virtual 
minimum;

64 MB physical, 
80 MB virtual 
recommended

16 MB minimum

32 MB or more 
recommended

Disk space

The minimum 
amounts are the disk 
space required for 
installing default files. 
More disk space is 
required and if 
databases are 
replicated locally or 
copied locally.

Notes client:
69 MB minimum
112 MB or more 
recommended

Designer client:
70 MB minimum
236 MB or more 
recommended

Administrator client
78 MB minimum
182 MB or more 
recommended

Notes client:
69 MB minimum
112 MB or more 
recommended

Designer client:
70 MB minimum
236 MB or more 
recommended

Administrator client
78 MB minimum
182 MB or more 
recommended

75 MB minimum; 
100 MB or more 
recommended
(standard client)

75 MB minimum; 
150 MB or more 
recommended
(designer client)

Notes client:
69 MB minimum
112 MB or more 
recommended

Designer client:
70 MB minimum
236 MB or more 
recommended

Administrator client
78 MB minimum
182 MB or more 
recommended

Monitors supported Color monitor 
required

Color monitor 
required

Color monitor 
required, 256 colors 
or greater.

Color monitor 
required

Protocols supported

AppleTalk No No Yes No

Banyan VINES
3 No No No No

ISDN No No No No

NetBIOS/NetBEUI Yes Yes No Yes

SPX Yes Yes No Yes

SPX II No Yes No Yes

TCP/IP Yes Yes Yes Yes

X.25 No No No No

X.PC Yes Yes Yes Yes
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Domino server - table one

Platform AIX Windows 95, 98, 
Millennium

Windows 2000 Windows NT  

Supported Operating 
System Versions

AIX 4.3.1; 4.3.2; 4.3.3; 
5.1; 5.2

(see "AIX patch 
requirements" Release 
Note for patch 
information)

Windows 95;
Windows 98;
Millennium Edition

(see "Windows Service 
Packs" Release Note for 
Service Pack 
information)

Server, Advanced 
Server, Datacenter

(see "Windows Service 
Packs" Release Note for 
Service Pack 
information)

Windows NT 
Server 4.0; 
Windows NT 
Workstation 4.0;NT 
Enterprise 
Edition;Windows 95, 
98, and Millennium 
Edition

(see "Windows Service 
Packs" Release Note for 
Service Pack 
information)

Processors supported PowerPC, POWER, 
POWER2, POWER3
RS64 

Intel Pentium Intel Pentium Intel Pentium

SMP support
1 Yes No Yes Yes

RAM 64 MB minimum
128 MB or more 
recommended

128 MB or more 
minimum (256 MB 
recommended)

128 MB or more 
minimum (256 MB 
recommended) 

8

48 MB minimum
96 MB or more 
recommended

Disk space
2 750 MB minimum

1 GB or more 
recommended

2 GB
(with a minimum of 1 
GB free space)

2 GB
(with a minimum of 1 
GB free space)

750 MB minimum
1GB or more 
recommended

Disk swap space 3 times the physical 
RAM recommended 

128 MB 128 MB 64 MB

Monitors supported Color monitor required Color monitor 
required

Color monitor 
required

Color monitor 
required

Protocols supported

AppleTalk No No Yes Yes (with Service Pack 
3 or higher)

Banyan VINES
3 No No No No

ISDN No No No No  

NetBIOS/NetBEUI No Yes Yes Yes

SPX
4 Yes Yes Yes Yes

SPX II Yes Yes Yes Yes

TCP/IP Yes Yes Yes Yes

X.25 No No No No

X.PC Yes Yes Yes Yes
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Domino server - table two

Platform Linux OS/2 HP-UX Solaris
5

Supported Operating 
Systems 

Red Hat 6.0; 6.1; 6.2; 
7.1, 7.2
SuSE 6.3; 6.4; 7.2
TurboLinux 6.0; 6.5
Caldera 2.2; 2.3

(see the "Linux patch 
requirements" and 
"Linux settings" Release 
Notes for more 
information)

OS/2 Warp Server 4; 
OS/2 Warp Server for 
e-business 

(See "OS/2 patch 
requirements" Release 
Note for patch 
information)

HP-UX 11.0; 11i

(see "HP-UX patch 
requirements" Release 
Note for patch 
information)

Solaris 2.6, 7; 8 
                
(see "Solaris patch 
requirements" Release Note 
for patch information)

Processors supported Intel x86 Intel PA-RISC 2.6, 7 Sparc
8 SPARC 

SMP support
 1 Yes Yes Yes Yes

RAM 64 minimum;
128 MB or more 
recommended

48 MB minimum ;
64 MB or more 
recommended

64 MB minimum
128 MB or more 
recommended

64 MB minimum
128 MB or more 
recommended

Disk space
 2 750 MB minimum 

1 GB or more 
recommended

750 MB minimum
6
 ; 

1 GB or more 
recommended

750 MB minimum
1GB or more 
recommended

750 MB minimum
1GB or more 
recommended

Disk swap space 3 times the physical 
RAM installed

16 MB minimum 3 times the physical 
RAM recommended

3 times the physical RAM 
recommended 

Monitors supported Color monitor 
required

Color monitor 
required

Color monitor required Color monitor required

Protocols supported
AppleTalk No No No No

Banyan VINES
3 No No No No

ISDN No No No No

NetBIOS/NetBEUI 
7 No Yes No No

SPX
4 No No No No

SPX II No No No No (Intel)
Yes (SPARC)

TCP/IP Yes Yes Yes Yes

X.25 No No No No

X.PC Yes Yes Yes Yes

IMPORTANT NOTE: Not meeting minimum recommended patch requirements on the operating system that underlies 
Domino Server can cause serious system instability. Be sure to read the patch requirement documents in the Release 
Notes regarding the platforms you use. These platform-specific documents can be found in the Release Notes "Things 
you need to know" chapter.

Domino for AS/400 (iSeries) and S/390 (zSeries) information
For more information about the Domino for AS/400 (iSeries) and S/390 (zSeries) R5 server and system requirements, 
refer to the "AS/400 (iSeries) and S/390 (zSeries) information sources" Release Note.
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Footnotes
1
 SMP (Symmetrical Multiprocessing) support is for SMP-enabled versions of listed operating systems. For details on 
whether a version of an operating system supports SMP, check with the operating system vendor or with your Lotus 
representative.
2
 Disk space requirements include estimated free disk space amounts for a functioning Domino system (that is, one or 
more mail databases and applications). The actual disk space needed to install the Domino files is lower than the 
minimum and recommended values.
3
 Effective with 5.0.9, due to the withdrawal of support from vendors, Lotus no longer supports Banyan VINES, ISDN, 
or X.25.
4
 Domino Clusters and Partitioned server configurations do not support the IPX/SPX protocol.  At this time, Lotus 
does not plan to provide IPX/SPX network support for future releases of these features.
5
 Starting with Release 5.0.4 Solaris 8 is the certified platform when running Domino in 64-bit mode. Please refer to 
the "Solaris for SPARC - platforms supported" Release Note for further details.
6
 The Domino cache directory must reside on an HPFS file system. The cache directory is specified in the Notes Server 
document under the HTTP Server section.
7
 Notes SPX and NetBIOS port driver (Novell NetBIOS) is not certified or supported on an OS/2 Warp server platform.

8
 These are recommended levels of RAM. Microsoft increased the system requirements for Windows 2000 relative to 
Windows NT. Be sure to address these Windows 2000 specific requirements before installing or upgrading Notes and 
Domino.

Administrator Client, Client, Designer, Server

Windows platforms supported
Notes, Domino Designer, and Domino Administrator clients
Beginning in Release 5, Windows 95, Windows 98, and Windows NT 4.0 Workstation (Intel Pentium only) are 
supported platforms for the Notes clients.

Beginning in Release 5.0.3, Windows 2000 Professional is a supported platform for the Notes clients.

Beginning in Release 5.0.6, Windows Millennium Edition (Windows ME) is a supported platform for the Notes clients.

Beginning in Release 5.0.10, Windows XP Professional is a supported platform.

Beginning in Release 5.0.11, Microsoft Office XP is a supported platform in the following areas:

Office Libraryl

OLE Objectl

Active Docl

Drag and Dropl

Word as NotesMail Editorl

Send mail from Officel

Internet integrated browserl

Domino server
Beginning in Release 5, Windows NT 4.0 Workstation and Server (Intel Pentium) are supported platforms for the 
Domino server.  Windows NT Server Enterprise Edition (Intel Pentium) are supported platforms for the Domino server.

Beginning in Release 5, Windows 95 and Windows 98 are supported platforms for the Domino server.

Beginning with Release 5.0.3, Windows 2000 Server is a supported platform for the Domino server. Support for 
Windows 2000 Advanced Server and Windows 2000 Datacenter began with Release 5.0.7.

Beginning with Release 5.0.6, Windows Millennium Edition is a supported platform for the Domino server. Please refer 
to additional documentation in this section of the Release Notes for more information about Windows requirements 
and service packs.

End of life for Domino for Windows NT Alpha support
Domino for Microsoft Windows NT Alpha will no longer be updated starting with 5.0.11.  The last version of Domino for 
Windows NT Alpha is 5.0.10, and no subsequent versions will be developed.  Existing deployments of Domino 5.0.10 
and Domino versions prior to 5.0.10 will continue to be fully supported on Windows NT Alpha.
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Administrator Client, Client, Designer, Server

Windows 2000 system resource guidelines
Beginning in Release 5.0.3, Notes and Domino now support the new Windows 2000 operating system. (Refer to the 
"Windows 2000 now supported for Notes and Domino" document in the Things You Need to Know chapter of these 
Release Notes for more information). 

The minimum system resources for a Windows 2000 server shown below are suggested guidelines. Your requirements 
may be higher than those shown:

Server Guidelines

CPU: 133 Mhz or higher Pentium-compatible
RAM: 128 MB or more minimum 

(256 MB recommended) 
1

Swap file: 128 MB
Hard drive space: 2 GB

(with a minimum of 1 GB free space)

Client Guidelines

CPU: 133 Mhz or higher Pentium-compatible
RAM: (64 MB recommended) 

1

Hard drive space (Notes client): 69 MB or more minimum 
(112 MB recommended)

Hard drive space (Designer client): 70 MB or more minimum 
(236 MB recommended)

Hard drive space (Administrator client): 78 MB or more minimum 
(182 MB recommended)

1

  These are recommended levels of RAM. At the release of Notes and Domino R5.0.3, Microsoft Windows 2000 is a 
newly released operating system. Microsoft has recently increased many of their system requirements for Windows 
2000. Be sure to address these Windows 2000 specific requirements before installing or upgrading Notes and 
Domino.

Administrator Client, Client, Designer, Server

Windows XP Professional system resource guidelines
Beginning in Release 5.0.10, Notes and Domino now support the Windows XP Professional operating system; 
beginning in Release 5.0.11, Office XP is supported.

The minimum system resources for Windows XP shown below are suggested guidelines. Your requirements may be 
higher than those shown:

Client Guidelines

CPU: 233 Mhz or higher Pentium-compatible
RAM: 64 MB minimum

(128 MB recommended) 
1

Hard drive space (Notes client): 69 MB or more minimum 
(112 MB recommended)

Hard drive space (Designer client): 70 MB or more minimum 
(236 MB recommended)

Hard drive space (Administrator client): 78 MB or more minimum 
(182 MB recommended)

1

  These are recommended levels of RAM. At the release of Notes and Domino R5.0.10, Microsoft Windows XP is a 
newly released operating system. Microsoft has recently increased many of their system requirements for Windows XP. 
Be sure to address these Windows XP-specific requirements before installing or upgrading Notes and Domino.
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Administrator Client, Client, Designer, Server

Windows service pack requirements
R5 was initially supported on Windows 95/98 and Windows NT 4.0 with the following Service Packs applied. Although 
individual operating system patches and Service Packs are not certified, Lotus realizes that there are later service 
packs that may become publicly available after testing, and acknowledges that these more recent updates may fix 
additional problems. You may wish to apply these newer service packs as they become available.  You can obtain and 
install the following patches from Microsoft, or download them from http://www.microsoft.com/msdownload/

Windows 95/98: Service Pack 1 and Service Pack 1 Updatesl

Windows NT 4.0 Workstation and Server: Service Pack 4l

Client, Designer

Macintosh PPC platforms supported
MacOS versions 9.0, 8.5.1, 7.6.1, 8.0, 8.1, 8.5 and 8.6 are supported as of R5.0.1a.

Client, Designer

Running Notes in a Macintosh OS 9 multi-user environment
A new feature in Mac OS 9 is the ability to run in multiple-user mode. If a user runs in this mode, the user must log in 
as the system owner to run Notes. Multiple installations of Notes in a multi-user environment is not supported. 

Server

AS/400 (iSeries) and S/390 (zSeries) information sources
For more information about the Domino for AS/400 (iSeries) and S/390 (zSeries) R5 servers and system 
requirements, refer to the following sources of information available on the Domino for AS/400 or S/390 server CD, or 
in the documentation library of the Lotus Developer Domain.

AS/400 (iSeries) information
Domino for AS/400 Release Notes (readas4.nsf, readas4.pdf) l

Domino for AS/400 Help (as400hlp.nsf, as400hlp.pdf)l

Additional information can also be found at http://www-1.ibm.com/servers/eserver/iseries/domino

S/390 (zSeries) information
Domino for S/390 Release Notes (readmes.nsf, readmes.pdf) l

Domino for S/390 Installation Guide (srvs390.nsf, srvs390.pdf)l

OS/390 Console Support for Domino (domcnsl.nsf, domcnsl.pdf)l

Domino for IBM HTTP Server Guide (connector.nsf, connector.pdf)l

 Additional information can be found at http://www-1.ibm.com/servers/eserver/zseries/software/domino

Server

Checkos patch checker utility for UNIX
For UNIX platforms, Checkos is a patch checker utility that starts when you install Domino Release 5 for the first time. 
If you are missing patches for your operating system (OS), Checkos prompts you. If all of the correct patches are 
installed, you are notified with the message, "The OS appears to have the correct patches."  This feature is new in 
Release 5.0 of the Domino server.  See also the UNIX patch requirements in the "Things you need to know" chapter of 
the Release Notes for additional information about patch requirements and specific issues associated with not running 
proper patch levels.

Server

AIX platforms supported
Beginning in R5.0, AIX 4.3.1 and 4.3.2 are supported platforms for the Domino server.

Beginning in R5.0.2, AIX 4.3.3 is a supported platform for Domino servers. Subsequent information about patches 
required for this release will be release noted as the information is made available to Lotus.

Beginning in R5.0.9, AIX 5.1 is a supported platform for Domino servers.

Beginning in R5.0.12, AIX 5.2 is a supported platform for Domino servers 

35



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 2 - Things you need to know

Server

AIX patch requirements

AIX 4.3.1 patches
AIX 4.3.1 was tested with Domino R5 using the patches listed below. Lotus realizes that there are later patches that 
may become publicly available after testing, and acknowledges that these more recent updates may fix additional 
problems. You may wish to apply these newer patches as they become available. You can obtain and install the 
following patches from IBM or download them from IBM's Web site:  http://www.ibm.com

Fix IX85874l

bos.adt.debug 4.3.1.1l

bos.adt.syscalls 4.3.1.1l

bos.rte.bind_cmds 4.3.1.1l

bos.rte.commands 4.3.1.1l

bos.rte.control 4.3.1.1l

bos.rte.cron 4.3.1.1l

bos.rte.install 4.3.1.1l

bos.rte.shell 4.3.1.1l

bos.sysmgt.smit 4.3.1.1l

devices.graphics.com 4.3.1.1l

X11.base.rte 4.3.1.1l

X11.compat.lib. X11R5 4.3.1.1l

xlC.rte 3.6.4.1l

Fix IY01777l

IY06473  (Needed to prevent crashing of server when running NSD).l

AIX 4.3.2 patches
AIX 4.3.2 was tested for the R5 Domino Server, using the patches listed below. Lotus realizes that there are later 
patches that may become publicly available after testing, and acknowledges that these more recent updates may fix 
additional problems. You may wish to apply these newer patches as they become available. You can obtain and install 
the following patches from IBM or download them from IBM's Web site:  http://www.ibm.com.

Fix IX85874l

Fix IY01777l

xlC.rte 3.6.4.1l

IY06473  (Needed to prevent crashing of server when running NSD).l

AIX 4.3.3 patches

AIX 4.3.3 was tested for the R5 Domino Server, using the patches listed below. Lotus realizes that there are later 
patches that may become publicly available after testing, and acknowledges that these more recent updates may fix 
additional problems. You may wish to apply these newer patches as they become available. 

For Domino threadpools to work properly, it is recommended that you run AIX 4.3.3.22 or above. Threadpools do not 
work with AIX 4.3.3.11 through 4.3.3.19. While threadpools do work with AIX 4.3.3.1 through AIX 4.3.3.10, a 
significant AIX security upgrade was included in 4.3.3.13.  It also recommended that you run Domino Release 5.0.3 or 
higher to take full advantage of threadpools. You can obtain and install the following patches from IBM or download 
them from IBM's Web site:  http://www.ibm.com.

IY06473  (Needed to prevent crashing of server when running NSD).l

IY11972  (Prevents a problem where client connections are never released)l

IY17945 (Fixes memory leaks, allows dbx to debug more than 512 threads, and improves performance for libpthreads)l

IY43950  bos.rte.libpthreads  4.3.3.82 APPLIED  libpthreads Libraryl

36



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 2 - Things you need to know

AIX 5.1 patches
AIX 5.1 was tested for the R5 Domino Server, using the patches listed below. Lotus realizes that there are later 
patches that may become publicly available after testing, and acknowledges that these more recent updates may fix 
additional problems. You may wish to apply these newer patches as they become available. 

AIX 5.1

IY21149l

bos.iocp.rte - 5.1.0.11  COMMITTED  I/O Completion Ports APIl

xlC.aix50.rte - 5.0.2.0  COMMITTED  C Set ++ Runtime for AIX 5.0l

bos.rte.libpthreads 5.1.0.52l

IY43951  bos.rte.libpthreads  5.1.0.25  C   F  libpthreads Library l

AIX 5.2

IY43952  bos.rte.libpthreads  5.2.0.15  COMMITTED  libpthreads Libraryl

Server

AIX environment settings
Kernel configurations for IBM AIX servers

Use SMIT to set the following kernel parameters:

Maximum number of processes allowed per user should be a minimum of [128]l

Minimum paging space should be 2 x real memory for systems with less than 512MBl

Maximum number of Licensed Users should be a minimum of [2]l

Generation of a CORE file in the event of a fatal error

If you want the Domino Server to generate a core file in the event of a fatal error, set the following variable in the 
environment of the UNIX account in which the Domino Server operates. This is typically set in the .profile of the UNIX 
account:

DEBUG_ENABLE_CORE=1

Note: The default behavior is to not generate a core file and have the option of running the nsd utility to generate 
information about the fatal error.

Default sizes in etc/security/limits

All default sizes specified in /etc/security/limits should be specified as unlimited (set to -1).

Configure file systems for large file support

For Domino servers on AIX, the file systems must be explicitly configured to support large files (greater than 2GB.) If 
the file system is not configured for large file support, it is possible that a crash could occur on the server if the 
database grows beyond the 2GB limit. A qualified AIX system administrator should configure or verify that  the file 
system supports large files using smit:

System Storage Managementl

File Systemsl

Add/Change/Show Delete File Systemsl

Journaled File Systemsl

Change/Show Characteristics of a Journaled File Systeml

Large File Enabled -> truel

Server

AIX - Installing bos.alt.debug
On AIX versions 4.3.3 and higher, it is possible that bos.adt.debug will not be installed by default.  If this package is 
not installed on your system, then you need to manually install it in order for the nsd program to work.  This package, 
bos.adt.debug, contains the dbx program which is used by nsd to attach to the running processes and provide the 
stacks necessary for debugging problems with Domino.
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Server

AIX - More private memory data space available
The available process memory (for use by Notes/Domino tasks and  API applications) increased in R5.0.9,

The result is that two 256 MB segments are now available for process memory on a per-process basis and two fewer 
segments are available for shared memory by the Notes/Domino application. 

The Notes/Domino binaries map in nine shared memory segments. If your API application maps a different number of 
segments, you will receive the following error message during its initialization:  

"0x01FE:This process [API app name] is unable to map the required amount of shared memory. Please refer to 
the documentation on how to fix this."

This ensures that APIs and add-in tasks are properly aware of the total shared memory space that Notes/Domino has 
available to it. 

To resolve binary inconsistencies we have created a new utility: dataseg. With the dataseg utility you can check and 
change the number of shared memory segments a binary is allowed to allocate. All third-party add-in tasks or 
homegrown APIs must match those in the Notes/Domino distribution.   If upgrading from 5.0.8 or below, this is will 
likely be a required change for customers that use third-party add-in task inclusive of Lotus Brand products such as 
LEI or  Domino.Doc. as well as any home grown APIs.  

       dataseg  *       (checks all apps; you can supply namelist)

       dataseg -s  *  (sets to our default; you can supply namelist )

This will change only 32-bit AIX executables and change only the data segment.

NOTE: Using the -f switch (where you can choose the number of data segments) is NOT recommended. This was 
tested with only two segments (the automatic setting with the -s switch). If you need to run it with more segments, go 
back to the original executable form (by using "-f 0"), or change the executables to the number of segments 
recommended by Support.  Also, generally root authority will be required to change the segments on a binary.  
Partition server customers should have all partitions down when changing the segment number on a set of binaries.

For more information refer to the AIX General Programming Concepts book, the "Large Program Support" chapter 
(keyword: maxdata).

Server

HP-UX platforms supported
Beginning in R5.0.1b, the R5 Domino server for HP-UX is supported on the HP-UX 11.0 operating system.

Beginning in R5.0.9, HP-UX 11i is supported.

Server

HP-UX patch requirements
For Bundle(s):

XSWGR1100 B.11.00.43 HP-UX Extension Pack, December 1998 

Product(s) not contained in a Bundle:

PHCO_24400    for 11i
PHCO_24402    for 11i

PHKL_23226    for 11.0
PHCO_24148    for 11.0
PHCO_23963    for 11.0 

PHCO_17556    1.0     fsck_vxfs(1M) cumulative patch 
PHCO_19491    1.0     libc cumulative patch 

PHKL_18543    1.0 
PM/VM/UFS/async/scsi/io/DMAPI/JFS/perf patch 

PHNE_18221    1.0     ONC cumulative patch 
PHNE_18972    1.0     Cumulative STREAMS Patch 
PHNE_19375    1.0     cumulative ARPA Transport patch

PHCO_17792    1.0     cumulative SAM/ObAM patch 
PHKL_17935    1.0     libpthreads cumulative patch 
PHKL_19169    1.0     correct VxFS process hangs 
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The HP-UX 11.0 patches above are required for correct operation of the R5 Domino server on HP-UX. Specifically, the 
patch provides the gethrtime call to facilitate fast timer functionality. They represent the patches used to initially 
certify Domino R5 on HP-UX.  Lotus realizes additional patches may become publicly available following our 
certification testing, and we acknowledge that new updates may fix additional problems. You may wish to apply such 
operating system patches as they become available. 

Note that the last three patches have been added to the list since the initial patch listing for R5.0.1b. They are linked 
to/dependencies of patches listed in the initial R5.0.1b patch list.

Server

HP-UX settings

Note:  These settings require modifications to SAM to allow some of the parameters to be given values greater than 
those normally allowed by SAM. 

It is strongly recommended that you use the HP-UX system administration utility sam to configure your Notes server 
machine as an OLTP/Database Server machine and then modify settings. To do this:

1.  Bring up sam.

2.  Select and open Kernel Configuration.

3.  Select and run Configurable Parameters.

4.  Choose  Actions->Apply Tuned Parameter Set...

5.  Select "General OLTP/Database Server System" and click "OK".

6.  Select each of the parameters in the following table and:

a. Choose "Actions->Modify Configurable Parameter..." 

b. Be sure the "Specify New Formula/Value" button is selected

c. Enter the "Value" from the table into the "Formula/Value:" text box

d. Click "OK"

Parameter Value
NSTREVENT       50
NSTRPUSH        16
NSTRSCHED       0
STRMSGSZ 65535
aio_max_ops (nkthread)
max_thread_proc (nkthread*8)/10
maxdsiz 0x20000000 
maxfiles 4096
maxfiles_lim 4096
maxtsiz 0x0C000000
ncallout (nkthread)
nflocks (nfile/2)
nkthread ((nproc*8)+16)
shmseg 64

7.  Select Process New Kernel from the Actions menu.
(This rebuilds your kernel resources to handle the requirements of a Notes server).

Heavy client loads, or Notes applications that consume a great deal of kernel resources, may require that parameters 
be set even higher than the recommended values shown above.  Some guidelines for setting particular parameters are 
listed below.  Note that HP supplies a real time monitoring tool called Glance Plus.  Glance Plus is on the HP 
Applications CD and is useful for monitoring the status of these values while the application is running.  If other 
applications are also being used concurrently on the system, please use caution when modifying these values.
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maxfiles and maxfiles_lim: This is the soft (and hard) limit on the number of file descriptors per process.  Large 
numbers of active clients and/or large number of open files may require that this value be increased.  (Note that 
even the recommended value is greater than the maximum value SAM allows by default, and SAM's configuration 
settings must be modified to allow greater values for these to parameters. The release note 'HP-UX - Modify 
maxfiles and maxfiles lim' covers this configuration issue).

nkthread: This is the total number of threads system-wide.  As a general rule Lotus recommends that this number 
be three times the number of concurrent clients the system is intended to host, at minimum.

nfile:  This is the total number of files that can be opened system-wide.  As a general rule Lotus recommends that 
this number be (5 times the number of active domino users + 2048) for the system.

nflocks:  This is the total number of file locks for open files system-wide.  As a general rule Lotus recommends 
that this number be greater than 1/2 the value of nfile (explained above).

nproc:  This is the total number of processes system-wide.  Domino uses threads.  The nproc does not have a 
direct relationship to the number of clients and it should not normally be necessary to increase its value.  Note 
that other parameters are calculated based on nproc, and increasing its value may result in those other 
parameters going out of their allowed range.

ninode: This is the total number of inodes system-wide.  If there is a large number of unique open files, this 
parameter may need to be increased.

maxdsize: This affects the amount of dynamic memory available.  Heavy client loads may require increasing this 
value.

Some additional factors you should keep in mind include:

Increasing the values of some kernel parameters affect the amount of memory used by the kernel.  On small l
memory systems (those close to the min recommend) you might generate a kernel that will not boot, or there 
might not be enough resources left to run the desktop environment. 
Certain parameters have maximum values which SAM checks for.  Also, since some parameter are calculated l
from other parameters, increasing one parameter may cause another to go out of range.
Some parameter are constrained to be related to others in certain ways (such as max_thread_proc <= nkthread).l

Server

HP-UX environment settings
Be sure that your NOTES.INI file includes the following line on HP-UX server systems:

SERVER_IOWAIT_THREADS=18

Server

HP-UX - Modify maxfiles and maxfiles lim
The suggested kernel parameter settings require changing some values to numbers greater than those allowed by 
SAM. The following procedure will modify SAM's configuration to allow a greater maximum value for several kernel 
parameters.

This procedure should be performed as root:

View the file: /usr/sam/lib/kc/params.txl
Look for lines starting with maxfiles and maxfiles_lim.  They should start like this:l

maxfiles:::l
maxfiles_lim:::l

If they start are like this:l
maxfiles:number:numberl
maxfiles:number:numberl

Then...l
delete number (leave the colons)l
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Edit /usr/conf/master.d/core-hpuxl
Locate the following two linesl

*range maxfiles<=numberl
*range maxfiles_lim<=numberl

Change number to 32000l
Run this programl

/usr/sam/lbin/getkinfo -b -wll
Sam will now allow maxfiles and maxfiles_lim to be given values up to numberl

Server

HP-UX - Space swapping
On HP-UX  systems a large number of SYSV shared memory segments cause performance degradations. In R5.0.8, 
the default segment size has been increased to improve system performance. The default size was 12 megabytes and 
is now set to the value of the kernel shmmax (up to 256 megabytes). This will increase the initial swap space used  by 
the new default value. If this is an issue the old default size can be configured by setting the shell variable 
Notes_SHARED_DPOOLSIZE = 12000000.

Server

HP-UX - Shared memory increased
Prior to HP-UX 10.20, the maximum amount of shared memory available to an application was 1.75 GB. This 
limitation is a function of how HP-UX implements a process on (32-bit) PA-RISC architecture. Each process is 
allocated a virtual address space of 4 quadrants, each 1 GB in size for a total of 4 GB. A process is mapped onto 
these four quadrants so that text or code is placed in the first quadrant, global program data is placed in the second, 
with the third and fourth quadrants shared. One quarter or 0.25 GB of the fourth quadrant is used for I/O mapping. 
The size of the shared areas is 1.75 GB. Domino was also dependent on this limitation until release 5.0.9. 

Under HP-UX 11.0, kernel changes where made so that an executable could be marked "SHMEM_MAGIC". Previous 
alternatives were "EXEC_MAGIC" for an executable with write-able code. By linking with the -N option, the data and text 
spaces of an process are combined into a single quadrant and the executable is marked as "EXEC_MAGIC". The kernel 
arranges so that the process marked "EXEC_MAGIC" can be changed via the HP-UX chatr utility  to "SHMEM_MAGIC". A 
"SHMEM_MAGIC" executable can use the second quadrant as a shared area making available 2.75 GB of shared 
memory for applications. 

Starting with Domino 5.0.9, the chatr(1) command may be used to change the Domino executables in the installed 
directory from EXEC_MAGIC to SHMEM_MAGIC and back. The chatr command may also be used to list the existing 
attributes of an executable indicating whether or not it is EXEC_MAGIC or SHMEM_MAGIC. Chatr works by setting bits 
in the executable that are interpreted by HP-UX. 

To increase the amount of shared memory for Domino by 1 GB, (giving 2.7 GB per partition), change the directory to 
the installed location of the executables for Domino and, for each executable file, type the following:

%chatr -M filename

Do not use the chatr command with a wild card such as "chatr -M *" or your executables will be corrupted. An example 
would be as follows: " chatr -M server ". 

CAVEAT: You cannot change this if you have API programs using 5.0.8. 

Server

HP-UX - Server maximum shared memory segments
The maximum shared memory segment size in all versions of Domino R5, up to and including 5.0.9, should not 
exceed the HP-UX system configuration assigned to the shmmax kernel parameter. To ensure that your settings 
comply with this requirement, set the shell environment variable Notes_SHARED_DPOOLSIZE below the value assigned 
to the kernel parameter shmmax. Alternatively, shmmax can be set to a value greater than 256Mb (for those systems 
that have the resources available), which will exceed the default size used by Domino (256Mb). An example setting for 
a system requiring a small shared segment size under 12 Mb would be assigned (using csh) as follows:

setenv Notes_SHARED_DPOOLSIZE  12000000
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Server

Solaris for SPARC - platforms supported
The following versions of Sun Solaris are supported for the Domino server on the SPARC platform.

Solaris version Machine Type Notes supported version
Solaris 2.6 SPARC 5.0 and later

Intel x.86 is no longer supported 
starting with R5.0.11

Solaris 7 SPARC 5.01 and later

Intel x.86 is no longer supported 
starting with R5.0.11

Solaris 8 SPARC 5.04 and later

Server

Solaris patch requirements

Solaris 2.6
Beginning in R5.0.2, the Solaris 2.6 patches below are required for correct operation of the R5 Domino server on 
Solaris.  Lotus realizes that additional patches may become publicly available, and we acknowledge that new updates 
may fix additional problems. You may wish to apply these newer patches as they become available.

You can obtain and install the following patches from Sun Microsystems or download them from Sun's Web site:  
http://www.sun.com

Solaris SPARC

SPARC: 105181-16 Kernel update patch
SPARC: 105490-05 linker patch

Solaris 7
Beginning in R5.0.2, the Solaris 7 patches below are required for correct operation of the R5 Domino server. Lotus 
realizes that additional patches may become publicly available following our initial certification testing, and we 
acknowledge that new updates may fix additional problems. You may wish to apply these newer patches as they 
become available.

Solaris SPARC
SPARC: 106541-05 Kernel update patch

Note about Solaris Patch Listings
These patch recommendations have been updated since the R5 Domino Server for Solaris was originally introduced.

Note: Support for Intel x.86 ended with R5.0.10
Domino for Solaris Intel x.86 will no longer be updated starting with 5.0.11.  The last version of Domino for Solaris 
Intel x.86 is 5.0.10, and no subsequent versions will be developed.  Existing deployments of Domino 5.0.10 and 
Domino versions prior to 5.0.10 will continue to be fully supported on Solaris Intel x.86.

Server

Solaris settings

File Descriptors
If you are running a Domino R5 server on Solaris, you need to have the following parameter in your /etc/system file. If 
this parameter is not present already, add it and reboot the server:

set rlim_fd_max=32768

This will allow for enough file descriptors to run the server.  NOTE:  If you are running any older 3rd party applications 
that use the select() function call, this setting can cause them to malfunction. Such applications may experience 
errors while trying to use the select() call. This can happen if the application sets the soft limit to the hard limit 
and then consumes more than 1024 file descriptors. A workaround to this is to become root user in a shell, change 
the hard limit to 1024, and then su to the user that runs the application.
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Priority Paging
To use priority paging, you need Solaris 2.6 (SPARC) with at least kernel patch 105181-09. 

To enable priority paging, set the following in the file /etc/system:

set priority_paging=1

NOTE: This priority paging recommendation does not apply to servers running Solaris 8, because this version of the 
operating system subsumes the priority paging mechanism in its new file system caching architecture.  Do not set this 
value in /etc/system on Solaris 8 systems.

Fault Recovery - Solaris 2.6 or greater
If you are using the Fault Recovery feature on Solaris 2.6 or greater, you must add the following line to /etc/system 
and reboot:

set msgsys:msginfo_msgtql=1024

This needs to be set on Solaris because Fault Recovery uses message queues. The default for Solaris is 40 messages 
per queue, and Fault Recovery requires more than 40 messages in this queue. This setting increases it from 40 to 
1024.  For additional information, please see "Fault Recovery" in the 'Documentation updates - Administering the 
Domino System' chapter of these release notes.

Update Information: Solaris 7
There are no additional settings for Solaris 7 beyond those described in this Release Note.

Note: Support for Intel x.86 ended with R5.0.10
Domino for Solaris Intel x.86 will no longer be updated starting with 5.0.11.  The last version of Domino for Solaris 
Intel x.86 is 5.0.10, and no subsequent versions will be developed.  Existing deployments of Domino 5.0.10 and 
Domino versions prior to 5.0.10 will continue to be fully supported on Solaris Intel x.86.

Server

Linux platforms supported
Beginning in R5.0.2, the R5 Domino server for Linux is supported on the Red Hat 6.0 distribution. Later versions of 
Red Hat 6.x are also also considered supported. Beginning with R5.0.9, Red Hat 7.1 is supported.

Beginning in R5.0.3, the R5 Domino Server for Linux is supported on the following:

Caldera 2.2 (and later 2.x versions)l

SuSE 6.3 (and later 6.x versions)l

TurboLinux 6.0 (and later 6.x versions)l

Beginning in R5.0.10, Domino supports Suse Linux 7.2 with the 2.4 Linux kernel.

See the Release Note "Linux patch requirements" regarding distribution needs, and for known details about 
appropriate supporting code libraries.

All Domino for Linux software is for use on Intel x86/Pentium-based systems only, unless otherwise noted.

Server

Linux patch requirements
Identifying required patches for Linux is difficult because Linux is distributed as different levels, with different 
packages of an application on each. However, by setting requirements based on kernel and library levels, then 
evaluating each distribution based on this, a set of requirements can be determined.  

By supporting specific distributions, a certain set of patches is guaranteed.  At the lowest level, Linux kernel 2.2.5 or 
greater is required, along with glibc 2.1.1 or greater, and libstdc++ 2.9.0 or greater. Each of the supported/certified 
distributions contains these levels or higher. There is one exception to this rule: the version of glibc/libstdc++ 
installed must contain the libstdc++-libc6 naming convention. If it does not, you must make the appropriate link 
yourself (for example, on Red Hat 6.0, the file is /usr/lib/libstdc++-libc6.1-1.so.2. on Caldera 2.2, this naming 
convention is not used and therefore you must link /usr/lib/libstdc++-libc6.1-1.so.2 to the file 
/usr/lib/libstdc++.so.2.9.0 , which is the appropriate library). A distribution that meets these requirements should be 
able to accommodate the Domino server.
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The upgrade from Red Hat 6.0 to Red Hat 6.1 contains patches to the Linux kernel which allow larger process/thread 
limits and increased file descriptor limits.

Beginning with Release 5.0.9, the Domino server is supported on Red Hat 7.1 and higher, and SuSE 7.2 and higher.  
For Redhat 7.1 and 7.2, you must apply the glibc and gdb errata/bugfixes for these levels which should bring glibc to 
2.2.4-19 and gdb to 5.0.1 or higher.  See the "Linux settings" topic in these Release Notes for additional important 
information about the Linux system you choose to run beneath the Domino server.

Server

Linux settings

Performance of Domino on Linux Systems
Domino benchmarks and workload capacity are significantly affected by the hardware and operating system processes 
that run beneath the Domino Server. This document discusses some known limits of Domino running on Linux (and 
some settings made at the Linux operating system level that can affect those limits). As of R5.0.2, the capacity of 
Domino Servers that run on Linux platforms is still being investigated.  Please see the 'Performance Tuning a Domino 
for Red Hat Linux Server' and 'Performance Tuning a Domino for SuSE Linux Server' topics below.

As additional information about Linux capacity and performance is developed, more documentation will be released in 
the usual Lotus forums.

Linux Services
Most Linux distributions enable services for the following by default: NNTP, SMTP, IMAP, POP3, and HTTP. In order to 
use the versions of these services provided by the Domino server, you must disable the corresponding Linux services. 
For IMAP and POP3, this is most easily done by editing the /etc/inetd.conf file and commenting out the entries for 
pop3 and IMAP. For SMTP, NNTP, and HTTP, you must use the appropriate utility for the given Linux distribution to 
disable these services.

Concurrent Task Limits
Because of limitations in the Linux 2.2.5 kernel, the Domino server cannot accommodate more than approximately 
200 concurrent tasks. A task is roughly defined as one of the following (with a session being a user connection): 

a dbserver session (a user connection to the database server)l

an LDAP sessionl

an IMAP session l

each of the Agent Manager concurrent agents (up to 8)l

each Replica processl

the Routerl

Calconnl

each HTTP threadl

The limitations that affect this are the maximum number of concurrently open file descriptors per user/system and 
the maximum number of processes/threads per user/system. Increasing these limitations will result in the Domino 
server being able to support a larger number of concurrent tasks.

Important Notes about Rebuilding your Kernel
It is true that you can rebuild the Linux kernel and increase the limits discussed in this document. In fact, this is what 
has been done by the operating system developers in the Red Hat 6.1 kernel distribution itself. Very early preliminary 
testing indicates Domino should perform with higher capacity on Red Hat 6.1. However, care should be taken when 
modifying any Linux limits for the following important reasons:

Custom Linux kernels will not be officially supported by Lotus/IBM technical support for the Domino server.l

Increasing the soft/hard limitations of the maximum number of file descriptors can disable various legacy l
applications running on your Linux distribution.

Increasing the soft/hard limitations on the maximum number of processes can result in an unstable kernel due l
to internal tables.

Increasing these limitations results in a larger kernel image in memory which can overload your system’s l
resources. You may be unable to even load the modified Linux kernel.

You must consider and accept all these factors before Linux kernel modification on Domino systems. These factors 
must be considered in addition to the usual caveats that come with customizing the kernel (as noted in the Linux 
kernel documentation).
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File Descriptors
As of the Linux 2.2.5 kernel, the default settings for the maximum number of open file descriptors per user is 1024 
with a system limitation of approximately 3000 total open file descriptors. Red Hat 6.1 has the same default user 
limit; however it also contains code providing for a workaround to increase this number. As root, you can increase the 
values in the running kernel by echoing a larger value into /proc/sys/fs/file-max and /proc/sys/fs/inode-max, keeping 
a 3/1 ratio between the values contained in this file. For example:

$ echo "16384" > /proc/sys/fs/file-max 
$ echo "55296" > /proc/sys/fs/inode-max

...will increase the file-max value to 16K and inode max to 54K resulting in a system wide maximum of 16K open file 
descriptors. Keep in mind this will increase the memory usage of the running kernel. To complete this workaround, 
you must then increase the per user limits to allow usage of these descriptors. One such method is to, as root, use the 
ulimit command to increase the user limit and the su to the user id owning/running the Domino server. For example:

$ su
# ulimit 8192
# su - notesadmin
$ cd /my/notes/data/directory
$ /opt/lotus/bin/server

...will increase the user maximum limit to 8K open file descriptors. (This number must be less than the system-wide 
limit defined above).

Thread/Processes
Because each thread is a light-weight-process (LWP) on Linux, each is curtailed by the maximum number of running 
processes, just like normal processes. This means that a process with 200 threads and 56 processes together total 
256 processes, meeting the standard limitation of 256 processes per user in the 2.2.5 kernel. In the Red Hat 6.1 
distribution, this limitation has been increased to 2000 processes per user, and 3000 system wide.

Examples
Roughly speaking, you can figure that each user for your server uses about three file descriptors and constitutes one 
process for each task that the user is performing. For example, a user accessing his mail file is one thread of the 
dbserver, uses one file descriptor for the network connection, one file descriptor for access to the name and address 
book, and one file descriptor for access to the mail file. These numbers are very hard to quantify because the task can 
greatly change the needs.

As an example, consider a user accessing the Domino server via HTTP.  For each request generated by the browser, 
the user uses a network file descriptor, a thread for the request, a file descriptor for the item being requested, and yet 
more file descriptors are required for authentication. If the browser supports multiple concurrent requests, we can see 
that one user can use quite a few requests (say, four concurrent requests, which would mean four threads and over 12 
file descriptors). With this in mind, we try and approximate the user load as three file descriptors and one thread for 
each task (as noted previously), which gives an idea of how many users a configured Domino server can handle. For 
instance, at 16K file descriptors and 2000 threads, the limitation is the thread count and we see that the server 
should be able to support approximately 2000 tasks using 2000 threads and 6000 file descriptors. However, keep in 
mind that the shells of the user running the Domino server also count, as well as any other processes the user is 
running (X, kvt, kdwm,…).  Therefore, this task count would be less as you definitely do not want to exhaust the user's 
resources.

Server

Linux environment settings
There are presently no variables that must be set on Linux for the operation of the Domino server. See the "Linux 
settings" Release Note for explanations (and caveats) about modifying the Linux environment to increase the Domino 
server capabilities.

Server

Linux DIIOP port setting configuration
Due to system limitations, DIIOP cannot bind to the default ports (63148, 63149). In order to run DIIOP, modify the 
server document for the Linux server on the "Ports" tab in the "IIOP" section. Change the port numbers to settings that 
correspond to any desired unused ports between 1024 and 60999.
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Server

Comments for customers upgrading Beta test Domino Linux code
Some general notes if you are upgrading from a computer that used the Domino for Linux beta test code:

Please review the certification configuration documents throughout Chapter 2 (Things you need to know) in the l
Notes and Domino Release Notes. These documents contain important new information about Linux settings and 
versions that you should consider when deploying Domino on Linux.

If you have indexed databases under beta releases of Domino for Linux, you will need to update the indices of l
your full-text indexed databases for search features to work properly.

Server

Installing Domino for Linux
This guide explains how to install a Domino server on the Linux operating system. Refer to the Release Notes for this 
product and the Domino manual Administering the Domino Server for more details about configuring your server.

System Requirements
The minimum system requirements for a Domino server for Linux installation are:

Processor: 486 or laterl

RAM: 64MB or larger (128MB is recommended) l

Swap file: 3 times the physical RAM or greaterl

Hard drive space: 750MB free space or larger (1GB is recommended)l

Operating system: Linux kernel version 2.2.5. Refer to the "Linux platforms supported" Release Note for l
supported distributions.T

NOTE: You must have selected the following packages during the Red Hat Linux install and setup:

C Developmentl

Development Librariesl

C++ Developmentl

These packages provide the libraries that are required by Domino.

To install Domino for Linux and administer it, it is recommended that you use separate machines for Notes client and 
the Domino Administrator client.  Both machines must run TCP/IP on the same network or on the Internet. You can 
confirm connectivity by pinging each from the other before proceeding.  

NOTE:  You can configure the server using a browser on the same machine, but you will need the Domino 
Administrator or Domino Designer (a Notes client) on a Windows machine if you plan to create new users and server 
IDs or design databases. 

Release notes
See the release notes shipped with this product for the latest information.

Installing more than one server
You can install more than one instance of Domino on a Linux server on separate partitions. Each data directory will 
contain data specific to each server, such as databases, templates, bookmarks, ID files, etc., but all the program files 
reside in a single shared program directory. Each server must use different UNIX user names, to distinguish between 
processes for the different servers. Each user will be made the owner of the files in each data directory and the 
processes run by that server. If the user name is not changed for additional servers, you will not be able to start the 
server, because the operating system will only detect server processes that are not already running for existing user 
names.

Note that many of the steps detailed in this installation must be repeated for each additional server you install.

See Administering the Domino Server to review all your options before you begin.
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Creating a notes user and group
Before you start the installation, you must add a user and group on the Linux machine.

Log onto Linux as "root."1.

Open a terminal session2.

At the command prompt, enter a user name.  For example:3.

adduser notes

This adds a user and group to your system called notes.

Give this new user a password by entering:4.

passwd notes

See "Installing more than one server", if you plan to install more than one server.

Downloading Domino for Linux
Create a temporary directory for the Domino download at the command prompt:1.

cd /tmp
mkdir Domino

NOTE:  Make sure that this space is large enough to accommodate the install file as well as the expanded files for 
the install (at least 20MB).

From a Web browser, open the Notes Web site (http://www.lotus.com/ldd/linux)2.

NOTE: You must be a registered user to download this software. 

Download the tar file into the directory you've just created, (/tmp/Domino).  If you do not have Internet access or 3.
X-window installed on your Linux machine, download the file and then transfer it to the Linux machine using FTP 
or some other tool. 

Change to the correct directory by entering the following at the command prompt:4.

cd Domino

You should now be in the directory /tmp/Domino.  You can verify your current location by entering pwd at the 
command prompt.

Unpack the installation files by entering the following (assuming the tar file is called "linux.tar"):5.

tar xvf linux.tar

Starting the install program

Change to the correct directory by enter the following at the command prompt:1.

cd linux

You should now be in the directory /tmp/Domino/linux.  You can verify your current location by entering pwd at 
the command prompt.

Start the installation by entering:2.

./install

The install program displays a series of screens about the Lotus license agreement.  Use the TAB key to accept a 
setting and advance to the next screen, the ESC key to back up to the previous screen, the space bar to toggle 
through possible choices other than the default, and ENTER to edit a text field.
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Select a setup type.  Choose Domino Mail Server, Domino Application Server, or Domino Enterprise Server and 3.
press TAB.

Select the program file location.   The default is /opt/lotus.  Make sure your have enough space.  The installed 4.
files in the program directory are approximately 51MB. 

NOTE:  If you select a program directory other than /opt/lotus, then a soft link will be created from your program 
directory to /opt/lotus so that commands may be executed from that path.

Indicate if you plan a number of Domino servers on the current physical machine. The default is No.5.

Select the data file location. The default is /local/notesdata. Make sure your have enough space. The installed 6.
files in the data directory are approximately 60MB. 

Select the user and group for this server. Choose the default that you set up earlier ("notes" in the example).7.

The install program displays the settings you selected. Use the TAB key to accept these settings and begin the 8.
installation, or press the ESC key to back up to change any settings. The install program will then begin installing 
the files.

Run the Server Setup program

Log on to Linux as the user you established earlier ("notes" in the example).1.

Change the directory to /local/notesdata by entering:2.

cd /
cd local/notesdata

and then enter the following:

/opt/lotus/bin/http httpsetup

A series of messages indicate the start of the Domino server. For example:3.

02/18/2000 10:49:35 AM  Created new log file as
/local1/6.0_0218_Ent_dom/lotus/notesdata/log.nsf
02/18/2000 10:49:35 AM  
*****************************************
*      Lotus Domino Server Setup        *
* To setup this server, please connect  *
*     your web browser to port 8081     *
* Example: http://this.server.com:8081  *
*****************************************
02/18/2000 10:49:36 AM  JVM: Java Virtual Machine initialized.
02/18/2000 10:49:38 AM  HTTP Web Server started

Continuing setup and configuration

You begin the configuration process by connecting to your Linux server with a Web browser, either from an 1.
external machine, or the Linux machine.

to perform setup from another machine, enter:

http://mycompany.linux.server:8081  

to perform setup from the Linux machine, enter:

http://localhost:8081 

where mycompany.linux.server is either the IP address or DNS name of your Linux server.   At this point, the 
standard Domino configuration screens are displayed in your browser.  Follow the instructions on these screens 
and click the Finish button on the final screen to complete the initial configuration.  Online help is available on 
each of these screens.
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The HTTP Setup program will have created SERVER.ID and CERT.ID files in the  /local/notesdata.   The USER.ID 2.
file is attached to a person document in NAMES.NSF.

Starting the Server
Before starting your Domino server, make sure no other Web server is running because it will block the Domino HTTP 
task from operating correctly and you will be unable to use a Web browser to administer your server after the initial 
setup.  

Log on to Linux as the user you established earlier ("notes" in the example).1.

From the /local/notesdata directory, enter:2.

/opt/lotus/bin/server

The server starts and the usual server console messages appear.

See "Installing more than one server," if you have installed more than one server.

Extracting your administrator ID file
Before you can perform any more administration on your Domino for Linux server, will need to extract the 
administrator ID file and move it to the machine you plan to use for administration. 

After the HTTP Web Server task has started, switch to your administration machine and use a Web browser to 1.
connect to your new server:

http://mycompany.linux.server

Where mycompany.linux.server is either the IP address or DNS name of your Linux server.  The default Lotus 2.
Domino navigator screen displays. 

Now open the address book by entering:3.

http://mycompany.linux.server/names.nsf

Click to the People view and open the Person document for the administrator you created earlier and download 4.
the USER.ID file to your administration machine.

NOTE: If you are using a Netscape browser,  you may have to rename the id file to "USER.ID."

Connecting a Notes Client to the Linux server
Many administration functions can be performed using a Web browser, but you need the Domino Administrator client 
to perform many other tasks such as creating IDs or designing new databases.

Open a Notes Client and switch to the ID you downloaded earlier.1.

Using File - Database - Open, enter the Server name or IP address of the new server and click Open.  After a few 2.
seconds, the Notes client displays the databases available for the new server. 

Server

OS/2 platforms supported
Beginning with the OS/2 platform introduction in R5.0.1a, the Domino server is supported on OS/2 Warp Server 4. 

Beginning in R5.0.2, the Domino server is supported on OS/2 Warp Server for e-business. 

Please refer to additional documentation in this section for more information about OS/2 Warp Server 4 and OS/2 
Warp Server for e-business.
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Server

OS/2 patch requirements
Domino Server for OS/2 has been initially certified on Warp Server 4 using Base Fixpak 39.  Although individual 
operating system patches and fixpaks are not certified, Lotus realizes that there are later patches that may become 
publicly available after testing, and acknowledges that these more recent updates may fix additional problems. You 
may wish to apply these newer patches as they become available.

While not certified, Lotus will support customers running Domino with any valid Base Fixpak for Warp Server 4 beyond 
Fixpack 39, whether it is Entry server, Advanced server, or Advanced server with SMP.

Following are the minimum Fixpak recommendations for a Warp Server Advanced Server running UNI or SMP code.

MPTS fixpak WR08610 is required for UNI or SMP code.

TCPIP fixpak for UNI UN00959 is highly recommended.
TCPIP fixpak for SMP UN00965 is recommended.

Finally, if the server is running OS/2 Warp Server for e-business and the JFS File system, you should apply the JFS 
fixes found on the IBM "PS.SOFTWARE.IBM.COM" web site.

Server

OS/2 install requires HPFS drive
Installing the Domino server software on an OS/2 system requires a High Performance File System (HPFS) volume.  
Some Domino installation file names exceed the 8.3 file naming convention limit present on FAT volumes.

Note:  If your site is using OS/2 Warp Server for e-business, Domino can be installed on a JFS Volume which also 
supports long file names and performs better than HPFS in multi-processor environments.

Administrator Client, Client, Designer, Server

Lotus Notes WAN Drivers - End of Support
We have  updated our position for Lotus Notes WAN Drivers:

Lotus Notes Connect for SNAl

Lotus Notes Connect for X.25l

Lotus Notes Connect for CAPI ISDNl

The Lotus Notes WAN drivers are available via the download section of http://www.lotus.com. 

In general, the WAN driver market has diminished, and is forecast to continue this trend. The number of customers 
using the Lotus Notes WAN drivers supports this claim.

The course of action is to immediately discontinue development of SNA for all releases of Domino/Notes, and 
discontinue development of CAPI ISDN and X.25 for Domino/Notes 4.6.x. Furthermore we will discontinue support of 
these drivers. Details listed below.

The following Lotus Notes WAN Drivers  will be discontinued 2/28/2001,  with support of the WAN drivers to 
discontinue on 2/28/2001.

Connect for X.25 Release 4.x.xl

Connect for CAPI ISDN 4.x.xl

The following Lotus Notes WAN Driver will be discontinued immediately, with support of the WAN Driver to 
discontinue on 12/31/2000.

Connect for SNA Release 4.x.xl

Connect for SNA Release 5.x.xl
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Administrator Client, Client

MAPI support is not offered with Citrix
While Citrix Metaframe XP is a supported platform for Notes beginning in R5.0.12, running MAPI with Citrix and Notes 
is not supported.

Client

Outlook XP not supported
Outlook XP is not supported with 5.013.  Support is provided in the 6.0x product stream.

General certifications and requirements

Client, Designer, Server

Scalability considerations for DNFS deployment
Due to the manner in which Domino Network File Store (DNFS) interfaces with NetBIOS on the NT and Windows 2000 
platforms, there is an inherent limitation of 254 concurrent users accessing DNFS on a single Domino server at one 
time.

Server

Server resource requirements
You should dedicate the server platform for the sole use of the Domino server processes whenever possible. Depending 
on the system's operating system and resources, you may encounter resource constraints when running other 
application processes concurrently with the Domino server processes. Examples involve, but are not limited to:  file 
and print sharing services or other shared resource, tape backup agents, SNA or terminal gateway services, running 
multiple Domino servers (partitioned servers) which are all heavily accessed concurrently. Ensure the platform's 
hardware capacity and scalability meet your requirements.

Administrator Client, Client, Designer

SVGA (800x600) recommended for Notes Client
Although the Notes Client will work with VGA (640x480) screen resolution, it is highly recommended that SVGA 
(800x600) or higher screen resolution be used for best performance.

Server

Browser client must support 800x600 for mail file access
Domino users who are accessing Mail, Calendars and To Do Lists from a web browser must be using a system that 
supports a screen resolution of 800x600 or higher.  Users of older machines with VGA (640x480) screen resolutions 
will not see all the mail file items present in some secondary application windows.

Administrator Client, Client, Designer, Server

Supported Web browsers
The following Web browsers are supported for use with Notes and Domino R5 and above.

Also, see the "Minimum browser support for Domino Java Applets" document in the "Things you need to know" chapter. 
It provides baseline Web browser requirements for using the Domino Applets.

Platform Internet Explorer Netscape Communicator 
5

Notes Native Browser
 4

AIX 4.31 N/A 4.5 N/A

Solaris SPARC 2.6 4.01
1,2

 4.5 N/A

Windows 95/98 4.01 SP1 4.5 Current Release
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Platform Internet Explorer Netscape Communicator 
5

Notes Native Browser
 4

Windows NT 4.0 (Intel) 4.01 SP1 4.5 Current Release

Macintosh PowerPC 8.5.1 4.01
2, 4 4.5 Current Release

HP-UX  11.0 4.01
1,2 4.5 N/A

OS/2 Warp Server 4 N/A 4.04 N/A

1
 Due to design limitations in Java implementation, Internet Explorer does not support Java on UNIX platforms. Please 
note that some Notes Templates and other features that require Java may be affected by this limitation.
2
 The SSL applications (client certificate request/accept) do not work on Internet Explorer 4 for Macintosh or UNIX 
because the feature depends on ActiveX controls that are not available.
3
  The Notes Native Browser does not support remote (CORBA) operation. It locates the local classes first and runs 
locally. 
4
  Webmail is not supported on Macintosh for Internet Explorer 4.01.

5
  Netscape Communicator 4.7 is considered a supported browser on a Red Hat 6.x Linux client in conjunction with 
Domino Release 5.0.8 and above.

Administrator Client, Client, Designer, Server

Web browser support declared for Internet Explorer 5
Lotus Notes and Domino release 5.0.3 and later R5 releases are considered supported with the use of Microsoft 
Internet Explorer 5. Please note that there are display issues with web-enabled Domino templates prior to Release 
5.0.3.

Client, Designer, Server

Minimum browser support for Domino Java applets
The following is the minimum Web browser supported, by platform, as tested with the R5.0.5 Domino Java applets.

NOTE: Internet Explorer is not available on AIX 4.31, and is not supported on Macintosh PowerPC and HP-UX.

Platform ActionBar Applet Editor Applet Outline Applet View Applet

AIX 4.31 Netscape Communicator
4.5

Netscape Communicator
4.5

Netscape Communicator 
4.5

Netscape Communicator 
4.5

Solaris SPARC 
2.6 

1

Netscape Communicator 
4.5

Netscape Communicator 
4.5

Netscape Communicator 
4.5

Netscape Communicator 
4.5

Windows 
95/98 

Internet Explorer 4.01 
SP1; 

Netscape  
Communicator 4.5x & 

4.61
 2

Internet Explorer 4.01 
SP1; 

Netscape  
Communicator 4.5x & 

4.61
 2

Internet Explorer 4.01 
SP1; 

Netscape  
Communicator 4.5x & 

4.61
 2

Internet Explorer 4.01 
SP1; 

Netscape  
Communicator 4.5x & 

4.61
 2

Windows NT 
4.0 (Intel)

Internet Explorer 4.01 
SP1; 

Netscape  
Communicator 4.5x & 

4.61
 2

Internet Explorer 4.01 
SP1; 

Netscape  
Communicator 4.5x & 

4.61
 2

Internet Explorer 4.01 
SP1; 

Netscape  
Communicator 4.5x & 

4.61
 2

Internet Explorer 4.01 
SP1; 

Netscape  
Communicator 4.5x & 

4.61
 2

Windows 2000
 Internet Explorer 5.0; 

Netscape  Communicator 
4.5x & 4.61

 2

Internet Explorer 5.0; 
Netscape  Communicator 

4.5x & 4.61
 2

Internet Explorer 5.0; 
Netscape  Communicator 

4.5x & 4.61
 2

Internet Explorer 5.0; 
Netscape  Communicator 

4.5x & 4.61
 2
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Platform ActionBar Applet Editor Applet Outline Applet View Applet

Macintosh 
PowerPC 8.5.1

Netscape 4.5x Browsers do not support 
this applet so HTML is 

used as a fall back.

Netscape 4.5x Netscape 4.5x

HP-UX  
11.0

 1

Netscape Communicator 
4.5

Netscape Communicator 
4.5

Netscape Communicator 
4.5

Netscape Communicator 
4.5

OS/2 Warp 
Server 4

Netscape Communicator 
4.61 with IBM JDK 1.1.8 

support
 3

Netscape Communicator 
4.61 with IBM JDK 1.1.8 

support
 3

Netscape Communicator 
4.61 with IBM JDK 1.1.8 

support
 3

Netscape Communicator 
4.61 with IBM JDK 1.1.8 

support
 3

1
  Due to design limitations in Java implementation, Internet Explorer does not support Java on UNIX platforms. 
Please note that some Notes Templates and other features that require Java may be affected by this limitation.
2
  Using Netscape 4.6 is not recommended because of a known LiveConnect issue. Specifically, use of the Outline, 
ActionBar, or Editor applets may generate a security exception and eventually cause the browser to hang. Upgrading 
to Netscape 4.61 solves this issue. Also note that Netscape 4.51 does not exhibit this problem. Some Notes 
Templates and other features that require Java may be affected by this limitation.
3 
 When using Netscape Navigator 4.61 for OS/2  you must also install the IBM JDK 1.1.8 for the Domino Java applets 

to work properly.  If the IBM JDK 1.1.8 is not installed then the Domino Java applets will revert back to corresponding 
HTML elements.

Administrator Client, Client, Designer, Server

Java logo testing for Notes and Domino
Sun has created the "Java CompatibleTM" logo for companies developing products with or based on the Java technology. 

The "Java Compatible" logo was designed for Java OEM source licensees who license the Java runtime source code to 
integrate Java into their commercial products. Products bearing this logo have successfully passed the Java 
Compatible Test Suites.

The Java certification, as Lotus/IBM has tested for it, is assurance that the Java Virtual Machines (JVM) shipped with 
Notes and Domino meet the full Sun compliance specs as set out by the Java Compliance Kit. Where Lotus has 
compiled the JVM from source code (on Win32 Intel, AIX, and Solaris), Lotus is required to run and pass the full Java 
Compliance Kit suite. For other JVMs shipped with Notes and Domino that are only repackaged, such JVMs retain 
their original compliance status.

For additional information about Java, please see the following Sun Web sites:

http://java.sun.com/nav/business/licensed-logos.html
http://java.sun.com/

For additional information about Java usage with Notes and Domino, see the online help and any Release Notes that 
discuss Java implementation.
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Administrator Client, Client, Designer, Server

Java certification
Notes and Domino R5 include a Java Virtual Machine (JVM) based on Sun Microsystem's JDK 1.1.6 on the following 
platforms: 

HP-UXl

Notes and Domino R5 include a Java Virtual Machine based on Sun Microsystem's JDK 1.1.8 on the following 
platforms:

Windows 95, 98, 2000 and NT (Intel) (JVM level 1.1.8-8)l

Linux (JVM level 1.1.8-2)l

AIX (JVM level 1.1.8-6)l

OS/2l

Solaris SPARCl

The Lotus Java Virtual Machines pass Sun's official Java compliancy test.

Client, Designer

Java applets not currently supported on Macintosh systems
Please note that Java applet support is not currently available on Macintosh systems.

Designer

Java/Imported Java Agents cannot be created on Macintosh
Java and Imported Java Agents cannot be created on the Macintosh in Notes. This is a known limitation.

Client, Designer, Server

Domino Objects and required JDK compilation levels
When running stand-alone Java applications that access the Domino Objects, Lotus recommends using an 
environment where the Java Development Kit/Java Runtime Environment (JDK/JRE) is at least level 1.1.6. This applies 
whether you are accessing the Domino Objects remotely or locally.

This recommendation applies to any Java program run outside of Notes or Domino, whether from a browser, an IDE 
(such as Visual Cafe or Sun's JDK), or the JVM of a third-party server.

NOTE:  Beginning with R5.0.5, JDK 1.2.x or later may be used to run Java applications that remotely access the 
Domino Objects via Java/CORBA. Prior to R5.0.5, JDK 1.2.x may only be used to run local Java applications on a 
machine where Notes or Domino is installed.

Client, Designer

Lotus Components installation and supportability
The following are requirements and known issues when using the Lotus Components with the Notes Client and Domino 
Designer:

Version 1.2 of Lotus Components is not supported in Notes R5. Version 1.3 of Lotus Components is now l
available and is the officially supported version for Notes R5. For more information on Components 1.3 see the 
web site:
http://esuite.lotus.com/components/components.nsf

All instances of Version 1.2 Components should be updated with the Version 1.3 Component for complete l
compatibility with Notes and Domino R5. Once a component is activated and saved using version 1.3 it is 
updated. After a component is updated you may no longer be able to edit it with a version of components earlier 
then release 1.3.

Be aware that document properties are not supported with multiple controls (components) in a single document.l
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Designer

LotusScript Data Object platforms
The LotusScript Data Object (LS:DO) provides full read and write access to external ODBC data sources using 
LotusScript. The LS:DO consists of a set of three classes -- ODBCConnection, ODBCQuery, ODBCResultSet -- that 
come complete with a powerful set of properties and methods and full SQL capabilities. LS:DO is easy to learn and 
use because its design is consistent with LotusScript's BASIC syntax and other LotusScript Notes classes.

Notes supports LS:DO on the following platforms: OS/2, Windows 3.1, Windows 95, Windows NT, AIX, and SPARC 
Solaris platforms. LS:DO is also on the AS/400 and OS/390 platforms. On these platforms, LS:DO is implemented 
using the native operating system enterprise integration not ODBC. Check the documentation on these platforms for 
detailed installation and implementation.

For information on using LS:DO, see Domino 5 Designer Help or Domino Designer Programming Guide Volume 2: 
LotusScript Classes.

Updates and additional troubleshooting information about LS:DO are available on the Lotus Developer Central Web 
site at http://www.lotus.com/devtools.

Also, please note the following new LS:DO feature:

Connection pooling

Connection Pooling allows a connection to a ODBC data source to be reused. When this feature is enabled, an LS:DO 
connection first checks to see if any connections with the same username and password are available in the 
connection pool. The user does not have to wait for a connection to take place if a connection is available on the pool.

A new NOTES.INI variable, ODBCConnectionPooling, has been added that enables LS:DO for use with the ODBC Driver 
Manager 3.x connection pooling feature. You enable this feature by setting ODBCConnectionPooling=1 on the machine 
where LS:DO is executed. This feature must also be enabled and configured for the ODBC Driver Manager via the 
ODBC Administrator. See the ODBC documentation for further details.

Designer

Mail API service providers support
The Domino Mail API (MAPI) service providers work and have been tested with the following products on Windows NT, 
Windows 95, and Windows 98:

Exchange version 5.0.1458.47l

Outlook 97 version 8.02.4212l

Microsoft Office 97l

Since the providers conform to the MAPI specification, they also work with other MAPI-enabled clients, such as 
Outlook 98, though it has not been fully tested in this environment for this release.

Administrator Client, Client, Designer, Server

Time zone and DST settings
Client settings

Notes time zone and Daylight Saving Time (DST) settings are now synchronized with those of the operating system. 
When you start Notes, the operating system (OS) time zone and DST settings are updated to match those of your 
current Notes location. In previous releases, Notes updated the OS clock, not the time zone/DST settings, causing the 
OS time and time zone to be different. In R5, if you change to a location with a different time zone, or change time 
zones in your current location, the operating system time zone and DST settings are updated to match. Because of 
this, it is important that time zone, DST on/off and Greenwich Mean Time (GMT) are set correctly on your operating 
system. For example, if your operating system is set to "DST off", and you have manually changed your clock to 
account for DST, running Notes causes DST to be turned on in the OS, and the OS clock will be off by one hour.  

Windows 95/98/NT platforms

When you edit your Location document, the list of time zones to pick from now match those of your operating system. 
The DST start and end dates also match those of the operating system. If you change to a location with a different 
time zone, that time zone's DST start and end dates take affect. In addition, if you change the OS time zone or DST 
setting in the control panel while Notes is running, the current location's time zone and DST are updated to match the 
OS.  When upgrading to R5, if any of your Location documents contain a time zone that doesn't match that of the 
operating system, you may be prompted to choose a specific time zone.
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Server

On Windows 95/98/NT platforms, Notes time zone and DST settings are retrieved from the operating system. Server 
settings should match client settings, and servers that replicate should all be set to the same settings. If server 
settings do not match (for example, one server with DST on and one server with DST off), you could get some strange 
behavior with agents that run at a specific time. A symptom of this would be the following message:

08/10/98 03:59:13 PM  AMgr: Time span since last reset of hourly statistics is negative

On non-Windows platforms, the list of time zones to pick from is the same list as in previous Notes releases. 

On Windows platforms, if the OS time zone/DST setting is changed via the control panel while the server is running, it 
will have no effect until the server is restarted.

Client

EasySync
If you install R5 of Lotus Notes with EasySync 2.1 you will not be able to synchronize. You must upgrade to EasySync 
3.0.

Client

Servers supported for IMAP mail clients
The Notes R5 IMAP mail client is supported with the following IMAP4rev1 servers:

Lotus Domino R4.6l

Lotus Domino R5l

IBM Research Server 03010711l

Microsoft Exchange 5.5l

Netscape Messaging Server 3.01l

University of Washington 11.241l

Eudora Worldmail 2.0l

Server

NSF Buffer Pool size limits
The NSF Buffer Pool size in all versions of Domino R5, up to and including 5.0.3, should not exceed 1920MB. To 
ensure that your settings comply with this requirement, do not set the notes.ini variable NSF_BUFFER_POOL_SIZE 
above the value 2013265920 and do not set the Notes.ini variable NSF_BUFFER_POOL_SIZE_MB above the value 
1920.  

In installations with more than 5GB of physical memory, at least one of these two notes.ini variables should be set, 
and the setting should not reserve more than 1920MB.

Server

Notes_SHARED_DPOOLSIZE set automatically
Starting with Domino R5.0.8, the shell variable Notes_SHARED_DPOOLSIZE (shared memory size) for Domino for 
Solaris is set automatically as a default to 8126464 bytes which is 7 3/4 MB (or 8 MB minus 256 KB). There is no 
longer a need to change this manually.  Since many simultaneous accesses to a single shared memory segment can 
cause increased lock contention, so we recommend several smaller (7 3/4 MB) shared memory segments instead of 
fewer large ones.

Server

User name requirements regarding partition servers
The Domino Server has the ability to run multiple servers on the same machine using the same program files. It does 
this in a Partition Server installation. Each Data directory contains data specific to one server, such as databases, 
templates, bookmarks, ID files, etc. The binaries, or program files, reside in the Program directory. A Partition Server 
installation can have multiple Data directories (Servers) using the same program files from a single Program 
directory.
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Domino Server installations on Unix require three pieces of information:

The Program directoryl

The Data directoryl

The Current Unix Userl

The Unix User (or Username) must be a user recognized by the operating system.  This User will be made the owner 
of the files in the Data directory, as well as the owner of the processes run by that server.

The default value for the Unix User and Unix Group values in the Unix Install Interface, is "notes".

When a Partition Server is installed, it must be done using an installation scrip.  This script contains the path to the 
shared Program directory and the paths to each partition servers Data directory.  It also identifies the Unix User and 
Group that will own each server.

The version of the script provided with a Unix (or Linux) installation needs to be edited in order to perform a Partition 
Server install.  The Program directory, Data directory and Username are provided once with these default values:

program_directory  = "/opt/lotus"
data_directory = "/local/notesdata"
data_UNIX_user     = "notes"
data_UNIX_group    = "notes"

In order to install additional servers, this information must be copied and the path to the data directory changed.

Server

User name requirements when installing Domino on UNIX or Linux
The Domino Server installation includes fields for Unix User and Group. These represent the Unix User that will have 
ownership of the installed files in the data directory.

In order to start the Domino Server in R5 (or the httpsetup process), you must be logged in as the user that has 
ownership of the datafiles. The default values given for the Unix User and Group are "notes" (for the user) and "notes" 
(for the group).

To log in as this user (if the default was used during the installation), type this command:

su notes

This will prompt you for the password required to log in as the user "notes".

Note: The user "notes" and the group "notes" must both exist in the Unix system (either locally or on the network) in 
order to log in and be able to run the Domino Server.

Client, Designer

Versions of Lotus SmartSuite supported by Notes clients
The Notes Client and Designer Client support Lotus SmartSuite 96, 97, and SmartSuite 9 (Millennium Edition). If you 
find your SmartSuite applications are running slowly with Notes R5, please see the Release Note, "SmartSuite 
performance issue with Notes R5" in the Troubleshooting chapter.

Client, Designer

Versions of Microsoft Office supported
On Windows 95/98, Windows NT 4.0 and Windows 2000, Lotus Notes and Domino Designer support Microsoft Office 
95, Office 97, and Office 2000 for client interoperability issues.

On the Macintosh, Lotus Notes and Domino Designer support Microsoft Office 4.2.1 for client interoperability issues.

Client, Designer, Server

Webmail 5.0.3 certified for Internet Explorer 5
In Domino Release 5.0.3, the Webmail template was certified to work with Microsoft Internet Explorer 5.0.

For more information, see the "Web browser certifications" and "Minimum Web Browser Requirements for Webmail" 
documents in the "Things you need to know" chapter.
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Client, Designer, Server

Minimum browser requirements for Webmail
The following platforms and browser levels are the minimum requirements for the Webmail template in the current 
Notes/Domino Maintenance Release. 

Platform Internet Explorer Netscape Navigator

AIX 4.31 N/A 4.5

Solaris SPARC 2.6 Unsupported 
1 4.5

Windows 95/98 
2 4.01 SP1 4.5 

3

Windows 2000 
2 5.0 4.5 

3

Windows NT 4.0 (Intel) 
2 4.01 SP1 4.5 

3

Macintosh PowerPC 8.5.1 Unsupported 
4 4.5

HP-UX  11.0 Unsupported 
1 4.5 

OS/2 Warp Server 4 N/A 4.61 with 
IBM JDK 1.1.8 or higher  

5

For more information, see the "Web browser certifications" and "Webmail 5.0.3 certified for IE 5" documents in the 
"Things you need to know" chapter.

1
  Due to design limitations in Java implementation, Internet Explorer does not support Java on UNIX platforms. 

Please note that some Notes Templates and other features that require Java may be affected by this limitation.
2
 The off-line feature of the Extended Webmail template (mail50ex.ntf) is supported on Windows platforms 

only--specifically Windows 95/98/2000 and Windows NT 4.0 Intel.
3
  Using Netscape 4.6 is not recommended because of a known LiveConnect issue. Specifically:  use of the Action Bar 

or Editor applets may generate a security exception and eventually cause the browser to hang. Upgrading to 
Netscape 4.61 solves this issue. Also note that Netscape 4.51 does not exhibit this problem. Some Notes Templates 
and other features that require Java may be affected by this limitation.

4
 Webmail is not supported on the Macintosh for Internet Explorer

5
  If you are using Netscape Navigator for OS/2 4.61, you must also install the IBM JDK 1.1.8 to support the Domino 

Action Bar or Editor applets.  If IBM JDK 1.1.8 is not installed, the Domino Action Bar and Editor applet revert back 
to corresponding HTML elements.

Server

Versions of WebSphere Application Server supported by Domino
Generally, Domino 5.0.5 or later supports all current versions of the WebSphere Application Server: version 2.0, 3.0, 
3.5 and 4.0. 

Please refer to the detailed table below for specific support information on functions supported between Domino and 
WebSphere Application Server.

Function WebSphere versions supported Domino versions supported
Use WebSphere DSAPI plug-in with 
Domino HTTP task

WebSphere 3.02 PTF2
 1

WebSphere 3.5
WebSphere 4.0

Any Domino R5 version, 5.0.5 or later 
recommended

Use Domino LDAP service for 
WebSphere secure authentication

All Domino 5.0.5 or later

Perform single sign-on from a Web 
browser across Domino and 
WebSphere servers

WebSphere 3.5
3

WebSphere 4.0
3

Domino 5.0.5 or later
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Function WebSphere versions supported Domino versions supported
Call local Domino Java methods from 
WebSphere Java code on the same 
server

All Any Domino R5 version, 5.0.5 or later 
recommended

Call remote Domino Java methods 
from WebSphere Java code on a 
remote server

All Domino 5.0.4 or later
 2 

(5.0.5 or later 
recommended)

Call Domino Java methods from 
WebSphere code, passing the new 
Session Token for single sign-on

not supported at this time, to be 
addressed with a future fix to 
WebSphere 3.02 and 3.5

Domino 5.0.5 or later

1
  See WebSphere 3.02 Release Notes for information about the DSAPI plug-in installation.

2
  See Domino 5.0.4 Release Notes for information on the new ncsow.jar file.

3
 Single Sign-On for WebSphere and  Domino was only tested on Windows NT for this release, although other platforms 
are supported.

Administrator Client, Designer, Server

DOLS system requirements

Server System Requirements: 
Domino Server 5.0.12l

Client System Requirements: 
Pentium P133 l
32MB RAM l
100MB free disk space recommended for basic operation l
Additional disk space for each subscription, depending on sizel

Server Operating Systems Supported: 
Windows NT 4.0 (Service Pack 5 or Service Pack 6a)l
Windows 2000 (Service Pack 2)l
OS/2 Warp 4 (Fixpack 14)l
OS/2 Advanced Server 3 (Fixpack 39)l
Solaris  SPARC (Sun OS Version 5.8)l
AIX (Version 4.3.1 and above)l
Microsoft Internet Information Server (IIS) V4.0 with Windows NT Service Pack 5 and Windows 2000l

Client Operating Systems Supported: 
Windows 95 (with Y2K updates)l
Windows 98 l
Windows NT 4.0 (Service Pack 4, 5, or 6a)l
Windows 2000 Professionall

Windows XP Professionall

Browser Requirements: 
Internet Explorer 5.0 and higher recommended (but can use IE 4.0 SP1 or higher)l
Netscape 4.7 and higher recommended (but can use Netscape 4.5x or higher) l

Server

Localized Server Kit (LSK)
This Release Note is for Languages using Localized Server Kit  (LSK).

An LSK contains the following:

International English Domino l

Language Server & Client Templates*l

Language Help Databases*l

* Same set of translated templates currently delivered.
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The following translated files are now included in the LSK for customers who wish to access mail via the web:

C:\LOTUS\DOMINO\DATA\DOMINO\ICONS\SRCHXX.HTM
C:\LOTUS\DOMINO\DATA\DOMINO\ICONS\SCHBXX.HTM
C:\LOTUS\DOMINO\NHTRSXX.DLL
C:\LOTUS\DOMINO\NOTES.JAR
C:\LOTUS\DOMINO\DATA\DOMINO\JAVA\EDITOR_XX.PROPERTIES
C:\LOTUS\DOMINO\DATA\DOMINO\JAVA\VIEW_XX.PROPERTIES

Where C:\LOTUS\DOMINO is the drive and directory where Notes is installed.

Table of Language Denoters:

Language Denoter Language Denoter Language Denoter
German de Danish da Polish pl
French fr Dutch nl Czech cs
Spanish es Norwegian no Hungarian hu
Italian it Swedish sv Russian ru
Portuguese (Brazilian) pt Finnish fi Turkish tr
Slovenian sl Portuguese (Iberian) ip Greek el

To select the required language, do the following:

Open the the Server Document in the Public Address Book.1.

Select Tabs -> Internet Protocols and then Domino Web Engine. 2.

In the the "Character Set Mapping" section,  there is an option "Convert Resource Strings to".  Select the required  3.
Language here.  By default this should be the language of your LSK.

Administrator Client, Server

Lotus Notes as a Performance Monitor Object
In R5.0.9, Lotus Notes no longer appears in the Performance Monitor's Object list when remotely monitoring a 
Domino server running on Windows NT. 

Client

R5 "Welcome Page" users can continue to display AOL Web pages
Notes R5 users who want to continue to have an AOL Web page -- "AOL Anywhere," for example -- displayed in their 
Notes R5 "Welcome Page," will need to follow these simple instructions:

Click the "Welcome" task button to bring up your "Welcome Page." (If the "Options" button does not appear, use the 1.
pull-down menu at the top right of the page, next to the work "Basics," and select "Basics Plus"). 

Click the "Options" button in the top right of your "Welcome Page." 2.

From the "Content" tab, click on the "Welcome Page" from the window on the right which displays AOL"s Web page. 3.

Select the "I want to type in the address" checkbox in the "Web Page" configuration settings. 4.

Type in the desired AOL Web Page URL (i.e., http://my.aol.com/).5.

NOTE: See also the related Release Notes, "Support for "Headlines with AOL My News" ends June 15, 2001" and "Notes 
R5 "Welcome Page" users can switch to another predefined Web page".

Client

Support for "Headlines with AOL My News" ends June 15, 2001
After evaluation and assessment of business priorities, America Online, Inc. (AOL) has decided to redeploy resources 
supporting the "Headlines with AOL My News" for Lotus Notes R5 users specifically. Support will officially end on June 
15, 2001, and subscribers will no longer be able to access this Lotus/AOL-branded news platform after that date.

NOTE: Please see the related Release Notes, "Notes R5 'Welcome Page' users can continue to display AOL Web pages" 
and "Notes R5 'Welcome Page' users can switch to another predefined Web page."
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Client

"Welcome Page" users can switch to another predefined Web page
Notes R5 users who want to switch to another predefined Web page -- "Headlines with My Lycos," for example -- in their 
Notes R5 "Welcome Page," can do so by following these instructions: 

Click the "Welcome" task button to bring up your "Welcome Page." 1.

Click the "Welcome page" pull-down list in the top right of your "Welcome Page." 2.

From the list, choose "Headlines with My Lycos," or "Headlines with UK My Lycos, or "Headlines with Terra."3.
- From the "My Lycos" page, click "Log In" and follow the instructions Lycos provides to register.
- From the "UK My Lycos" page, click "Log In" and follow the instructions Lycos provides to register.
- From the "Terra" page, simply follow the instructions Terra provides.

NOTE: Refer also to the Release Notes "Support for "Headlines with AOL My News" ends June 15, 2001" and "Notes R5 
'Welcome Page' users can continue to display AOL Web pages".

Server

End of life and service for DB2 LSX
The DB2 LSX will no longer ship with Domino starting in Domino 5.0.10.  The DB2 LSX is similar to LS:DO but it offers 
native access to DB2 as opposed to using ODBC with LS:DO.  Its functionality has been replaced by using the Lotus 
Connector for DB2, which provides native access, in conjunction with the Lotus Connector LSX (LC LSX).  For more 
information on the Lotus Connector for DB2 and the Lotus Connector LSX, go to www.lotus.com/ei.  

The End of Life date is 1/31/2002 and the End of Support date is 1/31/2003.  For more information on the 
definitions for End of Life and End of Support, see Technote 157820.

Administrator Client, Client, Designer, Server

End of life for Lotus Notes/Domino R4.6
As previously announced in Technote #184093, there will be no further software updates to Notes/Domino R4.6 as of 
January 31, 2002.  The R4 codestream, first shipped in 1995, has officially End of Lifed (EOL) on that date.  
Engineering resources have shifted focus to the current (R5) and future versions of Notes and Domino.  No options will 
be available to provide any updates or modifications to Notes/Domino R4.x code through any programmatic, 
individual, or pay-per-fix engagements.

While the vast majority of Lotus customers have adopted Notes/Domino R5, Lotus recognizes the need for ongoing 
support of customers still using R4.6.  The following two statements pertain to these customers:

Telephone technical support for Notes/Domino R4.6 continues for at least twelve months beyond the product l
EOL date.  The current scheduled End of Service (EOS) date for Domino/Notes 4.6x is January 31, 2003.

Upgrading directly from Notes/Domino R4.6 to Notes/Domino 6, the next major release of these products l
scheduled for 2002 release, will be supported, as will coexistence of these releases.  However, it is important 
to recognize that upgrade and coexistence between R5 and Notes/Domino 6 will be the most thoroughly 
tested configuration, and customers should consider moving to R5 in the near term to facilitate a smoother 
transition in the future.

Administrator Client, Server

Incremental Install to a partitioned server
When using the Incremental Installer to upgrade a partitioned server, the upgrade will only be made to the first 
partition.  Upgrades to additional partitions must be done by manually copying the upgraded files into those other 
partitions.

Client

Reminder: cc:Mail end of life
As previously announced, Lotus Software will not provide support for cc:Mail after October 31, 2001.

Neither phone support or electronic support (e-support) will be available for cc:Mail. Technical information will 
continue to be available from the Lotus Knowledge Base and on the Lotus Support web site.
Phone support is available for those needing assistance in the migration to Domino. For more information on 
migration, refer to the following resources:

"Quick Step-by-Step Guide on Converting cc:Mail Users to Notes R5" (#187848) l
The Migration home page on the Lotus Web site (www.lotus.com/migration)l
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Network protocols and methods

Client

Citrix MetaFrame support begins with Release 5.0.2
MetaFrame now supported

Citrix MetaFrameTM is a server-based software solution. Windows-based applications are stored on a central Windows 
server, then accessed and executed remotely by workstations that run a variety of operating systems. Starting with 
Notes Release 5.0.2, Lotus supports the use of Citrix MetaFrame software in combination with the Lotus Notes Client. 
Support begins with the following MetaFrame configurations:

MetaFrame 1.8 for Microsoft Windows 2000 Serversl

MetaFrame 1.8 for Microsoft Windows NT 4.0, Terminal Server Editionl

WinFrame releases and earlier Notes releases

Citrix WinFrame® is a product and technology separate from Citrix MetaFrameTM. Lotus does not support any R5 Notes 
client release running on WinFrame systems. Notes R5 releases prior to R5.0.2, even when running on MetaFrame 
systems, are also considered not supported.

Additional information

You can find additional information about Citrix and MetaFrame on the Web at:

http://www.citrix.com

Client

Windows Terminal Server Environment now supported
Lotus Notes Client release 5.0.2 and later R5 releases are considered supported when deployed on Microsoft Windows 
NT Server 4.0, Terminal Server Edition (TSE).

Lotus Notes Client release 5.0.3 and later R5 releases are considered supported when deployed on Microsoft Windows 
2000 Terminal Services (WTS).

Microsoft Windows NT Server, Terminal Server Edition, [version 4.0] gives the Windows NT Server operating system 
the capability to serve the 32-bit Microsoft Windows operating system-based applications to terminals and terminal 
emulators running on PC and non-PC desktops. The Terminal Server environment is, by definition, a thin-client 
architecture where all application processing occurs centrally on the server.

Windows 2000 Terminal Services is a technology that lets you remotely execute applications on a Windows 
2000-based server from a wide range of devices over virtually any type of network connection. With the integration of 
Windows 2000 Terminal Services into the core server operating system, you can choose to deploy the latest 
Windows-based applications in a fully server-centric mode, where applications run entirely on the server.

Server

DNS naming conventions
Newer DNS (Domain Name System) servers no longer support the "_" underscore character, therefore, Lotus 
recommends that you do not name your Domino servers or TCP Host Name with names that contain the "_" 
underscore character. 

In R5, as a migration path to move away from underscores, two DNS lookups occur in the following conditions:

Domino server name contains an underscorel

Target TCP Host Name contains an underscorel

For example, given a Domino server name of hr_1/Acme:

Do a TCP/DNS lookup using hr1.acme.com1.

Do a  TCP/DNS lookup using hr_1.acme.com 2.

Given a Host Name of foo_bar.acme.com:

Do a TCP/DNS lookup using foobar.acme.com1.

Do a TCP/DNS lookup using foo_bar.acme.com2.
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Server

SPX connectivity and AIX ipx.base configuration
Connectivity to UNIX AIX Domino servers over the SPX protocol is limited by the default configuration of the ipx.base. 
The default value results in the failure of Notes clients to connect, with SPX wrapper errors exhibited at the Domino 
server console. 

The default number of connections configured by ipx.base is 100. If your SPX connection requirements are higher, 
modify the settings using the AIX smit (gui) or smitty interface while logged in as the super-user for that server 
machine. Choose the following menu choice:

Communications Applications and Services->
  Novell Network Services 4.1->
    Further Configuration->
      IPX/SPX->
        General IPX/SPX Variables

Locate the field "Maximum SPX Connections" and increase the value (choose an appropriate value above the default of 
100). Apply the changes and exit.

Administrator Client, Client, Designer, Server

Windows 32-bit TCP/IP stacks
The following Windows TCP/IP 32-bit stacks have been tested:

On-Net  Kernel v4.0 for Windows 95 and Windows 98 from NetManage, Inc  l

Windows 95 from Microsoft Corporationl

Windows 98 from Microsoft Corporation l

Windows NT 4.0  from Microsoft Corporationl

Client

Windows RAS Dial-back
Dial-back connections will only work reliably when the standard Windows 95/98 DUN services are installed and used.  
The Windows95 Plus! RAS (remote access server) service must be disabled on a Windows 95/98 machine making a 
connection to a server using Dial-back.

If a RAS connection is attempted in Notes under Windows 95/98 using Dial-back, after attempting the connection for 
the first time, Windows may continually tell Notes that the port is still in use during each additional attempt to 
connect. Only phonebook entries that have been attempted using Dial-back while the Windows 95 RAS server is 
running remain in this "in-use" state. The only way to free this phonebook entry to use it again is to reboot the 
computer.  

The Windows 95 RAS server is only avaliable in the Windows 95 Plus! software package.

Server

Only 200 concurrent sessions allowed on Linux using X.PC
The maximum number of sessions possible using X.PC on the Linux platform is 200. If you try to execute more than 
200 X.PC sessions, the server will crash.

Administrator Client, Client, Designer, Server

Lotus Notes WAN Drivers - End of Support
We have  updated our position for Lotus Notes WAN Drivers:

Lotus Notes Connect for SNAl

Lotus Notes Connect for X.25l

Lotus Notes Connect for CAPI ISDNl

The Lotus Notes WAN drivers are available via the download section of http://www.lotus.com. 

In general, the WAN driver market has diminished, and is forecast to continue this trend. The number of customers 
using the Lotus Notes WAN drivers supports this claim.
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The course of action is to immediately discontinue development of SNA for all releases of Domino/Notes, and 
discontinue development of CAPI ISDN and X.25 for Domino/Notes 4.6.x. Furthermore we will discontinue support of 
these drivers. Details listed below.

The following Lotus Notes WAN Drivers  will be discontinued 2/28/2001,  with support of the WAN drivers to 
discontinue on 2/28/2001

Connect for X.25 Release 4.x.xl

Connect for CAPI ISDN 4.x.xl

The following Lotus Notes WAN Driver will be discontinued immediately, with support of the WAN Driver to 
discontinue on 12/31/2000

Connect for SNA Release 4.x.xl

Connect for SNA Release 5.x.xl

International language requirements

Administrator Client, Client, Designer

Bi-directional (BiDi) Language support
In order to use bi-directional languages (for example, Arabic or Hebrew), perform the following steps:

Install the R5 client on a BiDi (bi-directional) Windows platform (Arabic or Hebrew, Enabled or Localized)1.

Run the client to finish setup and verify that everything is working.2.

Turn on BiDi support by adding the following line to your NOTES.INI file:3.

EnableBiDiNotes=1

Hebrew users who want to force all equations to flow from left to right should also add:4.

EnableHebrewEquations=1

These settings will be enabled by default in Arabic and Hebrew localized versions of Notes.

Additional BiDi relevant settings may be selected by choosing File->Preferences->User Preferences and then selecting 
International.

Bi-directional language issues 

Previous releases of Notes did not support BiDi; however, some users may have R4.x databases with documents l
containing BiDi text. When such documents are edited using Notes R5, the BiDi text is converted to the 
R5-supported format.  Once converted, Notes R4.x cannot read any BiDi text in these documents.

Also, if you use Notes R5 to create or edit a document containing BiDi text then this text is not visible to an R4.x 
client.  Furthermore, if you use a R4.x client to edit such an R5 document, then the BiDi text is lost.

You can design views with the most significant column on the right. However, quick search always acts on the l
leftmost column. You may want to create a hidden leftmost column containing appropriate data for quick search.

Outline flow is from left to right and the bitmap is always to the left of the text.l

We recommend that you use English only in domain names, organization names, ID file names, mail file names l
and passwords.

To send faxes containing Arabic or Hebrew text, the server must be running on a BiDi-enabled Windows 95/98/NT l
platform.

When running on Arabic or Hebrew Windows, the NOTES.INI setting EnableBiDiNotes=1 is required to correctly l
display setup dialogs.
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Excel spreadsheet data is imported into Notes with left-to-right reading order and table direction.l

When exporting a Notes document to RTF format, the reading order of the first paragraph is left-to-right. You may l
want to start such documents with a carriage return.

Notes tables with right-to-left reading order are exported to RTF format with left-to-right reading order.l

Import and export do not handle the following characters : &rlm, &lrm, &zwj, &zwnj.l

The reading order of field help and database synopsis is always left-to-right.l

Alphabetical bullets always use English letters.l

Find/Replace works from left-to-right across BiDi tables.l

When creating hotspots containing bilingual text, include all of the minor language string in the hotspot.l

When determining reading order of strings in the search bar editor, any text in the gray highlighted area is treated l
as part of the whole line.

In right-to-left tabbed tables, you must enter text into the second tab before you can enter text into the rightmost l
tab.

When changing tabs or cell widths in a scrolled right-to-left paragraph, use the Properties box rather than clicking l
on the ruler.

The No Wrap alignment does not work with right-to-left reading order.l

Using F11 to change text style does not work for BiDi text.l

The marked area cannot be predicted if you change the reading order of marked mixed text. The same happens l
with undo.

Hebrew specific issues

When EnableHebrewEquations=1 is set:

Equations should be written without spacesl

Trailing periods always appear to the left of numbersl

Editing in Native OS controls is not affected (display of equations, currencies, dates is determined by the l
operating system).

MIME Mail received in visual reading order can be read by selecting the encoding to be Hebrew (8859-8 Visual).  In 
some cases measurements appear as inches regardless of the setting in the International Settings Dialog. This will 
work as expected after changing the setting.

Client, Designer

International input and display on Macintosh clients
The Lotus Notes client can automatically accept input and display text in one of the following non-English languages 
(if the version of Macintosh appropriate for that language is being run):

Danishl

Dutchl

Finnishl

Frenchl

Germanl

Italianl

Japanesel

Norwegianl

Portuguesel

Spanishl

Swedishl

Languages not listed above are not supported in Notes for the Macintosh.  Notes may not launch when the Macintosh 
system language is set to something other than the languages listed above. Please set the system language to English 
(or one of the languages listed above) in order to run Notes.
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Client, Designer

Windows - Euro symbol support
In order to display and use the euro symbol, you must down load the necessary feature updates from the Microsoft 
Web site (http://www.microsoft.com).

If you are running Windows 95, you need to download and install the feature update for Microsoft euro currency 
support.  

If you are running Windows NT 4.0, you need to download and install the NT 4.0 euro product update or Windows NT 
Service Pack 4.

If you are running Windows 98, support for euro currency symbol is enabled without any additional updates.

For details on which fonts are updated, please refer to Microsoft Web site.

Client, Server

Internet messaging and character set support
As part of the native MIME support in R5, the Notes client detects the most appropriate character set for sending a 
message to the Internet. All the regions listed below are supported.

In addition to the character set support on the client, the R5 Domino Router provides conversion between Notes Rich 
Text and MIME (for backward compatibility). With respect to international, the Router supports all of the regions listed 
below. Where previously with the SMTP MTA multiple MTAs were required to provide complete character set support 
to a WW organization, now only a single R5 Domino Server is required. This extensive character set support is enabled 
by default when a server has been configured to support SMTP.

The language groups and the associated default character sets are:

Language Groups Character Set

English US-ASCII

Unicode UTF-8

Japanese ISO-2022-JP

Simplified Chinese GB2312

Korea ISO2022-KR

Traditional Chinese BIG5

Thai Windows-874

Western ISO-8859-1

Central European ISO-8859-2

Baltic Rim Windows-1257

Cyrillic KOI8-R

Arabic Windows-1256

Greek Windows-1253

Hebrew Windows-1255

Turkish Windows-1254

Vietnamese Windows-1258

This support is provided in all language versions of the product including International English.
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Where changes are required to the default settings, these can be made on the client in the Personal Address Book in 
International MIME Settings and on the server in the Domino Directory in Server Configuration - MIME Settings. The 
settings that can be configured include inbound and outbound options for character set, encodings and font.

Designer

ISO currency symbol for the Euro updated in R5 Gold builds
The ISO currency symbol for the Euro character has been corrected in the R5 Gold builds. In earlier Beta releases of 
R5 the proposed ISO symbol "XEU" was used. In the final build, this has been corrected to "EUR" which is the approved 
ISO three-letter currency symbol.

If you created a currency field using a Beta release of R5 that used the three letter ISO currency symbol for the Euro, 
that field continues to use the old "XEU" symbol instead of the "EUR" symbol until you resave the form containing the 
field.

Note that you do not have to resave the form if you were using the euro symbol instead of the ISO three letter symbol. 

Also note that the three letter "country code" used for the Euro has been changed to EMU (European Monetary Union) 
instead of the originally proposed XEU. This change is for clarity only; it has no impact on the use of the currency 
symbol.

Client, Designer

Japanese and Chinese yen symbols appear the same
Due to a Unicode system limitation, the Japanese and Chinese yen symbols appear the same. This is true for Windows 
98, Windows 95 and Windows NT.

Client

JIS X 0212-1990 support
R5 supports JIS X 0212-1990 Kanji Characters for Japanese with the following requirements and caveats:

Windows NT 4.0 with Service Pack 4l

You can use JIS X 0212-1990 characters on Windows 98, but you can not input the characters into dialog boxes. l
That is a limitation of Windows 98, not Notes.

Windows 95 does not support JIS X 0212-1990l

Some old IME (ATOK11/WXG etc.) do not support JIS X 0212-1990.l

Please make sure that Unicode Display is enabled in your user preferences.

Server

Setting collation on the Domino server
By default, the Domino server uses the operating system settings to determine locale information. This locale 
information is used to determine the collation used by the Indexer for sorting views on the Domino server. 

Administrators can change the settings by altering NOTES.INI values. It is possible to run the Domino server on with 
an operating system set for in one locale (for example, en-US, for US English) and have Domino use a different 
collation setting for sorting (for example, ru for Russian.)

Specify the following settings in the NOTES.INI on the server, using values from the Collation and Character Set tables 
below:

COUNTRY_LANGUAGE= xx (or xx-yy)
PLATFORM_CSID= nnnnnnn
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Collation table

CollationName Code

Albanian sq-al

Arabic ar

Baltic lv

Catalan ca

Croatian hr

Cyrillic ru

Czech cs

Danish/Norwegian da

Dutch nl

Estonian et-ee

Finnish fi

French fr

French (Canada) fr-CA

German de

Greek el

Hebrew he

Hungarian hu

Icelandic is-is

Italian it

Japanese ja

Korean ko

Latin1 en

Latin2 pl

Lithuanian lt

Nordic no

Polish pl-pl

Portuguese pt

Romanian ro

Simplified Chinese zh-cn

Slovak sk

Slovenian sl-si

Spanish (Modern) e2-es

Spanish (Traditional) es
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CollationName Code

Swedish sv

Thai th

Traditional Chinese zh-tw

Turkish tr

Vietnamese vi

Character Set table

Language Win95/WinNT UNIX

English 52 20

French Canadian 52 20

German  52 20

French  52 20

Italian  52 20

Spanish  52 20

Brazil. Portuguese  52 20

Dutch  52 20

Norwegian  52 20

Swedish  52 20

Danish  52 20

Finnish  52 20

Czech  50 21

Hungarian  50 21

Polish  50 21

Russian  51 24

Lithuanian  57 23

Turkish  54 22

Japanese  12 12

Simplified Chinese  1B 1B

Korean  18 18

Thai  90 90

Traditional Chinese  1A 1A
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Language Win95/WinNT UNIX

Arabic 56 25

Greek 53 26

Hebrew 55 27

Albanian 50 21

Byelorussian 51 24

Bulgarian 51 24

Catalan 52 20

Croatian 50 21

Estonian 57 23

Latvian 57 23

Macedonian 51 24

Romanian 50 21

Serbian (Cyr) 51 24

Serbian (Latin) 50 27

Slovak 50 21

Slovenian 50 21

Ukrainian 51 24

Vietnamese CEE D04

Server

OS/2 Domino server setting for Baltic langauges

The "Country" and "Keyboard" setting in "Locale" in the OS/2 "system configuration" must be set to "US" for Baltic rim 
languages.

The administrator needs to set a language in the NOTES.INI file for the Domino locale setting.  Specify the following 
settings in the NOTES.INI on the server, using values from the Collation and Character Set tables below:

COUNTRY_LANGUAGE= xx (or xx-yy)
PLATFORM_CSID= nnnnnnn

Language COUNTRY_LANGUAGE PLATFORM_CSID

Estonian et-ee 57

Latvia lv 57

Lithuanian lt 57
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Administrator Client, Client, Designer

Indic Language support
Indic scripts (Devanagari and Tamil) have been supported in 5.0.3.
This information is for users who are using Indic languages (Hindi, Konkani, Marathi and Tamil) in English or 
International English Notes.

Platform : Windows 2000 platform (Indic enabled) 1.

Indic Display setting : You have to enable Unicode Display to display Indic characters.2.

Select "Enable Unicode Display" in File->Preference->User Preference->Basic->Additional options.

You can use the following setting to turn on Indic support for Full Text Search in the NOTES.INI file:3.

FT_LIBNAME=nftgtr34.dll
FT_ALTERNATE_FILTER=naltfltr.dll
FT_USE_KV_CHARSET=1

Indic Transliteration : Indic transliteration is activated by the F12 key. You can use the following setting to turn on 4.
Indic support for Transliteration in the NOTES.INI file:

IndicTransliteration=1
IndicXlitScript=<script>

IndicXlitScript variable is optional. 
If not specified, the default support scripts are Devanagari and Tamil.
Available scripts are Roman, Devanagari and Tamil.
Use comma as delimiter between scripts.

You can use the following setting to force all number formatting to a 3;2;0 digit grouping (eg. 12,34,56,789.00) 5.
in the NOTES.INI file:

IndicDigitGrouping=1

Web Publishing6.

For web publishing of Indic characters, it is advisable to use UTF-8 encoding. So, if a browser is used to view the 
web pages, the browser needs to support decoding of UTF-8.

Messaging7.

For outbound messages, we recommend encoding using UTF-8. For inbound messages, we have provided an ISCII 
option in mime setting in server document, to allow character conversion ISCII to LMBCS.

Additional Indic relevant settings may be selected by choosing File->Preferences->User Preferences.8.

Notes Regional Setting (Hindi, Marathi, Konkani, Tamil)
Notes Sorting Setting
Unicode display option and Notes Font Setting
Notes Dictionary Setting (English (United Kingdom))
Notes Import/Export Characters

Indic language issues 

When importing an ISCII file, for the purpose of UNICODE conversion, only plain text is imported.  The basic l
display attribute such as BLD (Bold), ITA (Italic), UL (Underline), etc are ignored.  The numerals are converted to 
the selected script.  In addition, Devanagari script is assumed if an ISCII file to be imported doesn't have script 
attribute. 

We recommend that you use English only in domain names, organization names, ID file names, mail file names l
and passwords.
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Unicode Domain Search, Full Text Search and Summarizer have some problems handling Tamil script.l

Current character iteration is based on syllabic boundaries for both Devanagari and Tamil scripts.l

In Windows 2000, under Indic locale, all Java related features will be disabled.  These Java related options will l
always be disabled, even when user chooses to enable them.  For non-Indic locales in Windows 2000, Notes will 
fully support all Java features enabled by the user's settings.

Web Mail contains Java Applet. Due to the problem with JVM, we are unable to support this application when the l
locale is set to any of the Indic languages.

Web Admin is supported in English only.l

Server

Setting up Domino on Linux for non 'C' locales
The Linux glibc 2.1 has a bug that causes setlocale() to fail for many locales.

Workaround
In the NOTES.INI file set the following:

PLATFORM_CSID=hhh  

where hhh is a hex number that represents the codepage from the following list:

Code Codepage
0040 37
0CA5 256
0CA6 259
0041 273
0CA7 274
0CA8 275
004C 277
0042 278
0043 280
0CA9 281
0CAA 282
0044 284
0045 285
0046 290
0047 297
0CAB 361
0CAD 382
0CAE 383
0CAF 384
0CB0 385
0CB1 386
0CB2 387
0CB3 388
0CB4 389
0CB5 390
0CB6 391
0CB7 392
0CB8 393
0CB9 394
0CBA 395
0CBB 423
0CBC 424
0008 437
0048 500
0CE0 737
0CE1 775
0CBD 803
0026 813
0020 819
0009 850
0001 851
0002 852
0003 853
000A 855
0C00 856
0004 857
000B 860
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000C 861
0005 862
000D 863
0006 864
000E 865
0007 866
000F 869
0CBE 870
0CBF 871
0010 874
0CC0 875
0CC1 880
0013 891
0011 899
0CC2 905
0021 912
0024 915
0027 916
0028 920
0057 921
0049 930
004A 931
0012 932/934
0CCA 935
001B 937
0CC5 938
004B 939
0012 932/944
0CC4 948
0018 KS /* Windows Shift-KSC 5601 */
001A 1002
0CA1 1003
0C01 1004
0025 1008
0CA2 1025
0CA3 1026
0CA4 1028
004D 1047
00A0 1200
0050 1250
0051 1251
0052 1252
0053 1253
0054 1254
0055 1255
0056 1256
0057 1257
0CEE 1258
0CC8 1381
001B 1383
001B 1386

For example:

PLATFORM_CSID=CA5

would set Notes to use Code Page 256

This will force Domino to run in the desired locale no matter what the value of the LANG environment variable.

To specify date order etc....

dateorder=DMY
or
dateorder=YMD
or
dateorder=MDY
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You can also set

dateseparator=any char
and 
timesepartor=any char

Create a symbolic link for the desired locale to the C locale. For example:

ln -s desiredlang_desiredcountry   C

Administrator Client, Client

Downloading iNotes for international versions of Outlook
Users with international versions of Outlook need to check that their Windows locale is matched to their language 
version of Outlook before attempting to download iNotes Access for Outlook.

Special Note - Iberian Portuguese Outlook 98 users
Open your mail file over the Internet (servername/mail/mailfile.nsf), select "Go Offline", and choose "Iberian". Then, 
continue to the iNotes Access for Outlook download page (servername/mail/mailfile.nsf/iNotes).

Special Note - Dutch Outlook 98 users
After downloading iNotes Access for Outlook, delete the file "nmstrings.dll" in the Program Files\Lotus iNotes 
directory, and then rename the file "nmstrings98.dll" to "nmstrings.dll". This should be done before 
Outlook is launched.

Special Note - Japanese Outlook 98 users
After downloading iNotes Access for Outlook, delete the file "nmstrings.dll" in the Program Files\Lotus iNotes 
directory, and then rename the file "nmstrings98.dll" to "nmstrings.dll". This should be done before 
Outlook is launched.

Administrator Client, Client, Designer, Server

Settings for GB18030 support
Supported platforms
The Notes Client must be run on a platform that supports GB18030. Microsoft provides the GB18030 support 
package for the Windows 2000 and the Windows XP. Please refer to the Microsoft website for details about Windows 
add-on packages for the GB18030 support. The Windows XP support package is bundled with the Simplified Chinese 
version of the Windows XP.

Microsoft does not have a plan to support GB18030 for Windows 95, 98, Millennium or NT4. Mac OS does not support 
GB18030. 

The Domino server does not depend on an OS for supporting GB18030, so all platforms for the Domino server are 
supported.

Supported Notes/Domino versions
Notes/Domino is a world-wide single code based products, so GB18030 is supported in any language version of 
Notes/Domino including Global English version in 5.0.10. 

Settings for Input/Display GB18030 characters
A GB18030 support package for Windows installs a font for GB18030. Users must specify that font to display l
GB18030 characters. Notes uses the Windows system font to display characters in Notes. If Windows system font 
is not set to a GB18030 font, GB18030 characters may not be displayed.

Enabled Unicode Display must be set ON in the Notes User Preferences. l

Microsoft GB18030 support package provides the IME to input GB18030. Users must use that IME to input l
GB18030 characters. Please refer to the Microsoft User Assistance about the GB18030 support IME.

Unicode UTF8 must be set for Web Publishing and Internet messaging
The GB18030 is not the official encoding for Internet standard yet, so please set UTF-8 for Internet settings.
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Security

Administrator Client, Client, Designer, Server

US export regulation changes and their effects
The following FAQ provides a high-level overview of recent changes to US export regulations and how these changes 
affect Lotus and its customers, particularly with the first "Global" release of Lotus Notes and Domino, release 5.0.4. 
Note that this information also applies to release 5.0.5.

What are the new regulations?
On January 15, 2000 the U.S. Government relaxed export restrictions on the worldwide shipment of strong encryption 
(defined as 128 bit support). Software eligible for US export is classified into one of two categories: "Non-Retail" 
software can be shipped worldwide, except to foreign governments, and "Retail" can be shipped worldwide to any 
customer, including foreign governments. 

In order to attain a Retail status for release 5.0.4, the first "Global" release, US export regulations require a one time 
application, review and approval process prior to shipment to international governments and their agencies. Lotus has 
received this status. The US Government granted Lotus non-Retail and Retail status for Lotus Notes and Domino R4 
and R5, Lotus QuickPlace 1.x and Lotus Sametime 1.x. 

What impact will this have for Lotus?
The implication to Lotus and its customers is that worldwide shipment of stronger encryption is now permitted. 
Customers will no longer be required to order and choose between 6 kits (North American, North American Canadian 
French, International English, International English for France , French for France, and French) of different 
cryptographic strength. Notes/Domino release 5.0.4 meets this new strong encryption standard. 

Any R4 or R5 North American Edition is immediately available to commercial, individual and foreign government 
customers worldwide (retail status, which Lotus has obtained, makes it possible to ship to foreign governments), with 
the exception of the seven prohibited countries. (Currently, the seven prohibited countries are Cuba, Iran, Iraq, Libya, 
North Korea, Sudan, and Syria).

These regulations pertain only to export from the United States. For other countries with import regulations, 
customers will need to check the requirements of the specific country. While Lotus takes all steps to ensure 
acquiescence with governmental encryption regulations worldwide, Lotus recommends that customers familiarize 
themselves with local encryption regulations to remain in compliance.

What does this mean to an existing administration scheme?
From the customer perspective, there is:

A higher level of security on both Notes and web protocols for international companiesl
The ability for a company to purchase one kit and deploy it worldwidel
A reduction in time to administer, deploy and trainl

Are Lotus Notes and Domino users able to retain their current international ID?
As long as the new software is installed, Lotus Notes users can keep their existing International ID. The new software 
will automatically allow the use of stronger encryption.

Browser users can keep their existing key ring, but users must follow the manufacturer's recommendations for 
upgrading the browser to stronger encryption.  

How will interoperability work with older releases?
Lotus Notes users as well as Domino servers which have been upgraded to release 5.0.4 can authenticate and 
continue day-to-day operations securely with clients and servers running on earlier releases of software.

What if a company decides to remain at a release prior to the stronger release?
International customers who choose to continue using weaker encryption can remain at 5.0.3 (or earlier) or 4.6.7 (or 
earlier). Should they decide to upgrade only a portion of the clients and servers, they will still interoperate with older 
releases.
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Why hasn't the "Register New User" Dialog changed?
There are several reasons why Lotus has elected to preserve the dialog:

Given that Administrators use the North American or International distinction for administration purposes, l
few changes were made to the Graphical User Interface (GUI). The dialog still presents a choice between 
North American and International.
Countries have their own import rules. By preserving this distinction it will allow Lotus to respond to specific l
country changes if required.

How can I identify the new release?
Choose File - Tools - User ID. The description for "Software" should be "Global." 

Why not change R4.X?
The R5 family and beyond is the strategic direction for Lotus Notes and Domino.  Lotus has no plans for additional 
Maintenance Releases post R4.5.7 and R4.6.7 code streams; only Maintenance Updates (MUs) are planned for these 
respective releases. Lotus Notes and Domino release plans for Q1 and Q2 2000 are availabe at 
http://www.lotus.com/ldd.

How long will Lotus support prior releases of R5.x international after release 5.0.4?
Lotus will provide support for all R5.x international releases, regardless of the encryption scheme, until Lotus publicly 
issues an End of Life (EOL) statement outlining plans to end support for a release.

What happens if an international customer interested in stronger encryption purchases North American software 
outside the US?
Today, North American software may be used worldwide, but users utilizing international IDs will automatically 
negotiate down to a lower level of encryption. The only way to use the higher level encryption prior to release 5.0.4 is 
to use the North American release and to create a North American ID. This is now allowed by U.S. law.

What strength encryption does Lotus Notes and Domino support with release 5.0.4?
Anything over 512 bit RSA key and 56 bit symmetric key is considered strong encryption and was previously not 
allowed for export. With the availability of release 5.0.4, the Notes client and Domino will support 1024 bit RSA key 
and 128 bit symmetric key for S/MIME and SSL. The Notes proprietary protocols will use a 630 bit key for key 
exchange, and a 64 bit symmetric key.

Summary of Keys and Encryption for release 5.0.4
1024 bit RSA key in the web protocols (SSL and S/MIME)
128 bit encryption (SSL and S/MIME)
630 bit RSA key for Notes protocols *
64 bit encryption in the Notes protocols (mail, doc encryption, session encryption, etc)

* For International IDs, 630 bit encryption will be used for port encryption. International ID encryption for Notes Mail 
will remain at the 512 bit encryption strength for R5.0.4. Plans call for international ID mail encryption to achieve 630 
bit strength in a future R5 release.

How do I migrate to stronger crypto?
When you upgrade to release 5.0.4, stronger cryptography will be used without a requirement to reissue existing IDs. 
These changes are seamless to users as well as administrators.  When two different versions of  software are 
communicating, the encryption negotiation will result in a step-down to the weaker level. Therefore, the full benefits of 
stronger encryption will only be realized when all software has been upgraded to the release 5.0.4 level. However, any 
mixed versions of the software will interoperate.

If users are accessing Domino from a Web client, in order to take advantage of stronger crypto, customers need to 
install release 5.0.4 on the Domino server and obtain a browser capable of strong encryption. Even using a 512 bit key 
ring, Domino Servers running release 5.0.4 will negotiate strong session encryption (ie, 128 bit RC4 or TripleDES). 
However, to take best advantage of the relaxation of regulations, customers should obtain a new 1024 bit key pair for 
their Domino server. For third party browsers, follow the manufacturer's recommendations for upgrading to stronger 
encryption.
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Administrator Client, Client

Should I register a North American or International ID?
If your organization's clients and servers are all running release 5.0.4 (or later), it makes no difference whether you 
create North American or International IDs. Both types of ID will work the same way. *

However, if your organization has clients or servers running earlier releases (prior to 5.0.4) of Notes and Domino, 
continue creating the same types of IDs you created with the earlier versions. International versions of earlier releases 
don't allow users to switch to North American IDs, so when registering new international users, you shouldn't create 
only North American IDs. Similarly, North American versions of earlier releases use weaker cryptography when running 
with International IDs, so you shouldn't  create only International IDs. 

The best strategy for deciding between North American and International IDs is to continue using the decision process 
that was in place for earlier releases of Notes and Domino. Eventually, as you upgrade the clients and servers running 
earlier releases to 5.0.4 (or later), the decision will not matter.

* For International IDs, 630 bit encryption will be used for port encryption. International ID encryption for Notes Mail 
will remain at the 512 bit encryption strength for R5.0.4. Plans call for international ID mail encryption to achieve 630 
bit strength in a future R5 release.

Administrator Client, Client

Administering SSL applications on a Mac client
The following templates are not supported on a MAC client:

CCA50.NTFl

CSRV50.NTFl

You must use a W32 Notes client in order to administer the SSL applications.

Server

Federal Information Processing Standard 140-1 crypto standard
The Domino server is not currently certified to the Federal Information Processing Standard (FIPS) 140-1 
cryptography standard.

Client, Server

Known issues and considerations regarding ECLs
Below are some known issues and caveats you should consider when using Execution Control Lists. These issues are 
current as of R5.0.5. For more generalized information about configuration, see the Release Notes document 
"Recommendations for deploying tighter ECLs."

Known issue:  SPR# JTHN4DFNUW

An Execution Security Alert is presented when executing a script with NotesEmbeddedObject.New.

There is an issue when using "Create Object From Template" to embed another application object within Notes. If you 
use the "Create Object From Template" option and choose, for instance, Microsoft Word with update macro, you will 
eventually receive an Execution Security Alert:

Action: NotesEmbeddedObject.New
Signed by: -No Signature- 
Not allowed: Access to external programs

Known issue:  SPR# HUR4DDPJL

Execution Control Lists do not support groups.  

When adding ECL entries to your personal security options by selecting File, User Preferences, Security Options and 
choosing Add, the dialog box for Add User implies you can add a Person, Server or Group. This is not the case. If you 
choose to Add group(s), they are not applied and have never been supported. The dialog box in this context is in error, 
and at this time there are no plans for supporting groups.
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Known issue:  SPR# VMAA4CWQ4E

Auto-launching a file attachment generates the Execution Security Alert:

Signed by: -No Signature- 

There is a known Execution Security Alert when a file is attached to either the "Help About" document or a form, and 
then the launch option for the database is set to "Launch first attachment in About Document" or "Auto-launch first 
attachment on form" (respectively).

Known issue:  SPR# LDEY4CZQTL

An Execution Security Alert occurs when editing a form marked as "Available to Public Access Users":

Signed by: -No Signature-

There is a known Execution Security Alert when a form marked as "Available to Public Access Users" is edited and 
saved. If the same form is edited and saved a second time, the correct signature is associated with the form and its 
elements, and the Execution Security Alert "Signed by: -No Signature-" is then suppressed.

Administrator Client, Client, Server

Default ECL entries as of R5.0.3
Beginning in R5.0.3, the following entries will appear in a default Execution Control List (ECL). A default ECL is 
generated when a new ECL is created and there is no other default, either because it's a new administration ECL or 
because it's a disconnected client.

Signature Applies to Default access options

-Default- Formulas and code that contain a signature, but the 
signature does not match any entry on the ECL

For example, if the signer is John Andrews/Atlas, the ECL 
uses the -Default- signature type to assign access,  although 
the database contains a signature, it does not match any 
entry in the ECL.

None

-No Signature- Formulas and code that do not contain a signature. 
Unsigned formulas and code should be considered a 
malicious security threat.

For example,  if the signer contains an invalid or unavailable 
signature, the ECL matches -No Signature-. 

None

Lotus Notes Template 
Development / Lotus Notes

Every template shipped with Domino contains this signature

The signer matches this type only if it has the Lotus Notes 
Template Development / Lotus Notes signature.  

All 

BT Mail and Calendar 
Migration Tools/Lotus 
Notes Companion Products

Every template related to Binary Tree Mail and Calendar 
Migration Tools.

If your organization isn't using this tool, you can remove this 
entry from the ECL.

Access to file system, 
Access to current 
database, Access to 
environment variables, 
Access to external code, 
Ability to read other 
databases, Ability to 
modify other databases

Lotus Fax 
Development/Lotus Notes 
Companion Products

Every template related to Lotus Fax for Domino.

If your organization isn't using this tool, you can remove this 
entry from the ECL.

Access to current 
database, Access to 
environment variables, 
Ability to read other 
databases, Ability to 
modify other databases

Sametime 
Development/Lotus Notes 
Companion Products

Every template related to Sametime.

If your organization isn't using this tool, you can remove this 
entry from the ECL.

All except Access to 
workstation security ECL
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Client

Recommendations for deploying tighter ECLs
Notes' and Domino's first line of defense against virus attacks is the Execution Control List (ECL). The best way to 
protect your organization is to deploy and maintain tighter workstation ECLs. To deploy tighter ECLs, your goal is to 
limit who your trusted signers are. To get to that goal, however, you could ask all your users to turn off all accesses, 
and encourage them to think about whether it makes sense to give the signer the requested access for every signature 
dialog they see. This could be a tedious and error-prone task. The procedure described here can streamline this 
process.

Unless your organization has taken some other proactive steps, such as limiting the number of trustworthy signers 
and ensuring that clients' ECLs only trust those signers, the first step is to take a close look at your current ECLs. If 
you already tightly control who has access, there is no need to follow this procedure. If, however, your ECLs seem too 
wide open, you should follow this procedure and use it as a starting point for managing and maintaining tighter ECLs. 
This  procedure describes how to create a reasonable administration ECL and how to roll out the ECL. It also provides 
suggestions for maintaining ECLs. You can use this process to create as secure an environment as possible in the 
shortest amount of time.

There are five sections in this Release Note that cover recommendations for creating tighter ECLs:

Collect information for an Administration ECLl

Create the Administration ECLl

Rolling out the new Administration ECLl

Maintaining ECLsl

Other considerationsl

Collecting information for an Administration ECL
Before you can create an ECL that you can distribute enterprise-wide, you need to identify what people and/or 
organizations you can trust. Identify a small number of users (perhaps 2-5) who use a broad range of typical Notes 
applications, then have them complete these steps.

1.  Remove all entries from the workstation ECL EXCEPT the following:

All entries in the form */org, where org  is a local domain/organization.l
-Default-l
-No signature-l
Lotus Notes Template Development/Lotus Notesl

NOTE: You might also want to keep any identities used to sign applications that you know you use  -- for example, 
Sametime or Lotus Fax.

 
To do this, highlight the item to remove under "When signed by," then click Remove.

Note: If any of these entries are not listed in the ECLs that are being edited, it means that those entries are not 
needed. There is no need to add them to the ECL.

2.  Record the entries removed so that if those entries were in fact not needed, they can be added with "no access" 
later in the admin ECL.

3.  Make these changes to the remaining entities in the ECL:

For  "When signed by" For "Allowed"
*/org, where org  is a local 
domain/organization

Deselect any selected items. "Default" should have no 
permissions.

-Default- Deselect any selected items. "Default" should have no 
permissions.

-No signature- Deselect any selected items. "Default" should have no 
permissions.

Lotus Notes Template Development/
Lotus Notes

Select all items. This entity should have all 
permissions.
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4. For a designated time period (a week should be sufficient), when the "Execution Security Alert" dialog box appears, 
click "Trust signer," with the following exceptions:

Do not trust any actions with "-No Signature-"l

Check with the security administrator before trusting any odd or unfamiliar signatures, or before clicking l
"Execute once" for templates or applications signed with odd or unfamiliar signatures.

Note: Users running an earlier release of the Notes client (prior to Release 5.0.2) should answer "No" to the dialog 
that asks if you want to trust everybody in the organization of the user whose signature you are about to trust. 

The resulting ECLs for these two users should be significantly larger than what they started with, unless your 
organization has managed the signing process up front and only uses objects signed by a small number of known 
trustworthy signers. 

Creating the Administration ECL
After the designated time period is complete, the security administrator should use the information in the resulting 
ECLs to create an updated Administration ECL. The new ECL should be a union of the users' ECLs. 

1. From the Domino Directory, choose Actions->Edit Administration ECL.

2. Using the information from the two users' ECLs, make changes to the Administration ECL. 

Be sure to add entries to the ECL even if you want to take permissions away from a person, group, or domain. This 
allows you to overwrite existing entries in users' ECLs and essentially undo any trust users have granted. Use the 
list of entries your test users removed that did not reappear in their "final" ECLs (see step 2 under "Collecting 
information for an Administration ACL," above). Add those entries, but do not assign any permissions.

NOTE: Using this method of updating and distributing the ECL, you can't remove entries from individual users' ECLs. 
You can, however, overwrite entries so that those entries have the correct permissions and essentially undo the 
permissions previously granted. For example, if there is a particular person that should not have any permissions, you 
can add that person to the administration ECL with no permissions. Then when the updated ECL is distributed, if that 
person was originally granted some permissions in any users' ECLs, the updated Administration ECL will overwrite the 
users' ECLs with the updated permissions.

Rolling out the new Administration ECL
After the Administration ECL has been updated, you must distribute those changes to all users.

For releases 5.0.4 and earlier

1.   Make sure the Domino Directory with the ECL changes has replicated throughout the domain.

2. Address a memo to users whose ECLs you want to update.

3. Add a button to the memo that executes this formula:

@RefreshECL (server : database ; name)

Where server : database is a text list that specifies the server location and file name of the 
Notes/Domino directory (NAMES.NSF) that you want to refresh the Administration ECL from; and 
name is text that specifies the name of the ECL. Specify "" (null) for the unnamed ECL. For 
example, for the unnamed ECL located in NAMES.NSF on the server SERVER1, the @RefreshECL 
formula would look like this:

@RefreshECL("server1":"names.nsf";"")

For more information on this @function, see Application Development with Domino Designer.

Note: For MIME-enabled users who lose their active content in mail messages, add the button to a document 
in a particular Notes database and tell those users to go there to update their ECLs.

4. Describe the purpose of the memo and instruct users to click the button.

5. Mail the memo.

For release 5.0.5

1.   Make sure the Domino Directory with the ECL changes has replicated throughout the domain.

2. Address a memo to users whose ECLs you want to update.
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3.   Describe the purpose of the memo and instruct the users to do the following:

Choose File->Preferences->User Preferences.l

Click Security Preferences.l

Click Refresh.l

Click OK.l

4.  Mail the memo.

Maintaining ECLs
Users might still encounter the "Execution Security Alert" dialog box after the updated ECL is deployed. Make sure that 
users:

Do not trust any actions with "-No Signature-"l

Check with the security administrator before trusting any odd or unfamiliar signatures, or before clicking l
"Execute once" for templates or applications signed with odd or unfamiliar signatures. The security administrator 
should investigate those signatures, and if necessary, update and redistribute the administration ECL.

Other considerations
You can create a separate organizational unit specifically for users who must sign templates and applications. Then 
create an ID in that organizational unit for each of those users. Users who create templates and applications should 
only use the ids issued through the new organizational unit when signing their templates and applications. The 
administrative ECL can then trust any user in that special organizational unit, or it can be fine-tuned on a per-user 
basis, as explained the steps above.

Administrator Client, Client, Server

How ECLs respond to changes in the Notes/Domino environment
Execution Control Lists (ECLs) were introduced in Notes/Domino versions 4.5. You use an ECL to set up workstation 
data security. An ECL limits the actions of formulas and scripts when they run on a workstation. For example, an ECL 
can prevent another person's code from running on a computer and damaging or erasing data. As the administrator, 
you can allow users to modify their ECL, or you can control changes to the ECL.

In versions of 5.0.2 and later of Domino/Notes, the client default ECL settings were changed to help strengthen the 
security that ECLs offer. If you're planning to upgrade clients from version 4.5 or later to versions 5.0.2 or later, or if 
you're just planning to install a new client, the table below should help clarify how ECLs respond to changes in the 
Notes/Domino environment. 

Notes: 
In the table below, the "Results when there is no Admin ECL" applies under either of the following two l
circumstances:

The user is disconnected (that is, there is no server connectivity).1.
The  server the user is connecting to does not have an Administration (Admin) ECL. When a server is initially 2.
installed, it does not have an  Admin ECL. An Admin ECL becomes available after someone makes a 
modification to it -- for example, when an administrator views the Admin ECL using the user interface, and 
adds an entry. 

For a list of client default ECL settings by version of Notes and Domino, see the table titled "Client default ECL l
settings" at the end of this Release Note.

Action Results when there is no Admin ECL Results when there is a home server 
with an Admin ECL

"Allow user to modify" button is not 
selected in the Admin ECL, and the 
workstation ECL is being updated via 
an install or refresh.

Not applicable The workstation ECL is updated with 
the server's Admin ECL.
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Action Results when there is no Admin ECL Results when there is a home server 
with an Admin ECL

Install a new client ECL defaults are assigned based on  
version of the client that you install. 
The user's name is automatically 
added to the ECL if there was no ECL 
in the user's desktop. 

The server's Admin ECL overwrites the 
client default ECL. The resulting ECL 
has entries from the client default ECL 
in addition to new entries from the 
server Admin ECL. The privileges in 
the Admin ECL overwrite the privileges 
of the same entry in the client default 
ECL. The user's name is automatically 
entered in the ECL because there is no 
existing workstation ECL.

For a list of client default ECL settings 
by version of Notes and Domino, see 
the table titled "Client default ECL 
settings" at the end of this release 
note.

View server Admin ECL If the server is available, you see the 
client's default settings. However, if 
the server isn't available, you can't 
view the server Admin ECL.

You see the server Admin ECL. 

Upgrade any client version 4.5 or later 
to a newer version of the client where 
a workstation ECL already exists in the 
desktop and the ECLSetup NOTES.INI 
setting is unchanged and set to its 
default, 3.

The workstation ECL maintains its 
original settings from before it was 
upgraded.

The workstation ECL maintains its 
original settings from before it was 
upgraded.

Upgrade a client running a version 
prior to 4.5 and having no desktop (or 
ECL) to version 4.5 or higher.

-or-

Start a client running version 4.5 or 
later with no desktop 

The workstation ECL takes on the 
default workstation ECL settings. The 
user's name is automatically added to 
the ECL.

The server's Admin ECL overwrites the 
client default ECL. The resulting ECL 
has entries from the client default ECL 
in addition to new entries from the 
server Admin ECL. The privileges in 
the Admin ECL overwrite the privileges 
of the same entry in the client default 
ECL. The user's name is automatically 
entered in the ECL because there is no 
existing workstation ECL.

For a list of client default ECL settings 
by version of Notes and Domino, see 
the table titled "Client default ECL 
settings" at the end of this release 
note.

Upgrade a client from and to a version 
after 4.5 where the NOTES.INI setting 
for ECLSetup is less than the target 
client default of 3, or ECLSetup does 
not appear in the NOTES.INI file.

-or-

Start a client version 4.5  or later  
where the NOTES.INI setting for 
ECLSetup is less than the target client 
default of 3, or ECLSetup does not 
appear in the NOTES.INI file.

The client default ECL overwrites the 
current workstation ECL. The resulting 
workstation ECL contains entries from 
the default settings that were not 
already in the existing workstation 
ECL. In addition, if  there's an entry 
that appears in both the default 
workstation ECL and the existing 
workstation ECL, the privileges in the 
client default ECL overwrite the 
privileges of the same entry in the 
existing workstation ECL.

The server's Admin ECL overwrites the 
current workstation ECL. The resulting 
workstation ECL contains entries from 
the Admin ECL that were not already 
in the existing workstation ECL. The 
privileges in the Admin ECL overwrite 
the privileges of the same entry in the 
existing workstation ECL.

NOTE: This table concentrates on the workstation ECL, but the principles are the same for the Java and Javascript 
ECLs.
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Client ECL settings: Default entries

When you first install a client, its ECL settings include some preset entries in the "When signed by" field:

Version Defaults
4.5.x, 
4.6.x

- No Signature - l
- Default -l
Note template (with all privileges)l
The user's name is automatically added to the ECL if there was no ECL in the user's desktop.l

5.0.2 - No Signature -l
- Default - (with no access)l
Note template (with all privileges)l
The user's name is automatically added to the ECL if there was no ECL in the user's desktop. l

5.0.3 - No Signature -l
- Default - (with no access)l
Note template (with all privileges, special trustworthy entries)l
The user's name is automatically added to the ECL if there was no ECL in the user's desktop. l
As of 5.0.3 the trustworthy entries are Binary Tree, Sametime, and Fax for Domino, which are assigned l
the set of accesses they need, determined on a case by case basis. 

Examples:
An existing enterprise has clients and servers currently running several versions of Notes and Domino, from l
version 4.5 to version 5.0.1. Upgrading all existing servers, all existing clients, or all existing clients or servers to 
version 5.0.2 will not automatically enforce the new ECL settings on any of the existing clients.  

In the same enterprise, installing a new 5.0.2 client will enforce the new ECL settings regardless of the version of l
the Domino server, as long as the server doesn't have a customized Admin ECL.

Server

Directory catalog does not enforce some Reader fields
If you use Reader fields in source directory entries, a directory catalog does not enforce those Reader fields.  As a 
partial workaround, use the new directory catalog configuration field "Selection Formula" to exclude from a directory 
catalog all entries that contain Reader fields, as in the following example:

SELECT @IsUnavailable($Readers)

For more information on the new "Selection Formula" field, see the Release Note titled "Selection formula in a Directory 
Catalog Configuration document."

Administrator Client, Client, Designer, Server

Using the workstation ECL Refresh button
The Workstation Security: Execution Control List dialog box has been updated to include a Refresh button that 
automatically updates the workstation ECL with settings from the Administration ECL on the user's home server. 

When you refresh an ECL, new entries from the Administration ECL are added to the workstation ECL. For entries that 
exist in both the Administration ECL and the workstation ECL, permissions assigned in the Administration ECL 
overwrite those assigned in the workstation ECL. Note that you can't remove entries, but you can overwrite entries and 
essentially undo the permissions previously granted.

For example, if there is a particular person that should not have any permissions, you can add that person to the 
administration ECL with no permissions. Then, when the updated ECL is distributed, if that person was originally 
granted some permissions in any users' ECLs, the updated Administration ECL will overwrite the users' ECLs with the 
updated permissions.

You can use the new Refresh button in place of the previous method that required administrators to create a button 
with a formula and insert it in a mail message to roll out updated ECLs to users' workstations. This new feature should 
be particularly useful for MIME-enabled users who lose their active content in mail messages.

To refresh a workstation ECL via the new user interface, perform these steps from a Notes client:

Choose File->Preferences->User Preferences.1.

Click Security Preferences.2.

Click Refresh.3.

Click OK.4.
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Administrators can now do the following to instruct users to update their ECLs:

1.   Make sure the Domino Directory with the ECL changes has replicated throughout the domain.

2. Address a memo to users whose ECLs you want to update.

3.   Describe the purpose of the memo and instruct the users to do the following:

Choose File->Preferences->User Preferences.l

Click Security Preferences.l

Click Refresh.l

Click OK.l

4.  Mail the memo.

Directories

Administrator Client, Server

Client support for LDAP continuation references
Starting in Release 5.0.5, a Notes LDAP client and the ldapsearch utility can follow continuation references received 
from an LDAP server. Continuation references, part of the LDAP v3 protocol, allow an organization to distribute a 
directory tree across multiple directory servers. When an LDAP client specifies a search base when searching an LDAP 
server that is configured to hold continuation references, the server can return URLs that allow the search to continue 
to additional servers that potentially hold entries applicable to that search base. 

For example, suppose the Acme organization distributes a directory tree over four servers:  Server A has entries for 
"o=acme," Server B and C have entries for "o=acme,ou=people," and Server D has entries for "o=acme,ou=groups."  
Acme could configure Server A to hold continuation references for Servers B, C, and D. If a client then searched Server 
A for "cn=John Doe" using the search base "o=acme," Server A would return URLs for Servers B, C, and D.  

Directory vendors don't necessarily use the term "continuation references"; for example, Netscape uses the term 
"Smart Referrals". 

Note that the Domino LDAP service cannot return continuation references, only referrals. A referral is an alternate 
server address (along with that of usually one replica) that a directory server returns when its directory doesn't contain 
a search base specified by a client. A referral is a form of error message, while a continuation reference is a positive 
response indicating that one or more servers have to be traversed to complete a search.

Server

Confine LDAP writes to local directories
If you allow LDAP write operations to a Domino Directory, store that directory on the server running the LDAP service 
rather than on another server. Make sure that the Replicas tab of the Directory Assistance document for the directory 
in the Directory Assistance database used by the LDAP service includes a replica only for the local directory. If you 
allow LDAP write operations to remote Domino directories, the ACL is unreliable.

Server

Extended Directory Catalog
Starting in Release 5.0.5, the Dircat task (Directory Cataloger) can aggregate entries from multiple secondary Domino 
directories into a database created from the PUBNAMES.NTF template, the template also used to create the Domino 
Directory. This style of directory catalog is called an Extended Directory Catalog. The Extended Directory Catalog 
combines advantages of the Domino Directory and the standard Directory Catalog --  it aggregates entries from 
multiple Domino directories into a single directory database while retaining the full set of indexed views and other 
features of the Domino Directory. 
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This hybrid design based on the Domino Directory provides more flexibility and faster responses locating entries 
because a server can virtually always use views to quickly look up names. In contrast, to look up names in a  standard 
Server Directory Catalog created from the DIRCAT50.NTF template, a server must do full-text searches -- a slower 
lookup process than view lookups -- when the name formats don't correspond to the "Sort by" configuration setting.

Since the Extended Directory Catalog contains the views that are in a standard Domino Directory and combines 
multiple directories into one database, it can be quite large. Therefore don't replicate the database to Notes clients 
and use as few replicas on servers as feasible.  

Servers use Directory Assistance to determine the location(s) of an Extended Directory Catalog. One Directory 
Assistance document, and therefore one set of naming rules, applies to all the directories aggregated into an Extended 
Directory Catalog. Therefore if you want to trust some secondary directories for Web user authentication but not 
others, you should create one Extended Directory Catalog that aggregates the trusted directories and a second that 
aggregates untrusted directories. Then create a Directory Assistance document for each catalog and enable "Trusted 
for Credentials" only in the one for the trusted Extended Directory Catalog.  

When to use an Extended Directory Catalog
We recommend using an Extended Directory Catalog in place of the standard Directory Catalog on the server, 
especially on servers that are handling a large volume of message or user traffic.  Our expectation is that in these 
cases the use of the Extended Directory Catalog will help improve Router performance.  For more information, see the 
topic "Using Extended Directory Catalog to improve Router performance" in the Troubleshooting section. 

You can also use the Extended Directory Catalog as a means of "publishing" a controlled version of secondary Domino 
directories to users. Control the content of the published directories by using the "Additional field to include" and 
"Selection formula" configuration settings. If you use the Extended Directory Catalog in this way, you can make the 
source Domino directories more secure by tightly controlling which users access them directly. 

Caution: Do not convert a primary Domino Directory (NAMES.NSF) to an Extended Directory Catalog. 

Setting up an Extended Directory Catalog

1. If you currently use the standard Server Directory Catalog, disable it by removing its file name from the "Directory 
Catalog database name on this server" field in the Basics tab of the Server documents. Or, remove its file name 
from the "Directory catalog database name for domain" field in the Public Directory Profile document, if you've 
specified the file name there rather than in Server documents.  

2. On the server that runs the Dircat task, use the File->Database->New command to create the Extended Directory 
Catalog from the PUBNAMES.NTF template. Give the database a unique file name and title; don't give it the file 
name NAMES.NSF.

Note: It is not necessary to create a full-text index.

3. In the ACL of the database you created in step 2, set the Default access to "Reader".

4. Open the database you created in step 2, then choose Create->Aggregate Configuration, fill out the Configuration 
document, and click Save and Close. This document has most of the same configuration choices as the 
Configuration document used in the standard Server Directory Catalog. However, if you want to include Server 
documents in the Extended Directory Catalog, you can do so by selecting the "Include Servers" option. Also, there 
is no "Sort by" option -- the Extended Directory Catalog retains all the indexed views in the Directory, so this 
option is unnecessary. 

The Server - Aggregate Directory Configuration view shows the saved configuration document.

Keep these points in mind when you configure an Extended Directory Catalog:

Don't aggregate the primary Domino Directory into an Extended Directory Catalog.l

If the "Additional fields to include" configuration field is blank, the Dircat task aggregates all fields from the l
source directory documents.
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To use the Extended Directory Catalog for Web user authentication, you must use the "Additional fields to l
include" configuration field to aggregate additional fields. To use name and passwords to authenticate Web 
users, add the HTTPPassword field to the configuration. To use X.509 client certificates to authenticate Web 
users, add the UserCertificate field. 

For more information on Directory Catalog configuration settings, see Domino 5 Administration Help or the book 
Administering the Domino System.

5. To build the Extended Directory Catalog, run the Dircat task against the database you created. Given the larger 
side of the Extended Directory Catalog, expect the Dircat task to take longer to run against an Extended Directory 
Catalog than it does a Standard Directory Catalog. You can improve Dircat performance by selecting "No" next to 
the "Remove duplicate users" option. If you select "No," then entries with identical names are all included in the 
Directory Catalog and users choose between the duplicates. Selecting "No" avoids the building of a particular view 
used to ensure the removal of entries with duplicate  names.  

6. If you use Directory Assistance, open the Directory Assistance database and remove the Directory Assistance 
documents for all directories that you included in the Extended Directory Catalog. 

If you don't currently use a Directory Assistance database, create one from the DA50.NTF template, replicate it to 
servers, and add its file name to the field "Directory Assistance database name" in the Basics tab of Server 
documents.   

7. In the Directory Assistance database, create a Directory Assistance document for the Extended Directory Catalog. 
Choose Add Directory Assistance, fill out the configuration fields, then click Save and Close.  Keep the following 
points in mind: 

Next to Domain type, select Notes, not LDAP.l
Next to Domain name, make up a unique domain name. Do not specify the name of the primary domain. l

If you want to trust the directory catalog for Web user authentication, include a rule that is "Trusted for l
Credentials."
In the replicas tab, specify one or more replicas of the Extended Directory Catalog. In a large domain it's l
important that there be more than one replica for performance and failover reasons. 

See Domino 5 Administration Help or the book Administering the Domino System for more information on 
configuring Directory Assistance.

8. Replicate the updated Directory Assistance database to the servers in the domain that will use it. Then restart the 
servers to load the new Directory Assistance information or wait 5 minutes for the servers to do this themselves.

Server

Dircat performance improvement
Starting in R5.0.5, the Dircat task no longer aggregates the group entries LocalDomainServers and 
OtherDomainServers in either a standard Directory Catalog or in an Extended Directory Catalog. This change 
eliminates unnecessary rebuilding of the $Unid view that these groups can cause and should result in improved Dircat 
performance.

Administrator Client, Server

Changing the name of the Users view in a directory catalog

You can change the name of the Users view in a  directory catalog as long as you keep the name Users as an alias.

Administrator Client, Server

Setting the correct default anonymous LDAP access
If you use the LDAP service, as of R5.0.7, you must create an (All Servers) Configuration Settings document to 
correctly define the default fields that are allowed for anonymous LDAP access to the Domino Directory. If you don't 
create this document, anonymous LDAP users can't search all of the fields that they should be able to by default. 
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Administrator Client, Server

The LDAP service and hiding Domino Directory design elements
If you use the LDAP service, do not select the form design property  "Hide design element from: Notes R4.6 or later 
clients" on forms in the Domino Directory. If you select this property, the LDAP schema fails to load, and the LDAP 
service shuts down.

Viewers and filters

Client

Viewers supported for Windows clients
Notes R5x contains KeyView viewer technology from Verity. 

These file formats are supported for Notes R5x on Windows 95, Windows 98, Windows 98 SE, Windows NT, and 
Windows 2000:

AmiDraw (.SDW)l

Applix Presents V4.3, 4.4l

Applix Spreadsheets V4.3, 4.4l

Applix Words V4.2, 4.3, 4.4l

ASCII Text All Versionsl

Bitmap (.BMP)l

CCITT Group 3 Fax (.TIF)l

CompuServe (.GIF)l

Computer Graphics Metafile (.CGM)l

Corel Draw CDR (TIFF header)l

Corel Presentations V7.0, 8.0l

Corel Quattro Pro V7, 8l

Encapsulated PostScript (TIFF header)l

Enhanced Metafile (EMF)l

Executable file (.EXE)l

Folio Flat File V3.1l

Format (AIFF)l

HTML (.HTM)l

IBM DCA/RFT vSC23-0758-1l

JPEG file (.JPEG, .JPG)l

Lotus 1-2-3 3.0, 4.0, 5.0, 6.x, R9 (.WK*, .123)l

Lotus 1-2-3 97 and 98, R9 (.123)l

Lotus 1-2-3 for Macintoshl

Lotus 1-2-3 for OS/2 (.WG2)l

Lotus AMI Pro V2, 3 (.SAM)l

Lotus Freelance V96, 97, Millennium Edition R9 (.PRE, .PRZ)l

Lotus Freelance  for OS/2 (.PRS)l

Lotus PIC (.PIC)l

Lotus WordPro 96/97, Millenium Edition R9 (.LWP) l

Mac PICT (raster content)l
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MacPaint (MAC)l

Maker Interchange Format (MIF) V5.5l

Microsoft Audio-Video Interweaved (.AVI)l

Microsoft Excel 2.x, 3.0, 4.0, 5.0, 7.0, 97, Office 2000 (.XLS)l

Microsoft PowerPoint 4.x, 7.0, 97 (.PPT)l

Microsoft Sound (WAV)l

Microsoft Windows Animated Cursorl

Microsoft Windows Bitmap (BMP)l

Microsoft Windows Cursor/Iconl

Microsoft Windows Metafile (WMF)l

Microsoft Windows Write V1.0, 2.0, 3.0l

Microsoft Word for Macintosh V2 3, 4, 5, 6, 98l

Microsoft Word for Windows 6.0, 7.0, 97, Office 2000 (.DOC)l

Microsoft Word for PC V2 to 5.5 l

Microsoft Works Spreadsheet V1.0, 2.0, 3.0, 4.0l

Microsoft Works V1.0, 2.0, 3.0, 4.0l

MIDI (MID)l

MPEG 1 Video (MPG)l

MPEG 2 Audiol

NeXT/Sun Audio (AU)l

Paintbrush/DCX (multi-page PCX) (.PCX)l

Portable Network Graphics (PNG)l

PICT and PICT2 Graphics (.PCT)l

QuickTime Movie (.MOV)l

Revisable Form Text (.RFT)l

Rich Text Format (.RTF)l

Sun Raster SGI RGBl

Tagged Image File Format  (.TIF and .EPS)l

Text file (.TXT)l

Truevision Targal

Unicode Textl

Windows Metafile Graphic (.WMF)l

WordPerfect 5.x, 6.x, 7.x, 8.x l

WordPerfect for Macintosh 2.0, 3.0l

WordPerfect Graphics (.WPG)l

XyWritel

ZIP file (.ZIP)l
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Client

Viewers supported for Macintosh clients
Notes R5x for the Macintosh uses Outside In Viewing Technology v 5.2.1 (Update 2) from Inso Corporation. 

These file formats are supported for Notes R5x on the Macintosh PPC.

Ami Pro 3.x (.SAM)l

AmiDraw (.SDW)l

Bitmap (.BMP)l

CompuServe (.GIF)l

Computer Graphics Metafile (.CGM)l

Executable file (.EXE)l

HTML (.HTM)l

JPEG file (.JPEG, .JPG)l

Lotus 1-2-3 3.0, 4.0, 5.0, 6.x (.WK3, .WK4, .123)l

Lotus 1-2-3 for Macintoshl

Lotus Freelance (.PRE, .PRZ)l

Lotus Freelance  for OS/2 (.PRS)l

Lotus PIC (.PIC)l

Macintosh PIC (.PIC)l

Microsoft Access 1.0, 2.0 (.MDB)l

Microsoft Excel 2.x, 3.0, 4.0, 5.0, 7.0, '97 (.XLS)l

Microsoft PowerPoint 4.x, 7.0, '97 (.PPT)l

Microsoft Word for Windows 6.0, '97 (.DOC)l

Microsoft Word for Macintosh 2.0, 3.0l

Paintbrush/DCX (multi-page PCX) (.PCX)l

PICT and PICT2 Graphics (.PCT)l

Revisable Form Text (.RFT)l

Rich Text Format (.RTF)l

Tagged Image File Format  (.TIF)l

Text file (.TXT)l

Windows Metafile Graphic (.WMF)l

WordPerfect 5.x, 6.x, 7.xl

WordPerfect 8l

WordPerfect for Macintosh 2.0, 3.0l

WordPerfect Graphics (.WPG)l

ZIP file (.ZIP)l

Client

Mac Link import filters not supported
The Mac Link import filters are not supported for the Macintosh in Release 5.0.2

Client

Importing large files into a Notes rich text field
Importing extremely large files into a Notes Rich Text Field may cause virtual memory issues. If virtual memory is low, 
users will be presented with a virtual memory error box, requesting that applications be closed or the system 
restarted.  We are working to resolve this issue in the next version of Notes.
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Feature changes

Administrator Client, Client, Designer, Server

Details of feature changes in "History of Changes" chapter
The "Details of feature changes" section of the "History of changes" chapter contains details of prominent feature 
changes since the original R5 product release. (In Release Notes before R5.0.10, many of these had been here, in this 
"Feature changes" section of the "Things you need to know" chapter.)

Not all features are discussed in this section. 

The specific revision number in the "History of changes" chapter contains a complete historical listing of feature 
changes, in the "New features and enhancements for R5.0.x". Those documents are grouped according to the release 
in which they were first documented. 

This "Details of feature changes" section gives you a view of all the details of feature changes that went into the product 
since R5 -- without having to sort through each revision number. 

Refer to the "New Features" section of the "What's new?" chapter for a listing of all new features for this particular 
Maintenance Release.

Server

New Notes.INI variable for transaction logging
On some servers, memory fragmentation may occur due to the logging of large non-summary data.  A new Notes.INI 
variable has been added to eliminate this memory fragmentation: RM_SMALL_NBNSRO_LOG_RECORD.  Setting this 
variable to '1' in Notes.INI will cause the transaction logging code to break the larger log record into smaller pieces, 
thereby using less memory.

NOTE: If you set this INI variable, the transaction logs may not be used on a server prior to 5.0.13 (i.e., a 5.0.12 
server cannot read the logs properly).  Only set this variable if you are not going to fall back to a prior release, and if 
all other servers that may read the logs are also at 5.0.13 (i.e., a backup server).
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Chapter 3 - Troubleshooting

Installation issues

Administrator Client, Client, Designer

Notes client installation/upgrade
The supported upgrade installation configuration is to upgrade an existing Notes client, NOTES.INI, and databases. If 
you deviate from this supported configuration, the following situations can occur:

If Notes is elsewhere in the user's system path, the installation program renames the existing NOTES.INI to 1.
NOTES.00x and creates a new, default NOTES.INI in the program directory. To continue with a supported 
upgrade, the user must rename NOTES.00x back to NOTES.INI and move it into the program directory, replacing 
the default NOTES.INI created by the installation program.

Before installing R5, a user might uninstall the previous Notes client without deleting files and databases not 2.
removed by the uninstall program (such as NAMES.NSF). If this occurs, it is recommended that the user install 
R5 into a new directory, free of existing databases, and then move the databases into the new Notes data 
directory after the Notes R5 installation and setup has been completed.

If existing databases are present during an R5 installation and setup, yet NOTES.INI has been reset or deleted, 
inconsistencies can result in the starting configuration of the Notes client.  For example, the starting Location 
may be different than what was set in previous Notes client.

Uninstalling a previous version and then installing R5 without removing old configuration files is not supported or 
suggested.

Administrator Client, Client, Designer, Server

New location for NOTES.INI file
In new (clean) installs of R5, the Setup program places the NOTES.INI file in the following locations:

Operating System NOTES.INI location

Microsoft Windows 95, Windows 98, Windows NT 
(Intel)

Notes program directory (for example, 
c:\lotus\notes)

UNIX Domino data directory

Partitioned servers Domino data directory of each server

Shared installation Windows system directory (for example, c:\winnt)

This is a change from previous releases, which placed the NOTES.INI file in the system directory by default. 

Note: When you upgrade to Release 5, the upgrade program moves the NOTES.INI file to the new locations listed in 
the table above.
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Administrator Client, Client, Designer, Server

Cannot install on NT with drive mapped to 95/98
Due to a third-party software bug, you are unable to run the installation program on Windows NT if the install kit is 
located on a Windows 95 or Windows 98 file system, and the path contains long (greater than 8 character) directory 
names.

For example, the install does not work with a directory path of: 

f:\download\Notes\NotesR5_client\

To work around this problem, change the pathname to a DOS-compatible form, such as:

f:\download\Notes\NotesR~1\

Server

Cannot use default install user and group on UNIX
Prior to R5, you could install on UNIX using the default user "notes" and default group "notes" regardless of other 
factors. In R5, this procedure has changed somewhat.

If you install with the default user "notes" and group "notes" (notes.notes), you will be unable to run the server if the 
login user account (notes.notes) does not exist and you are not running as user notes.notes. You should always install 
the server with the user and group of the login user account which will be used to run the server. (For partitioned 
servers, each Data directory should be installed with the login ID and group that will be used to run that partitioned 
server). 

For example, as root user, installing Domino with two partitioned servers run under the existing login ID's of 
server1.notes and server2.notes (respectively), you must:

Modify the default user name on the first partitioned server data directory from "notes" to "server1", leaving the l
group "notes" intact.

Next, modify the default user name on the second partitioned server data directory from "notes" to "server2", l
leaving the group "notes" intact.

You must next log in as server1.notes to run the first partitioned server, or log in as server2.notes to run the l
second partitioned server. If instead you log in as server3.notes and try to run the server from server2's data 
directory, certain files cannot be opened (since they are owned by server2 with user-read-only bits set). Server3 
is therefore unable to start up the server.

So, if you have an account designated notes.notes, it is OK to install with default notes.notes and run as notes.notes, 
but you cannot run a notes.notes initiated server with a user such as joe.user.

Server

Changing the AIX OS locale after installing Domino
If you want to change the locale for Domino after installation, follow these steps:

Check your AIX OS locale. Enter the following command at dtterm:1.

locale

Verify that the locale is correct for your language/country. If the locale is not correct, then refer to your AIX help 2.
system for information on how to install and configure your correct language locale.
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To change the OS locale after you have installed Domino, you need to complete the following steps. You must be a 
super user to carry out the following steps:

Locate the Domino resource directory [../res/C]:1.

Copy the C res directories to the $LANG directories as follows:2.

cp -r /opt/lotus/notes/5000/ibmpow/res/C  
/opt/lotus/notes/5000/ibmpow/res/$LANG

Note: $LANG can be any international locale, for example, de_DE for German, ru_RU for Russian, or tr_TR for 
Turkish. You must name the directory in this manner.

Verify that the $LANG dir has been created and the files have been successfully copied as follows:3.

ls -la /opt/lotus/notes/5000/ibmpow/res

Administrator Client, Client, Designer, Server

Data Transfer Error during installation

If you receive a Data Transfer Error dialog box during a Windows 95/98/NT installation, exit the install and shut down 
all other applications. In most cases, this is due to a .DLL (Dynamic Link Library) file that is still in use while the 
install program is trying to update it. It may also help to log off the system and log in again before retrying the 
installation.

Example Data Transfer Error dialog box

Data Transfer Error Information

ComponentError returned the following data transfer error.
Setup will now abort.

Media Name: DATA
Component: Domino as an NT Service
File Group:
File:
Error Number: -115

Administrator Client, Client, Designer

Don't select Modem Setup during a LAN + Direct Dialup Setup
When client setup is done by connecting over both a LAN and by dialing directly into a Domino server, if the user 
selects the Modem Setup button to configure the speed, sound, etc., through the Additional Modem Setup dialog, 
setup will fail when looking for the user's name in the public Domino Directory with the error "Server not responding."  

To avoid this error, do not select the Modem Setup button during client setup; after setup has completed successfully 
change the speed, volume, and other settings through the Ports tab in User Preferences. If the user is connecting by 
only dialing directly into a Domino server, the Modem Setup button can be used the change the speed and other 
settings without causing this problem.

Server

Error setting up additional server
When setting up an additional server on Windows platforms, if you select serial port, then change back to network, and 
click Finish, the following error appears:

Note error: The server name is different than the one you specified

You must re-install Domino to avoid this error.
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Server

Remove Domino as a service before upgrading NT servers
If you are upgrading from Domino R4.x to R5.x, and if Domino R4 is currently installed as a Windows NT Service, R4 
must be removed as an NT service before you upgrade to Domino R5.x.

In this situation, execute the "ntsvinst -d" command to remove the Domino Release 4 NT Service before you perform 
the Domino server upgrade.

Server

Installing Domino as an NT Service
When installing a Domino Server as an NT Service you must set up the server before attempting to start the Service. If 
an attempt to start the Service is made before setup, you receive an error message similar to the following: 

Services: Could not start the Lotus Domino Server <Server Name> service on 
\\<LocalHost>
Error 2140.  An internal Windows NT error occurred.

Note: <Server Name> only appears if this is a Partitioned Server installation..

If you attempt to set up the server after receiving this error, you may receive the following message after running the 
setup client: 

Lotus Notes: Unable to open desktop file.  Notes may have been terminated 
abnormally in an earlier session. Please logoff or shut down the operating system 
before running Notes again.

You need to reboot Windows NT before proceeding.

Server

Master Address Book template deleted upon install
The Master Address Book template (MAB45.NTF) is deleted during server install. If you have customized it and want 
to save your changes then copy it to a safe location before installing Domino R5.

Server

Back button error in silent install for partitioned server
Due to a third party software bug, if you select the Back button when recording a silent (automated) install for a 
partitioned server, you will receive an result code of -12 (dialogs are out of order).  The silent install will fail to run.  

You must re-record the silent install without selecting the Back button.

Example setup.log file containing the error:

[InstallShield Silent]
Version=v5.00.000
File=Log File

[Application]
Name=Notes
Version=5.0
Company=Lotus
Lang=0009

[ResponseResult]
ResultCode= -12
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Client, Designer

Appearance Manager requirements for Notes on Macintosh
The Macintosh Notes client requires Appearance Manager version 1.01 or higher to run.  The MacOS versions 8.1 and 
later already include a version of Appearance Manager that meets this requirement.

For MacOS 8.0x (and all earlier MacOS versions that Notes R5 supports), Appearance Manager will be installed with 
Notes as follows: 

If the language version of Notes matches that of the Operating System, the Notes installation will install a more l
current version of the Appearance Manager as needed. 

If the language of Notes does not match the language of the MacOS operating system you are running, you need l
to install the Appearance Manager version 1.01 (or higher) that matches your operating system language.  
Otherwise, Notes will not launch.

Server

Domino setup screens do not update correctly using Navigator
When using Netscape Navigator to set up a Domino server, the status "%" icons do not update and you must reload 
manually to see the Congratulations screen.

This problem occurs if you have the cache preference "Document in cache is compared to document on network" set to 
"Never." Change this preference to "Once per session" for future Domino server setups.

Client, Designer

Remote network client setup unavailable for Macintosh
Currently, client setup by dialing a remote network is unavailable for Macintosh PowerPC clients.

Server

Remove DEBUG_NONQNC_DEBUGGER variable on OS/2
The Release Note below, which went out with version 5.0.2 of Domino, contains an incorrect recommendation. This 
NOTES.INI variable should not be added in released versions of the Domino Server, since it disables the QNC 
debugger used to detect problems with the server. If you are using this variable please remove it from your NOTES.INI 
file.

As a precaution, recognition of this variable is being disabled in the Domino Server for release 5.0.3.

***************************************************************************************

Obsoleted Release Note below:

***************************************************************************************

When running Domino on OS/2 Warp Server at fixpack level 39, the following statement must be placed in the 
NOTES.INI file:

DEBUG_NONQNC_DEBUGGER=1

This will disable the Quincy debugger for OS/2, conserving memory so it can be used by other server tasks. While this 
will not impact installation, this parameter should be put in the NOTES.INI file after installation, and before starting 
the Domino server for production use.

Client

SSL applications cannot be administered using Macintosh clients
The two SSL administration applications (Domino Certificate Authority and Server Certificate Administration) that are 
created using the cca50.ntf and csrv50.ntf templates are not supported when using a Notes client on a Macintosh 
platform. You must use a R5.0 Notes client on the Windows 32-bit platforms in order to administer these two SSL 
application databases.

Please note: Macintosh users who use a web browser may still access the Domino Certificate Authority database on a 
Domino web server to request X509 client certificates.
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Client, Designer

Macintosh Error: "...'NotesLib' could not be found."
This error message may occur when Virtual Memory has been turned off. If this error appears when Notes is launched, 
go to the Control Panel for Memory and enable Virtual Memory. Lotus recommends that the total Virtual Memory 
should not be set to more than twice the physical memory of the machine.

Administrator Client, Client, Designer

Install "Shared" installs to a path without a space
When choosing to perform a Shared Installation, do not include a space in the Program Directory name.

Application design issues

Designer

Cannot display euro character on Japanese Windows NT
In the Designer Field Properties box on a Windows NT Japanese operating system, the actual symbol for the euro 
currency does not display properly. This is a Windows NT system limitation. The symbol should appear correctly in 
the actual document in the client.

Designer

Categorized embedded view display in Notes
If you preview a categorized embedded view in Notes that has "Show Single Category" set to a valid category, the 
documents in the embedded view will not be visible if the category is collapsed. To view the documents in the view, 
expand the category. 

This also occurs in the Notes client. For example, open a database to the embedded view and collapse the category. 
Compose a document using the form that contains the embedded view. Notice that the embedded view does not show 
the document.

Designer

Copying hotspot from navigator to form
If a form contains an imported navigator with a LotusScript action, you need to edit the hotspot on the form after the 
navigator has been imported.  In the click action, replace "Source As Navigator" with "Source As Button".  Resave the 
form and the LotusScript will work.

Designer

Environment variables in NOTES.INI
It is recommended that the name of Environment variables be limited to less than 62 characters in the NOTES.INI file.

If an Environment variable names are set at 62 characters long, they can cause the NOTES.INI to become very large 
and slow down performance. It may also cause applications to fail.

If this happens, limit the name of the environment variable to less than 62 characters and clear the environment 
variable manually.

96



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 3 - Troubleshooting

Designer

Frameset design issues
If the Launch option of a database is set to "Open designated Frameset," the margin width attribute of the l
frames will be ignored in the Notes client. 

To avoid an error when switching the Kind attribute (form, page, etc.) of a named element that resides in a l
frame, clear the Value field first.

Designer

Image Resources not displaying in Web browser
An Image Resource containing a plus sign (+) in its name will not display in a Web browser. To correct this problem, 
remove the plus sign (+) from the name of the Image Resource. For example, my+picture.gif would become 
mypicture.gif.

Designer

Multi-currency and euro support in views
Using R5, a developer can create applications which manipulate more than one currency, including the euro, and 
these currency values and symbols are independent of the locale setting or operating system default currency symbol. 

When creating a form, a currency field is defined using the Field Definition Infobox. One step in the currency field 
definition is to choose the currency symbol. Once chosen, the currency symbol and the currency amount always 
display together in that field.

In R5, displaying a currency field value in a view must be approached differently. For a view column to display a 
currency field, use a view column formula similar to the following example for displaying Japanese Yen in a view:

@If(JapaneseCurrencyValue!="";"¥"+@Text(JapaneseCurrencyValue;"F,2");"")

where  "JapaneseCurrencyValue" is the name of a form field and "F,2" is a format string that establishes a fixed 
format with 2 digits of precision.

Right justify the view column and the currency amounts align properly.

Designer

Multi-value separators include comma
When creating a multi-value field of type readers or names, if the developer removes the selection for comma as a 
separator, saving the form re-adds it. If a Notes client user enters a name, a comma, and a return before the next 
name, then  any names entered after the return are lost.

Designer

Outline entry issues
Outline entries containing hide-when formulas that are based on field values display regardless of the field value. l
Hide-when formulas attached to the outline itself work.

Deleting entries from the bottom of an outline that is larger than the window, then using Home or Page Up to l
return to the top of the outline, may cause gaps to appear in the rest of the outline. This can also occur after 
reducing the outline size by collapsing the outline. To make the entries visible again, use the arrow keys to move 
up or down the outline over the area where the entries are missing.

An Outline Entry that points to a database that has never been opened by the current user may not open the first l
time it is accessed through the Outline Entry.

If you place a database link to the current database into an outline, it is not visible when the outline is embedded l
in a page or form.
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Designer

Private folders appearing in shared or move folder lists
To avoid having nested private folders appearing in the shared folder or move folder location lists, create the first level 
private folder first, then create the sublevel private folders.

Designer

Private on first view doesn't update in an outline
Placeholders should be included in an outline with an outline entry for a "Shared, private on first" view. If they are 
omitted, the outline entry will not be updated.

Designer

Replacing or refreshing database design containing a frameset
If you replace or refresh a database design with a template containing a frameset, you must close and then reopen the 
database in order to see the new design.

Designer

Showing multiple values as separate entries requires sorting
If a view has the column property "Show multiple values as separate entries" marked, but none of the columns in the 
view are sorted, then the entries appear only once and only one of the multiple values appear per document. To see 
the multiple values as separate entries, the column containing the multiple values should be sorted.

Client, Designer

Macintosh Design Synopsis fails to report Java code
Because Java is not implemented on the Macintosh, performing a Design Synopsis (from a Macintosh) will not report 
any Java code in the specified agent or script library.

Client, Designer

Macintosh Platform - Notes AppleScript Support
Programming Notes

All the product classes, that is Database, Document, and so on, are documented in the Lotus Notes Programmer's 
Guide.  Use that documentation to explain what the various object/verb/methods/properties are meant to do. 
However, there are two basic variations from that LotusScript definition you need to know:

The Notes prefix was dropped on all classes.  NotesDocument becomes Document, NotesDatabase becomes 1.
Database, and so on.
For various reasons there may have been name conflicts that had to be changed.  Be aware that the definitive 2.
interface definition will always be the AppleScript dictionary contained within the Notes application icon.

AS Objects and their life cycle

The objects created when interacting with Notes are "bridge" objects.  They are references to the internal product 
classes associated with internal Notes programming.  When you create an object using the "make new" command or a 
"get" command from another object, an intermediate object is created to represent that class.
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The following script creates an object for the document collection and an object for each of the documents in the 
collection:

tell app "notes"
set myDB to make new database with data {srvrName, dbName}
openmail myDB
set docCollection to ftsearchdatabase of myDB query "test" maxdocs 3
set aDoc to getfirstdocument of docCollection
repeat until aDoc is equal to 0

set aDoc to getnextdocument of docCollection document aDoc
end repeat

The best approach to deal with these left over objects is to delete them as you go.  This approach becomes more 
critical when your script runs for a long time. For example, as in the case of a script with an idle loop handler: 

repeat until aDoc is equal to 0
set aDoc to getnextdocument of docCollection document aDoc
delete aDoc

end repeat
delete docCollection

Alternatively, the command, "flush bridge", can be used at the end of your script.  Just make sure that you are no 
longer planning to use the identifiers, that is, myDB.

The "delete docCollection" line will NOT delete each of the corresponding document objects.  If you were looking for a 
specific document and have attached the document to an AS variable (in this case, the aDoc), that reference will 
remain after deleting the collection.

Creating Notes product objects

Each object class that can be instantiated as needed will show required/optional parameters in the dictionary class 
definition.

Class database : make new database with data { server, file }

For the "make new" verb only, the variable identifiers are not included, only the data.
set myDB to make new database with data { "", "mymail.nsf"}

The preceding syntax creates an object that points to the db mymail.nsf in your notes data folder.  To open that 
database, you can either use the normal "open" verb or the Notes-specific "opendb". Each requires that the server/file 
name be supplied.

open myDB
or
open myDB server "" file "mymail.nsf"

Support of Required/Standard Suite verbs 

The ability to use the standard verbs is supported in some cases.  In the database open example previously provided, 
the open verb is supported.  
Get/Set/Make are fully supported.  Open/print is supported on some objects as relevant.

Note:  To see if the command is supported, you should try it in a test.

Default Objects and Order of Precedence

Three suites are considered to be the default objects, Default Notes Suite, Session, and UIWorkspace.  By making 
them application default objects, you do not need to explicitly define them as command targets.  Should there be a 
name conflict between the three default objects, the order of precedence is Default, Session, UIWorkspace.

Note:  By design, naming conflicts have been eliminated and therefore occurrence of such conflicts is highly unlikely. 

Conceptually, the way to communicate with the uiworkspace would be:
tell app "Notes"

set ws to make new uiworkspace
set aUIDB to get currentuidatabase of ws

end tell

99



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 3 - Troubleshooting

In practice, the creation of the session and/or uiworkspace can be skipped:
tell app "Notes"

set aUIDB to get currentuidatabase
end tell

Boolean var types

When a boolean type is listed in the dictionary as a small integer, you can use the form "with" to specify that var. For 
example,

getenvironmentvalue varname "DEBUG_CONSOLE" with issystemvar
getenvironmentvalue varname "DEBUG_CONSOLE" without issystemvar

...instead of:

getenvironmentvalue varname "DEBUG_CONSOLE" issystemvar 1

Client, Designer

Problem composing forms in views with form formulas
Notes views use a feature called Form Formula to change the form that is used when displaying a Document. Typically 
a Form Formula will look like this:

@If( Amount > 50; "Big Amount"; "Little Amount");

This formula looks at the current document being opened. If the document has field named Amount and its value is 
more than 50, then it uses the form Big Amount to view the document, otherwise it uses the form Little Amount.  

However, this also causes strange behavior when the user creates a new document while this view is open. If there is a 
form called Phone Number and the user composes it by selecting Create - Phone Number from the Notes menu while 
in the same view, he will instead see the Little Amount form. This is because the same Form Formula is executing 
regardless of whether the user is composing a new document or opening an existing document from the view. The 
same is true of view actions that use Formulas or LotusScript to compose a new document.

To work around this, the application developer should change the Form Formula to this:

@If( @IsNewDocument; @Return(Form); "");
@If( Amount > 50; "Big Amount"; "Little Amount");

This will restore the expected behavior when composing new documents.

Designer

'Use Outline' on Windows 2000
In outline design on Windows 2000, clicking the "Use Outline" button (or menu equivalent) while the outline or outline 
entry infobox is opened may crash.

Workaround: Close the infobox prior to clicking the "Use Outline" button (or menu equivalent).

Client

Database property "Display images after loading"
In the Database properties, checking the "Display images after loading" results in an extra $file added for each $file 
attachment that is created in a document. For example, if you check the formentioned property and attach a file to a 
rich text field in a document, you see that $file in the doc properties and an extra $file item gets created. Therefore, 
formula like @Attachments, @AttachmentLengths, @AttachmentNames return incorrect/invalid information.
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Client, Designer

Opening a form with an embedded view after the view has been deleted
If the view that is embedded on a form has been deleted, and the designer then opens the form and clicks on the 
embedded view, Notes will appear to hang. In actuality, it is searching for the deleted view, and will eventually return 
to user control.  Rather than wait for control to return, the user can hit ESC to move focus off the deleted view and 
resume editing. The same symptoms and work around apply to accessing the form from the client and clicking on the 
embedded view.

While searching for the deleted view, Notes will give an error beep if the user tries to click on anything else, or switch 
from the client to the designer or vice versa.

Client, Designer

Infobox error in Japanese and Traditional Chinese Windows
Due to an acknowledged Microsoft bug, text is being cut off in R5.0.4 infoboxes in Japanese Windows 2000, Japanese 
Windows NT, and Traditional Chinese Windows.

For example, you will see this if you open a form via Designer and select Design->Design Properties. Note that the text 
(of certain field names in the infobox) is cut off.

Designer

Template design names can contain spaces
In a topic entitled "Templates," the documentation incorrectly states that when you convert a database to a template, 
you must specify the template name with no spaces.  Template design names can contain spaces (for example, "DOLS 
Resource Template 1.0").

Administrator Client, Designer

"Allow more fields in database" field limit
The advanced database property "Allow more fields in a database" is documented incorrectly as allowing a database to 
contain up to 64,000 fields. The correct limit for the number of fields is 23,000.

Attachment issues

Client

Attachment file names containing exclamation points
If you attach a file to a Notes document and the attachment name contains a double exclamation point (!!), the file 
name does not appear.  The !! is an internal network separator to Notes, therefore, any characters preceeding this do 
not appear.
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Calendar and Scheduling issues

Administrator Client, Client

Meetings or Events get migrated as Appointments
Any meeting or event that is migrated from MS Outlook into Lotus Notes will be migrated as a Notes appointment.

Client

Alarm message text incomplete
Only the first line of text entered in the Description field of the Alarms dialog is displayed in the alarm notification box. 
Any text after the first carriage return is not displayed in the notification box.

Client

Calendar and scheduling with Prefers MIME mail preference
In general, Calendar and Scheduling users should use the mail format preference of "Prefers Notes Rich Text" or "No 
Preference;" however, if the users have the "Prefers MIME" preference, these are the known issues:

Meeting invitations contain duplicate meeting information in the Description and comments fields.l

Invitees' names are missing from response documents sent to the meeting chair.l

Invitation responses sent to the meeting chair contain duplicate meeting information in all comments fields.l

Any attachments added to the comments page are lost.l

The chair is not able to "Send Updated Information..." to an invitee's "Request information...".l

If a user reserves a room or resource that has owner restrictions, the document link included in the Resource l
Reservation Request is converted to text. The resource owner has to open the Resource Reservations database to 
the  "Waiting for Approval" view to process the reservation request.

Client

Calendar printing issues
Calendar view prints over boundaries of entry in weekly style view.l

Calendar views, especially monthly and weekly, with many "to do" items and/or appointments on a single day, l
may generate several pages in order to complete the listing for that day. In order to reduce the number of pages 
generated, there is a setting to print the first line only. This setting can be found by going to the main print 
dialog box (File - Print), clicking the customize button, then checking the setting to "Print first line only."

Calendar printing on a Hewlett-Packard PCL (or compatible) with "draft quality" button checked in the print l
dialog box causes much larger than normal calendar text.

Trifold Style printing on Day Timer Senior Desk and Franklin Day Planner Monarch must be printed in portrait l
mode to look correct when printed.

May experience distinction problem between small and large fonts in calendar printing when Unicode is turned l
on.

May experience decreased printing time with trifold and monthly calendar printing to local and network printers.l

A5 and B5 international paper sizes do not print correctly with Day Runner Entrepreneur (8.5" X 11"), Day Timer l
Senior Desk (8.5" X 11"), and Franklin Day Planner Monarch (8.5" X 11").  The size of the image (8.5" X 11") is 
larger then the size of the page (A5, B5).  When printing these 8.5" X 11" types, print to either a full page or an 
international size paper such as A4 or B4, that can accomodate an 8.5" X 11" page.

Client

Canceling and/or adding rooms to existing meeting invitation
If a chair sends a meeting invitation that includes a room or rooms and then either cancels a room or adds additional 
rooms, no notification of these changes is sent to the invitees. The chair should open the calendar entry and choose 
Actions - Send Memo to Participants to send the updated information.
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Client

Comments and Purpose fields in Reservation document
The Comments and Purpose fields in the Reservation document of the Resource Reservations database serve the same 
basic purpose. If you manually create a reservation, you may use either field to store additional information about the 
reservation. If you are reserving a room or resource via a Meeting invitation, the information contained in Subject field 
of the invitation is stored in the Purpose field of the Reservation document.

Client

Copying and pasting resources
To avoid reservation conflicts, do not copy and paste resources in your Resource Reservations database. Always create 
new ones using the "New Resource" action.

Client

Double-booking same holiday imported from different countries
If you import multiple holiday sets that contain some of the same holidays, they appear doubled-booked in your 
Calendar.  Any of the duplicate entries can be deleted from the Calendar without affecting the others.

Client

Free Time scheduling and Daylight Saving Time
Free Time scheduler returns incorrect results if the chairperson is in a time zone that does not use Daylight Saving 
Time and the invitee is in a time zone that uses Daylight Saving Time, but Daylight Saving Time is not in effect. For 
example, if the chairperson uses Japanese standard time and the invitee uses Eastern Standard Time and Daylight 
Saving Time is not in effect, the Free Time scheduler does not correctly reflect the free time for the invitee.

Client

Free Time view is not automatically updated
The Free Time view is not automatically updated when time zone settings change. This issue is currently being 
investigated by Lotus Notes Quality Engineering. An example of how this scenario can occur follows:

Create a location document for the current time zone. (For this example, use EST).1.

Save this location document and use these EST settings.2.

Create a second location document (for the same user) but use PST as the time zone. 3.

Switch to this new location document. Notice the time and time zone settings on your machine change 4.
accordingly.

Create an appointment. Observe the free time for the appointment. It is for the original (EST) time zone.5.

Workaround

The Free Time Settings in your profile need to be updated with the new time zone information. To do this:l

Change the time zone on your local client.1.

Open your mail database.2.

Select the Tools -> Preferences Action from the action Bar.3.

Select the Calendar Tab, Free Time Tab.4.

Uncheck, then check one of the check boxes to recalculate your free time settings with the new time zone.5.

Press the OK button. (You have now updated your profile with your current Free Time/Time Zone settings.)6.

The Free Time System needs to update.l

Once your free time has been updated you may have to wait some amount of time for the server task (Schedule 
Manager) to update the busytime database with your changes. This is usually a process that runs every five 
minutes, but can take longer depending on load. To force this to happen faster, you can type the "Tell Sched 
Validate" command at your Lotus Notes Domino Server. This should update the busytime.nsf database.  

In this scenario, Schedule Manager must run for the busytime system to have up to date information about your 
free time.
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Client

Group calendar and mobile directory catalog
Groups in a Domino Directory do not expand to individual members in the Group Calendar if you are using a Mobile 
Directory Catalog that does not contain the group members. To use both features, do the following:

Ensure your Personal Address Book (NAMES.NSF) is listed before the directory catalog in the Mail and News 1.
settings of User Preferences.

Select the group name in the Domino Directory.2.

Choose "Copy to Personal Address Book."3.

Alternatively, you can list each of the group members individually in the group calendar, or obtain a directory catalog 
from their administrator that contains members of public groups.

When creating or editing a Group Calendar, a Names dialog box is provided to allow the user to choose the individual 
members of the Group Calendar.  The domain names for the individual members are not included in the Group 
Calendar if the members were chosen from a Directory Catalog (local or server based).

This absence of a domain name may prevent freetime from being obtained for the Group Calendar members in the 
following situation:

The user's current location is a connected location. This means that freetime information will be obtained l
from the user's home server as opposed to using the client's local freetime database.
The individual member(s) are not in the same domain as the user who is editing the Group Calendar.l
The user's home server is not properly configured to resolve name lookups for members that are not in the l
user's domain.

The solution is to ensure that your home server is properly configured to use Directory Catalogs and is able to resolve 
name lookups for user names that are not in the server's domain.

Client

Group calendar does not display "pencil-in" calendar entries
Any Calendar entries that were save with "pencil-in" enabled are not displayed in the Group Calendar grid.

Client

Invitations tab in non-meeting entries
In a browser, when a calendar entry type is anything other than meeting or personal to do, selecting the Invitations 
and Reservations tab displays the Description field only. Use the browser's Back button to return to the Basics tab of 
the form.

Client

One entry displayed from group calendar for multiple entries
If a calendar has multiple calendar entries in the exact same date/time slot, only one will be displayed or opened from  
the group calendar grid.

Client

Processing encrypted invitations in a Web browser
If you expect that any invitees of a meeting or a group "to do" will be processing their invitations via a Web browser, 
then deselect the option to encrypt sent mail in your user preferences (File->Preferences->User Preferences->Mail and 
News->Encrypt sent mail). This option is deselected by default.

Client

Removing invitees before they respond
If the chair of a meeting invitation removes an invitee before that invitee responds, the invitee's original invitation is 
not automatically removed from the mail file.
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Client

Repeating meeting/to do issues
When you want to delete one instance of a repeating meeting by selecting the instance and pressing the Delete l
key, all the instances of the repeating meeting are marked for deletion. When you press F9 to refresh, and you 
receive choices as to which instance(s) you want to delete.

Another case of this issue is that when some, but not all, repeating meeting instances are modified and then one 
of the instances is marked for deletion. After you refresh, you receive a partial list of instances. When you make a 
choice about which set of instances you want to delete (Just this one, All instances, This and all future, and This 
and all past), your choice is put to effect for all instances.

When a chair decides to add an invitee after sending a repeating meeting or group to do, the new invitee does not l
receive the complete repeat information. The same problem happens when a repeating meeting/group to do is 
first saved as draft and then sent.

To avoid errors, respond to an invitation to a repeating meeting or to do before opening any reschedule notices. l

To propose a new time for any or all of the instances of a repeating meeting or repeating group to do, you must l
first accept the invitation or assignment. After you accept, you can propose a new time or date.

When you open a repeating group to do assignment, double click the form and click on the Repeats button to see l
the repeat information.

When a room or resource is reserved for a repeating meeting or group to do and not all the days are available, the l
chair receives two notices -- one is a Declined notice and one is an Accepted notice. To find out which instances 
were accepted or declined, chair should go to the rooms/reservations database and verify dates. If the chair only 
wants to reserve a room and/or resource for one instance of a repeating meeting, the reservation will be done for 
all instances of the repeat.

If you want to use the Delete key to delete single or repeating meetings or group to do entries, use the Calendar l
view. Using a browser, if you select the Delete button from an instance of a repeating entry, all instances will be 
removed.

In the calendar view, overdue repeating to do's are not displayed on today's date.l

"Propose new time" is a response option for an invitee for a repeating meeting that was saved as draft prior to l
getting sent.   Invitee should accept the meeting prior to proposing new time

If a repeating meeting chair checks the field "Start from the end of the month," that information does not appear l
in the meeting invitation. Invitees will not know the repeating meeting is scheduled on the specified dates but 
counting from the end of the month unless they accept the invitation and look at their calendar. As a work around, 
the chair should write a note in the Description field indicating the repeating meeting will occur on specified dates 
but counting from the end of the month.

If you receive an ambiguous dialog box when you are sending an invitation to a user, choose the name that is l
qualified with the Organization name. This issue occurs if you have a user specified in your Personal Address 
Book without the organization name and if that user is also specified in the Domino Directory.

Client

Reschedule notice when chair adds additional invitee
If you access your mail file from a browser and edit an existing meeting invitation to include an additional invitee, a 
reschedule notice is sent to all previously invited users. They should respond to the reschedule even though no 
changes will be made to their original calendar entry.

Server

Schedule_Check_Entries_When_Validating
Do not enable the setting Schedule_Check_Entries_When_Validating in the NOTES.INI file on a heavily-loaded server or 
one that uses a considerable amount of I/O. Schedule_Check_Entries_When_Validating validates the busytime 
database entry on a user by user basis. Enabling this setting can degrade server performance.

Client

Setting free time schedule to span midnight
In the Calendar Preferences/Free Time schedule, avoid entering values that span midnight. While this is not 
prohibited, it causes the Free Time dialog to display erroneous information.
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Client

Showing to do's on the calendar
For the user preference "Always show current to do's on Calendar" option to take effect, save the preference, and then 
exit and reopen the database. At the next scheduled time for agents to run, the to do's appear on your calendar and 
are updated to today's date.

Client

Use calendar view or open invitations to process invitations
Use the Participant Actions button in the calendar view or the Respond and Respond with Comment buttons from the 
open invitation to process a repeating invitation.

Use the Owner Actions button in the calendar view or in the open invitation form to perform meeting actions by the 
owner.

Client

Web only - scheduling events that span across a year-end
If a Web browser user creates an All Day Event that spans across years (for example, start date is 12/21/98, end date 
is 1/2/99), the user receives the following message when switching fields:

The End Date for the meeting must be later than the Start Date of the meeting

In order to work around this, the user should re-enter the End Date of the event and then immediately click the Save 
and Close button.  If they enter information in another field after changing the date, they receive the same message, 
so the order of execution is extremely important.

Client

Calendar problems with SMTP
When you configure your mail to run over an Internet account, and you point to an SMTP server in your account 
document, you may encounter problems scheduling meetings and using other calendar features. You may successfully 
send out a meeting invitation, but responses may be truncated or lost all together. When you change a meeting time, 
it may not change on the invitee's calendar. Or a new meeting may be added but the old meeting will also remain on 
the calendar. Future releases should address this problem.

Client

Time Zone for Free Time now coordinated
In past releases, you may have had trouble sending meeting invitations to people in other time zones, or checking 
their free time. The time in the chair's time zone would become the meeting time, with no adjustment for a change in 
time zone.  When you schedule now, the correct meeting time shows up, adjusted for the time zone.

Client

Must re-open Calendar to apply work week changes
The work week view is a feature in Calendar. You select the days you want to appear in the work week view in Calendar 
preferences. When you select different days for the work week view, you must first close, then re-open the Calendar to 
see the change take effect.

Client

Calendar not refreshed if left open after midnight
If you leave the Welcome page with a Calendar pane open overnight, the Calendar view does not get updated, even 
after a refresh. To update the Calendar, restart the Notes.
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Administrator Client, Client, Server

Importing Holidays into the Name and Address Book
In R5.0.12 the list of holidays has been expanded to include more countries, and holiday dates have been updated.  
When upgrading to Domino 5.0.12, to acquire this new data, the Administrator needs to navigate to "Holidays" in the 
server Name and Address Book, and delete all existing holidays imported from previous templates (pubnames.ntf). 
When the Administrator then runs the agent  'Import Holidays from Template' from the "Actions" menu, the new set of 
updated holidays will be imported.

Please note when importing holidays for Mexico, the error message: 'Error accessing product object method' may 
display.  The holiday data is, however, successfully imported.

DECS issues

Server

Running DECS 5.0.7 on Solaris 8
If you are starting Domino on a Solaris 8 OS after logging in via the Common Desktop Environment (CDE), you will be 
unable to start the DECS server addin task. An error will occur, stating that the extension manager cannot be 
initialized. This occurs only when running Solaris 8 and logging in via CDE.

For a workaround, log in using either rlogin or telnet, and DECS will start without errors.

Designer, Server

Oracle Connector passes procedure parameters by name
The Oracle Connector provided with the Domino Enterprise Connection Services and the LSX For Domino Connectors 
passes parameters for stored procedures by name. Therefore, the Oracle parameter names must now match the field 
names defined in the RealTime Activity, rather than the position of the fields in the RealTime Activity. Previous 
versions of the Oracle Connector passed parameters to stored procedures by position.

Administrator Client, Client, Designer, Server

Using the Lotus Oracle connector in DECS RealTime Activity
Beginning with DECS 5.0.4, when you use the Lotus Oracle connector in a DECS RealTime Activity and you have a Key 
field data type of CHAR, do not select the "Trim spaces on all fields" option in the RealTime activity document.

The CHAR data type in Oracle requires a fixed number of spaces for it to be identified by the backend. Without the 
correct number of spaces, connection with the backend will be lost. When you use a CHAR data type as a Key field, 
Lotus recommends that you use the default setting, "Trim spaces on non-key fields."

Administrator Client, Server

DECS security issues
There are two reported problems regarding security information using:

DECS administrator (Notes browsing and initialize keys)l

LC LSX against the Notes or file connectorsl

 DECS administrator problem description: Attempting to browse Notes when creating an activity or using the Initialize 
Keys functionality may generate a LotusScript error regarding access to unrestricted agents. The DECS application 
must be allowed to run unrestricted agents for these capabilities to work.
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LC LSX problem description: Agents or other LotusScript code which uses the Notes or File connectors must be 
signed with a Notes ID that has permission to run unrestricted agents. This also applies to any script libraries used by 
this code. Specifically, connections through these connectors will be blocked with an error unless the signing Notes ID 
has permission to run unrestricted agents.

Solution: There are two ways to address this error (in both cases):

Add the ID "Lotus Notes Template Development/Lotus Notes" to the "Run Unrestricted Agents" field in the Domino l
Server's entry in the N&A book containing that server. This field is found under the Security tab.

Resign the DECS Administrator database with a Notes ID which already has permission to run unrestricted l
agents. Resign the DECS Administrator through the Domino Administrator client - not through the normal Notes 
client.

Administrator Client, Client, Designer, Server

Multi-value Data Fields: binary option
When using multi-value data fields, do not designate a "Character Set" when you select  the "Sorting -> Text order -> 
Binary" option.  When you use the binary option, the "Character Set" field must be blanked out to prevent an error.

Server

DECS: Connecting DB2 with ODBC on Solaris
When using DECS on Solaris, activities connecting to DB2 should not be used in conjunction with activities connecting 
with ODBC.  When using DB2 and ODBC connections together, use the ODBC DB2 Driver to connect to DB2 backends 
rather than the DB2 Connection.

Directories

Server

Anonymous access allowed refers to non-secure LDAP only
Domino allows the capability of enabling or disabling anonymous access for both non-secure (default port 389) and 
secure (default port 636) LDAP. The following log message in bold may appear in the NOTES.LOG file and refers to the 
non-secure LDAP port only.

02/07/99 02:51:47 PM  LDAP Server: Started
02/07/99 02:51:47 PM  LDAP Server: Serving Directory c:\notes\data\names.nsf in
the acme.com Internet Domain
02/07/99 02:51:47 PM  LDAP Server: Maximum entries returned = Unlimited
02/07/99 02:51:47 PM  LDAP Server: Time limit for search = Unlimited seconds
02/07/99 02:51:47 PM  LDAP Server: Minimum characters needed for wild card = 1
02/07/99 02:51:47 PM  LDAP Server: WARNING: Authenticated Users do not need SSL
02/07/99 02:51:47 PM  LDAP Server: Anonymous access allowed
02/07/99 02:51:47 PM  LDAP Schema: Started loading...

Server

Can't use OID in LDAP search filter
You can't use an OID in a search filter when using LDAP to search a Domino Directory.
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Server

Disabling exhaustive name lookups to gain performance
By default, the mail router configuration option "Exhaustive lookup" -- available on the Router/SMTP - Basics tab of a 
Configuration Settings document -- is disabled. If you keep this default setting, once the router finds a name it doesn't 
continue its search to other directories. Disabling exhaustive lookups is used to improve router performance.

By design, disabling "Exhaustive lookup" does not apply to a directory catalog. After searching the primary Domino 
Directory, the router continues its search to the directory catalog even if "Exhaustive lookup" is disabled because it can 
find all the names quickly in one database (rather than having to take the performance hit of searching multiple 
secondary directories). 

The router returns a delivery failure if it looks up a name in the directory catalog that corresponds to more than one 
directory entry and the Mail server, Mail file, and/or Domains are different for each entry. To avoid these delivery 
failures when the two entries actually represent the same person (for example, when someone's name and directory 
location within the organization has changed but you want to allow people to address mail using the original name), 
make the entries in the Mail server, Mail file, and Domain fields identical for each entry. 

Server

LDAP over SSL using self-signed Domino server certificate
To use a Web browser such as Netscape or Internet Explorer 4.0 to perform secure LDAP searches (SSL) on a Domino 
server using a self-signed server certificate, you must first connect to the server via a different protocol (for example, 
HTTPS or IMAP) and accept the server's certificate in the browser when the dialog box appears.  

A self-signed certificate is not issued by a trusted Certificate Authority and therefore, an SSL-capable browser does not 
recognize the issuer and prompts the user with a warning. In the warning dialog window, the user can then tell the 
browser to accept the certificate. This must be done before any LDAP searches using SSL can be performed.

Server

LDAP using client certificates for authentication
When client certificates are enabled, and anonymous and name and password authentication are disabled for LDAP, 
Notes/Domino LDAP client and Netscape 4.6 are the only clients that send the client certificate over LDAP when 
requested by the Domino LDAP server. 

Microsoft Outlook Express currently does not send a client certificate when requested by the server, when using LDAP, 
therefore if you are using Microsoft Outlook  as your LDAP clients and SSL you would need to enable name and 
password or anonymous authentication in order to communicate.

Server

Cannot export LDAP schema if schema50.nsf is open
If you attempt to export the LDAP schema (e.g. TE LDAP EXPORTSCHEMA) while the schema50.nsf 
database is open, it will fail with the following message:

> te ldap exportschema
09/10/99 07:49:23 AM  LDAP Schema: Started exporting...
09/10/99 07:49:23 AM  LDAP Schema: Failed exporting

The database must be closed before attempting to export the schema.

109



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 3 - Troubleshooting

Server

Domino requirements when connecting to external LDAP directories
Beginning with Release 5.0.3, if you use directory assistance to connect a Domino server to an external LDAP server, 
the Domino server making the connection must be able to search the objectClass attribute of entries. This change 
means that if the Domino server connects anonymously, the external LDAP server must allow anonymous searches of 
the objectClass attribute for people (to allow Web user authentication or Notes mail addressing to people) and the 
objectClass attribute for groups (to allow group ACL authorization or Notes mail addressing to groups). If the Domino 
server connects using a name and password, the LDAP server must allow similar objectClass attribute access for 
authenticated searches.

If the Domino server cannot search the objectClass attribute, Web user authentication, group ACL authorization, and 
mail addressing fail.

Server

Shortname lookups to LDAP directories
In the following situations a Domino R5.0 or R5.0.1 server first looks for a shortname attribute when searching a 
third-party LDAP server:

You set up directory assistance to use a third-party LDAP server to authenticate Domino Web clients and you l
choose the Web server authentication option "More name variations with lower security." 

You set up directory assistance so that Notes users use a third-party LDAP server for mail addressing and a Notes l
user enters part of the common name (for example John) and presses F9.

These types of searches can be slow if the third-party server's schema doesn't include the shortname field. To speed 
up these types of searches, add the attribute shortname to the server's schema. 

Note: As of R5.0.2, the shortname attribute is no longer used in the search filters so this schema extension is no 
longer necessary.

Server

Directory catalog rebuilt if you upgrade from R5.0 or R5.0.1
If you upgrade an R5.0 or R5.0.1 server to R5.0.4 (or later R5 releases), the dircat task entirely rebuilds a directory 
catalog the first time the task runs. This avoids a potential view corruption problem that has occurred in a very small 
number of cases. Note that this rebuild does not occur if you upgrade from R5.0.2 or later servers, because the 
problem is corrected in R5.0.2.

Server

Removing duplicate users from a directory catalog
If you select "Yes" for the directory catalog configuration option "Remove duplicate users," if the Directory Cataloger 
encounters more than one entry with the same hierarchical name, it adds to the directory catalog only the first entry 
with that name that it finds. Directories are searched in the order they're listed in the "Directories to include" 
configuration field.

If you decide to remove duplicate user entries from the source directories and you remove the one that is used in the 
directory catalog, that name will no longer be included in the directory catalog until one of the following occurs:  

(1) someone modifies the remaining entry which causes the Directory Cataloger to add it to the directory catalog the 
next time it runs, or,

(2) you rebuild the directory catalog.
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Client, Server

Running the Directory Cataloger

Lotus recommends that you build or update a source directory catalog by running the Directory Cataloger on a 
schedule enabled in the Domino Directory 'Server' document. You can also immediately build or update the source 
directory catalog using the console command:

tell dircat quit

...and then issuing the command:

load dircat filename

...where 'filename' is the name of the source directory catalog. Do not choose Task->Start->Directory Cataloger from 
the Server Status tab of the Domino Administrator to immediately build or update a source directory catalog; this tool 
does not allow you to specify the file name for the directory catalog.

Server

Create full-text indexes manually on directory catalog copies

Full-text indexes are created automatically only on replicas of a directory catalog. A copy of a directory catalog is not 
automatically full-text indexed; you must manually create the full-text index on a copy.

Server

Signer of a cross-domain "Delete in Address Book" request
If your domain receives "Delete Person in Address Book" or "Delete Server in Address Book" requests and the 
Administrators in the source domain typically perform immediate deletions, the Administration Server of the Domino 
Directory of the source domain must be in the "List of approved signers" field of your Inbound Request Configuration 
document for the source domain.

Server

Do not use "container" or "domainComponent" for object classes

Do not use container or domainComponent as the name for a new object class. These object classes are reserved for 
future use.

Server

Web client authentication using Microsoft Exchange Server directory
Authenticating Web users registered in a Microsoft Exchange Server directory fails if the Exchange Server the Domino 
Web server connects to is not a Primary Domain controller or a Backup Domain controller and the users belong to a 
different Windows NT domain than the Exchange Server. Authentication fails because in this situation the Exchange 
Server requires clients to bind using cn=NTAccount,cn=NTDomain while directory assistance requires that users' 
distinguished names -- the industry standard convention -- be used for binds.  A workaround for this problem is 
making sure that the users and the Exchange Server reside in the same NT domain.
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Designer, Server

Cascading Domino Directory forms off the Create menu
If you use a backslash (\) in a Domino Directory form name so the form cascades off an item in the Notes "Create" 
menu, add the right-most portion of the name as an alias to the form name. This will ensure the object is correctly 
named in the schema. In addition, use this alias as the formula for the form's Type field.

For example, to cascade the new form "Printer" off of "Acme" in the Create menu, give the form the name:
 
Acme\Printer | Printer 

...and use "Printer" as the formula for the Type field so the LDAP name becomes Printer rather than Acme\Printer. If 
you use the form name Acme\Printer, you will not see search results if you use "Objectclass=Acme\Printer" in a search 
filter. Also, if you use another search filter to return entries associated with this object class, the class shown in the 
results is AcmePrinter (with no backslash).

Server

Do not include a CN attribute containing @ in an ACL
Do not add the distinguished name of a user from an external LDAP directory to a Notes database ACL if that name 
has a CN attribute that contains an @ character. Domino cannot correctly interpret such a name when it is in the ACL. 
Instead, assign the access to the user through either a group ACL entry or wildcard ACL entry.  

For example, don't add the name "CN=jdoe@acme.com/OU=NewYork/O=Acme" to an ACL. Instead, add the name of a 
group that includes that name, or add a wildcard entry such as "*/OU=NewYork/O=Acme" to represent all names at 
the New York organizational unit of the Acme organization.

Server

Using Extended Directory Catalog to improve Router performance
The Extended Directory Catalog is a new type of directory catalog available in R5.0.5. For more information on this 
feature and instructions to set it up, see the Release Note "Extended Directory Catalog" in the "Things you need to 
know" section of the Release Notes.

Using the Extended Directory Catalog on a server is particularly recommended if using the standard Server Directory 
Catalog (created from the DIRCAT50.NTF template) is causing Mail Router backups. When the Mail Router uses the 
standard Server Directory Catalog for mail routing lookups, it uses full-text searching, a slower process than using 
views, to look up names that don't correspond to the "Sort by" directory catalog configuration selection.

For example, if the "Sort by" field is set to Last Name, then the Router uses full-text searching to look up names that 
don't begin with the last name, such as John Doe/Acme or JohnDoe@acme.com. Using the "Sort by" configuration 
option "Distinguished Name" will avoid full-text searches for names in the Notes distinguished name format, such as 
John Doe/Acme (possibly a majority of names). However, the Distinguished Name sort order will still cause full-text 
searches for names such as JohnDoe@acme.com, so using Distinguished Name as the sort order may alleviate only 
some of the performance problem, depending on the types of names the Router needs to process.

If a mail routing backlog develops while using the standard Server Directory Catalog, follow these steps to 
troubleshoot the problem:

1) To determine if the standard Server Directory Catalog is the cause of the problem, remove its file name 
from the Server document or from the Public directory profile.

2) If the standard Server Directory Catalog is the cause of the problem and the "Sort by" configuration 
selection is not Distinguished Name, change the selection to Distinguished Name and then re-enable the 
Directory Catalog to see if the change resolves the problem. 

3) If using Distinguished Name as the "Sort by" selection does not solve the problem, use the Extended 
Directory Catalog instead, so that the Router uses view lookups rather than full-text searches to look up 
names.
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DOLS issues

Client

Using the Extended Mail template with DOLS
Users who choose the Extended Mail template (mail50ex.ntf) to replace a mail file design in the "Replace Database 
Design" dialog box must ensure that the "Inherit future design changes" field is enabled.

Disabling the "Inherit future design changes" field causes the "MAPI enablement" field to be hidden in the DOLS  
Actions -> Edit Offline Configuration profile, and the MAPI Service Providers will not download properly.

Workaround
If the "MAPI enablement" field is not visible, replace the design of the mail file, leaving the "Inherit future design 
changes" field enabled.

Administrator Client, Client, Designer, Server

Troubleshooting tips for DOLS installations
Upgrading from a Domino build without DOLS to Domino 5.0.10 and higher
If you are upgrading to Domino 5.0.10 or higher from a Domino build that does not already have DOLS installed, 
DOLS may not be properly installed. The DOLADMIN.NSF file will be created, but the correct DSAPI filter filename may 
not be added to the server document. When you start the Domino server, DOLS will not be loaded. 

To work around this problem:

Open the server record from the Administrator client.1.

Go to Internet Protocols.2.

Go to the HTTP tab. In the "DSAPI filter file filename" field, enter one of the following values, depending on your 3.
platform: 

Platform Value

Win32 ndolextn

OS/2 idolextn

AIX libdolextn

Solaris Sparc libdolextn

OS390 libdolextn

AS/400 * libdolextn

Shut the server down and restart it.4.

* NOTE:  For the AS/400 platform, the server document will be updated when a new server is configured or an  
existing server is modified using the CFGDOMSVR or CHGDOMSVR CL command with DOLS(*YES) specified. Refer to 
the Domino for AS/400 Release Notes for more information on configuring a server with DOLS. 

Cannot download a subscription from a Domino 5.0.4 or earlier server to a DOLS 5.0.10 or higher client
Once the user installs or upgrades a subscription from a Domino 5.0.10 or higher server, their client software is 
updated. They cannot then download a subscription from server running Domino 5.0.4 or earlier. The download will 
fail with error messages.

To avoid this problem, upgrade other servers to Domino 5.0.10 or higher.

Users can install the iNotes Sync Manager and custom subscriptions from a CD
This eliminates long waits for the Sync Manager and subscriptions to download during first-time install. To get a CD, 
contact your Lotus Sales Representative. Or you can download the CD code from www.lotus.com/dols and create your 
own CD. For more information, see the Readme file on the CD.
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Dial-up (or LAN) installation fails with "Unable to launch..." message
If the user tries to install the Lotus iNotes Sync Manager by using a dial-up or LAN connection and receives an "Unable 
to launch" message, the problem may be that the dial-up session had a time-out setting that was set too low. To 
increase the timeout:

Open the Domino Adminstrator client. 1.
In the navigation pane, click Server - Current Server Document.2.
Click the Internet Protocols tab, then the HTTP tab. 3.
Change the "Output timeout" field to 300 minutes to allow enough time for downloads.4.

Administrator Client, Designer

Desktop icons don't appear if database titles use Unicode
If you create a database, and the database title or subscription title uses Unicode, after a download you will not see 
the desktop icon for the subscription on your Windows workspace.

Workaround To launch the subscription after the download you must launch it from the Lotus iNotes Sync Manager.

Administrator Client, Designer, Server

Problem viewing "Out of Service" databases on a clustered server
When a user installs a database offline, then an Admin or Designer marks the online version "Out of Service," the user 
can still synchronize (with a replica on another server in the cluster). But when they then try to use the Web Control or 
iNotes Sync manager to view the database online, they get an error.

Administrator Client, Designer

Users must be Reader or higher to install DOLS database
Users must have at least Reader access in the Access Control List (ACL) of a DOLS-enabled database in order to 
install the database offline. A user with Depositor access or No Access trying to install a subscription will get an error. 

Workaround: Upgrade the user's access in the database ACL.

Administrator Client, Server

Internet password does not synchronize
When a user downloads a subscription, changes their Internet Password in the Person Record on the server, then 
synchronizes, they should be able to use the new password to open the subscription, either online or offline. 

They can use the new password to open the subscription online, but they get an "access denied" error if they try and 
use the new password to open the subscription offline.

Workaround: Use the old password to open the subscription offline.

Administrator Client, Designer, Server

Large fonts in Netscape may cause missing plug-in link
If you have set Netscape to use large fonts (Edit- > Preferences -> Appearance -> Fonts), you may have problems 
viewing and accessing the entire download page. You may not be able to access the Netscape plug-in link. To solve 
this problem, reduce the font size for Netscape.

NOTE: This problem can also occur if you set the Display to use large fonts at a high resolution setting.

Administrator Client, Designer, Server

Limit subscription names to fewer than 30 characters/bytes
Some subscription titles with international characters (double-byte or multi-byte) are truncated when the subscription 
is downloaded. The workaround is to use a title that contains fewer than 30 characters or bytes (if multi-byte).
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Administrator Client, Designer, Server

Save Offline Subscription Configuration profile document
If you set up a database for offline use but forget to edit and save the Offline Subscription Configuration profile 
document, offline users will experience problems. At a minimum, edit at least once the Offline Subscription 
Configuration profile document (Actions -> Edit Offline Configuration) for the Domino database you want to enable for 
offline use, and then save (File -> Save). If you do not edit and save, the Web Control will not appear in the Web 
application, and you will have no way to take it offline.

Administrator Client, Designer, Server

Scheduled agents do not run offline
Domino Off-Line Services does not currently support running scheduled agents offline.

Administrator Client, Designer, Server

Flatnames now supported
Previous releases of DOLS did not support users who were registered and given a certifier ID with a flatname. A 
flatname means the username has no hierarchy, for example, John Smith, as opposed to John Smith/Human 
Resources. 

Flatname users can now use DOLS. However, the administrator must set the server to work with them. Also, since 
Domino 5.x no longer allows the creation of flatname users, administrators must manually move these users to the 
server's Name and Address Book.

Making the server work with flatname users
To setup a DOLS-enabled R5 server to work with flatname ID users the certifying information from the flat certifier ID 
must be merged into the server's ID. To do this:

Open the Admin client, switch to the "Configuration" tab, and open the drop-down tools list.  1.

Open the server ID by clicking "ID Properties..." on the Certification tools drop-down.2.

Click "More Options..." then click "Create a Safe Copy...".3.

Rename and save the safe ID. Exit the dialog.4.

Click the "Certify..." tool on the drop-down.5.

Select and open the flat cert ID. Enter the password.6.

Select the SAFE ID, to certify it. Hit OK to complete. Hit Cancel to exit certifying.7.

Open the server ID again with the ID Properties... tool.  8.

Click "More Options..."9.

Click "Merge a Copy..." Select the safe ID. Click OK to merge information.10.

Click "Certificates" and scroll down to verify that the flat cert's name exists in the server ID.11.

Click OK to exit.12.

Restart the server. All flat IDs certified by the above flat certifier ID should be accepted as trusted by the server.13.

Adding flatname users to the Name and Address Book
On an R5 server you must manually add flatname users to the Personal Address Book. You cannot create new ones. To 
add flatname users to an R5 NAB:

In the Domino Administrator client, click the People & Groups tab.  1.

Click the Add Person button at the top. A new Person Record is displayed.  2.

Fill in the name information for the user with out an organization.  3.

Fill in the Internet Password.  4.

Save and close the Person Record.  5.

Refresh (F9) the view, and the new user appears in the list. This user is now part of the Name & Address book 6.
(Domino Directory) for this server.
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In the Domino Administrator client, click the People & Groups tab.  7.

Click the Tools drop-down on the top-right, and click People to open that section.  8.

Click Register... Enter the password for the certifier ID.  9.

Check the Advanced checkbox, then click the ID Info button.  10.

At the top, click the Certifier ID button, choose the flat certifier ID, and enter the password.  The user, once 11.
registered, will be entered in the Domino Directory (NAB) for this server, with an ID file that is "flat."

Note: the user with a flatname user ID file will always be prompted for an ID when they try to install offline, no matter 
what the DOLS Security Policy document is set to.

Client, Server

When browser prompts to "work offline," choose No
If the user's browser (IE or Netscape) prompts them to "work offline" they must choose No. If they choose to work 
offline with their browser there will be no live connection with a server and they will not be able to synchronize. If they 
choose Yes, the fact that they are not actually synchronizing may not be clear.

Workaround: Make sure users know the difference between working offline with their browser and working offline with 
DOLS.

Client

Cannot install subscription when username is non-ASCII
When a user with a non-ASCII (including high ASCII) username attempts to install a subscription, they get an error and 
cannot install.

Workaround Usernames must be in ASCII.

Administrator Client, Client

CD: Synchronize before deleting subscriptions
If users want to delete the offline version of a subscription, but save work they have done in it, they must synchronize 
with the online version at least once before deleting. Just because the subscription was installed with the DOLS 
Pre-Installer CD does not mean offline changes are saved somewhere on the CD or in the cache created by the CD.

Administrator Client, Client

CD: Uninstall misses non-default directory
If the user chooses to install the DOLS Client Pre-Installer to a directory other than the default (Program Files\Lotus 
iNotes\FilesetCache),  the iNotes Uninstaller will not remove the directory. 

Workaround  Remove the registry key and delete the directory in Explorer.

Administrator Client, Designer

Download iNotes access for Outlook before other DOLS databases
If you are using both iNotes access for Microsoft Outlook and Domino Off-line Services enabled databases please 
always download iNotes access for Microsoft Outlook first, before the other DOLS-enabled databases. If you download 
the DOLS-enabled databases first, the language files get overwritten in English.
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Client, Designer, Server

New Offline Configuration document required for database copies
Users with a subscription to a DOLS-enabled database should be able to also install a subscription to a copy of that 
database. However, if the Administrator creates a new copy of a DOLS-enabled database, and a user with a 
subscription to the original tries to install a subscription to the copy, DOLS will attempt to overwrite the original 
subscription. The user gets the message: "This subscription is already installed offline.  Do you want to update this 
subscription?"

Workaround: To allow the user to install a subscription to the copy, when they create the copy the Administrator must 
delete the copy's Offline Subscription Configuration profile document and create a new one.

Client

You can install twice without the CD noticing
If a user runs the Pre-Installer CD and installs the files to their C: drive, then runs the Pre-Installer again and installs 
somewhere on the D: drive, setup doesn't recognize that another installation is already on the machine. If the user 
Uninstalls, only the most recent files are removed.

Workaround: Manually delete old versions in different drives.

Administrator Client, Server

Moving extended mail files from one server to another
When you move an extended mail file (mail50ex.nsf) from one DOLS-enabled Domino 5.0.5 or later server to another 
using AdminP, the move will not be completed. 

This happens because the last step in moving these mail files is for the user to access the original file using Notes. 
When they do this, it updates the Notes Dialup Connection and Location documents in the Personal Address Book with 
the new mail file and new mail server information. Then a "Push changes to new mail server" request is created and the 
old mail file is deleted.

If a user accesses the original file with their browser using DOLS (or via replication) instead of Notes, this last step is 
not initiated.

The Administrator must use LotusScript to create an agent in the Administrator Request Database that will create the 
"push changes" request. The LotusScript can be downloaded from the Sandbox on the Lotus Developer Domain.  You 
can get the download from the following URL: 

http://www.lotus.com/ldd/sandbox.nsf/ecc552f1ab6e46e4852568a90055c4cd/c425421e4e419540852568630079
bb8c?OpenDocument&ExpandSection=1&Highlight=0,admin4.nsf.

Client

Multiple directory catalog issues
Each iNotes Web Mail subscription installed on a Client can have its own directory catalog. If several Web Mail 
subscriptions with directory catalogs are downloaded to the same machine, several issues may arise:

Any user with a subscription on that machine can read all of the installed directory catalogs, since they will all be l
listed in the address selection dialog.

All the directory catalogs with the same name will appear in the address selection dialog of any Web Mail l
subscription on that machine.

Despite having the same name, directory catalogs can contain different information, if they have different l
replication schedules. If the user can't tell which one is most up to date, they may be using an outdated catalog.

Workaround: Make sure that all directory catalogs on the same Client have the same replication schedule.
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Administrator Client, Client, Server

Problems if Internet and Notes passwords are different
Synchronization

Each user has an Internet password and a Notes ID password. DOLS needs the Internet password for logging into a 
subscription, and the Notes ID password for synchronizing. By default, DOLS assumes the two passwords are the 
same and makes the Internet password the default for synchronizing. But, if the user's Internet password is different 
from their Notes ID password, DOLS cannot synchronize. It tells the user they are using an incorrect password and 
prompts them for the correct one.

Workaround: When prompted for the correct password, the user must enter their current Notes ID password. This 
allows synchronization to continue. For a quick solution, the user can wait for synchronization to finish, then open the 
iNotes Sync Manager Properties for the subscription, click the Security tab, change the default password to their 
Notes ID password, and check "Remember password." They will not be prompted again during synchronization. 
Another solution is for their administrator to make the user's Internet password match their Notes ID password.

Opening encrypted subscriptions offline

If the user's Internet and Notes ID passwords are different, when they install an encrypted subscription they will be 
prompted for their Notes ID password. If they enter it, the subscription will synchronize. But, after first-time 
synchronization, the user will get "HTTP 500 Internal server error" every time they attempt to open the subscription 
offline.

Workaround: User must open the subscription's properties, click the Security tab, change the default password to 
their Notes ID password, and check "Remember password."

Server

5.05 DOLS: Live console can't display Off-Line service
If you use the Notes Admin client "live console" to administer your Domino Server running DOLS, the Admin client does 
not always display the Domino Off-Line Services task loading or unloading.  However if you look at the main server 
console, you will see that indeed DOLS is being loaded and unloaded with the Server HTTP task.

Workaround: Use the Server's main console to verify the loading and unloading of DOLS services.

Server

Cannot move main DOLS db to subdirectory under Notes\Data

You cannot move the main application database of a multi-database DOLS-enabled application from the notes\data 
directory to a subdirectory. Doing this breaks the application and OFF-LINE install fails. Off-line subscription syncs to 
5%, then stops with error message in dol.log that the "file does not exist." Editing the configuration document and 
uninstalling/reinstalling the off-line subscriptions does not work. 

You can move associated dbs to a directory structure under the notes\data directory. 

Workaound:  Do not move the main application database of a DOLS subscription.

Client

CD: Pre-installer does not appear on program list

The DOLS Pre-Installer program does not appear in the program list on Win '95, v4.00.950. 

Client

Don't change Internet password and go off-line in same session

If a user is logged into a DOLS enabled database on-line and changes their Internet password, then takes the database 
off-line during the same session, they may have to log into the off-line subscription with the old Internet password.  
This is because DOLS uses the password from the current session, and does not synchronize changes to the user's 
Internet password.

Workaound:  After changing the Internet password on-line, a user should close the browser and re-open the database, 
logging in with the new Internet password, then take the database off-line.  
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Client

Error 500 launching off-line if Sync Password wrong or not set

A user may encounter an HTTP 500 Internal server error trying to launch a database off-line in a browser under the 
following conditions.  

The server off-line security policy is set to "Prompt for ID."  l

On the server, the user has a different notes password from their Internet password.  l

The subscription is configured to be encrypted off-line.l

After the user has downloaded a DOLS subscription, and the subscription attempts to synchronize for the first time, an 
error is generated: "Incorrect synchronization password for this subscription.  Would you like to retry?"  The user clicks 
OK and enters the correct sync password (which is the Notes ID password).  Now synchronization will run.  (If you 
don't change the password manually in the subscription options, you will get this prompt every time you try to 
synchronize.)  Without manually changing the synchronization password in the subscription options, the user tries to 
launch the subscription in a browser off-line.  The user is not asked to enter the correct password, like during 
synchronization.  The browser just gives an HTTP 500 Internal server error.  

Workaround: Set correct sync password (the Notes ID password) in sync manager security options and select to 
remember it. Restart the sync manager.   

Client

Field setting can cause error message when synching
 DOLS subscriptions may not be able to synchronize when the "compare Notes public keys against those stored in 
Directory" field is set in the security section of the on-line server document.  When this field is set in the server 
document, a subscription may fail synchronization at 5 - 10%, and then generate the error, "Your public key does not 
match the one stored in the Address Book," and the synchronization status will go to "Idle".  The Server console will 
read: "CN=[username]/O=[domain] failed to authenticate: Your public key does not match the one stored in the 
Address Book."

Workaround: Disable the "compare Notes public keys against those stored in Directory" field in the security section of 
the server document, restart server. 

Client, Server

LDAP cannot be used for authentication with DOLS
In order for DOLS applications to run off-line, the subscription user must have a valid Notes ID and an entry in the 
primary address book on the Domino server, so that the local application can replicate with the server.  DOLS does 
not support authentication using LDAP. 

Workaround: None

Client

Lotus iNotes Sync Manager can't launch when DBCS directory
DOLS Subscriptions currently do not work if you try to install the subscription to a DBCS directory.  The Lotus iNotes 
Sync Manager will not launch during the initial download, and an error will be generated, saying either "Init Notes 
Session: (no error message available)" or "Error: Command Line Argument Error"

Workaround: Do not install DOLS to a DBCS directory.

Administrator Client, Server

Optional files not synching if *.nsf added to Rules tab

In the Off-line Configuration Document of a DOLS enabled database, under the Rules Tab, select the "Optional files to 
replicate" check box and type in *.nsf in text field.  When you take the database off-line, you expect that all nsf 
databases in the same directory will also be brought down.  However, these files are not created or replicated off-line.

Workaound:  Use \*.nsf instead of just *.nsf
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Server

Save/send message w/attachment while off-line gives server error
If a DOLS user sets their off-line mail file to "save sent mail" automatically, they may receive an error trying to save and 
send a mail which includes an attachment ("Cannot access documents original database to copy attachments. Click 
here to close this window and return to the main window").  The result of this error is that the mail will be sent to the 
recipients mail box during sync, but the message will not be saved in the "Sent" queue in the sender's off-line mail 
database.

Client

Sync Details dialog opens behind Sync Manager
If the user starts synchronization, then clicks "Sync Details," the "Sync Details" dialog opens behind the Sync Manager. 
This could be a problem if the user doesn't see the "Sync Details" dialog, because if the user doesn't close the Sync 
Details dialog, synchronization does not complete.

Administrator Client, Server

When adding a TCPIP address to the NOTES.INI
When you add TCPIP_TCPIPAddress=IP address to the NOTES.INI file on the server, it automatically adds that IP 
address to the "Optional Network Address" field in the user's Offline Address Book. (Open dolnames.nsf on the user's 
machine; click Server -> Connections; open the user's connection document; click the Basics tab.)

A problem occurs when someone uses DOLS both inside and outside a firewall. They often have a different IP address 
for each situation - one internal, one external. If the user is outside the firewall, and the "Optional Network Address" 
field contains the internal IP address, the user won't be able to synchronize.  The server's hostname should be in this 
field: for example, hostname.lotus.com

Workaround: The administrator should delete the TCPIP_TCPIPAddress= setting. 

However, this is not a workaround for customers using partitioned or clustered Domino servers because this 
NOTES.INI setting tells a partitioned or clustered Domino server which IP Address to use. With partitioned or clustered 
servers, a workaround is to change the port name part of the INI setting. For example, change TCPIP_TCPIPAddress= 
to <different port name>_TCPIPAddress. 

If you can't remove or change the TCPIP_TCPIPAddress= setting, add a new NOTES.INI setting called 
$DOLS_TCPIPAddress= and make the value the appropriate port to handle RPC calls. This value will populate the 
"Optional Network Address" field.

Client

Windows XP: "Uninstall Lotus iNotes" dialog UI has repaint issue
There is an issue with the UI repaint when attempting to uninstall iNotes, as in the following example:

Open mail file via web.1.
Install subscription.2.
From the Start menu, choose Program -> Lotus iNotes -> Uninstall Lotus iNotes3.
The dialog box shown below appears:4.

    

Note that this window will not disappear, and you will be unable to move this dialog box.  Additionally, when moving 
another application window over this dialog, the dialog is not re-drawn correctly.
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Client, Server

iPlanet default setting prevents download control from loading
Problem occurs when you set up an iPlanet Reverse Proxy Server to run with a Domino Server and leave all the iPlanet 
Portal Profile settings as the defaults. Then you setup a DOLS-enabled database on the Domino server, editing the 
Offline Config Document in the database at least once and saving the default settings. 

From a client, log into the iPlanet Proxy Server, then load the DOLS-enabled database through the proxy server. The 
database loads, but the DOLS download control (which normally says "Go Offline") does not load in the web control 
frame.

Workaround
Open the iPlanet Portal Management Profile and remove window.location.pathname from the "Rewrite Javascript 
System Variables" setting. Then restart the iPlanet server.

Client

Timezone error during sync can be ignored
When a user downloads a subscription from a Domino server whose OS is in an international time zone where daylight 
savings is in effect, the iNotes Sync Manager may display an error during synchronization. The error states that the 
clocks on the local machine and host server are more than 15 minutes apart, even though they are not.

Workaround
Click OK to disregard the message and synchronization will continue. The functionality of the synchronization should 
not be affected.

Domino applets

Designer

Action Bar applet - known issues
If you are running a version of Internet Explorer (IE) 4.0 prior to Service Pack 1, the action bar applet, outline applet, 
and view applet may not display the first time a page is loaded. Refreshing the page displays the applet. Installing IE 
4.0 with Service Pack 1 resolves this problem.

The action bar applet is disabled when IE 3 or 4 on the Macintosh (or Netscape 4.04 on OS/2) is detected. Instead, 
the action bar is displayed using HTML. This is due to design limitations in the Java implementation for these 
browsers.

Displaying all action buttons as right-aligned is not supported via the action bar property 'Alignment:  Buttons start at 
right'.  In order to make your action buttons display as right-aligned, you must check the 'Right align action button' 
setting in the Action properties box for each of the actions.

The action property 'Only show icon in button bar' is not currently supported using the action bar applet.  If you do not 
want to see text in your action button, you must leave the action's name field blank.

Designer

Editor applet issues

Use of images in documents that can be edited both from the Web and a Notes client is not recommended. l
Images are not preserved in the Notes client after editing a document in a browser. If you will only be editing 
and/or viewing documents on the Web, you can use image resources to add images to the original document 
from the Notes client.
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Microsoft Internet Explorer (IE) 3.0 is not supported by the Editor applet. Submitting from the Editor applet l
results in JavaScript errors using MS IE 3.0, and the contents of the applet will be lost.

The Thai currency symbol, the Baht, does not display in the editor applet when running in Microsoft Internet l
Explorer 4.0x. This is because the Baht character is not available in the font used by the Java Virtual Machine 
(JVM). The character is correctly understood and preserved by the editor applet, it simply does not display within 
the applet.

See the "Minimum browser support for Domino Java Applets" document in the Things you need to know chapter for 
baseline Web browser requirements.

Designer

Editor applet sizing issues
There are cases where the Input field for entering Unicode characters does not display properly in the Editor applet. 
The prompt, input field, and buttons do not all fit within the width of the Editor applet. Thus, these controls wrap 
improperly making the input field unusable.There are two workarounds:

Change the prompt displayed for this feature. This change must be made on the Domino server and affects all 1.
instances of the Editor applet hosted by that server. The English language prompt is defined in the 
editor.properties file. The prompts for other languages are found in the editor_xx_yy.properties files where xx is 
the two letter language code and yy is the two letter country code. These files are located in the \DOMINO\JAVA 
directory in the server's data directory. Open the editor.properties file and change the UNICODE_PROMPT = Enter 
Unicode Value (decimal or 0xhex) to UNICODE_PROMPT = Enter Unicode Value: (or to your preference). Save the 
file.

Change the size of the Editor applet. This must be done in the database template. For each body field that is set 2.
to use the applet, check if the HTMLBodyAttributes contains a height = \"300\" width = \"625\" entry (the values 
may differ). Change the width to a larger value.

Designer

Notes browser will not use Editor applet
The way that the editor applet gets its data has changed between R5.0 and R5.0.1.  In R5.0, the editor applet gets its 
data with a separate call to the Domino Web Server using the "INPUTSRC" applet parameter.  There were some 
problems with this method like losing the editor applet contents when the user activates something (e.g. some button)  
that causes the page to gets refreshed if the page is not saved first.  In R5.0.1, the editor applet now gets its data from 
a hidden HTML field using Java to JavaScript communication (using a convention known as LiveConnect).  

The current Notes browser doesn't handle Java to JavaScript communication.  Because of this, the Domino Web 
Server will not generate HTML that uses the Editor applet for the Notes browser.  Instead, the Notes browser will 
receive the regular HTML input area (i.e. <TEXTAREA>) from the Domino Web Server.

To override the default size of the HTML input area, use the HTMLAttributes (e.g. "rows=15  cols=80).

Designer

Outline applet - known issues
If you are running a version of Microsoft Internet Explorer (IE) 4.0 prior to Service Pack 1 (SP1), some of the outline 
applets may not display the first time a page is loaded. Refreshing or resizing the page displays the outline applets. 
Installing IE 4.0 with SP1 resolves this problem.

The outline applet is disabled when Internet Explorer 3 or 4 on the Macintosh is detected.  Also, the outline applet is 
disabled when Netscape 4.04 on OS/2 is detected and the outline contains entries which have computed actions.  
Instead, the outline is displayed using HTML. This is due to design limitations in the Java implementation for these 
browsers.

See the "Minimum browser support for Domino Java Applets" document in the "Things you need to know" chapter for 
baseline Web browser requirements.
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Designer

Rich text applet doesn't always work correctly in tables
Problems:

If a rich text applet is the first item in a table cell, anything following it does not appear.l

If a rich text applet follows a rich text field as HTML in a table cell, part of the applet tool bar is displayed but the l
applet is not usable.

If a rich text applet is in a merged cell within a tabbed row, the rich text applet will not show up.l

Solutions:  

Explicitly set the width and height values of the rich text applet. The table cell sizes are calculated properly and l
the applet displays properly.

Manually specify the width and height of the applet in Domino Designer via the HTML Attributes of the rich text l
field.  Enter:  "width=xx height=yy".

Client, Designer, Server

Using Netscape 4.6 not recommended - LiveConnect issue
An issue was introduced in the Netscape 4.6 implementation of LiveConnect that affects the Domino Java Applets.  
Specifically, use of the Outline, ActionBar, or Editor applets may generate a security exception and eventually cause 
the browser to hang.  Netscape is aware of the problem.

Upgrading Netscape 4.6 to Netscape 4.6.1 resolves this problem.  Note that Netscape Navigator 4.51 does not exhibit 
this problem, and can be used without errors. See the various browser and applet-related documents in the Things you 
need to know chapter of these release notes for baseline information about Web-browser usage.

Designer

Using the editor applet with non-English languages
There are some issues when using the editor applet in a non-English locale. The editor applet is now written in Java 
Developer's Kit (JDK) 1.1.8, which better supports Unicode and non-English languages. However, different browsers 
and Java Virtual Machines (JVMs) handle non-English characters differently as well.

Netscape issues

In order to properly display and enter non-English characters, you must be running an operating system in the l
desired language. For example, if you are connecting to and editing documents from a Cyrillic Domino server, you 
must be doing so using a browser running on a Cyrillic operating system. This is because the JVM gets the fonts 
from the operating system. If you are running a US English operating system, the Java fonts are Latin 1 and all 
characters are interpreted as Latin 1.

Double-byte languages are simplified and traditional Chinese, Japanese, and Korean. Now that the editor applet l
is built using JDK 1.1.8, it should get the proper key codes from Netscape 4.x browsers when running in a 
double-byte operating system. In a previous version of the editor applet, characters input into the IME (input 
mode) did not get entered into the editor applet. To solve this problem, the editor applet displays a text field at 
the bottom of the data area when running in the ZH, JA, or KO locales. Press F4 to move the cursor into this text 
field and use the IME to enter characters into the text field. Press Return to move the characters into the applet's 
data area. Press F4 again to return the cursor to the editor applet's data area. Even though the IME should now 
work properly with the editor applet, this extra text field is still displayed when running in Netscape.  The IME 
works properly with Internet Explorer 4.01 so this extra text field is not displayed.

Netscape and Internet Explorer issues

Often times international characters are inserted into an editor using an Alt or Esc sequence. This method of inputting 
characters varies greatly from browser to browser and does not work consistently. To work around this issue, the 
editor applet allows you to enter Unicode character values. Press the button in the editor applet's UI. A text field is 
displayed where you can enter a Unicode character value either in decimal or hexadecimal. A hexadecimal value must 
be preceded with 0x (zero x).
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Designer

View applet - known issues
Depending on the font you specify when designing column headings, the title text may be clipped.l

If you insert an embedded view and text in a document, set the embedded view to display as an applet, and then l
choose Preview in Web Browser, only the embedded view appears. The workaround is to open the top view in the 
browser and then open the document.

When you select a document in a view applet and press Delete, the trash can icon appears in the selection l
column. Unlike in Notes, pressing the F9 key at this point does not result in a prompt for the documents to be 
deleted. The @Command([EmptyTrash]) action actually deletes the selected document(s). 

View property - Shrink rows to content is always on for the view applet so changes to the Lines per row: field l
appear to work incorrectly.  

When a view applet is displayed with the Notes browser, an Execution Security Alert dialog box with a clipboard l
access warning may appear - depending on the settings in your File - Preferences->User Preferences->Security 
Options->Java applet security screen. 

In Netscape Navigator 4.5, the View applet doesn't re-size automatically if the browser window re-sizes. This is a l
known Netscape limitation. Netscape doesn't automatically re-size applets when the browser window or frame is 
re-sized. However, if you refresh, the applet should re-size.

If you are looking at a database (created from the mail template) using a browser, and then you make changes to l
the database that affect a view in the browser's cache, use the browser's View->Refresh option to refresh the view. 

The following third-party software issue has been identified:  The Macintosh version of Netscape 4.5 quits when l
attempting to open a document that contains an embedded 1.1 Java applet.

The Delete key does not work with Netscape 4.04 (990212) on the OS/2 platform.l

All applets except for the view applet are disabled when Internet Explorer 3 or 4 on the Macintosh is detected. l
That is, the HTML counterparts for these components are used. This is due to design limitations in the Java 
implementation for these browsers. For the view applet, we issue an error message rather than reverting to the 
HTML view since templates may have made use of applet-specific features that are not present in the HTML view.  

An embedded view applet in a table with the Width and Height set to "Fit to window" appears incorrectly when l
viewed with any of the supported Netscape browsers.  This is a known Netscape limitation.  

A view applet problem has been observed that involves the behavior of twisties with views that are catagorized.  l
The following description and workaround also apply to using @Command([ViewCollapse]) and 
@Command([ViewExpand]) instead of the twisties. The problem is that clicking the twistie to collapse/expand 
the category does not completely collapse it (the second level is not collapsed).  This may occur if the view is 
"time-variant".  That is, there is a formula that may cause the view collection to change as a result of the value of 
that formula changing over time.  The workaround for this problem is to bring up the View properties box and in 
the Advanced tab, set Refresh index: to "Automatic" and set Discard index: to "After each use".  Since the view 
index will be rebuilt each time, this may cause degradation in performance in large views.

Various problems have been reported that involve the component applets failing to load with Netscape 4.7.  We l
think the problem is in the Netscape Java support and have entered a Netscape Defect Report on the issue. 

Designer

Editor applet intentionally disabled in Macintosh browser

The Editor applet is disabled when a browser on the Macintosh is detected.  If a Rich Text field is set to display "Using 
Java Applet", and a Macintosh browser is detected, a text input field will display using HTML instead.  This is due to 
design limitations in the Java implementation for these browsers.

See the "Minimum browser support for Domino Java Applets" document in the Things you need to know chapter for 
baseline Web browser requirements.
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General issues

Client

SmartSuite performance issue with Notes R5
There is a known performance issue with applications hanging in SmartSuite 96, SmartSuite 97, and SmartSuite 9 
(Millennium Edition) when the Notes R5 client and SmartSuite are running simultaneously. The problem is more 
noticeable when many Notes documents are open or when using a Notes Welcome page style other than "Basics." 

NOTE: It is only SS 9.0 and 9.1 that may have this problem. 9.5 and higher will not have a problem.

Workaround 1: A utility to fix these problems is included in \APPS\SMARTSUITE\PATCH\SSUPDATE.EXE on the 
Notes R5 installation CD-ROM. Installing the update is highly recommended. You can also download the patch from 
the Lotus Customer Support Web page at http://www.support.lotus.com/

To install the SSUPDATE Application:

Close Notes and any SmartSuite applications.1.

Start Windows Explorer or Windows NT Explorer.2.

Go to the \APPS\SMARTSUITE\PATCH directory on the Notes R5 CD-ROM and double-click SSUPDATE.EXE. If  3.
SSUpdate encounters a problem, it displays a warning message before ending.

Note: An optional command line parameter is available that limits the search and update to files on a specific drive. 
For example:
SSUPDATE X
...where X is the only drive that you want to search for files to update.
In most cases, you don't need any optional parameters because SSupdate automatically searches all non-network, 
non-removable drives. However, if you are a system administrator with write access to a network drive with a server 
install, then you must run SSUpdate with this parameter. You also need to use this parameter if you want to update a 
copy of SmartSuite that is installed on a removable drive.

Workaround 2: You can eliminate these problems for all SmartSuite applications (except 1-2-3 97) by turning off 
Bubble Help in each SmartSuite product. To fix the problem for 1-2-3 97, you must run the update utility mentioned 
in workaround 1 above, or upgrade to a more current release of 1-2-3.

To turn off Bubble Help in SmartSuite products: 

From the File menu, choose User Preferences, and then choose SmartIcons Setup.1.

Uncheck the "Show icon descriptions (bubble help)" check box.2.

Repeat steps 1 and 2 for each SmartSuite product you have installed.3.

Client, Designer

Allowing more fields in a database
Databases in R5 format (On Disk Structure, or ODS) can have up to 64,000 fields by enabling the option "Allow more 
fields in database" on the Advanced tab of the Database Properties box. Databases in R4 format and R5 databases 
that do not have this option enabled can have up to 3000 fields (where the total length of the concatenated field 
names is less than 64KB). 

Enabling "Allow more fields in database" lets you create more fields in a database but keeps some features, such as 
full-text indexing, searching by form, and populating the field list in the Design pane of Domino Designer, from 
working. Also, replication between a database with the "Allow more fields in database" enabled and a replica of that 
database on an R4 server fails. You cannot create a new replica of a database that has this option enabled on an R4 
server.

Lotus recommends that customers not enable the option "Allow more fields in database" for databases with replicas on 
both R5 and R4 servers.
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Server

Anonymous/no access setting may produce ISpy error
While setting up the first server in a domain, you are given the option to add Anonymous with No Access to the Access 
Control List of all the server's databases. If you choose this option and load the runjava ISpy task on the server, this 
error may appear on the console:

You are not authorized to perform this operation [/homepage.nsf?Open]

You can ignore this error. It is not a problem and it will be fixed in a future release. If you would prefer not to see the 
error, open HOMEPAGE.NSF and change the access level for Anonymous from No Access to Reader.

Client

Bookmarks

Things you should know about bookmarks in R5

In R5, please be aware that there is no synchronization between the bookmarks and the workspace. Also, if you remove 
a bookmark entry, the corresponding database is not removed from your workspace, so upon a restart of Notes the 
bookmark re-appears.

Also, if you remove a bookmark that represents several replicas, all references to that replica are removed. If you want 
to remove a single replica, right mouse click on the bookmark, select Open Replica, then select Manage List.

To force replication after creating a new replica using bookmarks,  you must use the "Replicate via background 
Replicator" option in the replicate dialog, or replicate using the new replica stub on the workspace, or  go to the 
replicator page and replicate from there.

Note: An error will occur if you try to force replication after creating a new replica using bookmarks, if you use the 
"Replicate with options" in the replicate dialog.

Other issues:

Choosing Create->Response in a database's right-click menu causes the error "No document selected".l

After upgrading from 4.x, when you open your 4.x favorites databases, the database name will no longer be listed l
in the bookmarks list although the icon will appear. You can re-add the database to the bookmark list to correct 
this.

If you are using a bookmark file other than the default bookmark.nsf (as specified in your location document), l
you will need to restart the client in order for that bookmark file to be used.

If you have more icons on the Bookmark bar than what can be displayed on the screen, you can scroll to the l
icons that are not currently visible. To scroll the bookmark bar, you must first set the focus. To set focus, 
right-mouse click on any part of or icon on the Bookmark bar, and then press Esc to dismiss the pop-up menu. 
You can now use the up and down arrows to scroll the Bookmark bar.

You can expand upon the accessibility feature "Show extended accelerators" by enabling keyboard navigation of l
the Bookmarks bar. Add the line AllowBookmarkFocus=1 to the NOTES.INI and restart Notes. Press Alt-B and 
then you can use the up arrow, down arrow, Home, End, Page Up and Page Down keys to navigate the Bookmark 
bar. Use Enter to select a Bookmark bar icon and Esc to exit. Note: This feature is only available when "Show 
extended accelerators" is enabled in User Preferences.

Server

Certifier ID requires password quality of at least 8 characters
If you create a certifier ID during the setup process, you must choose the password quality of "Acceptable," which is at 
least 8 characters.

Client

Changing Local Address Books in User Preferences
Type-ahead and the LDAP client do not recognize changes made to the Local Address Books settings in User 
Preferences until after the client is restarted.
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Client, Designer

Delay refreshing date/time fields
It may appear to the end user that they need to press F9 twice to refresh a native Calendar entry or date/time field. 
There is a short delay built into the Calendaring and Scheduling controls before converting the text into a time or date 
value. Pressing F9 during that delay disrupts the refresh of the field. This will be addressed in a future release.

Designer

Deleting databases with multiple Designer instances open
If you open multiple instances of Domino Designer, you cannot delete a database. You should only have one instance 
of Designer open when you want to delete a database. If you do delete a database with more than one Designer 
instance open, the database is not removed from your Most Recently Used list.  

To remove the database from the Most Recently Used list, you need to add more databases to the list so that there 
are more than five databases in the list. When you close the Designer and re-open, only the five most recently-used 
databases will be in the folder.

Client

Deletion trash icon doesn't appear in the Headlines inbox
If you have a document marked for deletion in your mail file inbox, the trash icon does not appear in your Headlines 
inbox.

Client

Disabling Headlines to improve performance
If you do not use Headlines, disable them to free up resources and improve the performance of Notes.

To disable Headlines, choose File->Preferences->User Preferences, and then click Basics. Under "Startup Options", 
deselect "Check subscriptions."

If you have an old headline.nsf that is causing issues for you, try fixing it in these ways:

Delete headline.nsf and it will be recreated with the new template information.l

Change the archiving on headlines.nsf to purge every 2 days instead of every 365.l

Disable the New Mail subscription in the headline.nsf database.l

Manually purge the subscription results by right-clicking New Mail results on the Database Subscription l
outline and pick 'remove' in the popup dialog.

Server

Empty results in REPORTS.NSF
If you receive an "empty" report, for example, where only the original request information is present, after running a 
message report in REPORTS.NSF, there may be a protection problem with the reports database. If this happens, there 
are several things you can check:

Check the ACL for REPORTS.NSF to ensure the ID trying to run the report has at least Editor access. This level of 1.
access is necessary for the actions the agent performs.

Check the signature of the agent by looking at the $UpdatedBy field in Designer. If the signer of the agent doesn't 2.
have Editor access, it won't work.

Ensure that the signer of the agent is allowed to run unrestricted agents on this server. You can check this in the 3.
Security section of the server's Domino Directory.

The signer of the agents should be the administrator for the server. If it is not, edit each agent in the Designer and 4.
save the agent. This re-signs the agent (see step 3 again.)
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If the report was created by a scheduled agent, make sure the server has Manager access.5.

If you don't receive any reports at all for a scheduled agent, make sure it is enabled. If you enable the scheduled 6.
agent, you re-sign it, so perform step 3 above.

Make sure that the database is not full-text indexed.7.

Note: An "empty" report is not one where the Message Tracking Store (MtStore located in \DATA\MTDATA) is empty or 
not present. If that is the case, you receive a message in the report indicating a problem with the MtStore.

If you still are having problems getting a report to run, an SPR should be written. To expedite the SPR process, first 
turn on debugging for the reports agent. This is accomplished by setting the NOTES.INI variable DEBUG_REPORTS=1. 
The output for scheduled reports appear on the server console. The output for one-time reports appears in the client 
debug window. Include this output in your SPR.

Client, Designer

Enabling Java, JavaScript, and LiveConnect in the Notes client
Although JavaScript and LiveConnect (the ability of JavaScript to drive Java applets) appear to be enabled by default, 
they may not be set properly. If you want to drive Java applets from JavaScript, do the following:

Choose File->Preferences->User Preferences.1.

Ensure that the following options are checked: Enable Java applets, Enable JavaScript, and Enable Java access 2.
from JavaScript.

Click OK even if you haven't changed any settings. This forces the proper settings to be written to NOTES.INI and 3.
ensure the preferences are enabled.

Administrator Client

Files tab shows incorrect logging status of MAIL.BOX
The Files tab does not show the correct transaction logging status of MAIL.BOX. Even when MAIL.BOX is being logged, 
the "Is Logged" column on the Files tab contains "No." This will be fixed in a future release.

Client, Designer

French franc currency symbol
When Windows 95 has the currency symbol set to the French franc, the symbol imported by the Notes client for 
currency-format field is F, not the correct symbol of FF. This is a Windows 95 problem.

Administrator Client, Client, Designer

Help appears to freeze when using "Always On Top"
The Help database window may appear to freeze:

In the Help window, choose View -> Always On Top.1.

Open a dialog box, for example, File -> Database -> Open. It opens, but behind the Help window where you cannot 2.
see it.

The Help window appears to be frozen, because with the dialog box open you cannot perform any navigation in 3.
the Help window.

When this problem occurs, press Esc to close the dialog box, which is hidden behind the Help window. You can then 
continue using the Help window. Or, if you want to use the dialog box, close Help before choosing the dialog box 
command again.
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Client, Designer

Hotspot/link issues
There are some known issues when using or creating URL links or hotspots with the Notes client and Domino 
Designer:

The URL hotspot frame attribute is not saved. This is only a problem with URL string hotspots, that is, the URL l
hotspots created when the complete URL string typed into a document is converted when the user preference 
"Make internet URLs into hotspots" is enabled. Frame attributes for URL hotspots are saved correctly.

The hotspot properties box panels go blank after "Highlight the text" option is selected. Closing and re-opening l
the hotspot properties box repaints the panels.

The formula for a mouse-over formula pop-up does work correctly, however, it cannot be edited once the l
document is saved and closed. Upon re-opening the document, the hotspot properties box incorrectly displays 
the pop-up text edit control (containing garbage ASCII characters). The pop-up text control should not display at 
all for a formula pop-up. Formula pop-ups using the "On Click" event works fine.

Hotspot view links (and database and document links) don't fail over to different replicas when the server of the l
current replica (on the workspace stack) is down. Notes returns a "server is not responding" error instead of 
failing over to a different replica.

Designer

Imagemap hotspots are not highlighted on the image
Selecting an imagemap hotspot from the Objects tab in the Programmer's pane does not highlight that hotspot on the 
picture. To enable this feature, click on the hotspot that you want to edit. This sets the focus on the click event of the 
selected hotspot.

Client

In browser, rich text fields within tables lose contents
In a browser, for tables with "Show only one row at a time" enabled, a rich text field within any cell loses contents when 
you switch to another row in the table. All other field types retain contents as expected.  As a workaround, add 
contents to the rich text field as the last act before saving.

Client

Keywords not updated on Meta tab in Document properties
The Keywords field on the Meta tab in Document properties does not get updated after you categorize the document. 
This error only occurs when you access Document properties via a view. Switching to another document in the view 
and then switching back to the document refreshes the Keywords field. This will be fixed in a future release.

Administrator Client

Message tracking issues
Message tracking data is collected at regular intervals. A status of "unknown" is reported if a message is tracked l
before the routing information for that message can be collected. The default interval for message tracking data 
collection is 15 minutes. You can configure this value in the server's Server Configuration document.

It is not possible to search for messages with the Domino Administrator or Web Administrator Client using l
alternate names. Only the user name is supported for message tracking at this time.
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Server

Multiple server access probes generate only one statistic
If you create multiple server access probes to probe the same server, only one statistic is generated. For example:

Probe #1 - Server1 probes Server2 over any port by just accessing the serverl

Probe #2 - Server1 probes Server2 over any port by opening NAMES.NSFl

Probe #3 - Server1 probes Server2 over any port by opening EVENTS4.NSFl

There is only one resulting statistic in this format:

Server.Server1.Server2=xxx

Client

Netscape icon in Notes
The Notes client displays a Netscape icon on the bookmark bar if Notes detects that Netscape Navigator or 
Communicator is installed.

For the Netscape icon to appear, Notes must be able to determine the directory where Netscape's bookmark file is 
installed (typically called BOOKMARK.HTM). On Windows 95/98 and NT, for most versions of Netscape, this is done 
by consulting the Windows Registry. 

For some newer versions of Netscape Communicator, Netscape is using a new mechanism for tracking the location of 
the bookmark file rather than using the Registry. Notes does not currently support this new format. If you have 
Netscape Communicator installed and the Netscape icon does not appear, you can specify the location of the 
Netscape user directory where the BOOKMARK.HTM file resides by setting NetscapeUserDirectory in NOTES.INI. For 
example:

NetscapeUserDirectory=c:\Program Files\Netscape\Users\Default

Administrator Client, Server

Non-Latin1 characters not appearing correctly on UNIX
On the remote and server consoles and the Web Administrator database on UNIX platforms, non-Latin1 characters in 
file names may not appear correctly. If you create file names using native characters (non-ASCII) these may not be 
displayed correctly. File names will be written to the log files correctly. 

Client, Designer

OLE issues
The following items are known issues when using OLE (object linking and embedding) in the Notes client and Domino 
Designer client.

Deactivating an embedded OLE object causes the history currently associated with the Notes back arrow to be l
erased. Backward navigation is not possible with the back arrow until a new history is established.

Pressing the ESC key after entering data in a new OLE object may prevent data from appearing in the OLE object, l
because some OLE objects, such as 1-2-3, WordPro, Word Pad, and Excel, interpret the ESC keystroke as data.

Setting the "Size object to window" property of an embedded Lotus 1-2-3 workbook is not supported by Lotus l
1-2-3 97. Activating the workbook object in edit mode causes the object to zoom in and any column or row 
headings are not displayed. Upgrade to Lotus 1-2-3 Release 9 (Millennium Edition), which supports this 
property.

Two new R5 keyboard shortcut keys could conflict with OLE objects. In R5, you can now use Alt-W to access task l
buttons and Alt-B to access bookmarks. If you want to use a keyboard shortcut key for a Bitmap Image, press 
Alt-B-B. If you want to use a keyboard shortcut key for a Lotus 1-2-3 Workbook, press Alt-W-W.
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Saving a document with an embedded Adobe Acrobat 3.01 or 4.0 OLE object in it may cause Notes to crash. You l
can work around this issue by disabling NotesFX on your form. Open your form in the Notes Designer, choose 
Design->Form Properties, and then select Disable Field Exchange. Close and save your form.  Adobe is aware of 
this issue and it has been addressed in Adobe Acrobat 4.05a.

You may experience hanging when creating/editing OLE objects in Notes while using the Windows 2000 terminal l
server.  There is a workaround to this issue, you need to disable Notes/FX on the actual form.  Edit your form 
using Domino Designer, select Design, Form Properties, then deselect Disable Field Exchange under Options, 
then save and close the form.  Since the Windows 2000 terminal server allows multiple Notes users to operate at 
once you end up with multiple notes.ini files which can cause some applications to hang during OLE because 
these applications may have difficulty finding the correct notes.ini during your terminal session.  Disabling 
Notes/FX eliminates the need for these applications to find the correct notes.ini file.

The Microsoft Music Control object is not supported by Notes/Domino and causes a crash when added to a form l
or document.

Administrator Client

Potential Server Monitor paint performance degradation
If the Column scale slider in the By Timeline view of the Server Monitor is not returned to its lowest position prior to 
switching to the By State view, the screen graphics performance of painting the By State view may noticeably degrade.

Client, Designer

Notes Client and Designer printing - known issues
Printing a document with search highlights on a Hewlett-Packard PCL (or compatible) printer results in dark l
black boxes appearing over the search highlights.

Currently, Notes cannot print to a printer if there is a space in the printer's name.l

The Welcome page must be printed in landscape mode in order to properly read text. If you print it in portrait l
mode, text runs off the page.

Printing an OCX (OLE Control Extension) that spans more than one page prints only the first page.l

If you have difficulty printing any text formatted in a Unicode font (for example, Monotype Sans WT J) on a l
Hewlett-Packard PCL (or compatible) printer, try selecting the option in the printer settings that forces characters 
to be sent to the printer as downloadable soft fonts or bitmaps. The text may appear correctly on screen, but it 
may not print correctly.

In the Personal Address Book, if you print an Account document that spans two pages, the print output is l
misplaced on the second page. A fix for this is being considered for a future release.

The top portions of graphical table background images do not print correctly.l

Long subjects run off the page when a view is printed.l

For web pages that contain more than one frame, focus must be on the frame that you intend to print.  Click once l
within the content you wish to print and then preview or print the web page.

Administrator Client

Save and Close button saves but doesn't close
Please be aware of the following scenario when using the Domino Administrator:

Select a server.1.

Click the Configuration tab.2.

In the Servers pane, click Server and select "Current server document."3.

Click "Edit Server" and make a change.4.

Click "Save and Close."5.

Your changes are saved but the document remains open in edit mode.
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Server

Schedule Manager on Solaris may contain garbage error text
Some error messages logged by Schedule Manager on Solaris may appear as garbage or totally unrelated to any 
error.  There is an actual error message that is actually being logged but an optimizer problem results in the error 
code being incorrectly looked up. This will be fixed in a future release.

The proper error text appears on all other platforms.

Administrator Client

Server Monitor issues
If a server task has the same name as a database (for example, the server task Billing has the same name as the l
database BILLING.NTF) on servers on which the task is not configured, the Server Monitor may sporadically 
report this task as running, then not running.

The Server Monitor may report that the Indexer on a server is Not Responding when the Indexer is updating the l
full text index of a large database.

The Server Monitor automatically sorts troublesome servers to the top of the display. If the currently selected l
server changes state, the monitor adjusts the display so this server remains visible at its new location in the 
server list. To keep the Server Monitor display oriented to the top of the list, click on a stable server (at the 
bottom of the sorted list), then scroll the display to the top. Because the selected server is not visible, the monitor 
continuously displays the troublesome servers at the top of the list.

If the Server Monitor is configured to monitor both the Cluster Replicator and the Replicator on a server on which l
only the Cluster Replicator is running, the Server Monitor monitor may sporadically report the Replicator as 
running, then not running. 

Administrator Client

Set Quotas tool accepts letters
You are incorrectly allowed to enter letters into the "Set database quota to" and "Set warning threshold to" fields in the 
Set Quotas dialog box. These fields should only accept numbers. This will be fixed in a future release.

Client

Tables - known issues
There are some known refresh problems with table display, including:

The bottom border sometimes does not display. This is a refresh problem that is corrected when scrolling.l

Adjusting column size or inserting/deleting columns may cause display problems in tabbed tables or if outside l
borders are selected. This is a refresh problem that is corrected when you scroll or press Enter.

Column spacing initially throws off drop shadows, then corrects when an edit is made.l

Some changes to border sizes may cause text wrapping not to adjust properly. If this happens, save and reopen l
the document and the wrapping will be adjusted.

In Subforms only, text that wraps around an animated table overprints the first displayed row and then corrects l
with the display of subsequent rows.  Workaround:  Place the table and wrapped text in a form instead of a 
subform.

Other known issues: 

It is not recommended to merge cells in tabbed tables because there are some display and editing issues. l
Workaround: In a tabbed table, set borders to zero to achieve the same effect as merged cells.

If a fixed width table is center or right justified, and a value is expressed in Column Spacing, the table placement l
shifts to the left. Workaround: Use Table Margin to achieve the desired placement.

Cell image background content does not appear when a new row or column is inserted or appended. l
Workaround: Place the cursor in the cell that contains the background image and select Apply To All.  
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Cell image background and table color are not recognized as content when special border styles l
(ridged/grooved) are selected. The cell fills with the border color in read mode. Workaround: Entering a space 
displays the cell image and table color in read mode.

Text may be overprinted by large borders if the text is indented then outdented. Workaround: Adjust column l
spacing.

When selecting Transitions, you must do so cell by cell. Highlighting a group of cells results in the transition l
being applied to only the rightmost cell.

When using "Once when opened" as the cycle option for special table row display, there must be a minimum of l
two rows. A single row does not display in read mode. Workaround: If you want to display only a single row, you 
can insert a row above the row to be displayed and set the all the border widths to zero, effectively creating an 
invisible row.

Macintosh only: Transition Effects are currently not working on the Macintosh platform.ll

Client

TeamRoom issues
When using TeamRoom Setup, you may notice that the cursor appears to be missing from the screen.  Actually, l
the cursor is focused on the Help hotspot on each tab in the table. Pressing the tab key or the down arrow brings 
the cursor into the first editable field on the screen. This is due to a software limitation.

Client

Troubleshooting spell check for International
If spell check for International languages does not work, check these possible solutions: 

Ensure you have the appropriate language dictionaries in your data directory. If you do not, you can copy the l
correct dictionary files (.DIC) from the \APPS\DICTRNY directory on your Notes installation CD-ROM.

Check your International User Preferences (choose File->Preferences->User Preferences->International) to ensure l
you are using the correct international spelling dictionary.

Client

Undo function has changed
The undo function has changed for R5.

In previous releases of Notes, undo would only remove text entered since the last save command. For example:

If you opened a document,1.

Typed paragragh 1,2.

Saved the document,3.

Typed paragragh 2 and then chose Edit->Undo, only paragragh 1 would be removed. Paragraph 2 would remain.4.

In R5:

If you open a document,1.

Type paragragh 1,2.

Save the document,3.

Type paragragh 2 and then chose Edit->Undo, both paragraghs are removed.4.

If you accidentally select Edit->Undo, you can always close the document without saving the changes so the document 
reverts to its original state.
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Client, Designer

Use space bar to select in navigation pane after F6
Use the space bar to select an item in the navigation pane after using F6 to put the focus in the navigation pane. This 
is a change from previous releases, where just moving the cursor up/down or clicking with the mouse causes the item 
to be selected and appropriate views/forms to be displayed.

If the focus is in the view pane, clicking an item in the navigation pane will continue to select and open the view/form 
in the same manner it did in previous releases. This applies only to using F6 to put the focus in the navigation pane.

Server

Web Administrator - known issues
If you encounter any problems with the Web Administration application it is possible that the database has l
become damaged. Shutdown HTTP, delete WEBADMIN.NSF, and re-start HTTP. When HTTP starts it checks for 
the existence of WEBADMIN.NSF, and creates a new one from the template if it doesn't exist.

If you are having trouble authenticating with the Domino Web Administrator, ensure that you are logging in with l
one of the aliases specified in the "User Name" field of your Person document, and that you are using the correct 
password as specified in the "Internet password" field (Note: The shortname is only a valid Notes alias if it is 
added to the "User Name" field). Your name should also be listed in the Server document "Administer the server 
from a browser" field, and in the ACL on WEBADMIN.NSF. Also, make sure that the File protection document for 
the Web Administration executables is configured properly (see the release note on "Controlling Access to the Web 
Administrator files"). Both the server and administrator should have post and get (read & write) access to the 
domino/adm-bin directory.

Some browser configurations may require two authentications due to the way realms are handled. In such cases l
remote console and some of the other applets do not function correctly until the second authentication has 
occurred. Selecting "Live" console forces a second authentication if it is required.

The Domino R5 Web Administration application incorporates a feature that allows administrators to edit ASCII l
text files on Domino servers (such as the NOTES.INI file). To enable this feature you will need to open 
WEBADMIN.NSF with a Notes Client and click on the button to "Sign unrestricted agents for browser access". You 
will need Manager access in the ACL to do this. You will also need to add the hierarchical name of the UserID to 
the "Run unrestricted LotusScript/Java agents" field in the Domino Server record.

If your Domino Server ID is using a password and you want to use the Domino Web Administrator to modify l
database security (such as database ACLs and roles), you will need to set the server ID to "share password with 
Notes add-ins." Failure to do so may cause the Domino server to hang if WebAdmin is used to modify database 
ACLs. To set this use a Notes Client to access the Server ID, select File - Tools->UserID->Basics, and enable the 
"Share password with Notes add-ins" check box.

Web administrators can not modify Notes database security by default. This is because Notes databases don't l
generally have the "Maximum Internet name & password access" set above "Editor". If you want to modify Notes 
database security from a browser you will need to use a Notes client to change this parameter to "Manager". You 
will also need to ensure that this parameter is set to "Editor" or above if you want to edit Notes documents from a 
browser.

Your Web browser cache should be set to check documents every time.l

Internet Explorer 4.x users need to disable HTTP 1.1. This setting is located at the bottom of the Advanced l
section under "View->Internet Options->Advanced".

If your Internet browser setting in your Location document is set to "Notes with Internet Explorer" or "Microsoft l
Internet Explorer", you must make sure the Update cache setting in the Advanced section of the Location 
document is set to "every time". This setting overrides the setting in Microsoft Internet Explorer as mentioned 
previously.

Domino Web Administration is fully-supported with Netscape Navigator 3.01 Gold on the Macintosh. Some later l
versions of Netscape are only supported in "Dropdown interface" and "Plain interface" due to JavaScript 
compatibility issues. Similar JavaScript issues and lack of support for HTTP 1.0 prevent all versions of Internet 
Explorer from working properly on the Macintosh or UNIX platforms.
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Domino Web Administrator 5.0 Database Tools don't recognize group membership in database Access Control l
Lists.

If you have trouble creating databases, or replicas of databases, using Domino Web Administrator 5.0, it is l
because the "Create new databases" or "Create replica databases" field in the Server document is not set correctly.

Thai characters are not displayed in the Web Administrator applet on Windows 95 and Windows 98. There is no l
problem with displaying Thai characters in the applet on Windows NT. Hence, it is recommended that the Web 
Administrator applet is run on Windows NT for administering servers in a Thai environment.

Client, Designer

Extra, irrelevant submenus appear on Macintosh 8.5.x systems
Occasionally, a Notes client menu spawns submenus with choices that are irrelevant to the task you are performing.  
For example, choosing Create->Mail->Memo may reveal another cascading submenu with choices for 
marking/unmarking the Read Marks in a view.

This issue is specific to MacOS 8.5.x.  Testing shows this issue may occur on Macintosh 8.5.x systems, but the issue 
does not occur on Macintosh 8.6 systems.  If this problem persists, Lotus recommends you upgrade the operating 
system to MacOS 8.6.

Client

Macintosh - known IMAP client SSL issue
Use of SSL with the IMAP proxy on the Macintosh platform is not recommended due to performance problems.

Client, Designer

Macintosh - known issues when using Microsoft Office 98
Notes Release 5.0.1 does not support OLE (Object Linking and Embedding) creation with Microsoft Office 98 for l
Macintosh.  The OLE libraries in Office 98 are not compatible with Notes 5.0.1a.  This means that the Create 
Object menu will be grayed out if you have Office 98 installed.  You can create and edit OLE objects in Notes by 
using Microsoft Office 4.2.1 which includes Excel 5.0a, Power Point 4.0 and Word 6.0.1.  Lotus currently plans to 
have this issue addressed in a future maintenance release.

Quitting Excel while the object is still active in Notes can cause Excel to terminate.  Close the object in Notes l
prior to exiting Excel.

OLE Drag & Drop is not supported at this time.  Use the clipboard to copy or move data from one application to l
another.

Client, Designer

Mac Archive setting won't save after accessing Archive Help
On the Macintosh platform only, the following known issue exists:

If you open the Database Properties dialog for any database and click the Archive button to get the archive window, 
and then click the Help button for archiving help, after closing the archive help you must click Cancel to close the 
Archive window and subsequently reopen the Database Properties window to save any changes.  If you then attempt to 
save the archive settings, you will get an error 'Entry not found in Index.'  If you repeatedly attempt to save changes, 
the client will eventually crash.

Workaround:  Look up the archive help via the Help menu BEFORE entering the Database Properties window.
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Client

Macintosh client printing adjustments
Please note the following updates to printing for Macintosh users.

To set paper size, layout, paper source and, orientation:l

To specify printer-specific settings, choose File->Print, then switch from the default General to Notes (or some 
other drop-down, depending on your needs).

To preview page layout:l

Choose File->Print preview. Adjust your view as necessary.

Client

Macintosh printing - known issues
Long subjects run off the page when printing a view. Try printing in landscape mode from the Page Setup menu, 
instead of portrait mode.

Client, Designer

Printing java applet issue
Java applets will not print in a document when you print a document from a view.  You need to open the document 
and then print it for the Java applet to print too.

NOTE: See the "Minimum browser support for Domino Java Applets" document in the "Things you need to know" 
chapter for baseline Web browser requirements.

Server

R5 ignores Local time zone and Daylight savings time fields
In the server document (of the public Name and Address book) at the bottom of the Basics tab exist two fields labelled 
as follows:

Local time zone:
Daylight savings time:

As of R5, these field values are ignored by Notes.  The OS time is used instead.

Client

Refresh the Welcome page to see the latest database changes
If you have a database open in Notes, and you also have the same database displayed on the Welcome Page, you must 
refresh the Welcome Page to see any changes you make.

Administrator Client

Black & white table in message tracking reports
Black and white bar charts may be seen in message tracking reports. The bar chart in some reports will be black and 
white while the table below it does contain colors.

Adjusting the display settings in the system for a higher resolution and/or color scheme usually resolves the issue of 
black and white charts. 

Note: Once the chart is created, it will always stay the same and it won't matter what version of the client is displaying 
it, so only newly run reports will be affected by the display changes.

It is possible to receive both color and black and white charts for a particular server. The scheduled agents run on the 
server and the one time agent runs in the client. So, the hardware setting on the server could be different than the one 
on the client. That would explain a situation where you see color when you run the report once and black and white 
when it's scheduled. Adjusting the display setting of both the server and client may be needed.
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Client, Designer

Function keys in Mac Notes client (iBook laptop ONLY)
If you are running Notes on an iBook laptop and you see unexpected results when using the function keys (F1 through 
F12), this may be caused by a new feature in the Apple system software.

Background information
Apple has implemented programmable "hot key" function keys on the iBook. Keys F1 through F6 are preconfigured to 
do common system tasks such as changing the speaker volume or monitor brightness. Keys F7 through F12 can be 
configured by the user. Apple makes this the default behavior; that is, pressing these keys will be intercepted by the 
system instead of being processed by the application you are running. This can result in the following behavior: Press 
a function key, and instead of the expected Notes function executing, an unrelated system action takes place (or a 
dialog appears regarding 'configuring custom functions').

When this default Apple hot key behavior is enabled, you may still use old-style function keys by holding down the "fn" 
modifier key (at the lower left of your keyboard) before pressing the function key. When the Apple hot key functionality 
is turned off, this is reversed, so you must use the "fn" modifier key to access the programmed hot key.

Solutions for Notes users
Either turn off the hot key behavior by default, or, always use the "fn" modifier key when you want function keys to 
result in the normal Notes function key behavior.

To turn off the default Apple hot key behavior:

Open the Keyboard control panel (Apple menu, Control Panels, Keyboard).l

Click the button "Function Keys...".l

At the bottom there is a check box, "Use F1 through F12 as Function Keys.  l
(When this is selected, hold down the Function key to use hot keys)".  
Make sure this box is checked (on).

Click OK.l

Close the Keyboard control panel.l

F-keys within Notes (and other applications) should now work as expected.l

You can still use the programmed Apple hot keys by holding down the "fn" modifier key and pressing the desired l
F-key.

Server

java.lang.AbstractMethodError occurs because of JVM level
On Linux and OS/2 there is a known problem using the lotus.domino.Document.replaceItemValue() API if the object is 
a number. Strings work correctly. The usual symptom of this issue is a java.lang.AbstractMethodError. This is caused 
by a bug in certain versions of the JVM on Linux and OS/2.

A workaround is to make all items Strings and do the appropriate conversion before setting (and after getting).

On Linux, using notesjre to replace the JVM with the latest IBM JDK 1.1.8 seems to solve this problem. However, this 
solution is untested and considered unsupported as of R5.0.3.  On OS/2 there is no supported way to replace the 
JVM, so this issue currently has no workaround in terms of changing/upgrading the JVM level on OS/2.

NOTE: As of R5.0.7, testing shows that these particular errors no longer occur.

Server

Run "Compact" twice when a database is open
Notes 5.0.x allows you to compact a database while the database is still open. However, you actually need to compact 
the database twice, in order to set the document table bitmap optimization. On the first compaction the Document 
table bitmap optimization pending flag gets set. The table is actually generated on the second compaction.
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Server

HTTP connection errors and the listenbacklog queue
Through Release 5.0.4, the listenbacklog queue size is set to 64. If your server is experiencing connection errors, this 
parameter can be tuned. Administrators can do this by adding the LISTENBACKLOG=n parameter to the HTTPD.CNF 
file of the server and experimenting with various (n) values. The optimal value will vary from system to system.

Client

Accessing Web pages via Notes' Welcome Page with IE 5.5
Notes users running Internet Explorer 5.5 who have set their browsers to "Notes with IE" may experience an issue with 
accessing a Web page contained in their Welcome page.

If the Welcome page format contains a Web page, for example "Headlines with AOL," clicking on a link within that Web 
page will not open a new window.

Workaround
Press and hold the "Shift" key while clicking on a link; this allows a new window to be opened.

Server

NSD not working in Red Hat Linux 6.2
In R5.0.5 NSD is not working properly for Red Hat Linux 6.2.

Administrator Client, Client, Designer

Don't select Modem Setup during a LAN + Direct Dialup Setup
When client setup is done by connecting over both a LAN and by dialing directly into a Domino server, if the user 
selects the Modem Setup button to configure the speed, sound, etc., through the Additional Modem Setup dialog, 
setup will fail when looking for the user's name in the public Domino Directory with the error "Server not responding."  

To avoid this error, do not select the Modem Setup button during client setup; after setup has completed successfully 
change the speed, volume, and other settings through the Ports tab in User Preferences. If the user is connecting by 
only dialing directly into a Domino server, the Modem Setup button can be used the change the speed and other 
settings without causing this problem.

Administrator Client, Client, Designer, Server

Horizontal scrolling in localised versions
In localised versions, text expands to a width greater than in the US product.  Therefore, in order to view all text, 1024 
x 768 is the preferred resolution.

Client

Importing files with non-US-English character sets
A bug has been fixed where it was impossible to import a Microsoft Word or RTF document that was in a character set 
other than US English (code page 1252).

In order for the characters to display correctly, the entry UNICODE_DISPLAY=1 must be added to NOTES.INI.

Client

Windows XP: Icon is blank for drag/drop or attachments to Notes
When using Windows XP, the "attachment" icon is not retained when dragging and dropping, or attaching, a file into a 
Notes document, although the file itself does get dropped/attached into the document.
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Client

Windows XP: New XP Start menu covers the Notes app on start-up
When auto-launching Notes for the first time with the new XP Start menu, the menu will cover the Notes application, 
as in the following example:

On Windows XP, launch Notes and run setup for any user.l
Select "Restart As New User" from the "File" menu.l
When prompted to log on to the machine, type in the name of a user that hasn't run Notes before.l

Notice that the Windows XP Start menu is displayed, and the Notes setup program is displayed behind the XP Start 
menu.  Typically, launching the application would cause the Start menu to be dismissed

iNotes Access for Outlook

Client

Outlook invitee names missing from Acceptance notice in Notes
Users of iNotes Access for Outlook who send meeting invitations to Outlook invitees are unable to see a complete list 
of invitee names with the Outlook user's Acceptance response.

For example, a Notes user ("Chair") sends a meeting invitation to an Outlook invitee. Due to a limitation in the Outlook 
software, when the Outlook invitee accepts the invitation, the Acceptance response that the Chair receives will not 
show the Outlook invitee in either the "To:" or "cc:" fields of the Invitee tab.

Please note that the Outlook invitee's name is missing only from the Acceptance notice. The Chair's calendar entry will 
correctly display all invitees.

Client

Outlook "Folder->Copy" adds extra character to folder name
Outlook users who use the Folder -> Copy feature to copy one mail folder into another one will notice that an extra 
character has been added to the copied folder's name, when using iNotes Access for Outlook. For example, a Mail 
Folder called "User1", and copied to the Contacts folder, will then display the name "User11" in the Contacts folder. 

The Notes folder mechanism does not currently allow a Folder -> Copy using a name which is also a folder name at 
the top level. After the folder copy has been made, the user may then modify the copied folder's name.

Client

Outlook "Remove Recurrence" will not work for Notes invitees
Outlook users who use "Remove Recurrence" to update repeating meeting information for a meeting invitee who is 
using Notes Client will create duplicate entries in the invitee's Calendar View.

For example, an iNotes Access for Outlook user (the "Chair") sends a weekly, repeating meeting invitation to both an 
Outlook invitee and a Notes Client invitee; both invitees accept the invitation. Subsequently, the Chair decides to 
cancel one of the weekly meetings, selects the appropriate entry, and then chooses Recurrence->Remove 
Recurrence->Send Update. Both invitees accept the updated invitation.

The Outlook invitee will see the updated meeting information in their Calendar view, while the Notes Client invitee will 
see a duplicate meeting entry since Notes cannot update a repeating meeting.
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Client

Outlook "Unable to save Free/Busy info" dialog box appears
During normal operation, Outlook users will sometimes encounter a dialog box that states "Unable to save Free/Busy 
info".

This dialog box appears because iNotes Access for Outlook draws upon a different source for Free/Busy information 
than Outlook. Free/Busy information is automatically updated by Outlook, which looks to its own source and 
subsequently finds no information to update.

Users can minimize the appearance of this dialog box by setting the Save Free/Busy Info option in Outlook to "Very 
Seldom". There is currently no option that allows a user to completely avoid saving Free/Busy info.

Client

Repeating meetings over a weekend will not work in Outlook
Notes users should avoid sending repeating meeting invitations that span a weekend to users of iNotes Access for 
Outlook, as the Outlook invitee's calendar will display incorrect information. This problem occurs only if the Notes user 
selects something other than the default setting (i.e., Don't Move) from the "If the date occurs on a weekend:" option in 
the Repeat Rules dialog box.

For example, a Notes user sends a daily, repeating meeting starting on Thursday, for five days, to an Outlook invitee.  
The Notes user selects "Move to Monday" from the "If the date occurs on a weekend:" drop-down menu, intending that 
the meeting be scheduled for Thursday, Friday, Monday, Tuesday, and Wednesday.

When the Outlook invitee accepts the meeting, they will find that their Calendar displays meetings for Thursday, 
Friday, and Monday only, as there is currently no way to express this type of repeating meeting rule in Outlook.

Client

Unchecking "Request Response" option in Outlook doesn't work
Users of iNotes Access for Outlook will find that, despite sending meeting invitations with the "Request Response" box 
unchecked, the invitee will still be given the option to respond.

For example, an Outlook user ("Chair") creates a meeting for an Outlook invitee and unchecks the Actions->Request 
Response menu item (for Notes Client users, select the Delivery Options->"I do not want to receive replies from 
participants" menu item). The Outlook invitee accepts the Chair's invitation, and selects "Accept/Decline/Tentative", 
which then gives the invitee several response options ("Send response now", "Edit response before sending", and "Don't 
send response now"), in spite of the Chair's intent.

Client

"File->New->Distribution List" not updating Outlook Address Book
When creating a new distribution list in their Address Books by selecting File->New->Distribution List, iNotes Access 
for Outlook users will subsequently be unable to find the new distribution list in their NAB file.

Workaround  
Select Tools->Address Book->New Entry->Distribution List, then choose "Public NAB" from the drop-down list to create 
a new group in the public NAB file.

Client

Outlook Calendar availability shows Out of Office as "Busy"
When working with iNotes Access for Outlook, an Outlook designation of "Out of Office" results in a Notes designation 
of "Busy".
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Administrator Client

Admins must name a directory catalog in Notes.ini
For users to use the new feature which lets them take a directory catalog (address book) offline, the administrator 
must add the name of the directory catalog to the $DOLSDirectoryCatalog= setting in Notes.ini.

Client

Off-Line Address Book not synchronizing
On the iNotes Web Access for Microsoft Outlook installation Web page, if the user checks the option to install Off-Line 
Address Book, the address book does not replicate with the mail file.

Workaround: The user should reinstall their mail file.

Client

Off-line catalog property box won't open with non-ASCII username
Off-line users may be unable to select names in a Directory Catalog that include non-ASCII characters, receiving the 
error "Unable to Create MailUser Object."  This would happen if the directory catalog has been set up on a Domino 
Server to sort by the Alternate Fullname of the user. 

Workaround: Reconfigure the on-line Directory Catalog to sort by"Distinguished Name," rebuild the directory catalog, 
and sync the subscription. 

Client, Server

Users with non-ASCII in alternate name may fail on download
If a user has an alternate name in the server's address book containing non-ASCII characters, and this user attempts 
to download a subscription from a Domino Server, the download may fail with this message "Server returned Error 500 
when attempting to request off-line configuration data."  

Workaround: Remove the alternate name with non-ASCII characters from the server's address book.

Administrator Client, Designer

Location of Help for iNotes Access for Outlook
To view the online Help for Lotus iNotes Access for Microsoft Outlook:

Open either Domino Designer Help or Administrator Client Help.1.
At the top-level Contents view, click Domino Off-Line Services. The introductory DOLS topic appears in the right 2.
pane.
In the right pane, click the "Click here" link to open the DOLS help database.3.
In the Index view, click "Lotus iNotes Access for MS Outlook" to view the available list of topics.4.

Client

iNotes Access for Outlook doesn't support public folders
Lotus iNotes Access for MS Outlook does not currently support public folders.  Even if a folder named Net Folder Inbox 
is created, it is not supported.

Client

Can't select directory catalog in Outlook if name is non-ASCII
You cannot select a directory catalog in the "Show names from the:" field in Outlook if the directory catalog's name is 
non-ASCII.
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Client

DOLS users with alternative names cannot use iNotes for Outlook
DOLS users with alternative names cannot use iNotes for Outlook.

Internet issues

Server

Close and reopen new Certificate Authority database
When an administrator creates the Certificate Authority database (from the CCA50.NTF template), if that person 
attempts to select any of the options in the main navigator screen, they receive the following error messages:

View or navigator 'defView' does not exist

Followed by:

You have insufficient access to perform this operation

These error messages occur if the administrator does not have the role [CAPrivilegedUser] assigned in the database 
ACL. The administrator who created this database is automatically assigned this role; however, that role is not 
recognized when the database is first created until you exit from the database and reopen it.

Designer, Server

Domino does not preproces regular text in passthru HTML
In R5, Domino no longer preprocesses regular text within passthru HTML. When using passthru HTML, you must 
explicitly include any HTML that is necessary.

For example, in R5 Domino does not generate an implicit <BR> (line break) tag as it would in R4. 

In R4.6, for a form with the pass-thru HTML:

[<b>Line 1
Line 2
Line 3</b>]

Domino would generate the following HTML:

<b>Line 1<BR>
Line 2<BR>
Line 3</b>

In R5, Domino does not include the <BR> tags since the designer did not include them in the passthru HTML, which 
in this example causes the lines to concatenate in a Web browser.

In another example, in R4.6x, Domino generates an anchor tag when you create a URL hotspot within passthru HTML. 
In R5, Domino no longer generates the anchor tag.

Server

Domino for IIS adjustment with Domain Search or RepID
In the Domino for Microsoft IIS configuration, all URL requests received by IIS that contain the letters ".nsf" are passed 
to Domino. However, it is possible to use a Domino replication ID to identify a Domino page which does not include 
the letters ".nsf" in the URL syntax, and thus would not be passed to Domino in the default configuration. Note that 
Domain Search uses replication IDs when returning results as well.
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If you are using Domino for IIS you should fill out the "Generating References to this Server" section under Internet 
Protocols / Domino Web Engine in the Server document in your Domino Directory.  This indicates you are using IIS 
(and therefore require the .nsf in your URL syntax), and allows you to specify how IIS is configured so references to 
this server can be properly generated.

Setting the "Does this server use IIS?" field to Yes replaces the use of the DominoGenR5RepIdSyntax=1 setting in 
your notes.ini as previously suggested in R5.0 documentation.

When IIS is indicated, the Domino server will add the string ".nsf" to all Domino-generated URLs using the following 
syntax, which enables the IIS filter to pass the request to Domino:

http://server/__replication id.nsf/?Command

...where "replication id" is the 16 digit identity of the database prefixed with 2 underscores. For example:

http://www.lotus.com/__852559DF0070D6E7.nsf/?OpenDatabase

The URLs that use this syntax includes those produced in a page that is a result of a Domain Search. Domino R5 
servers process the page as it would normally. Domino 4.x servers do not recognize these URLs.

If you are upgrading a 4.x Web site that includes explicit URLs using replication IDs, and you want to run it in a 
Domino for IIS configuration, you need to manually change the URLs to match the syntax above.

Client

Explanation of "Use Replication History" option for NNTP/IMAP Accounts
This feature is currently undocumented.

NNTP
On the Advanced Settings Tab of the NNTP Internet Account document there is a field entitled, "Use Replication 
history when replicating."  Setting this to "Yes" allows the replicator to start pulling articles based on where it left off on 
the previous replication. This is the default setting and this is the most efficient way to replicate NNTP databases. 
Setting this value to "No" will force the replication to check every article (starting with the first one) and determine if it 
needs to be pulled into the replica.  You should set this value to "No" if you delete articles from your replica and want 
to get them back.

IMAP
On the Advanced Settings Tab of the IMAP Internet Account Document, there is a field entitled "Use Replication history 
when replicating."  Setting this to "Yes" allows the replicator to start pulling messages based on where it left off on the 
previous replication. (Note that messages that are modified, deleted, moved, or copied in either the replica or the 
server mail file will still be replicated.) Setting this option to "Yes" increases performance with negligible side effects, 
so most users will want to leave this option set to "Yes".

If you set "Use Replication History" to "No", IMAP replication will check every message (starting with the first one) and 
determine if it needs to be pulled into the replica. You may want to set the option to "No" when using the Universal 
Inbox in order to re-pull messages that you have deleted from the Universal Inbox. Note, however, that if your 
Universal Inbox is a server-based mail file, you will receive duplicate messages if you set this option to "No."

Server

File protection documents are not working for servlets
The Domino 5 Designer Help and Domino 5 Administration Help both contain references to using File Protection 
documents to control Web client access to Java servlets. This is not working properly in R5. Do not create File 
Protection documents for servlet class files, archive (.JAR and .ZIP) files, or the servlet directory.
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Server

Last-Modified HTTP header and JavaScript databases
Domino R5.0a does not send Last-Modified headers for responses from databases that have the database option "Web 
access: Use JavaScript in generating pages" selected. In Domino R5.0.1 this is still the behavior for requests which 
specify the HTTP/1.0 protocol. However, if a request specifies HTTP/1.1, Domino 5.0.1 will return a Last-Modified 
header along with the header "Cache-Control: private", which indicates that the response may be cached by a browser's 
local cache, but not by public caches (for example, proxy server caches).

Server

Listener errors reported against Internet protocols on AIX
Listener errors may be reported against Internet Protocols. There is a pending third-party problem where 
listener/binding problems can potentially occur against SSL and non-SSL ports.

Designer, Server

Microsoft Internet Explorer 3.x Issues with JavaScript
Domino R5 provides enhanced support for redirection to framesets, which produces JavaScript that is not supported 
by Microsoft Internet Explorer (IE) 3.x. Microsoft IE 4.x provides full support for all Domino R5 Web elements.

When dynamically generating pages, Domino can detect the version of the browser making the request. If a IE 3.x user 
requests a page containing JavaScript design elements not supported by IE 3.x, Domino generate the following error:
 
Error 500  HTTP Web Server: Your browser's JavaScript implementation does not 
adequately support usage of this feature. Upgrade your browser to be able to use 
this feature.

Domino 5 features not supported by IE 3.x

These types of features results in Domino automatically generating JavaScript that is not supported by IE 3.x:

The "Web Access: Use Javascript when generating pages" Database Option is enabledl

Options are selected that result in a URL redirection to a frameset, such as the "Auto Frame" option in the Launch l
properties of design elements

URL targets are defined by formulas, such as:l
- @SetTargetFrame
- Tabbed tables
- Design elements (such as Form, View, Page) that have a "Target Frame" specified

For example, the error message above will be returned for a URL containing the &BaseTarget argument which points 
to a page in a Domino database where the "Web Access: Use Javascript when generating pages" Database Option is 
enabled. If the same URL is used for the same database where the JavaScript option is not enabled, the URL will work 
as expected.

Client, Server

NNTP - known issues
Below are some known issues when using NNTP (Network News Transfer Protocol) service in Notes and Domino, as of 
Release 5.0.1:

If you create an account with a news server that contains more the 32,000 groups, the list of groups available to l
you is truncated at 32,000. A warning to that effect displays, indicating that the list has been truncated.

After clicking the Refresh button in the Newsgroups dialog box, you cannot stop or cancel the Refresh using Ctrl + l
Break. To cancel the Refresh action, use the Cancel button or press the Esc key.

If you attempt to subscribe to a newsgroup whose name contains the ampersand (&) character, the following l
message is returned: "Invalid newsgroup name".

Full Text indexing now works in 5.0.1, however, search hits found in the body field are not highlighted. Search hits l
found in the header fields (Subject, Newsgroups, From etc.) are highlighted correctly.
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Client, Server

Notes Web Navigator issues
The limit of displayable HTML in the Notes Web Navigator is 255 rows and 64 columns. If either of these limits is l
reached, Notes displays a message and the page is not loaded.  An alternate browser is needed for these pages.

If a Web page has more than 64K of JavaScript, it does not appear in the Notes browser. A message appears that l
the "Paragraph or field cannot be larger than 64K bytes".  After clicking OK the message and page are removed.  
An alternate browser is needed for these pages.

The R4.6 Server Web Navigator template is not automatically upgraded when you move to R5. To replace the l
design of the R4.6 template, open your Server Web Navigator, select File->Database->Replace Design and choose 
Server Web Navigator (R 5.0). 

Note: Some of the sampler section links from R4.6 are no longer in service. The only way to remove them is to 
delete your WEB.NSF before replacing the design. If you do not want to delete your database, then disregard the 
pages that do not load from the sampler.

If you try to forward a copy of a framed Web page (Actions - Forward - Forward copy of page) using the Notes l
native browser, only the first frame is included in the e-mail.

The Notes browser does not support Visual Basic on Web pages. Visual Basic is used to manipulate ActiveX l
controls.

In Actions->Internet Options, the Presentation tab setting HTML Save Options should be set to "Save as MIME l
only"  to get the true look of the HTML. If you have a Notes R4.6 database, you may need to set it to "Save as Rich 
Text only".

Server

Requesting a client certificate using a Netscape browser
When requesting a client certificate from a Domino CA using a Netscape browser, you must be sure to complete the 
name and organizational information fields. These fields are required for client certificate requests. If you do not, after 
you submit the request you will receive the message "Invalid or non-existent distinguished name component."

Client

Requesting Internet certificates from Verisign
You can request Internet certificates from the Verisign Internet certificate authority at 
http://www.verisign.com/client/index.html. On the page labeled "Choose Your Browser," you may see icons for 
Microsoft and Netscape, but not for Notes or Domino. In that case, click on the Netscape icon.

After filling in your personal information and submitting the form, you may see a page labeled "Error Online 
Enrollment Status: 3041".  If that happens, you need to add the following line to your NOTES.INI file:

WebUserAgent=Mozilla/4.0 (Windows-NT)

Restart Notes and resubmit your client certificate request to Verisign.

These steps are required until Verisign makes the necessary changes to their Web site to recognize the Notes browser.  
Verisign has committed to make those changes in the near future.

Server

Server-wide custom error message issues
With DOMCFG.NSF configured for server-wide custom errors:

Users should receive the "General" custom error message when Error 500 occurs; however, when users access l
non-database files (such as .HTM or .GIF files) via a Web browser and Error 500 occurs, the regular system error 
is incorrectly displayed rather than the "General" custom error message.

If the server-wide custom error form contains an embedded view, the custom error is not displayed when users l
access non-database files (such as .HTM or .GIF files) via a Web browser. Instead, users receive the generic 
system error message.
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Server

Unable to add X.509 certificate
If a user who exists in a secondary (trusted) directory requests an X.509 client certificate, the Certificate Authority 
application cannot add the client certificate to that user's Person document if there is another person in the primary 
directory with the same name.

Server

URLs should not contain .nsf except in database name
The Domino HTTP task assumes that the part of a URL that contains the file extension ".nsf" or ".ns4" indicates a 
Domino database. Therefore, in your Web applications you should not use these extensions anywhere other than with a 
database name. Do not use them in directory names or the names of database design elements. For example, you 
should avoid URLs such as:

www.acme.com/directory.nsf/sales.nsf/view.nsf?OpenView

Client

Use Replication History replicating NNTP and IMAP accounts
When you create an NNTP or IMAP account, you can click the Advanced tab to change the "Use replication history" 
setting. 

When set to Yes, the replication for NNTP or IMAP will be optimized to use the account's replication history. When set 
to No, the replication will search through every document in order to determine whether to replicate it or not, 
regardless of whether the document has already been replicated.

Client

Mac may run out of memory while retrieving list of NNTP Newsgroups

If you crash or hang while retrieving/refreshing newsgroup lists in an NNTP database, try increasing the size of your 
Macintosh's Virtual Memory pool.

Designer, Server

Servlets: Change in behavior of ServletRequest.getParameter
In Domino R5.0.1, the behavior of the following Java servlet methods has changed:

javax.servlet.ServletRequest.getParameter()
javax.servlet.ServletRequest.getParameterNames()
javax.servlet.ServletRequest.getParameterValues()

The behavioral change concerns the scenario where an HTTP POST request contains both a query string and a 
URL-encoded content body. In Domino R5.0, these methods would return parameters only from the query string; the 
content body was ignored. In Domino R5.0.1, these methods conform to the more standard handling of this scenario 
as follows:

1. If a POST request contains an encoded content body, the parameters are always obtained from the body. Any query 
string is ignored. To access the query string, use the method HttpServletRequest.getQueryString().

2. If a POST request does NOT contain an encoded content body, but has a query string, the parameters are obtained 
from the query string.

3. If a request does not contain either an encoded content body or a query string, no parameters are returned.
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Administrator Client

Java error using Webmail with Communicator 4.04

If error "SYS3175" in JAVAI.DLL occurs while using Webmail with Netscape Communicator 4.04 for OS/2 and the 
following is true:

you have Java 1.1.8 installedl

nojit is specified as an Optional Java parameterl

SYS3175 disappears when the browser is restarted after enabling the JIT in the Optional Java parametersl

...you need to obtain the fix for Netscape Communicator 4.0.4 for OS/2. 

To enable the JIT for troubleshooting:

Start Netscape Communicator 4.04 for OS/2.1.

Choose Edit->Preferences->OS/2 Preferences.2.

Click "IBM Java Properties."3.

In the Java Options/Enter Optional Java Parameters field, remove -nojit.4.

Click OK to save the Java choices.5.

Click OK to save preferences.6.

Restart Netscape Communicator 4.04 for OS/2.7.

Client

NNTP newsgroup header display problems
Using the Notes Client to open a document from an NNTP Discussion database can result in the NNTP header fields 
not getting displayed correctly (either missing or only partially visible). This has been found to be a problem only if 
your Bookmarks are pinned open and if your Notes window is not maximized.

Server

HTTP port conflict on Windows 2000 servers
Users who install Domino Server on a Windows 2000 operating system may find they cannot run the HTTP service, 
because a port needed to do this is already being used by the operating system.

If a user sees the following messages in the Domino log, then they will need to make a change to the Windows 2000 
configuration:

HTTP Socket bind error, hostname/ip <servername>
HTTP server: Could not bind port 80. Port may be in use
HTTP Web Server shutdown

Another indication of this problem is inability to view the server through a browser, as when using Webmail.

To change the Windows 2000 configuration:

Choose Start->Programs->Administrative Tools->Services.1.

Right-click on World Wide Web Publishing Service and choose Properties.2.

Under the General tab, click on the Startup type drop list and select Manual.3.

Click on OK.4.

Close the Service dialog box and restart Windows 2000.5.

When you run the Domino server you should now no longer see the error message in the log.6.
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Server

Single Sign-on and Tell HTTP Show Users
The console command "Tell HTTP Show Users" may be used for tracking user sessions. Servers participating in single 
sign-on, configured for multi-server session-based authentication may not  report sessions accurately using this 
command after a logout, when the logout doesn't occur on an SSO participating server. 

If a browser's cookie was created on a server (Server A), this command will display the user name, IP address, and 
cookie expiration time for that web server. If the browser then uses the cookie to authenticate with another server 
(Server B), tell http show users, will display this user session on Server B.

However, if the browser performs a db.nsf?logout url command on any server, whether the cookie originated on that 
server or not, that server will not display the user session after this command is issued. If the logout occurred on 
Server B, for example, Server A will display the session as still active until it expires, but the cookie has been 
invalidated and the browser will be re-prompted for authentication if it tries to access Server A.

LDAP client

Client

Update full-text index for LDAP client searches
When using the LDAP client to search local address books, you must update the full-text index of local address books 
after adding or editing entries.

Client

User authentication via Internet certificate with LDAP client
When an LDAP Account document is configured with the Advanced fields "SSL" and "Send SSL certificates when asked" 
enabled, also enabling "Attempt authenticaton using SSL certs first" allows the client to authenticate with the LDAP 
server using the credentials supplied by the Internet certificate passed during SSL negotiations.

Client

Using the LDAP client to search Local Address Books
If the search query is not well defined and generates excessive entries, then it is possible that the LDAP client will l
not display all entries. 

Since phone numbers can have different separators, it is best to search for a set of contiguous digits. For l
example, if you are looking for a phone number such as (123) 456-7890 search for the area code 123 or the 
exchange 456.

Mail issues

Client

Addressing mail to Internet contacts
When you address e-mail to an Internet contact listed in your personal address book, such as "Jane Smith", the 
address is replaced with the Internet address only, for example, jsmith@xyz.com, and not the full name that includes 
the phrase "Jane Smith." If you want the address to include a phrase, ensure that the e-mail address includes a 
phrase, such as:

"Jane Smith" <jsmith@xyz.com>
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Client

Alternate Memo Editor - known issues
Microsoft Word 95/97 (versions 7.0 and 8.0) and Lotus Word Pro (Millennium edition/version 9.0) are supported l
as alternate memo editors. Lotus Word Pro 97 is supported, although Lotus recommends you upgrade to Word 
Pro (Millennium Edition) in order to take advantage of new ActiveX features. Lotus Word Pro 96 is not supported 
as an alternate mail editor.

You may experience redraw issues when switching back and forth between the salutation of a new alternate memo l
and the body of the memo. You may also experience this issue when selecting one of the action buttons (such as 
Send) after switching back and forth between the salutation of a new alternate memo and the body of the memo.

Printing from within the alternate memo editor results in three print jobs. The rich text field, the OLE object, and l
the document with the mail header all print. Printing an alternate memo editor from a view results in one print 
job.

The Alternate Memo editor is not supported on the Macintosh since OLE is currently not supported.  In the "Mail l
and News" panel of Notes Preferences, there is an option for Alternate Document Memo Editor. Since this feature 
is not currently supported on Macintosh, the selection should be set to "None."

Client

Cannot connect to two mailboxes on same server
You cannot connect to two mailboxes on the same server. 

Server

Configuring languages
The following example shows how you might configure Character Conversions for your system. While this example 
shows a configuration for Vietnamese, it could be used for other language groups.

Setting up the Configuration Settings document

From the Domino Administrator, click the Configuration tab and then expand the Messaging 1.
section.

Choose Configurations.2.

Click Add Configuration to create a new Configuration Settings document.3.

On the Basics tab, complete the following fields:4.

Field Enter

Use these settings as the default settings for 
all servers

Check yes

International MIME Settings for this 
document

Check Enabled

Optimize LDAP queries Yes

On the LDAP tab, select 5.

Field Enter

Choose fields that anonymous users can 
query via LDAP

List the appropriate fields
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On the MIME -Basics tab, complete the following fields:6.

Field Enter

Primary character set group Vietnamese

Secondary character set group Unicode

On the MIME - Settings by character set group tab, complete the following fields:7.

Field Enter

For outbound message options below use all 
possible choices

Check the box to indicate that all character 
sets are available during configuration of the 
headers and message body parts.

MIME settings by character set group Vietnamese

On the MIME - Advanced - Advanced Inbound Message Options tab, enter the following field:8.

Field Enter

For non-MIME messages or MIME messages 
with an unknown character set, 8-bit 
character set is assumed to be

Windows-1258

On the MIME - Advanced - Advanced Outbound Message Options tab, enter the following field, and save the 9.
Configuration Settings document.

Field Enter

When a Notes user sends a multilingual 
messages

Send it in most representable charset

Create a Foreign SMTP domain document.10.

Create a Global domain document.11.

Edit the Server document as follows: On the Internet protocols tab, enter the following and save the document.12.

Field Enter

Allow HTTP clients to browse databases Yes

Client

Creating a new memo with automatic signature enabled
If you're creating a new memo and receive a message stating that the file does not exist, then it's possible that the 
automatic signature feature is enabled, but the signature file that it's referring to no longer exists.
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Administrator Client

Design element replication during mail file move process
If the administration process creates a replica of a mail file on the new mail server during a mail file move, all private 
design elements in the mail file on the old mail server replicate to the new mail server. Private design elements 
include folders, view, and agents. 

If a replica of the mail file already exists on the new mail server, the private design elements in the mail file on the old 
mail server will not replicate to the new mail server.

If private design elements are added to the mail file on the old mail server after the replica has been created on the 
new mail server, the new private design elements do not replicate to the new mail server.

Server

Do not use both sendmail and SMTP on UNIX
Sites with UNIX platforms running the sendmail daemon should not enable the optional SMTP component of Domino 
on these machines. In the default configurations, each respective program attempts to use port 25 to provide service, 
but only one will be successful in obtaining the port. Therefore, it is recommended that you enable either the sendmail 
daemon or the SMTP component, but not both, when SMTP services are required. The normal caveats apply to SMTP 
services of a machine if the service is not running.

Server

Do not use sendmail on AIX
On the AIX platform only, to ensure inbound mail is received from Internet mail clients and directed to Lotus Notes 
clients, stop the sendmail daemon on the Domino server.

Client

IMAP client - known issues
For best results, recreate any proxies from previous versions of Notes.l

You may experience problems using the Welcome Page if you have a proxy database listed as your mail database l
in your Location document. Specifically, since the proxy database does not contain Calendar Information or To 
Do lists, you will get an "Invalid or nonexistent document " error message when trying to create a new Calendar 
Entry or To Do from the Basics Welcome Page. Also, the other Welcome Page styles may display an error 
message in the frames containing the Inbox and Calendar views.

If the Drafts or Sent folders are removed from the proxy, you receive an error when trying to save drafts or send l
mail. Either recreate the folders or change your Account document Configuration Options to save drafts and sent 
mail to your Inbox or some other folder.

There is no way to add a certificate to the address book directly from a signed message in an IMAP proxy. You l
must have the recipient's certificate in order to send encrypted mail over the Internet. As a workaround, you can 
either download the message into an R5 mail template via IMAP offline mode or POP3, or you can use LDAP to 
retrieve the certificate when sending encrypted mail. You cannot rename a folder on a Netscape server from a 
Notes IMAP client database.

To get new mail notifications from your IMAP proxy database, you must:l
Set your mail program to Lotus Notes in your Mail User Preferences.1.
Enter the name of the proxy in your location document.2.

In some circumstances, Netscape's V3.0 Messaging server does not completely delete folders that have l
contained messages or that contain subfolders. These folders are turned into No Select folders.

Appending messages to a Cyrus server may cause the error "cannot find the message's UID". If this happens, l
close the message without saving, and try again.

cc:Mail servers do not currently support the storage of MIME, which results in HTML tags appearing in the body l
of messages. The text\html part of the message is stored as text\plain by the cc:Mail server.
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You can not replicate an IMAP Server Proxy database connected to a cc:Mail server.l

A Notes IMAP client database cannot be used with servers that do not conform to the IMAP specification RFC l
2060, regarding BODY [HEADER.FIELDS]. Alta Vista servers and cc:Mail servers prior to version 8.30 do not 
conform to this specification.

These servers cannot correctly interpret the following standard IMAP command:

FETCH  X:Y (BODY [HEADER.FIELDS  (FROM DATE SUBJECT MESSAGE-ID)])

which Notes uses for summary information regarding messages in an IMAP mailbox. Notes uses this command 
to improve performance when opening an IMAP Server Proxy database. X:Y represents a message set.

Server

IMAP exact message size
The default for the "IMAP server returns exact size of message" field on the Configuration Settings document is set to 
"enabled."  If non-MIME messages are being handled by the IMAP server requiring exact message size, the server must  
convert every message to MIME just to display its summary information. Therefore, Lotus strongly recommends that 
you disable this field for performance purposes if you are using clients that work with an estimated message size. If 
you are using Netscape Navigator 4.5 and above or Pine as a browser, you need to use the default.

Server

IMAP proxy error when connecting to Netscape server
The Netscape server may drop your connection when using the IMAP proxy if it encounters a bad message.  You 
receive the error "Remote system no longer responding."  Netscape will continue to drop the connnection until the 
faulty message is removed.

Client, Server

International MIME settings are not reloaded
When you change the International MIME settings in a Personal Address Book on a client, they automatically reload, 
however, they do not automatically reload in the Domino Directory. 

Also, the International MIME settings are currently not loading from group-specific Configuration Settings documents.

Client

Mail Rule issues
The Mail Rule condition "Internet Domain"  may not work for all incoming Internet mail.l

When creating a Mail Rule, the system incorrectly allows you to choose a private folder. Mail Rules cannot move l
mail into private folders.

When editing a Mail Rule in Netscape Navigator 4.5, you may see old cached data. Click on the refresh button of l
the browser to insure the data is current.

Client, Server

Moving mail files
When a user's R5 client recognizes that the location of their mail file has been moved, the client tries to post an 
administration requests to the Administration Requests database on the user's new mail server. If the person does not 
have access to the new mail server, this request is not posted. As a result, the mail file on the old mail server is not 
removed.
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Client

No such entry error when replying to mail from a R4.6 user
If you encounter the error "no such entry" when replying to mail to another in the same Notes domain, you can 
successfully work around the problem by "fully qualifying" the address in the To: field. For example, if you are replying 
to Jane Doe/East/Acme, append "@domain" to the address, where "domain" is the name of the Notes mail domain. For 
example, Jane Doe/East/Acme@Acme

Client, Server

Non Delivery Reports do not preserve non US ASCII Subject fields
The Router, when it generates an SMTP DSN style Non Delivery Report, fails to select an appropriate character set in 
which to encode the delivery report text if any of the text is not US ASCII. As a result, the subject, if not in US ASCII, 
will not be readable in the Non Delivery Report text sent via SMTP.

Client

Opening folders on cc:Mail IMAP server
If messages in the Sent or Drafts folder on a cc:Mail IMAP server won't open from a Notes IMAP client database, you 
can press Control-Break to resume normal operations.

Client

Pasting messages into Cyrus IMAP Proxy
When you try to cut and paste using a Cyrus IMAP client, you may get the following error message "Cannot find the 
message's UID."  The workaround is to select "Paste" again from the "Edit" menu.  No error is displayed the second 
time.

Client

Prevent Copying stops printing, forwarding, reply with history
A Notes mail user can use the delivery option "Prevent copying" to send documents that cannot be shared with others. 
Recipients who try to print, forward, or reply with history to the e-mail receive the error "Unable to execute the 
specified command."

Server

Problems using the -s option with convert
When using convert, the mail file conversion utility, you can use the -s option to prevent the utility from upgrading any 
folders when converting a mail file. However, when upgrading from R4.6 to R5, the option also prevents the Inbox 
folder from being upgraded. This results in the following error appearing when the database is opened:

Illegal circular USE: Object Variables

To work around this problem, edit the design of the mail file being converted. Enable the "Prohibit design refresh or 
replace to modify" check box in Design Properties, then re-run the conversion utility without the -s option.  

Note: The upgrade by mail notification sent by an administrator to an end user does not use the -s option.

Client, Server

R4.x clients cannot use inline images served from UNIX
If a native MIME message is accessed by an R4.x client, or replicated to an R4.x server, the R5 server converts the 
message to CD records on the fly. If the native MIME message contains inline images, the image conversion may fail, 
with the result that the images are converted to attachments that cannot be accessed by an R4.x client. When an R4.x 
client displays the message, attachment icons appear, but attempts to view, launch, or detach them result in the error 
"Invalid or nonexistent document".
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The original native MIME message will still contain the images and can be successfully accessed using an R5 client or 
a Web browser.

This problem always happens if the R5 server is a UNIX server; on NT servers it happens rarely, if at all. The problem 
affects only inline images; image attachments are not affected.

Client, Server

R5 clients unable to read R4.x encapsulated messages
When a message is encapsulated on an R4.6x client and transported over the Internet via SMTP to an R5 server, the 
message is not converted correctly for recipients whose Person document field "Format preference for incoming mail" 
is set to "Prefers Native MIME" or  "No Preference." The message appears as an ENCAP2.OND attachment that cannot 
be viewed by the R5 client.

Client, Server

Replies may be encrypted by default
If a recipient's person document indicates that all received mail should be encrypted on reception, whenever such a 
recipient replies to a message, the reply will by default be encrypted. All replies can be sent encrypted if desired, or 
the end user can select the delivery options dialog and disable encryption if they desire.

Client

Retrieving duplicates in a mail replica
When you choose not to use replication history for replicating your mail onto the server, duplicate mail messages may 
appear. That's because when you select "No" for the prompt "Use Replication History," Notes doesn't check to see if the 
message is already on the server.

You should, however, not see duplicates when you replicate to a local mail file.

Client

Sending Notes documents to other Notes users over Internet
The Advanced Delivery Option to send Notes documents to other Notes users over the Internet only functions if the 
outbound Internet mail server is running the pre-R5 SMTP MTA. This option is intended to support R5 mail users 
sending Notes mail to pre-R5 Notes mail users over the Internet only.

Client

Sent mail format versus saved mail format
R5 users who save their sent mail should be aware that the saved format of their mail may be different from that which 
was sent to Internet users. Saved mail is almost always Notes Rich Text, whereas Internet mail will often be sent in 
MIME format.

Server

SMTP inbound recipient control fields do not expand groups
The Server Configuration document in the Domino Directory allows you to restrict who in your organization can receive 
mail from external Internet domains. You set these restrictions on the Router/SMTP -> Restrictions and Controls -> 
SMTP Inbound Controls tab, under the Inbound Intended Recipients Controls section, in the fields "Allow messages 
intended only for the following Internet addresses" and "Deny messages intended for the following internet addresses." 

If you enter a group in one of these fields, the SMTP listener task does not expand the group into the group's members 
and the restriction does not work. For example, the Acme corporation has a group named Support in its Domino 
Directory that contains the members Jane Doe and John Smith. If Acme included "Support@acme.com" in the "Deny 
messages intended for the following internet addresses" field of its Server Configuration document for Internet mail 
servers, the server will reject mail to the address "Support@acme.com". However, the server does not reject mail for 
Jane Doe and John Smith, since it does not expand the group Support into its constituent members. This will be fixed 
in a future release.
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Server

When Using SMTP on OS/2 or UNIX, verify the port is unclaimed
When loading SMTP on OS/2 or UNIX platforms, ensure the port (25) is not enabled by another mail system.  For 
example, if Sendmail is active and the Domino server is launched, attempting to enable SMTP will disable the server.

Client

Switching to Prefers MIME
If, after using Notes mail and receiving messages, a user decides to change their preference from "No Preference" or 
"Prefers Notes Rich Text" to "Prefers MIME", and they then begin using an Internet client to access their mail, they may 
find that Notes Rich text messages they received take longer to retrieve from Internet clients. This is because the 
messages need to be converted from Notes Rich Text format to MIME on the fly during download to the client. These 
users should increase the message download timeouts on their Internet clients to prevent timing out when very large 
messages need to be converted.

Client

Text color not converted from HTML to Notes Rich Text
Text color attributes are not preserved when a message is converted from MIME/HTML format to Notes Rich Text.

Client

Webmail issues
If you use a browser to access folders that were created in Notes R4, they do not use the new View and Action l
Bar applets.

You are unable to read encrypted mail from a browser.l

Using the Next or Previous actions may cause the browser to stop displaying the View/Folder pane.l

If you add colored text to the body of the e-mail, the color attributes are lost if you send the message to a Notes l
user or another Webmail user. 

If you reply with history to a message from your inbox, the header that is generated in the rich text field may l
show your e-mail address first, and a "Sent by:" with the actual sender's e-mail address below yours. This should 
not interfere with sending the reply to the correct person.

If you are using a mail template to send mail to someone using Webmail, do not encrypt the mail because the l
encryption files are not used by a browser. Therefore, the mail cannot be decrypted at the browser.  Also, 
Webmail users cannot process meeting invitations that were sent from a client that had encrypt option set.

Users do not have the preference settings available to toggle the display of Calendar Entries in the All Documents l
view, nor is the ability to toggle the display of meeting invitations in the Sent View available. This will be 
enhanced and added in a future release.

Webmail users whose mail files are located in a directory other than the data directory local to the server receive l
the following error message after they send a message or create/respond to a calendar entry:

Error 404 HTTP Web Server: Lotus Notes Exception - File does not exist 

For example, if the server administrator has created a database link to the mail file (to the directory 
G:\MAIL\MYMAIL.NSF) instead of having the mail file located locally on the server 
(C:\DOMINO\DATA\MAIL\MYMAIL.NSF) the error occurs.

Beginning in R5.0.1, Domino Java applets have been improved and now require the use of Netscape Navigator l
4.x, Microsoft Internet Explorer 4.01 (or higher), or a compatible release browser.  Therefore, it is recommended 
that you use a 4.x (or higher) version of these  browsers when accessing Webmail.  Refer to the "Minimum 
browser support for Domino Java Applets" table in the General Certifications and Requirements section of the 
Release Notes.
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Client

Why can't I see certain mail features mentioned in the Help?
If you are running the Notes R5 client and you cannot see certain mail features, such as the Tools button in the action 
bar, it is likely because your Domino administrator has not updated your mail server to Release 5. Without Release 5 
mail server support, you cannot use the Notes Release 5 mail template that contains this functionality. The Tools 
button helps you change mail preferences, specify out-of-office settings, insert signatures, and use other features new 
to Release 5.

Client

Why won't Webmail work with Netscape 4.6 ?
A bug was introduced in the Netscape 4.6 implementation of LiveConnect that affects the Domino Java Applets.  The 
use of Netscape 4.6 is not recommend for Webmail, since it may generate a security exception and eventually cause 
the browser to hang.

Server

IMAP folders - unsupported feature

Any folder name prefixed by "$" or "( )" would not be visible to either a Notes client or an Internet client. These folders 
would be flagged as either a System or Hidden item.  This feature is unsupported in 5.0.1a.

       folder flag = 16 means folder is system 
       folder flag = 32 means folder is hidden 
       folder flag = 48 means folder is system and hidden. 

The folder is NOT visible to the IMAP client if: 

        folder flag = 48 and not named "inbox" or "trash" 
        folder flag = 16 
        folder flag = 32 

Server

"Convert tabs to spaces" option should be disabled
The current cvs code does not support the Convert tabs to spaces option in the MIME - Conversion Options 
(Outbound) section in the Server Configuration document. 

When this option is enabled, it will prohibit transfer of outbound SMTP messages with the reason: "Cannot convert 
Notes Rich Text message to MIME message." 

Client, Server

Outgoing MIME content transfer encoding problem
Several subsystems incorrectly calculate the user's or administrator's outbound content transfer encoding preference. 
(This preference item is used when 8-bit MIME text parts are written into a MIME stream that is not 8-bit clean.) The 
preference is set in the location document for the client and in the configuration doc for the server. 

If this problem exists, it is impossible in certain parts of the product to get base64 encoding of parts whose content 
type is text, no matter how the encoding preference is set. This problem is scheduled to be fixed in a future release.
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Administrator Client

Short To/From fields using Webmail with Communicator
When using Webmail with Netscape Communicator 4.61 for OS/2 the "To" and "From" entry fields for sending mail 
may be short. To remedy this situation, change the default font as follows:

1. Start Netscape Communicator 4.61 for OS/2.
2. Select Edit->Preferences->Fonts.
3. In the Fixed Width Screen Font field, select any font except Courier New. For example, select Courier.
4. Click OK to save the new font selection.
5. Click OK to save preferences.
6. Restart Netscape Communicator 4.61 for OS/2.

Server

Revert to R5 handling of Foreign SMTP Domain documents
R5.0.3 adds multiple relay support utilizing Foreign SMTP Domain documents. In R5 these documents were ignored 
unless SMTP External was disabled. For customers wishing to maintain the current R5 behavior the following 
NOTES.INI variable should be used:  RouterIgnoreForeignSMTPDomains=1.

Note: This change will affect only customers with an R5.x server with SMTP External enabled and Foreign SMTP 
Domain documents in the Domino Directory who got used to R5's behavior.

Server

POP3MarkRead variable in NOTES.INI with Notes and POP3 clients
If you set the POP3MarkRead variable in the NOTES.INI file, and you access the mail database at the same time from 
a POP3 client and a Notes client, the server may not mark the mail as "read" in some cases.

Server

SMTP Internal must be enabled to Pull messages from internet hosts
In order to successfully pull messages from external SMTP hosts via ETRN it is currently necessary to enable SMTP 
Internal. This setting can be found in the Server Configuration document: Router/SMTP -> Basics -> "SMTP allowed 
within the local internet domain" = MIME messages only.

Administrator Client

Create DOLS/MAPI users with ASCII characters only
When an administrator creates a new DOLS/MAPI user, the user's name, short name, and the mail file name should 
be created using ASCII characters only.

Client

Outlook "Sticky Notes" cannot be accessed via the iNotes Client
Outlook users who use the "Sticky Notes" feature to create a note, and subsequently attempt to access that note via 
the iNotes Client, will receive an error message stating "Cannot locate Form: Sticky Note".

To access "Sticky Notes" when working with iNotes Access for Outlook, users need to create a customized "Sticky Note" 
form.

Administrator Client

Selecting mail preferences for Arabic and Hebrew MAPI users
Arabic and Hebrew MAPI users need to select either "Prefers MIME" or "No Preference" in the Person document of their 
server's name and address book, to avoid any issues with handling Rich Text characters.
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Client, Server

Installing iNotes Access for Outlook 98 (Japanese or Dutch)
If you use iNotes Access for Microsoft Outlook with Outlook 98 Japanese or Dutch, follow these steps:

Go to mail file via your browser. Start the installation.1.

After the installation, you will get a message saying the Notes MAPI provider has been successfully installed.2.

Before starting Outlook 98, you need to change the file name in Lotus iNotes directory:3.

Change: nmstrings.dll --> nmstrings2000.dll
Change: nmstrings98.dll --> nmstrings.dll

Start Outlook 98.4.

NOTES: 

Japanese or Dutch Outlook 2000 users don't need the steps above. However if Outlook 2000 users migrate back l
to Outlook 98, they will need these steps.

If Outlook 98 users migrate to Outlook 2000, they must uninstall Lotus iNotes first, then install iNotes l
components again.

Client

Webmail does not display all folders
Webmail users may not be able to see all of the mail folders they have previously created in Notes Client. This may 
occur in two cases:

"Private Folders" are unavailable for viewing through a browser because they require the use of a Notes ID, which 1.
is not used in WebMail.

"Shared Folders" may need to have the browser cache cleared. Clearing the cache will allow Shared Folders to 2.
display properly.

Client

Mail Rules Disable All
There are instances when pasting rules into your rules folder cause unexpected results. This is due to the Rules 
Information on the Calendar profile falling out of sync with the rules in the rules folder. To correct this problem, from 
the Rules folder select All Rules and then select the Disable Rule(s) action. This will reset the note items on the 
Calendar profile and when you later enable the rules, they will be correctly in sync.

Client

Using encryption when sending to a group in the DirCat
With Release 5.0.6, a problem with mail not being delivered when sent disconnected, with encryption, to groups in a 
Directory Catalog only, has been addressed.  This regression was introduced in 5.0.3. 

This Release Note outlines the specific circumstances of this issue in releases prior to Release 5.0.6, and the steps to 
work around the problem.  

Problem

While working in local (disconnected) mode, you create and send an encrypted email to a group located in the 
Directory Catalog.  The message appears in your local mailbox.  However, when you connect to the server to transfer 
mail, the e-mail message never arrives.

Solution:

This issue occurs only when all of the following conditions are true:

1. You must be working disconnected from your Domino server.

2. You must create and send an e-mail message.
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3. The message must be addressed to a group.

4. The group must reside in the local Directory Catalog.

5. The  'Encrypt' Delivery Option must be selected.

If all five of the conditions listed above are met, the e-mail message is lost.

This issue occurs because mail goes through a lookup to resolve addresses when being moved into a mail.box.  In 
disconnected mode, there is a second lookup when the mail is moved to the server.  This second lookup mistakenly 
assumes the address is already fully qualified as a result of the first lookup; however, the address is not already fully 
qualified in the first lookup when using a group out of a Directory Catalog.  DirCat does not have the necessary 
members list, so this can only be resolved at the second lookup.  So, when you connect the group name is not 
expanded and Notes attempts to encrypt the group name as if it  were a user.  This is the cause of the failure.  No 
mailbox is opened in the router and the email message is lost.  The sender does not receive a Delivery Failure report.

This is a regression that was introduced in 5.0.3.  As a workaround for all 5.0.3 - 5.0.4 users that send encrypted mail 
by default, you can create a separate directory catalog and include the field "members".  These 5.0.3 - 5.0.4 users can 
then use that directory catalog.  For 5.0.5 users, please be advised that this problem can exist undetected and can 
only be fixed by upgrading to the 5.0.6 client.

Administrator Client, Server

Converted rich text messages display MIME information
Notes users who have Person documents in which the Format preference for incoming mail is set to Notes rich text 
may see MIME boundary strings, HTML tags, and other MIME part information in the body of messages received from 
Notes 5.0.5 and earlier Clients.

The workaround is to upgrade all Notes Clients to 5.0.6 or later.

Migration

Administrator Client

Incorrectly maps fonts in Japanese-language messages
When converting messages from environments that use the Japanese character set (codepage 932), the migration tool 
for cc:Mail incorrectly maps font settings in the message text as follows:

cc:Mail Notes

MSP Gothic MS Gothic

MSP Mincho MS Gothic

MS Gothic MSP Mincho

MS Mincho MSP Gothic

Client

Issues in Migrating from Organizer to Notes

Users must use the Notes client in order to run this migration utility since this migration involves creating a local l
database.   The migration utility cannot be executed via a browser.

When Notepad entries are migrated from Organizer into Notes, the OLE objects that existed in the Notepad l
section cannot be opened in the Notes Journal database. The objects, however, can be re-created in the Journal 
database by following these steps, in order:

Launch the application that was used in the OLE object in the Organizer Notepad (MSPaint for example).1.
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Select all of the Organizer OLE object's content and copy it to the clipboard.2.

In the Notes Journal database create a new OLE object using the application (MSPaint) and paste the 3.
clipboard contents into the new OLE object.

Save the new information into the Journal database.4.

Information contained in an Organizer Call entry under the Dialing Properties is not mapped to Notes.    If you l
wish to access that information, paste the data in the "Notes" tab of the Call entry which is mapped to the 
Description field of the new entry in the Notes To Do document.

Administrator Client

Long cc:Mail folder name may not be migrated
cc:Mail folders whose names are longer than Notes limitation may not be migrated correctly. Before using the 
migration tool, these folder names should be truncated.  Folder name limitation:

Individual folder name: 64 bytes in LMBCS
Hierarchcal folder name: 128 bytes in LMBCS

Administrator Client

Long Exchange folder names may not be migrated
Exchange folders whose names are longer than the Notes limitations may not be migrated correctly. Before using the 
migration tool, these folder names should be shortened.  Folder name limitations:

Individual folder name: 64 bytes in LMBCS
Hierarchcal folder name: 128 bytes in LMBCS

Administrator Client

Long Microsoft Mail folder names may not migrate correctly

Microsoft Mail folders which names are longer than Notes limitation may not be migrated correctly. After the 
migration, the long folder names will be truncated or the hierarchy will be changed.  As a workaround, you should 
shorten the names before migrating.  Folder name limitation:

Individual folder name: 64 bytes in LMBCS
Hierarchcal folder name: 128 bytes in LMBCS

Administrator Client

Notes log may have garbage characters after migration
The Notes log may have garbage characters after Microsoft Mail migration. This is a cosmetic problem, and won't 
have affected the migration.

Administrator Client

Using Microsoft Mail Migration tool in non-ASCII environment

The Microsoft Mail Migration tools may not be able to migrate non-ASCII characters in some fields (group 
member names, for example). To avoid this problem, perform the following steps:

Replace the following eight DLLs with the equivalent localized DLLs. These DLLs can be found on the 1.
Windows NT 3.51 installation diskettes or CD.  Use the EXPAND utility to expand and copy these files to your 
Notes directory.

ab32.dll
demil32.dll
frame32.dll
mailm32.dll
mssfs32.dll
pabnsp32.dll
store32.dll
vform32.dll
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Modify the three resource strings in nmmget.dll to match their counterpart resources strings in the Microsoft 2.
Mail client. To determine the resource strings used in your version of the Microsoft Mail client, perform the 
following steps:

Select  Mail  Address Book...l

Click the 'Open Directory' button in the upper-left corner of the 'Address Book' dialog to display the l
'Open Directory' dialog.

The resource strings in nmmget.dll must match the resource strings which appear in the 'Open l
Directory' dialog.

The resource strings used in the Microsoft Mail client are in the file mssfs32.dll.  Alternatively, you can use a 
text editor or text search utility on this file to locate the resource strings used in the Microsoft Mail client.

To modify the nmmget.dll file using the Microsoft Visual C/C++ 6.0 compiler, perform the following steps:

Choose File->Open...l

Open the nmmget.dll file as a 'Resources' file.l

Expand the nmmget.dll hierarchy by clicking on the '+' iconl

Expand the String Table hierarchy by clicking on the '+' iconl

Right-click the 'String Table'l

Select 'Properties' from the menul

Select the appropriate language in the 'Language' list.l

Close the 'Properties' dialog.l

Double-click the 'String Table' to display the resource strings.l

Double-click each resource string and modify to match the string used in the Microsoft Mail client.l

Save the modified resource strings.l

Save and Close the nmmget.dll filel

Administrator Client

Full read/write access to cc:Mail post office is required by cc:Mail migration software
In order to ensure sucessful completion of data migration from a cc:Mail post office to a Notes Mail database, full 
read, write, and create access must be available to the files and directories associated with the cc:Mail post office. 
Potential problems include: failure to login to the post office, or a Fatal Application Error.

Administrator Client

Exchange DUS does not migrate recipient lists >64KB
When migrating messages from Microsoft Outlook/Exchange to Domino, each recipient list ("Send to", "CC", and "BCC") 
in a message is limited to 64KB. Recipient lists longer than 64 KB are not preserved during migration. and are left 
blank in the resulting Notes message. An entry in the Notes Log reports that the list exceeded the Notes limit of 64 
KB.  

The message body is migrated intact. 

The limit applies independently to each recipient field in a message. Recipient lists smaller than 64 KB convert 
properly. For example, if a source message contains a "Send to" list of more than 64KB, but the list in the CC field is 
only 32KB, after migration the "Send to" list in the Notes message is empty, but the contents of the CC field are the 
same as in the original message. 

Administrator Client

Empty cc:Mail bulletin boards not migrated
When migrating a cc:Mail post office, if you select the "Convert bulletin boards to Notes discussion database" option, 
only bulletin boards that contain at least one message will be migrated. Empty cc:Mail bulletin boards do not migrate.
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Administrator Client

Migrating non-ASCII character data from Organizer and cc:Mail
The cc:Mail migration tool does not support migration of Organizer 2.x data from languages that use non-ASCII 
characters in single-byte or double-byte character sets. This restriction applies only to the migration of Organizer data.

The R5.0.8 version of the migration tool supports the migration of cc:Mail data from the following languages: 
Japanese, Simplified Chinese, Traditional Chinese, Korean, Western Europe (including but not limited to France, 
Italian, German, Spanish, Portuguese, Danish, Dutch, Norwegian, Swedish, and Finnish), and Central European 
(including but not limited to Czech, Hungarian, Polish, Slovenian, Romanian, and Russian).

In addition, the cc:Mail migration tool does not currently support the migration of either cc:Mail or Organizer data 
from bidirectional languages, which read from right to left (such as Arabic and Hebrew).

Administrator Client

cc:Mail upgrade wizard not supported with R8 clients
The cc:Mail upgrade wizard (end-user migration tool) is designed to work primarily with cc:Mail R2.x or R6.x clients 
and was designed to read certain information, such as a user's personal addresses and the location of the user's 
archive files, from .INI files residing on the workstation. 

Unlike earlier versions of the cc:Mail client, the R8 client does not store information in .INI files. As a result, when 
users migrating from R8 run the upgrade wizard, they cannot migrate personal addresses and must browse for and 
select the location of archives (.CCA files) to migrate. This is being examined as a possible fix for a future release. R8 
users can use the upgrade wizard to successfully migrate private mailing lists.

Administrator Client

Initialization failure during cc:Mail migration
When opening a cc:Mail post office for migration, the following error message may appear:

Initialization of cc:Mail Migration engine failed 

If you encounter this error, do the following:

Verify that you have the correct post office name, path, and post office password, and attempt to connect to the 1.
post office again. 
If you still receive the same error after entering the correct post office information, it is possible that the 
CCVER.TB file for the post office may have been corrupted. 

Copy the existing CCVER.TB file to another location and then delete it from the post office directory. 2.

Obtain a good copy of the CCVER.TB file from a backup, copy it to the cc:Mail post office directory, and then 3.
resume the migration.

It is possible to get this same error (Initialization failure during cc:Mail migration) if the user 
attempting to access the post office does not have full access to the volume on which the post office is located.  For 
example, if the the user had read only access to the post office then this error would occur.

Administrator Client

Read and unread marks not preserved during cc:Mail migration
Read and unread marks may not be preserved in messages migrated using the cc:Mail migration tool.

Administrator Client

Second mail file created when re-migrating cc:Mail R6.3 users
Re-migrating the mail box of a cc:Mail R6.3 user may result in inadvertently creating a second mail file for the user, as 
described in the following scenario:

Use the cc:Mail migration tool to migrate a user from cc:Mail to cc:Mail R6.3.  1.

After successful migration, open \CCDATA\NOTES.USR and note the mail and ID files that are listed.  2.
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As the administrator, re-migrate the user's cc:Mail mailbox. If you do not have access to the existing mail file, you 3.
are prompted to create a new mail file.  

After designating a unique filename, you are prompted to update the Person document in the directory. The user 4.
should be successfully migrated to a second mail file.  

Check the user's Person document and note that it points to the second mail file, as expected.  Check the 5.
NOTES.USR file and note that it still points to the original mail file. Notes mail is delivered to one file, while the 
user logs into another. 

To avoid this problem, do not create a second mail file for cc:Mail R6.3 users. If you anticipate having to re-migrate 
users' cc:Mail mail boxes, place yourself on the Access Control List (ACL) for those users' Notes mail files during 
migration (using the migration option "Add administrator to mail file access control list"), so that you can later 
combine mail files. 

Administrator Client

LDIF migration tool supported schema
The current version of LDIF migration tool supports a limited range of schema. The tool supports importing attributes 
for the following schema:

LDAPl

 X.500l

Internet White pagesl

If you export users from the Domino Directory to an LDIF file and then import the file using the LDIF migration tool, 
Notes attributes that do not conform to the supported schema are not imported.

Administrator Client

LDIF tool does import of countryname and c attributes
Previously, the LDIF migration tool did not import the LDAP attributes countryname and c. 

Beginning in R5.0.1, these attributes are imported correctly as follows:

attribute c mapped to Notes attribute OfficeCountry 
attribute countryname mapped to Notes attribute OfficeCountry 
attribute HomeCountry mapped to Notes attribute Country

Administrator Client

LDIF tool does not import all attributes
The Domino migration tool for LDIF does not import the following attributes from entries in the LDIF file:

MailSystem l

AltFullnameLanguagel

MailSystem

The value of the Notes attribute MailSystem is intended to reflect a user's actual mail configuration. Prior to 
migration, an administrator specifies a value for this attribute based on the system to be used for exchanging e-mail. 
Because an imported value for this attribute could conflict with configuration settings set by the administrator, the 
migration tool does not import the MailSystem value.

AltFullnameLanguage

The value of the Notes attribute AltFullnameLanguage specifies the languages available for storing alternate language 
versions of a user's Notes name. For example, setting French as a value for this attribute lets you provide a user 
named Steven with a French alternate name, such as Etienne. The alternate languages available depend on the 
certifier ID used to register a user. You can give users alternate names only in those languages supported by the 
certifier ID.  
Before you perform a migration, the LDIF migration tool cannot determine whether the certifier ID being used supports 
the language specified in AltFullnameLanguage. Because of this, the migration tool does not import the value of 
AltFullnameLanguage.
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AltFullname

The migration tool does import the attribute AltFullname from user entries in an LDIF file, but Notes only uses the 
attribute if the administrator configures an appropriate alternate language (AltFullnameLanguage) for that migrated 
user. If the certifer IDused to register a user does not support the alternate language specified, Notes ignores the value 
of the AltFullname attribute.

Administrator Client

Why LDAP searches based on DN organization can fail
When you migrate a user from an LDIF file, if you select the option "Add full name provided to the Notes person 
document," the migration tool adds the user's LDAP distinguished name (DN) to the Notes Person document as a 
secondary user name. The primary user name is always derived from a user's First Name and Last Name components, 
together with the organizational information taken from the Certifier ID. This is true, even if the user is migrated as a 
directory entry only, and is not registered as a Notes user.

For example, if you used the /Acme Corp certifier ID to import the following LDIF file:

dn: cn=Bruce Bitter, ou=Product Development, o=Acme, c=US
objectclass: top
objectclass: person
objectclass: organizationalPerson
objectclass: inetOrgPerson
ou: Product Development
cn: Bruce Bitter
cn: BBitter
cn: BBitter Alias
sn: Bitter
givenname: Bruce
l: Boston
uid: bbitter
mail: bbitter@acme.com

After the migration completes, the following names appear in the User Name field of the Person document, regardless 
of whether you register the user:

Bruce Bitter/Acme Corp
Bruce Bitter
Bruce Bitter/Product Development/Acme/US
Bbitter
Bbitter Alias

Note that the organizational modifier for the primary name (/Acme Corp) is derived from the Certifier ID, not from any 
attribute in the LDIF file. 

LDAP searches of the Domino Directory examine only the primary user names in the Person document. As a result, if 
you specify a search base to limit the search to the organizational hierarchy found in the imported DN (/Product 
Development/Acme/US), the search would fail, since the specified base does not exist in the Domino Directory.  To 
correctly search the Domino Directory for this user, specify the search base "o=Acme Corp."

ldapsearch -l 300 -L -h server -b "o=Acme Corp" "(cn=Bruce Bitter*)"

If you are not sure of the correct base, do not specify a search base. When no base is specified, the search attempts to 
locate the user in all available hierarchies.
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Administrator Client

LDIF migration tool import changes in R5.0.2
Beginning in R5.0.2, some LDAP-to-Domino attribute mappings have changed. The following table summarizes how 
the behavior of the LDIF migration tool has also changed as a result. For more information about the attribute 
mapping changes in R5.0.2, see the release note "Schema changes in R5.0.2" under the Documentation updates 
chapter.

attribute R5.0 and R5.01 R5.0.2
middleName Imported to the MiddleInitial field Not imported. In R5.0.2, middleName is no longer 

included in the schema by default.
roomNumber Imported to OfficeNumber field Not imported. In R5.0.2, roomNumber maps to 

roomNumber. The import tool no longer imports the 
room number attribute, however. This is a known 
problem.

textEncodedORAddress Imported to X400Address field Not imported. In R5.0.2, textEncodedORAddress is no 
longer included in the schema by default. 

mhsORAddress Imported to X400Address field Not imported. In R5.0.2, mhsORAddress is no longer 
included in the schema by default.

street Imported to OfficeStreetAddress Not imported. In R5.0.2, street maps to the new, 
hidden field street. The import tool no longer imports 
the street attribute, however. This is a known problem.

postalAddress Imported to OfficeStreetAddress, OfficeCity, 
OfficeState, OfficeZip, OfficeCountry 

Not imported. In R5.0.2, postalAddress maps to the 
new, hidden field PostalAddress. The import tool no 
longer imports the postalAddress attribute, however. 
This is a known problem.

homePostalAddress Imported to HomeStreetAddress, HomeCity, 
HomeState, HomeZip, HomeCountry 

Not imported.  In R5.0.2, homePostalAddress maps to 
the new hidden field HomePostalAddress. The import 
tool no longer imports the homePostalAddress 
attribute, however. This is a known problem. 

Administrator Client

Cannot migrate Custom Recipients from MS Exchange
You cannot migrate Custom Recipients listed in the Microsoft Exchange directory. The Available people/groups list 
does not display the names of Custom Recipients. Also, when migrating Exchange groups (Distribution lists), Custom 
Recipients who are members of the group are not migrated and do not become members of the resulting Notes group.

Administrator Client

Does not migrate personal folders for non-ASCII names
The end-user upgrade wizard for Microsoft Exchange does not migrate data from the personal folders of users whose 
names contain non-ASCII characters from the following Windows code pages : Central European (1250), Cyrillic 
(1251), Greek (1253), Turkish (1254), Baltic Rim (1257).

Administrator Client

Does not properly convert bullets in Japanese messages
The Domino migration tool for Microsoft Exchange does not correctly convert bullet characters in messages migrated 
from environments that use the Japanese character set (codepage 932).
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Administrator Client

Does not properly convert Western European codepage characters
When converting messages, the migration tool for Microsoft Exchange does not correctly convert the following 
characters from the Western European codepage 1252:

– Ÿ † ‚ ƒ „ " … • œ

‡ — ™ ˜ ‰ Š š ‹ › Œ

Administrator Client

End-user wizard does not migrate Deleted Items folder
The end-user upgrade wizard for Microsoft Exchange does not migrate items from the Deleted Items folder of a user's 
Personal Folders.

Administrator Client

Ignore errors about messages without body content
The Domino migration tool and end-user upgrade wizard for Microsoft Exchange incorrectly report errors to the Notes 
log when migrating messages that have a subject line, but contain no message body. Ignore these log entries.

Administrator Client

Incorrectly maps fonts in Japanese-language messages
When converting messages from environments that use the Japanese character set (codepage 932), the migration tool 
for Microsoft Exchange incorrectly maps font settings in the message text as follows:

Exchange Notes

MSP Gothic MS Gothic

MSP Mincho MS Gothic

MS Gothic MSP Mincho

MS Mincho MSP Gothic

Administrator Client

Items displayed in Exchange migration tool Available people/groups list
After you connect to the Exchange server to migrate, the names of users available for migration appear in the l
Available people/groups list. The names in this list are imported from the Display name field of the Exchange 
directory, not from the Exchange First name and Last name fields. The migration tool parses the Exchange 
display name into the First name and Last name components of a user's Person document.

The Available people/groups list displays the object "Schedule + Free/Busy connector." This item is not a user, l
and should not be migrated.
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Administrator Client

Known MS Exchange message and folder migration issues
This release note lists message and folder information that may not be migrated along with a user's Exchange mail 
file.

Messages

The Domino migration tool for Microsoft Exchange does not migrate the following message items:

Attachments in messages where the attachment is preceded by an embedded object in the body of the message.l

Messages that are inserted within another message.l

Information in the BCC field of a message.l

CC recipient lists over 255 characters. Only the first 255 characters of the CC field are preserved during l
migration.

Read\unread marks.l

Some font information. The fonts used to display text in a migrated message may differ from those used in the l
original Exchange message.

Large Outlook "Notes" items. The Domino Administrator may hang while attempting to process these items.l

Receipts

The Domino migration tool for Microsoft Exchange does not migrate the following information in automatically 
generated messages:

Body text of Exchange return receipt messages marked read before migration and stored in the Exchange Inbox, l
Deleted Items, or Personal  folders. 

Body text for delivery confirmation receipts.l

Body text in undeliverable message reports.l

Return receipts for unread messages received by Outlook\Exchange users.l
 
For example, If Outlook\Exchange user A sends a message to Outlook\Exchange user B with a request to receive 
a return receipt, and the message remains unread prior to migration, after users A and B are migrated, if user B 
opens the message in Notes, user A does not receive the return receipt.

Folders

The Domino migration tool for Microsoft Exchange does not migrate the following folder items:

Subfolders within a user's Outbox, Sent Items, or Drafts folder. Messages within these folders are migrated to the l
All Documents view of the mail file.

Folder names containing the characters "\" or "|". These folders may be renamed during migration.l

Folder hierarchy for subfolders migrated from a user's Inbox and Deleted Items folders. Subfolders migrated l
from these locations are placed within a folder named according to the following format:

Exchanged[Inbox|Deleted Items]Subfolders

For example, after migrating a subfolder CurrentProjects from a user's Inbox, in the Notes mail file a folder with 
that name is placed within a folder with the name ExchangedInboxSubfolders.

Administrator Client

May not import Exchange user attributes with large DBCS values
The migration tool for Microsoft Exchange migrates certain user attributes to equivalent user attributes in the Notes 
Person document. In environments that use the code page for a double-byte character language, the migration tool 
may be unable to migrate values for the following Notes attributes if their Exchange equivalents contain large amounts 
of data: 

MiddleInitiall

OfficePhoneNumberl

OfficeFAXPhoneNumberl
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CellPhoneNumberl

PhoneNumber_6l

Assistantl

StreetAddressl

Cityl

Statel

Zipl

Countryl

PhoneNumberl

Commentl

The problem occurs only when the Exchange field mapped to one of these Notes fields contains excessive data. 
Otherwise, the fields are mapped correctly and migrate successfully.

Administrator Client

Owner field of Exchange Distribution lists not migrated
When migrating Exchange Distribution lists to Notes groups, information in the Owner field of the Exchange list is not 
migrated to the Owners field of the resulting Notes group. You can edit the Group document to specify an Owner, if 
necessary.

Administrator Client

Progress bar in Exchange upgrade wizard is inaccurate
When migrating a user's personal mail data, the progress bar displayed by the end-user upgrade wizard for Microsoft 
Exchange does not accurately represent the amount of data migrated. 

The upgrade wizard for Microsoft Exchange lets end users migrate personal addresses from two sources: Outlook 
Contacts and Personal Address Books (PABs). The upgrade wizard migrates Outlook Contacts, which are stored on the 
Exchange server, from a message attachment generated by the Domino migration tool and saved in the user's newly 
created Notes mail file. Outlook contacts can also be stored in a Personal Folder. 

From the upgrade wizard, when a user runs an Express upgrade or a Custom upgrade with the option to migrate 
Personal Address books, a progress bar shows how much of the available information has been converted to Notes. In 
this release, the progress bar only represents the amount of information converted from the Outlook Contacts, which 
were stored on the Exchange server. Therefore, it does not reflect the number of Outlook contacts which are kept in 
Personal Folders nor PAB entries.

The progress bar is also inaccurate in depicting the migration of information from Personal Folders.

Administrator Client

Exchange upgrade wizard not supported for Outlook Express
Exchange upgrade wizard (end-user migration tool) is designed to work for Outlook (Exchange client) migration. It will 
not work unless the user first exports their Outlook Express data to the Outlook client. When users migrating from 
Outlook Express, first they must export Outlook Express data to Outlook Client. After that, they can convert the 
exported Exchange data to Notes data.

Administrator Client

Microsoft Mail migration tool runs on Windows NT only
The Microsoft Mail migration tool in the Domino Administrator client only runs on Windows NT.  Windows 95 and 
Windows 98 have a conflicting dynamic link library (DLL) that prevents you from using the migration tool on these 
platforms.

Please note, however, that you can use the Microsoft Mail migration tool to migrate users from a Microsoft Mail post 
office to any Domino platform.  The Windows NT restriction applies only to where the migration tool itself can be run.
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Networking issues

Administrator Client, Client, Designer, Server

Authentication error in Windows NT clients
Due to a problem introduced by Microsoft in Windows NT Service Pack 4, a Windows NT client communicating over 
NetBIOS may return the following error:

Unknown authentication message type was received

This message usually appears when you try to connect to a non-Windows NT Domino server. To avoid this message 
you have to disable "DNS for Windows Resolution" in the Microsoft TCP/IP Properties for the Notes client.

Server

Domino availability on AIX using SPX protocol
Domino on AIX can experience periods of service refusal when connecting over the SPX protocol. In this scenario, the 
SPX listener task does not report any errors, and the service appears in the bindery as well. Clients receive a "server 
not responding" message. However, the clients can connect at a later time. This issue is under investigation.

Administrator Client, Client, Designer, Server

Issues with third-party WinSock services
Some third-party PPP dialers or TCP/IP proxy client services, as well as protocol tunneling software, replace your 
original WinSock services on Windows platforms. If you encounter connectivity problems after installing these 
applications you need to un-install them so you can recover the original WinSock services. You may also find the 
original DLL (Dynamic Link Library) file was renamed in your Windows directory so you need to switch the files 
around. If you encounter problems you may need to contact the third-party software vendor. Domino server and Notes 
client software require Microsoft's supplied WinSock DLL services supplied with Windows 95/98/NT

Note: WinSock 2.1 services from Microsoft are also supported.

Server

SPX port cannot be restarted on AIX
Attempts to use  "restart port spx" or the stop and start sequence of commands on an AIX Domino server can result in 
an unrecoverable listener failure for SPX. If this happens, it requires that Domino be brought down and back up again 
in order to accept client connections over the SPX protocol. 

Server

SPX with Token-Ring, FDDI, LAN/WAN topology networks
Windows 95, Windows 98, or Windows NT systems deployed with Microsoft's NWLink do not support large SPX 
network packets. This underlying protocol issue can cause problems on Token-Ring and FDDI, or in some cases, 
mixed LAN/WAN topology networks with IPX/SPX, generating the following Notes/Domino errors:

Client or Server Error Messages

Server Not Respondingl

Network Operation Did Not Complete in a Reasonable Amount of Timel

Remote System is No Longer Respondingl

Server Session Errors

Mail Router spawning multiple sessions to other server.l

Replication failures and spawning multiple sessions to other server.l

"Security context error" when using passthru server services.l
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There are two possible ways that you can correct the issue: 

Use the Microsoft-supplied client with a NIC driver that can constrain the Frame size.1.

Use the Novell Client services with an ODI NIC driver that can set the Link Support Layer maximum buffer size. 2.

One of these approaches should control the IPX/SPX Packet size, depending on your client services and NIC vendor's 
driver.

Microsoft stack

Depending on the NIC vendor's driver, you must either alter the interface properties or edit the Registry to adjust the 
frame size. Review the documentation that came with your adapter, or discuss your requirements with the interface 
vendor's support staff. Use the table below to determine the frame sizes setting.

Novell stack

The Novell client services offer a way to prevent the creation of SPX packets that are too large for the other system to 
accept by using the "Link Support Layer Max Buffer Size" setting to control the transport buffer size. You also need to 
use an ODI-based adapter driver for the LSL buffer setting to work. Review the documentation that came with your 
adapter, or discuss your requirements with the interface vendor's support staff. Use the table below to determine the 
needed LSL buffer setting to control the Packet size setting.

Topology/Frame type Frame size IPX packet 
size

SPX data 
size

LSL buffer 
size

Comments

Ethernet/DIX or RAW 1518 1500 1458 N/A Entry provided for reference only

Ethernet/802.2 LLC 1518 1496 1454 N/A Entry provided for reference only

Token-Ring/802.2 LLC 1522 1500 1458 1500 Optimized for SPX crossing Eth 
with DIX or RAW to TR with 
Bridges or Routers

Token-Ring/802.2 LLC 1518 1496 1454 1496 Optimized for SPX crossing Eth 
with LLC to TR with Bridges or 
Routers

Token-Ring/802.2 LLC 2048 2026 1984 2026 Required for older 4Mb adapters & 
networks using them.

Token-Ring/802.2 LLC 4096 4074 4032 4074 Optimized for performance

Token-Ring/802.2 LLC 4202 4180 4138 4180 Novell default frame size

Token-Ring/802.2 LLC 4500 4478 4436 4478

FDDI/802.2 LLC 1538 1500 1458 1500 Optimized for SPX crossing Eth 
with DIX or RAW to FDDI with 
Bridges or Routers

FDDI/802.2 LLC 1534 1496 1454 1496 Optimized for SPX crossing Eth 
with LLC to FDDI with Bridges or 
Routers

FDDI/802.2 LLC 4112 4074 4032 4074 Optimized for SPX crossing TR 
using 4096 fs to FDDI with Bridges 
or Routers

FDDI/802.2 LLC 4218 4180 4138 4180 Optimized for SPX crossing TR 
using 4202 fs to FDDI with Bridges 
or Routers

170



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 3 - Troubleshooting

Topology/Frame type Frame size IPX packet 
size

SPX data 
size

LSL buffer 
size

Comments

FDDI/802.2 LLC 4516 4478 4436 4478 Optimized for SPX crossing TR 
using 4500 fs to FDDI with Bridges 
or Routers

FDDI/802.2 LLC 4096 4058 4016 4058 Optimized for performance

FDDI/802.2 LLC 4202 4164 4122 4164 Novell default frame size

FDDI/802.2 LLC 4500 4462 4420 4462

Note: Token-Ring allows larger frame/packet sizes than those listed here. In most cases, these are the values to use in 
your network; if you require other values, use the formulas given below.

Note: IPX using LLC/SNAP framing is not recommended and is not included in these tables.

Note: Windows NT systems using SPX II negotiate to the common packet size between the systems as needed.

The following formulas are used to derive the values in the table shown above:

Frame/IPX packet

Ethernet with DIX Frame size - MAC headers (18) = IPX packet size
Ethernet with LLC Frame size - MAC headers (18) - LLC headers (4) = IPX packet size
Token-Ring Frame size - MAC headers (18) - LLC headers (4) = IPX packet size
FDDI Frame size - MAC headers {ANSI standard} (34) - LLC headers (4) = IPX packet size

IPX packet to SPX data size (Notes RPC data stream)

IPX packet - IPX headers (30) - SPX headers (12) = SPX data size

Note: All measurements are in octets. Bytes is quite often used as the term but technically it is not the same.

During the workstation's (IPX client) attachment process, it accesses the NetWare server to acquire additional setting 
information, which includes the maximum frame size the NetWare server accepts. By default, the maximum frame size 
is set to 4202. With Ethernet networks, the topology's limitation of 1518 takes precedent, but with Token-Ring or FDDI 
networks, or mixed topology networks, this value can create problems with SPX communication.

Within a flat network, make sure the settings of the Notes and Domino server systems are set for the NetWare default 
settings as needed. If you have a Switched, Bridged, or Routed network with either Token-Ring or FDDI, it is 
recommended that you alter the NetWare servers setting "Set Maximum Physical Receive Packet Size" to 4096 to 
better match the memory buffers of the switches, bridges, and routers. With a mixed topology network, you may need 
to use one of the optimized choices listed in the table above. The guidelines you should use are as follows:

Transparent Bridge or Straight-Routed networks with Token-Ring or FDDI: Use the entries in the table as needed.l

Token-Ring Source Route Bridged networks: An additional 30 bytes must be subtracted to account for the RIF l
field in the IPX packet, SPX packet, and LSL buffer settings. This applies only to Token-Ring or FDDI network 
values and ones that are not optimized for SPX conversion with Ethernet.

Translational Bridge between Token-Ring or FDDI and Ethernet networks: Use the optimized listings in the table l
as required.

Transparent or Source Route Bridges between FDDI and Token-Ring:  Use the optimized listings in the table as l
required.

Because SPX is not a fragment-prone protocol, unlike SPX II, networks that have systems located on dissimilar 
topologies require alteration of the Frame/Packet size to meet the requirements of the smaller Frame/Packet size 
allowed between the topologies (maximum common size). If the systems are crossing over a larger frame-capable 
topology and the maximum size at each end node is the same, there is no conflict. Otherwise, with mixed topologies 
you need the following change:

Routing between Token-Ring or FDDI to Ethernet networks or between Token-Ring to FDDI networks: Use the l
optimized listings the table as required.
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Using a NetWare server as a Router

If you are using the NetWare server as a Router with Token-Ring, it is recommended that the NetWare server's 
STARTUP.NCF file contain the following line:

Set Maximum Physical Receive Packet Size = 4096

Follow with any needed alterations to the Domino server and Notes client systems. This ensures all the end nodes that 
are accessing this NetWare server are using the 4096 frame limit.

Note: Your network may require different values if there are network segments set up with a lower frame or packet 
size. Consult your network administrator to discuss any possible conflicts, and use the largest value your network can 
support.

Server

TCP/IP MTU sizing issues
You may encounter problems with TCP/IP MTU (Maximum Transmission Unit) sizing depending on the version of the 
system's TCP/IP stack (end node and routers) and the types of devices and topologies that make up your network. 
This can happen when end node systems (Domino servers or Notes clients) are located on Token-Ring or FDDI 
networks directly, located in a mix with Ethernet network segments, or with WAN or SLIP/PPP dial up connections that 
you are trying to access.

Using the PING TCP/IP tool, you can verify what the limitations of the network are. Make note that not all PING 
variations offer the same functions. The PING utility must be able to create variable test packets and be able to set the 
Don't Fragment flag. which prevents the packet from being fragmented by either the Router or the direct end node 
system. The Windows 95/98/NT version of PING offer these functions. 

Use the table below to base your measurements for the value of the test packet, where the test packet returns 
acknowledgments for each successful packet, plus one more byte to the test packet, should give you an error 
indicating the packet needed to be fragmented. This break point is the maximum size the pathway supports. In some 
cases, the larger test packets return one or two errors. This is not an issue with packet sizing but should be 
investigated with your network administrators as it is an indication of a network health problem.

Depending on your TCP/IP stack and your network devices you may need to set the MTU size manually. Most TCP/IP 
stacks use Maximum Segment Size (MSS) discovery to learn the local segment (routed segment) TCP data size, which 
it then translates into the IP packet size. By default, 576 is used when the TCP/IP MSS can not be discovered. Newer 
TCP/IP stacks use the MTU path discovery method to learn the limits of the entire pathway. In some cases, these 
mechanisms fail to offer the needed constraint or prevent the effective use of the topologies abilities. Some TCP/IP 
stacks may need to be manually set or tuned for the local segment topology as their default setting is set the 
minimum value (576), which is not recommended for most LAN networks (Ethernet, Token-Ring or FDDI). Make sure 
the stack needs to be set, the size is correct for the LAN topology/ies in use, and any WAN links are set to smaller 
values. If you need to lock down the MTU manually the use the following guidelines on the needed sizes.

Topology/
Frame type

Frame 
size

IP packet/
MTU Size

Ping test 
packet 
size

Comments

ARPA or SLIP 1024 1006   978 Still used with some old Routers supporting ARPA 
framing (rare)

Ethernet/
DIX or PPP

1518 1500 1472 Preferred size for Ethernet networks

Ethernet/
802.2 SNAP

1518 1492 1464 Rarely used in Ethernet only networks

Token-Ring/
802.2 SNAP

1522 1500 1472 Optimized for TCP/IP crossing Eth w/DIX to TR 
w/Bridges or Routers
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Topology/
Frame type

Frame 
size

IP packet/
MTU Size

Ping test 
packet 
size

Comments

Token-Ring/
802.2 SNAP

1518 1492 1464 Optimized for TCP/IP crossing Eth w/SNAP to TR 
w/Bridges or Routers (rarely used)

Token-Ring/
802.2 SNAP

2048 2022 1994 Required for older 4Mb adapters & networks using 
them.

Wide-Band/
Frame-Relay

 N/A 2048 2020

Token-Ring/
802.2 SNAP

4096 4070 4042 Optimized for performance

Token-Ring/
802.2 SNAP

4202 4176 4148 Optimized for TCP/IP with NetWare 3.x/4.x servers

Token-Ring/
802.2 SNAP

4500 4474 4446 Default size for must Routers

FDDI/802.2 SNAP 1542 1500 1472 Optimized for TCP/IP crossing Eth w/DIX to FDDI 
w/Bridges or Routers

FDDI/802.2 SNAP 1526 1492 1464 Optimized for TCP/IP crossing Eth w/SNAP to FDDI 
w/Bridges or Routers (rarely used)

FDDI/802.2 SNAP 4096 4054 4026 Optimized for performance

FDDI/802.2 SNAP 4104 4070 4042 Optimized for TCP/IP crossing TR to FDDI 
w/Bridges or Routers

FDDI/802.2 SNAP 4202 4160 4132 Optimized for TCP/IP with NetWare 3.x/4.x servers

FDDI/802.2 SNAP 4440 4474 4446 Optimized for TCP/IP crossing TR  to FDDI 
w/Bridges or Routers

FDDI/802.2 SNAP 4394 4352 4324 RFC 1188 IETF standard

FDDI/802.2 SNAP 4500 4458 4430 Optimized for TCP/IP using full FDDI packets (not 
recommended)

Note: Token-Ring allows larger frame/packet sizes than what is listed here. In most cases, these are the values used 
in your network. If you require other values use the formulas listed below.

Note: Refer to your OS or TCP/IP stack vendor for details of altering the MTU or TCP window size as required.

The following formulas are used to derive the values in the above table:

Frame/IP packet sizing

Ethernet w/DIX Frame size - MAC headers (18) = IP packet size
Ethernet w/LLC Frame size - MAC headers (18) - LLC/SNAP headers (8) = IP packet size
Token-Ring Frame size - MAC headers (18) - LLC/SNAP headers (8) = IP packet size
FDDI Frame size - MAC headers {ANSI standard} (34) - LLC/SNAP headers (8) = IP packet size

Ping test data size

IP packet - IP headers (30) - UDP ( TCP) headers (12) = Ping test packet size (TCP data size)

Note: All measurements are in octets. Bytes is quite often used as the term but technically it is not the same.
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Within a flat network, make sure the settings of the Notes and Domino server systems are set for the largest 
Frame/Packet size workable for the LAN topology. If you have a Switched, Bridged or Routed network with either 
Token-Ring or FDDI, it is recommended you alter the Frame/Packet sizing to 4096 to better match the Switches, 
Bridges, and Routers memory buffers. With a mixed topology network, you many need to use one of the optimized 
choices listed in the table above. Here are the guidelines you should follow:

Transparent Bridge or Straight-Routed networks with Token-Ring or FDDI: Use the table entries as needed.l

With Token-Ring Source Route Bridged networks: An additional 30 bytes must be subtracted to account for the l
RIF field in the IP packet and MTU settings. This only applies to Token-Ring or FDDI network values and ones 
that are not optimized for Ethernet.

Translational Bridge between Token-Ring or FDDI and Ethernet networks: Use the optimized listings that offer the l
same IP packet size as required (common size).

Transparent or Source Route Bridges between FDDI and Token-Ring: Use the optimized listings as required.l

ATM with either ClassicIP or LANE should be matched to the same LAN topology the other end node is using.l

WAN links using ATM should use smaller packet sizes to compensate for the BER of the link.l

With Wide area networks using T1/E1, T3/E3 Wide Band links or Frame-Relay links, match them to the LAN l
topologies MTU or alter the LAN topologies MTU to match Wide Band or Frame-Relay link.

Note: With WAN connections, you may want to add a second NIC in the Domino server systems. This offers a way to 
tune the TCP/IP stack for the constraints of the WAN link without effecting local user or server access.

Because IP is a fragment-prone protocol, networks that have systems located on dissimilar topologies, with a direct 
router connection offering fragmentation services, do not require alteration of the Frame/Packet size to meet the 
requirements of the smaller size allowable between the topologies (maximum common size). If the systems are 
crossing over a larger frame-capable topology network and the maximum size at each of the end node systems are the 
same, there is no MTU conflict. Otherwise, with mixed topology networks crossing between Switches, Bridges, or a 
Router that does not offer fragmentation services, or it is disabled, you require the following changes:

Between Token-Ring or FDDI to Ethernet networks, or between Token-Ring to FDDI networks: Use the optimized l
listings that offer the same IP packet size as required (common size).

Between Token-Ring or FDDI networks accessing across a Leased Line, Fractional T1/E3, T1/E1, Fractional l
T3/E3, T3/E3 or Frame-Relay network: Use the optimized listings that offer the same IP packet size as required 
(common size). With these networks we strongly recommend multi-homing so the local LAN traffic accesses a 
separate NIC than the remote traffic. which requires the tuned interface.

When using GEO stationary satellite up/down link access you need to multi-home the Domino server with l
separate NICs at each location so the MTU and TCP window sizes can manually tuned for the satellite path 
latency.

Note: If the Router is doing a lot of fragmentation you may want alter the Routers port MTU setting to match the 
smaller segments MTU setting (enforcing the end node systems to use smaller packets). In the case of a Domino 
server, you may want to add a second NIC in the system. This offers a way to tune the TCP/IP stack for the constraints 
of the pathway without effecting other local user or server access.

Using a NetWare server as a Router

It is recommended if you are using the NetWare server as an TCP/IP Router with Token-Ring to append "Set Maximum 
Physical Receive Packet Size = 4096" to the STARTUP.NCF file and follow the needed alterations to the Domino server 
and Notes client system TCP/IP stacks for a 4096 frame size. This ensures all the end nodes that are accessing 
across the NetWare server are using the 4096 frame limit.

Note: Your network may require different values if there are network segments set up with lower frame sizes. Consult 
your network administrator to discuss any possible conflicts, and use the largest value your network can support.
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Administrator Client, Client, Designer, Server

Using IPX/SPX with NetWare 5.0-only networks
Domino and Notes using SPX or SPXII still require access to IPX/NCP services for NDS access. When using only 
NetWare 5.0 servers in your network you need to enable the IPX gateway services so the Domino servers and Notes 
clients can access the NetWare 5.0 NDS services. As long as there are NetWare 3.xx or IntranetWare 4.xx servers 
present in the network, Bindery services can be used as well.

Note: The SPX/SPXII protocols are not transportable over Novell's new native IPX over-IP services.

Administrator Client

Using the Setup Ports tool
In Domino Administrator, if you use the Setup Ports tool on the Server - Status tab to create ports but exceed the 
ports line size limit, *next ports line* is added to the end of the first ports line, a Ports1 line is created, and the 
following error appears:

Server error: No response from server for this command

The ports information is added to the NOTES.INI file correctly (for example, TCPIP= TCP, 0, 15, 0) but the ports are 
not added to the Active ports (Ports=) line in NOTES.INI.

The workaround is to manually add the port name(s) to the Ports= line in NOTES.INI.

Server

Linux serial driver problem
Modem initialization continuously cycles through modem speeds after a connection is terminated on a Linux server. 
The modem appears to be unresponsive during the cycling. To correct this problem, edit the modem file and add the 
following line to the file:
 FIXED SPEED=baud rate

Programming issues

Designer

ACLEntry.isAdminReaderAuthor incorrectly returns false
When an administration server ACLEntry is set to "Modify All Reader And Author Fields," in the Access Control List, and 
then this ACLEntry is obtained in a backend application, for example, the backend call "ACL.getEntry( entry name )," 
calling "isAdminReaderAuthor" incorrectly return false, even though the ACLEntry has rights to modify all reader and 
author fields.  If, instead, setAdminReaderAuthor( true ) has been set to true in the backend application, 
isAdminReaderAuthor correctly returns true.

Designer

Backend call Database.getSize returns negatives values
With LotusScript and Java backend classes programming, as your database size grows beyond 2 GB, calling 
Database.getSize() returns an increasingly lower negative double number. To convert this negative double to the 
correct positive double that reflects the size of the database, take the absolute value of the negative double returned 
from Database.getSize() (subtract the returned value from 0 to change its sign), and then add 2^31 (2 GB) to that 
absolute value.
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Designer

Database.getURLHeaderInfo is not implemented
The Back End class call, Database.getURLHeaderInfo(), behaves unreliably in R5 depending on the context of the 
application that calls it. For this reason this method is considered not implemented and it should not be called. In 
LotusScript, calling it raises the error "not implemented." In remote IIOP Java, a "not implemented" NotesException is 
thrown. In a Java agent, if the web retriever task is not running, the method returns a null or an empty string. In a Java 
agent, if the web retriever task is running, the agent may hang.

Designer

Differences between UI and backend ACLEntry settings
The following applies to Java and LotusScript backend classes:

In the user interface (UI), when you set an ACLEntry to be "administration server," its type is automatically made l
"server."  In backend classes, when you set an ACLEntry to be "administration server," its type is not changed.

In the user interface (UI), when you set an ACLEntry to be "administration server," any existing administration l
server entry in the ACL is no longer an administration server.  In backend classes, when you set an ACLEntry to be 
"administration server," any existing administration server entry in the ACL remains an administration server -- 
you can set more than one entry to be an administration server.

Designer

Embedded Java Applet issues
There is a 32K limit for an Applet Shared resource in Domino Designer. There is a list of the files that is part of l
the resource in a field and this field must be less than 32K bytes. The workaround for the size limitation here is 
to split these files into separate resources.

There is a 64K size limit for Imported Java Applet Files. The combined amount of data stored with the applet l
(which includes the signature information, the applet parameter information, and list of all of the files associated 
with the applet) is limited to 64K bytes. 

Canceling the paste of a parameter value may not revert it to its original value. When you have more than one l
applet parameter, pressing "x" to cancel the paste operation of a subsequent value replaces the value with that of 
the first parameter.

Loading and reloading large Java applets leads to "out of memory" conditions. A workaround is to use l
JavaUserClasses in NOTES.INI to load all or most of the classes. This ensures the classes are loaded only once, 
so there is no significant heap size expansion for every applet instance that is loaded. There may be replication 
problems with this workaround because it relies on classes loaded from the file system, which is outside of 
Designer's control.

Designer

JavaScript and dates
Notes uses a "rule of 50" convention for dealing with two-digit dates. Less than 50, the year is set to 20nn, greater than 
49 is set to 19nn.

The JavaScript DateObject constructor does not adhere to this convention. If you pass it a two-digit year it always 
returns 19.

For example, if you perform @Year on a Notes date of 01/28/01 you receive 2001, while if you create a JavaScript  
Date object from 01/28/01 and call getYear(), you receive 1901.

Designer

JavaScript in templates
For JavaScript to work properly in databases created with templates such as Web Mail, Discussion, or TeamRoom, the 
databases must have an .NSF extension.
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Designer

JavaScript - known issues
Support for the Document Object Model (DOM) within the R5 Notes Client is defined in the Notes Document l
Object Model database, available at:

           http://www.lotus.com/ldd/doc

Note that [window.]alert is not available in onMouse events.l

Designer

LotusScript and Java method CreateFromTemplate
There has been a change in how the CreateFromTemplate method determines if the source database is a template or 
a database. In R4.6, the source database required an NTF extension only. In R5, the CreateFromTemplate method 
does not treat the source database as a template unless it has both an NTF extension and the "Database is a template" 
property selected. Otherwise, the source is treated as a database, and does not convert bracketed entries (such as 
[-Default-] ) in the ACL to regular ACL entries in the newly created database.

Designer

LotusScript Terminate
All file handles are now closed when a LotusScript module stops executing, so Sub Terminate doesn't need a "Close" 
statement.  

Terminate can be used for other kinds of cleanup, such as deleting temporary files, but Terminate should be kept as 
short as possible, because if a module times out during Initialize, Terminate is called and runs to completion.  For 
example, if a module times out after one minute and the module's Terminate runs for two minutes, the total module 
will run for three minutes.

If a module is halted by control-break, Terminate runs only for a fraction of a second after the control-break, and 
results are unpredictable.

Halted by Initialize() Terminate() File handles

Normal completion runs to completion runs to completion all close

Timeout during Initialize() stops at timeout runs to completion all close

Timeout during Terminate() runs to completion runs to completion all close

Control-Break during Initialize() stops at control-break runs for its first <1 second all close

Control-Break during Terminate() runs to completion continues for <1 second all close

Designer

NotesRegistration.AddUserProfile
The NotesRegistration.AddUserProfile method is not working correctly. The workaround is to use the 
GetDocumentByKey method to find person documents and replace the value. This will be fixed in a future release.

Designer

Outline and Database object recycling issue
Because of the way OutlineEntry, Outline, and Database are contained within the class containment hierarchy, if your 
application calls Database.recycle() after instantiating Outlines and OutlineEntries from it, your application must call, 
in this order, OutlineEntry.recycle(), Outline.recycle() and finally Database.recycle(). These must always be called in 
this order; otherwise, it is better to not call Database.recycle() at all.
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Designer

OutlineEntry.isHidden does not work correctly
The Java backend class OutlineEntry.isHidden() does not work correctly in R5. It should return the property that was 
set by OutlineEntry.setHidden(), but does not.

Designer

OutlineEntry.setImagesText() may not keep value
When an outline is saved, modifications to the entry frame text on a newly created outline entry may be lost. The work 
around for this is to first add the entry to the outline prior to setting the imagestext.  For example, the following order 
does not keep the imagestext:

Outline outline = db.createOutline("Test");
OutlineEntry oe = outline.createEntry("Domino");
oe.setImagesText("abc.gif");
outline.addEntry(oe, null);
outline.save();

If oe.setImagesText() is moved after outline.save(), it keeps the imagestext.

Designer

Session.getAgentContext returns null
Session.getAgentContext() returns null or crashes if the agent runs on "All Docs in Database" when the database is 
empty. You can work around this problem by opening and saving the appropriate agent context document in the 
AGENTRUNNER.NSF database.

Designer

Shared LotusScript actions and UnprocessedDocuments
If a shared LotusScript action calls a script library in a view that has no non-shared actions or events that use the 
library, then the method NotesDatabase.UnprocessedDocuments may return an empty list the first time the button is 
clicked. The second and subsequent clicks work.

The workaround is to add a non-shared action to the view that uses the script library containing the call to the 
UnprocessedDocuments method. In the Options section of the new action, create USE statements for each script 
library used in the shared actions.

Designer

StrCompare using case sensitivity
If the following code sample is run in an agent inside of Notes the result will be +1.  If run outside of Notes the result 
will be -1

Sub Initialize
Print sSrCompare( "A", "a")

End Sub

The different behavior is the result of different versions of ccstr used in a Notes build versus a standalone LotusScript 
build. Now that both use the same version of ccStr, the behavior is the same - strcompare ("A", "a") == 1. This differs 
from previous versions of Notes.

Designer

Use of createSession method within Java agents
The use of the createSession() method on the Session class is deprecated when running in an agent. Instead, use the 
getSession() method, which provides the necessary context for the agent.
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Designer

Using FullTrim with strings containing significant white space
FullTrim does not render you with a space delimited string in all cases. For example, if you have the following: space, 
space, tab, tab, tab, space, space, tab, tab - between two words within a string - the results would still contain 
significant white space between the words consisting of space,tab,space,tab. In other words, FullTrim for strings 
removes duplicate adjacent white space characters, not just all duplicate white space characters.

Designer

Using LotusScript Data Object on AIX
The Intersolv Driver Pack version 3.02 for AIX contains an archived version of the driver manager libodbc.a, while 
LotusScript Data Object (LS:DO) requires an executable or shared object version of the driver manager. To check the 
type of your libodbc.a, enter the following command:

file libodbc.a

In case of an archive file, you need to extract the executable or shared object version of the driver manager odbc.so 
with the following:

ar -x libodbc.a

Save the archived version and rename odbc.so to the new libodbc.a with the following:

mv odbc.so libodbc.a

so that the driver manager is an executable or shared object file.

Designer

Web Server uses last @SetTargetFrame/@Command
@SetTargetFrame is a new @Function that works with certain @Commands. See the "@SetTargetFrame" topic in 
Domino 5 Designer Help for a list of compatible @Commands.  

This note discusses the effects of multiple @SetTargetFrames and @Commands.

Program a button or hotspot as follows:

@SetTargetFrame("FrameA")
@Command([OpenForm]; "Form A");
@SetTargetFrame("FrameB")
@Command([OpenForm]; "Form B");

In the Notes client, this formula opens Form A in FrameA and Form B in FrameB. In a Web browser, only the last 
@SetTargetFrame @Command combination executes, so that Form B opens in FrameB, but Form A does not open in 
FrameA.

To avoid this problem and to open multiple pages in multiple frames from one button or hotspot on the Web Server,  
use JavaScript. The example below assumes that there are three frames in the frameset.  

FrameNav has two sibling frames named FrameA and FrameB.

The page loaded in FrameNav can have a  hotspot or button that executes the following JavaScript code:

parent.FrameA.location = "http://myserver/mydb.nsf/FormA?OpenForm";
parent.FrameB.location = "http://myserver/mydb.nsf/FormB?OpenForm";
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Designer

Writing executable code at module level
Executable code at the module level is not supported. Code inside an execute statement but outside any function is at 
module level and should be avoided.

For example, the code fragment:

Execute |
Print "Hello World!"

|

Should be rewritten as:

Execute |
Sub Initialize

Print "Hello World!"
End Sub

  |

Designer

@SetTargetFrame and pre-defined target names
@SetTargetFrame does not work when used with one of the predefined frame names that are relative, such as, _parent 
and _self.

Designer

Replacing datetime values and dateranges from a DateTime field
To replace datetime values and dateranges in a DateTime field, create a string containing the new values, then use 
replaceItemValue to pass the string into the field. 

Designer

Retrieving datetime values and dateranges using getItemValue
The getItemValue method in the LotusScript NotesDocument and Java Document classes returns the beginning and 
end date-times of a range as individual date-time values. 

For example, if you have the range 1:00-10:00 in a DateTime field, Document.getItemValue will return 1:00;10:00 as 
separate date-time values, not as a range. In Java, use the getFirstItem method to get the DateTime item you want to 
manipulate, then use the getText property to get a plain text representation of the contents of the item. This will allow 
you to parse the contents of the field for individual date-time values and date-ranges. For LotusScript, use the 
GetFirstItem method and the Text property to achieve the same results.

Examples: 

This Java example parses the contents of a DateTime field that has been retrieved using the getFirstItem and 1.
getText methods. Individual date-time values and date-ranges are identified by their separators. Hyphens (-) 
separate the beginning and end date-time values of a date-range and semicolons (;) separate individual date-time 
values from each other, or from date-ranges. In this example, date-time values are returned first, then 
date-ranges. 

import java.util.Vector;
import java.util.Enumeration;

public class DTParser {

private int posHyphen;
private int posSemicolon;

DTParser(int iHyphen, int iSemicolon)
{

setPosHyphen(iHyphen);
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setPosSemicolon(iSemicolon);
}

private void setPosHyphen(int iHyphen)
{

posHyphen = iHyphen;
}

private void setPosSemicolon(int iSemicolon)
{

posSemicolon = iSemicolon;
}

public void resetPos(int iHyphen, int iSemicolon)
{

setPosHyphen(iHyphen);
setPosSemicolon(iSemicolon);

}

public boolean isDateTimeRange(String sDateTime)
{
   posHyphen = sDateTime.indexOf("-", posHyphen);

posSemicolon = sDateTime.indexOf(";", 
             posSemicolon);

// Encountered an individual DateTime entry
if ((posSemicolon < posHyphen) &&  

           !(posSemicolon == -1))
{

posHyphen = 0;
posSemicolon++;
return false;

}

// Encountered a DateTime range
if ((posHyphen < posSemicolon) &&     

                !(posHyphen == -1))
{

posHyphen++;
posSemicolon++;
return true;

}
}
// Encountered a DateTime range - last in 

         // the list
if (!(posHyphen == -1) && (posSemicolon == 

                -1))
{

return true;
}

// Encountered an individual DateTime entry 
         // - either no DateTime ranges follow this 
         // entry or this entry is the last in the 
         // list of DateTimes

if (posHyphen == -1)
{

return false;
}
return false;

}

public String assembleDTString(Vector vSchedule)
{

String sSchedule = new String("");
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Object objDT;
Enumeration enumItems;

for (enumItems = vSchedule.elements(); 
            enumItems.hasMoreElements();)

{
objDT = enumItems.nextElement();
sSchedule = 

              
sSchedule.concat(objDT.toString()+",");

System.out.println("sSchedule="+sSchedule);
}
return

(sSchedule.substring(0,sSchedule.length()-1));
}

}

This LotusScript example uses the GetFirstItem method to retrieve the data from a DateTime field 2.
and then uses the Text property to get the contents of the field in plain text. The ReplaceItemValue 
method is used to put the data in a field called "ReturnValue". The dashes in the date-ranges are 
preserved in the output.

Dim session As New NotesSession
Dim db As NotesDatabase
Dim doc As NotesDocument
Dim collection As NotesDocumentCollection
Dim item As NotesItem

Set db = session.CurrentDatabase
Set collection = db.AllDocuments
Set doc = collection.GetLastDocument()
Set item = doc.GetFirstItem("DT")
Call doc.ReplaceItemValue("ReturnValue",item)
Call doc.Save(True,False)

Designer

Replication.Priority PRIORITY_NOTSET is unsupported
Regarding the Priority property of NotesReplication (in LotusScript) and Replication (in Java), the settings 
DB_REPLICATION_PRIORITY_NOTSET (LotusScript) and CNOTES_REPLCONST_PRIORITYNOTSET (Java) are not 
supported as of R5.0.1. 

Setting this value causes a run-time error. In normal usage, you cannot get this value with these properties.

Designer

Removing the password on "createSession" method
If the Domino server is running with a server ID that is password protected, using the method 
NotesFactory.createSession(null, null, password) in a servlet running in the WebSphere servlet engine to create a local 
Domino session with the server ID, Domino will prompt for the password (instead of giving access to the local Domino 
server ID).

As a workaround, remove the password on the Domino server ID file, and use method NotesFactory.createSession(null, 
null, null). 

Designer

Error with NotesUIDocument.GetSelectedText()

This method cannot return the contents of a Rich Text Field with more than one paragraph when there is no selection. 
In this case a lsERR_LSXUI_NOTES_ERROR (4412) will occur, with the error message "Notes Error - #0C:04""
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Search issues

Server

Cannot use termweight syntax in Search by Field
When searching by field, you cannot use the termweight syntax. This issue will be addressed in a later release.

Server

Domain Index -- do not copy files into a directory
Do not use the operating system to copy files into a directory that the Domain Indexer updates. Files that are older 
than the current date and time are not included in the index. This problem occurs only after you set up Domain 
Search for the directory and files that are older than the current date and time are copied into that directory. It does 
not occur when you initially set up the directory for Domain Search.

Administrator Client, Client, Server

Domain Indexing removes database information from Domain index
Before R5.0.9, if the Domain Indexer creates an index for a database and then the database is deleted from the server, 
performing a domain search finds documents from the deleted database. 

With R5.0.9, you can now delete databases and information from the Domain Index:

Remove the MultiDBIndex bit from the database1.

Run catalog.nsf on the host server and or Domain Indexing server2.

Allow Domain Indexer to run3.

Make sure you set up the correct ACL for the database catalog (CATALOG.NSF). For information on setting up the ACL 
for the database catalog, see the Domino 5 Administration Help (HELP5_ADMIN.NSF).

Deleting a database without first removing it form the Domain Index will cause this database information to remain in 
the Index.

Client

Domain search and displaying a large number of results
When searching a file system with domain search, changing the Display Results per page to a large number does not 
return all the results of the search.

Server

Domain Search and documents with 205x creation date
When using Domain Search to search for documents by creation date, Domino returns unexpected results if the 
document creation date is after 1/1/2050.

Server

Domain Search and HTML files
By default, when Domino indexes HTML files for Domain Search, only the text in the <BODY> field is indexed. Domino 
does not index text included in any other fields. You can do the following to include all HTML fields in a Domain index, 
for example, <META> or <TITLE> fields:

Edit the FORMATS.INI file in the Notes or Domino directory.1.

Find the 210=htm statement and enter the following to remark out the statement:2.

REM 210=htm

Add the following variable to the NOTES.INI file in the Notes or Domino directory:3.

FT_HTML_TITLE=1
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Server

Domain Search and replica databases
Limiting the scope of servers to include in a Domain Index produces unpredictable results if you have multiple Domain 
Index servers in a single Notes domain that include the same replica databases in each of the indexes.  As a 
workaround, disable the "Include in multi database indexing" Database Property on those databases that you do not 
want to include in the Domain Index.

Server

Domain Search by Author on the $UpdatedBy field
Using Domain Search to search by Author returns hits on only the first name listed in the $UpdatedBy field.

Client

Domain Search issues
On the Domain Search form, Domain Indexes containing multiple code pages (more than one language is present l
in the indexed databases) display duplicate search results when the query is Search By Date (created/modified).

There is no highlighting in documents returned from a search on the client.l

In Domain Search of file systems, categories are not supported, and if they are selected then no documents will l
be returned.

In Domain Search of file systems, documents are indexed as text; therefore, number searches are not supported.l

Client

Excluding forms in full-text index search builder
In the Forms properties box, unchecking "Include in Search Builder" has no effect. The form is included in the search 
builder list when you create a full-text index of the database.

Client

Extended characters not found without Fuzzy search
When performing a full-text search, specific extended characters (¥, Ñ, ß, Ð, Õ) from the 1252 Code Page are not 
found unless the "Fuzzy search" option is selected.

Server

FIELD CONTAINS syntax to search attachments
The FIELD CONTAINS syntax does not locate hits on the contents of an attachment in a rich text field. Attachments 
are stored internally in a separate field named $FILE, even though when displayed, the attachment appears as part of 
the rich text field.

Administrator Client, Server

Full-text indexing on UNIX
R5 provides a more accurate method of indexing attachments called the "Binary" method, and it is used to include the 
entire contents of a file attachment in the "searchable index."  However, some file types that are indexed on certain 
Domino UNIX platforms are not indexed as accurately as NT platforms. The specifics are:

Word Pro attachments are indexed, however, the results are not as accurate because the "Binary" method does l
not work on any platform except Intel NT, Windows NT and Windows 98. 

Domino for IBM AIX and Sun SPARC may return additional results when searching on extended characters from l
the 1252 Code Page table.

Domino for IBM AIX and Sun SPARC may produce an error (Query Not Understandable) when searching on a l
single extended characters from the 1252 Code Page table. 

Domino for IBM AIX, and Sun SPARC return corrupted text in the document summary field when searching on a l
file system and displaying detailed results.
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Client

Full-text search agents do not display in the Load search menu
If you create a shared agent and select the agent option "Show in search bar menu," the agent does not appear on the 
Load search menu on the search bar until you close and reopen the database.

Client, Server

Full-text search and searching a numeric field
A full-text search query that contains an OR operator in parentheses to search fields returns an error if the query also 
contains an AND operator to search a numeric field that is outside of the parentheses. For example, the following 
search query returns the error "Query is not understandable":

(Field Subject contains "First Doc" or Field Color contains "Purple") and Field Quantity = 2

You can enclose the numeric field in parentheses to prevent this error. For example:

(Field Subject contains "First Doc" or Field Color contains "Purple") and (Field Quantity = 2)

Client, Server

Full-text search for extended characters on UNIX Intel servers
Full-text searches on a databases residing on UNIX Intel servers returns bad results when searching on extended 
characters.

Client

Full-text search issues
Full-text indexes containing multiple code pages (when more than one language is present in the indexed l
database) display duplicate search results when the query is searching on a specific field and the field is a date 
or a numeric field.

The search by example feature (Fill Out Example Form button) returns a non-fatal error when used in the l
Personal Address book.

Search results in categorized views may not appear as single documents. This occurs when using the "sort by" l
options "Keep current order" or "Show all documents."  To see your result documents, expand the Category 
triangle or expand the view categories (View->Expand All) prior to executing search.

After a full-text search, sortable columns work only if using the "sort by" options "Keep current order" or "Show all l
documents."

The full-text search message is misleading when Search finds more than the Maximum Results Limit. If you set l
the Maximum Results Limit to 20 and Search finds 25 documents, the status bar should display "More than 20 
documents found."  Currently it reports, "20 documents found."

Performing a full-text search for a word written in Chinese, Korean and Japanese characters may not work if a l
document has the word but there is a carriage return in the middle of a it. For an example, if your search word 
consists of three Chinese characters and a document has this word with a carriage return after the first 
character, Notes does not find the document.

Currently there is no way to perform a full-text search for a search word of pattern : double byte string 1 + single l
byte space + double byte string 2. "Double bytes strings" means a series of Chinese, Korean, or Japanese 
characters. In order to search for a word pattern like this, use the following pattern with the "Fuzzy search" option 
enabled : double byte string 1 + double byte string 2.

By default, the "Fuzzy search" option finds words that match 75% or more of a search word. You can change the l
value of this option by using the "matchinglevel" operator. For example, if you search using the string 
"matchinglevel 80 user", the results reflect words where "user" makes up 80% of the word.

You cannot use wild card characters (* or ?) when searching for words written in Chinese, Korean, or Japanese.l

R4.x full-text options no longer supported in R5

Thesaurusl

The "Stop Word" file option is no longer used when creating a full-text indexl

The word proximity/breaking operator "NEAR"l
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Client

Full-text searching in categorized views
Full-text searching a view that uses collapsed categories does not return individual documents when you use the 
sorting options "keep current order (sortable)" and "show all documents (sortable)." To prevent this problem from 
occurring, expand all categories in the view before searching.

Client, Server

Full-text search: fixed attachments for international characters
In order for attachments to be indexed correctly for full-text search, the document in which the attachment is stored 
must have a field that contains text in the same language as the attachment. For example, if the contents of the 
attachment are in Chinese, a field in the document must contain Chinese text. 

NOTE: This problem was corrected in R5.0.1, for customers using the UNICODE based indexing (which is the default 
method since 5.0.5, and available as an option since 5.0.2.)

If the attachment is stored in a document that does not have some text in one of the fields, Notes/Domino is not able 
to determine the language and character set of the attachment content. This may result in improper conversion of the 
attachment, resulting in the inability to retrieve the information during a search.

This applies to all languages that are represented by code-pages other than cp1252 (Latin1).

Client

Highlights on search results
Highlights indicating what matches were found do not appear in the document when searching for text in Rich l
Text Fields where the option "Store contents as HTML and MIME" is selected on the Control tab of the Field 
Properties box.

When printing search results that contain highlighted words, in certain cases when the printer does not support l
PostScript, the words appear as black squares.

Client

Workaround if Full-Text Search in Help returns incorrect results
When Notes is upgraded from one release to another, the user can be left with a bad full-text index for their Help files. 
This can occur with a Maintenance Release upgrade, if the user already has a full-text index. This situation leaves the 
novice user with no alternatives to getting a workable full-text index.

To get to the database properties in R5 Help: 

Right-click a topic in Help.1.

Choose Document Properties.2.

In the drop-down list at the top of the properties box, select Database.3.

Click the Search (magnifier) tab.4.

Click Delete Index and then Create Index.5.

Client

Incorrect Domain Search results listed by Newest or Oldest First
When you search a domain and sort results by Newest First or Oldest First, Domino displays the results correctly on 
the first page, but does not display the results correctly for subsequent pages.

Server

Indexing Readers fields
In order for Readers fields to be indexed by the Domain Indexer, the name of the server must be included in 
the Readers field. The server name must be in canonical format, for example, CN=ServerName.acme.com,O=DomainName.

186



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 3 - Troubleshooting

Client

Limiting Domain Search by categories
When performing a Domain Search and limiting the search results to one or more categories, Notes finds documents 
that contain the category name or a substring of the category name. For example, if you perform a Domain Search 
and you limit the results to the category "Insurance," Notes returns matching documents from the Insurance category 
as well as Life Insurance, Homeowner's Insurance, and Auto Insurance if these categories exist.

Server

Max Results is set for all databases
When you set the Max Results value to determine the maximum number of search results that Notes displays, this 
value applies to all databases that you search, not just the current database.

Client

Message displayed when maximum search results exceeded
In R5.0.1, the status bar message that Notes displays when the maximum search results limit has been exceeded is 
inaccurate. Notes displays "xxx documents found."  Notes should display "More than xxx documents found."

Server

Netscape 3.04 and Domain Search
The Domain Search form does not display properly using a Netscape 3.04 browser. Use Netscape Communicator 4.0 
or greater to display the form properly.

Client

Known issues with the OR operator in Domain Search
The following are issues with using the OR operator in searches involving the Domain Search feature.

In some cases, Domain Search does not include the correct format for parentheses when using the OR operator. l
For example, a query that will be interpreted as (black AND cat) OR (brown AND dog) will not return accurate 
results if typed into the search box in Domain Search. Such a query must be constructed by opening the "More" 
section and using the buttons for conditions, as follows:

Click "Text," select "and," select "contains," and then type "black."1.

Click "Text," select "and," select "contains," and then type "cat."2.

Click "Text," select "or," select "contains," and then type "brown."3.

Click "Text," select "and," select "contains," and then type "dog."4.

When you search for text and sort the results by relevance, if the query contains an OR operator, Domain Search l
does not return accurate results. The other sort options work properly.

Client

Relevance ranking has less granularity
Search Results are ordered and displayed by relevance, however, this is not as refined as it is in V4.x.

Client

Search query syntax
The following applies to the query syntax to use in the Search field:

In R5, using the NOT expression requires a parenthesized expression. For example:l

NOT (field number1 = 20)
NOT (field number1 =20 or field number1 = 21)
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Split complex queries into separate parts, such as:l

(Field subject contains cat) or (field subject contains dog)
([subject] contains apple) and ([date1] = 12/31/1996)

Maximum query length of a single word is 65 characters. If the query contains dashes between words, each l
dash is counted as one character when computing the sum of 65 characters.

Server

Searching documents that use extended characters
When searching for extended characters from code page 1252, incorrect search results are returned in the following 
situations:

The document that you search has an attached file that contains 2 extended characters, which do not contain l
any text following the characters. The document was also indexed using the Raw Text Attachments indexing 
method.

You search for an extended character from code page 1252 and documents that use punctuation characters that l
use an equivalent code in LMBCS are returned.

Server

Updating a database ACL in the Domain Index

When changing the ACL of a database that is part of the Domain Indexer, a document in that database must also be 
changed. The Domain Indexer does not update the index files of a database (including ACL information) unless a 
document has been modified, added or deleted. 

There is a similar problem when updating database categories in a database. All documents that utilize the change to 
the category must be modified in order for their index entry to be updated.

Client

Use double quotation marks in a search query
Note that you cannot use single quotation marks in a full-text search query to indicate that you want to search for a 
specific string. You must use double quotation marks.

Client

Wrong search result highlights on pasted HTML page

Note that Full Text Search highlights incorrect text when the Notes document contains a Web page that was 
copy-pasted into the Document.

In some cases, the highlighting appears on the word after the "search hit." So, the user can still find their information.

Client

Cannot paste text in certain situations on Mac
On the Macintosh:

You cannot paste text into any fields on the Example form in the full-text index Search bar. l

You cannot paste text into the Save Search dialog box. l

You cannot paste text into the New Mail Rule dialog box. l

These issues occur on the Macintosh platform only.
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Client

Cannot navigate to attachment or OLE hits if below screen
Normally, when you get search results, you can navigate through the highlighted search "hits" in a result document 
using the CTRL + '+' keys. However, Notes won't navigate to a highlighted "hit" that occurs inside an attachment (or 
OLE object) below the "end" of the PC screen (meaning you would have to scroll down to see it).

Client

Domain Search fails if search string ends with a hyphen
In a Domain Search, searching for databases when the search string ends with a hyphen fails to find databases whose 
titles contain that string. A workaround is to search with the string surrounded in quotation marks, such as "DS-*".

This problem has been reported only on Windows NT and OS/2 servers.

Client

Indexing completion clears search results on Desktop
When the update or creation of a full text index (on a a local Notes client) completes, it triggers a reset of any full-text 
searches that may have been in progress on your Notes Desktop. This clears any search results already found.

Client

Search By Example Form doesn't work for Names & Address Book
The "Fill Out Example Form" search condition doesn't work when you're searching the Names & Address book.

Server

Authorization error when searching domains for databases

If you set the Default access level of the Domain Catalog to "No Access" and try to do a domain search for databases, 
you will receive an error:

"Notes error: You are not authorized to perform that operation..."

Users can perform Domain Searches for documents at this access level, but they cannot search for databases. This is 
a known issue that is being considered for a fix in a future maintenance release.

Administrator Client, Client

Domain Search: Known issue with document content categories
When using the Meta tab (plus sign) in the Document Properties box to assign a Notes document or Web URL to a 
content category in the Domain Catalog, the Post to Catalog button is not enabled after you select a category from the 
list or enter a new keyword for a category.

Workaround:

If you click Categorize, select one or more categories from the list, and click OK, you can click another tab in the l
properties box and then return to the Meta tab. Your selections now populate the Keywords field, and Post to 
Catalog is enabled.

If you type a new category in the Keywords field, you can then click another field on the Meta tab. Post to Catalog l
is now enabled.
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Administrator Client, Server

False error when deleting a Search Site database on Linux

Deleting a Search Site database on Linux
Attempting to delete a Search Site database on a Linux server can generate a false error stating that the database is 
not indexed for full-text search. To avoid this problem, close the Search Site database and then reopen it before 
issuing the Delete Index request.

Client

Win2000 TermServ: highlighted query tokens are unreadable
When using a PC running Win2000 Terminal Server, users may experience a problem; hightlighted Query Tokens (in 
the Search Bar) don't display the text  -- they appear as white boxes. After executing a full-text search, the contents of 
the Search field are left highlighted.

To reproduce the issue:

Create a search with one of the Condition buttons - it will create a Query Token in the Search bar field.1.

Click the "token" to highlight it - it will turn white and can't be read.2.

The workaround:

Unhighlight (click elsewhere) the "token" so that you can see what it says.

Client

Domain Search Thai Title in search results display incorrectly
In a Domain Search, Domain search results display incorrect Thai characters in a title.

Client, Server

Full-text search: logical operations with DBCS
Beginning in R5.0.6, the search string 'AandB' searches exactly the string of 'AandB' whereas 'A and B' searches a 
document which contains both A and B.  If you enter 'AandB' and one of the documents contains 'AandB', that 
document will be found. In R5.0.5 or earlier versions, this does not work when A or/and B are in DBCS.

If you use the '&' operator instead of 'and', you don't have to put spaces between the operator and the strings to 
search.  In other words, you can use 'A&B' to find a document which contains both A and B.  This is because '&' can 
be distinguished from the search string without adding spaces.  If you want to search 'A&B' explicitly, you can quote 
the string with quotation marks, like '"A&B"'.

Client

Server database's full text index not recognized by updater
The first time a new database is created and full text indexed (on a Server), pressing the Update button doesn't 
recognize the existence of the full text index. This is a Client only issue.  It is not related to the Server Platform or 
Server version of Domino. 

Workaround: Close and reopen database before attempting to UPDATE the database's full text index for the first time.
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Security issues

Administrator Client, Client, Server

Adminp fails to write public key during recertification/expiration
This is targeted to be fixed in R5.x.  There are no plans to fix this in R4.x.

The following steps show that the Admin process fails to write the same public key to the Person document and User 
ID during authentication:

Register a new user.1.
Check to see when the certificate expires - (my test - 03/31/2000).2.
Compare public keys from User.ID to the person doc in the NAB, the public keys should be the same.3.
From the NAB, select the new user's Person document and click Actions->Recertify Person and for testing 4.
purposes. (I entered a date later than the default to verify that the ID gets updated (03/31/2010). Click the 
Certify Box.
From the Server console, type "Tell Adminp process all." The request is processed in the admin4.nsf.5.
Check the certifier expiration date on the user.id. The date is 03/31/2000 which is expected since 6.
authentication has not occurred yet. 
Authenticate with the server. The message, "The hierarchical certificates in your ID file have been updated 7.
with new expiration dates" appears.
Look at the user.id and the new expiration date is present (03/31/2010) - but comparing the public key in 8.
the User.id and the person document reveals that the second grouping of characters is different.
From the administration panel, choose certify ID file.9.
Select the certifier, then the same user.id, and set the expiration date to (03/31/2020) and certify.10.
Compare the public keys between the User.id and that in the corresponding person document.11.

The User's ID now has matching public keys in the ID itself and the Person document in the NAB, with a certifier 
expiration date of (03/31/2020). The problem with the above scenario is that if an administrator wants to make the 
certificate expire on a user's ID via the admin process, by placing a certification date in the past (I tried 03/31/1997). 
The request is then generated in admin4.nsf, and appears to be successfully processed. The certlog.nsf is updated. 
When the user tries to authenticate, there is no message: "The hierarchical certificates in your ID file have been 
updated with new expiration dates," the ID file is never updated and the certificate still reflects the later date:

Select the same user, and click Actions->Recertify and place the expiration date back to (03/31/2001).1.
From the Server console, type "Tell Adminp process all." The request is processed in the admin4.nsf.2.
Check the certifier expiration date on the user.id. The date is 03/31/2020 which is expected since authentication 3.
has not occurred yet.

After authenticating with the server and with the User.id, THERE IS NO MESSAGE:  "The hierarchical certificates in 
your ID file have been updated with new expiration dates." The User.id still reflects the expiration date of 03/31/2020. 
If you compare the public key is the User.id with that of the Person document, the second grouping of characters is 
again different.

At this point, the public keys are different in the Person document and User.id. There is an expiration date of 
(03/31/2020) on the user.id:

From the administration panel, choose certify ID file, select the certifier, then the same user.id, and set the 1.
expiration date to (03/31/2004) and certify.
Compare the public keys between the User.id and that in the corresponding Person document and they are the 2.
same. The expiration date upon examination of the ID file is (03/31/2004).

If select an expiration date in step 1 of (03/31/97) and certify, the public keys via the user id and person document 
would be the same. When the user.id tries to authenticate with the server, the user is locked out because the id is 
expired.

Server

Authenticating Web clients in an LDAP directory
The first time a Web client authenticates with an LDAP server, server response time can be slow. This occurs because 
Domino takes time to initialize the views in the LDAP directory. When the Web client authenticates subsequent times, 
server response time improves.
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Administrator Client, Client, Server

CA e-mail notification not readable in Webmail
When selecting the option "Send a notification e-mail to the requester" in the Certificate Authority database, the e-mail 
notification cannot be opened using Webmail, and must either be opened in a Notes client or the sequence number 
can be transmitted to the certificate recipient via another means.

When opened in Webmail, the Web server responds with a "Corrupt Data Exception" rather than displaying the e-mail.

To fix this problem, open the database in Designer, open the form MailClientCertRequestApproved, and open the form 
properties. Select the option "Store Form in Document." Save the form. All e-mail should then be readable by Webmail.

Client, Server

Certificates containing extended characters
When performing the action "Add Internet Cert To Selected People" in the Domino Directory, Internet certificates are 
created with the ASN1 encoding of the x.509 certificate as follows:

Printable1.
IA52.
Latin-13.
BMP (form of Unicode).4.

However, please note that a NOTES.INI setting allows the user to default to UTF8 instead of BMP. 
If the user has extended characters (not Printable, not IA5, and not Latin-1) in its user name then the X.509 
certificate, created by the above action, includes BMP-labeled (or UTF8-labeled) strings. When a Netscape user tries 
to open signed mail sent by such a user with BMP or UTF8 strings in its certificate, Netscape crashes. (NOTE: This 
was corrected in R5.0.1)

When creating certificates and certificate requests for key ring files, or when creating certificates from Web client 
certificate requests via the Domino Certificate Authority, Domino encodes distinguished name character strings via the 
following procedure:

If the string contains only ASN1 printable characters: encoded as a DER printable string
If the string contains only US-ASCII characters: encoded as a IA5 string
If the string contains non-US-ASCII characters: encoded as a T.61string using Latin-1 character set

To change how non-US-ASCII strings are encoded use the NOTES.INI setting, IntlDERStringEncodeType as follows. 
(This should be set on both the Domino server and the Notes client that hosts the Domino Certificate Authority 
application and the Domino Certificate Administration application.):

IntlDERStringEncodeType=1 Encode non-US-ASCII strings as UTF8
IntlDERStringEncodeType=2 Encode non-US-ASCII strings as BMP

Server

Controlling access to the Web Administrator files
The Web Administrator files are stored in the subdirectory domino\adm-bin of the Domino data directory. You should 
protect access to this directory so unauthorized users cannot access the Web Administrator. Domino creates a File 
Protection document for this subdirectory by default when you start the server for the first time. The File Protection 
document appears in the Web - Web Server Configurations view on the Configuration tab of the Domino Administrator. 
The NOTES.INI file variable DominoConfigLevel indicates whether the File Protection document has been created 
during server startup. It also indicates whether Mapping/Redirection and Virtual Server documents have been 
upgraded to the Domino Directory. For more information and mapping and redirection, see the release note "Migrating 
Mapping/Redirection and Virtual Server documents" in the Troubleshooting section.  If DominoConfigLevel is set to

1 -- Mapping/Redirection and Virtual Server documents in the Domino Configuration database (DOMCFG.NSF) are l
upgraded, but the File Protection document for domino\adm-bin is not created yet.

2 -- File Protection document for domino\adm-bin is created, but  the Mapping/Redirection and Virtual Server l
documents in the Domino Configuration database are not upgraded yet.

3 -- Both the File Protection document and upgrade of the Domino Configuration database are done.l

Use the DominoConfigLevel setting to troubleshoot problems with controlling access to the Web Administrator files 
and migrating Mapping/Redirection and Virtual Server documents. Do not modify this setting in the NOTES.INI file.

For more information on File Protection documents, see Administering the Domino System or Domino 5 Administration 
Help.
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Server

Default validity period for certificates issued by a Domino CA
The default validity period  for certificates issued by a Domino CA is blank, which issues certificates that are valid for 1 
day. You need to modify the profile in the Domino Certificate Authority application in order to change this default. To 
modify the profile, open the Domino Certificate Authority application and choose Configure Certificate Authority 
Profile. 

Client

Dual Internet certificates for S/MIME encryption and signatures
In Release 5.0, the Internet certificate that you added to the Notes ID file was used for both S/MIME encryption and 
electronic signatures. In Release 5.0.1, you do not have to use the same Internet certificate for both encryption and 
signatures. If you added multiple Internet certificates to your Notes ID file, you can specify one Internet certificate to 
use for encryption and another Internet certificate to use for signatures. For example, if a third-party CA issues an 
Internet certificate to use for encrypted mail messages and issues a different Internet certificate to use for signed mail 
messages, you can add both of these certificates to your Notes ID and you can use one certificate for encryption and 
the other for signatures. 

For information on using dual Internet certificates, see "Using dual Internet certificates for S/MIME encryption and 
signatures" in the Documentation updates chapter of the Release Notes.

Client

Long issuer names on Internet certificates
When you use File->Tools->User ID to view an Internet certificate on your Notes ID file, issuer names that are lengthy 
and have spaces will be truncated in the Name field.

Client

No message shown if an error occurs when adding an Internet certificate
When you add an Internet certificate to a user's Person document, if the user authenticates with the server and the 
server's Domino Directory does not contain a root certificate for the CA who issued the certificate, Notes does not add 
the certificate to the user's ID file and does not display a message indicating that this process failed. The root 
certificate is necessary to validate the Internet certificate before it is added to the ID file.

Server

Protect directives are ignored in R5
In R5 the Domino Web Server ignores any protect directives that users may have specified in the HTTPD.CNF file using 
earlier  versions of the software.  With R5, administrators can create File Protection documents in the Domino 
Directory to protect files and directories from Web browser users.

Administrator Client, Server

Server key ring file should be owned by server
When copying a server key ring file to the Domino server data directory, make sure the file owner is the same as the 
account that is running the server, otherwise the key ring may not be able to be read by server tasks.

Client

Setting a default Internet certificate as encryption certificate
If a Person document in the Domino Directory or a Contact document in the Personal Address Book has multiple 
Internet certificates that can be used for encryption, only one of them will be used for S/MIME encryption.  The last 
certificate entered in the Person or Contact document will be used for S/MIME encryption.
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Administrator Client

Truncated Internet certificates in Person documents
When you edit a Person document and choose Examine Internet Certificate(s), certain attributes such as the Issuer 
Name, Serial Number, and Subject Name may be truncated because of the current screen resolution (pixels setting).

Client

Using Enforce Consistent ACLs with local replicas
Be very careful when you use "Enforce a consistent Access Control List across all replicas of this database" with a local 
replica.  If you make a local replica of a database and then turn this option on, you may not be able to update your 
replica or make access control changes to your replica.  You may be forced to delete your local replica and start over.

Administrator Client, Server

Recertifying certificate after adding alternate name
In R5.0, when the Administration Process server task processes a Recertify Person in Address Book request issued by 
a Certifier ID with a multibyte character alternate name, the request may fail with the following message: 

File name: names.nsf; Error: The signature on the certificate was found to be invalid.  Check the log file for details.

The problem is the Certifier document in the Domino Directory has an invalid public key that contains a truncated 
multibyte character alternate name. This needs to be fixed by replacing the truncated public key with the good public 
key from the Certifier ID file.

This issue affects some Certifier IDs with multibyte characters (for example, Japanese characters), and some IDs 
containing alternate names longer than 10 characters created with the 5.0 Domino Administrator. Alternate names 
added to Certifier IDs with the R5.0.1 Domino Administrator will be correctly stored in the Certifier document.

Follow these steps to correct the problem:

Upgrade to the R5.0.1 Domino Administrator and R5.0.1 Domino Administration Process server.1.

Copy the public key to the clipboard buffer:2.

a. On the Configuration tab, choose Tools - Certification - ID Properties.
b. Select the Certifier ID file and enter the password.
c. Choose More Options.
d. Click the Copy Public Key button.

Edit the Certifier document in the Domino Directory:3.

a. Clear the contents of Certified Public Key field.
b. Paste the public key into Certified Public Key field.
c. Save the Certifier document.

Client

Error while attempting to accept the Certificate Authority
Domino may be set up as a Certificate Authority for SSL transactions, in which  your browser will need to add the 
Certificate Authority's Trusted Root.

1. Browse to the Domino Certificate Authority application.

2. Select Accept this Authority in Your Browser.

If you are using Microsoft Internet Explorer and you are unable to open the .crt file, an Open File dialog box appears. 
Cancel out of the dialog box. 

3. Save the file to disk as a .crt file.

4.  Open the file using Windows Explorer. (If you cannot open the file via Windows Explorer, refer to the Microsoft NT 
4.0 Service Pack 4 or 5 readme file.)

For additional information on the Domino CA, see "Setting Up Clients for S/MIME and SSL" in Administering the 
Domino System.
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Client

S/MIME encryption to international recipients with long public keys
When a client uses S/MIME to encrypt a message, Notes chooses a data encryption algorithm that depends on the 
length of the public key in the recipient's certificate.  If the recipient's public key length is greater than 512 bits, the 
default algorithm is 3DES (if the sending client is using North American Notes); if the public key length is 512 bits or 
less, the default algorithm is 40 bit RC2.

With recently relaxed export controls, some international Notes users may have public keys longer than 512 bits, but 
they still can't decrypt S/MIME messages that use 3DES data encryption. Therefore, they won't be able to decrypt a 
message from a North American Notes client.

To change the default algorithm used for encrypting messages to users with public keys greater than 512 bits, use the 
notes.ini variable SMIME_Strong_Algorithm to specify an algorithm available to the international Notes recipient. For 
example:

SMIME_Strong_Algorithm=DES 
or

SMIME_Strong_Algorithm=RC2_56 
or

SMIME_Strong_Algorithm=RC2_40 

Note: A future release of Notes will use S/MIME version 3 capabilities management to store transmit and store 
information about what algorithms are available to particular clients.  Then the client will not need to control the 
encryption algorithm with the notes.ini variable.

Client

Error when setting up new Certificate Authority
When an administrator tries to set up a new Certificate Authority (CertCA) database from the CCA50.NTF 
template, the error "You are not authorized to perform that operation" appears.  

This error occurs because of settings in the ACL of the CCA50.NTF template.  In order to create a new 
database from CCA50.NTF, the user creating the database must be assigned the [CAPrivlegedUser] role 
either individually or as part of a group.

By default, the -Default- entry in the ACL of CCA50.NTF is set to "Reader" and assigned the 
[CAPrivlegedUser] role. When you create a new CertCA database from this template, normally you are 
accessing the template via the -Default- entry. As a result, you have "Reader" access to the template and 
you have the privileges assigned to the [CAPrivlegedUser] role, which allows you to create the CertCA 
database. However, if you're listed in the ACL as a person or as part of a group (for example, in a group 
called Administrators) that isn't assigned the [CAPrivlegedUser] role, then you can't create the database.

Here are two examples of when this situation is likely to occur:

You modify the CCA50.NTF template and add the name of the administrator, or the Administrators l
group, to the template's ACL without assigning the [CAPrivlegedUser] role.  When you use the 
CCA50.NTF template to create the CertCA database, you'll be granted access via the Administrators 
group entry, rather than the -Default- entry. 

You set up the first Domino server in your organization and then let the set up program automatically:l

Create a group called Administrators.1.

Put the administrators' names in the Group document.2.

Add that group to the ACL of all databases. 3.

Note: The option to automatically complete these steps after setting up your first server is a new 
feature in Release 5.
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In this case, since one of the templates affected is the CCA50.NTF, all databases created from that 
template will automatically have an ACL with an Administrators entry. By default, the Administrators group 
doesn't have the [CAPrivlegedUser] role assigned to it. Anyone included in the group called Administrators 
won't be allowed to create a database using the CCA50.NTF because that group doesn't have the 
appropriate access to do so.

Workaround
Open the CCA50.NTF template.1.

Choose File->Database->Access control.2.

Select the user name or group who you want to be able to create the CertCA database and assign the 3.
entry the [CAPrivlegedUser] role.

Click OK to save the changes to the ACL.4.

The person or group you chose in Step 3 should now be able to create a CertCA database.

Administrator Client, Server

SSL option for virtual hosts create name mismatch
This problem occurs when a Domino R5 is configured for SSL, and has Virtual Hosts (and Virtual Servers) that are also 
configured for SSL. If you try to access a Virtual Host via SSL (HTTPS), you get an error message stating that the 
name issued to the certificate does not match the hostname. This is because the Virtual Host name is an alias name 
to the main server. There is no workaround, as there is no way to avoid having the Virtual Host use SSL if the main 
server document uses it.

Server issues

Server

Domino Error running NSD on AIX
There have been various reports of Domino crashing with a Fatal Error signal = 0x00000004 after running NSD on AIX 
4.3.3.  In these cases AIX was correctly patched. The problem at this time is believed to be an AIX issue and has been 
reported to AIX development.

Server

Troubleshooting Single Sign-on for Domino and WebSphere
Please refer to the following troubleshooting tips regarding Single Sign-on (SSO) for Domino and WebSphere. For 
more instructions on SSO, please see the Release Notes entitled, "Enabling Single Sign-on for Domino and WebSphere 
servers."

This Release Note contains troubleshooting tips for three scenarios: 

Configuring the Web SSO document failsl
Server Console fails to load the Web SSO document upon HTTP start-upl
Authentication failsl
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Configuring the Web SSO document fails

The client must be able to find server documents for the participating Single Sign-on servers. Since the Web ll
SSO document is encrypted for the servers you specify, your client's location record's home server must be 
pointing to a server in the domain where the participating servers reside so that lookups will be able to find the 
public keys of the servers. If you get a message box that states that one or more of the participating server's 
cannot be found, then those servers will not be able to decrypt this document  and will not perform Single 
Sign-On.

When the Web SSO document is saved, the status bar will state how many public keys were used to encrypt the 
document by finding the listed servers, Authors and Administrator's on the document.  

Server Console fails to load the Web SSO document upon HTTP start-up

If the Server Document is configured for Multi-Server in the Session Authentication field, then the HTTP server ll
will try to find and load a Web SSO Configuration document  during start-up.  The server console will report the 
following if a valid document is found and decrypted:

HTTP: Successfully loaded Web SSO Configuration.

       If  participating SSO server is reporting the following, then SSO will not work:

HTTP: Error Loading Web SSO configuration. Reverting to single-server session authentication.  

Make sure that there is only one Web SSO document in the Web Configurations view of the Directory and the ll
$WebSSOConfigs hidden view.  Currently you cannot create more than one, but another one could be replicated 
over from another server.  (In a future release this document will be managed by Adminp, as only one should exist 
per domain.)  Check the hidden view $WebSSOConfigs.  From a client, select File -> Database -> Open.  In the 
dialog type in the server name and the names.nsf  file in the bottom half.  Hold the Shift and Ctrl buttons down 
and double click the open button. This will open up the directory with all the hidden views. Make sure you only 
have one document in this view.  If you have more than one, then delete them all and recreate the document.

If the server document's public key does not match the public key in the ID file then the decrypting of the Web ll
SSO document will fail and receive the error message above on the console.  This could happen if the id file was 
created multiple times and didn't update the server doc correctly.  Usually there is an error on the server console 
that states that the public key does not match the server id.  If this happens then SSO will not work because the 
document could be encrypted with a public key for which the server does not possess the corresponding private 
key to decrypt with. The way to correct this is to copy the public key out of the server id then paste it into the 
server doc and recreate the Web SSO document.  

Authentication fails

WebSphere and Domino should both be configured for the same LDAP directory.  The authentication token used ll
for Single Sign-On stores the full Distinguished Name of the user (DN), for example, cn=john smith,ou=sales, 
o=ibm, c=us.  The way to set up LDAP for Single Sign-on to work would be to set-up Directory Assistance in 
Domino and configure it to point at the LDAP server the WebSphere server is using.  Another way is to load LDAP 
on the Domino Directory and configure WebSphere to use the Domino LDAP server.

If Single Sign-on participating servers include WebSphere servers, using a Domino LDAP directory, the users ll
with flat names will not work.  If the participating servers are all Domino, then Single Sign-On will work with flat 
user names.  It is best to always use hierarchical names and is strongly recommended.

URLs issued to servers configured for Single Sign-on must specify the full DNS server name, not the host name ll
or IP address.  For browsers to be able to send cookies to a group of servers, the DNS domain must be included 
in the cookie.  The DNS domain in the cookie must match the URL. This is why cookies cannot be used across 
TCP/IP domains.

Clustered Servers must have the host name populated with the full DNS server name in the server document ll
for ICM to redirect to cluster members using Single Sign-on.  If this field is not populated ICM (the Internet 
Cluster Manager) will redirect URLs to clustered web servers with only the TCP/IP host name, by default, and will 
not be able to send the cookie because the DNS domain is not included in the URL.  Edit the server document, go 
to the Internet Protocols tab -> HTTP tab -> host names field and add the server's full DNS name.

If WebSphere's LDAP server is configured with a port, the Domino Web SSO configuration document must be ll
edited and a \ must be added to the LDAP realm field for WebSphere servers.  For example, replace 
r5qmr.iris.com:389  with r5qmr.iris.com\:389.
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Administrator Client, Server

Compact -L does not work
The Compact -L  (Copy style: Allow access while compacting) server task incorrectly does not run on a database that 
you have opened or that is held open by the server (for example, names.nsf, log.nsf, statrep.nsf as well as any system 
databases).  If you run compact -L on such a database, you receive the following error:

>09:41:49 AM  Compacting dbname.nsf
>09:41:51 AM  Error compacting dbname.nsf: Function to-be-defined
>09:41:51 AM  Database compactor process shutdown

Compact -L is useful only for copy-style compacting.  A sample command that uses copy-style compacting is Load 
compact mail1.nsf -c -L.

Administrator Client, Server

International settings - update to documentation
System settings are not made available to Windows NT tasks that run as a service. By default, Windows NT services 
run in an account called the System Account which is not the same as the Administrator. International settings are 
saved for each individual user account on the system.

When Domino starts, it reads the International settings for the current users.  The System Account is not a user; 
therefore, it must be using the default International settings. To use a specific set of International settings, you can 
change the International settings for a user, then start the NT service as that user. The date&time formatting and 
Time Zone settings are examples of a user's International settings.

Use these steps to run a service as a specific user with International settings.

1. From the Control Panel, choose Administrative Tools - Services.

2. Open the Lotus Domino Server services.

3. On the Lotus Domino Server dialog box, click the Log On tab.

4. In the "Log on as:" field, click the "This account" button and enter the user log-on and password information of the 
user for whom you set the International settings. 

5. Click Apply and OK.

Administrator Client, Client, Server

Move master.kyr file to Notes data directory
During server keyring creation, Notes looks for the master.kyr file in the client/data directory.  However, this file is 
installed in the client directory, so is never accessed when creating the keyring file.

Workaround
Move the master.kyr file to the client/data directory.

Upgrade issues

Server

Collect task has replaced Reporter task
The R5 Collect task has assumed the functions of both the Reporter and R4.x Collect tasks. If you were running the 
Reporter task on an R4.x server, you now need to run the Collect task if you want to have statistic events, alarms and 
statistics reports generated in the Statistics Reporting database (STATREP.NSF). 

During an upgrade from R4.x to R5, the Reporter task is automatically removed from NOTES.INI and the design of the 
Statistics & Events database (EVENTS4.NSF) is upgraded to support new features, including the new Statistic 
Collector (Collect) task.
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Server

COLLECT4.NSF not upgraded to EVENTS4.NSF
The R5 Statistic Collector (Collect) task does not use the Collector Configuration database (COLLECT4.NSF). Any 
Statistic Monitors created in the Collector Configuration database need to be recreated in the Statistics & Events 
database (EVENTS4.NSF) after upgrading from R4.x to R5.

Client, Server

Concurrent Web retrievers setting
R5 includes a new default setting for the concurrent Web retrievers setting on both the client and server. If you are 
upgrading from an earlier release, including an R5 beta, you need to modify the setting to reflect the R5 default value.  

For Notes, choose File->Preferences->Location Preferences, then set the "Concurrent retrievers" field on the Advanced - 
Web Retriever tab to the default setting of 15.

For Domino, set  the "Concurrent retrievers" field on the Server Tasks - Web Retriever tab of the Server document to the 
default setting of 50.

Server

Deleting obsolete Stats Mail-In Databases and documents
After upgrading from R4.x to R5, a new Stats Mail-In Database document and an associated Stats Mail-In Database is 
automatically created for your Domino server. Although it is not necessary to do so, the R4.x versions of both items 
may now be deleted. 

To delete the R4.x Stats Mail-In Database document, open your server's Domino Directory (NAMES.NSF) and go to the 
Server/Mail-In Databases and Resources view. The R4.x Stats Mail-In Database that may be deleted is in this format:

Title: <ServerName/Organization> Stats
File name: STATSnnn.NSF

Note: the "nnn" in statsnnn.nsf may be any 3-digit number.

To delete the database itself, choose File->Database->Open and browse to find the database. Once the database is 
open, choose File->Database->Delete. You receive a message that the database is currently open and that it will be 
deleted later. After you close the database, the database is deleted.

The new R5 Stats Mail-In Database is:

Title: <ServerName> Stats/<OrganizationName>
File name: STATMAIL.NSF

Server

Domain Catalog ACL
In some instances, when you upgrade a Release 4.x standard catalog (CATALOG.NSF) to a Release 5 Domain Catalog, 
the ACL of the Domain Catalog is not properly set. Make sure the ACL for the Domain Catalog includes the following 
entries:

LocalDomainCatalogServers Editor
LocalDomainServers Editor

199



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 3 - Troubleshooting

Server

Remove free time databases from R5 Betas
There have been changes to the format of the final R5 free time database (BUSYTIME.NSF and CLUBUSY.NSF for 
clustered R5 servers). Since it is possible that some old or inaccurate data may be left in the free time databases 
created by some of the R5 beta versions, the administrator should manually delete the free time database on any R5 
server that was used for R5 Beta testing. Simply delete either the CLUBUSY.NSF (Clustered Server) or the 
BUSYTIME.NSF (non-Clustered Server) before starting the Schedule Manager task for the first time.

This task should only be done once when the server is upgraded from an Beta R5 server to a final R5 server. 

Server

Upgrading Mapping/Redirection and Virtual Server documents
In previous releases, you used the Domino Configuration database (DOMCFG.NSF) to map and redirect URLs on the 
Domino Web server and set up a virtual server. In this release, the Mapping/Redirection and Virtual Server documents 
are stored in the Domino Directory. Domino migrates existing Mapping/Redirection and Virtual Server documents 
after you start the server for the first time. The Mapping/Redirection and Virtual Server documents appear in the Web - 
Web Server Configurations view on the Configuration tab of the Domino Administrator. The NOTES.INI file variable 
DominoConfigLevel indicates whether the documents have been upgraded. It also indicates whether a File Protection 
document has been created for the domino\adm-bin directory.

If DominoConfigLevel is set to

1 -- Mapping/Redirection and Virtual Server documents in the Domino Configuration database (DOMCFG.NSF) are l
upgraded, but the File Protection document for domino\adm-bin is not created yet.

2 -- File Protection document for domino\adm-bin is created, but  the Mapping/Redirection and Virtual Server l
documents in the Domino Configuration database are not upgraded yet.

3 -- Both the File Protection document and upgrade of the Domino Configuration database are done.l

Use the DominoConfigLevel setting to troubleshoot problems with controlling access to the Web Administrator files 
and migrating Mapping/Redirection and Virtual Server documents. Do not modify this setting in the NOTES.INI file.

For more information on upgrading, see Moving to Domino Release 5 or Domino 5 Administration Help.

Server

Upgrading partitioned servers from R4 to R5 now supported
Upgrading partitioned server installations (R4.5.x or R4.6x to R5) was not supported on Windows NT platforms in 
Release 5.0.  

In R5.0.1, upgrades of partitioned servers from either R4.5x or R4.6x to Release 5 is now supported on Windows NT 
and current UNIX platforms.

Server

User author access to Administration Request database
Many Domino sites currently restrict access to the Administration Request Database to their Administrators. In R5, 
Administration Requests associated with Mail File Delegation, Mail File Move, and Change User License Type are 
created by Notes users. To take advantage of the new feature, users must have Author access in the Administration 
Request database.

Administrator Client

Default security of ID was changed to NA from R5.0.4.
Customers using the "International English" version or "Each language" version before R5.0.3 will notice a change in 
the default security. When the administrator creates a new Notes ID, the ID used by North America security from 
R5.0.4 is the default. 

Administrators who want to use International English security for the end user will have to change security type in 
register person dialog box after checking "Advanced."

Customers using the pre-R.5.0.3 North American version will not see any changes.
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Webmail issues

Client

Drafts created in the Client must be manually edited in Webmail
A change to 5.0.5 Webmail drafts to allow the draft to automatically open in Edit mode caused a regression in the 
Notes Client where any received memo that was originally created as a draft caused the document to open in Edit 
mode when read.  In 5.0.6, the Webmail draft fix was reversed. Therefore, if you save a draft in the Notes Client then 
edit the memo in Webmail, you must click the Edit action to place the document into Edit mode.
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Chapter 4 - Documentation updates

Administrator Client, Client, Designer, Server

Details of feature changes in "History of Changes" chapter
The "Details of feature changes" section of the "History of changes" chapter contains details of prominent feature 
changes since the original R5 product release. (In Release Notes before R5.0.10, many of these had been in the 
"Feature changes" section of the "Things you need to know" chapter.)

Not all features are discussed in this section. 

The specific revision number in the "History of changes" chapter contains a complete historical listing of feature 
changes, in the "New features and enhancements for R5.0.x". Those documents are grouped according to the release 
in which they were first documented. 

This "Details of feature changes" section gives you a view of all the details of feature changes that went into the product 
since R5 -- without having to sort through each revision number. 

Refer to the "New Features" section of the "What's new?" chapter for a listing of all new features for this particular 
Maintenance Release.

Notes 5 Help

Client, Server

Format for messages addressed to Internet addresses
On the Location document, the field "Format for messages addressed to Internet address" now contains the default 
value of "MIME format."  This change was effective in Notes 5.0.10.

In the Notes 5 documentation, the topic "Using MIME or Rich Text Format in the mail form" contains incorrect 
information. MIME format is now the default so the procedure does not need to be completed in order to use MIME; 
you would need to use that procedure to switch to Rich Text Formatting. In Step 3 of that procedure, to switch from 
MIME to RTF, choose Rich Text Formatting.

Domino 5 Designer Help

Designer

Pasting a folder view link into an outline
Copying a folder as a view link, then pasting it into an outline as an entry, automatically categorizes the entry as a 
view. When the outline is used in the client, folder operations (such as drag and drop) will not work.

To create an outline entry that is a folder

Create a new entry in the outline.1.

(Optional) Give the entry a Label and an Alias.2.

Select Named Element from the first Type list.3.

Select Folder from the second Type list.4.

Click the folder icon next to the Value box.5.

Select the name of your folder from the Folder list.6.
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Designer

New View property to set target frame for double-click
You now have the ability to specify what frame is targeted when you show a document by double-clicking on it in a 
view.  This property is honored at runtime in the client and in the view applet.

For views, you set this property with the new "Target Frame (double click)" event in the Programmer's pane. You can 
also set a "Target Frame (single click)" event in the Programmer's pane.

For embedded views, you set the target frame property on the Info tab of the Embedded View Properties box.  The 
target frame specifies where the document is displayed when a user selects a document with a single-click or with the 
arrow keys, or with a double-click. You can specify a target frame for a single-click (next to "for single click") and a 
target frame for a double-click (next to "for double click"). 

For information on the order of precedence when you set target frames, see the release note entitled, "Order of 
precedence in setting target frames."

Designer

Domino Web sites can remove Domino tags from HTML source
When you go to a Web site created with Domino, by default, a page's HTML source has the 
following header:

<HTML>
<!- - Lotus-Domino (Release 5xx - [date of release] on Windows NT/Intel) - ->
<HEAD>

Beginning in R5.0.2, adding the following setting to the server's NOTES.INI file will suppress the Lotus Domino tag:

DominoNoBanner=1

Designer

NotesUIDatabase.OpenView has replaceView parameter
The OpenView method of NotesUIDatabase has a fourth parameter and is re-specified as follows:

Syntax

Call notesUIDatabase.OpenView( viewName$  [, key$] [, newinstance] [, replaceView] )

Parameter

viewName$

String. The name of the view you want to open. 

key$

NOTE:  This parameter is new with Release 5.

String. Optional. The value to scroll to.

newinstance

NOTE:  This parameter is new with Release 5.

Boolean. Optional. Has effect only if an instance of the view specified by viewName$ is already open. Specify 
True if the view should be opened in a new window, otherwise the already open view 

will be given focus.

replaceView

NOTE:  This parameter is new with Release 5.0.4.

Boolean. Optional. Has effect only if the view specified byviewName$ is not already open, but a different view is 
open.  Specify True if the view specified by viewName$ should replace the already open, but different, view.  
Otherwise, it will be opened in a new window.
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Designer

Additions to the platforms and requirements for MAPI
The following additions have been made to the platforms and requirements documentation for MAPI:

Windows 98, NT, and 2000
The Domino MAPI service providers are available for Windows 98, NT, and Windows 2000. The required DLLs for 
the Windows messaging subsystem are only available from Microsoft.  It is a prerequisite to install 
Microsoft Outlook 98 or Microsoft Outlook 2000 before installing the Notes client.

Mail
The Domino MAPI service providers may only be used to access mail files that use the Domino Release 5.0 mail 
extended template (mail50ex.ntf).

Designer

TrimTrailingSpaces property for ODBCResultSet
ODBCResultSet has a new property as documented below:

TrimTrailingSpaces property
Read-write. Indicates whether trailing spaces are trimmed from character values upon retrieval. Can be set to "False" 
to prevent trimming.  NOTE: This property is new with Release 5.0.5.

Defined in
ODBCResultSet

Data type
Boolean

Syntax
To get: flag% = odbcResultSet.TrimTrailingSpaces

To set: odbcResultSet.TrimTrailingSpaces = flag%

Legal values
True (default) - indicates that trailing spaces are trimmed

False - indicates that trailing spaces are not trimmed

Usage
This property, when set, affects subsequent Execute and ExecProcedure methods.

Example: TrimTrailingSpaces property
This agent looks at the 16-character DESCRIP column in a database and replaces those rows that have all spaces with 
the phrase "The Description.":

Sub Initialize
  Dim con As New ODBCConnection
  Dim qry As New ODBCQuery
  Dim result As New ODBCResultSet
  Set qry.Connection = con
  Set result.Query = qry
  con.ConnectTo("ATDB")
  REM WHERE clause contains 16 spaces
  qry.SQL = "SELECT * FROM STUDENTS WHERE DESCRIP = '                '"
  result.TrimTrailingSpaces = False
  result.Execute
  result.LastRow
  For i = 1 To result.NumRows
    result.CurrentRow = i
    Call result.SetValue("DESCRIP", "The Description.")
    result.UpdateRow
  Next
  result.Close(DB_CLOSE)
  con.Disconnect
End Sub
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Designer

Length of database titles can now be 96 characters
The length of a database title can now be a maximum of 96 characters (as opposed to the old limit of 32 characters).

Designer

Change in view import/export filenames
In R5.0.5, the descriptions for the file types in the Import and Export dialogs were made more consistent. This change 
may effect existing scripts that contain FileImport and FileExport @commands. You should review your scripts to see 
if this change affects you. If a script does contain an old data type, it will generate the error message, "Import/Export 
not configured."

For example, previously, the filetype name for Lotus 1-2-3 was "Lotus 1-2-3 Worksheet." It has been changed to "Lotus 
1-2-3" (removing the word "Worksheet"). If a version 5.0.5 database runs a macro from an older Notes version that 
contains the following code, it will fail, since the NOTES.INI file will not recognize the Lotus 1-2-3 Worksheet file type:

@Command([FileExport];"Lotus 1-2-3 Worksheet";"SBRAUN:Lotus 1­2­3:Hardware") 

NOTE: This is only for new installations of R5.0.5 and beyond (as opposed to upgrades). The NOTES.INI file in an 
upgrade contains the old filetype name (variable name VIEWIMP1=Lotus 1-2-3 Worksheet, VIEWEXP1=Lotus 1-2-3 
Worksheet and EDITIMP3=Lotus 1-2-3), and users will not notice this problem. 

The following file name changes have also been implemented:

OLD FILENAME CURRENT FILENAME

Word for Windows 6.0 Microsoft Word 6.0
Microsoft Word RTF Microsoft RTF
Excel 4.0 Microsoft Excel
Excel 5.0 Microsoft Excel
Frame(MIF) FrameMaker 3.0

When importing at the document level on a UNIX platform:

WordPerfect 5.0 WordPerfect 5.x
WordPerfect 5.1 WordPerfect 5.x

The file names WordPerfect 4.1 and WordPerfect 4.2 are no longer supported, but WordPerfect 6.0/6.1 is.

When exporting at the document level on a UNIX platform, the WordPerfect 4.1, WordPerfect 4.2, and WordPerfect 5.0 
filenames are no longer supported, but WordPerfect 5.1, WordPerfect 6.0, and WordPerfect 6.1 are.

In addition, Notes no longer supports the import or export of ANSI metafile formatted files nor the import of Lotus Ami 
Pro files on any platform.

Designer

Broken links in Help topics for pages and forms
The following help topics contain broken links to other topics: 

Designing pages l

Form elementsl

To work around this problem, look up the linked topic in the Designer Help index.  

Client, Designer

Designers: Don't use FTV_Max_Fields or FTV_Fields_database
The NOTES.INI variables FTV_Max_Fields and FTV_Fields_database are not supported in R5. 
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Designer

Changes in search since R4
Search has undergone the following changes since R4:

The Thesaurus and stop word features are no longer available.l

R5 search is fully double-byte character enabled; you can use it with multiple languages and in multinational l
organizations.

For more information, see Domino 5 Administration Help.

Designer

COM user must add 'Call session.initialize' to NotesSession
The current Notes documentation may not make it clear to users of the COM interface that they must add extra steps 
right from the start of coding in COM.

After creating a session, a COM user must add a 'Call session.initialize' to their code to get any other Notes code to 
work. The documentation should be updated as shown below.

1.  Changes to the topic "NotesSession class":

NotesSession class  

Creation and access

To access the current session, use New.

Syntax

Dim variableName As New NotesSession

OR

Set notesSession = New NotesSession

To access the current session from a NotesDatabase object, use the "Parent property" in NotesDatabase.

added to Rnext: To access the current session through COM, see "Creating a session object" and "Initializing a session."  

added to Rnext: To access the current session through OLE, see "Using OLE."

2.  Changes to the Index:

NotesSession class
in COM

Creating a session object
added to Rnext: Initializing a session

Lotus.NotesSession class
in COM

Creating a session object
added to Rnext: Initializing a session

VBScript
accessing Domino Objects through COM

Creating a session object
added to Rnext: Initializing a session

Visual Basic
accessing Domino Objects through COM

Creating a session object
added to Rnext: Initializing a session

Designer

Displaying a categorized view as flat
If your view is a categorized view built in Designer 5.0 or later, you can select "Categorized is flat version 5 or greater" 
to convert your view to a non-hierarchical, flat view, which displays all documents on a single level. Use this feature if 
your level of indentation in a view exceeds the limit of 32 levels.
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Designer

JAVA EmbeddedObject Class doVerb method and User Interaction
doVerb method

Executes a verb in an embedded object.

Defined in

EmbeddedObject

Syntax

public void doVerb(String verb)
    throws NotesException

Parameter

String verb

The name of one of the object's verbs.

   Usage

   Verbs which require user interaction, such as Open or Edit, are not supported.

Designer

New StrConv constants SC_NATIVEDIGIT & SC_ARABICDIGIT
LotusScript Language function StrConv has two new constants:

Constant Value Conversion
SC_NATIVEDIGIT 256.00 Convert 0-9 to native digits
SC_ARABICDIGIT 512.00 Convert native digits to 0-9

Designer

NotesEmbeddedObject class DoVerb method and User Interaction
DoVerb method  

Given the name of a verb, executes the verb in an embedded object. 

Note: This method is treated as a Sub in COM.

Defined in

NotesEmbeddedObject

Syntax

variant = notesEmbeddedObject.DoVerb( verb$ )

Parameter

verb$

String. The name of one of the object's verbs.

Return value

variant

Variant. Always empty.

    Usage

Verbs which require user interaction, such as Open or Edit, are not supported.
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Designer

NotesUIView class Print method PageSeparator parameter
Prints the selected document(s) or the current view.

If no parameters are specified, or if the first parameter is omitted, displays the File Print dialog box.l

If the second form of the method is used, the document or view prints according to the specified parameters.l

NOTE:  This method is new with Release 5.

Defined in: NotesUIView

Syntax

Call notesUIView.Print

Call notesUIView.Print( numCopies% [, fromPage% ] [, toPage% ] [, draft ] [, pageSeparator% ] [, formOverride$ ] [, 
printview ] [, dateRangeBegin ] [, dateRangeEnd ] )

Parameters

numCopies%

Integer. The number of copies you want to print. If you omit this parameter you get the first form of the method 
and all other parameters are ignored.

fromPage%,

Integer. Optional. The page of a document where you want to start printing. "0" means all.

toPage%

Integer. Optional. The page of a document where you want to stop printing. "0" means all.

draft

Boolean. Optional. Specify True if you want to print the document in draft mode.

pageSeparator%

Integer. Optional. Determines the page separator.

0 No page separator

1 Line between documents

2 Page break between documents

formOverride$

Text. Optional. The name of the form that you want to use to print the document. 

printView

Boolean. Optional. Specify True to indicate that you want to print the current view instead of the contents of the 
document. Defaults to False.

dateRangeBegin

Variant. Optional. Prints the beginning date if printing from a calendar view.

dateRangeEnd

Variant. Optional. Prints the end date if printing from a calendar view.

Designer

Twips per centimeter value
The twips per centimeter value should be 567.
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Designer

Correction: "USE or USELSX name must be a string constant"
The documentation for the error "Use or USELSX name must be a string constant" contains an example that is 
incorrect, as both "Legal" lines of code result in compiler errors. The corrected text is as follows:

LOTUSSCRIPT LANGUAGE

USE or USELSX name must be a string constant  

The name that you specified in a Use or UseLSX statement is not a quoted literal or a string constant though that is 
what is required. For example, to use the module LSModule :

Use LSModule            ' Illegal
Use "LSModule"         ' Legal

Const myModuleName$ = "LSModule"
Use myModuleName$            ' Legal

Change the name to a quoted literal or string constant.

Designer

Setting "Prohibit design refresh or replace to modify"
If you use a template to refresh or replace the database design, to ensure that the option "Prohibit design refresh or 
replace to modify" takes effect, in the design properties of the template, select this option as well as the option 
"Propagate this prohibition of design change."

Designer

Updates: Synchronizing databases with master templates
Synchronizing databases with master templates  

To use a consistent design for multiple databases, database designers can associate databases or elements within 
databases with a master template. Designers can manually synchronize databases with a master template, but more 
often they rely on the Designer task to do this. When a master template design changes, the Designer task updates all 
databases that inherit their designs from the master template. The Designer task runs daily by default at 1 AM. The 
Updall task, which runs by default at 2 AM, updates the view indexes of databases changed by Designer.

For a server's Designer task to update databases, you must create a replica of the master template on each server that 
stores databases that inherit from the master template.

Caution  To avoid inconsistencies during database updates, ensure that replicating servers do not update 
simultaneously.

After updating database designs, the Designer task also reloads the LDAP schema on a Domino server that runs the 
LDAP service. You can run the Designer task manually.  

For more information on the LDAP service, see Lotus Domino Administrator Help.

Running the Designer task using the Task - Start tool

  1. From the Domino Administrator, in the server pane on the left, select the server on which to run Designer. To 
expand the pane, click the servers icon.

  2. Click the Server - Status tab.

  3. In the task panel on the right, click Task - Start.

  4. Select Designer and then click Start Task.
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Running the Designer task using a console command

  1. From the Domino Administrator, select the server on which to run Designer in the server pane on the left. To 
expand the pane, click the servers icon.

  2. Click the Server - Status tab.

  3. Click Console.

  4. Enter the following command in the command line at the bottom of the console, and then press ENTER:

Load design

Running the Designer task for a single database

If you want to refresh a single database, you can supply arguments to the design server command using the following 
syntax:

design [source-server [dest-server]] [-f single-db-to-refresh] [-d [
single-dir-to-refresh]]

  1. From the Domino Administrator, select the server on which to run Designer in the server pane on the left. To 
expand the pane, click the servers icon.

  2. Click the Server - Status tab.

  3. Click Console.

  4. Enter the Load design command in the command line at the bottom of the console along with optional 
arguments to refresh a single database or all of the databases in a single directory, and then press ENTER.

Examples

To refresh all databases in the mail directory:l

design -d mail 

To refresh only the NAMES.NSF file:l

design -f names.nsf

To refresh only the USER.NSF in the mail directory:l

design -f mail\user.nsf

Domino 5 Administration Help

Server

5.0.2 and later allow user registration on pre-R5 servers
Domino R5.0.2 and later allow administrators to register users via a registration server running a version of Domino 
released prior to Domino R5. 

Domino R5, R5.0.1, and R5.0.1a require that user registration be performed on a registration server running Domino 
R5 or later. 

Administrator Client, Server

Domino Web Server Application Programming Interface (DSAPI) availability
The Domino Web Server Application Programming Interface (DSAPI) is a C API that lets you write your own extensions 
to the Domino Web Server. These extensions, or "filters,"  let you customize the authentication of Web users. The 
Domino 5 Administration Help topics listed below each include a cross-reference that directs you to the Lotus C API 
Toolkit for Domino and Notes Release 5.0.3. Note that this toolkit will not be available until 30 to 60 days after the 
release of Domino and Notes 5.0.3. When it is available, you can obtain the toolkit at http://www.lotus.com/techzone. 
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The relevant Domino 5 Administration Help topics are:

"Customizing access to a Domino server"l

"Validation and authentication for Notes and Domino"l

"Name-and-password authentication for Internet/intranet clients"l

"Validation and authentication for Internet/intranet clients"l

"Controlling the level of authentication for Web clients"l

Administrator Client

Forward slashes in group names are not supported
Domino R5 and subsequent point releases allow forward slashes to be typed into group names. This construct is 
considered by Lotus to be "not supported." A group name that contains forward slashes can be interpreted as a 
hierarchical group name, regardless of whether it was intended as such. For example a group name could be 
interpreted as having a common name, organization unit, and organization, where each is separated by a slash. If all 
representations of the group name are not identical this could result in failures during name comparisons.

Server

Installing Domino for IIS on Windows 2000
Instructions for installing Domino for IIS are found in the Domino R5 Administration Help topic "Configuring Domino 
for Microsoft IIS." This topic was written for Windows NT. Most of the information in this topic still applies to Windows 
2000. However, there are some important differences that you need to know:

References to the Microsoft Management Console (MMC) should be changed to Internet Services Manager. This 1.
application can be invoked by Programs->Administrative Tools->Internet Services Manager.

References to the Alpha platform do not apply.2.

The section entitled "To set up the ISAPI extension" requires some changes for Windows 2000. Here is an updated 3.
version of this section:

To set up the ISAPI extension
You need to set up the Domino ISAPI extension as the program to use when IIS encounters a browser request for a 
Domino application -- that is, a URL request that specifies a file with an .NSF file extension. You use the Internet 
Services Manager to set up the ISAPI extension.

Start the Internet Services Manager. Right-click the Web site for which you want to install Domino for IIS, and 1.
select Properties.

Select the Home Directory tab. Set the option Application Protection to "Low (IIS Process)".2.

Click Configuration. Select the App Mappings tab. Make sure that the option Cache ISAPI Applications is 3.
checked.

Click Add. In the Executable field, enter the full path name of the ISAPI extension file. This file is located in the 4.
Domino directory and is named NIISEXTN.DLL. For example, if you installed Domino in the default directories, 
the full path name is c:\lotus\domino\niisextn.dll.

In the Extension field, enter 5.

.NSF

In the Verbs box, select Limit To, and enter 6.

GET,POST

Select Script Engine and deselect Check that the File Exists.7.

Click OK.8.
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Administrator Client, Server

License tracking and new client license type
Using the Domino Administrator, you can track the number of Notes and non-Notes clients 
who are authorized to access your Domino servers. First, you assign license types to each 
client. Then you view this licensing information in the Domino Directory.

You can assign the following types of licenses:

Lotus Notesl

Lotus Notes Maill

Lotus Notes Desktopl

Lotus Notes Designerl

Lotus Notes Administration l

Lotus iNotes/Domino CALl

The default license type is Lotus Notes.

Assigning license types
You can assign license types manually, or you can create an agent or action to assign license 
types to multiple users simultaneously.

Assigning license types manually
To assign license types manually, you edit Person documents.

From the Servers pane of the Domino Administrator, choose the server from which you want to work.1.

Click the People & Groups tab.2.

Select the Person document to which you want to assign a license type, and click Edit Person.3.

Click the Administration tab.4.

In the "Notes client license" field, choose one or more license types.5.

Click Save and Close.6.

Assigning license types by using an agent
To use an agent to assign license types, you first create a form in the Domino Directory. The 
form includes a dialog box from which you can choose license types. Then you create and use 
the agent in the Domino Directory to assign the license types to Person documents you 
select.

The procedures below describe one way of creating the form and the agent.

Creating the form
To create a form in the Domino Directory, you should first create a copy of the Domino 
Directory template file and then create the form in the copy of the template file. For directions 
and rules about creating a coy of the Domino Directory template file, see the topic 
"Customizing the Domino Directory template" in Domino Administration Help or in the book 
Administering the Domino System.

From the Domino Designer, open the copy of the Domino Directory template file you created.1.

Open the Forms view.2.

Click New Form.3.

Choose Create->Layout Region->New Layout Region.4.

Do the following to add text to the layout region:5.

Choose Create->Layout Region->Text.l

Choose Edit->Properties.l

Enter the following text in the Text field:  Chose the license type for the selected users.l

Click the Font tab, and choose Bold to make the text bold.l

Close the properties box, and then drag the text to the upper left corner of the layout region. l

If necessary, drag the right side of the text object until it is wide enough to display all of the text.l
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Choose Create->Field.6.

Choose Edit->Properties, and do the following in the Field properties box:7.

In the Name field, type ClientType.l

In the Type fields, choose Listbox from the first drop-down list, choose Editable from the second drop-down l
list, and select "Allow multiple values."

Click the Control tab in the Field properties box, and add the following keywords in the Choices section:8.

Lotus Notes | 0l

Lotus Notes Mail | 1l

Lotus Notes Desktop | 2l

Lotus Notes Designer | 3l

Lotus Notes Administration | 4l

Lotus iNotes/Domino CAL | 5l

Click the Field Info tab in the Field properties box, and adjust the Width and Height so that the field will 9.
accommodate the keywords you entered in step 8.

In the Layout properties box, adjust the Width and Height of the layout region to the size you want.10.

(Optional) In the Form properties box, click the Form Background tab, and change the background color of the 11.
form region. Light gray is the most commonly used color for this purpose.

Choose File->Save, name the form "(SetLicenseType)" and then click OK.12.

Add the form to the Domino Directory. For directions, see the topic "Applying template customizations to the 13.
Domino Directory database" in Domino Administration Help or in the book Administering the Domino System.

Creating the agent
From the Domino Designer, open the Domino Directory.1.

Open the Agents view.2.

Click New Agent.3.

In the Name field, type Set License Type.4.

In the "When should this agent run?" field, choose Manually From Actions Menu.5.

In the "Which document(s) should it act on?" field, choose Selected documents.6.

In the Run field in the Programmer's pane, choose Lotuscript.7.

Click Initialize, and then add the following code to the Programmer's pane8.

Sub Initialize

Dim NDB_currentDB As NotesDatabase

Dim NV_currentView As NotesView

Dim NDC_collection As NotesDocumentCollection

Dim ND_document As NotesDocument

Dim NI_item As NotesItem

Dim NS_session As New NotesSession

Dim NW_workspace As New NotesUIWorkspace

Dim NV_Values As Variant

'enumerate currently selected notes

Set NDB_currentDB = NS_session.CurrentDatabase

Set NV_currentView = NDB_currentDB.GetView ("People")

Set NDC_collection = NDB_currentDB.UnprocessedDocuments

Set ND_document = NDC_collection.GetFirstDocument
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'launch the dialog that uses the SetLicenseType form and get the values set by the 
administrator

Call NW_workspace.DialogBox ( "(SetLicenseType)", True, True, True, True, False, 
False, "Set License Type", ND_document )

NV_Values = ND_document.getItemValue( "ClientType")

'loop the collection

Do Until ND_document Is Nothing

'set the ClientType field to the value retrieved from the dialog box

Call ND_document.replaceItemValue( "ClientType", NV_Values)

Call ND_document.save( True, True)

'ND_document is the current note handle

Set ND_document = NDC_collection.GetNextDocument(ND_document)

Loop

End Sub

Choose File - Save to save the agent.

Using the agent
To use the agent to assign license types, do the following:

From the Domino Administrator, click the People & Groups tab, and then open the People view.1.

Select the people to whom you want to assign the same license type(s).2.

Choose Actions->Set License Type.3.

Choose the license types you want to assign to the people you selected.4.

Click OK to assign the license types, or press ESC to cancel assigning the license types.5.

Viewing the assigned license types
You can view how many of each type of license you have assigned and to whom you have 
assigned each type of license.

Open the Domino Directory.1.

Open the Server\Licenses view.2.

Expand each section to view the people to whom you assigned each type of license.3.

The Server\Licenses view displays only one license type per person, even if you assign 
multiple license types to a person. The following section describes how the view determines 
which license type to display for a person.
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Precedence of license types in the Server\Licenses view
The following table shows the precedence for determining which license type to display in the 
Server\Licenses view. The table also shows the category in which each license type is 
displayed in the view.

Precedence License type Category in the view

1 Lotus Notes Mail Clients\Lotus Notes Mail

2 Lotus Notes Desktop Clients\Lotus Notes Desktop

3 Lotus Notes Clients\Lotus Notes

4 Lotus iNotes/Domino CAL Client (alternate access)\Lotus iNotes/Domino CAL

5 Lotus Notes Designer

Lotus Notes Administration 
Client (alternate access)\Other*

                     OR

Client (alternate access)\Unknown*

* Lotus Notes Designer and Lotus Notes Administration are displayed in the Client (alternate 
access)\Other category if the Person document contains at least one of the following:

A Notes certificate or public keyl

A mail file l

A mail serverl

An Internet passwordl

An Internet certificate (using the X.509 certificate format)l

If none of the above exist in the Person document, Lotus Notes Designer and Lotus Notes 
Administration licenses are displayed as Unlicensed/Unknown in the view.

Server

New Administration request in R5.0.3 - set web admin fields
Domino R5.0.3 includes the new administration request, Set web admin fields.  

Request triggered by - Updating an HTTP server to Domino R5.0.3.

Carried out on - Administration server for the Domino Directory.

Carried out - Immediately

Results: 

Places the server administrators into the "Administer the server from a browser" field on the Security tab of the l
Server document.

Places the HTTP server's name in the following fields:l

Administrator field on the Basics tab of the Server documentl

Run Unrestricted LotusScript/Java Agents field on the Security tab of the Server documentl

Administrator Client, Server

Migrating object classes from an LDIF entry - correction
The topic "Understanding how Notes uses information in the LDIF file" in the Migration section of the Domino 5 
Administration Help and in the book Moving to Notes and Domino Release 5 incorrectly suggests the LDIF migration tool 
supports the import of multiple object class types from an LDIF entry. The R5.x LDIF migration tool can import Person 
records only. The tool validates entries before importing them. Each entry must contain the object class definitions top
and person.
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Server

Naming rules for external LDAP directory group expansion
The topic "Verifying membership in groups in an LDAP directory" in Domino 5 Administration Help and in the book 
Administering the Domino System has incorrect information about the directory assistance rules required for the Group 
Expansion option for an external LDAP directory.  To search groups in an external LDAP directory when checking 
database access, you should configure rules that correspond to the name formats of the authenticated users within 
the groups. In addition, if you choose the "Nested Group Expansion" option, you should additionally add rules that 
correspond to the names of any nested groups to be searched.

Server

Quick method for configuring directory assistance to look on the local server
You can enter an asterisk (*) in the Server Name field in the Replicas tab of a Directory Assistance document to 
indicate that directory assistance should look on its local server for a replica of the secondary directory.  This feature 
is useful in an environment where multiple servers store replicas of secondary Domino directories and do local 
lookups to the directories.  Using an * in the Server Name field avoids having to use multiple Server Name/Address 
Book Filename entries in a Directory Assistance document. 

For example, if servers A, B, C, and D all store a local replica of the secondary directory ACMEWEST.NSF, if you use 
the *, it's necessary to make only one replica entry in the Directory Assistance document for that directory as follows:

Server Name Address Book Filename
* ACMEWEST.NSF

Without an asterisk, four Server Name/Address Book Filename entries are necessary:

Server Name Address Book Filename
Server A ACMEWEST.NSF
Server B ACMEWEST.NSF
Server C ACMEWEST.NSF
Server D ACMEWEST.NSF

If there are directory assistance servers that don't have a local replica of a secondary directory, then you must add at 
least one explicit Server Name/Address Book Filename entry in the Directory Assistance document for these servers to 
use. 

Note: Do not use * in the Server Name field in a Directory Assistance database that R4.x servers use. If you want to 
use the * for R5 servers, create a separate Directory Assistance database that uses explicit server names for the R4.x 
servers to use.

Server

Server restart needed to complete Domain Search setup
When enabling Domain Search, after entering the appropriate information in the Server document and loading the 
catalog at the console, you must restart the Domino Server to ensure the Domain Indexer will run at its next scheduled 
interval.

Server

Session-Based Authentication login messages
Session-Based Web Authentication will return error messages for login failures and session timeouts. This is 
accomplished by configuring two fields on your custom login form (reasontext and reasontype fields). Domcfg.ntf has 
been updated to include these two new fields in the default form provided, $$LoginForm. (To obtain the changes, you 
must refresh or replace the design of domcfg.nsf with the new domcfg.ntf.)  

The four cases that cause the Login form to appear are listed below,  which are encoded in the field "reasontype".

Prompt for the user to log in, at which no error message will display.l

"You are not authorized to perform this operation." The user is authenticated with correct credentials for the l
server but is not authorized to the database or file, for example.
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"Invalid username or password was specified." The user has given an incorrect name or password.l

"Your session with the server has expired. The current operation was not executed." This occurs when the browser l
has not sent a request to the server in the given amount of time as configured in the server document (default=30 
minutes). If the session times out, they will lose what hasn't been saved. We recommend that administrators 
lengthen the server's session timeout, if this occurs frequently, to perhaps the length of a workday.

Server

Enabling Single Sign-on for Domino and WebSphere servers
Beginning with R5.0.5, Web users can log on once to a Domino or WebSphere server, then access any other Domino or 
WebSphere server in the same DNS domain that are enabled for Single Sign-on (SSO) without logging on again. This is 
accomplished by selecting a new "Multi-server" option (in a Server document) for session-based authentication, along 
with creating a new domain-wide configuration document in the Domino Directory called the Web SSO Configuration 
document.  This document, which should be replicated to all servers participating in the Single Sign-on domain, is 
encrypted for participating servers and contains a shared secret used by servers for authenticating user credentials. 

All servers participating in Single Sign-on must be at the Domino 5.0.5 level or above. The users' Web browsers must 
have cookies enabled since the authentication token that is generated by the server is transported to the browser in a 
cookie.  

Notes:

The Web SSO Configuration document must be created using a Notes Client that is R5.0.5.l

You can create only one Web SSO Configuration document in your domain.l

You can create Single Sign-on across multiple domains. (For instructions, refer to the "Setting up the Web SSO l
Configuration document for more than one Domino domain" section below.)

Domino Single Sign-on has been tested on all Domino supported platforms. WebSphere Single Sign-On with l
Domino has been tested with WebSphere 3.5 on NT only.

For more information, refer to the Release Note "Troubleshooting Single Sign-on for Domino and WebSphere."l

Step One: Create the Web SSO Configuration document 

In the Domino Directory, select the Servers view.1.

Select the Web... pull-down menu button.2.

Select Create Web SSO Configuration. 3.

In the document, select the Keys... pull-down menu button.4.

Initialize the Web SSO Configuration with the shared secret in one of two ways:5.

Domino only (no WebSphere servers participating in Single Sign-on).1.

Select Create Domino SSO Key.1.

Domino and WebSphere (Single Sign-on with WebSphere 3.5).2.

Select Import WebSphere LTPA Keys.1.

Browse and select the WebSphere LTPA export file (See WebSphere documentation for details).2.

Enter the password  (Specified when generating the keys in WebSphere).3.

The document should update to reflect the information in the export file.4.

Configure the Token Expiration field. Note that a token does not expire based on inactivity, it is valid for only the 6.
number of minutes specified from the time of issue.

In the Token Domain field, enter the DNS domain (for example, lotus.com) for which the tokens will be 7.
generated. The servers enabled for Single Sign-on must all belong to the same DNS domain. This is a required 
field.
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In the Server Names field, enter the servers that will be participating in Single Sign-on. This document will be 8.
encrypted for the creator of the document, the members of the Owners and Administrators fields, and the servers 
specified in the Server Names field.

Note: Groups and wildcards are not allowed in the fields. WebSphere servers do not get listed as a participating 
server in the Server Names field, only Domino Servers. 

Save the Web SSO Configuration document. It will appear in the Web Configurations view.9.

Step Two: Enable Single Sign-on in the server document and Basic Authentication

Edit the Server document.1.

Select the Ports tab -> Internet Ports tab -> Web tab, enable Name & Password authentication for the HTTP port.2.

Select the Internet Protocols tab -> Domino Web Engine tab, select Multi-server in the Session authentication 3.
field.

Save the Server document.4.

Step Three: Start the HTTP task on the Single Sign-on enabled servers

Start  the HTTP web server.1.

On the Domino console, the following message should appear:2.

HTTP: Successfully loaded Web SSO Configuration.

If a server enabled for Single Sign-on cannot find a Web SSO Configuration document or is not included in the 3.
Server Names field (and thus cannot decrypt the document), then the following message should appear on your 
server's console:

HTTP: Error Loading Web SSO configuration. Reverting to single-server session authentication.  

Setting up the Web SSO Configuration document for more than one Domino domain

An Administrator (with the rights to decrypt the Web SSO Configuration document in Domain X and to create 1.
documents in the Directory for Domain Y) should copy the Web SSO Configuration document out of the Directory  
for Domain X and paste it into the Directory for Domain Y. 

Edit the Web SSO Configuration document for Domain Y and edit the "Participating Domino Servers" field to 2.
include only the servers with server documents in Domain Y that will participate in Single Sign-On.

Make sure that your client's location home server is set to a server in Domain Y.  Save the document. It should 3.
now be encrypted for the participating Servers in Domain Y, and should enable servers in Domain Y to do Single 
Sign-On with servers in Domain X, as both domains are now using the same key information.

Single Sign-on used with Domino/IIS servers

When IIS's Directory Security is set to allow anonymous access, Single Sign-on will work with both Domino and l
WebSphere servers and Domino/IIS servers. If IIS's Directory Security is set to Basic Authentication or Windows 
NT Challenge/Response (NTLM), Single Sign-on is not supported for this release of Domino. NTLM is a 
Microsoft-specific protocol supported by Internet Explorer, in which the user's current NT logon account name is 
used to authenticate to the server.   In both cases,  IIS will authenticate the  NT account name against the NT 
registry on the IIS Server first and because the user is already authenticated, a cookie is not generated nor 
honored. 

For more information about troubleshooting Single Sign-on, please refer to the "Troubleshooting Single Sign-on for 
Domino and WebSphere" Release Note (in the "Troubleshooting/Server Issues" section).
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Administrator Client, Server

Enabling Java API options for authenticated invocation
The following Java/CORBA class (lotus.domino package) elements support sign-on to Domino and WebSphere servers 
in a Single Sign-on domain.

getSessionToken method
Gets a session token for enabling sign-on to Domino and WebSphere servers in a domain that supports Single Sign-on.

NOTE: This method is new with R5.0.5.

Defined in

Session

Data type

String

Syntax

public String getSessionToken()
    throws NotesException

public String getSessionToken(String serverName)
    throws NotesException

Parameter

String serverName

The name of a server configured for Single Sign-on. If the server name is not specified, the code must execute 
on a server configured for Single Sign-on.

Return value

String

The session token.

Usage

The token is unique for each user and is valid for the time specified in the Domino Directory. The format of the token 
is consistent with the LtpaToken cookie used by WebSphere.

You can also get the token from the HTTP headers in a servlet with HttpServletRequest.getCookies().

NotesFactory class
NOTE: To make remote (IIOP) calls to the Domino Objects in a WebSphere environment, NCSOW.jar must be in your 
classpath. This is new with R5.0.4.

The description of the NotesFactory class is extended as follows.

NOTE: These extensions are new with R5.0.5.

To access a server using Single Sign-on, create a Session object as follows. For remote (IIOP) calls, the first parameter 
is the Internet name of the host. For local calls, the first parameter is null.

createSession(hostString, String token) - Access is granted based on the token. This method works in a Domino l
environment. The token must be a valid token for Single Sign-on obtained from Session.getSessionToken or the 
LtpaToken cookie used by WebSphere.

createSession(hostString, org.omg.SecurityLevel2.Credentials) - Access is based on the Credentials object. This l
method works in a WebSphere environment where the Credentials object is created using loginHelper.

createSession(hostString, null) - Access is granted based on the current Credentials object in the WebSphere l
environment. This method works from an Enterprise JavaBeans (EJB) application in WebSphere.

The specification of NotesFactory is extended with the following methods:

static public Session createSession(String host, String token)
throws NotesException

static public Session createSession(String host, org.omg.SecurityLevel2.Credentials)
throws NotesException
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Examples

Example #1

This Domino agent gets a token for Single Sign-on and creates a remote (IIOP) session to another server based on the 
token. The agent runs on the server containing the token.

import lotus.domino.*;

public class JavaAgent extends AgentBase {
  public void NotesMain() {
    try {
      Session session = getSession();
      AgentContext agentContext = session.getAgentContext();
      Session s2 = NotesFactory.createSession("test5.irish.com",
                   session.getSessionToken());
      System.out.println("remote session name = " + s2.getUserName());

    } catch(Exception e) {
      e.printStackTrace();
    }
  }
}

Example #2

This Domino agent gets a token for Single Sign-on and creates a remote (IIOP) session to a server based on the token. 
The agent runs a Notes client.

import lotus.domino.*;

public class JavaAgent extends AgentBase {
  public void NotesMain() {
    try {
      Session session = getSession();
      AgentContext agentContext = session.getAgentContext();
      Session s2 = NotesFactory.createSession("test5.irish.com",
                   session.getSessionToken("test5.irish.com"));
      System.out.println("remote session name = " + s2.getUserName());

    } catch(Exception e) {
      e.printStackTrace();
    }
  }
}

Server

Multiple network adapters in partitioned server
If there are multiple network adapters in the server, two entries must be added to the NOTES.INI file for these tasks to 
run in a partitioned server environment for the respective protocol. The first, <PortName>_TCPIPAddress, binds an 
individual Notes port to an IP address; the second, <INTERNETPROTOCOL>NotesPort=TCPIP, binds an Internet 
service (such as LDAP, SMTP, or IMAP) to the Notes port, thus associating the service with it IP address.  

The general syntax of the first setting is <PortName>_TCPIPAddress=0,xxx.xxx.xxx.xxx:1352, where PortName is the 
name of the Notes port defined in the PORTS= line in NOTES.INI, and xxx.xxx.xxx.xxx is one of the IP addresses defined 
in the machine's network settings.  

The second entry is the <INTERNETPROTOCOL>NotesPort=TCPIP entry, such as IMAPNotesPort=TCPIP. This 
applies to IMAP, LDAP, NNTP, POP3, and SMTP. For example

IMAPNotesPort=TCPIP   (or the protocol used on your server)l

LDAPNotesPort=TCPIPl

NNNTPNotesPort=TCPIPl

POP3NotesPort=TCPIPl

SMTPNotesPort=TCPIPl
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Server

Performance Monitoring Statistics
Performance Monitoring Statistics is for these supported platforms: 

Windows NT Intell
Solaris Sparcl
AS/400 l

See the Domino AS/400 Release Notes for more information about Platform Statistics on that platform.

Platform Statistics are not supported for Windows 2000 running Domino Release 5.x. 

Domino will track performance metrics of the operating system and capture the results in the Domino server. Type 
"show stat platform" at the server console to display them. This feature is disabled by default in R5.0.x. 

You can enable it by setting the parameter:

PLATFORM_STATISTICS_ENABLED=1 

in the NOTES.INI file and restarting the Domino server. 

Metrics are collected continuously, unless disabled or reset (see commands below), or unless the server is brought 
down. The server resets this information each time it is started. This feature also expects certain Notes processes to 
be present. Performance counters for absent Notes processes will have zero values. This is normal behavior.

To collect disk stats on Windows NT execute the "diskperf -y" command at the command line prompt, (or "diskperf -ye" 
if your system uses striped RAID arrays).

Run the "diskperf" with no parameters gives status and help info. Disk stats will be enabled the next time you restart 
the system.

The server monitors the following metrics:

Performance Metric Description
Platform.Memory.KBFree The amount in kilobytes of virtual memory available on the system. 

Equivalent to: 
Windows NT - Memory Object/AvailableBytes Counter in Perfmon divided by 1024.
Solaris - vmstat,  memory free, in Kb/sec.

Platform.Memory.PagesPerSec The number of pages read to or written from the disk. 
Equivalent to: 
Windows NT - Memory Object/Pages/Second Counter in Perfmon.
Solaris - vmstat,  add pi and po on to get total pages.

Platform.System.TotalUtil The average percent CPU utilization of all CPU's on the system. 
Equivalent to:
Windows NT - System Object/% Total Processor Time Counter in Perfmon.
Solaris - iostat -c,  add % time in user mode & system mode to get total % utilization.

Platform.System.TotalPrivUtil The average percent CPU utilization in privileged mode of all CPU's on the system. 
Equivalent to:
Windows NT - System Object/% Total Privileged Time Counter in Perfmon.
Solaris -  iostat -c,  use %time spent in system (kernel) mode.

Platform.System.TotalUserUtil The average percent CPU utilization in user mode of all CPU's on the system. 
Equivalent to:
Windows NT - System Object/% Total User Time Counter in Perfmon.
Solaris -  iostat -c,   use %time spent in user mode.

Platform.LogicalDisk._Total.1._Total.1.PctTi
me

The percentage of the sampling interval that all logical disks on all physical disks are 
servicing read or write requests. 
Equivalent to:
Windows NT - LogicalDisk Object/% Disk Time Counter in Perfmon.  As in Perfmon, 
the first "_Total" refers to all physical disks, and the second "_Total" refers to all 
logical disks.
Solaris - iostat -x,  look under %b for  percent time disk is busy (utilization).

Platform.LogicalDisk._Total.1._Total.1.AvgQ
ueueLength (NT only)

The average number of both read and write requests that were queued for all logical 
disks on all physical disks during the sample interval. 
Equivalent to LogicalDisk Object/Avg. Disk Queue Length Counter in Perfmon.

Platform.LogicalDisk._Total.1._Total.1.Servic
eTime (Solaris only)

The amount of time in milliseconds for a read or write command to complete.
Equivalent to iostat -x, look under svc_t  

Platform.Process.nserver.1.Util (not on 
Solaris)

The CPU utilization of the first server process. This is the percentage of the sample 
interval that the process used the CPU. 
Equivalent to Process Object/% Processor Time/nserver Counter in Perfmon.

Platform.Process.nrouter.1.Util (not on 
Solaris)

The CPU utilization of the first router process.
Equivalent to Process Object/% Processor Time/nrouter Counter in Perfmon.
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Performance Metric Description
Platform.Process.nreplica.1.Util (not on 
Solaris)

The CPU utilization of the first replica process.
Equivalent to Process Object/% Processor Time/nreplica Counter in Perfmon.

Platform.Process.nreplica.2.Util (not on 
Solaris)

The CPU utilization of the second replica process.
Equivalent to Process Object/% Processor Time/nreplica Counter in Perfmon.

Platform.Process.nreplica.3.Util (not on 
Solaris)

The CPU utilization of the third replica process.
Equivalent to Process Object/% Processor Time/nreplica Counter in Perfmon.

Platform.Process.nreplica.4.Util (not on 
Solaris)

The CPU utilization of the fourth replica process.
Equivalent to Process Object/% Processor Time/nreplica Counter in Perfmon.

Platform.Process.nupdate.1.Util (not on 
Solaris)

The CPU utilization of the first update process.
Equivalent to Process Object/% Processor Time/nupdate Counter in Perfmon.

Platform.Process.nupdate.2.Util (not on 
Solaris)

The CPU utilization of the second update process.
Equivalent to Process Object/% Processor Time/nupdate Counter in Perfmon.

Platform.Process.nupdate.3.Util (not on 
Solaris)

The CPU utilization of the third update process.
Equivalent to Process Object/% Processor Time/nupdate Counter in Perfmon.

Platform.Process.nupdate.4.Util (not on 
Solaris)

The CPU utilization of the fourth update process.
Equivalent to Process Object/% Processor Time/nupdate Counter in Perfmon.

Platform.Process.nadminp.1.Util (not on 
Solaris)

The CPU utilization of the first adminp process.
Equivalent to Process Object/% Processor Time/nadminp Counter in Perfmon.

Platform.Process.nadminp.2.Util (not on 
Solaris)

The CPU utilization of the second adminp process.
Equivalent to Process Object/% Processor Time/nadminp Counter in Perfmon.

Platform.Process.nadminp.3.Util (not on 
Solaris)

The CPU utilization of the third adminp process.
Equivalent to Process Object/% Processor Time/nadminp Counter in Perfmon.

Platform.Process.nadminp.4.Util (not on 
Solaris)

The CPU utilization of the fourth adminp process.
Equivalent to Process Object/% Processor Time/nadminp Counter in Perfmon.

Platform.Process.nhttp.1.Util (not on 
Solaris)

The CPU utilization of the first http process.
Equivalent to Process Object/% Processor Time/nhttp Counter in Perfmon.

For non-process metrics (those not starting with "Platform.Process"), average, minimum, and maximum statistics are 
also reported. For example, in addition to Platform.Memory.KBFree, there are the following secondary statistics:

Platform.Memory.KBFree.avg The average of all KBFree samplings for a session. This is calculated by 
summing all the KBFree samplings, and dividing by the number of 
samplings.

Platform.Memory.KBFree.min The smallest KBFree sampling for a session
Platform.Memory.KBFree.max The largest KBFree sampling for a session

If a process is removed, the metric for that process will go to 0.

The PLATFORM command allows you to control this feature at the console. It has the following form:

PLATFORM <main argument> [<optional arguments>]

These are the main arguments:

Argument(s) Description
TIME [<sampling rate>] With an optional argument, changes the sampling rate to the specified 

value in minutes. Otherwise displays the current sampling rate. The 
default is 1 minute.

RESET Initiates the beginning of a new statistics monitoring session; resets 
secondary metrics.

WAIT Pauses the collection of performance data
RUN Resumes the collection of performance data

For example, to start a new performance data monitoring session with a sampling rate of 5 minutes, type the following 
commands at the console:

Command Description
platform time 5 The server collects performance data every 5 minutes.
platform reset Statistic values sampled before this command was issued 

are not used in calculating average, maximum, or 
minimum.

Changes have also been made to the Stats and Events database so these statistics can be treated like any other stat 
(i.e. thresholds, etc.). They can be viewed through the Admin client.
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Troubleshooting
If you get the following error at the console on Domino server startup: "Perform: Unable to set up 1.
performance counters," use Regedit to check the following registry setting.

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\notestat\Performance\Libr
ary 

This should be set to NNOTES.DLL. It should include the path to your Domino server executable directory. For 
example: C:\Domino\NNOTES.DLL.

If you don't see disk counters on NT, follow earlier instructions for enabling disk stats on your system.2.

Administrator Client

Fixup task does not work on database folders
R5 documentation incorrectly states that when you run the Fixup task, you can specify a database folder as the 
database path. The database path for Fixup must be a database or any type of Notes file (which can reside in a 
database folder); Fixup does not work if you specify a database folder.

Administrator Client, Server

Server_Max_Concurrent_Trans settings
The settings for the NOTES.INI variable Server_Max_Concurrent_Trans in the Admin Guide are not up to date. This 
variable should not be set unless advised by Lotus Support. 

Currently the Admin Guide recommends that the Unix setting be -1. By default, it is actually 20, and it should not l
be changed. (By default on S/390 it is -1, on all other platforms it is 20.) 
Currently the Admin Guide recommends that the NT setting be 20 "system-wide." The actual default is 20, l
"per-partition." Again, this should not be changed.

For all platforms, Server_Max_Concurrent_Trans should not be set unless advised by Lotus Support.

Administrator Client, Designer

Administrators: Don't use FTV_Max_Fields or FTV_Fields_database
The NOTES.INI variables FTV_Max_Fields and FTV_Fields_database are not supported in R5. 

Administrator Client, Server

Running server tasks from operating system command line
To run the Updall, Compact, and Fixup server tasks on the following operating system command lines, you need to 
supply the following prefixes.

Operating System Prefix Needed Examples
Win32 platforms n ncompact -C, nupdall -R, nfixup -F
OS/2 i icompact -C, iupdall -R, ifixup -F
Linux none compact - C
Unix none updall -R

Administrator Client, Server

Updall -R rebuilds only all used views
The documentation for the Updall  -R server task incorrectly states that it rebuilds full-text indexes as well as all used 
views.  Updall -R rebuilds only all used views; Updall -X rebuilds full-text indexes.  To rebuild full-text indexes as well 
as all used views, use both options, for example, Load updall -X -R.
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Server

Determining whether to create a private LAN for your cluster
If you create a private LAN for cluster communication, using the Server_Cluster_Default_port NOTES.INI variable, 
please note that if communication fails on this port Domino does NOT fall back to another port. To recover from a 
failure of the cluster private port you must either resolve the network problem or remove the NOTES.INI variable.

Administrator Client, Client

Use MAIL50.NTF to create POP3 mail file
Step 4 of the topic "Creating a mail file for a POP3 user" in the Domino 5 Administration Help, incorrectly instructs 
administrators to "Select the template named MAIL.NTF" to create a POP3 user's mail file. There is no R5 template 
with the filename MAIL.NTF. Administrators should use the template MAIL50.NTF to create the mail file.

Administrator Client, Server

Selection formula in a Directory Catalog Configuration document
Use the "Selection Formula" field in a Directory Catalog Configuration document to enter a selection formula to 
aggregate only documents defined by the formula. For example, to aggregate only Person documents with a value of 
"Atlanta" in the Location field, aggregate all Group documents, and exclude all other documents, use the following 
selection formula:

SELECT (Form = "Person" & Location = "Atlanta") | (Form = "Group")

Or to aggregate only Person documents for people assigned to a specific mail server, use a selection formula such as:

SELECT (Form = "Person" & MailServer = "MailServer1")

The "Selection Formula" field functions similarly to the replication setting "Replicate a subset of documents - select by 
formula" option used in other databases. Keep in mind that a selection formula applies to all the aggregated 
directories, so make sure it is valid for all of them. Note that you can't use a selection formula to aggregate 
documents that are never aggregated into a directory catalog. For example, you can't use a selection formula to 
aggregate Server Configuration documents or Server Connection documents.  

For more information on selection formulas, see the topic "Selection formulas" in Domino Designer Help. 

How a selection formula interacts with the "Group types" setting
The "Group types" field in a Directory Catalog Configuration document controls the types of groups that the Dircat task 
aggregates into a directory catalog. If you use a selection formula and you want to aggregate groups, you must select 
the groups as part of the selection formula and use the "Group types" field to indicate which types of groups to 
aggregate. For example, if you want to aggregate only Person documents with a Location of Atlanta, and only Mail and 
Multipurpose groups:

• Use this selection formula:  SELECT (Form = "Person" & Location = "Atlanta") | (Form = "Group")
• Select the "Group Type" option "Mail and Multipurpose."

A selection formula can select only the types of groups indicated by the "Group types" option.

How a selection formula interacts with the "Include Servers" setting
The "Include Servers" field in an Directory Catalog Configuration document for an Extended Server Directory Catalog 
controls whether the Dircat task aggregate Server documents. If you use a selection formula and you want to 
aggregate Server documents, you must select the Server documents as part of the selection formula and check  the 
"Include Servers" field.

You cannot aggregate Server documents into a Mobile Directory Catalog/Condensed Server Directory Catalog. 

How a selection formula interacts with the "Include Mail-In Databases" setting
The "Include Mail-In Databases" field in a Directory Catalog Configuration document  controls whether to aggregate 
Mail-In Database documents. If you use a selection formula and you want to aggregate Mail-In Database documents, 
you must select the Mail-In Database documents as part of the selection formula and select Yes for the "Include 
Mail-In Databases" setting.
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Server

LDAP Schema changes in R5.0.2
There are several LDAP schema changes in R5.0.2 as described in the following topics.

Street and postalAddress attribute mapping
LDAP RFC 2256 makes a distinction between the attributes street and postalAddress. Street is defined as a physical 
delivery location and postalAddress as a mailing address used by the postal service. In addition, postalAddress isn't 
comprised of component parts. In Release 5.0 and 5.0.1, the LDAP service mapped the attribute street to a street 
portion of the  postalAddress and also derived postal addresses by concatenating values for multiple fields. To better 
comply with LDAP standards, in Release 5.0.2 the LDAP service correctly distinguishes between street and 
postalAddress attributes. Also, the Domino LDAP service no longer derives postalAddress attributes from multiple 
fields. The following table summarizes these mapping changes:

LDAP attribute Schema source Previous field mapping 
in Person documents 
(R5.0 and R5.0.1)*

Current field mapping 
in Person documents 
(R5.0.2)*

Street 
(or the alias, streetAddress)

RFC 2256 OfficeStreetAddress Street 
(new, hidden)

postalAddress RFC 2256 OfficeStreetAddress, 
OfficeCity, OfficeState, 
OfficeZip, OfficeCountry

PostalAddress 
(new, hidden)

homePostalAddress InetOrgPerson Draft HomeStreetAddress, 
HomeCity, HomeState, 
HomeZip, HomeCountry

HomePostalAddress 
(new, hidden)

homeStreetAddress Domino StreetAddress StreetAddress
officeStreetAddress 
(new) 

Domino ------ OfficeStreetAddress 

*Names refer to the fields themselves rather than the labels used to display them. 

In R5.0.2, if a user searches for the attribute street (or streetAddress) and there is no value in the Street field, the 
LDAP service returns nothing (it will not revert to the previous behavior). 

If a user searches for the attribute postalAddress, the LDAP service first looks for a value in the PostalAddress field. If 
it does not find a value there, it reverts to the previous behavior as described in the table above. Similarly, if a user 
searches for the attribute homePostalAddress and there is no value in the HomePostalAddress field, the LDAP service 
reverts to the previous behavior.

If users add or modify values for the postalAddress or homePostalAddress attribute, changes only apply to the 
PostalAddress field or HomePostalAddress field, respectively. For example, if users specify the attribute postalAddress 
in a modify command, the LDAP service does not change values in the fields OfficeStreetAddress, OfficeCity, 
OfficeState, OfficeZip, and OfficeCountry if there is no value in the PostalAddress field. 
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New mappings for LDAP name attributes
In R5.0 and R5.0.1, LDAP name attributes in the schema were derived from components of distinguished names. In 
R5.0.2, the LDAP service uses distinct name attributes. The following table summarizes these changes.

LDAP attribute Previous mapping 
(R5.0 and 5.0.1)

Current mapping 
(R5.0.2)

cn RDN* 2nd-nth values in the FullName 
field, ListName field (for groups) 
or ServerName field (for servers). 
Also maps to the RDN if cn is 
specified as the RDN. 

uid RDN ShortName field. Also maps to 
the RDN if uid is specified as the 
RDN.

ou ou component of DN ou attribute; no longer derived 
from a DN**

o o component of DN o attribute; no longer derived 
from a DN**

l OfficeCity field OfficeCity field. Also maps to the 
RDN if l is specified as the RDN. 

*The RDN (Relative Distinguished Name) is the left-most component of the DN (Distinguished Name). The value for a 
DN is the first value listed in the FullName field, ListName field (for groups), or ServerName field (for servers). 

**The "ou" and "o" attributes do not typically map to fields in the directory. An exception to this is the Person form 
(which represents the dominoPerson object class) which contains a new hidden field called "ou." 

When you add an entry, the RDN specified for the entry becomes the value for the RDN as well as a distinct l
attribute For example, if you add a person entry with the DN "uid=jdoe, ou=west, o=acme," "jdoe/west/acme" is 
added as the first value in the FullName field and "jdoe" is added to the ShortName field.

When you search on cn, uid, or l, the LDAP service searches an RDN as well as the distinct attributes. For l
example,  for a search on "uid=jdoe" , the LDAP service searches for "jdoe" in the RDN and also in the ShortName 
field.

When you search on o or ou attributes, the LDAP service no longer returns a component of a DN.  For example, a l
search on "ou=west" doesn't return the value "west" from the DN "jdoe/west/acme." 

If you specify one of the above attributes in an LDAP modify command, the change doesn't affect an RDN. l
Assuming previous examples, if you do an LDAP modify-add operation to add "johnd" as an additional UID 
attribute value, the ShortName field then contains the values, "jdoe" and "johnd." If you then specify "uid=johnd" in  
an LDAP modify-delete operation, the "johnd" value is deleted but if you specify instead "uid=jdoe", the "jdoe" value 
is not deleted because it is the RDN. 

textEncodedORAddress and mhsORAddress attributes
In R5.0, the textEncodedORAddress attribute  was included as part of the ePerson object class and had the alias 
mhsORAddress. textEncodedORAddress mapped to the field X400Address in Person documents. In R5.01, the 
ePerson object class was removed from the schema, and so textEncodedORAddress (and its alias, mhsORAddress) 
then were re-defined as part of the dominoPerson object class.  
In R5.0.2, textEncodedORAddress and mhsORAddress are no longer part of the directory schema. You must add these 
attributes to the schema if you want to use them. 

X400Address remains as a Domino defined attribute with syntax type 'DN', which is derived from the X400Address 
field assigned the data type "Names."

physicalDeliveryOfficeName and roomNumber attributes
In R5.0 and R5.0.1, roomNumber is treated as an alias of physicalDeliveryOfficeName, which maps to the field 
OfficeNumber. In R5.0.2, roomNumber is a distinct attribute in the schema; roomNumber does not have a field 
correlation in the Domino Directory.  Note that physicalDeliveryOfficeName continues to map to the OfficeNumber 
field.
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initials, middleName, and middleInitials attributes
In R5.0.2, the LDAP attribute middleName is no longer defined in the schema; to use this attribute you must extend 
the schema. Previously the middleName attribute was included in the schema and mapped to the field MiddleInitial in 
the Person document. There is a new Domino-defined LDAP attribute called MiddleInitial that maps to the 
MiddleInitial field.  

The LDAP attribute initials is still defined in the schema, but it does not have a field correlation in the Domino 
Directory.

Additional organizational units allowed in distinguished names
In R5.0.2, a distinguished name added through LDAP can include up to 12 OUs. Entries created through Domino are 
still limited to four OUs, however. Distinguished names with more than four OUs cannot be displayed in the usual 
abbreviated format by Notes clients and may have unknown side effects in the Notes client.  Consequently, creating 
entries with more than 4 OUs in their DNs is not recommended if the entries will be used by both Notes and LDAP 
clients.

Changes to Object Class definitions
In R5.0.2, object class definitions have changed as follows:

R5.0 and 5.0.1 
object class

Changes in R5.0.2* Comments

ePerson Removed (in R5.0.1) LDAP standards define this as auxiliary, so you 
should add this to your schema yourself if you 
need it.

dominoGroup _____ _____
dominoPerson Superior object class is now inetOrgPerson _____
Server Object class name changed to dominoServer _____
$PersonGeneralInfo _____ Defined in the schema as an auxiliary object class 

with ditContentRule that associates it with the 
dominoPerson object class. 

Correlates to the $PersonGeneralInfo subform 
that defines the fields displayed in the 
Work/Home tab of a Person document. 

inetOrgPerson Redefined as a structural object class. Previously 
defined as abstract.**

Entries created for the inetOrgPerson object class 
also include attribute definitions for the 
dominoPerson object class. Don't add values for 
these attributes if you don't want to use them. 

Top _____ _____
organization Redefined as the structural object class 

"organization" specified in RFC 2256.**
Entries created for the "organization" object class 
also include attribute definitions for the 
dominoOrganization object class. Don't add 
values for these attributes if you don't want to 
use them. 

The new dominoOrganization object class 
correlates to the "organization" object class 
previously used in R5.0 and R5.0.1.

organizationalUnit Redefined as the structural object class 
"organizationalUnit" specified in RFC 2256.**

Entries created for the organizationalUnit object 
class also include attribute definitions for the 
dominoOrganizationalUnit object class. Don't add 
values for these attributes if you don't want to 
use them. 

The new dominoOrganizationalUnit object class 
correlates to the "organizationalUnit" object class 
previously used in R5.0 and R5.0.1.

person Redefined as a structural object class. Previously 
defined as abstract.**

Entries created for the "person" object class also 
include attribute definitions for the 
dominoPerson object class. Don't add values for 
these attributes if you don't want to use them. 
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R5.0 and 5.0.1 
object class

Changes in R5.0.2* Comments

organizationalPerson Redefined as a structural object class.  Previously 
was defined as an abstract object class.**

Entries created for the organizationalPerson 
object class also include attribute definitions for 
the dominoPerson object class. Don't add values 
for these attributes if you don't want to use them. 

groupOfNames Redefined as a structural object class. Previously 
was defined as an abstract object class.**

Entries created for the groupOfNames object 
class also include attribute definitions for the 
dominoGroup object class. Don't add values for 
these attributes if you don't want to use them. 

--------- New structural object class:  
dominoOrganization. Has definitions for 
Domino-specific organization attributes.

Correlates to the "organization" object class in 
R5.0 and R5.0.1. Entries created using the 
Certifier form.

--------- New structural object class: 
dominoOrganizationalUnit. Has definitions for 
Domino-specific organizationalUnit attributes

Correlates to the organizationalUnit object class 
in R5.0 and R5.0.1. Entries creating using the 
Certifier form.

--------- New structural object class: locality. Entries created from the new, hidden form, (LDAP 
Locality). 

*Many standard LDAP attributes have been added to the schema. This table does not list these new attributes. Please 
refer to the Domino LDAP Schema database updated on an R5.0.2 server for the current list of supported attributes. 
Some attributes defined in the schema are not physically represented in the directory as fields. However, LDAP 
operations work against these attributes.

**You cannot create entries for these object classes from Notes. When you add the entries via LDAP, the entries are 
not physically created in the directory and can only be accessed through LDAP operations.

Server

"Optimize LDAP queries" change beginning in R5.0.2
In R5 and in R5.0.1, there is an LDAP service configuration option called "Optimize LDAP queries." Enabling this 
option builds certain hidden views in the Domino Directory that improve LDAP search performance and that allow 
alternate language searches (and searches of entries of object classes you add to the directory). 

Beginning in R5.0.2, the "Optimize LDAP queries" option has been removed. Now, the LDAP service always builds 
these hidden views in the replica of the primary Domino Directory on the server running the LDAP service and in the 
replicas of any secondary Domino directories served by the LDAP service. This new behavior ensures optimum LDAP 
search performance. If you want to allow alternate language searches, it is still necessary to choose the "Allow 
alternate language information processing" option. 

Note that if a Domino Directory on an R5 or R5.0.1 server has all of the following characteristics, you should upgrade 
the server to R5.0.2 or higher:

The directory is served by the LDAP service running on an R5.0.2 server or higher.l

The "Optimize LDAP queries" option is enabled for the directory.l

The directory design will be updated with the R5.0.2 or higher PUBNAMES.NTF template.l

Administrator Client, Server

Directory Assistance and LDAP add operations
In an environment with secondary Domino directories, the following rules determine in which directory or directories 
the LDAP service puts an entry added through LDAP: 

NOTE: To modify a secondary directory through LDAP operations, store the directory locally on the server that runs 
the LDAP service. For more information, see the release note "Confine LDAP writes to local directories."

If the entry name corresponds to a Directory Assistance naming rule assigned to only one secondary directory, l
the LDAP service adds the entry to that directory.
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If the entry name corresponds to naming rules assigned to more than one secondary Domino Directory, the entry l
is added to the directory with the naming rule that most closely matches the entry name. 

If the rule that most closely matches the entry name is assigned to two or more secondary Domino directories, l
the "Rules to follow when this directory is...." LDAP setting for the primary Domino Directory controls where the 
entry goes as follows:

"Rules to follow when this directory is..." setting for 
the LDAP service primary Domino Directory

Where entry is added

Don't modify any Entry not added; error message returned
Modify first match Secondary Domino Directory with the closest matching 

rule and the lowest sort order.
Modify all matches All secondary Domino directories with the closest 

matching rule.

If the entry name doesn't correspond to a naming rule in Directory Assistance, the LDAP service adds the entry l
to the primary Domino Directory. 

For example, suppose the LDAP service primary domain for the Acme organization is DomainA and there are three 
secondary domains, DomainB, DomainC, and DomainD. The Directory Assistance documents for the three secondary 
domains contain the following:

Domain DomainB DomainC DomainD
Search Order 1 2 3
Rules */*/*/DomainB/Acme/*

*/*/*/DomainC/Acme/*
*/*/*/DomainC/Acme/*                              
*/*/West/DomainC/Acme/*

*/*/*/DomainD/Acme*

The following table provides examples of where different entries are added given the Directory Assistance configuration 
described above:

Entry to be added "Rules to follow 
when this directory 
is..." setting

Domain directory in 
which entry is added

Reason

cn=Kate 
Powers,ou=DomainD,o=Acme

N/A DomainD DomainD is the only domain with 
a matching rule.

cn=Sue Wu,ou=West,ou=DomainC,o=Acme N/A DomainC The DomainC rule 
*/*/*/West/DomainC/Acme/* is 
a closer match than the DomainB 
rule */*/*/*/DomainC/Acme/* .

cn=John Ashby,ou=DomainC,o=Acme Modify first match DomainB DomainB and DomainC both have 
rules that match, but since 
"Modify first match" is selected, 
the entry is added to the 
DomainB directory because it has 
the lower search order.

cn=John Ashby,ou=DomainC,o=Acme Modify all matches DomainB and DomainC DomainB and DomainC both have 
rules that match, and since 
"Modify all matches" is selected, 
the entry is added to both 
domain directories.

cn=John Ashby,ou=DomainC,o=Acme Don't modify any None DomainB and DomainC both have 
rules that match, but since "Don't 
modify any" is selected, the entry 
isn't added to either directory.

cn=Phyllis Spera,o=Acme N/A DomainA (primary 
directory)

No secondary directory has a rule 
that matches.
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Server

MIME and international character set conversion options
You can use a Configuration Settings document to set up how MIME and international 
character sets convert on multiple Domino servers. You can indicate that you want all servers 
in the Notes domain to be included by entering a wildcard (*) in the group or server field, or 
you can specify server names or group names that are controlled by this document. By 
checking the "International MIME Settings for this document" field on the Basics tab in the 
Configuration Settings document, it means obey the international MIME settings for the 
servers using this document. If the field is not checked in a configuration document, then the 
International MIME settings for that document will be ignored. This allows your organization 
to set language-specific information for messages depending on the server.

MIME - Basics tab
Domino R5 supports 16 different character set groups (also known as language groups) including Unicode. Some 
language groups (for example, "Japanese") correspond to a single language and some (for example, "Central Europe") 
correspond to a region where the languages use more or less the same characters. Some language groups support 
multiple character sets. 

You can indicate a single primary character set group and multiple secondary character set groups. These choices 
control both inbound (MIME -> Notes CD) and outbound (Notes CD -> MIME) conversions.

For inbound conversion, character set autodetection is required when the incoming MIME or non-MIME message does 
not contain character set information. Domino is able to distinguish with a high degree of (but not perfect) accuracy 
among the various character sets used by "CJKT" languages, that is, Simplified Chinese (used in the People's Republic 
of China), Japanese, Korean, and Traditional Chinese (used in Taiwan). In order to perform this autodetection with the 
best accuracy possible, it is necessary for Domino to know what priority order to assign to the CJKT regions. For 
example, if a message is ambiguously either EUC-KR (a Korean character set) or GB2312 (a Simplified Chinese 
character set), then the priority order of primary and secondary character set groups will be used to determine which 
character set to choose. The priority order chosen is primary, then secondary (in an undefined order -- it does not 
matter in which order you have your multiple secondary choices), then the operating system group (for operating 
systems such as Windows NT where the locale can be queried).

For outbound conversion, Domino chooses a MIME character set based on the text of the message. For some 
messages in some languages (such as Thai), it is usually obvious which character set to choose. For other messages 
(such as some European languages), there is much more overlap in the character sets and it is sometimes difficult to 
guess which MIME character set to use. The primary, secondary, and operating system groups, in that order, are used 
to break ties in determining which character set to use. That means, for example, if a message contains all characters 
that could either be Korean or Japanese, then the primary and secondary groups will be used to determine which 
character set to use.

Note that the client makes additional uses of the primary and secondary settings (configured in the International 
MIME Settings document in the personal Address book of the user), such as determining which character sets appear 
by default in the override Encoding dialogs.

Field Enter

Primary character set group Choose the appropriate language or region -- for example, 
Western -- used by your organization.

Secondary character set groups Choose the appropriate language or region(s) -- for example, 
Western -- used by your organization.
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MIME - Conversion Options - General tab
This tab allows you to indicate whether return receipts can be requested for messages that are going either inbound or 
outbound from the Internet.

Field Enter

Return receipts Enable to allow return receipts for outbound or inbound SMTP 
messages. For inbound messages, it supports both disposition 
notifications and return receipts. 
(default = Disabled)

MIME - Conversion Options - Inbound tab
The fields on this tab control how inbound messages are converted.

Field Enter

Line length The maximum line length for the body of inbound messages, 
useful when a message contains long lines of text without 
spaces -- for example, URLs. 
(default = 75)

Use character set auto-detection if 
message has no character set 
information

Yes to determine the character set used in the body by 
examining the content; useful if your site routinely receives 
non-MIME messages that are encoded in character sets other 
than ASCII. Provides the best fidelity, but costs in 
performance. 
(default = No)

MIME - Conversion Options - Outbound tab
The fields on this tab control how outbound SMTP messages are converted.

Field Select

Attachment encoding method The method for encoding file attachments included with 
outbound SMTP mail. 
Choose one: 
- Base64 (default)
- Quoted Printable
- UUencode

Message Content Determines how the message will be converted. Choose one:
- Convert from Notes to Internet message format (default)
- Create multi-part alternative including conversion and 
encapsulation. This provides true fidelity of the note and 
encapsulation. 

Covert tabs to spaces Enable to change tabs within text to spaces. 
(default = No)

Outbound line length The maximum line length for the body of outbound messages, 
useful when a message contains long lines of text without 
spaces -- for example, URLs. 
If there is a table or forwarded mail headers, then the line 
length default is doubled so no line break occurs until 150. 
(default = 75)

Lookup Internet address for all 
Notes addresses when Internet 
address is not defined in 
document

Enable to lookup the Internet address in the Person document 
, if not provided in the Send To field. 
Disable (default) to form an Internet address by converting 
spaces into underscores and encoding Notes domains with 
percent signs. 
For example: John_Smith%Notes@acme.com
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MIME - Settings by Character Set Groups tab
These fields allow you to override default values for character sets, fonts, and so on, for individual character set 
groups.

Field Enter

For outbound messages options 
below use all possible choices

Check this box to indicate that all character sets are available 
during configuration of the headers and body character sets. 
This is an advanced option that allows you to configure 
non-standard character set choices for various languages.

MIME settings by character set 
group

This list allows you to choose among the different groups for 
configuration.   It does not matter which value you leave this 
on when you save the document, it is just used for switching 
among "tabs".

MIME - Settings by Character Set Groups tab
Inbound Message Options - Font Options section

Field Enter

HTML Proportional The typeface style to be used for proportional type in inbound 
SMTP messages. 
(default = Default Serif)

HTML Mono-spaced The typeface to be used for mono-spaced type in inbound 
SMTP messages. 
(default = Default Mono-space)

HTML Size The point size to use for HTML text in inbound SMTP 
messages. 
(default = 12)

Plain text The typeface to be used for plain text in inbound SMTP 
messages. 
(default = Default Mono-space)

Plain text size: The point size to use for plain text in inbound SMTP messages. 
(default = 10)

MIME - Settings by Character Set Groups tab
Outbound Message Options section
Enter the character set and encoding type for the header and body text of a message. This does not affect 
attachments. For each language (or region) there is a default character set. For example, for Western Europe the 
default character set is ISO-8859-1, but other Latin character sets would also be appropriate. You can indicate the 
specific character set and encoding to be used for outbound SMTP message headers and body content. In general, it 
is correct to use the same character set for both the headers and the body of outbound messages. The exception is 
Korean, where the headers and body are typically sent using different character sets.  The default values reflect this.

The following matrix shows supported combinations of Message Content versus Attachment Encoding:

Message Content Options Base 64 Quoted Printable UUencode

Users without Lotus Notes [MIME] Yes Yes Yes

Users with & without Lotus Notes (not a 
recommended option)

Yes No No
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Note: You must be a system administrator with editor access to the Administration Client to see the value choices.

Field Choose

Header Character Set The character set.
(default = character set defined in the MIME settings by 
character set group field.)

Body Character Set The character set. 
(default = character set defined in the MIME settings by 
character set group field.)

Header Encoding The encoding method for outbound headers. Choose one:
- Base 64
- Quoted Printable
- None 
The default value is based on the chosen character set.

Body Encoding The encoding method for outbound body text. 

MIME - Advanced - Advanced Inbound Message Options tab

Field Enter

Resent headers take precedence over 
original headers

Enable to use RFC822 re-sent headers instead of 
normal headers. 
(default = Disabled)

Remove group names from headers Enable to remove all group names from address 
headers. 
(default = No)

If each recipient's address does not appear 
in any address header, then add their 
address to the BCClist

Enable resolve differences between the address in the 
envelope and the address in the header. Any 
non-RFC822 compliant address is placed in the BCC: 
header field of a separate copy of the message. 
(default = No)

For non-MIME messages or MIME messages 
with an unknown character set, 8-bit 
character set is assumed to be

Choose the character set to be used as the default if 
the "Use character set auto-detection if message has 
no character set information" field is disabled or fails 
to identify the character set.

Character set name aliases Enter the substitute name for the equivalent character 
set to allow MIME to be converted to native MIME. An 
alias allows a character set name tag in an inbound 
message to be treated as though it were a different 
character set.  For example, mapping "ISO-8859-1" to 
"KOI8-R" would be useful in an environment where 
incoming messages are frequently labeled as 
ISO-8859-1 (Western) when the data is really KOI8-R 
(Cyrillic).

MIME - Advanced - Advanced Outbound Message Options tab

Macintosh file attachment support

Sending and receiving Macintosh attachments presents a unique set of problems. Conventional operating systems 
store a file as an unstructured stream of bytes, along with a small amount of descriptive information such as the file 
name, creation date, and so forth. The Macintosh operating system (MacOS) carries more information, and stores a 
file in three parts:

Finder information: This includes the file creator and type, which are 32-bit binary identifiers (often represented 1.
as 4-character strings), as well as the position of the file icon in the Finder window it lives in.
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Resource fork: Structured information that can be manipulated by standard system tools; this can include strings, 2.
sounds, pictures, code segments, icons, GUI elements, and so forth.

Data fork: An unstructured byte stream.3.

When Macintosh users exchange attachments, they want all this information to be preserved. If only the data fork is 
preserved, then the attachment will not have the correct icon, cannot be launched, and may be completely useless.

RFC1740 vs. BinHex
The traditional way Macintosh users have coped with this problem is to encode Macintosh files using an encoding 
called BinHex. This encodes all three parts of a Macintosh file in a single text file using a subset of the ASCII character 
set. BinHex-encoded Macintosh files can be safely mailed or stored on non-Macintosh systems, and when decoded on 
a Macintosh the resulting file is intact.

BinHex is fine for Macintosh-to-Macintosh use, but often a Macintosh user wants to send a file containing valid 
cross-platform data -- for example, a JPEG image, a QuickTime video, or a Lotus 1-2-3 spreadsheet -- to a colleague 
who is using a PC. BinHex isn't as suitable for this case. Although there are freely available utilities for PCs that let 
them decode BinHex attachments, using such a utility entails an extra manual step (not to mention the trouble of 
obtaining and installing the utility in the first place). Because of this, the Internet community defined a standard, 
called RFC1740, for mailing Macintosh attachments that preserves maximum fidelity for Macintosh users and yet 
permits cross-platform data to be received in a useful form by non-Macintosh users. In most cases, RFC1740 
encoding is used to send Macintosh file attachments.

MIME encoding for Macintosh attachments outbound (Notes to Internet)
Standard RFC1740 encoding occurs for outbound MIME processing and when the "Outbound Macintosh attachment 
conversion" field is set to "AppleDouble (base64 only)". If the attachment contains a resource fork, the Notes format to 
MIME converter always sends the resource fork, followed by the data fork. The MIME-to-Notes format converter 
handles the forks in either order. If the attachment does not contain a resource fork, the data fork is sent "normally" 
(as a standard MIME type if it can be recognized as such).

If the message is sent outbound as MIME and "Outbound Macintosh attachment conversion" is set to "BinHex", and it 
goes through a Notes format to MIME conversion, then the attachment is sent as application/mac-binhex40.

In all cases, the attachment is accompanied by the MIME "x-mac-type" and "x-mac-creator" parameters so that even if 
there is no "application/applefile" part, the receiving user agent can store the attachment with the correct type and 
creator, allowing the attachment to be launched properly.

Inbound (Internet to Notes)
Inbound, AppleSingle, AppleDouble, and BinHex are supported. Macintosh attachments of any encoding are stored as 
normal Notes Macintosh attachments; if the data fork would be meaningful to a PC user, then a PC Notes user can 
launch the attachment normally.

In these examples, unless noted otherwise, when it is said that an attachment can be detached and launched 
normally, or can be launched from within Notes, it is assumed that the user has the application needed to open the 
attachment properly installed on his or her system. Also, it is assumed that MIME-compliant user agents are used.

A Macintosh Netscape user sends a JPEGview file containing a JPEG image (with no resource fork, which would be 1.
the normal case) to two recipients: both are Notes users, one uses a Macintosh and one uses a PC.

Both users receive the attachment intact. If the Macintosh user has JPEGview, the attachment displays with the 
JPEGview file icon, and can be launched from within Notes. If the Macintosh user does not have JPEGview, the 
attachment displays with a generic file icon and cannot be launched from within Notes. For the PC user it also 
has a generic icon; it can be launched from within Notes only if its name ends in .JPG and the user has an 
application association set up for the .JPG extension. In all cases, the image can be viewed from within Notes by 
using the "Attachment - View" function.

 A Macintosh Claris Emailer user sends a 1-2-3 spreadsheet to two Notes users; one who uses a Macintosh and 2.
one who uses a PC.

Both recipients receive an intact 1-2-3 spreadsheet attachment. The Macintosh recipient can launch it from within 
Notes, or can detach it and double-click to launch -- regardless of the name given to the attachment.

The PC user can launch it from within Notes, or detach it and double-click to launch, only if the filename ends in 
.WK1, WK3, .123, or some other extension associated with the Lotus 1-2-3 application. (This is a restriction of 
Windows and has nothing to do with Notes.)
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 A PC Notes user sends a 1-2-3 spreadsheet to a Macintosh Claris Emailer user.3.

The PC user would have to save the spreadsheet as a 1-2-3 R1 spreadsheet, since it is the most recent version of 
1-2-3 available on the Macintosh. This is encoded with the MIME type "X-Lotus-123R1", a private MIME type 
defined by Lotus. Since this is a private MIME type, normally Claris Emailer would not understand it, so the 
attachment would contain correct data but could not be directly launched. It could be opened manually by first 
launching 1-2-3 and using the File - Open command.

As an alternative, Claris Emailer uses the file mapping table maintained by Internet Config (a widely used free 
software utility) to look up MIME types and map them to Macintosh file type and creator codes. It's easy to use 
Internet Config to add a mapping for the "X-Lotus-123R1" type. If this is done first, then the attachment in this 
example can be directly launched on the Macintosh.

Field Enter

Macintosh attachment conversion The format for Macintosh attachments. Choose one:
- AppleDouble [Base64 only] (default)
- BinHex4.0

RFC822 phrase handling The way that phrases are handled within an address header. 
Choose one :
- Do not add phrase (default)
- Use DN as phrase (Use domain name for the phrase)
- Use alt. name if available - otherwise DN (Use the alternative 
name or domain name)
- Remove phrase

Internet mail server sends Notes 
private items in messages

Enable to send non-standard Internet items to IMAP or POP3 
clients. This allows all Notes header items that are not in 
RFC822. 
(default = Disabled)

Notes fields to be removed from 
headers

List of Notes item names that are not be included in outbound 
Internet messages if you have enabled Notes private items to 
appear in messages (see previous field).

When converting a multilingual 
message

The character set that is chosen for a message containing 
more than one language group, where some character sets 
may not include all the characters of the other. Choose one:
- Send it in Unicode [UTF8]
- Send it in most representable character set

Character set name aliases Enter a non-standard character set name to be used for 
outbound messages. For example, you can send messages 
sent in ISO-8859-1 with the tag "My-Character-Set".  It is not 
recommended that you providing aliases here because your 
outgoing message will only be understood by similarly 
configured mail clients.

Server

FTG_INDEX_LIMIT
Domino uses a default maximum size of 6 MB for full-text index files (and 1MB for the Mac). 
If you have a database with large attachments that you want to full-text index, you can 
increase the default size using the NOTES.INI variable FTG_INDEX_LIMIT = xxx, where xxx is 
the number (in bytes) that you want to use as the maximum size. For example, to increase 
the default size to 7,000,000 bytes, add a variable of FTG_INDEX_LIMIT=7000000 to the 
NOTES.INI and restart the server.
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Server

Settings for troubleshooting HTTP/SSL
There are two new NOTES.INI settings that allow administrators to troubleshoot HTTP connections using SSL.

ReportSSLHandshakeErrors=1

Reports HTTP SSL handshake errors to the console and LOG.NSF. You may want to set this by default, since it only 
reports errors

TraceSSLHandshake=1 

This allows you to follow the handshake details on the console and in LOG.NSF to better pinpoint errors.

Administrator Client, Server

Do not use NOTES.INI variable Config_DB
This Release Note is a correction to the Domino Administrator Help documentation. The NOTES.INI setting Config_DB, 
which was used in pre-R5 versions of Domino to reset the path of the Statistics and Events database (EVENTS4.NSF), 
is not supported in R5 versions. Use the Report_DB setting instead:

Syntax:  Report_DB=path
Description:  Specifies the location of the Monitoring Configuration database (EVENTS4.NSF) if you want to 
designate a path other than the default.
Applies to:  Servers
Default:  EVENTS4.NSF
UI equivalent:  None

Server

Using Web client certificates with Domino for IIS
Domino for IIS supports using client certificates alone or in combination with any of the other 
authentication options. In all cases we rely on IIS to verify the certificate signer. The 
certificates do not have to be stored in the Domino Directory since Domino for IIS uses the 
common name from the certificate sent from IIS. No configuration of Domino is necessary 
other than enabling client certificates on the SSL port.

Here is a step-of-step description of how authentication works with client certificates:

The user opens an SSL connection to IIS and presents a client certificate.1.

IIS verifies the certificate signer.2.

On every Domino request made during the SSL session, IIS passes the client certificate to Domino. IIS will also 3.
pass a user name with the request if any of the following conditions is true:

Client certificate mapping is enabled in IIS. In this case, the user name is the mapped NT account name.l

Certificate mapping is not enabled, but Basic Authentication is enabled in IIS and the browser has sent a l
basic authorization header. In this case, the user name is the name entered by the user into the browser.

Certificate mapping is not enabled, but NTLM is enabled in IIS. In this case, the user name is the user's NT l
account name.

Domino does a lookup of the certificate common name in the Domino directory. If the lookup succeeds, Domino 4.
maps the user to the distinguished name specified in the directory. Domino uses the distinguished name for ACL 
checking. Domino also sets the CGI variable REMOTE_USER to the distinguished name.

If Domino does not find the certificate common name in the directory, but IIS also passed a user name with the 5.
request, then Domino does a lookup of the user name in the directory. If that lookup succeeds, Domino maps the 
user to the distinguished name as described above. If the lookup fails, then Domino returns a 401 error.

If Domino does not find the certificate common name in the directory, and IIS did not send a user name with the 6.
request, then Domino authenticates the user as Anonymous, if Anonymous is enabled for the SSL port. If it is not 
enabled then Domino returns a 401 error.
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Client Certificate Scenarios & SSL tips
Scenario 1: How do I use my existing IIS client certificates mapped to NT User Accounts with 
Domino/IIS? 

This scenario represents an existing MS IIS configuration with SSL, including client 
certificates already in use and mapped to NT accounts.  All users requiring access to 
protected Domino databases that are defined by an existing NT user account mapped with a 
client certificate need a corresponding Person document in the Domino Directory. Domino 
needs to authenticate the user by verifying the name in the user name field of the Person 
document. The user name field must either include the certificate's common name or NT 
account name as an alias, and then be mapped to a Domino Distinguished Name.

The first example below demonstrates the common name on the user certificate mapped to a 
Domino Distinguished Name.  The second example below demonstrates the NT account name 
mapped to the Domino Distinguished Name. The ACL setting on the database only authorizes 
the first entry in the user name field. In this scenario, IIS validates the client certificate, and if 
it exists in the Domino directory it would not be used. The SSL port settings in Domino are 
honored and are enabled by default for anonymous, basic and client certificate 
authentication.

Joe Smith/CorpSales
Joe Smith
.....any other aliases

or

Joe Smith/CorpSales
SALES\JSmith
......any other aliases

Scenario 2: How do I use my existing Domino client certificates currently registered in 
Domino and continue to register new users?

When using Domino for IIS, IIS handles the actual SSL connection. If you currently use SSL 
and have a Domino Server Key Ring configured, it is not used and you need to create one for 
IIS. All users registered in the Domino Directory with a client certificate continue to use their 
existing client certificates for database authorization to protected Domino databases. To 
achieve this, IIS's Directory Security must be enabled for Anonymous access and set to 
Accept Client Certificates. Users with client certificates must be able to authenticate with the 
IIS server "Anonymously" and also send the client certificate following the request from IIS. 
Domino must also have client certificate authentication enabled in the Server document.  
Registering new client certificates may continue, using the Domino CA Application, after 
creating Person documents in the Domino Directory. The user name field for this scenario 
may be the same as scenario 1. If the user has an NT Account, this may also be used as an 
alias.

Benefits for implementing this option:

Users can access Domino servers elsewhere (without IIS) to take advantage of features such as Domino l
clustering

Circumvents the IIS certificate authentication l

Do not have to create NT user names for the certificatesl
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Server

Configuring partitioned servers and virtual Web servers
The books for Administering the Domino System describe how to set up partitioned servers in Chapter 9 and also how to 
set up virtual Web servers in Chapter 23, but not as a combined configuration. One essential step for binding the IP 
address of each virtual server to each partitioned server's HTTP process in the server document is not mentioned. 
Here are the steps:

Setting up the partitioned servers using separate TCP/IP addresses

See Chapter 9, "Assigning separate IP addresses to partitioned servers using the NOTES.INI variable" 1.

TCPIP_TcpIpAddress=0,ipaddress

To bind port 80 to each partitioned server's HTTP process, as described on the top of page 164, enable Bind to 2.
host name in the server document (Internet Protocols tab -> HTTP tab) for each server and also add the host 
name, full DNS name or IP address for each server in the host name field.

Using a browser, verify that each partitioned server can respond to requests on Port 80, after restarting your 3.
server.

Setting up virtual web servers for each partitioned server

See Chapter 23 - Hosting multiple Web sites to configure a virtual server document for each partitioned server in 1.
the Directory.  

To assign a specific partitioned server one or many virtual servers you must include the IP address(es) of each virtual 
server (can also use host name or DNS name) in the host name field of the server document separated by semicolons 
(If you separate them by commas, it will be saved with semicolons.) See the example below:

ServerA is the partitioned server and 9.88.43.113 & 9.88.46.110 are both virtual web servers. (Note: you can have up 
to 32 entries in this field)

Basics

Host name(s): ServerA;9.88.43.113;9.88.46.110
Bind to host name: Enabled
DNS lookup: Disabled
Default home page: default.htm
Allow HTTP clients to 
browse databases:

Yes No

Restart HTTP and you should now be able to send HTTP requests to the partitioned servers and all of the virtual 
servers for each partition.

Administrator Client, Server

Compact Options correction
The compact options -U and -u were incorrectly documented.  Select "Set advanced properties" before you enable or 
disable either of these properties.

Option Command-line 
equivalent

Description

Don't maintain unread marks: Off -u Disables "Don't maintain unread marks" database 
property; in other words, this option maintains 
unread marks.

Don't maintain unread marks: On -U Enables "Don't maintain unread marks" database 
property; in other words, this option does not 
maintain unread marks.
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Administrator Client, Server

Generating a mail usage report
The "Generating a mail usage report" topic in the Domino Administrator R5 online help contains incorrect information. 
The "Report results should be" field in Step 4 is corrected to indicate that reports are saved by default. 

 4. Complete these fields, and then click OK:

Field Enter

Report Type Choose the type of report you want to create.

Description Text to identify the report.

Time Range Choose one:

Todayl
Yesterdayl
Over the last week (default)l
Over the last two weeksl
Over the last monthl
All available informationl

Note  Each choice refers to the specified time period up to the current day. For 
example, if you choose "Yesterday," the report includes information from yesterday 
and today.

Execution Interval Choose one:

Once to generate a report immediately (default)l
Daily to generate a report at midnight every dayl
Weekly to generate a report at midnight on Saturdaysl
Monthly to generate a report on midnight on the first day of every monthl

Reports results should 
be

Choose one:

Saved (default)l
Mailed l
Saved & Mailedl

Mail Recipient If you chose Mailed or Saved & Mailed in the "Report results should be" field, enter 
the user name of the person who should receive the report or select the user name 
from the Domino Directory. The default is the name of the administrator running 
the report.

Administrator Client, Server

Push command - Documentation correction
The "Domino Server Commands" topic in the Domino Administrator R5 online help contains incorrect information on 
the Push command and the Quit command. The correct information is as follows:

Push Forces a one-way replication from your server to specified server.

Quit Stops the server. This command is identical to the Exit server command.

240



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 4 - Documentation updates

Administrator Client, Server

Quit command
The Domino Administrator online help contains incorrect information on the Quit command. There are two corrections 
to the documentation for the Quit command.

First correction
The information in the Server Commands appendix, Quit command, located in the Tip following the last paragraph.
The correct information is as follows:
Tip  You can also stop the server from the Domino Administrator. From the Domino Administrator, click the Server - 
Status tab. From the tool bar, click Servers - Shutdown.

Second correction

The "Domino Server Commands" topic in the Domino Administrator R5 online help contains incorrect information on 
the Quit  command. The correct information is as follows:

Quit Stops the server. This command is identical to the Exit server command.

Administrator Client, Server

Rename Group - Correction to documentation
The information in the Domino Administrator online help and printed documentation is not correct for the Rename 
Group administration request.  The first paragraph of the Rename Group topic in the Administration Requests 
appendix should read as follows:

Rename Group

You can rename a group using the Administration Process by performing a Rename Group action from the Domino 
Administrator. The following flowchart shows the sequence of Administration Process requests that occur when you do 
this. (Boxes indicate requests). The timing shown for each request is the default, which you can customize through the 
Server Tasks - Administration Process tab on the Server document.

Administrator Client, Server

SMTP outbound mail
The Domino Administrator R5 documentation contains incorrect information in the topic  "Specifying how the Router 
picks the recipient's SMTP server for outbound mail." 

Step 6 of the procedure  "To set how host names are looked up" should read as follows:

6. On the Basics tab, complete this field, and then save the document:

Field Enter

Host name lookup Choose one:

Dynamic lookup only (DNS only) - The Router determines the IP address for a host l
by looking it up in DNS. SMTP transfer can occur only if the destination host is 
listed in DNS.
Local lookup only (host files only) - The Router determines the IP address for a host l
by looking it up in a hosts file on the local machine.
Dynamic then local - (default) The Router determines the IP address for a host by l
looking it up in DNS first and then checking the local hosts file if no DNS entry 
exists.

Administrator Client

UNIX - Do not use Server_Max_Concurrent_Trans=-1
This release note is an update to the Domino help documentation for improving UNIX server performance. Do not use 
the NOTES.INI setting Server_Max_Concurrent_Trans=-1 to improve Domino server performance on UNIX systems.
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Administering Domino clusters

Server

Generating URLs that refer to the Internet Cluster Manager (ICM)
The following sentence is not accurate in all instances:

"If the page that a Web server displays to a client includes links to other databases on the same server or to other 
databases in the cluster, the Web server includes the host name of the ICM in the URLs to those databases."

The Web server includes references to the ICM in the following instances only:

When generating URLs to databases on the same server as the original databasel

When generating URLs to databases on different servers if there are replicas of those databases on the server that l
contains the original database

For other cases, you can use the Redirect URL command to create links to other servers, although this is less dynamic 
than the method using the ICM. For information about the Redirect URL command, see the topic "Finding links with 
the Redirect URL command" in Chapter 23 of Administering the Domino System or in Administration Help.

Server

Using a cluster name for replication and passthru
When you use a cluster name in a Connection document to replicate with all the servers in a cluster, use only l
Pull-Push, Pull Only, and Push Only as the replication type. Pull-Pull does not work with a cluster name.

When you connect to a cluster of passthru servers, use the name of one of the passthru servers, rather than the l
cluster name, to specify the passthru server in Location documents and Passthru Connection documents. If you 
use the cluster name instead of a server name, failover is not available.

Administering the Domino system

Server

Domain Search and the Summarizer - additional information
In Release 5.0.3 Lotus released the Inxight Summarizer on the NT platform. The Summarizer is enabled, and the new 
search engine enabled as well, when the following notes.ini server variable is set:  FT_LIBNAME=ftgtr34.

There is a topic entitled "Domain Search Security" in Chapter 7 of the Help book Administering the Domino System which 
indicates a search can, under certain circumstances, return results to a user who cannot access the results document. 
If summarization is enabled, this problem is exacerbated because the result of a search will now include several key 
sentences from the document when detailed results are requested. If this occurs, you may wish to disable the 
Summarizer by setting the server notes.ini variable to FTG_No_Summary=1.

There are other new notes.ini variables and settings which affect the behavior of domain search and the Summarizer.

In R5.03 Lotus added a notes.ini variable that allows users and administrators to select the location and name of the 
Domain Index. By default this is located beneath the Domino Data Directory and has the Name FTDOMAIN.DI.  By 
adding the setting FT_DOMAIN_DIRECTORY_NAME = directory  to the notes.ini file, Domino will support 
directory links and Index relocation.  FT_INDEX_ATTACHMENTS=2 will override any setting in a Notes database or 
the domain indexer and also turn off attachment indexing. (FT_INDEX_ATTACHMENTS=1 is an unconditional 
command to index all attachments.)

There is another new notes.ini variable, FT_SUMM_DEFAULT_LANGUAGE. If it is set to "default" or if it is not set at 
all, the native language from the locale is used as the default language. If it is set to the NULL string, "english" is used 
as the default language. Finally, it can be set to any language like "Dutch." Whenever the Summarizer assigns a 
language to a document, and the Summarizer is unable to summarize in that language, the Summarizer will try to 
summarize using the default language instead. Please note that if the native language is one which is not yet 
supported, like Japanese, the FT_SUMM_DEFAULT_LANGUAGE should be set to NULL or English.

Whenever the Summarizer cannot summarize a document because it is too short, or the Summarizer cannot 
summarize a document because it cannot summarize in the language specified, no error message and no summary 
will be produced.
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Server

Fault Recovery
Fault Recovery is a feature of Domino which enables a server that has crashed to shut itself down and then restart 
automatically, without any administrator intervention. When Domino encounters a situation which is considered a fatal 
error, each Domino process is terminated and all associated resources are freed. The startup script 
(/opt/lotus/bin/server) detects the situation and restarts the server.

When Fault Recovery is enabled, the server password, if any, is securely stored in the system kernel memory area 
where it can be retrieved by a restarting server.

Fault Recovery supports Domino partitions. When a situation arises in a partition, only that partition is terminated and 
restarted. Other Domino partitions on the server are unaffected.

An optional program can be executed by the Fault Recovery system before any other cleanup takes place by using the 
CleanupScriptPath notes.ini variable. For example, to automatically invoke nsd add the following line to notes.ini:

CleanupScriptPath=/opt/lotus/bin/nsd

(NOTE: The cleanup script feature is available even if Fault Recovery is disabled)

To enable Fault Recovery, add the following line to NOTES.INI:

FaultRecovery=1

Fault Recovery is currently available only on Domino for UNIX platforms.

If you are using the Fault Recovery feature on Solaris 2.6 or greater, you must add the following line to /etc/system 
and reboot:

set msgsys:msginfo_msgtql=1024

This needs to be set on Solaris because Fault Recovery uses message queues. The default for Solaris is 40 messages 
per queue, and Fault Recovery requires more than 40 messages in this queue. This setting increases it from 40 to 
1024.

Administrator Client, Server

Sign Database with Server's ID File - New admin request
A new administration request, Sign database with server's ID file, is available beginning with release 5.0.6.  Use this 
administration request to sign all database elements for a selected database with the server's ID.

From the Domino Administrator, click the Files tab.1.

Select the database you want to sign.2.

From the tools panel, choose Database -> Sign.3.

On the Sign Database dialog box, click Active Server's ID. By default, All design documents is selected. NOTE: 4.
You have the option of choosing "Update existing signatures only" which is the fastest method of signing with a 
server's ID file. 

Click OK.5.

Administrator Client, Server

New client level settings on Server Configuration document
Starting with Lotus Domino release 5.0.11, the Server Configuration document contains two new fields: "Minimum 
client Level" and "Maximum client Level" that can be used to specify the minimum and maximum version of client code 
that can access the server. 
Domino release 5.0.11 is the first level of code that you can reliably set as a "Minimum client Level" or a "Maximum 
client level."  If you designate a client level prior to 5.0.11 as a minimum or maximum level, all Domino R5.0.x clients 
can access the server because the server cannot distinguish releases prior to Domino R5.0.11 for minimum or 
maximum client levels.
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The following formats are acceptable when entering client levels:

Format Example
#.# 6.0
#.#(a-z) 6.0a
#.#.# 6.0.1
#.#.#(a-z) 6.0.1a
#.#.## 5.0.11
#.#.##(a-z) 5.0.11a

Administrator Client

Server document - Server access fields only affect Notes clients
The "Allow access" and "Not allow access" fields on the Security tab of the Server document only affect Notes clients. 
They can not be used to control server access for browser clients.

Administrator Client, Server

Domino Network File Store supported in Domino R5.0.5 and forward
Lotus Domino Release 5.0.5, and subsequent post R5 releases, support Domino Network File Store (DNFS). 

Administrator Client, Server

Group names can consist of all digits
The Domino R5 Administrator documentation incorrectly states that group names can not consist entirely of digits. 
That is incorrect.  Group names can consist entirely of digits.

Administrator Client, Server

LDAPAddress NOTES.INI variable ignored
In Domino 5.0.1a and subsequent releases, the LDAPAddress NOTES.INI variable is ignored. 

For Domino R5 servers and later, bind a Notes TCP port to a specific address, and then have the LDAP service use the 
Notes port. To bind the Notes port, use the NOTES.INI variable <NotesTcpPortName>_TcpIpAddress= . For example,  
<NotesTcpPortName>_TcpIpAddress=0,IPaddress:1352.  The port number 1352 is optional but refers to the 
Notes/Domino TCP Port number.

Designate to the LDAP server, the Notes TCP port name to use by adding this NOTES.INI variable:
<InternetServer>NotesPort=<NotesTcpPortName>.  In this case, the InternetServer is LDAP.

Administrator Client, Server

Mail_Log_To_MiscEvents NOTES.INI variable -- correction
The Lotus Domino R5, Domino Administrator 5 online help for the NOTES.INI variable Mail_Log_To_MiscEvents 
requires correction.  The "Description" section for this NOTES.INI variable has been corrected and is shown below.

Syntax:  Mail_Log_To_MiscEvents=value

Description:  Determines whether all mail event messages are displayed in the Miscellaneous Events view of the log file:

0 - The router determines whether to log messages to the Mail Events view, the Miscellaneous Events view, or to both views. 
This is also true if this variable is not defined.

1 - The router ensures that all messages are logged to the Miscellaneous Events view. If a message is typically logged only to 
the Mail Events view, it wold now be logged to both the Miscellaneous Events view and the Mail Events view. 

Note: To prevent logging to the Mail Events view, the NOTES.INI variable MailLogToEventsOnly can be set to a value of 1. 
There is no NOTES.INI setting to prevent logging to the Miscellaneous Events view.

Applies to:  Servers and workstations

Default:  None, although if this setting is omitted, mail events are not displayed in the Miscellaneous Events view.

UI equivalent:  None
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Administrator Client, Server

Restricting name lookups to primary directory
The Lotus Domino 6, Administering the Domino System printed documentation, and the corresponding online help, 
require correction. Step 7 in the topic "Setting advanced transfer and delivery controls" has been corrected. The 
revised text is in the field "Restrict name lookups to primary directory only." The corrected information is:

Restrict name lookups to 
primary directory only

Choose one:

Enabled -The router can only look up names and groups in the Domino Directory for the l
server's Domino domain. The router cannot look up names and groups in other directories 
that are available through Directory Assistance or Directory Catalog.
Disabled - (default) The router can look up names and groups in any directories available l
from the server.

Administrator Client, Server

Using multiple Internet domain names
The Domino R5 Administrator documentation contains the topic "Using multiple Internet domain names within one 
organization."  The procedure "To use multiple Internet domain names" is part of that topic and requires correction.

A new Step 5 has been added, and the previous Step 5 is now Step 6.  Step 7 has also been added.

To use multiple Internet domain names

  1. Make sure you already have a Configuration Settings document for the server(s) to be configured.

  2. From the Domino Administrator, click the Configuration tab and then expand the Messaging section.

  3. Choose Domains, and then click Add Domain.

  4. On the Basics tab, complete these fields:

Field Enter

Domain type Choose Global Domain

Global domain name A word or phrase that describes the domain

Global domain role Choose R5 Internet Domain or R4.x SMTP MTA 

  5.      Click the Restrictions tab and complete this field:

Field Enter

Domino domains and aliases The Domino domain name and aliases. Domino uses the dmain name and 
aliases when accepting mail from the alternate domains listed in the Global 
Domain document.

6. Click the Conversions tab, complete these fields, and then save the document:

Field Enter

Local primary Internet domain The primary Internet domain name that your company uses to represent 
themselves to the outside world -- for example, ACME.COM

Alternate Internet domain aliases Additional Internet domain names that your company uses -- for example, 
ANOTHER.COM, and so on

These fields represent the only ones you must complete if you are using the Global Domain document solely for the purpose 
of defining the internal Internet domains in an organization running Domino Release 5 and greater.

  7. Restart the server to put the changes into effect. The server reloads information in the Global Domain document into 
memory only after a restart.
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DECS Documentation

Administrator Client, Client, Designer, Server

DECS 5.0.10 Release Notes
These are the Release Notes for DECS functionality included with Release 5.0.10 Notes/Domino product shipments. 

Domino Enterprise Connection Services (DECS) is a visual tool and high-performance server environment you can use 
to create Web applications that provide live, native access to enterprise data and applications. The visual tool includes 
an application wizard and online Help to assist you to define external data source connections -- for example, DB2, 
Oracle, Sybase, File directory, EDA/SQL, or ODBC -- and fields within your application that automatically update with 
external connector data. For more information on connecting to legacy databases, see the Domino Enterprise 
Connection Services User's Guide. (DECSDOC.NSF) in your Notes or Domino data directory. For information about the 
Lotus connectors that are available in DECS, see www.Lotus.com/ei.

These notes include:

Overview of this releasel

System requirementsl

Operational considerations and known limitations with this releasel

Reporting feedback and software problem reports l

Overview of this release
Important information from previous releases that is being retained in this Release Note are as follows:

Oracle Runtime library
If you have trouble loading the Oracle Runtime library due to unresolved symbols, you may need to re-link the 
oraclntsh.so library WITHOUT the sorapt.o file.  In the Oracle installation script $ORACLE_HOME/bin/genclntsh, 
comment out the following command at line 148:
      ar d $LIBCOMMON sorapt.o 
and run genclntsh to re-create the library.

Subfield Key Ordering
In the Activity document Options section, Multivalue data  subfield keys can now be ordered by the user.

Domain Search and DocLinks
Domino, post R5, introduced a change to its Extension Manager interface which adversely effected the behavior of 
DECS. DECS has been updated to restore support for RealTime event handling triggered by Domain Searches, 
DocLinks, Notes replication, @Formulas, and LotusScript written with the NotesDocument class.

System Requirements
A complete matrix of enterprise systems and versions certified and supported for each Domino OS platform may be 
found at www.lotus.com/dominoei

Operational Considerations and Limitations
Be aware that for DECS to browse the server, on Domino 5.x, the Name and Address Book server document for l
the DECS server must have the "Only allow server access to users listed in this directory" option set to NO.

When using multi-value data fields, do not designate a "Character Set" when you select  the "Sorting - Text order - l
Binary" option.  The "Character Set" field must be blanked out to prevent an error.

Reporting product feedback, comments and software report problems
This software product will be supported via Lotus Support. You can request enhancements to this product in the 
customer forum on the Lotus enterprise integration web site: www.lotus.com/dominoei.
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Administrator Client, Server

Additional DECS Guide Availability
The following Domino Enterprise Connection Services (DECS) guides are available from the Lotus Developer Domain 
(LDD) at http://www.lotus.com/ldd.

Book Title Pre-Domino 6 filename Domino 6 filename
Domino Connection Services (DECS) 
Installation and User Guide

Note: Pre-Domino 6 title is DECS User 
Guide

decsdoc.nsf decsdoc6.nsf 

Lotus Connectors and Connectivity Guide lccon.nsf lccon6.nsf

Lotus Connector LotusScript Extensions 
Guide

lsxlc.nsf lsxlc6.nsf 

DOLS Documentation

Administrator Client

Error in topic "Preparing the CD for offline users"
Step 4 reads: 

4. If the subscription has a directory catalog, create a Directory Catalog folder under \Content\Subscriptions\<replica 
id> and add a replica of the catalog .nsf. For example: 

\Content\Subscriptions\72638271927F46D8\Directory Catalog\nameofcatalog.nsf

Issue: "Directory Catalog" should be one word: "DirectoryCatalog"

iNotes Access for Outlook

Administrator Client, Client

Instructions for using Delegation (Managed Calendar) with iNotes
Beginning with Release 5.0.6, iNotes users can now manage their own mail file delegation. Previously, Administrator 
intervention was required.

Here are the instructions for using Delegation (sometimes called Managed Calendar) with iNotes Access for MS 
Outlook:

Set the Mail Delegation tab
NOTE: In order for an Outlook user to use the Mail Delegation tab, they must have one of the following conditions: 

They must be listed in the ACL of their mail file as "Manager".  l
They must be listed in the ACL of their mail as "Designer" or "Editor" and the "This mail file belongs to:" field l
located in the "Mail Preferences"/"Basics" tab must contain their hierarchical name.

("Manager" access makes changes directly to ACL. "Designer"/"Editor" sends a request to AdminP to carry out.)

Right-click on the Outlook icon on your desktop.1.

Select "Properties" from the menu.2.

In the "Local Mail" Properties" dialog select "Properties".  If prompted, type your password.3.

In the "iNotes Access for Microsoft Outlook Properties" dialog click on the "Mail Delegation" tab.4.

From the list, select the user to whom you are giving access to your mail file, and click "OK."5.

Once this is done the user can create a new Profile to open your mail file.
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Create a new Profile
(In order to create a profile to access someone else's mail file the user must first be added the ACL of that owner's 
mail file via mail delegation in previous steps.)

Download your own mail file from a Browser. Once this has finished two Outlook profiles are created, one to 1.
access your mail file on the Domino server "Mail on <ServerName>" and the other to access your local mail file 
"Local Mail".

Right-click on the Outlook icon on your desktop.2.

Select "Properties" from the menu.3.

In the "Local Mail Properties" dialog select "Show Profiles".  If prompted include your password.4.

In the "Mail" dialog click "Add".5.

From the "Inbox Setup Wizard" dialog, select "Lotus Notes Mail" and click "Next".6.

Modify the "Profile Name" field to the name of the user whose mail file you will be accessing (for example, "John 7.
Doe's Mail") and click "Next".

Type your Password and click "Next".8.

Click "Next" through the next two dialogs and then "Finish".9.

In the "Mail" dialog highlight John Doe's profile from the list and click "Properties".10.

In the "John Doe's Mail Properties" dialog click "Properties" and enter your password.11.

In the "iNotes Access for Microsoft Outlook Properties" dialog select the "Profile" tab.12.

Select "John Doe" from the list and click "OK".13.

Click "OK" and "Close".14.

Launch Outlook and select John Doe's profile.  This will open John Doe's mail file.15.

Client

Changing passwords with iNotes Access for Microsoft Outlook
Beginning with Release 5.0.6, iNotes users can now change their own passwords.  Previously, Administrator 
intervention was required. 

The user should follow these instructions: 

Open the Outlook properties panel.1.

In the "Local Mail Properties" dialog, click on the "Show Profiles" button.2.

In the "Mail" dialog, select the "Mail on <servername>" profile and then click the "Properties" button.3.

In the "Mail on <servername>" dialog, click the "Properties" button.4.

Enter your password when prompted.5.

In the "iNotes Access for Microsoft Outlook Properties" dialog, on the "Password" tab, enter your current 6.
password, new password, and confirm password.

Click "OK".7.

Click "OK".8.

Click "Close".9.

Client

Set up Outlook 2000 before downloading iNotes
Outlook 2000 must be set up (have a profile) before downloading iNotes Access for MS Outlook to complete the 
installation and setup.
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iNotes Web Access

Administrator Client, Client, Server

iNotes Web Access 5.0.13
iNotes Web Access - Release Notes for Domino/Notes 5.0.13 
iNotes Web Access is a Web client for access to Domino-based mail, calendar, scheduling, and collaboration services. 
The client uses the latest Domino Server and DOLS (Domino Off-Line Services). It's based on the latest browser 
technologies to ensure a highly functional and robust product. It offers a subset of the functionality found in the 
current Notes client with the convenience of the Web. With iNotes Web Access, you can walk up to a Web browser 
anywhere to send and receive mail, view your calendar, invite people to a meeting, create a task for your To Do list, or 
access your contact list or journal. You can do all this offline, too.

Getting Help 

Before rolling out iNotes Web Access, be sure to read:

White Paper: iNotes Web Access Deployment Guide (l
http://www.lotus.com/ldd/notesua.nsf/0b345eb9d127270b8525665d006bc355/dcea56a48a39f14885256
b8a0054dafe?OpenDocument&Highlight=0,iNotes) - updated more frequently than the Redbook and may 
contain last minute information.

IBM Redbook, iNotes Web Access Deployment and Administration Guide (l
http://www.redbooks.ibm.com/pubs/pdfs/redbooks/sg246518.pdf) - the complete reference for deploying 
and administering iNotes Web Access. 

Hardware and Software Requirements
Server requirements 

IBM zSeries (S/390) with OS/390l
IBM pSeries (RS/6000) with AIX 4.3.3l
IBM iSeries (AS/400) with OS/400l
Sun Solaris Sparc 7 or 8l
Win32 with Windows 2000, Server or Advanced Serverl
Win32 with Windows NT Server 4.0 and Service Pack 4 or higherl

Client requirements
Win32 Internet Explorer 5.01 and Service Pack 1 or laterl

This release does not support Netscape Navigator browsers.

Installing and Configuring the Domino Server

Note: The Spell Checker for iNotes Web Access is not Installed by default.  You need to explicitly select the Spell 
Checker when you install the 5.0.13 Domino server. Spell checker may produce incorrect results for non-Latin-1 
languages.
1. Run the Domino/Notes 5.0.13 Server installation.
2. Choose Enterprise installation.
3. Click Customize.
4. Select "iNotes Web Spell Checker" and continue with the installation.

Installing and Configuring the Domino Server
1. Install the Domino 5.0.13 server first, then start the server.
2. When the setup wizard starts, choose First or Additional Domino Server.
3. Choose Advanced Configuration.
4. (Optional) Select Internet mail protocols (IMAP, POP3, SMTP).
5. Enable HTTP and choose an HTTP performance setting.
6. Enable DOLS to support users who will work off-line.  
7.   Finish the installation following the guidelines in Setting up a Domino Server.

Once you install the Server,  you'll need to configure DOLS. Configure DOLS as documented in the Administrator's 
documentation by creating an Offline Security document. 
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Configuring and Administering iNotes Web Access

Customizing iNotes Web Access for users
iNotes Web Access allows you to control user settings so you can manage disk space and improve performance on the 
server. For example, disabling archiving or full-text indexing on the server can save disk space. Specifying a long 
alarm polling time may improve performance. You can also set the minimum interval that must lapse before users can 
poll for new mail. To control the opening view, you can specify a Welcome Page URL for all users. 

Allow Users to Take the Domino Directory Offline
You can use a NOTES.INI setting to set the name of a Domino directory that the user may take offline. 

$DOLSDirectoryCatalog=nameofcatalog.nsf 

This setting makes a part of the preference user interface visible, giving users the option of taking the Domino 
directory or Directory catalog offline.  
For example, if  NOTES.INI contains $DolsDirectoryCatalog=dc.nsf,  the user sees a new preference setting, "Include 
server's Name and Address Book".  If the user enables this setting, the server's dc.nsf will be included among the files 
when the user goes offline. 

For disk space and performance reasons, it's recommended that users take offline the directory catalog rather than 
the Domino directory.

Disabling the Rich Text Editor
You can edit the NOTES.INI file to turn off the rich text editor when composing mail messages.

iNotes_WA_MessageFormat=1 

This setting in the server's NOTES.INI forces users to use only the plain text editor. However, the rich text editor is still 
available for calendar, notebook, and to do use.

Problems Accessing iNotes Web Access Files Through a Reverse Proxy Server
If users receive "Page Not Found" errors when entering the proper URL to a  mail file redirected through a proxy server, 
try appending "/iNotes/Welcome/?OpenDocument" to the end of the URL. Some older proxy servers do not properly fix 
HTTP 302 redirect responses, therefore the URL  returned to a  browser may actually be the non-fixed version of the 
URL. Entering this more explicit URL will avoid the 302 redirect. 

Keep in mind that any iNotes Web Access view page may be easily bookmarked to avoid always typing the full URL. 

Check for Newer Versions of Stored Pages Setting
The recommended setting for Internet Explorer browsers is automatically check for newer versions of stored pages. 
From the browser, choose Tools - Internet Options. On the General tab under Temporary Internet Files, click Settings. 
Select " Automatically" under Check for newer versions of stored pages"

Changing Settings on the iNotes Web Access Tab
To customize iNotes Web Access for users, edit the Configuration Settings document for the iNotes Web Access server.

From the Domino Administrator, click the Configuration tab and expand the Messaging section.1.

Click Configurations.2.

Select the Configuration Settings document for the iNotes Web Access mail server(s) and click Edit Configuration. 3.
If there is no Configuration Settings document, see the Domino Administration help documentation for creating a 
Configuration Settings document.

Select the iNotes Web Access tab.4.
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Change any of these settings and then save the document:5.

Setting Action

Archiving on server Enable (default) to allow users to create archives 
of their mail files on the server

Disable to prevent creation of mail archives to 
save disk space on the server. 

Full-text indexing Enable (default) to allow users to create a full-text 
index of their mail, calendar, and task entries on 
the server

Disable to prevent creation of full-text indexes to 
save disk space on the server and improve 
performance.

Modification of Internet password Enable (default) to allow users to change their 
Internet password

Disable to prevent users from changing their 
Internet password.

Calendar printing Enable (default) to allow users to print various 
calendar formats, including DayRunner, Franklin 
Planner, and Trifold. Calendar printing uses the  
PDF format from Adobe Acrobat. 

Disable to prevent users from printing Calendar 
formats using PDF. 

Note PDF printing is not supported in iNotes Web 
Access for Korean, Japanese, and simplified and 
traditional Chinese.

Custom ActiveX file attachment utility Enable (default) to allow users to use the custom 
file upload utility to drag-and-drop file 
attachments, select files easily, and have multiple 
file views.

Disable to allow users to use the standard browser 
file upload utility.

Alarms Enable (default) to allow users to set alarms for 
appointments, meetings, events, and task 
deadlines.

Disable to prevent users from setting alarms that 
may slow server performance.

Alarm polling time Enter a number to specify how often, in minutes, 
the iNotes Web Access client checks the server for 
alarms. Default is 5 minutes. Increase this 
number to improve server performance.

Minimum allowed mail polling time Enter a number to specify how often, in minutes, 
the iNotes Web Access client checks the server for 
new  mail.  Default is 5 minutes. 

To improve server performance, increase the 
minimum time. 

Welcome page URL
1 Enter the URL that all iNotes Web Access clients 

will use as the Welcome Page. Default is no URL.

Welcome page title Enter the Web page title for the Welcome page 
that all iNotes Web Access clients will use. Default 
is no page title.
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Setting Action

Alternate name display
2 Enable (default) to allow iNotes Web Access users 

to display alternate names in a native language. 

Disable to prevent iNotes Web Access from 
displaying alternate user names in a native 
language. When disabled, users see alternate 
names in English only.

Allow user to configure alternate name display 
setting

Enable to allow alternate name lookups, similar to 
"type-ahead" in Notes.  Lets user resolve 
ambiguous names and use alternate names by 
checking names against a contact list or Domino 
directory. 

This setting also lets users choose the preferred 
language for an alternate name. Disable (default) 
to prevent users from controlling alternate name 
support.

Allow user to choose the preferred language This setting enables or disables alternate name 
support in user Preferences.

Enable to allow users to choose the preferred 
language in which to view alternate names. 

Disable (default) to prevent users from choosing 
the preferred language in which to view alternate 
names.

Alternate name language This setting overrides the preferred language for 
an alternate name in user Preferences.

Pick from a list to select the default alternate 
name language . Default is English.  

Encrypt offline mail files Enable to allow users to encrypt their offline mail 
files.  

Disable (default) to prevent users from encrypting 
offline mail files. 

Allow user to override offline encryption setting Enable (default) to allow users to change the 
offline encryption strength.

Disable to prevent users from changing the offline 
encryption setting. 
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Setting Action

Disclaimer text Administrators can choose to attach a disclaimer to email 
messages when sent from iNotes Web Access users. For 
example, an administrator may want to add a couple of 
sentences to cover liability and security for the company. 
The disclaimer is appended to the email as it is sent, so the 
originator of the message doesn't see the disclaimer text as 
they are composing the message.

Enter the text that you would like to appear in email 
messages in HTML format  in this field.  For example, if you 
want line breaks to occur in specific places, you need to use 
the <BR> tag, or if you want to bold text you need to use 
the <B> tag. If you want to include references to external 
files within any of the HTML entered in the field, the external 
files are not packaged up and sent with the message, so  if 
you did include a link reference tag like "<img src="
http://www.company.com/logo.gif">," you need to make 
sure all recipients of any mail originating from iNotes Web 
Access will be able to reach the URL specified in your 
disclaimer. 

1 
 If you set the default URL and users are running Internet Explorer 5.01, the default page pane hides some of the sub 

menus in iNotes Web Access. This is caused by a limitation in Internet Explorer 5.01,  You can see all submenus if you 
are using Internet Explorer 5.5.
2 
If this setting is disabled (the default setting is enabled),  non-ASCII characters may be entered directly into primary 

name items. IBM/Lotus Software recommends that you do not disable this setting.
 

iNotes Web Access NOTES.INI Variables

Variable name First  
released

Default Description

iNotes_WA_DisableActCntSecurity 5.0.8 0 Enables/disables the iNotes Web 
Access Active Content Filter. A 
setting of 1 disables the filter. 
Setting this variable to 0 (or 
omitting it from the server's 
NOTES.INI file) enables the filter.

iNotes_WA_NameLookupMaxNumMatch 5.0.9 200 Specifies the maximum number of 
names to return on a name 
validation. 

iNotes_WA_LogoutRedirect 5.0.10 none Specifies the URL to redirect 
users to after logging out from 
server, doing normal cache 
clearing with the iNotes control, 
and clearing browser credentials. 
This variable allows sites which 
have additional actions that need 
to happen on a logout (such as 
logging out a reverse proxy server) 
to specify a URL to do this 
additional activity. Or you can use 
this variable to return people to an 
initial login page.
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Variable name First  
released

Default Description

iNotes_WA_MessageFormat 5.0.11 0 Determines whether to use the 
plain text editor when composing 
mail messages. Setting this to 1 
forces users to use the plain text 
editor.

iNotes_wa_MaxAttachmentSize 5.0.13 50,000K  Set the maximum attachment size. 
Note The Maximum POST Data in 
the Server document must be set to 
a value higher than this field.

Existing iNotes Web Access related variables
In addition to the above, there are two existing NOTES.INI variables important to the successful operation of iNotes 
Web Access. These are listed in the following table.

Variable name First  
released

Default Description

$DolsDirectoryCatalog 5.0.10 none Specifies the name of the Domino directory the user 
can  take off-line. When this variable is set, an 
option appears on the user preference interface. For 
example, if  NOTES.INI contains 
$DolsDirectoryCatalog=names.nsf,  the user sees a 
new preference setting, "Include server's Name and 
Address Book."  If the user enables this setting, the 
server's names.nsf will be included among the files 
when the user goes off-line.

This variable is actually part of Domino Off-Line 
Services (DOLS). iNotes Web Access uses DOLS to 
allow  users to work off-line.  

Log_DirCat 5.0 none Logs information about the Directory Cataloger task 
to the Miscellaneous Events view of the log file 
(LOG.NSF). This lets you monitor the Directory 
Catalog build process. This is a standard Domino 
NOTES.INI setting, described in the Domino 
Administrator's Guide. Set this to 1 for iNotes Web 
Access.

Known Timezone Problems For Repeating Calendar Entries

The table that follows identifies known problems when a client or server is observing Daylight Savings Time (DST).  In 
summary, repeating calendar entries may be off by one hour in an environment where servers and clients follow 
different DST rules. 

Client: No DST Observed Client: DST Rule same as 
Server

*
Client : DST Rule different 
from server

Server: No DST Observed Repeating calendar entries 
work correctly. 

Not Applicable Repeating calendar entries 
do not work correctly. 

Server: Some DST Observed Repeating calendar entries 
work correctly. 

Repeating calendar entries 
work correctly. 

Repeating calendar entries 
work do not work correctly. 

* DST Rule same as server means that the rule that specifies the Month, the week within the month, and the day of the 
week when a location starts observing daylight savings time and when it stops observing daylight savings time is the 
same on both the client and the server. 

254



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 4 - Documentation updates

Setting the Server to UTF-8 so Users can Save Documents in Multiple Languages
There is a default setting in the HTTP server that limits the server's ability to save documents created by a web client 
in languages other than English.  You need to switch the HTTP server to speak in UTF-8 language instead of ASCII.  
Here's how:

From the Domino Administrator, click the Configuration Tab.1.

Click Server, then All Server Documents.2.

Open the Web Server Document (for the server on which you are running the HTTP task) and click Edit Server.3.

Select the Internet Protocols tab, then the Web Engine tab.4.

Select "Yes" for the option: "Use UTF-8 for output:"5.

Installing and Configuring the Sametime Server

iNotes Web Access integrates Sametime 2.0 or 2.5 so that users can send and receive instant messages. Sametime is 
called "Chat" in iNotes Web Access.

Do not install Sametime and iNotes Web Access on the same Domino server. Sametime must be installed on a 
dedicated server.  For complete information on installing Sametime, see the Sametime Installation Guide.

Part 1 - Setup a Domino Server
1.   Install and configure a Domino 5.0.13 server.

2. Register users with the iNotes Web Access (R5) mail template. 

Part 2 - Create a Connection document on the iNotes Web Access server
1. From the Domino Administrator, click the Configuration tab.

2. Select the iNotes Web Access server's Domino Directory in the "Use Directory on" field.

3. Click Server, and then click Connections.

4. Click Add Connection.

5. Select Local Area Network in the "Connection type" field.

6. Enter the Sametime server's name in the "Destination server" field. For example: Sametime/Acme.

7. Enter the source domain of the iNotes Web Access server and the destination domain of the Sametime server. The 
domain must be the same in both fields. 

8. Click Save & Close. 

Part 3 - Edit each user's Person document and specify the Sametime server in the "Sametime server" field.
1. From the Domino Administrator, click the People & Groups tab.

2. Select the iNotes Web Access Domino directory, then click People.

3. Double-click a name to open the user's Person document.

4. Click Edit.

5. Enter the name of the Sametime server in canonical format in the "Sametime server" field. For example, the 
canonical format for the server Sametime/Sales/Acme/UK is: 

CN=Sametime/OU=Sales/O=Acme/C=US

where: CN is the common name, OU is the organizational unit, O is the organization, and C is the country code

6. Click Save & Close.

7. Repeat Steps 3 though 6 for each person.

Part 4 - Set up the Sametime server
Follow the instructions in the Sametime Installation Guide for installing Sametime in a Domino domain on a dedicated 
server. Make sure that the installation uses the same Domino domain in which the iNotes Web Access server resides.
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Part 5 - Create a Connection Document on the Sametime server
1. From the Domino Administrator, click the Configuration tab.

2. Select the Sametime server's Domino Directory in the "Use Directory on" field.

3. Click Server, and then click Connections.

4. Click Add Connection.

5. Select Local Area Network in the "Connection type" field.

6. Enter the iNotes Web Access server's name in the "Destination server" field.

7. Enter the source domain of the Sametime server and the destination domain of the iNotes Web Access server. 

8. Click Save & Close.

Part 6 - Create a one-time replica of the Tokens database on the iNotes Web Access server
The Sametime server implements a security policy to ensure Sametime clients that establish connections to the 
Sametime services are authenticated. This security policy involves the Secrets (stauths.nsf) database on the Sametime 
server.

1. Using a Notes client, choose File - Database - Open.

2. Enter the name of the Sametime server (for example, Sametime/Acme).

3. Enter the Secrets database filename: stauths.nsf 

4. Click Open.

5. Choose File -Replication - New Replica. 

6. Enter the name of the iNotes Web Access server (for example, iNotes/Acme)

7. Ensure that the database is replicated to the data directory: ...\domino\data\stauths.nsf.

8. Click OK to create the replica.

Part 7 - Push replication changes from the iNotes Web Access server to the Sametime server
1. From the Domino Administrator, click the Server tab.

2. Click the Server Console.

3. Enter a push command to replicate the Domino directory to the Sametime server.

For example: push Sametime/Acme names.nsf

4. Click Send.

Enter a push command to replicate the Tokens database to the Sametime server.

For example: push Sametime/Acme stauths.nsf

5.   Click Send.

Part 8 - Copy the Sametime applets to the Sametime server
1. Copy the contents from the Sametime applets folder on the iNotes Web Access server to the Sametime server.  On 

the iNotes Web Access server, the applets are located in the "SametimeApplet" directory: 

<data directory>\domino\html\SametimeApplet

2. Create a folder on the Sametime server in which to copy the iNotes Web Access Sametime applet files.  At a DOS 
prompt on the Sametime server, create the folder:

3. >mkdir <data directory>\domino\html\SametimeApplet

Note The folder name is case-sensitive and must be named "SametimeApplet".

Part 9 - Verify that Sametime works with iNotes Web Access
1. Make sure that replication is complete and the Person documents exist on the Sametime server.

2. Following the instructions in the Sametime Installation Guide for logging into the Sametime server using the 
Sametime Connect Client. Sametime must be functioning properly before you can test whether it is working with 
iNotes Web Access clients. 

3. Launch iNotes Web Access in a browser and click "Chat" to test the Sametime connection. 

Note If the chat link does not  appear in iNotes Web Access, check the user's Person document in the Domino 
directory. Verify that the name of the Sametime server in the Sametime server field is correct.
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Setting up iNotes Web Access and Domino Off-Line Services

With DOLS, users can take iNotes Web Access  offline, perform changes to mail, calendar, and so on, and synchronize 
the changes with an online replica. Users are not required to have Notes to use DOLS.  DOLS supports full data 
replication, retains application logic, and supports the full Notes security model.  Before deploying iNotes Web Access 
for offline use, you must review the DOLS topics in Domino Administration Help. It is also recommended that you read 
the "DOLS Issues" section of the Domino Release Notes. 

If DOLS was not selected when you installed the server, you can still enable DOLS on the server: 

Open the Server document, click the Internet Protocol tab, then the HTTP tab. 1.
In the "DSAPI filter file names" field, enter the appropriate file name (see table below) for the operating system 2.
running on your iNotes Web Access server.

Operating System DSAPI Filter File Name
WIN32 ndolextn
OS/400 libdolextn

AIX libdolextn
OS/390 libdolextn

Solaris Sparc 7 or 8 libdolextn

Create a DOLADMIN.NSF database from the DOLADMIN template and name the database "Offline 3.
Services".
Restart the Domino Administrator Client. 4.
Click the Configuration tab, and select "Offline Services." 5.
Create an Offline Security Policy document and save.6.

You must create an Offline Security Policy document. Refer to "Creating a DOLS Offline Security Policy 
document" in the Domino Administrator Help.

Providing a log-on URL for iNotes users

After you upgrade existing users or register new users, they will need three things to access their mail files: a user 
name, an Internet password,  and a URL.  See the Domino Administration Help, "Setting up session-based 
name-and-password authentication." for more information on user names and passwords. 

Before Applying the New Mail Template

Losing Custom Folders that are not marked "Prohibit design replace or refresh to modify"

When upgrading a mail template to iNotes Web Access, there is a potential to lose folders if the folders that do not 
have the property: "Prohibit design replace or refresh to modify" selected.  By default, folders created in R5 have this 
property enabled to maintain the integrity of a custom folder when upgrading Notes. However, some pre-R5 folder may 
not have this property set.  

You can make sure all folders have this property set properly. Open the mail database in Designer, select the Folder 
view,  and select any custom folder. Right-click the folder, choose Design Properties, then select the third tab.  If not 
enabled, check the box for "Prohibit design replace or refresh to modify".

Registering New Users

You need to set up the Internet username and password in the person record for each iNotes Web Access user. 
Register new users with the new mail template, iNotes5.ntf.  This template contains complete functionality for Lotus 
Notes and iNotes Web Access. For complete details about registering new users, follow the instructions in "Using 
Advanced user registration" in the Administrator' client help. Register a new user using the Administrator client,  but 
follow these key points:

Be sure to click Advanced on the Register Person dialog.l

On the Basics tab, enable "Set Internet password" and assign a minimum 8-character password. This password l
will be for both the Notes ID and iNotes Web Access authentication. 

On the Mail tab,  select Lotus Notes as the Mail system (this is the default).l

Select the template called "iNotes Mail and C&S" (iNotes5.ntf). l
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Upgrading Existing Users

The iNotes Web Access mail template is named "iNotes Mail and C&S". Its file name is iNotes5.ntf. This template is 
superset containing mail template support for Notes and iNotes Web Access clients.

Use the mail convert utility to convert Lotus Notes R5 mail files to the new iNotes Web Access design. When you 
upgrade users' mail files to the iNotes5.ntf template, you can do so one file at a time or use the mail conversion utility 
to automate upgrading the design. Be sure that you have already upgraded the Domino server hosting the mail files. 
Upgrade mail files at a time when users won't be accessing them -- for example, early mornings or over a weekend. 
Notify users that their mail files will be unavailable while they are being upgraded.

If users have customized their mail files, instruct them to back up these customizations. For example, users can 1.
make a new copy of their mail file that includes only the database design. This allows users to reapply changes 
they made to their Notes R5 mail file to the new iNotes Web Access mail template.

Launch the Domino server on which you want to customize mail files.2.

Shut down the router. Type: tell router quit3.

This prevents Domino from routing mail to the mail files while they are being upgraded. Mail is stored in 
MAIL.BOX while you upgrade the mail files. Once you have upgraded the mail files and load the router task again, 
the router processes and delivers the mail in MAIL.BOX.

Load the mail conversion utility. Type:  load convert [arguments]4.

See below for the arguments you can use with the mail conversion utility.

Once you have finished upgrading mail files to the iNotes Web Access template on this server, load the router. 5.

Type: load router

Notify users that you upgraded their mail files to the design. 6.

The mail conversion utility command uses arguments to specify options. It has the form: 

load convert [-r] mailfilepath existingtemplatename newtemplatefilename

where  -r converts mail files in subdirectories of the specified directory.

Example:

load convert -r mail\*.nsf StdR50Mail iNotes5.ntf

where ‘StdR50Mail’ is the design name. This example replaces all mail files in the data\mail directory that have the 
design called STDR50Mail, with the design that’s contained in iNotes5.ntf. The -r switch does this recursively for all 
files in subdirectories of data\mail.

Refer to the Domino documentation: Moving to Notes and Domino Release 5 and the section titled "Upgrading user’s 
mail files" for more information. 

Configuring Archiving on the Server

When configuring archiving for users, you need to specify an organization in the "Create new databases" field in the 
server form.
Domino/Notes interprets the creation of a new database differently for Notes and iNotes Web Access users. 

For Notes users, the "user" is trying to create a new archive database on the serverl
For iNotes users, the "server" is trying to create a new archive database on the serverl

If you allow only the "user" the right to create new databases, then iNotes Web Access will fail.  If you allow only the 
"server" the right to create new databases, then the Notes client will fail.   To satisfy both clients you should:

Leave the "Create new databases" field blank, or l
Enter   */<your organization> in the fieldl

The server is part of your organization, therefore, part of the */organization list.
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Example:
From the Notes client, an archive profile is signed by "John Smith/Sales/Acme".   From iNotes Web Access client, the 
archive profile is signed by "MailServer01/Sales/Acme".

An administrator would enter "*/Sales/Acme"  in the "Create new databases" field in the "MailServer01" server 
document.

Note: If archiving is disabled on the server, iNotes users cannot modify the Archive preferences setting. However, 
administrators can still archive iNotes users' mail files using a command at the console.

How Users Can Upgrade Their Own Mail Files

Users must be using a Lotus Notes client that is version 5.0.7 or later, and a mail server must be running Domino 
5.0.8 or later. As an administrator, you can provide this procedure to users:

1. Start Lotus Notes.
2. Ensure that you have Manager access to your own mail file: click File - Database - Access Control. Select your 

name, and make sure you have Manager access (most people already have this).
3. To ensure you have Internet access to your mail, click File - Database - Access Control, then click Advanced.
4. Set the "Maximum Internet name & password" field to Manager. This will let you enter your busy time, change your 

Internet password, and archive mail on the server with iNotes Web Access. 
5. Click File - Database - Replace Design to replace your mail template.
6. Set the "Template Server..." to your mail server. 
7. Select "Show advanced templates"
8. Scroll down and select "iNotes Mail and C&S" (iNotes5.ntf), and click Replace. This template contains the 

complete Lotus Notes and iNotes Web Access features).
9. To log-on to iNotes Web Access, you need a User Name and Password  To determine your username and 

password, open the Domino Directory on your mail server. Choose File - Database - Open, select your home mail 
server, then scroll down until you see NAMES.NSF.

10. Find your name in the directory and click "Edit Person".
11. On the Basics tab, take note of your "User names" according to your Person record.  Any one of the user name 

variations will work, including the "Short name/User ID" as well as your Internet address on the Mail tab.
12. Select the Other tab, and enter a password (you'll probably need to enter 10 characters). Validate your password 

by clicking "Check Password Strength".
13. Give the server time to run the Adminp process and replicate your new password to other servers. This may take 

anywhere from 5 minutes to an hour. 
14. To log in to iNotes, enter a URL in your Internet Explorer 5.01 (or later) browser using the following format: 

http://mailservername.com/maildirectory/mailfilename.nsf 

For example:  http://acmemail4.acme.com/mail/jsmith.nsf

15. When prompted, enter your username (Internet address) and Domino Internet password.

Troubleshooting the Domino Server

Problem: Can't Authenticate to iNotes Web Access
Solution: If you can't authenticate to iNotes Web Access, make sure your ACL is properly set for Maximum Internet 
Name & Password Access. Open the Access Control List for the database. Note that the Maximum Internet name and 
Password access is normally set to Editor by default. Change that to "Manager" to give yourself access to all iNotes 
Web Access features. 

Problem: User's can't see the server's Name and Address Book from their Contact List name picker.
Solution: This problem happens on newly installed servers because the view has not been refreshed soon after initial 
user registration during server installation and setup.   Users will be able to see the Name and Address Book from 
their Contact List name picker after the views are rebuilt overnight. However, you can rebuild the views immediately by 
running the UPDALL task on the server manually. 

Problem: DOLS Not Automatically Configured When Upgrading from Domino Server Without DOLS. You install Domino 
5.0.13 over a previous Domino version, one which did not have Domino Off-Line Services (DOLS) configured.  The 
install program copies the files, but Setup does not run so DOLS is never configured on the server.
Solution:  You must manually configure DOLS by adding the DSAPI filter to the Server document, creating the Offline 
Security document, then restarting the Server.  Refer to the Domino 5.0.5 Release Notes, excerpted below, for 
information on editing the Server document.  To create the Offline Security document, refer to the DOLS topics in the 
Domino 5 Administration Help. You should also verify that the DOLS Administration database (DOLADMIN.NSF) was 
created during the install.  If not, create the database using the Advanced template called "DOLS Administration 
Template (1.0)."
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Problem: Users can't send or save mail. They receive the error: "iNotes Warning.  Sorry, we were unable to process your 
request at this time.  If you are unable to continue working in your mail file, please dismiss this warning and then select View, 
Refresh from your browsers menu."
Solution:  Make sure the Web Server Document points to the directory used by iNotes Web Access. If this directory 
(domino\html) is not specified correctly in the Web Server document, iNotes Web Access and Domino Off-line Services 
(DOLS) using the HTTP task will not be able to successfully access the necessary files required to execute mail and To 
Do tasks. 

To check the HTML directory in the Web Server Document:

From the Domino Administrator, click the Configuration Tab.1.

Click Server, then All Server Documents.2.

Open the Web Server Document (for the server on which you are running the HTTP task) and click Edit Server.3.

Select the Internet Protocols tab, then the HTTP tab.4.

In the field "HTML directory", enter the following text: "domino\html"5.

Click "Save and Close". 6.

Tuning AIX Servers

Administrators tuning an AIX server for iNotes Web Access should follow these steps:
1. In HTTPD.CNF (UNIX only), define "maxactivethreads n", where n is  [40 / number of processors]
2. Launch the server
3. Verify the correct value by inspecting the "MaxActiveThreads" value displayed by the Domino "sho stat" command.  

(It will show maxactivethreads * nprocessors).
4. Run your Domino web server under load.
5. As your server runs, monitor the CPU run length.   The CPU run length is the value of the first column of the 

vmstat command.  A run length of 4 is optimal.  If the value is too high, lower the "maxactivethreads" value by 1, 
and re-test.  If your  run lengths are lower than 4, you can try increasing maxactivethreads.

See more performance and tuning information in  the latest iNotes Web Access Deployment Guide at:
http://www.lotus.com/ldd/notesua.nsf/0b345eb9d127270b8525665d006bc355/dcea56a48a39f14885256b8a0054
dafe?OpenDocument&Highlight=0,iNotes

Disabling Print Preview
Internet Explorer 5 Does Not Properly Support Print Preview  We have previously discovered that some installations of 
Internet Explorer (all of them 5.00) would not properly display Print Preview's PDF window. The MSDN KB article 
http://support.microsoft.com/support/kb/articles/Q262/2/13.ASP) describes this problem, and a resolution.

How to Determine Versions

When you are troubleshooting problems, it may be helpful to obtain the iNotes Web Access version number, server 
information, client operating system, and browser version.
Presently, when you view source and look at the top lines of the file, you will see this type of information:

<!-- $HaikuForm - 429 -->
 <html>     <head> 

  <!-- Domino Build V5011_06202002 (Windows NT/Intel) -->

The Domino Build information should indicate the Server Version.  Domino has no concept of Template Version, but 
there is a client build number which is emitted after the $HaikuForm -.  The server name is part of the URL the user is 
using and can also be gotten by looking for "var SERVER_NAME" within the page source:

var SERVER_NAME = 'wax.iris.com';
The client OS and Browser Version may be determined by searching for "var HTTP_USER_AGENT" within the page 
source:

var HTTP_USER_AGENT = 'Mozilla/4.0 (compatible; MSIE 5.01; Windows NT 5.0)';
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Known Client Problems

Note to Administrators: Please distribute the following section to your users.  It contains valuable information for 
clients and will reduce the number of calls made to the help desk. 

New Preference Dialog When Logging on the First Time
For Calendar and Scheduling operations to work properly in Notes/Domino, a user must first specify the owner of the 
mail file.  If you are an existing Notes user, this should already have been specified.  For new iNotes Web Access user 
mail files, the Preferences dialog showing the Mail tab will pop up automatically the first time a new user accesses 
iNotes Web Access. 

Make sure the name of the mail owner is specified. 1.
Click Save and Close.2.
Restart iNotes Web Access. 3.

Calendar and Scheduling Limitations
The following functions are not available in iNotes Web Access:

Delegate a meeting to someone.l
View participant status action.l
Resource Reservation Request form doesn't provide a way to accept or decline the reservation.l
Group To Do ( Assign a To Do document to the other person)l
Create a custom repeating meetingl
Domino/Notes 4.6 repeating meetings are not supported. Repeat meetings cannot be converted to iNotes l
Web Access, and the Notes client may lose the repeating meetings in a calendar after the mail database is 
converted. You need to update your calendar in Notes after applying the iNotes Web Access mail design.

Attachments
To open file attachments with iNotes Web Access from a Web browser, set your mail preferences in your Person 
document to the "No Preference" option. If you have the "Prefers MIME" option set and you open the attachment in 
iNotes Web Access from a Web browser, file attachments may appear distorted, or iNotes Web Access may prompt 
you to convert the attachment. Note that this problem does not occur when viewing file attachments in iNotes Web 
Access from a Lotus Notes client.

Setting Anniversary as the Default Calendar Entry
Using Anniversary as the default Calendar document changes the Repeat Meeting settings to default to the anniversary 
repeat settings.

Spellcheck
Spell check may produce incorrect results for non-Latin-1 languages.

Help Limitations
Help may not work correctly on some AS/400 legacy servers because filenames over 30 characters are not supported. 

How You Can Switch from Using iNotes Web Access to WebMail
There is a user interface parameter setting (&ui=argument) is available to easily switch between WebMail and the 
iNotes Web Access.  The first example shows how to open a user's mail with the IWA user interface; the second 
example shows how to switch to a WebMail user interface:

http://www.acme.com/mail/jsmith.nsf?OpenDatabase&ui=inotes

http://www.acme.com/mail/jsmith.nsf?OpenDatabase&ui=webmail

When a user switches to a either iNotes Web Access (ui=inotes) or WebMail (ui=webmail), that state is remembered on 
the server. If server is set up for basic authentication it affects all future URLs to this database from the same client 
machine or any client machine.

Resetting the Welcome Page Layout to the Default
You can open your mail file using the "default" URL argument to reset your Welcome Page to the default layout, even if 
you have a custom layout. You can use this argument if the layout data becomes corrupted. For example: 

http://hostname/mail/filename.nsf/iNotes/Welcome/?OpenDocument&ui=inotes&de
fault
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Opening Someone's Mail File to Which You Have Been Delegated Access
You can open a mail file to which you have been delegated access by first entering a URL for the person's mail file, 
then entering your own username and password.

To open John Smith's  mail (to which you have been delegated access), you would simply enter the URL of John's mail 
file:

http://acme.sales.com/mail/jsmith.nsf

When prompted for authentication, enter your own username and password. 

Categorized Views are not supported
Categorized views are not supported by Forms5.nsf, which is the basis for both iNotes5 and iNotes60 mail templates. 
If a user's mail database is based on either of these mail templates, categorized views will not display correctly.

Compacting Databases
Domino Off-line Services will not attempt to compact encrypted databases just as Domino servers cannot compact 
encrypted databases.  Compacting databases only works on unencrypted databases.

Editing of Entries with Attachments using both Notes and iNotes Web Access
iNotes Web Access does not allow the updating of attachments in repeating to-dos and repeating calendar entries.  We 
recommend that users do not update the attachments with the Notes client if you will also be using the iNotes Web 
Access client to interact with these entries. If you do so, you may encounter iNotes  warning messages when you 
subsequently interact with these entries with your iNotes Web Access client.

Going Offline
When opening an offline subscription from the Lotus iNotes Sync Manager on a Windows 2000 client that is 
disconnected from the network, a dialog box appears with a message stating that no connection to the Internet is 
currently available, together with options to "Work Offline" or "Try Again". You MUST choose "Try Again" in order to 
access your offline data.

Offline Encryption of Mail
By default, offline mail files are not encrypted.

Offline Mail Will Not Open when Encrypted and Password Has Changed
You will not be able to open your offline mail if you have selected to encrypt offline mail and your password has 
changed.  This is because your Notes and Internet passwords must be the same when the offline mail file is encrypted 
locally.  A Notes password is required to access the Notes ID to decrypt the mail file. However, only the internet 
password is available in the (offline) HTTP server. Make sure that you turn off encryption of your local mail file if you 
plan to change your Internet password. 

Changing Your Internet Password
When you change your Internet password, allow time for the server's Adminp process to run before the change will take 
effect. You may have to wait anywhere from 5 minutes to several hours depending on how often the Adminp process is 
set to run on the server.

When your Internet password is different from your Notes password:

You will be prompted for a "Synchronization password" whenever DOLS attempts to sync the offline mail file. l
This includes the initial sync that occurs when the mail file is first installed offline.

You will not be able to open an encrypted offline mail file.l

You must set the "synchronization password" for the subscription to your Notes password.  Note that DOLS l
initializes the Sync password to be the Internet password.  In the DOLS Sync Manager select the mail file 
subscription entry, then select the Properties - Security  dialog to set the sync password.

If your offline mail file is encrypted locally, then a HTTP 500 Server internal error will occur when the offline l
mail file is opened, unless you have correctly set the sync password for the subscription to the Notes 
password.
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Out of Office Mail
To enable Out-of-Office mail, you need to modify your mail file's ACL setting.  Change the "Maximum Internet name & 
password' setting to Designer. The online help states that Manager access is required, but this is wrong. The help also 
states that out-of-office messages are sent only to iNotes Web Access users. This is incorrect, the Out-of-Office agent 
notifies all users who send you mail that you are out of the office. The agent also notifies Internet users, unless you 
check "Do not automatically reply to mail from Internet addresses."

Blank messages
iNotes Web Access displays the contents of encrypted messages as blank and provides instructions on how to see the 
message unencrypted. 

Searching Work Hour Availability
Work Hour search does not support users whose mail server Timezone is different from the client's mail server 
Timezone.  Further, when repeat appointments/meetings cross Timezone boundaries, the time information will not be 
correct.

Group Calendar
If the server's local time is ahead of the client's local time, Group Calendar does not show correctly in the Month view. 

Contacts
For existing Notes client users, your Personal Name and Address book can be synchronized with the iNotes Web 
Access Contact List by means of a utility.  In Lotus Notes, use Actions - iNotes Web Access - Synchronize Contacts.

Notebook
Your iNotes Web Access Notebook entries can be synchronized with an existing journal database that you may have in 
Lotus Notes. In Notes, use Actions - iNotes Web Access - Synchronize Journal to bring your iNotes Web Access 
Notebook up to date with your Notes journal entries. 

To Do Items
Milestones are available in the iNotes Web Access client.  Checking the milestone box when you are either l
creating or editing a To Do will convert the To Do to a one-day milestone.  A milestone is meant to be either 
completed or not completed (rather than something that can be partially completed).
The To Do Chart is only available when the user is "On Line".  Refreshing the To Do chart refreshes its data l
and sends it back to its default view of that data.  So if the default view is days and the user refreshes from 
within the month's view, the refreshed view of the data will be the days view. 
If all To Do items are clustered in the last week of a single month, then the name of the month may not be l
displayed in the chart, due to space and font style constraints.
In the process of creating a To Do you decide to mark it complete, The To Do icon in the To Do List view will l
be correct, but it may not be correct in the All Documents view.
If a user opens a repeating To Do's parent document using the All Documents view, the changes to the parent l
document may not be retained after the user selects "Save & Close" or "Save."
PDF formatting is not available when printing To Do tasks. l

Busy Cursor
A busy cursor (combination mouse pointer and hourglass)  remains after some window are closed or search 
operations are executed. Refreshing the window or changing the view resolves the problem.

Working with Folders Offline
When working with folders offline, you need to refresh your browser when returning online to see the newly added, 
changed, or deleted folder. 

Group and Nested Group Expansion
When entering a personal group in a memo or calendar entry, the group will expand right away. If the group resides in 
a Domino directory, it will not expand when addressing a memo, but it will expand right away on a calendar entry. 
Nested personal groups, that is, groups containing another group inside your Contact List, do not expand when 
creating a memo or calendar entry.

Name Resolution Limitations
The Directory Catalog cannot be the target directory for name resolution in iNotes Web Access.  The maximum 
number of candidates per name being resolved is set to 200.
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Alternate Name Limitations
If "Validate name and set alternate name items" in the Server Configuration Document is disabled (the default setting 
is enabled),  there might be a chance that non-ASCII characters will be entered directly into primary name items. We 
highly recommend that you do not disable this setting.  
Alternate names are not supported in the following places:

Alternate names used in a group To Do created with the Notes clientl
Alternate names entered in a Delegation tab in Preferences.  What's typed in the fields will be processed l
literally.  
Alternate names used in "Reply To" fields.l

Name Picker
Search on the Directory Catalog is supported in this release. However, the search accuracy may not be as high when 
compared to searches in an ordinary Domino directory.  LDAP is not supported in iNotes Web Access. The case that 
Domino server is configured to redirect a query to an external LDAP server is not supported, either.

Domino Unified Messaging Service (DUCS) Version 1.1 for iNotes Web Access

The iNotes Web Access DUCS client lets you display but not create or update Private Notes entered by a Notes DUCS 
client. Private Notes is an annotation feature that lets the Notes DUCS client enter information about the sender and 
the audio content of a voice message in a text box labeled "<Click here to add your Private Notes>" at the bottom of 
the voice memo form. The Notes DUCS client can enter approximately 15K of plain text in the Private Notes box. 
Graphics and rich text are not supported. You can search on text in the Private Notes box. Private Notes are never sent 
to recipients.

Issue: If you install the Domino Unified Communications Services (DUCS) Notes client on a machine that already had 
the DUCS iNotes Web Access client installed, you will notice that Internet Explorer assigns the Lotus UC Player a 
status of "Unplugged," if you click Tools - Internet Options - Settings - View Objects. This condition, if you see it, is not 
a cause for concern and does not affect the usability of Player/Recorder when using IE with the Unified 
Communications iNotes Web Access client. Under this scenario, installing the DUCS Notes client directly registers a 
local copy of the Lotus UC Player, which causes IE to change the status of the previously registered Lotus UC Player to 
"unplugged." Subsequently, IE will use the locally registered Lotus UC Player for both the UC iNotes Web Access and 
Notes clients.

Workaround: Not applicable.

Webmail

Client, Server

Working with various memo types in Webmail
Plain and Rich Text editors have been implemented in Webmail R5.0.5 to provide optimized performance in most 
frequently used memo types (New Memo, Reply), while at the same time preserving the format integrity of pre-existing 
messages (Reply with History, Forward, Draft).

The following table lists each memo type and its default editor:

Memo Type Default Editor

New Memo Plain Text Field with the 
option to switch to Rich 

Text Editor Applet

Reply Plain Text Field with the 
option to switch to Rich 

Text Editor Applet

Reply with History Rich Text Editor Applet

Forward Rich Text Editor Applet

Draft Rich Text Editor Applet
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Client, Server

Setting up Webmail using the Extended Mail template
Once Domino Off-Line Services (DOLS) is installed and configured

1
, setting up Webmail for users using the Extended 

Mail (5.0) template is a five-step process.

Step 1: Register Webmail users by creating a special mail file or replace the design for each user.l

Step 2: Create a DOLS security policy document.l

Step 3: Open and save the offline configuration profile document in each person's mail file.  l

Step 4: Give each user a user name, internet password, and a URL to access their mail file. l

Step 5: Instruct users to download and install the iNotes Sync Manager, which they use to manage such l
activities as synchronization of the online and offline versions of their Webmail files.

Step 1: Register users with the extended mail template

For existing users, refresh the design of their mail files with the Extended Mail (R5.0) template (MAIL50EX.NTF). 1.

If you are registering new Webmail users, and want them to receive the offline mail feature, you must create their 
mail files with the Extended Mail (R5.0) template and not the default Mail (R5.0) template (MAIL50.NTF).

Make sure to enable the "Set Internet password" field in each user's Person document in the Domino Directory. 2.

Step 2: Edit the offline security policy document

Create an offline security policy document. See the DOLS online Help topic "Creating an Offline Security Policy 
document" for the steps needed to edit or create an offline security policy.

Step 3: Edit the offline configuration profile document 

Using the Administrator Client, go to the Domino Server mail directory and open a mail file that is using the 1.
Extended Mail (R5.0) template. Make sure you use the User ID created with the mail file to access the mail file.

Choose Actions->Edit Offline Configuration to open the Offline Configuration profile document. See the DOLS 2.
online Help topic "Creating an Offline Subscription Configuration Profile document" for more information on 
editing the Offline Configuration profile document in the online help. 

Save the document. 3.

Repeat these steps for each user's mail files. 4.

Step 4: Give each user a user name, password, and URL

Provide each user with a URL that points to the user's mail file using this format: 1.

http://server_name/mail_file_directory/mail_file_name.nsf

For example: http://server1/mail/jsmith.nsf

Provide each user with a Notes domain username and Internet password2.

Provide each user with all the instruction items contained in Step 5.3.

Step 5: Instruct Users to Download and Install iNotes Sync Manager

Instruct users to:  

  1. Go to the URL provided to them for their Webmail file (See Step 4 above). 

  2. Download and install the iNotes Sync Manager

Internet Explorer users: Once users go to their Webmail file, instruct them to click on the black "Go l
Offline" Web control in the bottom left portion of their Webmail file and choose the "Install subscription" 
item in the pop up menu.

Netscape Navigator users:  Once users go to their Webmail file, they will be prompted to install the l
"Lotus iNotes Plug-in".  Instruct users to:

Save the plugin in the Plugins directorya.

Close and relaunch Netscapeb.

Reenter their Webmail file and click on the black "Go Offline" Web control in the bottom left portion c.
of their Webmail file and choosing the "Install subscription" item in the pop up menu.
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  3. After the download and installation is complete, minimize (not close) the Lotus iNotes Sync Manager window 
when it appears.

  4. Use Lotus iNotes Sync Manager to synchronize between the offline and online mail files or to schedule 
automatic synchronizations.

  5. Get to the iNotes Sync Manager online help for more information on using the Lotus iNotes Sync Manager.

  6. Toggle between offline and online modes by:

Clicking on the "Go Offline/Go Online" Web control in the lower left corner of their Webmail filel

Clicking on the subscription listed in the iNotes Sync Managerl

Double clicking on subcription icons placed on their desktopl

  7. Synchronize their online and offline mail files through

The pop up menu in the Go Offline/Go Online Web control in the lower left corner of their Webmail filel

The icons or menus in the iNotes Sync Managerl
1
  For comprehensive instructions for setting up Domino Off-Line Services with Domino, refer to the DOLS online Help 
section within either the Domino Designer or Domino Administration Client. 

Client, Server

Two templates for Webmail
Starting with R5.0.5, administrators of Domino Webmail have a choice of two templates when deploying Webmail -- 
the default Mail (R5.0) template (MAIL50.NTF), and a new Extended Mail (R5.0) template (MAIL50EX.NTF). The 
Extended Mail (R5.0) template is a superset of the default Mail (R5.0) template. Beyond the functionality included in 
the default Mail (R5.0) template, the Extended Mail (R5.0) template also includes an offline mail feature for users of 
Domino Webmail

1
, as well as numerous features for users of iNotes Access for Microsoft Outlook

2
.  

Administrators of Domino Webmail who wish to extend offline mail capabilities to their Webmail users should use the 
new Extended Mail (R5.0) template (MAIL50EX.NTF) included in R5.0.5.  Administrators of Domino Webmail who do 
not wish to offline mail capabilities to their Webmail users should use the default Mail (R5.0) template (MAIL50.NTF).
1
  For more information on setting up Domino Webmail users using the Extended Mail (R5.0) template, refer to the 

Release Note entitled, "Setting up Domino Webmail Using the Extended Mail Template."
2
  For more information on setting up iNotes Access for Microsoft Outlook users using the Extended Mail (R5.0) 

template, refer to the online Help topic entitled, "Setting up for Lotus iNotes Access for MS Outlook."

Client

Upgrading folders in Webmail
Parent mail folders created prior to R5.0.5 must be upgraded to take advantage of new folder functionality.  To do 
this, navigate to the particular folder, click Folder in the Action Bar, and select Upgrade Design.

However, nested folders require specific steps for upgrades. Users can move the documents in a nested folder to a 
parent folder using the All Documents view, or use the Notes client to move the folder to the parent level before 
upgrading the folder design.
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Domino Designer Programming Guide

Designer

Displaying a categorized view as flat
If your view is a categorized view built in Designer 5.0 or later, you can select "Categorized is flat version 5 or greater" 
to convert your view to a non-hierarchical, flat view, which displays all documents on a single level. Use this feature if 
your level of indentation in a view exceeds the limit of 32 levels.

Designer

NotesDatabase Forms property example

The following example has been updated.

Example: Forms property
This example displays the names of all the forms in the current database

Sub Initialize
     Dim session As New NotesSession
     Dim db As NotesDatabase
     Set db = session.CurrentDatabase
     Forall form In db.Forms
        Messagebox form.Name
     End Forall
End Sub

Designer

NotesUIView Print method dateRange parameters
Clarified the dateRangeBeginand dateRangeEnd parameters with respect to data type.

Print method  

Implements the @Command([FilePrint]). Prints the currently open or selected document(s), or the current view.

Note  This method is new with Release 5.

Defined in

NotesUIView

Syntax

Call notesUIView.Print([ numCopies%] [, fromPage%] [, toPage%] [, draft] [, pageSeparator%] [, formOverride$] [, printview
] [, dateRangeBegin] [, dateRangeEnd])

Parameters

numCopies%

Integer. Optional. The number of copies you want to print. If you omit this parameter, the method displays the 
File Print dialog box.

fromPage%

Integer. Optional. The page of a document where you want to start printing. "0" means all.

toPage%

Integer. Optional. The page of a document where you want to stop printing. "0" means all.

draft

Boolean. Optional. Specify True if you want to print the document in draft mode.
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pageSeparator%

Integer. Optional. Determines the page separator.

formOverride$

Text. Optional. The name of the form you want to use to print the document. 

printView

Boolean. Optional. Specify True to indicate that you want to print the current view.

dateRangeBegin

Variant of type DATE. Optional. Prints the beginning date if printing from a calendar view.

dateRangeEnd

Variant of type DATE. Optional. Prints the end date if printing from a calendar view.

Designer

NotesUIWorkspace AddDatabase method
The filename$ parameter is not optional.

AddDatabase method
Adds a database to the workspace and highlights the icon, or highlights the icon if the database is already on the 
workspace.

Defined in

NotesUIWorkspace

Syntax

Call notesUIWorkspace.AddDatabase( server$ , filename$ )

Parameters

server$

String. The name of the server where the database resides. If this parameter is omitted or is an empty string 
(""), the database is opened on the local computer.

filename$

String. The path and file name of the database.

Designer

NotesUIWorkspace PickListCollection method
NotesUIWorkspace PickListCollection method return value has been clarified.

PickListCollection method
Creates a NotesDocumentCollection object from a list selected by the user. You specify a view within a database from 
which the user can select one or more documents.

Note  This method is new with Release 5.

Defined in

NotesUIWorkspace

Syntax

Set notesDocumentCollection = notesUIWorkspace.PickListCollection( type% [, multipleSelection ], server$, 
databaseFileName$, viewName$, title$, prompt$ [, Singlecategory$ ] )
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Parameters

type%

Integer. This parameter is restricted to PICKLIST_CUSTOM (3).

multipleSelection

Boolean. Optional. Specify True if you want to select multiple documents. Defaults to False.

server$

String. Name of the server where the database resides.

databaseFileName$

String. The filename of the database that contains the view.

viewName$

String. Name of the view you want displayed in the dialog box.

title$

String. Title for the dialog box.

prompt$

String. The prompt that you want to appear inside the dialog box.

Singlecategory$

String. Optional. Displays the specified category in the view. The view should be categorized in order to use this 
parameter.

Return value

This method returns a NotesDocumentCollection object if you click OK. If you click Cancel the Count property is set to 
0 and it returns an empty document.

Programmer's Guide

Designer

Accessing the current document in LotusScript classes
Corrected the link to NotesUIView.

Accessing the current document in LotusScript classes
You can access the back-end document that is currently open through the NotesUIWorkspace and NotesUIDocument 
classes. Using the NotesUIView  class, you can access the back-end documents in the view with the Documents 
property. 
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The NotesUIDocument class has the following properties:

Property Data type Description

AutoReload Boolean (Read-write) True to automatically reload the current 
document any time there is a change.

CurrentField String (Read-only) The name of the current field if the 
document is in Edit mode.

DialogBoxCanceled Boolean (Read-only) Indicates if a user cancels a dialog.

Document NotesDocument (Read-only) A reference to the NotesDocument object 
associated with this document window, giving you 
access to the back-end properties and methods. If you 
modify and save an item using the NotesDocument 
object, the item is automatically updated in the 
workspace, except for rich text items.

EditMode Boolean (Read-write) True for Edit mode.

FieldHelp Boolean (Read-write) True to display field help.

HorzScrollBar Boolean (Read-write) True if the horizontal scroll bar is visible.

HiddenChars Boolean (Read-write) True to display hidden characters.

InPreviewPane Boolean (Read-only) True if the document is being accessed 
from the preview pane.

IsNewDoc Boolean (Read-only) True if the document is not yet saved.

PreviewParentDoc Boolean (Read-write) True if the lower pane containing the 
parent document is displayed.

PreviewDocLink Boolean (Read-write) True if the lower pane containing the 
linked document is displayed.

Ruler Boolean (Read-write) True if the ruler is visible.

WindowTitle String (Read-only) The name of the window title.

The NotesUIDocument class has the following methods: 

Method Description

Categorize Categorizes the current document.

Clear Clears the selected text.

Close Closes the current document.

CollapseAllSections Collapses all sections in the document.

Copy Copies the selected text to the Clipboard.

CreateObject Creates an object in a rich text item.

Cut Cuts the selected text and places it on the Clipboard.
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DeleteDocument Marks the current document for deletion and closes it. The NotesUIDocument 
object is no longer available once you call this method.

DeselectAll Deselects the entire contents of the current field.

ExpandAllSections Expands all sections in the document.

FieldAppendText Appends the specified text to the specified or current field.

FieldClear Clears the contents of the specified or current field.

FieldContains Returns True if the specified or current field contains the specified 
case-sensitive text.

FieldGetText Gets the text of the specified or current field.

FieldSetText Sets the specified or current field to the specified text.

FindFreeTimeDialog Brings up the Find Free Time box. 

FindFreeTimeDialogEx Brings up the Find FreeTime box to allow searches for available meeting 
times.

FindString Finds the text in a given field.

Forward Creates a new mail document and prompts for recipients.

GetObject Gets a specified object.

GetSchedulerObject Gets an embedded scheduler.

GetSelectedText Gets the selected text in a UI document.

GotoTop Goes to the first field or scrolls to the top of the document.

GotoBottom Goes to the last field or scrolls to the bottom of the document.

GotoField Given a field name, puts the cursor in the specified field in a document.

GotoNextField Goes to the next field or scrolls so that it is visible.

GotoPrevField Goes to the previous field or scrolls so that it is visible.

GotoTop Places the cursor in the first editable field or the first button in a document.

Import Imports a file to the document.

InsertText Inserts the specified text at the current cursor position.

NavBarSetText Sets the URL navigation bar text. 

NavBarSpinnerStart Starts the URL navigation bar spinner. 

NavBarSpinnerStop Stops the URL navigation bar spinner. 

Paste Pastes the Clipboard text to the current cursor position.

Print Prints the current document.
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Refresh Refreshes the document.

RefreshHideFormulas Recalculates the hide-when formulas for the current document; this is an 
expensive operation.

Reload Refreshes the current document with any changes made to the stored 
document.

Save Saves the current document.

SaveNewVersion Saves the current document as a new version.

SelectAll Selects the entire contents of the current field.

Send Mails the current document and closes it.

SpellCheck Checks the spelling in a document.

The NotesUIView class has the following properties:

Property Data type Description

CalendarDateTime Variant of type DATE (Read-only) The date and time of the 
current region in a calendar view.

CaretCategory Variant (Read-only) Returns the current category 
in the view for the current document.

Documents NotesDocumentCollection (Read-only) All the documents that the 
current NotesUIView event is working on.

View NotesView (Read-only) The back-end view that 
corresponds to the currently open view.

The NotesUIView class has the following methods:

Method Description

Print Implements the @Command([FilePrint]). Prints the currently 
open or selected document(s), or the current view.

SelectDocument Selects the specified document in a view.

For a list of events in NotesUIView, see "Event Descriptions" in the "Programming Overview" chapter.
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Designer

Keyword property class usage
The "Keyword Property" usage has been updated for Java/CORBA classes and LotusScript/OLE/COM classes:

Java/CORBA Classes

Example

Read-only. The following components of a hierarchical name in the order shown separated by 
backslashes: country or region\organization\organizational unit 1\organizational unit 2\organizational 
unit 3\organizational unit 4. Returns an empty string if the property is undefined.

Defined in

Name

Data type

String

Syntax

public String getKeyword()

    throws NotesException

Usage

This property returns the full name if it is flat.

Language cross-reference

Keyword property in LotusScript NotesName class

LotusScript/COM/OLE Classes

Example

Read-only. The following components of a hierarchical name in the order shown separated by 
backslashes: country or region\organization\organizational unit 1\organizational unit 2\organizational 
unit 3\organizational unit 4.

Defined in

NotesName

Data type

String

Syntax

To get: string$ = notesName.Keyword

Usage

This property returns the full name if it is flat.

Language cross-reference

Keyword in Java Name class

Designer

NotesDatabase GetView method Return Value
Clarified the return value.

GetView method
Finds a view or folder in a database, given the name or alias of the view or folder.

Defined in

NotesDatabase
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Syntax

Set notesView = notesDatabase.GetView( viewName$ )

Parameter

viewName$

String. The name of a view or folder in a database. Case insensitive. Use either the entire name of the view or 
folder (including backslashes for cascading views and folders), or an alias. 

Return value

notesView

NotesView. The view or folder for which the name or synonym matches viewName$. Returns Nothing if no match 
is found.

Usage

If the database is local, GetView returns both public and personal views and folders. If the database is on a server, 
GetView returns only public views and folders.

When specifying the viewName$ parameter, do not use the view name and its alias together: for example, specifying 
"By Author|AuthorView" does not work. Use either the view name ("By Author") or its alias ("AuthorView").

When the view or folder name contains underscores to indicate menu accelerators, you have the option of either 
including or excluding the underscores. The method works more efficiently, however, if you include the underscores.

Designer

NotesRegistration class Mail Server parameters
NotesRegistration class server name parameters must be in canonical format. This applies to the mailserver$ 
parameter in the AddUserToAddressBook method and to the regserver$ parameter in the
RegisterNewUser method.

AddUserToAddressBook method

Syntax:

Call notesRegistration.AddUserToAddressBook( idfile$, fullname$, lastname$  [, userpw$  [, firstname$ [,  middle$ [, 
mailserver$ [, maildbpath$ [, fwdaddress$  [,location$ [, comment$]]]]]]]] )

Parameters:

mailserver$

String. The name of the user's mail server in canonical format.

RegisterNewUser method

Syntax:

Call notesRegistration.RegisterNewUser( lastname$, idfile$, regserver$   [, firstname$  [, middle$  [, certpw$ [, 
location$ [, comment$ [, maildbpath$ [, fwddomain$ [, userpw$ [, usertype% [, altname [, altnamelang ]]]]]]]]]]] )

Parameters:

regserver$

String. The canonical name of the server containing the user's mail file.
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Designer

NotesRichTextItem AppendDocLink method usage
The requirement for having a default view has been added to the Usage section.

AppendDocLink method
Given a database, view, or document to link to, adds a link to the end of a rich text item.

Defined in
NotesRichTextItem

Syntax
Call notesRichTextItem.AppendDocLink( linkTo, comment$ [, HotSpotText$ ] )

Parameters
linkTo

NotesDatabase, NotesView, or NotesDocument. The database, view, or document to which you want to create a 
link. 

comment$

String. The text that appears when a user presses and holds the mouse pointer over the link.

HotSpotText$

Note This parameter is new with Release 5.
Optional. String. If supplied, the HotSpotText appears in the RichTextItem as boxed text which can be clicked on 
with the mouse to follow the link. In this case, no other token appears in the text.

Usage
For this method to work you must set a default view in the database.

Designer

NotesSession FreeTimeSearch method example

The following example has been updated.

Example: FreeTimeSearch method
This example finds the first 60-minute time slot available for three people.

Dim session As New NotesSession
Dim window As NotesDateRange
Dim startDateTime As New NotesDateTime("Today")
Dim endDateTime As New NotesDateTime("Tomorrow")
Dim names(1 To 3) As String
Dim freeTime As Variant
Set window = session.CreateDateRange()
Set window.StartDateTime = startDateTime
Set window.EndDateTime = endDateTime
names(1) = "Robert Erronpay"
names(2) = "Marybeth Enakermay"
names(3) = "Kerry Oodwardway"
freeTime = session.FreeTimeSearch _
     (window, 60, names, True)
Messagebox Error$
If (freeTime(0) Is Nothing) Then
  Messagebox "No Match Found"
Else
  Forall x In freeTime
  Messagebox x.Text
  End Forall
End If
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Designer

NotesSession objects
NotesSession objects must not be deleted. The warning Do not delete session objects has been added to the Usage 
section.

NotesSession class
Represents the environment of the current script, providing access to environment variables, Address Books, 
information about the current user, and information about the current Notes platform and release number.

Containment

Contains: NotesAdministrationProcess, NotesAgent, NotesColorObject, NotesDatabase, NotesDateRange, 
NotesDateTime, NotesDbDirectory, NotesDocument, NotesDocumentCollection, NotesDOMParser, NotesDXLExporter, 
NotesDXLImporter, NotesInternational, NotesName, NotesLog, NotesNewsletter, NotesRegistration, 
NotesRichTextParagraphStyle, NotesRichTextStyle, NotesSAXParser, NotesStream, NotesTimer, NotesXSLTransformer

Properties

AddressBooks

CommonUserName

ConvertMime

CurrentAgent

CurrentDatabase

DocumentContext

EffectiveUserName

HttpURL 

International

IsOnServer

LastExitStatus

LastRun

NotesBuildVersion 

NotesURL 

NotesVersion

OrgDirectoryPath

Platform

SavedData

ServerName

URLDatabase

UserName

UserNameList

UserNameObject

Methods

CreateAdministrationProcess

CreateColorObject

CreateDateRange

CreateDateTime

CreateDOMParser 

CreateDxlExporter

CreateDxlImporter

CreateLog

CreateName
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CreateNewsletter

CreateRegistration

CreateRichTextParagraphStyle

CreateRichTextStyle

CreateSAXParser

CreateStream

CreateTimer

CreateXSLTransformer

Evaluate

FreeTimeSearch

GetDatabase

GetDbDirectory

GetEnvironmentString

GetEnvironmentValue

HashPassword

Initialize

InitializeUsingNotesUserName

New

Resolve

SendConsoleCommand

SetEnvironmentVar

UpdateProcessedDoc

VerifyPassword

Creation and access

To access the current session, use New.

Syntax

Dim variableName As New NotesSession

OR

Set notesSession = New NotesSession

To access the current session from a NotesDatabase object, use the Parent property in NotesDatabase.

To access the current session through COM, see "Creating a session object" and "Initializing a session."  

To access the current session through OLE, see "Using OLE."

Usage

Since there can only be one session per script, the New method always returns the same object each time you call it.

Do not delete session objects.
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Designer

NotesUIWorkspace class DialogBox method autoFit parameters
Clarified the autoHorzFit and autoVertFit parameters with respect to the layout region.

DialogBox method
Brings up a dialog box that displays the current document (either open or selected in a view) or a specified document 
using a form you specify. The dialog box shares fields with the underlying document. The user interacts with the 
dialog box as usual, clicking OK or Cancel when finished.

This function can be used with any form, but it's particularly useful with forms that contain a single layout region or 
table, because the user can interact with the layout region or table as if it were a dialog box.

Defined in
NotesUIWorkspace

Syntax
flag = notesUIWorkspace.DialogBox( form$ [, autoHorzFit [, autoVertFit [, noCancel [, noNewFields [, noFieldUpdate [, 
readOnly [, title$ [, notesDocument [, sizeToTable [, noOkCancel]]]]]]]]]] )

Parameters
form$

String. The name of the form.

autoHorzFit

Boolean. Optional. Specify True if you want to scale the dialog box horizontally to fit the layout region. If you 
specify False or omit this parameter, the dialog box is not scaled horizontally.

autoVertFit

Boolean. Optional. Specify True if you want to scale the dialog box vertically to fit the layout region. If you specify 
False or omit this parameter, the dialog box is not scaled vertically.

noCancel

Boolean. Optional. Specify True if you want to display only an OK button. If you specify False or omit this 
parameter, both OK and Cancel buttons appear.

noNewFields

Boolean. Optional. Specify True if you don't want to add fields (that are on the dialog box form but not on the 
underlying form) to the underlying form. If you specify False or omit this parameter, all dialog box fields are 
passed to the underlying form.

noFieldUpdate

Boolean. Optional. Specify True if you don't want to pass any edits from the dialog box to the underlying form (for 
example, if you're passing the edits somewhere else in a Queryclose script for the dialog box form). If you specify 
False or omit this parameter, the edits are passed to the underlying form.

readOnly

Boolean. Optional. Specify True if you want to prohibit writing to the dialog box (for example, if you are using the 
dialog box to display a help screen). If you specify False or omit this parameter, the dialog box is read-write. This 
option makes noCancel true.

title$

String. Optional. A title for the dialog box. Defaults to "Lotus Notes."

notesDocument

NotesDocument. Optional. A document to be opened instead of the current document.

sizeToTable

Note This parameter is new with Release 5.
Boolean. Optional. Specify True if you want to scale a table to fit into the dialog box. If you specify False or omit 
this parameter, the table is not scaled to fit the dialog box.
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noOkCancel

Note This parameter is new with Release 5.
Boolean. Optional. Specify True if you do not want to display the OK and Cancel buttons. If you specify False or 
omit this parameter, both OK and Cancel buttons appear. This parameter is dependent upon the noCancel 
parameter. If the noCancel parameter is False, the noOkCancel parameter is ignored.

Return value
flag

Boolean. Returns True if the user clicks OK in the dialog box. Returns False if the user clicks Cancel.

Usage
autoHorzFit and autoVertFit allow you to display an entire layout region in a dialog box, without displaying the rest of 
the form. If there is more than one layout region on a form, only the first one is displayed. For best results:

Use both parameters.l
In the layout region InfoBox, deselect Display Border and select 3D style.l

Sharing of field values
This method displays the current or specified document using a different form. This means:

If the form has field names in common with the document, the field values of the document are displayed in the l
dialog box.
If the user changes the value of any fields in the dialog box and clicks OK, the changes are reflected in the same l
fields on the document.
If the user enters a value for a field in the dialog box, and the document does not contain a field by that name, the l
value is added to the document, even if it is not displayed in the form, unless noNewFields is True.

Designer

NotesView FTSearch method usage
The behavior of the method depending on the full-text indexing property has been added to the Usage section.

FTSearch method
Conducts a full-text search on all documents in a view and filters the view so it represents only those documents that 
match the full-text query. This method does not find word variants.

Defined in
NotesView

Syntax
numDocs& = notesView.FTSearch( query$, maxDocs% )

Parameter
query$

String. The full-text query. See below.

maxDocs%

Integer. The maximum number of documents you want returned from the search. If you want to receive all 
documents that match the query, specify 0.

Return value
numDocs&

Long. The number of documents in the view after the search. Each of these documents matches the query$.

Usage
After calling FTSearch, you can use the regular NotesView methods to navigate the result, which is a subset of the 
documents in the view. If the database is not full-text indexed, the documents in the subset are in the same order as 
they are in the original view. However, if the database is full-text indexed, the documents in the subset are sorted into 
descending order of relevance. GetFirstDocument returns the first document in the subset, GetLastDocument returns 
the last document, and so on.
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Use the Clear method to clear the full-text search filtering. The NotesView methods now navigate to the full set of 
documents in the view.

If the database is not full-text indexed, this method works, but less efficiently. To test for an index, use the IsFTIndexed 
property. To create an index on a local database, use the UpdateFTIndex method.

Query syntax
To search for a word or phrase, enter the word or phrase as is, except that search keywords must be enclosed in 
quotes. Remember to escape quotes if you are inside a literal.

Wildcards, operators, and other syntax are permitted. For the complete syntax rules, see "To find documents using 
operators" in Notes 5 Help.

Managing Domino Databases

Administrator Client, Client, Designer, Server

How privileges are granted to users listed in multiple groups
The following note discusses how privileges are granted to a user listed in more than one group in an ACL. 
This information should be considered as part of the topic "Acceptable names in the ACL" under the 
subheading "Names of groups" in Managing Domino Databases.

NOTE:  If a user is a member of more than one group listed in the ACL, but not explicitly listed in the ACL, 
the user will have the highest level of access granted by any of the groups. The user will also have any 
additional privileges granted to any group in which they are a member -- for example, additional roles and 
any other selected privileges. However, if the user is explicitly listed in the ACL the access level, privileges, 
and roles granted to the individual take precedence over any privileges assigned to the group(s) in which 
that user is a member; group privileges are ignored for that user.

Client, Server

Default CATALOG.NSF includes mail databases
When you run the Catalog task to create a database catalog (CATALOG.NSF) from the CATALOG.NTF template, all 
databases in your organization are listed in the catalog. You can exclude mail databases from the catalog's default 
views by changing the database properties for each mail database. Excluding a database from a catalog's default views 
does not prevent administrators from creating views that display a complete listing of databases on the server.

Note: Because of ACL setting permissions, the Catalog task, and not a client's CATALOG.NTF, should always be used 
to create a database catalog.

Moving to Notes and Domino Release 5

Administrator Client, Server

DUS migration tool changes
Effective Oct. 15, 2000 the Domino Upgrade Services (DUS) migration tools for Novell GroupWise, Netscape 
Messaging, Eudora, OnTime, and Schedule+ are no longer included with Domino.  Please contact your Lotus 
Representative or Lotus Support in order to obtain these tools. 

References to the migration tools for Novell GroupWise, Netscape Messaging, Eudora, OnTime, and Schedule+ in the 
Moving to Notes and Domino Release 5 book are no longer applicable. 
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Server

Full-text indexes larger in R5, smaller in 5.0.5
R5 full-text indexes have been larger than R4 indexes, sometimes by as much as 50 percent. 
This has mainly been due to a problem with indexing too many attachment types that was 
resolved in QMR 5.0.5.

R5 index size can now be reduced by upgrading to 5.0.5, which incorporates a Unicode version of the internal GTR 
(Global Text Retrieval) engine. This version of the engine was actually incorporated into QMR 5.0.3, but not as the 
default search engine. Customers upgrading to 5.0.3 and 5.0.4 could elect to turn the new engine on with a 
NOTES.INI setting (see the" Domain Search and the Summarizer - additional information" Release Note on the 
Summarizer). The disk space advantage of the Unicode engine is achieved by combining terms from all code pages 
(languages) into a central lexicon. The 5.0.5 implementation of the engine has the added advantage of indexing only 
appropriate (non-binary) attachment types.

As in R4, the size of a full-text index in R5 and R5.x is related to the size of data, not database 
size. A small database with a lot of text can generate a larger index than a large database 
with a lot of design elements. In R4, a full-text index typically was 50 to 80 percent of the size 
of the data in the database. In R5, the size of the index increased to 75 to 120 percent of the 
size of the data. In QMR 5.0.5, index size decreases to roughly the same size as in R4.

We recommend that all customers concerned with index size upgrade to QMR 5.0.5.

If you want to reduce the size of your indexes even further, you can turn off attachment 
indexing by setting the NOTES.INI variable Ft_Index_Attachments to 2.

Client, Server

To keep track of replicas in R5, use the Domain Catalog
R4 database managers accustomed to using the database catalog to learn where replicas of their databases are need 
to use the Domain Catalog for this purpose in R5.

Starting in 5.0.3, the Domain Catalog can be built and used as an administrative tool regardless of whether an 
organization implements the Domain Search feature. To build the Domain Catalog, enable the Catalog task on a server 
by using the Server Tasks - Domain Catalog tab of the server document. 
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Chapter 5 - Interoperability

Client interoperability

Administrator Client, Client, Designer

Cannot use R5 to open R4 database on read-only media
When you open an R4 database, R5 clients rebuild views so the database can be properly opened in R5. In order to 
rebuild the views, R5 needs write access to the media storing the R4 database. If the R4 database is stored on 
read-only media, such as a CD-ROM, R5 cannot rebuild the views and cannot open the database. You must copy the 
R4 database to read-write media, such as your hard drive.  If the database is set to 'read only' at the file system level, 
you must also reset the read attribute of the file to 'read-write' using the operating system file management system.

An example of this is the README.NSF file supplied on the root of R5 installation CD-ROMs. It is an R4 database; you 
can use an R4 client to open the database directly from the CD-ROM. If you want to open it using an R5 client, you 
must copy it from the CD-ROM to a hard drive and ensure the file is set to read-write access.

Designer

Case and accent sensitive sorting in view columns
In R4, the view column properties "Case sensitive sorting" and "Accent sensitive sorting" meant if two strings were the 
same without regard to case or accent, then the case and accent would be used to try to differentiate them. This 
meant that most of the time, case and accent-sensitive sorting was not used.

In R5, the two properties mean to sort with regard to case and accent all the time. This is fundamentally different than 
it was in R4. For this reason, an R4 database converted to R5 defaults to not having the properties selected.

Client, Designer

Do not start Notes R4.6 with Designer R5 still active
It is not recommended to start the Notes R4.6 client if the Domino Designer R5 client is still active. Close Designer R5 
before starting the R4.6 client.

Client

Notes 4.x cannot open a Notes R5 mail or calendar file
Earlier versions of the Notes client cannot open a Notes R5 mail or calendar file.

Client, Designer

R5 embedded elements lost if form design saved in R4
In R5, you can embed an Outline, Date Picker, or Group Scheduling Control in a form. If you then edit and save this 
form in R4.x, the embedded elements are no longer displayed. The new elements in R5 can't be correctly saved in R4 
because R4 treats hotspots differently than R5. You can click where they were to select them and get the embedded 
element properties box, but they never display, either in form design or document, even after re-saving in R5. You 
need to delete and re-add the elements in R5.
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Client

Server-based password checking with mixed R4/R5 clients
If a single user uses both R4 and R5 clients with Domino servers that have "Check Passwords on Notes IDs" enabled, 
there may be problems when that user changes passwords. In particular, a password set on an ID file using R4 will not 
match the same password set on an ID file using R5, and the user is likely to get error messages of the form "Your 
password does not match the one stored in your entry in the server's Address Book." The workaround is to copy the 
user's ID file from the client where authentication is successful to the clients where it fails.

Client

Sharing ID Files between R5 and R3
ID files are fully backwards and forwards compatible between R4 and R5. There are, however, certain R4 and R5 
operations that render an ID file unreadable by R3 clients. The new operations in R5 are:

Adding recovery information so that the ID file can be recovered even if the user forgets the passwordl

Adding Internet X.509 certificates to the ID filel

If either of these operations is required for a user who still uses R3, a separate copy of the ID file should be kept for 
that purpose and that copy of the ID file should never be used with an R5 client.

Client

Using private views
During R5 installation, desktop information migrates to the DESKTOP5.DSK and BOOKMARK.NSF files. Private view 
information is stored in these files, which means that R5 is storing private view information in a different file than in 
R4. For most situations, this presents no difficulties. However, if you are switching between using R4 and R5 clients, 
note that private folders you create in a database with the R4 client may not be visible when you look at the same 
database with an R5 client.

The workaround for this is to delete your R5 DESKTOP5.DSK and BOOKMARK.NSF files and allow the R5 client to 
rebuild them from the R4 client files. This enables you to see private views created with the R4 client.  This 
workaround should be used carefully, because using it causes you to lose all R5 private views and all custom 
bookmarks.

Designer interoperability

Designer

Compatibility between R4 and R5 Designer
Once you begin using R5 Designer with a database, you must continue to use R5 Designer. If you later use the R4 
Designer with the database, your changes may not be visible to all users. For example, if you save a form using R5 
Designer, any subsequent changes to actions using R4 Designer will not be visible to R5 clients.

Designer

R5 formula agents not compatible with R3
Any formula agent created, enabled or disabled by R5 is not compatible with R3 servers.
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Mail interoperability

Client

Switching from Prefers MIME
If, after using the "Prefers MIME" setting for some time and switching to "No Preference" or "Prefers Notes Rich Text," 
any attachments that were stored while receiving messages in the "Prefers MIME" mode are only readable from R5 
clients and not R4 clients. In R4 clients, the attachments do not launch and if detached, they will be in Base64 
(encoded) form.

Server

Upgrade R4.6 LDAP servers to R5
An R4.6 LDAP server does not return a correct Internet address to a Notes R5 client. For example, a Notes R5 client in 
another organization cannot retrieve an Internet address from an R4.6 LDAP server in your organization.  If you want 
this capability, upgrade all R4.6 LDAP servers to R4.63 or R5.

Server

Webmail file attachment failure now addressed in R5.0.1a
In R5.0 and R5.0.1, there is a problem using Webmail to send attachments to Internet users. The mail is received 
without the attachments. This problem is addressed in R5.0.1a.  Sites with multiple servers should upgrade all 
relevant servers to R5.0.1a to avoid this issue.

Note:  There was never a problem with using Webmail to send attachments to Notes users, only Internet mail users.

Client

Mail "design upgrade" agent now available
The design for user created folders and views in mail files prior to R5 did not allow for 4-digit years in date columns. 
Users now have the ability to upgrade the design of any such folders or views to be consistent with R5 created folders 
and views. To do this, the user should follow these directions:

Go to the private folder or view, and choose Actions->Upgrade this folder or view to R5 design.1.

The user will be prompted to "Replace the design of your folder or view name with the design of ($Inbox)?". 2.
Selecting "Yes" will change the look of the view or folder to be that of the R5 Inbox. 

Please note: Users should NOT use this menu item to change the design of any R5 System folders such as 
Drafts, Sent, All Documents, Archive, Trash, Disussion Threads, Rules, Stationery, Calendar, Meetings, Group 
Calendar or any of the To Do views. 

If the user inadvertently uses the menu item against a system folder or view, the R5 system folder design can be 
retrieved by Replacing the Design of the mail file with the Mail (R5.0) design.

Server

Webmail 5.0.5 interoperability
It is recommended that all sites implementing R5.0.5 Webmail deploy it only on R5.0.5 servers. Deploying on servers 
earlier that R5.0.5 results in reduced functionality to end users. For example, users will not be able to select multiple 
documents in the HTML view. Usage of the R5.0.5 Webmail template on servers before R5.0.3 is not supported.
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Platform and network protocol interoperability

Administrator Client, Client, Designer, Server

Copying certain databases from one platform to another
In R5.0 and R5.01, a database with the large UNK table option enabled cannot be moved from one platform to 
another because of incompatible ODS (On Disk Structure) sizes.  If this type of database is moved, the newly created 
copied database cannot be opened.

This issue has been addressed in R5.0.2. (SPR # MPFM49QLGD)

Server interoperability

Server

Adding R4.6x server in Notes domain with R5 hub server
If you add an R4.6x server to a Notes domain which has an R5 hub server, change the Home URL field on the Internet 
Protocols - HTTP tab of the Server document for the R4.6x server. The default setting for the Home URL field is:

/homepage.nsf?Open

Homepage.nsf is an R5 database. Change the entry in the Home URL field to a URL you want users to see when they 
open the server, such as with a ?OpenServer command, from a browser.

To change the Home URL field

From the Domino Administrator, click the Configuration tab.1.

Expand the Server Configuration section.2.

Click "All Server Documents." 3.

Double-click the Server document for the server for which you want to change the Home URL field.4.

Click Edit Server. 5.

Click the Internet Protocols - HTTP tab.6.

Under the Mapping section, enter the Web page or database that users should see when they access the server 7.
with a browser.

Click Save and Close.8.

If you set the Home URL field to:

 /?Open
or
/?OpenServer

to allow users to see a list of the databases on the server, you must also do the following:

From the Domino Administrator, click the Configuration tab.1.

Expand the Server Configuration section.2.

Click "All Server Documents." 3.

Double-click the Server document for the server for which you want to change the Home URL field.4.

Click Edit Server. 5.
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Click the Internet Protocols - HTTP tab.6.

Select Yes for the field "Allow HTTP clients to browse databases."7.

Click Save and Close.8.

If you do not make this change, Web clients try to browse the list of databases, but get an error because they are not 
authorized to do so. In R4.6x, the default setting for "Allow HTTP clients to browse databases" is Yes. In R5, the default 
setting is No.

Server

Cluster Replicator and the Public Directory Profile
If you run a R4.63a, or lower, server in the same domain as an R5 server and there is a cluster in the domain, the 
Cluster Replicator removes entries in the Public Directory Profile. To prevent this, the following enhancement was 
added to R4.6.3b:

SPR# SALR3Y8NZH - Fix a problem with profile documents not being replicated via the cluster replicator.

R4.6.3b will be a required minimum for cluster replication with R5 Domino servers.

Server

Error message using LDAP 4.6x server for authentication
If you set up an LDAP directory assistance document on a Domino Web server so that the server uses names and 
passwords in a Public Address Book on a Domino 4.6 LDAP server, authentication fails if Web users provide a 
distinguished name with two cn components-- for example, "cn=qa/cn=recipients/ou=acmeqa/o=acme." The server 
logs this error message: 

Failed search on LDAP Server   xxxxxx(server name).com  Reason:  Insufficient 
access.

Server

Free time information not always removed in mixed clusters
The new R5 Schedule Manager does not flush a user's free time information if their home server is a cluster mate. It 
incorrectly assumes that all cluster mates are R5 servers. However, this is not always true because Notes clustering is 
available in R4.x, which does not have clustered free time information.

For example, a user on Server A (R5) moves to Server B (R4.64). Server A does not flush the user's free time 
information and as a result, all other R5 cluster mates have old or inaccurate information. Since Server B is pre-R5, it 
does not handle clustered free time information and does not maintain the information used by Server A.

To solve this, the administrator should delete the user's entry in the CLUBUSY.NSF database.

This is not an issue with R5 servers that are not clustered; the free time system works with R4.x.

Client, Server

Interoperability issues in a mixed cluster
If you are using clusters that contain some Domino R5 servers and some Domino R4.x servers, keep the following in 
mind when you set up mail databases:

The R5 mail template does not work properly on R4.x servers. If a user has a R5 mail database, do not create a l
replica on a R4.x server.

Because the cluster replicator always replicates the template design between replicas, the user's mail replicas l
should use only the R5 mail template or only the R4.x mail template.
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In addition, users see and experience the following things differently when they fail over between Domino R5 servers 
and Domino R4.x servers:

Documents that you receive in MIME are converted to Notes CD records on R4.x servers, so they look different l
than on R5 servers. R5 servers display these documents in native MIME. 

Documents that you send in MIME are converted to CD records when you send them from R4.x servers, so they l
look different than MIME messages you send from R5 servers. In addition, the original MIME version is attached 
to the message on a R4.x server. This is not necessary on a R5 server because the message is sent in native 
MIME.

Encrypted S/MIME documents can be decrypted by R5 servers but not by R4.x servers. When an R4.x server l
receives such a document, whether because of cluster failover or replication, the content of the document is 
replaced a warning stating that the document was encrypted with an Internet certificate and cannot be read.

Server

R4.6 LDAP servers and R5 Domino Directory
Prior to R4.6.3, LDAP servers on R4.6 were unable to serve correct e-mail addresses when the Public Address Book 
was upgraded to the R5 Domino Directory. This problem was corrected in R4.6.3 and above (SPR# BAKH3Z9QW3).

Server

Web Server Access option and LDAP 4.6x servers
Do not choose the Web Server Access option "Fewer name variations with higher security" on a Web server that has an 
LDAP Directory Assistance document for a Domino LDAP 4.6x Server. This option produces a filter that uses "uid" and 
this attribute is not recognized by the 4.6x server.

Server

Quickplace version may be incompatible with Domino
The following QuickPlace R3 versions are compatible with Domino R5.

QuickPlace Release Works as an overlay on top of 
Domino Release

3.0.1 5.0.12
3.0 5.0.10
NOTE: There is no QuickPlace release that is compatible with Domino 5.0.11, or Domino 5.0.13.

The following QuickPlace R2 versions are compatible with Domino R5.

QuickPlace Release Works as an overlay on top of 
Domino Release

N/A 5.0.9
2.0.8 5.0.8
2.0.7 5.0.7 or 5.0.7a
2.0.6a 5.0.6a
2.0.5 5.0.5
2.0 5.0.4

NOTE: There is no QuickPlace release 2.0.9 that runs with Domino 5.0.9.

Server

Recommendations for upgrading an ICM cluster
Because of programmatic changes in name encoding and decoding, Lotus recommends you upgrade an entire 
Internet Cluster Manager (ICM) cluster to 5.0.4 at one time. Note that a pre-5.0.4 Domino server will not recognize 
some name encodings made by R5.0.4 (and later) servers.

If you use the OpenCluster command you should upgrade all of the cluster members, then the ICM server itself.
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Template interoperability

Client, Designer, Server

General template interoperability
This table lists those templates that can be installed in Notes, Domino Designer, the Domino Administrator, and 
Domino for R5. The third column indicates if the template can be used by R4.6x clients in a mixed environment. 

Notes

Template file name Template title R4.6x client support

 ALOG4.NTF Agent Log Yes

 ARCHLG50.NTF Archive Log (R5.0) Yes (altered appearance)

 BOOKMARK.NTF Bookmarks
(Desktop is converted to Bookmarks)

No

 BUSYTIME.NTF Local free time info Yes

 CACHE.NTF Local Document Cache Not applicable

 DBLIB4.NTF Database Library  Yes

 DECSADM.NTF DECS R5 Administrator Template Partial

 DOCLBM50.NTF Microsoft Office Library (R5.0) Yes

 DOCLBW50.NTF Doc Library - Notes & Web (R5.0) Yes

 DSGNSYN.NTF Design Synopsis Template No

 HEADLINE.NTF Subscriptions No

 IMAPCL5.NTF Mail (IMAP) No

 JOURNAL5.NTF Personal Journal (R5) No

 LOG.NTF Notes Log Yes

 MAIL50.NTF Mail (R5.0) No

 MAILBOX.NTF Mail Router Mailbox (5.0) Yes

 NNTPCL5.NTF News Articles (NNTP) No

 PERNAMES.NTF Personal Address Book Yes (altered appearance)

 PERWEB50.NTF Personal Web Navigator (R5.0) Yes

 R63MAIL.NTF DLL that facilitates the upgrade of cc:Mail users to 
Notes

Yes

  SS9DOCLB.NTF  SmartSuite Document Library  No
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Domino Designer

Template file name Template title R4.6x client support

 ALOG4.NTF Agent Log Yes

 ARCHLG50.NTF Archive Log (R5.0) Yes (altered appearance)

 BOOKMARK.NTF Bookmarks
(Desktop is converted to Bookmarks)

No

 BUSYTIME.NTF Local free time info Yes

 CACHE.NTF Local Document Cache not applicable

 CLUSTA4.NTF Cluster Analysis Yes

 DBA4.NTF Database Analysis Yes (altered appearance)

 DBLIB4.NTF Database Library Yes

 DECOMSRV.NTF Decommission Server Reports Yes (altered appearance)

 DECSADM.NTF DECS R5 Administrator Template Partial

 DOCLBM50.NTF Microsoft Office Library (R5.0) Yes

 DOCLBW50.NTF Doc Library - Notes & Web (R5.0) Yes

 DOMADMIN.NTF Domino Administrator (R5) No

 DSGNSYN.NTF Design Synopsis Template No

 EVENTS4.NTF Statistics and Events Yes (altered appearance)

 HEADLINE.NTF Subscriptions No

 IMAPCL5.NTF Mail (IMAP) No

 JOURNAL5.NTF Personal Journal (R5) No

 LOGA4.NTF Notes Log Analysis Yes (altered appearance)

 LOG.NTF Notes Log Yes

 MAIL50.NTF Mail (R5.0) No

 MAILBOX.NTF Mail Router Mailbox (5.0) No

 NNTPCL5.NTF News Articles (NNTP) No

 NTSYNC45.NTF NT/Migrating Users' Passwords Yes

 PERNAMES.NTF Personal Address Book Yes (altered appearance)

 PERWEB50.NTF Personal Web Navigator (R5.0) Yes

 R63MAIL.NTF DLL that facilitates the upgrade of cc:Mail users to 
Notes

Yes

 STATREP5.NTF Statistics Reporting 5.0 Yes

  SS9DOCLB.NTF  SmartSuite Document Library  No

 USERREG.NTF User Registration Queue No
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Domino Administrator

Template file name Template title R4.6x client support

 ADMIN4.NTF Administration Requests (R5.0) Yes (altered appearance) 

 ALOG4.NTF Agent Log Yes

 ARCHLG50.NTF Archive Log (R5.0) Yes (altered appearance) 

 BILLING.NTF Billing Yes

 BOOKMARK.NTF Bookmarks
(Desktop is converted to Bookmarks)

No

 BUSYTIME.NTF Local free time info Yes

 CACHE.NTF Local Document Cache Not applicable

 CATALOG.NTF Catalog (5.0) Yes (altered appearance) 

 CCA50.NTF Domino R5 Certificate Authority Yes

 CERTLOG.NTF Certification Log Yes

 CLDBDIR4.NTF Cluster Directory (R5) Yes (altered appearance) 

 CLUSTA4.NTF Cluster Analysis Yes

 CSRV50.NTF Server Certificate Admin No

 DA50.NTF Directory Assistance Yes (altered appearance) 

 DBA4.NTF Database Analysis Yes (altered appearance) 

 DECOMSRV.NTF Decommission Server Reports Yes (altered appearance) 

 DECSADM.NTF DECS R5 Administrator Template Partial

 DIRCAT5.NTF Directory Catalog No

 DISCSW50.NTF Discussion - Notes & Web (R5.0) No

 DOMADMIN.NTF Domino Administrator (R5) No

 DOMCFG.NTF Domino Web Server Configuration Yes

 DOMLOG.NTF Domino Web Server Log Yes

 DSGNSYN.NTF Design Synopsis Template No

 DSPA.NTF Server.Planner: Analyst Yes

 DSPD.NTF Server.Planner: Decision Maker Yes

 DSPV.NTF Server.Planner: Vendor Yes

 EVENTS4.NTF Statistics and Events Yes (altered appearance) 

 HEADLINE.NTF Subscriptions No

 IMAPCL5.NTF Mail (IMAP) No

 JOURNAL5.NTF Personal Journal (R5) No

 LOGA4.NTF Notes Log Analysis  Yes (altered appearance) 

 LOG.NTF Notes Log Yes
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Template file name Template title R4.6x client support

 MAIL50.NTF Mail (R5.0) No

 MAILBOX.NTF Mail Router Mailbox (5.0) Yes

 MAILLIST.NTF Mailing List (5.0) Yes

 MTSTORE.NTF Domino MailTracker Store No

 NNTPCL5.NTF News Articles (NNTP) No

 NNTPDI50.NTF NNTP Discussion (R5.0) Yes

 NNTPPOST.NTF NNTP Cross-Post Not applicable

 NTSYNC45.NTF NT/Migrating Users' Passwords Yes

 PERNAMES.NTF Personal Address Book Yes (altered appearance) 

 PERWEB50.NTF Personal Web Navigator (R5.0) Yes

 PUBNAMES.NTF Domino Directory Yes (altered appearance) 

 PUBWEB50.NTF Server Web Navigator (R5.0) Yes

 REPORTS.NTF Reports Yes

 RESRC50.NTF Resource Reservations (5.0) Yes

 SIREGW50.NTF Site Registration 5.0 Yes

  SS9DOCLB.NTF  SmartSuite Document Library  No

 STATREP5.NTF Statistics Reporting 5.0 Yes

 TEAMRM50.NTF TeamRoom (5.0) No

 USERREG.NTF User Registration Queue No

 WEBADMIN.NTF Domino Web Administrator No

Domino Enterprise Server

Template file name Template title R4.6x client support

 ADMIN4.NTF Administration Requests (R5.0) Yes (altered appearance)

 ALOG4.NTF Agent Log Yes

 ARCHLG50.NTF Archive Log (R5.0) Yes (altered appearance)

 BILLING.NTF Billing Yes

 BOOKMARK.NTF Bookmarks
(Desktop is converted to Bookmarks)

No

 BUSYTIME.NTF Local free time info Yes

 CACHE.NTF Local Document Cache Not applicable

 CATALOG.NTF Catalog (5.0) Yes (altered appearance)
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Template file name Template title R4.6x client support

 CCA50.NTF Domino R5 Certificate Authority Yes

 CERTLOG.NTF Certification Log Yes

 CLDBDIR4.NTF Cluster Directory (R5) Yes (altered appearance)

 CLUSTA4.NTF Cluster Analysis Yes

 CSRV50.NTF Server Certificate Admin No

 DA50.NTF Directory Assistance Yes (altered appearance)

 DBA4.NTF Database Analysis Yes (altered appearance)

 DBLIB4.NTF Database Library Yes

 DECOMSRV.NTF Decommission Server Reports Yes (altered appearance)

 DECSADM.NTF DECS R5 Administrator Template Partial

 DIRCAT5.NTF Directory Catalog No

 DISCSW50.NTF Discussion - Notes & Web (R5.0) No

 DOCLBM50.NTF Microsoft Office Library (R5.0) Yes

 DOCLBW50.NTF Doc Library - Notes & Web (R5.0) Yes

 DOMADMIN.NTF Domino Administrator (R5) No

 DOMCFG.NTF Domino Web Server Configuration  Yes

 DOMLOG.NTF Domino Web Server Log Yes

 DSGNSYN.NTF Design Synopsis Template No

 DSPA.NTF Server.Planner: Analyst Yes

 DSPD.NTF Server.Planner: Decision Maker Yes

 DSPV.NTF Server.Planner: Vendor Yes

 EVENTS4.NTF Statistics and Events Yes (altered appearance)

 HEADLINE.NTF Subscriptions No

 IMAPCL5.NTF Mail (IMAP) No

 JOURNAL5.NTF Personal Journal (R5) No

 LOGA4.NTF Notes Log Analysis Yes (altered appearance)

 LOG.NTF Notes Log Yes

 MAIL50.NTF Mail (R5.0) No

 MAILBOX.NTF Mail Router Mailbox (5.0) Yes

 MAILLIST.NTF Mailing List (5.0) Yes

 MTSTORE.NTF Domino MailTracker Store No

 NNTPCL5.NTF News Articles (NNTP) No

 NNTPDI50.NTF NNTP Discussion (R5.0) Yes
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Template file name Template title R4.6x client support

 NNTPPOST.NTF NNTP Cross-Post Not applicable

 NTSYNC45.NTF NT/Migrating Users' Passwords Yes

 PERNAMES.NTF Personal Address Book Yes (altered appearance)

 PERWEB50.NTF Personal Web Navigator (R5.0) Yes

 PUBNAMES.NTF Domino Directory Yes (altered appearance)

 PUBWEB50.NTF Server Web Navigator (R5.0) Yes

 REPORTS.NTF Reports Yes

 RESRC50.NTF Resource Reservations (5.0) Yes

 SIREGW50.NTF Site Registration 5.0 Yes

 SRCHSITE.NTF Search Site Yes

  SS9DOCLB.NTF  SmartSuite Document Library  No

 STATREP5.NTF Statistics Reporting 5.0 Yes

 TEAMRM50.NTF TeamRoom (5.0) No

 USERREG.NTF User Registration Queue No

 WEBADMIN.NTF Domino Web Administrator No

Domino Mail Server

Template file name Template title R4.6x client support

 ADMIN4.NTF Administration Requests (R5.0) Yes (altered appearance)

 ALOG4.NTF Agent Log Yes

 ARCHLG50.NTF Archive Log (R5.0) Yes (altered appearance)

 BILLING.NTF Billing Yes

 BOOKMARK.NTF Bookmarks
(Desktop is converted to Bookmarks)

No

 BUSYTIME.NTF Local free time info Yes

 CACHE.NTF Local Document Cache Not applicable

 CATALOG.NTF Catalog (5.0) Yes (altered appearance)

 CCA50.NTF Domino R5 Certificate Authority Yes

 CERTLOG.NTF Certification Log Yes

 CLDBDIR4.NTF Cluster Directory (R5) Yes (altered appearance)

 CLUSTA4.NTF Cluster Analysis Yes

 CSRV50.NTF Server Certificate Admin No
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Template file name Template title R4.6x client support

 DA50.NTF Directory Assistance Yes (altered appearance)

 DBA4.NTF Database Analysis Yes (altered appearance)

 DBLIB4.NTF Database Library Yes

 DECOMSRV.NTF Decommission Server Reports Yes (altered appearance)

 DECSADM.NTF DECS R5 Administrator Template Partial

 DIRCAT5.NTF Directory Catalog No

 DISCSW50.NTF Discussion - Notes & Web (R5.0) No

 DOCLBM50.NTF Microsoft Office Library (R5.0) Yes

 DOCLBW50.NTF Doc Library - Notes & Web (R5.0) Yes

 DOMADMIN.NTF Domino Administrator (R5) No

 DOMCFG.NTF Domino Web Server Configuration Yes

 DOMLOG.NTF Domino Web Server Log Yes

 DSGNSYN.NTF Design Synopsis Template No

 DSPA.NTF Server.Planner: Analyst Yes

 DSPD.NTF Server.Planner: Decision Maker Yes

 DSPV.NTF Server.Planner: Vendor Yes

 EVENTS4.NTF Statistics and Events Yes (altered appearance)

 HEADLINE.NTF Subscriptions No

 IMAPCL5.NTF Mail (IMAP) No

 JOURNAL5.NTF Personal Journal (R5) No

 LOGA4.NTF Notes Log Analysis Yes (altered appearance)

 LOG.NTF Notes Log Yes

 MAIL50.NTF Mail (R5.0) No

 MAILBOX.NTF Mail Router Mailbox (5.0) Yes

 MAILLIST.NTF Mailing List (5.0) Yes

 MTSTORE.NTF Domino MailTracker Store No

 NNTPCL5.NTF News Articles (NNTP) No

 NNTPDI50.NTF NNTP Discussion (R5.0) Yes

 NNTPPOST.NTF NNTP Cross-Post Not applicable

 NTSYNC45.NTF NT/Migrating Users' Passwords Yes

 PERNAMES.NTF Personal Address Book Yes (altered appearance)

 PERWEB50.NTF Personal Web Navigator (R5.0) Yes

 PUBNAMES.NTF Domino Directory Yes (altered appearance)

295



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 5 - Interoperability

Template file name Template title R4.6x client support

 PUBWEB50.NTF Server Web Navigator (R5.0) Yes

 REPORTS.NTF Reports Yes

 RESRC50.NTF Resource Reservations (5.0) Yes

 SIREGW50.NTF Site Registration 5.0 Yes

 SRCHSITE.NTF Search Site Yes

  SS9DOCLB.NTF  SmartSuite Document Library  No

 STATREP5.NTF Statistics Reporting 5.0 Yes

 TEAMRM50.NTF TeamRoom (5.0) No

 USERREG.NTF User Registration Queue No

 WEBADMIN.NTF Domino Web Administrator No

Server

Server.Planner templates replication error
When replicating any of the Server.Planner templates (DSPA.NTF, DSPV.NTF, DSPD.NTF) from an R4.6x server to an 
R5 server, a message similar to the following may appear:

Unable to store document in dspa.ntf (NoteID = 326) from
toshi/46x dspa.ntf (NoteID = 322): Field is too large (32K) or View's column &
selection formulas are too large

To avoid this message, the templates should be deleted from the R4.6.x server and replicated from the R5 server.

Administrator Client, Client, Designer, Server

R4.6 and R4.5 enhancements made for R5 interoperability

R4.6.4

Template - Mail file

SPR# FGRN3YFSN3 - Fixed a problem with receiving an erroneous error message (Object variable not set) when 
receiving a reschedule notice for a repeating meeting from an R5 user without having first accepted the parent. [4.6.4, 
4.6.3b]

Template - Web Mail file

SPR# FGRN3WPHWF, FGRN3ZJQCT - Replace the RSVP button with the Accept button on Calendar entries for 
repeating meetings received by Web users from R5 users. When using the RSVP button (which is invalid for Web 
users), the error "Original invitation document not found (wNoticeOpen)" appeared. [4.6.4,4.6.3b]

R4.6.3b

Template - Mail file

SPR# FGRN3YFSN3 - Fixed a problem with receiving an erroneous error message (Object variable not set) when 
receiving a reschedule notice for a repeating meeting from an R5 user without having first accepted the parent.
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SPR# FGRN3ZJQCT - Correct a problem with the first instance of a repeating meeting having no date and time saved 
when a new date and time are proposed by an R5 user.

SPR# FGRN3WPHWF, FGRN3ZJQCT, FGRN3Z8HSR - Replace the RSVP button with the Accept button on Calendar 
entries for repeating meetings received by Web users from R5 users. When using the RSVP button (which is invalid for 
Web users), the error "Original invitation document not found (wNoticeOpen)" appeared.

R4.6.3

Templates

SPR# RJAN3WCLSH - Provides compatibility with R5 for repeating meetings in all of the mail templates and in the 
Resources Reservations template. [4.6.3]

R4.5.7

Templates

SPR# RJAN3WCLSH - Provides compatibility for future feature releases for repeating meetings in all of the mail 
templates and in the Resources Reservations template. [4.6.3,4.5.7]

Client, Designer

Replacing Document Library design with R4.6 or R5 design
When replacing a R4 document library design with either of the following templates:

Doc Library - Notes & Web (R4.6)l
Doc Library - Notes & Web (R5.0) l

...run the "Upgrade Doclib R4 Documents to New Design" agent against the database before opening the converted 
documents. The agent appears in the Action menu of the R4.6 and R5 Doc Library templates. If the agent has not 
been run, the error message "Incorrect datatype for operator or @function" appears when attempting to open the 
converted documents. Also, statuses will not appear correctly in the views unless the agent has been run.
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Chapter 6 - History of changes

Administrator Client, Client, Designer, Server

Overview - New Features and Enhancements
A cumulative list of all fixes announced via previous R5 Release Notes can be found in the online Release Notes 
README.NSF database that ships with each new release of the Lotus Notes and Lotus Domino products.  Features and 
enhancements newly introduced in previous R5 releases (such as Release 5.0a) are available in the History of Changes 
chapter.  All features and enhancements listed in that chapter for are also carried forward into the current Notes and 
Domino R5 Maintenance Release (MR) unless otherwise stated.

Official Fix Lists of Software Problem Report (SPR) fixes and enhancements are also available at the Lotus Developer 
Domain (LDD) web site.  (These Fix Lists are segregated by product, however, rather than comprehensively presented 
in one location like the fixes reported in the online Release Notes database. The Fix Lists are available on the various 
Incremental Installer pages in the LDD web site "Download" area).

In addition to shipping with the core product, online Release Notes databases containing the comprehensive Fix Lists 
for a release are available for download or live web browser viewing at the Lotus Developer Domain.  The 
Documentation site at there is:  http://www.lotus.com/ldd/doc

Notes/Domino Fix Lists

Beginning with Release 5.0.5, we have introduced the new R5 Web Fix List Application, which will allow you to access 
all of the fix list entries for the 5.0.x codestream on LDD via this new delivery mechanism.  The Release 5.0.5 fix list is 
contained on this new site, along with previous R5.0x fix lists.  You can access the R5 Web Fix List application on LDD 
at http://www-10.lotus.com/ldd/r5fixlist.nsf.  For more detailed information regarding the R5 Web Fix List 
application, refer to the Release Note entitled "R5 Web Fix Lists on Lotus Developer Domain". (NOTE: Fix Lists after 
R5.0.3 are not posted in the Release Notes, as they are also available in the new R5 Web Fix List Application.)

Online Release Notes SPR Tracking View
The sole purpose of this view in the online README.NSF database is to provide a means for finding SPR-related issues 
that happen to be discussed in the Release Notes.  This list is not comprehensive. The presence of an SPR in this view 
does not imply a 'fix' or development action is imminent, nor does the absence of an SPR in this view imply an issue is 
'resolved' or 'no longer under consideration' by Lotus, unless otherwise stated.

Details of feature changes
The documents that directly follow (in the online database, the items in the "Details of feature changes" section of the 
"History of changes" chapter) discuss details of prominent feature changes since the original R5 product release. Not 
all features are discussed in this section. 

The specific revision number in the "History of changes" chapter contain a complete historical listing of feature 
changes, in the "New features and enhancements for R5.0.x". Those documents are grouped according to the release 
in which they were first documented. 

This "Details of feature changes" section gives you a view of all the details of feature changes that went into the product 
since R5 -- without having to sort through each revision number. (In Release Notes before R5.0.10, many of these had 
been in the "Feature changes" section of the "Things you need to know" chapter.)

Refer to the "New Features" section of the "What's new?" chapter for a listing of all new features for this particular 
Maintenance Release.

Administrator Client, Client, Designer, Server

Enhancement reporting - SPR Fix Lists
Please refer to the Notes/Domino Fix Lists for a list of SPR-initiated enhancements in the Notes and Domino products.

The R5 Web Fix List Application was introduced in R5.0.5, allowing you to access all of the fix list entries for the 5.0.x 
codestream on the Lotus Developer Domain (LDD).  Access the R5 Web Fix List application on LDD at 
http://www.lotus.com/ldd/r5fixlist.nsf.  For more detailed information regarding the R5 Web Fix List application, refer 
to the Release Note entitled "R5 Web Fix Lists on Lotus Developer Domain".
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Official Fix Lists of Software Problem Report (SPR) fixes and enhancements for release previous to R5 are also 
available at the LDD web site. The 4.x Fix Lists are available on the relevant Incremental Installer pages of the LDD 
web site "Download" area.  

The Fix Lists that have previously been published in these Release Notes have been removed (reducing the size of 
these Release Notes).

The Fix Lists are also available on the IBM Lotus Support page: http://www-3.ibm.com/software/lotus/support/

You are encouraged to access this information from LDD to be sure you are seeing the most current information.

To locate individual Fix Lists, please follow the following links (to the IBM Lotus Support page):

R5.0a - Lotus Support Document #171868

R5.0.1 - Lotus Support Document #179291

R5.0.1a - Lotus Support Document #173952

R5.0.1b - Lotus Support Document #175264

R5.0.1c - Refer to Notes/Domino Fix List Database

R5.0.2 - Refer to Notes/Domino Fix List Database

R5.0.2a - Refer to Notes/Domino Fix List Database

R5.0.2b - Refer to Notes/Domino Fix List Database

R5.0.2c - Lotus Support Document #178211

R5.0.3 - Refer to Notes/Domino Fix List Database

R5.0.4 - Lotus Support Document #181962

R5.0.4a - Lotus Support Document #181147

R5.0.5 - Lotus Support Document #183002

R5.0.6 - Lotus Support Document #185178

R5.0.6a - Lotus Support Document #185179

R5.0.7 - Lotus Support Document #185173

R5.0.7a - Lotus Support Document #186194

R5.0.8 - Lotus Support Document #186852

R5.0.9 - Lotus Support Document #189795

R5.0.9a - Refer to Notes/Domino Fix List Database

R5.0.10 - Refer to Notes/Domino Fix List Database

Administrator Client, Client, Designer, Server

Release Notes on Lotus Developer Domain
All R5 Release Notes are available on the Lotus Developer Domain, in three forms: PDF, Notes NSF Database, and 
Web-browsable NSF. Please go to http://www-10.lotus.com/ldd/notesua.nsf/RN?OpenView for all three of these 
formats of any of the R5.x Release Notes.

PDF format: Print or view the Release in the searchable Adobe Acrobat PDF version of the Release Notes. (NOTE: ll
The PDF version is created earlier than the NSF version, and may not contain recent changes. For the more 
recent version, always use the Notes Database format).

Notes Database format: You can also download the latest version in Notes Database format (readme.nsf), for ll
later viewing in a Notes client.  This is always the most up-to-date version of the Release Notes available, which 
occasionally contains content not prepared in time for the product install packs.

Notes Database, browsable over the Internet: View the Release Notes online using live web browsing (using any ll
web browser) at the Domino and Notes User Assistance Web site. This is the same Notes Database that is 
described in the second option, available without downloading the actual NSF file.

300



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 6 - History of changes

Release 5.0 - initial release

Administrator Client, Client, Designer, Server

Welcome to Lotus® Notes, Domino, Domino Designer R5.0
Welcome to Release 5 (R5) of Lotus Notes, Domino Server Family and Domino Designer. R5 is the latest version of the 
world's leading products for information management, messaging, collaboration and Web application development. 
The R5 product line, conceived with the qualities and capabilities of the Internet, delivers on the promise of enabling 
users to find, act upon and share information, further improving communication among groups, organizations and 
people everywhere. 

These Release Notes contain information on the many new features and enhancements included in all R5 products.
Before installing R5, please be sure to read the Things You Need To Know and Troubleshooting sections of the 
Release Notes. 

For an overview of the features in this Release, see the What's New? section.

For exhaustive online searches without a full-text index, use the Search view of the online Release Notes (readme.nsf).

If you want detailed information about preparing for a larger deployment of R5, browse or download the book "Moving 
to Notes and Domino Release 5" from the Lotus Developer Domain at http://www.lotus.com/ldd/doc. This book is 
available as part of the Domino Administration help.

Client

What's new in Notes - R5 initial release
Overview

Lotus Notes is an innovative and integrated e-mail and document collaboration client for the Internet. This latest 
release of Notes has been enhanced in a number of ways. Perhaps most significantly, it has been transformed into an 
easier-to-use environment that is customizable and easily personalized, so you can work the way you want to while 
retaining all the power of Notes. You will find that the user experience in Notes R5 is like using a simple Web browser 
that allows you to group links to Web pages, news group discussions, and Notes documents all in one location.

In R5, the power of Notes is combined with the ease of the Internet, with enhancements built on features from previous 
releases such as Portfolios in Notes R4.6. Notes R5 combines Internet-standards support with the features of other 
Lotus products like cc:Mail and Organizer in a single, integrated state-of-the-art e-mail, calendar, group scheduling, 
and Web information management tool. All of this is offered without the requirement of a Domino-based infrastructure. 
These enhancements are reflected in our design goals for Notes R5:

Works with any serverl

Easiest Internet client to usel

Industry-leading applicationsl

Mobile support and ease of deploymentl

Innovation in collaboration -- knowledge managementl

Works with any server

Notes R5 offers full standards support of protocols (Mail: POP3, IMAP4, SMTP; Discussion: NNTP; Directory: LDAP v3) 
and content (MIME, S/MIME, HTML, Native image formats, Java, JavaScript, X.509 certificates). This means that 
users with ISP-hosted mail accounts can use Notes R5 to send, receive, and manage their Internet mail. Notes R5 can 
also access other Web servers, for full-fidelity access to intranet or Web applications.

When you launch Notes R5 for the first time, you are asked whether or not you want to use Notes to access your 
ISP-hosted mail. Notes acquires as much information as it can from the operating environment to set up your client 
for access to that mail account. Multiple accounts can be set within one location so that multiple mail accounts can 
be securely handled without changing Notes locations. With a universal inbox and support for native Web formats, 
Internet mail content has full fidelity.
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Features include:

POP3 and IMAP4 support -- Since R4.6, Notes has been a POP3 client. Notes R5 is also a full-function IMAP4 ll
client. POP3 mail can be pulled directly into the user's mail file. IMAP support is managed through a separate 
mail template and an IMAP account document in the Personal Address Book.

Native MIME support -- MIME (Multipurpose Internet Mail Extension) is the standard message format for Internet ll
mail. This IETF-standard specification describes the format and rules for constructing messages that contain one 
or more parts. For example, MIME allows you to send a mail item that could include one or more graphical 
images. The MIME specifications implemented by R5 include all of the base MIME specs and many of the 
extensions. R5 supports, for example, an HTML-based editor for generating rich mail content. HTML pages can 
have complex content such as interrelated URLs. No conversion is required and users maintain full message 
fidelity. By implementing this standard, R5 Notes delivers the richest highest fidelity Internet mail content 
possible.

S/MIME support -- For years, Notes has delivered a superior Public Key Infrastructure (PKI) very much like that ll
provided by S/MIME security. Thus S/MIME extends Notes' native security to include secure messaging to 
non-Notes mail recipients.

Fully-integrated X.509 certificates -- X.509 is the open-standard certificate format for inter-application ll
authentication. Notes users can now take advantage of either the traditional Notes certificates or X.509 v3 
certificates. 

LDAP support -- The Notes client has full support for LDAP. Any address lookup can be done using LDAP so a ll
user can address e-mail using any of the external, public LDAP directories. In addition, local address books can 
be accessed via LDAP queries. 

Native address support -- In Notes R5, standards-based Internet addresses are treated as a parallel native ll
address form. This means that Notes R5 users can address mail using either the Internet address format and/or 
the Notes hierarchical address format, and that both the Internet and Notes hierarchical address of senders and 
recipients is included in an R5 mail message.

Easiest Internet client to use

Our goal for Notes R5 was to create an environment that increases productivity by providing one consistent 
environment for access to all of the sources of information you need to do your job. Unlike some competing products, 
Notes R5 is not a bundle of products; it stands alone as we deliver the tightest-integrated Internet client in the 
industry, enabling customers to benefit from the combination of the best features in one seamless, easy-to-use mail, 
calendar, and Web client. 

The key new productivity features in R5 include:

The Welcome page -- Notes R5 introduces the concept of a Welcome page -- the first page you see when you ll
start the client. The default welcome page for the client is a basic page that has a simple, easy-to-learn user 
interface to allow users to access mail, a calendar, and their personal contacts. You can change the Welcome 
page to one of the styles that is provided by the client, or you can customize your own Welcome page. One type 
of Welcome page is called a headlines page.

The Headlines page -- This provides a user-customizable environment to navigate, filter, access and act on ll
information, regardless of where that information originates: your inbox, a Web site, or a newsgroup. For 
example, you may filter all e-mail from your manager, monitor competitors' Web sites, and view a list of 
important meetings and urgent tasks for the day, all from the Headlines page. In addition, tracking other Web 
information such as stock prices or competitive sites can easily be set up and monitored right from this 
personalized page.  Starting off your day with the right information in front of you at the right time makes you 
more productive from the moment you start Notes.

Subscriptions -- The ability to monitor Domino databases for documents that match your specific criteria is an ll
major innovation in R5. You can create any number of subscriptions to Domino databases using a simple profile 
form for each database. Once you've created these subscriptions, summary results are displayed in the headlines 
page.

The Navigation Bar -- This contains tools very similar to the "forward" and "back" buttons to which many browser ll
users are accustomed. Now navigating through the barrage of daily incoming information is easy with the 
intuitive forward and back buttons. In addition, there is a stop and refresh button (which works to refresh all 
applications including mail), a search button and the ability to enter a URL address to invoke Web browsing in 
Notes. 
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Bookmark Bar with Bookmark buttons -- Using these buttons, you can access core Notes applications like mail ll
and calendar that were previously located on the R4 Notes desktop. These new Notes R5 Bookmark buttons and 
folders allow you to create links to a wide variety of information -- a view of your inbox a calendar entry, a favorite 
Web site, or other documents -- whether they are part of a Domino application or from some other source. The 
Bookmark bar is set up to provide instant access to your core applications -- mail, calendar, tasks, and contacts. 
The folders below are places for you to add your own Bookmark links to your own information. Use the folders to 
store important links, or drag and drop links to information directly onto the Bookmark bar. 

Window tabs -- This way of working adds to the "Web-like" feel of the Notes R5 client and provides a much richer ll
information management tool than simple browsers can provide. The window tabs appear as each new 
document, Web page, or view is opened for an additional way to navigate through information accessed from the 
Notes client. These window tabs have replaced the Window menu as a more intuitive way of tracking where you 
have been. It's easy to see what window you have previously opened and get back to it quickly by clicking on the 
tab. Because the tabs have text titles to let you know what it is, you can close the windows you don't want open 
without having them as the active window on the desktop. Just click the small "x" to the right of the tab to close 
that window, without losing it in your "history". Hit the "Back" button, and that window re-opens as an indicator of 
where you have been. Create Bookmarks by dragging any open window tab to the Bookmark bar - over a folder, 
or directly onto the bar itself.

HTML editing -- With support for HTML 4, the Notes editor becomes an excellent Web content creation source. ll
With control over things like images and tables, users can instantly create great-looking pages, in full-fidelity 
HTML, with support for native formats such as Animated GIFs and JPEGs.

Enhanced table features -- An enhanced properties box provides access to all these additional controls over l
tables:

Paragraph-like alignment 
Style templates 
"Shadow" effect 
"Stackable" tables 
Recursive tables (tables within tables)
Tabs in tables
Multi-column text (text flows from one column to the next)
Table cell backgrounds
Fixed- and variable-width columns in the same table

Print Preview -- From the print dialog, you now have the option to preview your documents prior to printing.ll

Industry-leading applications

Since Notes R4, we have incorporated more and more cc:Mail features into Notes. We started with folders and a 
three-pane interface. In Notes R5, we have greatly enhanced the overall mail experience, adding even more cc:Mail 
features. Most notably, the new mail application in Notes R5 includes a separate address header in messages, 
type-down addressing, faster type-ahead addressing, an inbox view that can display new messages at the top, and 
simple setup of mail rules. Combining these core pieces of functionality with the Notes document editor and 
standards support, e-mail in Notes R5 is as full-featured as an Internet mail client can be.

We have incorporated many of the enhanced PIM features of Lotus Organizer into the Lotus Notes calendar, 
scheduling, and task management functions. For example, many people who use an electronic calendar product also 
like to print their calendars. Comprehensive printing capabilities in Notes R5 supports multiple print styles. The 
addition of a group calendar view makes it easier than ever for you to stay on top of multiple schedules, and to plan 
your time and work so that individuals and groups are more productive. 

Key new mail features include:

Separation of message header -- Message recipients are now kept in a separate pane from the message body. ll
Now you can scroll through the message while keeping the header information on screen. This is especially 
helpful when a message has many recipients.

Type-ahead addressing -- Performance increases in Notes R5 make this feature easier to use when selecting ll
recipients to address mail messages or initiate workflow applications.

Type-down addressing -- As type-ahead addressing begins to match names in the address dialog, you can use ll
the up and down arrows on your keyboard to cycle through "like" names. This feature works in conjunction with 
the new Mobile Directory Catalog (see below for more details).
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Mail rules -- English language syntax for developing automated tasks with multiple conditions for filtering mail ll
automatically. Multiple actions may also be selected. These Rules are server-based to provide 24x7 processing.

MAPI support -- Notes now registers itself as the default mail application. This allows Notes R5 messaging to be ll
integrated within products such as MS Office and MS Internet Explorer, so that Notes is launched as the mail 
client from these types of applications.

Notes Minder -- This utility loads automatically into the Windows 95/98/NT system tray and informs via flashing ll
icon, sound, or dialog of the arrival of new items. Headers of new messages can also be checked, and Notes can 
be launched if desired. 

Notification of Sent view behavior -- Users are notified that messages deleted from the Sent view will be deleted ll
from every folder as well.

Mail preferences -- Mail preferences include: option for automatic spell check on send, delivery priority, ll
automatic message signature and signature files, message content  options (HTML only,  plain text only, or 
both), message importance, security options, delegation options, and reply separator definition.

Inbox sorting -- A new preference option has been added to allow users to choose to have new mail arrive at ll
either the top or bottom of the Inbox.

Key new calendar and scheduling features include:

Calendar printing -- You can now print your calendar in hard-copy format, in a selection of styles that resemble ll
those in Lotus Organizer, so that you can take your calendar with you.

Group calendar view -- Create a calendar showing multiple colleagues' free and busy time, with the ability to see ll
more information if you have delegation access to their calendars.

Holiday support -- Ability to add holiday sets (geographic and/or religious) to calendar.  ll

Improved invitation form and invitation management -- Invitees as FYI, optional or required. Invitation delivery ll
options such as prevent delegation, prevent counter proposal. You can receive meeting updates after declining 
and add comments when canceling or rescheduling

Resource management -- Resources are an important part of how meetings are scheduled. With the ability to ll
schedule resources across domains and greater access control for resources, you can be sure you'll have 
everything you need for your important meetings.

Enhanced alarm support -- Support sound (such as .WAV files) for alarms. Alarms can now be set for tasks as ll
well as appointments and alarms can be sent to invitees 

Owner actions and participant actions buttons -- Notes exposes all the features required when viewing an ll
appointment from the calendar view to be able to: Send a reminder, cancel a meeting, reschedule a meeting, 
suggest alternate time.

Integrated task management - To do's automatically appear on the calendar and follow you day after day. To ll
do's can also include alarms, be marked as repeating, and marked private. Additionally, there is support for 
group to do's.

Mobile support and ease of deployment

Notes has always offered superior off-line use. Wherever you are, you still have access to and control over a wide 
variety of information. With Notes R5, additional off-line capabilities mean you'll have even greater control over the 
information you're working with and sharing -- whether it's Internet mail or Web pages that can be updated from a site 
to reflect changes when you reconnect.

In addition, mobile enhancements such as the Mobile Directory Catalog -- a single database that contains all of the 
directories in an enterprise -- were created for the road warrior. It contains partial replica information in a compressed 
form, with each user entry measuring about 100 bytes in size, instead of the 10 Kb per user in earlier versions of 
Notes. There is enough data in this compressed "catalog" of directories to yield information about the entire directory 
object if needed, automatically and invisibly to the user. This new directory occupies minimal disk space, so that 
mobile users can easily maintain a copy on their local hard disks.

Specific features include:

Disconnected use -- Off-line browsing and management of mail, Web pages, and News. Simplified mobile ll
configuration and setup. Easier replica management with Bookmarks.

Remote, connected use -- This allows you to use Notes with your existing Internet service provider.ll
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Mobile Directory Catalog -- Storing an optimized local copy of your enterprise directory means fast response ll
time as you access critical information about the people in your company; whether you are connected or not, 
and regardless of how large your organization.

Mobile location enhancements -- Connection documents and Dialup Networking entries are created for new ll
users automatically as they complete the Location document dialog. We now provide end-users with a 
Connection Configuration Wizard to facilitate setting up Remote Access Connection documents. The Wizard can 
configure connections to servers on an Intranet  over Dial-up Networking, to servers on the Internet, or to remote 
Domino servers using Notes Direct Dialup over X.PC.

Native PDA support -- Notes R5 fully supports Personal Digital Assistants to replicate mail, contacts and ll
calendar information.

User input during async script execution -- Notes provide a scripting command, Promptuser, which allows Notes ll
to pop up a password dialog box during a connection call, so that users do not have to re-dial when their 
passwords expire.

Passwords hidden in Connection documents and dial dialogs -- Passwords are now hidden in the Server ll
Connection documents and dial dialog boxes, which provides users with an additional level of security.

Network dial-up Connection document enhancements -- Users can enter area codes, country codes, and calling ll
card numbers in network dial-up connection documents. This leverages the extensive dialing support for network 
dial-up currently available for X.PC.

Innovations in collaboration -- knowledge management

In Notes R5, enhancements such as the Headlines page, Bookmarks, and enhanced search capabilities are examples 
of the knowledge management applications that are possible with Notes and Domino. Some of the new R5 features 
that support analysis and discovery of important information to do your job include:

Headlines -- Headlines does more than just filter out important e-mail. With Headlines, you can personalize the ll
"first look" at your day and be sure you get the information that will keep you most productive throughout the 
day. The ability to subscribe to Domino databases is a key feature that lets users access important, timely 
information.

Search engine and UI changes -- The search icon is always present on toolbar in upper right corner of the ll
screen; the engine is the Global Text Retriever from IBM Japan. The search dialog includes many new 
enhancements, such as Fuzzy search.

Full-text index of file system -- Any file system referenced by the file system configuration form (stored in the ll
domain catalog on Domino server) can be added to the index.

Summarization of search results -- Each document returned can have several sentences displayed describing its ll
contents selected by a special algorithm that finds the most meaningful sentences.

Additional file filters -- R5 indexes the entire document by using Inso filters to translate the attachments into ll
something that can be indexed. Supported formats are Acrobat PDF, Word, WordPerfect, Word Pro, 1-2-3, Excel, 
Freelance, PowerPoint, and HTML.

Server

What's new in Domino - R5 initial release
This release note provides an overview of the new R5 Domino server features.

Internet Messaging

Native Internet addressing -- Domino understands Internet addressing rules and interprets them, along with ll
existing Notes addressing rules.

Native MIME content support -- Message content is now stored as either Notes Rich Text or MIME, and Domino ll
translates between formats as needed. Notes users who choose MIME format require no message translation 
when sending mail to and from Internet users. In a mixed environment of R5 and pre-R5 Notes users, no 
translation is required because the R5 Notes client can render MIME or Notes Rich Text. 
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Native SMTP routing -- The Domino router now implements the SMTP protocol to transport Internet/intranet ll
messages, along with Notes mail routing protocols for compatibility with previous releases. The SMTP MTA, 
which was included in previous releases, is no longer needed. When deploying R5 Domino with R5 clients, 
message conversion between MIME and Notes Rich Text is eliminated at the routing layer because the Notes 
client fully supports MIME.

If configured, both SMTP and Notes mail routing protocols coexist within the same server. The Domino router 
implements the base SMTP standard plus SMTP service extensions (ESMTP) (such as 8BITMIME and SMTP 
PIPELINING) to deliver optimal SMTP performance. In addition, other extensions such as the Delivery Status 
Notifications specifications allow Notes and Domino SMTP to provide message delivery information to the Notes 
client.

Multiple character set support -- When converting between Notes Rich Text and MIME, the Domino mail router ll
can now support all character sets when sending and receiving messages. Previously, several SMTP MTA's were 
required to provide support for multiple character sets.

Security

Better support for Internet-standard X.509 v3 certificates -- Domino allows administrators to register new users ll
with traditional Notes certificates and with Internet-compliant X.509 v3 certificates. Notes clients can use these 
Internet certificates for secure access to Web servers (SSL) and for secure Internet Mail (S/MIME). 

Stronger cryptography -- North American editions of Domino create stronger RSA keys (1024 bits) and stronger ll
RC2 keys (128 bits) for users connecting to Domino via SSL. In addition, North American Notes clients use these 
stronger keys for SSL and S/MIME.

S/MIME -- Notes and Domino support the IETF standard, S/MIME v2, for secure Internet mail encryption and ll
digital signatures. 

SSL v3 for all Internet protocols -- Users accessing the Domino server over any supported Internet protocol can ll
now use SSL (Secure Sockets Layer) v3 for certificate-based authentication and encryption. Supported protocols 
include IIOP, LDAP, HTTP, POP3, IMAP and NNTP. 

Separate key rings for virtual Web servers -- Separate key rings for SSL v3 are supported for each Domino ll
Virtual Web Server. This means that each virtual server can have its own certified identity, and can authenticate 
its users with its own set of certificates.

Password recovery for Notes users -- Recovery agents can log password and ID changes. Administrators and ll
users can recover forgotten passwords, corrupted or lost Notes ID files, and encrypted information.

Just-in-time encryption -- Mobile Notes users who don't keep certificates in their Personal Address Book or don't ll
have certificates in their local Directory Catalog can encrypt e-mail when it is replicated to the server.

Authentication via third-party directory -- Administrators can choose to allow authentication through a trusted ll
third-party directory over LDAP. Domino Directory Assistance enables administrators to specify trusted 
third-party LDAP directories used to look up users and groups for authentication and access control.

Password quality -- To limit password guessing or dictionary attacks, administrators can control the quality of ll
password used to protect the Notes ID. Administrators have a choice of 16 quality levels; the higher the level, the 
more complex and difficult-to-guess the password must be.

Web server authentication interface (included in Domino Server API) -- Through DSAPI, you may now create ll
external programs to authenticate Web users (for example, single sign-on utilities) instead of using Domino's 
authentication mechanism. You can create your own authentication schemes for Domino that leverage external 
systems or special algorithms. 

Domino Directory

Domino Directory -- Previously called the Name & Address Book or Public Address Book, the Domino Directory ll
is the directory service within Domino.

Improved performance, scalability and reliability --The Domino Directory uses Domino database technology, ll
and benefits from the Domino R5 improvements in this core technology. These benefits include transaction 
logging, online and in-place compaction, and faster online view re-indexing. In addition, specific performance 
enhancements have been made for the Domino Directory in R5.

LDAP v3 support -- Complete support for the IETF-standard Lightweight Directory Access Protocol (LDAP) ll
version 3, including add, delete, modify, compare and abandon operations. In addition, Domino supports LDAP 
referrals, the UTF-8 character set (equivalent to Unicode), enhanced search capabilities, language tags, and 
X.509 v3 certificate-based authentication. Domino supports the IETF-standard LDAP directory schema for 
compatibility with third-party LDAP directories. 
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Extensible Schema -- Using Domino Designer, administrators can create custom document extensions and new ll
document types in the Domino Directory. These customizations are preserved across updates to the Domino 
Directory design template, and can be searched and updated with LDAP v3 and Domino Administrator.

Directory Catalog -- The Directory Catalog aggregates user information from one or more Domino Directories. It ll
is optimized for fast searches, compact storage of user information (approximately 100 bytes per entry with 
default attributes), and scalability to millions of entries. It is small enough to be replicated to users' desktop or 
laptop computers so that users can take the entire company directory with them when they are away from the 
office. Administrators can choose the attributes included in Directory Catalog entries, and can create multiple 
Directory Catalogs with different content or sort orders. The Directory Catalog is fully LDAP-enabled, and can be 
searched using standard LDAP clients.

Directory Assistance -- Directory Assistance, known in previous releases as the Master Address Book, allows ll
directory search requests to a Domino server to be redirected to other Domino directories or to a third-party 
LDAP directory, based on naming rules defined in the Directory Assistance database. In R5, the Domino server 
can reference group definitions stored in third-party LDAP directories, and use those groups for determining Web 
user access to Domino applications.

LDIF import and export -- Domino supports import and export of directory entries using the IETF-standard LDIF ll
file format.

Alternate name support for international names -- Domino and Notes now support an alternate name as the ll
secondary name for a Notes user. For example, the alternate name could be in the user's native language and 
character set, while the primary Notes user name could use the English alphabet. The alternate name is secure 
and authenticated, and users can send mail to and search on the alternate name.

Message Management

Message tracking -- Domino R5 now allows for detailed message tracking and monitoring. The Simple Message ll
Tracker Collector Protocol (SMTCP) provides a method to record message tracking information and the 
information is logged into the MailTracker Store Database that is resident on each mail server. The MailTracker 
Collector formats the data so it can be queried. Query options include: Sender (wildcarding permitted); Recipient 
(wildcarding permitted); Date Range; Subject Text (wildcarding permitted); Range of Message Sizes

Message reporting -- Domino R5 provides automated mail server reporting. Eleven different reports cover topics ll
such as: Message count by author and size; Most common message routings; and Volume summaries. Data is 
stored in Notes format so custom views and reports can be generated.

Single Copy Message Store management -- Message Store management (previously know as SCOS) has been ll
improved and now delivers management tools to help administer the message store on a per user basis and 
archive old messages. In addition to having unlimited message store databases, Domino R5 provides for auto 
creation of message store databases when the database has surpassed operating system size restrictions on a 
single database.

Routing control management improvements -- Administrators now have more control over routing options. Some ll
options include: Allow mail only from specific domains; Allow mail from designated organizations; Deny mail 
from designated organizations; Maximum message size quota; Send messages as low priority if meet specific 
criteria such as size. Additional Routing controls include:

Native Extended SMTP Routing - Allows pipelining for batch routing; Filters unsolicited junk e-mail (UBE, UCE); 
Assigns message size quotas for users.

Push Request Routing - The new router also supports "push request" routing such that the source server sends a 
"push request" to the destination server. The destination server then sends a request for the source to send the 
message. This facility enables Domino to provide Remote Message Queuing for one or more domains. This 
feature supports four configurable modes of operation which deliver the same functionality for both NRPC and 
SMTP connections.

Routing topology - Administrators have more control to optimize routing for their organization.

Message quotas -- Administrators can easily set individual mail file quotas. ll

Built-in migration tools -- Domino Upgrade Services provide easy-to-use migration wizards for cc:Mail, MS Mail, ll
Windows NT, MS Exchange, LDAP (LDIF), Novell Groupwise 4.x, Novell Groupwise 5.x, and Netscape Mail Server. 
In addition, there are now open APIs for Lotus Business Partners and third-party developers to create custom 
Domino Upgrade Services.
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Database and architectural improvements

Expanded database storage -- In R5, Domino databases are design for a limited size and certified up to 64GB.  ll
Your applications are limited by the system platform on which the Domino Server is deployed.  

Database storage limits for each platform:

Mac: 4GB
UNIX: 64GB
OS/2: JFS 64GB, non-JFS limit is 2GB
NT: 64GB

Memory and I/O optimization -- Low-level resource managers include enhancements that dramatically increase ll
performance. Enhancements are in these areas: compression, sequential I/O, paginated large structures, slotted 
pages, adaptive handling of non-summary data, a single buffer manager, background I/O threads with 
read-ahead.

Transaction logging -- Transaction logging is an industry-standard technique for reliable data storage. A ll
transaction log is a sequential file to which everybody writes -- sequential writing on disk is much faster than 
writing in various places on disk. Transaction logging records the operation you performed once it is written to 
disk (not just memory). Transaction logging replaces Database Fixup, which results in a much faster system 
restart and recovery.

Improved scalability -- Scalability improvements are twofold: size of databases and number of users supported ll
per server. With the database enhancement mentioned above, databases now scale to the limits of your system 
platform. Notably, work has been done to the Domino R5 directory to ensure that it scales to support at least 
one million registered users. The number of Notes, IMAP, POP and browser users supported by a single Domino 
server is two to four times greater than R4.6.x.

Availability and Reliability

Internet Cluster Manager -- Extends failover and load balancing to Web browser clients (HTTP and HTTPS) using ll
native Domino clustering and the Internet Cluster Manager (ICM).

Domino integration with OS clusters -- Domino can run under Microsoft Cluster Server (MSCS) configuration in ll
either Active/Passive or Active/Active modes. In an Active/Passive configuration MSCS fails over the Domino 
server to a secondary MSCS cluster server where the Domino server is then started. In an Active/Active 
configuration, two Domino servers are running on two MSCS cluster servers and if one Domino server goes down 
it fails over to a second partition running a separate instance of Domino on the other MSCS cluster server.

Clustering enhancements -- In order to provide users with a single system image of a Domino cluster, several ll
enhancements are provided in R5 such as collaborative calendar and scheduling support of fail over, 
synchronous mail agent support of failover, improved unread mark support of replicas, and better fail back 
functions in the Notes client.

Partitioning enhancements -- Unlimited partitions per server (previously six) so you can maximize your system ll
investment in larger platforms. In addition, each partitioned server runs as its own, distinguishable service in an 
NT environment, allowing for the startup and shutdown of each partitioned server through the NT service 
manager.

Online indexing -- Allows access to database views that are currently being updated and allows users to continue ll
accessing a server when the $Users view is being updated.

Auto restart enhancements -- Administrators can optionally keep the Domino server down -- after cleaning up all ll
the files -- which is extremely useful in conjunction with hardware clustering/failover. Allows for tighter 
integration with UNIX hardware clustering such as Sun FullMoon. Administration scripts are configurable to help 
gather diagnostic information on Domino failures.

Online, in-place compaction -- Allows for database compaction while database is in use. The Administration ll
Process systematically compacts database in intervals, allowing for user traffic to take turns with compaction 
process.

Full and incremental, online backup support -- Set of published APIs to allow tight integration with third-party ll
incremental backup solutions.

Web Server

Enhanced HTTP stack -- The Domino native HTTP engine has numerous enhancements including enhanced ll
performance and servlet support.

Domino for Microsoft IIS -- You may now choose to use Microsoft IIS as the HTTP engine for Domino. For NT ll
customers that use Microsoft IIS, Domino adds a secure, distributed, and cross-platform Web application server 
to IIS Web servers.
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CORBA/IIOP protocol support -- Support for Common Object Request Broker Architecture & Internet InterORB ll
Protocol (CORBA/IIOP). Permits extension of client/server computing to non-Notes clients. CORBA/IIOP enables 
applets that communicate with the server more efficiently than HTTP.

Access control for HTML and other files -- When using the Domino native HTTP stack, you are now able to ll
configure access control lists for files (HTML, GIFs, etc.) in the file system.

Domino Web server API (DSAPI) -- Domino now supports a server API that allows you to create your own Web ll
server extensions. A DSAPI extension, or "filter", is a program you create that is notified when certain events 
occur in the Web server, such as when a URL request is received or when a HTTP client is about to be 
authenticated.

Internet Cluster Manager -- Domino's clustering, load balancing and failover capabilities have been extended to ll
support Web browsers accessing the Domino Web server. When a Domino Web server is overloaded or 
unavailable, the Web browser request is rerouted to another server in the cluster.

HTTP session authentication -- Domino R5 allows you to choose authentication using HTTP sessions and ll
encrypted cookies, which provides the ability to "log in" and "log out" of a Web site served by Domino.

Determine browser capabilities -- You can now determine the capabilities of a Web user's browser from the ll
formula language, using @BrowserInfo.

Upgraded servlet support -- The Domino Web server now supports the JSDK 2.0.ll

Last-modified HTTP header -- Domino R5 now sends a last-modified header with most Domino responses. This ll
often results in a performance enhancement, since it enables many Web browsers or proxy servers to cache 
Domino pages.

Virtual server logging -- Virtual server information is now included in the common extended log format.ll

Virtual servers SSL and key ring support -- System administrators can specify a unique key ring for each virtual ll
server. This enables each virtual server to use SSL. Also, port security settings can be specified for each virtual 
server. 

Control server log life -- Administrators can now specify the length of time for which a log file is used: daily, ll
weekly, or monthly.

Byte range serving -- Domino R5 allows a Web client to download a file in sections (a range of bytes) rather than ll
all at once. This can make file downloads more efficient and fault-tolerant. For example, if a Web client is in the 
middle of downloading a file and the connection is suddenly lost, Domino, with byte range serving support, starts 
the download again from the point where it was interrupted, rather than from the beginning of the file. 

Simple URLs -- Domino R5 supports the ability to give a page in Domino database a name, which results in ll
simple URLs where no unique ID is required. For example: www.acme.com/News.nsf/Today?OpenPage where 
"Today" is the name of the page. If the name is unambiguous, you can further simply the URL further 
to:www.acme.com/News.nsf/Today

Automatic configuration of maximum performance settings -- In R5, you can have Domino automatically ll
configure various server options to optimize your HTTP performance based on the type of applications you are 
running, such as Web mail, Web applications, or both mail and applications.

Enterprise Integration -- Domino Enterprise Connection Services (DECS) -- Domino Enterprise Connection ll
Services (DECS) is a visual tool and high performance server environment you can use to create Web 
applications that provide live, native access to enterprise data and applications. The visual tool includes an 
application wizard and online Help to assist you to define external data source connections -- for example, DB2, 
Oracle, Sybase, File directory, EDA/SQL, or ODBC -- and fields within your application that automatically update 
with external connector data. For more information on connecting to legacy databases, see the Domino 
Enterprise Connection Services User's Guide. (DECSDOC.NSF) in your Notes or Domino data directory.

Install and Setup

InstallShield -- The Domino R5 and Notes R5 Install programs for Windows platforms are based upon the ll
InstallShield Wizard. The new procedure is significantly simpler than previous versions.

Server setup without a client -- For non-Windows platforms, Domino R5 launches a Web browser after install so ll
administrators can easily set up and configure the server.

Automated client setup -- Using the centralized client configuration tool, administrators can centrally setup ll
clients, choose what server the client connects to during setup and configure the user's desktop.

Enhanced server setup profiles -- Allows administrators to create server setup profiles. Administrators can ll
distribute these to remote sites for controlled server setup and deployment.
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Administration Process

Programmability -- The administration process is programmable via published APIs. Administrators and ll
third-party vendors can take advantage of core Administration Process functions in order to integrate Domino 
administration with other administration products and to develop customized administration functions.

Cross-domain functionality -- Administration Process is extended so administration process services such as ll
change name, add person, delete person, upgrade server, and delete server are available across domains.

Desktop Management

Centralized client configuration -- Domino R5 allows administrators to centrally configure and control desktop ll
setting such as home server, proxy server, UI preferences, and bookmarks. In addition, administrators can "lock 
down" the desktops so that the settings can't be altered.

Centralized upgrades -- Allows administrators to distribute client software upgrades. This feature supports UNC ll
(Universal Naming Convention) so there is no need for consistent drive mappings across all clients. 

Monitoring

Enterprise-wide monitoring -- New features in the Domino Administrator make it easy to find and monitor large ll
number of servers. Monitoring follows a distributed model, showing only those servers that an administrator can 
and should manage.

Expert analysis tools -- These tools allow administrators to analyze server performance, over time, to help you ll
predict and prevent future issues. These tools include:

Core services analysis -- For what is the server being used?

Service level agreements -- Set and Track SLAs, including server response time and replication schedules.

Correlated services analysis -- If an SLFA is not met, this tools helps administrators determine the reason by 
correlating statistics such as server response time with associated statistics like concurrent users and indexer, 
replicator and agent activity.

Database usage analysis -- Helps administrators optimize server tuning by knowing which databases are being 
used and how often. Also helps load balance applications and recoup disk space by archiving unused databases

Application monitoring and analysis -- Tells administrators how well an application is working. Calculates the 
time it takes to open the default view and create a document using the default form. Helpful in telling when views 
may be growing too large. 

ISpy -- Gives administrators the ability to get service-level statistics on any TCP/IP service supported by a ll
Domino server, including which services are available and the response time for a particular service. ISpy also 
includes the ability to ping servers to determine mail routing and response time, alerting administrators to 
potential mail delivery problems. ISpy is fully integrated with the Domino events and statistics collection, 
allowing the administrator to set their own response time goals and providing a range of automated actions to 
occur when a service is not performing to the administrator's expectations.

Administration enhancements

Telnet into server console for Domino UNIX servers -- Domino R5 provides the ability to use any UNIX or NT ll
workstation to Telnet (or remotely log in) to the server console of a Domino UNIX server. This allows you to see 
the history of what is happening on the server console, and you can type server commands at the console from 
the remote workstation.

Batch console commands -- This is the ability to give the server many commands from a batch file.ll

Decommission server analysis tool -- Domino R5 provides analysis tool to help administrators decommission ll
servers. You get detailed information comparing source server and target server. Any inconsistencies between 
them are flagged.

Passthru logging -- When configured as a passthru server, the Domino server can log sessions established ll
through that server. 

Ability to stop/start ports -- The administrator can stop and start individual Domino Server ports with the Start ll
Port and Stop Port console commands.

Enhanced trace connection facility -- Additional controls are available on the amount of information logged for ll
trace connection operations.
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Search tools

Domain Search -- In R5, you can search all databases in the domain with multi-database indexing selected, and ll
any file systems referenced. By incorporating ACLs into the search, users only get results from Notes documents 
to which they have access. Provides dynamic indexing of new databases that are flagged to be included, and a 
centrally located index of all databases.

Content categorization -- Provides the ability to categorize all documents in the domain regardless of the ll
database where they are located, according to a single hierarchical scheme or taxonomy. Web pages can be 
categorized as well. The domain catalog contains a view that can be used to browse through this content map.

Filters -- Domino R5 indexes attached documents by using Verity's KeyView filters to translate the attachments ll
into format that can be indexed. Supported formats include Acrobat PDF, Word, WordPerfect, Word Pro, 1-2-3, 
Excel, Freelance, PowerPoint, HTML, and many others.

Double-byte full-text indexing and searching -- All indexing and searching operations are fully enabled for ll
double-byte character sets.

Paged result set -- Search results are formatted on a page in a format similar to major Internet search engines. ll
A page comes back with 20 hits by default (this is user-configurable) and then you hit the next page button to get 
the next set of hits. The result form is customizable. You can specify logos, a summary of the document, author, 
relevance rank type, modified date, etc.

Full-text SPI -- Service Provider Interface provides APIs for other search engines to hook into core Domino ll
databases.

Full-text indexing of file system -- Any file system referenced by the file system configuration form and stored in ll
the domain catalog can be added to the index.

Domain Catalog -- Centrally maintains list of all database attributes such as Location, Indexing configuration, ll
and ACL properties. Also contains Search and Result forms and File system configuration forms.

Clustered searching -- Supports search of clustered Domain Catalog Servers and automatically load-balances ll
requests by redirecting users to the least-loaded server in the cluster. Fault Tolerant Domain Searching can be 
implementing with clusters. If one of the Domain Catalog Servers crashes, requests are automatically redirected 
to the remaining Domain Catalog servers in the cluster.

Fuzzy search -- Gives users the ability to locate words even if the document query terms used for the search are ll
misspelled within the documents or vice-versa. 

Network Protocol Support

HTTP Tunnel Proxy -- The Domino server and the Notes client can use the industry-standard HTTP Tunnel Proxy ll
to connect through a firewall, to each other and to other Internet standard clients and servers. The POP3, IMAP, 
SMTP, LDAP, and NNTP protocols are supported via the HTTP Tunnel Proxy, both with and without SSL (Secure 
Socket Layer). The internal Notes protocol (Notes RPC or NRPC) is also supported via the HTTP Tunnel Proxy, as 
in previous releases.

Flexible Notes TCP/IP connections/server names -- When connecting to a TCP/IP-based Domino server, users ll
can enter the server's name as a simple host name, even if the server's name is a fully-qualified TCP/IP name. 
For example, the user can enter "fred" to access a Domino server named Fred/Sales/Acme, or 
fred.acme.com/Acme.

External Domain Network Information document -- The administrator can import address information into this ll
document from another Domino domain.

Improved NetWare Directory Services (NDS) support -- Domino provides a snap-in DLL for the NetWare NDS ll
administration tool (NWADMIN), which allows an administrator to browse and update Domino server objects in 
NDS. Domino R5 uses the new 32-bit snap-in interface, allowing use of the 32-bit NWADMIN tool. Domino 
automatically finds its server object within NDS using the naming context of the current logged-in user.

311



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 6 - History of changes

Designer

What's new in Domino Designer - R5 initial release
Welcome to Domino Designer. Designer is an integrated application development environment that lets developers 
and Web site designers create, manage, and deploy secure, interactive applications for the Domino Application Server.

Domino applications let people share, collect, track, and organize information, using Lotus Notes or the Web. Domino 
applications can cover a wide range of business solutions, including:

Workflow -- Route informationl

Tracking -- Monitor processes, projects, performance, or tasksl

Collaboration -- Create a forum for discussion and collaborationl

Data Integration -- Integrate with relational databases and transactional systemsl

Personalized -- Produce dynamic content based on, for example, user name, user profile, access rights, or time l
of day

Globalization -- Use Domino Global Workbench to produce global sitesl

Domino Designer, with the Domino Application Server, is optimized to enable developers to build applications that 
facilitate the flow of information between an organization's enterprise systems and front-end business processes.

This release note provides you with an overview of the new features and benefits of Domino Designer R5.

Improvements to Development Environment

Comprehensive development environment -- The environment includes all the design and development tools ll
needed to develop and deploy applications.

Intuitive visual environment -- The new Designer look-and-feel lets developers optimize their work environment ll
by creating project bookmarks. Developers have easy access to all design elements and application metadata. 
The task-oriented environment better supports developer needs. The result is reduced development time and 
costs.

Improved programming environment -- The Programmer's pane provides access to all application objects and ll
reference information on the Domino objects and languages. The programming environment is consistent 
regardless of the programming language or tool used. New and updated tools enable easier access, use, and 
reuse of code and objects.

Multiple-browser preview -- Preview your work in all of the browsers your end-users demand, including Notes, ll
the Notes browser, Microsoft Internet Explorer, and Netscape Navigator. Automatic browser detection adds 
preview buttons for browsers installed on the developer's desktop. 

Context-sensitive Help -- Pressing F1 while in any of the integrated tools (such as pages, forms, outlines, or ll
framesets) brings up the Help topic for the tool. Pressing F1 when a function is highlighted in the InfoList 
Reference tab displays the Help topic for the function as in previous releases.

 
New Site Layout and Presentation Tools

Outline Designer -- The Outline Designer is a visual tool for designing the structure and navigation of an ll
application. You can design and display links to URLs, design elements, and actions in a hierarchical layout. The 
Outline is fully programmable, enabling a customized navigational structure based on user, time, or other 
criteria. You can embed the outline in pages or forms and add graphics and mouseover effects.

Frameset Designer -- The Frameset Designer allows developers to create multi-pane interfaces to their ll
applications. It includes a step-by-step process to allow developers to start designing Web sites with frames 
quickly with no HTML knowledge required.

Page Designer -- Page designer is a WYSIWYG HTML authoring tool allowing designers to add styled text, ll
images, image maps, tables, HTML, Java, ActiveX components, and multimedia objects to applications.

Domino Applets -- You can use these Java-based components to add unique features to your Web site not ll
previously available to browsers. Applets included are View, Action bar, Outline, and Text Editor.

HTML 4 support -- HTML 4 properties are accessible within the visual development environment via menu ll
options and properties boxes.
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Table enhancements -- Enhancements include style templates, nested tables, fixed and variable width columns ll
in the same table, and cell background images, among many others. The improvements enable more control 
over page layout. You no longer have to work with raw HTML code to obtain necessary control over the page 
layout and table characteristics.

Shared resources -- Images, applets, shared actions and Java libraries are added to existing shared code ll
resources.

Image maps -- You can create image maps by adding in-line hotspots to pictures.ll

Picture properties -- HTML attributes, such as vertical alignment, text wrap, and float options, are available in ll
the properties box.

Enterprise Integration

Domino Enterprise Connection Services (DECS) -- Domino Enterprise Connection Services (DECS) is a visual ll
tool and high performance server environment you can use to create Web applications that provide live, native 
access to enterprise data and applications. The visual tool includes an application wizard and online Help to 
assist you to define external data source connections -- for example, DB2, Oracle, Sybase, File directory, 
EDA/SQL, or ODBC -- and fields within your application that automatically update with external connector data. 
For more information on connecting to legacy databases, see the Domino Enterprise Connection Services User's 
Guide. (DECSDOC.NSF) in your Notes or Domino data directory.

Lotus Connector LSX Classes (LC LSX) -- Lotus Connector LSX Classes (LC LSX) allow for programmatic access ll
via LotusScript to Lotus Domino Connectors' native connectivity to relational databases, transaction processing 
systems, and enterprise resource planning (ERP) applications. Lotus Domino Connectors supplied with this 
release include: DB2/UDB, EDA/SQL, ODBC, Oracle, Sybase, and Text and File. Additional Lotus Domino 
Connectors for ERP and Transaction System Connectors are available separately from Lotus. For product 
information, please visit the Lotus Domino Enterprise Integration Web page at http://www.eicentral.lotus.com. 
Complete documentation can be found in the LSX for Domino Connectors On-line Manual (LSXLC.NSF) in your 
Notes or Domino data directory. You may also refer to LotusScript Data Object (LS:DO) documentation for more 
general guidelines on the use of LSXs.

DB2 LSX Classes (LSXDB2.DLL) -- DB2 LSX Classes (LSXDB2.DLL) are included with the Notes client, Domino ll
server and Domino Designer on Windows 95, 98, and NT platforms. DB2DAHLP.NSF is a documentation 
database that describes the DB2 specific features of the DB2 LSX. DB2SAMP.NSF contains a series of agents 
that demonstrates the use of the DB2 specific features in the DB2 LSX. The DB2 LSX is closely related to the 
LotusScript Data Object (LS:DO). You can also refer to LS:DO documentation for more general guidelines on the 
use of DB2 LSX. Note: DB2 LSX  AutoCommit defaults to False. Some of the DB2 ODBC script might not work if 
the user forgets to set AutoCommit to True.

JDBC (Java Database Connectivity) -- Access from Java agents to relational data via industry standard JDBC. A ll
JDBC-to-ODBC bridge is also part of Domino.

Support for Web-standard languages

Support HTML 4 -- Designer supports features defined in the W3C HTML specification. There is no need to write ll
HTML code, unless you want to.

Mix-and-Match Coded HTML on Pages and Forms -- You can mix and match WYSIWYG and native HTML code. ll
Use HTML if you want or need to.

Import HTML Pages -- You can import existing HTML pages that are automatically rendered as pages in ll
Designer.

Upgrade existing HTML -- Import existing HTML files into Designer so you can take advantage of Domino ll
features.

Leverage Web Programmability and Scripting Options -- Web standards (Java, JavaScript, HTML 4.0) are ll
supported in Designer R5 so you can use standard Web design languages and tools in Designer.

CORBA/IIOP support -- The Common Object Request Broker Architecture & Internet InterORB Protocol permits ll
remote access to Domino services. CORBA/IIOP enables creation of applets and applications that communicate 
with the server more efficiently than HTTP alone.
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Additional Domino objects -- Domino objects provide an integrated set of application objects that can be ll
accessed from a number of industry-standard languages. New application objects are added to one of the richest 
object models for application development. 

Java enhancements -- Designer supports Java as an alternative to other programming options. Compile and edit ll
Java code directly in the Agent Builder. There is support for shared Java libraries.

JavaScript -- Direct support in Designer for JavaScript development. JavaScript events, such as onMouseOver ll
and onBlur, are added to the event list for Domino Form and Page elements. Enables client-side scripting for 
both Notes and browsers. Support for the Document Object Model (DOM) within the R5 Notes client is as defined 
in the Notes Document Object Model database, which will be available at http://www.lotus.com/ldd.

Localization Features

Domino Global WorkBench -- Create the design of an application in more than one language with the Domino ll
Global WorkBench. Developers can quickly localize applications into multiple languages and keep them 
up-to-date as the structure and content of the application changes.

Multiple language support -- Generate and maintain different language versions of design elements and ll
documents via database and design properties. Allows the creation of local, global and translatable content in 
any supported language. Facilitate review and approval of localized documents through workflow process. 
"Switchbar" lets Web users switch between languages across synchronized pages in a multilingual Web site. 
Content appears accurately and simultaneously to all users worldwide. Access to appropriate information in 
appropriate/respective language in a timely fashion. Developers can build the translation process into 
applications to facilitate the rapid translation of Web content.

Multiple currency support -- Ability to store and use calculations involving multiple currencies within a form or ll
view. The currency indicator is stored with the field so that it remains consistent and doesn't change based on 
the user's local computer system preferences. Developers can more easily create applications that involve 
calculation and display of different currencies. Users can immediately understand the currency being used by 
the symbol and no longer need to do mental calculations to determine whether financial figures are correct or 
not.

Euro support -- Full Euro support including Euro symbol input and display and rounding. Developers can easily ll
create applications that use the new Euro currency. Users can immediately view financial figures calculated into 
Euros without doing mental or manual calculations. Combined with the multiple currency support feature listed 
above, developers have all the tools they need to develop truly global applications.

Long dates -- Ability to specify a long date format in a date field: for example, 01-January-1999. Developers can ll
use long date format to remove the ambiguity between the MM/DD/YY and DD/MM/YY date formats.

Administrator Client

What's new in Domino Administrator - R5 initial release
Domino Administrator is the new administration client for the Domino server. It is an intuitive, task-oriented interface 
that utilizes a familiar hierarchical server tree metaphor, making finding and switching to servers very easy. To 
leverage existing skills and experiences of administrators, the Domino Administrator implements common features 
such as drag and drop, multiple selections using the Shift and Ctrl keys, and right-click context-sensitive menus.

Domino Administrator provides graphical monitoring of servers, services, replication and routing. It groups features 
and chains steps to simplify task completion. It has six primary tabs to help organize administration and management 
functions logically:

People & Groups

Use the People & Groups tab for all user and group management, user registration, certification, migration from 
foreign mail systems and directories, and external directory management.

Files

The Files tab provides a central interface for all database and template management functions, such as moving and 
compacting databases, ACL management, configuring file replication settings, indexing, and setting quotas.
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Server

The Server tab consolidates all server management functions, such as server analysis, monitoring, console 
commands, and performance information. Server monitoring features give status reports in real time as to which 
servers and services are running on individual servers.

Messaging

The Messaging tab allows you access to all messaging management functions, such as shared mail management, 
assigning mailbox quotas, mail routing topology, and message tracking and reporting.

Replication

Use the Replication tab for all replication management functions, such as replication schedule configuration, topology 
maps, and troubleshooting.

Configuration

The Configuration Tab provides a central location for configuration settings such as servers, messaging, replication, 
clusters, Web servers, and statistics and events.

For more details on using Domino Administrator, see Domino 5 Administration Help.

Designer

eSuite DevPack
Lotus eSuite DevPack provides a set of Java-based business applets that allow Domino developers to create interactive 
applications for Notes clients and Web browsers. For more information about DevPack, please go to the eSuite home 
page (http://www.lotus.com/esuite) or the eSuite DevPack developer's site (http://esuite.lotus.com).

With enhanced features in eSuite DevPack 2.0 and Domino R5, developers can choose from a greater range of 
features, including:

The choice of importing or linking to DevPack applets to build interactive applications for Notes clients and Web 
browsers quickly and easily.

Integrated JavaScript support in Designer that allows developers to deliver the full capabilities of DevPack applets to 
Notes clients, as well as to Web browsers.

Integrated Java support from Domino, including support of the CORBA/IIOP protocol that allows remote access to the 
Domino Object Model (also known as the back-end classes or Notes Object Interface) from DevPack applets.

A new eSuite Servlet Kit that allows developers to create applications that leverage the servlet capabilities of Domino. 
This feature is especially useful to developers of enterprise applications who utilize Java for their server-side 
development and want to incorporate DevPack applets into the applications.

A new data access applet, Infobus/FX, that provides features similar to the Notes/FX capabilities used with OLE 
objects. This applet allows developers to set up data exchanges between embedded DevPack applets and fields in 
Domino documents.

A new data access applet, AgentGateway, that allows a developer to connect to a Domino server and pass values to a 
Domino agent, which in turn publishes the results to the DevPack InfoBus for use within applets. The applet gives 
developers a direct and simple way to work with DEC's (Domino Enterprise Connectivity) to provide access to 
enterprise data. 

A new DevPack install program with Domino integration options for installing the applets, samples, and 
documentation on both Notes clients and Domino servers.

Two new DevPack 2.0/Domino R5 templates, eSuite Contact Manager and eSuite Project Scheduler, that make 
extensive use of DevPack applets. The templates are designed for both Notes clients and Web browsers. Developers 
can use the designs as is, as a starting point for further customization, or as learning tools for their own applications.
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Designer

Formula language
These are the new and enhanced @Functions and @Commands for R5. For details on each, see Domino 5 Designer 
Help or the Domino Designer Programming Guide.

* An asterisk indicates an item that was added to the online Help that ships with the product, beginning in R5.0.3.

New @Functions

@AddToFolder
@BrowserInfo
@FontList
@FormLanguage
@HardDeleteDocument *
@IsAppInstalled
@LanguagePreference
@LaunchApp
@Locale
@NameLookup
@Narrow
@PasswordQuality *
@SetTargetFrame
@UndeleteDocument
@UserNameLanguage
@UserNamesList
@V4UserAccess
@ValidateInternetAddress
@Wide

New @Commands
@Command([AddBookmark])
@Command([CreateCrossCert]) *
@Command([Directories]) *
@Command([OpenFrameset])
@Command([OpenHelpDocument])
@Command([OpenPage])
@Command([RefreshParentNote])
@Command([ReloadWindow])
@Command([ViewAddInternetCertificate]) *

Enhanced @Functions and @Commands

@DialogBox - new parameters
@Name - new actions
@UserName - new parameter
@Command([CalendarFormat]) - new value

Also, the View applet is now programmable via the following @Commands:

@Command([EmptyTrash])
@Command([ViewCollapse])
@Command([ViewCollapseAll])
@Command([ViewExpand])
@Command([ViewExpandAll])
@Command([ViewRefreshFields])

Designer

Java classes
The lotus.domino package supersedes lotus.notes. The lotus.domino package has the same content as the Release 
4.6 lotus.notes package plus new classes, methods, and other enhancements. The Release 4.6 lotus.notes package 
continues to be supported for backwards compatibility only; it does not contain the new classes, methods, and other 
enhancements.
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Agents can be coded and compiled directly in the Programmer's pane. They can also be imported as before.

Applets and applications on a non-Domino machine can access lotus.domino objects through IIOP calls to a Domino 
server.

The following are the new and enhanced LotusScript classes, methods, properties, and events for R5. For details on 
each, see Domino 5 Designer Help or the Domino Designer Programming Guide.

New classes

Outline
OutlineEntry
Replication
RichTextParagraphStyle
RichTextTab
ViewEntry
ViewEntryCollection
ViewNavigator

ACL class 

New methods New property

getNextEntry (additional method)
removeACLEntry

InternetLevel

ACLEntry class new properties

IsCanCreateLSOrJavaAgent
IsCanCreateSharedFolder
IsAdminReaderAuthor
IsAdminServer
IsGroup
IsPerson
IsServer
Name
UserType

Agent class 

New method New properties

runOnServer IsNotesAgent
IsWebAgent
ServerName
Target
Trigger

Database class

New methods New properties

createOutline
enableFolder
FTDomainSearch
getOutline
getProfileDocCollection

FolderReferencesEnabled
MaxSize
ReplicationInfo

DateRange class new property

Parent
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DateTime class

New method New properties

toJavaDate LocalTime (additional methods)
Parent

DbDirectory class new property

Parent

Document class 

New method New properties

putInFolder (additional method) FolderReferences
IsDeleted
IsValid

DocumentCollection class methods

addDocument 
deleteDocument 
getDocument 
getNextDocument (additional method)
getPrevDocument (additional method) 
FTSearch (additional method)
putAllInFolder (additional method)

Form class new property

Parent

International class new property

Parent

Log class new property

Parent

Name class new properties

Addr821
Addr822Comment1
Addr822Comment2
Addr822Comment3
Addr822LocalPart 
Addr822Phrase
Language
Parent

Newsletter class new property

Parent

RichTextItem class methods

addPageBreak
appendParagraphStyle
appendDocLink (additional methods)
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RichTextStyle new properties

Parent
PassThruHTML

Session class

New methods New properties

getDatabase
createRichTextParagraphStyle
resolve

ServerName 
UserNameList 

View class

New methods New properties

createViewNav
createViewNavFrom
createViewNavFromCategory
createViewNavFromChildren
createViewNavFromDescendants
createViewNavFromMaxLevel
getAllEntriesByKey
getEntryByKey
getColumn

AllEntries
BackgroundColor
ColumnCount
ColumnNames
HeaderLines
IsCategorized
IsConflict
IsHierarchical
IsModified
IsPrivate
RowLines
Spacing
TopLevelEntryCount

ViewColumn class new properties

Alignment
DateFmt
FontColor
FontFace
FontPointSize
FontStyle
HeaderAlignment
IsAccentSensitiveSort
IsCaseSensitiveSort
IsField
IsFormula
IsHideDetail
IsIcon
IsResize
IsResortAscending
IsResortDescending
IsResortToView
IsSecondaryResort
IsSecondaryResortDescending
IsShowTwistie
IsSortDescending
ListSep
NumberAttrib
NumberDigits
NumberFormat
Parent
TimeDateFmt
TimeFmt
TimeZoneFmt
Width

319



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 6 - History of changes

Designer

LotusScript
These are the new and enhanced LotusScript classes, methods, properties, and events for R5. For details on each, see 
Domino 5 Designer Help or the Domino Designer Programming Guide.

New classes

NotesOutline
NotesOutlineEntry
NotesReplication
NotesRichTextParagraphStyle
NotesRichTextTab
NotesViewEntry
NotesViewEntryCollection
NotesViewNavigator

NotesACL class new property

InternetLevel

NotesACLEntry class new properties

CanCreateLSOrJavaAgent
CanCreateSharedFolder
IsAdminReaderAuthor
IsAdminServer
IsGroup
IsPerson
IsServer
UserType

NotesAgent class new properties

HasRunSinceModified
IsNotesAgent
IsWebAgent
Target
Trigger

NotesDatabase class

New methods Enhanced methods New properties

CreateOutline
EnableFolder
FTDomainSearch
GetOutline
GetProfileDocCollection

CreateCopy 
CreateFromTemplate

FolderReferencesEnabled
IsDirectoryCatalog
MaxSize
ReplicationInfo

NotesDateTime class

New method New property

TimeDifferenceDouble IsValidDate

NotesDocument class new properties

FolderReferences
IsDeleted
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NotesDocumentCollection class methods

New methods Enhanced method

AddDocument 
DeleteDocument 
GetDocument 

PutAllInFolder

NotesName class new properties

Addr821
Addr822Comment1
Addr822Comment2
Addr822Comment3
Addr822LocalPart 
Addr822Phrase
Language

ODBCQuery class new method

UseRowID

ODBCResultSet class new method

ExecProcedure

NotesRegistration class enhanced method

RegisterNewUser

NotesRichTextItem class methods

New methods Enhanced method

AddPageBreak
AppendParagraphStyle

AppendDocLink

NotesRichTextStyle new property

PassThruHTML

NotesSession class

New method Enhanced method New properties

GetDatabase CreateRichTextParagraphStyle NotesBuildVersion 
UserNameList 

NotesUIDatabase class

New method Enhanced method New events

OpenNavigator OpenView PostDragDrop
QueryDragDrop
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NotesUIDocument class

New methods Enhanced method New event

FindFreeTimeDialogEx
FindString
GetSelectedText
Import 
SpellCheck

Refresh PostSave

NotesUIView class

New method New properties

Print CaretCategory
ViewName

NotesUIWorkspace class

New methods Enhanced method New properties

Folder
GetListOfTunes
OpenFileDialog
OpenFrameset
OpenPage
PickListCollection
PickListStrings
PlayTune
Prompt
RefreshParentNote
ReloadWindow
SaveFileDialog
SetCurrentLocation
SetTargetFrame

DialogBox CurrentDatabase
CurrentView

NotesView class

New methods New properties

CreateViewNav
CreateViewNavFrom
CreateViewNavFromCategory
CreateViewNavFromChildren
CreateViewNavFromDescendants
GetAllEntriesByKey
GetEntryByKey

AllEntries
BackgroundColor
ColumnCount
HeaderLines
IsCategorized
IsConflict
IsHierarchical
IsModified
IsPrivate
RowLines
Spacing
TopLevelEntryCount
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NotesViewColumn class new properties

Alignment
DateFmt
FontColor
FontFace
FontPointSize
FontStyle
HeaderAlignment
IsAccentSensitiveSort
IsCaseSensitiveSort
IsField
IsFormula
IsHideDetail
IsIcon
IsResize
IsResortAscending
IsResortDescending
IsResortToView
IsSecondaryResort
IsSecondaryResortDescending
IsShowTwistie
IsSortDescending
ListSep
NumberAttrib
NumberDigits
NumberFormat
TimeDateFmt
TimeFmt
TimeZoneFmt
Width

Designer

LotusScript Data Object enhancements
ODBCConnection object changes

The AutoCommit and CommitOnDisconnect properties are moved from the ODBCResultSet object to l
ODBCConnection in order to support Transaction Mode, CommitTransactions, and RollbackTransactions. These 
take no arguments.  AutoCommit defaults to True and can be set False to enter Transaction Mode, if the driver 
and data source support transactions.  

The methods GetRegistrationInfo and IsTimedOut have been removed. l

The DisconnectTimeOut and Exclusive properties have been removed.l

Support for asynchronous execution of queries has been removed. The IsSupported property returns False so l
that scripts that attempt to use asynchronous mode when available will behave correctly.

The ConnectTo method does not perform the auto-registration of unregistered data sources.l

The ExecProcedure method has been removed.  A new ExecProcedure method is added in ODBCResultSet object l
to execute a stored procedure.

Also, please be aware of the following issues:

The ListProcedures method does not work with some drivers.l

In some cases, an ODBC driver indicated that it did not support a certain mode although it actually did. The l
IsSupported property of the ODBCConnection object may report incorrectly due to bugs in the ODBC driver. On 
the DB_SUPP_READONLY item, it may report incorrectly due to limitations in ODBC.

ODBCResultSet object changes

The properties AutoCommit and CommitOnDisconnect have been moved to the ODBCConnection object. The l
AutoCommit property of the ODBCConnection object can be set False (when supported by the DBMS) to enter 
Transaction Mode, which applies to all queries and result sets associated with that connection. 
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The Transactions method and the Commit and Rollback functions of the Close method have been replaced by the l
CommitTransactions and RollbackTransactions methods of the ODBCConnection object. These new methods 
take no arguments and apply to all transactions pending through that connection. You might get error 720, "You 
cannot have more than one statement active, when SQL_AUTOCOMMIT is false" for INTERSOLV drivers. As a 
workaround,  Lotus suggests to "Call Res.LastRow" after "Res.Execute" and before any "Res.UpdateRow" or 
"Res.Delete Row."

The Asynchronous and Override properties have been removed.l

The new ExecProcedure method allows you yo execute a stored procedure.l

The RefreshRow method has been removed.l

Server

Checkos patch checker utility for UNIX
For UNIX platforms, Checkos is a patch checker utility that starts when you install Domino Release 5 for the first time. 
If you are missing patches for your operating system (OS), Checkos prompts you. If all of the correct patches are 
installed, you are notified with the message, "The OS appears to have the correct patches."  This feature is new in 
Release 5.0 of the Domino server.

See also the UNIX patch requirements in the "Things you need to know" chapter of the Release Notes for additional 
information about patch requirements and specific issues associated with not running proper patch levels.

Server

New HTTPD.CNF file for Domino configuration in Release 5.0
R5 contains a new version of the Domino configuration file HTTPD.CNF. It contains MIME definitions and control 
directives for the HTTP server task. All of the important configuration settings for the HTTP task are included in the 
Server document of the Domino Directory, and administrators normally do not need to modify the HTTPD.CNF file.

HTTPD.CNF is installed into the server's data directory. The Domino Server Install program does not overwrite an 
existing HTTPD.CNF file. Therefore, if you already have Domino installed and you want to get the new version of 
HTTPD.CNF, you must delete or rename your existing file before running the install program. If you have made 
changes to your HTTPD.CNF file (such as adding custom MIME types), you should rename your old file before running 
the install program and then copy the changes from the old file to the new file.

The new version of HTTPD.CNF includes an updated  and reorganized list of MIME types. The following MIME 
extensions have been added:

Common Web MIME types

.class application/octet-stream # Java class file

.cdf application/x-cdf # Channel file

.css text/css # Cascading Style Sheet

.js application/x-javascript # JavaScript

.vcf text/x-vcard # VCard

.xml text/xml # XML

VRML

.wrl x-world/x-vrml # VRML

.wrz x-world/x-vrml # VRML

.xaf x-world/x-vrml # VRML

.xof x-world/x-vrml # VRML
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RealAudio media players and 
plug-ins

.rm application/vnd.rn-realmedia # RealPlayer

.rpm audio/x-pn-realaudio-plugin # RealAudio plug-in

.ra audio/x-pn-realaudio # RealPlayer

.ram audio/x-pn-realaudio # RealPlayer

.rv video/vnd.rn-realvideo # RealPlayer

Macromedia players and plug-ins

.dcr application/x-director # Shockwave for Director

.dir application/x-director # Shockwave for Director

.dxr application/x-director # Shockwave for Director

.swf application/x-shockwave-flash # Shockwave Flash

.spl application/futuresplash # Future Splash Animator

Vendor-specific MIME types

.wks application/vnd.lotus-1-2-3 # Lotus 1-2-3 97

.sam application/vnd.lotus-wordpro # Lotus WordPro 97

.imp application/vnd.lotus-improv # Lotus Improv

.dot application/msword # Microsoft Word

.pub application/x-mspublisher # Microsoft Publisher

.mpp application/vnd.ms-project # Microsoft Project

.pot application/vnd.ms-powerpoint # Microsoft Powerpoint

.ppt application/vnd.ms-powerpoint # Microsoft Powerpoint

.pps application/vnd.ms-powerpoint # Microsoft Powerpoint

.scd application/vnd.ms-schedule # Microsoft Schedule

.wcm application/vnd.ms-works # Microsoft Works

.wdb application/vnd.ms-works # Microsoft Works

.wps application/vnd.ms-works # Microsoft Works

.wri application/x-mswrite # Microsoft Write
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Vendor-specific MIME types

.xla application/vnd.ms-excel # Microsoft Excel

.xlc application/vnd.ms-excel # Microsoft Excel

.xlm application/vnd.ms-excel # Microsoft Excel

.xls application/vnd.ms-excel # Microsoft Excel

.xlt application/vnd.ms-excel # Microsoft Excel

.xlw application/vnd.ms-excel # Microsoft Excel

.eml message/rfc822 # Outlook Mail Message

.mht message/rfc822 # Mail Message

.mhtml message/rfc822 # Mail Message

.cmx image/x-cmx # Corel CMX format

The following elements have been removed from the MIME list:

Rarely-used CAE and CAD file extensions.l

Upper-case variants of file extensions (not needed because file extension comparison is case-insensitive).l

Unused "quality" and "encoding" attributes.l

The other major change to HTTPD.CNF is the removal of unsupported directives. The HTTP stack code in Domino is 
derived from code used in several IBM Web server products. The original version of HTTPD.CNF contained several 
types of directives that did not apply to the Domino implementation of the code. All of these directives have been 
removed. The net result is that the new HTTPD.CNF is much smaller than the original version.

Client, Designer

Date and time validation
Notes and Domino now interprets any input in a date/time field as a date or time, no matter how obscure the format. 
You receive an "Invalid date format" error only when it is impossible for Notes to interpret a value (such as 99/99/99) 
as a date or time.

For example, when a date field is formatted to expect month, day, and year, and only one of the three variables is 
entered, Notes tries to guess what the other two entries are. If there is no month, then the default is the current month 
according to the operating system settings. If there is no day, the default is "01." If there is no year, the default is the 
current year. If an alphanumeric entry is made, Notes ignores the alphabetic characters and tries to determine the 
date based upon the numerals entered.
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Release 5.0.1

Administrator Client, Client, Designer, Server

New Features in Release 5.0.1

Notes Client

Updated viewers
Viewer capability is now enhanced for Windows by providing the ability to view Office 2000 documents.

Designer

Designer usability
Many changes and enhancements have been made in Domino Designer to make it even easier to use.  Key 
changes since the initial release are detailed in the "Feature Changes" section of the Things you need to know 
chapter of the Release Notes.

Java applets

The four Java applets (Editor, View, Outline, and Action Bar applets) are now compiled with JDK 1.1.6 which l
makes them smaller and faster.  

The Editor applet can now support cut, copy, and paste of plain text from outside the applet. This applet will l
be signed with the Lotus Development certificate, so users will be prompted to trust the signer the first time 
they use it.  The Editor gets its text from a hidden field on the page instead of passing in a url. This also 
addresses a problem where entered text is lost when the page is refreshed, but may affect existing R5.0 
applications.

The View applet adds SetDblClickTarget method in its API, so the frame target for the document can be set, l
for example, in the onLoad event of the form or page with the view.

The Outline applet now supports image wells.l

JavaScript

The Notes client now supports:

window.open with height and width settings and opening in its own window.l

mouseOver and mouseOut events on images (picture)l

Interpreting date/time field inputs
When a date field is formatted to expect month, day, and year, and only one of the three variables is entered, 
Notes will attempt to interpret what the other two entries are.  If there is no month, then the default is the current 
month according to the operating system settings. If there is no day, the default is "01." If there is no year, the 
default is the current year. If an alphanumeric entry is made, Notes ignores the alphabetic characters and tries to 
determine the date based upon the numerals entered.

QuickStart tutorial
QuickStart is a hands-on tutorial that takes you through the steps of creating a Domino application. The 
\data\quickstart directory contains the QuickStart Tutorial database as well as the files needed to create the 
sample Domino application.  There's also a link added to the Designer Welcome page.  QuickStart is only 
available on the Windows platforms setup.

Domino Enterprise Connection Services (DECS)
Enhancements which add robustness to DECS include Oracle Connector support for stored procedures, ERP 
connector support, Collapse/Expand and Order Metaconnector support, Support Pre-Open Formula, increasing 
the number of concurrent activities allowed, and a Reconnect on Dropped Connection option.

Lotus Connector LSX
Added connection pooling support.
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Administration Client

DUS option to add Administrator to mail file ACL
As part of the People and Groups Migration in the Domino Upgrade Services (DUS), two new options were added.  
The first option -- called "Add administrator to mail file access control list" -- allows the administrator's name to 
be added to a new mail file's ACL with manager access.  This gives the administrator the ability to migrate mail to 
the new mail file during the second phase of a two phase migration, where mail migration is done during the 
second phase.  The second option, called "Overwrite existing passwords with random passwords" creates a 
random password for a migrated user, overwriting the migrated password for that user if one exists.

Enhanced Internet Address Tool
The Internet Address tool has been enhanced to allow the administrator to select the person records which should 
have the internet address set.  When the administrator selects more than one person record, and then invokes the 
internet address tool, the internet address tool will indicate the number of users selected from which Domino 
Directory and will set/overwrite the internet address for only the selected users.

Domino Server

56-bit encryption supported
56-bit encryption ( DES) is now supported  for international licenses of the Web server.

LDAP schema database
Domino will automatically build a database called Domino LDAP Schema (SCHEMA50.NSF) in the Domino data 
directory. This database provides information about the Domino LDAP schema attributes, object classes, and 
syntax. If you extend the directory schema, you can use the server command "tell ldap reloadschema" to update 
the schema in memory and then update SCHEMA50.NSF with your directory changes. If you don't use this 
command, these two updates are done automatically when the Designer task runs or when you quit and restart 
the LDAP service.  Refer to the "Directories Enhancements" document in the Things you need to know chapter for 
related information.

Transaction Logging features and improvements

There is a new API to determine the state of a logged database or backup:  l
STATUS LNPUBLIC NSFIsNewBackupNeeded

If transaction logging restart fails, a new server console error messages appear that list dirty databases.l

During the first restart after disabling logging, restart recovery is run one final time to clean up databases.l

Security

Importing Internet certificates from a Netscape browser
Internet certificates from a Netscape browser can now be imported to the Notes ID file. The certificates can be 
used for SSL client authentication, and for encrypted and signed S/MIME messages. Certificates and keys which 
are compliant with Public Key Cryptographic Standard #12 (PKCS #12) in a version of the Netscape browser that 
is also PKCS #12 compliant can be imported to the Notes ID file if the browser is accessible to the local machine.  

Dual key support of Internet certificates
If multiple Internet certificates are available in a Notes ID file, a user can specify one Internet certificate to use for 
encryption and another Internet certificate to use for signatures, instead of requiring that one certificate be used 
for both.

Templates

Reports
A new version of the Domino Messaging Reports database "reports.ntf" is provided.  A previous version of 
reports.ntf was part of the R5 beta builds but did not ship officially in the R5 released code.
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Server

Value add applications on the CD-ROM
In addition to the new features found in the Notes and Domino products, the \APPS directory of the R5.0.1 CD-ROM 
contains applications which enrich the capabilities of Notes, Designer, and Domino.  Additional information about 
these applications can be found in the "Additional items on Notes and Notes/Domino/Domino Designer CD-ROMs" 
document in the Directory Install and CD-ROM Structure section of the Things you need to know chapter.  New applications 
found on the R5.0.1 CD-ROM include:

Lotus Domino Translation Object Release 1.02 
Lotus Domino Translation Object (DTO) allows Domino developers to integrate best-of-breed Machine Translation 
features into Notes or Domino applications via Translation Connectors. It provides two programming interfaces, a 
LotusScript extension, and a Java API, complete with a powerful set of properties and methods. Using Translation 
Connectors certified with the DTO, Machine Translation is integrated with Domino applications and works with both 
the Notes client and Domino server.

Domino Server.Load
Domino Server.Load is a tool that measures and characterizes various Domino server capacity and response metrics.  
It allows you to select a workload and run it against a target server.  The workloads (also called tests or scripts) 
simulate the behavior of Notes workstation-to-server operations.

Domino "Tivoli Ready"
Beginning in Release 5.0.1, files now ship with the Domino Server for Windows NT (Intel) which make Domino "Tivoli 
Ready".  Customers will be able to manage their Domino Server software under an integrated Tivoli management 
umbrella. This allows customers to automatically discover, inventory and monitor Domino servers with Tivoli 
Enterprise management products.

Release 5.0.2

Administrator Client, Client, Designer, Server

New Features and Enhancements in Release 5.0.2

Notes Client

Contact Management via Web Mail
Web mail users have the ability to do contact management. Web mail users can create contact and group information 
from a web browser which is stored in the user's mail file as address book documents.

Calendar Enhancements

There are two new print layouts as well as support for various page sizes and types for users to select from when l
printing their calendars from Notes. The new layouts are a trifold style print and a To Do List print. The trifold 
option enables users to print three separate panels on a page, either portrait or landscape. Users can select from 
the following options for the three panels on the page; Daily, Weekly, Monthly, To Do List or a Notes section. 
Users will also have the option to now print their calendars on the following page types and sizes; Franklin Day 
Planner Classic, Franklin Day Planner Monarch, Day-Timer Portable, Day-Timer Desk, Day-Timer Jotter, 
Day-Timer Folio as well as 3x5 Cards.

Notes now also supports alternate names for calendar and scheduling.l

Importing Organizer GS into Notes
You can now migrate Organizer Notepad and Call entries into Notes Release 5.0.2.
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Enhanced Import capability for Notes Rich Text
The Windows client for Notes Release 5.0.2 provides the ability to import the following into a Notes Rich Text field 
using ANSI code page 1252:

SmartSuite 97 and R9 files (1-2-3 and Word Pro)l

Microsoft Office 97 and 2000 files (Word, RTF,  Excel)l

WordPerfect 7 and 8l

Optimized Memory Utilization
Memory in the Notes client is further optimized in Release 5.0.2 by sharing memory pools among threads in 
nweb.exe, reducing instances of memory fragmentation, and allocating certain memory pools only when needed. On 
the Windows platforms, resource usage is further optimized by reducing the number of bitmap handles allocated from 
the GDI heap. The result is a better coexistence with other applications.

New bookmark icon for Sametime
If the Sametime Connect client exists on a workstation when Notes Release 5.0.2 is installed, a new icon in the 
bookmark bar appears which allows you to launch Sametime Connect from within Notes.

Designer

Designer usability

Launch infobox when entering view design - When a user opens up a view in design mode the infobox is opened, if l
it is not already open, and the selection is placed on the first column.

Web launch option for views - A launch panel has been added to the view infobox to allow users to specify the l
frameset and frame that the view should be launched in when it is launched on the web.

Image Resources

Image wells are now supported on the web.  When creating an image well which contains more than one image for l
use on the web, a new "Web browser compatible" check box will be available.

Can now select more than one image resource at a time to refresh or export.l

New View property to set target frame
You can now specify a target frame for displaying a document when the user double-clicks on it in a view.  A 
single-click event can also be specified.

@RegQueryValue
A new query function, @RegQueryValue, provides the ability to query values from the Windows registry.

Right-to-left Outlines
International users can now have their outlines displayed in the right-to-left fashion native to some languages.

Programmability

XML support via ?ReadViewEntries URL command
Release 5.0.2 adds support for a new URL command, ?ReadViewEntries, which returns view data in XML form.  

Alternate Name support for Registration classes
LotusScript NotesRegistration and Java Registration classes contain two new properties, AltOrgUnit and 
AltOrgUnitLang, which support the use of alternate names when creating ID files. In addition, altname and 
altnamelang parameters for the RegisterNewUser method have been added.
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Java createSession allows local user lookup and password
NotesFactory.createSession(String host, String user, String passwd) is expanded to allow the creation of local 
sessions based on either the Notes user ID or (server installations only) a user lookup in the local Domino Directory.

Outline and OutlineEntry classes
Release 5.0.2 contains new and enhanced methods for the Outline and OutlinEntry classes for LotusScript and Java.

Agent.runOnServer method
The LotusScript and Java Agent.runOnServer method has been enhanced so that a client agent that invokes an agent 
to be run on the server may pass a noteid to the server agent. The document represented by the noteid may be used 
to pass input/output parameters between the client agent and the server agent.

Agent.run method
The LotusScript and Java Agent.runOnServer method has been enhanced so that a client agent that invokes another 
agent on the client  may pass a noteid to the invoked agent. The document represented by the noteid may be used to 
pass input/output parameters between the two agents.

MIMEEntity
MIMEEntity is a new class which provides the ability to acquire the unconverted MIME content of Items of type 
MIME_PART.  The MIMEEntity properties in Release 5.0.2 permit reading of MIME entity headers, reading of body 
content as text, and iteration through the individual body parts of a multipart MIME entity.

Domino Server

Performance Monitoring Statistics for Windows NT and Solaris
Domino will track performance metrics of the Windows NT (Intel) and Solaris (Sparc) operating systems and output 
the results to the server console.  They can also be viewed from the Statistics & Events view via the Administrator 
client.

LDAP schema checking enforcement
Release 5.0.2 allows you to enforce LDAP schema checking. If you enforce schema checking, the LDAP service only 
carries out LDAP add or modify operations if the information in the operations conform to the directory schema.  
Enforcing schema checking helps administrators control the content of the directory and helps lay the groundwork for 
future interoperability with other directories.

Additional LDAP schema enhancements
To better comply with LDAP standards, in Release 5.0.2 the LDAP service provides enhancements in areas such as 
street and postalAddress attribute mapping, new mappings for LDAP name attributes, and changes to object class 
definitions. There are many LDAP schema changes. For details, see the category Domino 5 Administration Help in the 
release notes Documentation updates chapter.

Security

Export Internet certificates
In Release 5.0.1 you could import Internet certificates into your User ID file. Beginning in Release 5.0.2, you can now 
export Internet certificates from your User ID file into a file on your local machine, and then import them to use with a 
Netscape browser. Refer to "Importing and exporting Internet certificates" in the Documentation Updateschapter of 
these release notes for additional information. 

ECL permission defaults
Beginning in Release 5.0.2, the ECL entries for -Default- and -No signature- have been changed to have no permissions 
checked. The ECL dialog has also been changed. You will no longer be prompted to trust everybody in the 
organization of the user whose signature you are about to trust. 
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Templates

DA50.NTF template change
The DA50.NTF template now creates a modifiable Group Expansion field in the Directory Assistance document. This 
enhancement allows administrators to control nested group searches in LDAP queries during web authentication. For 
more information, see the Multiple Directories topics in the Domino 5 Administration Help section of these release 
notes, in the chapter Documentation updates.

Mail template enabled with Sametime
Notes mail now supports the ability to see if the sender and recipients of a mail message are online when you read 
that message. You can then have an instant message conversation with one or more of the online people who received 
the e-mail message. This feature is available if you have Sametime Connect installed and are using a Sametime 1.5 
server in your organization.

Java Support
Beginning in Release 5.0.2, the Java Virtual Machine has been upgraded to JDK 1.1.8 for Windows (Intel and Alpha).

Release 5.0.3

Administrator Client, Client, Designer, Server

New Features and Enhancements in Release 5.0.3
Client

Calendaring and Scheduling

Complete Calendar printing for the following paper types: Day Runner Classic, Day Runner Entrepreneur, Day l
Runner Running Mate, A4 210 x 297 mm, A5 148 x 210 mm, B4 and B5.

Release 5.0.3 includes an option in the calendar preferences that allows users to disable the display of meeting l
documents in their inbox. This is for users who delegate control of their calendars to other people, and do not 
want meeting information appearing in the Manager's inbox. 

The Open Calendar feature is an option in the Calendar tools menu. Selecting this option opens a directory search l
dialog called "Open Calendar." The dialog enables users to individually open other people's calendars,  if they have 
been given proper access.

Users of 4.6 Notes client can now open a 5.0.3 user's mail file, for such actions as Check Calendar or Group l
Calendar.

When users print out the weekly view of their calendar, the date will be printed along with the day of the week. l
Example: Instead of just printing out "Tuesday" in the column head, "Tuesday - February 1" will appear.

RTL View Support
Views now support Right To Left display.

Enhanced HTML Import
Enhancements have been made in the importing of HTML file types resulting in better data  fidelity, expanded list of 
supported file formats, and better HTML rendering upon import.

Welcome Page enhancements
The Welcome page has some minor cosmetic enhancements when opting to change your Welcome page.

Restore Bookmark Defaults
If you inadvertently remove any of your default bookmarks (i.e., replicator, designer, workspace), you can now retrieve 
them without deleting your bookmark.nsf file.  
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DECS

The following enhancements have been made to DECS:

Added Linux supportl

Updated the ODBC Connector for compatibility with ODBC 3.5 and to allow access to Microsoft SQL Server 7 l
data sources

User-controlled subfield key orderingl

Improved functionality for domain searches and doclinksl

The DECS Initialize Keys functionality has been modified to allow key fields of the NUMERIC data typel

Stored Procedure browsing & selection from the Connection documentl

International

Indic scripts support 
Beginning in Release 5.0.3, the following scripts and locales are supported in Notes:

Scripts: Devanagari, Tamil 
Locales: Hindi, Tamil, Marathi, Konkani

Please refer to Indic Language support in the International Language Requirements section of theThings you need to know 
chapter  for details.

Messaging

Allow multiple transfer threads to remote domains
A new notes.ini variable for the Domino server, RouterAllowConcurrentXFERToALL, provides the ability to allow 
multiple transfer threads to remote domains.  Previously, multiple concurrent transfer threads were allowed to 
intranet domains only, primarily to prevent multiple threads from being allocated to one or more slow connections.  
This feature allows a simple override to this default behavior.

Router low priority delay notification
Provides the ability to send the author of a low-priority message a custom e-mail which notifies the author that the 
message will be sent during an off-peak time allocated for low priority messages.  This feature is useful for reminding 
people about company policy when sending low-priority messages and the potential for delay.  Therefore, the author 
would be informed and not alarmed that the recipient had not yet received the mail message.

Restrict outbound Internet mail to specific domains or hostnames
Using new fields in the Server Configuration document of the Domino Directory, the Router can now allow or deny 
delivery of messages to specific domains or hostnames.

Support multiple configurable relay hosts
This feature allows Domino administrators to specify that non-local Internet domains can be relayed to different relay 
hosts or to no relay host at all. 

Programmability

New LotusScript API - AgentLSTextFormat
This is a function that receives raw LotusScript code as input, and formats it so that it is understandable by the Notes 
IDE. This is to enhance the abilities of programmers to create agents through the C-API and debug them using the 
IDE.

Java Classes for XML/XSL
New Java classes and methods have been added in Release 5.0.3 to provide services for the developer who needs to 
work with XML data. They include the industry leading XML parser (XML4J) and XSL transform engine (LotusXSL), 
plus a new method to generate XML documents from native Domino documents. For additional information, please 
refer to the topic "XML for Domino" in the Domino Designer Programming Guide, Volume 2, which has been updated for 
Release 5.0.3.
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Search

Search Engine Enhanced
Domino now includes an alternate GTR search engine beginning in Release 5.0.3. This engine is not turned on by 
default. If you activate the new engine, Unicode support becomes available for searches. You will also see 
improvements in search response time, particularly with large databases. This alternate engine is activated by placing 
the following parameter in your notes.ini file:

FT_LIBNAME=ftgtr34

Note that if you activate the alternate search engine using this .ini parameter, Domino will re-build the indices for all 
databases that are currently indexed. If the parameter is later removed from the notes.ini file, all indices will again be 
rebuilt in their original R5 format.

[HISTORICAL NOTE: The GTR search engine has now become the default search engine, instead of the alternate 
engine, as of R5.0.5].

Inxight summarizer
The Inxight Summarizer is a feature for Domain Search on Windows NT that automatically pulls the best n sentences 
out of a document and displays them at search time as the document summary.  This feature only works in 
conjunction with the alternate GTR search engine described above and using domain indexes. For further information, 
see the Release Notes (Chapter 4) document entitled, "Domain Search and the Summarizer -- additional information."

Alternate filter for attachment indexing
In Release 5.0.3, an alternate filter is provided for attachment indexing which enhances the capabilities of the Keyview 
filter.  The alternate filter provides support for file types, such as Ichitaro file format, which are important in 
international regions.  The alternate filter is enabled by using the notes.ini parameter 
FT_ALTERNATE_FILTER=naltfltr.dll.

Server

Additional IMAP client support
IMAP services on the Domino server have been enhanced to provide for wider support of IMAP clients, such as PINE, 
Eudora, Cyrusoft Mulberry, and Execmail 5.1 clients.

IMAP session limits
Domino administrators can now limit the number of sessions that the IMAP server will allow.  A notes.ini parameter - 
IMAPMaxSessions - allows administrators to specify the maximum number of sessions that will be allowed in the IMAP 
server.  If the parameter is not specified, or if the parameter is specified with a value of 0, then no limit will be 
enforced.

NNTP performance enhancement
NNTP replication performance has been improved so less time is spent pulling articles.  The nntpcl5.ntf template is 
required to take advantage of the performance improvements.

DECS on Linux
The Domino install for the Linux operating system now includes the option to install DECS. 

Authentication to LDAP servers
There is a new option in an LDAP Directory Assistance document called "Optional Authentication Credential" which 
enables a Domino server to present a name and password when connecting to an LDAP directory server. If you do not 
specify a name and password, the connection occurs anonymously. For instructions on using this feature, see links in 
the topic "Setting up directory assistance for LDAP directories" in Domino 5 Administration Help. 

Passive Tracking for CALs (client access licenses) and Notes/ Domino Licenses 
You can now select the license type "Lotus iNotes/Domino CAL" to get a total license count in the Server\License view 
of the Domino Directory.   This was included in the R5 easy-to-use tool to assist our non-Notes, web-based clients 
authorized to access a Domino server. For more information on license tracking, see the topic "License Tracking and 
new client license type" in the Documentation updates chapter, Domino 5 Administration Help section.
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Templates

Mail template (mail50.ntf)
Add new action, "Expand date column," to Actions->Folders menu in the mail database.  This allows users to widen the 
date column to accommodate 4-character years (such as 2000).  Folders created pre-R5 template have columns that 
are too narrow.

Personal Journal template (journal5.ntf)
The Personal Journal template has been upgraded to use R5 features such as outlines, framesets, and shared actions.  
It is also web-enabled.

TeamRoom template (teamrm50.ntf)
The TeamRoom template in Release 5.0.3 provides a utility which migrates the design of the R4.x TeamRoom to the 
new 5.0+ design.  

SmartSuite Document Library template (doclbs5.ntf)
Formerly found in the Apps directory of the Notes and Domino CD-ROMs, the  SmartSuite Document Library template 
has been incorporated into the installation process of Notes and Domino.  The template has also been enhanced to 
use R5 features.

XML for Domino

New DTDs
Two new DTDs are documented: Domino View DTD and Domino Document DTD.  Please refer to the topic "XML for 
Domino" in the Domino Designer Programming Guide, Volume 2, which has been updated for Release 5.0.3.

Integrate the XML4J parser and LotusXSL transformation engine
The XML4J Parser and LotusXSL Processor have been packaged with the product, and new methods were added to the 
Domino back-end objects so application developers can easily use them.  The Designer and Server installation kits  
include both jar files.

Version Information:
XML4j 2.0.15
LotusXSL .0.19.1

Java applications/applets/etc that use the remote Domino classes (i.e., not agents) will have to include XML4j.jar or 
XML4j.cab in their classpath to use the XML Parser. And, they will have to also include LotusXSL.jar or LotusXSL.cab 
in their classpath to use the processor. 

Administrator Client, Client, Designer, Server

Value-add applications on the CD-ROM
In addition to the new features found in the Notes and Domino products, the \APPS directory of the R5.0.3 CD-ROM 
contains applications which enrich the capabilities of Notes, Designer, and Domino. Additional information about 
these applications can be found in the "Additional items on Notes and Notes/Domino/Domino Designer CD-ROMs" and 
"Additional items on the Domino CD-ROM" documents in the Directory Install and CD-ROM Structure section of the Things 
you need to know chapter. Updated applications found on the R5.0.3 CD-ROM include:

Domino "Tivoli Ready" (updated)
The files which make the Domino Server for AIX and Solaris (Sparc) "Tivoli Ready" have been updated for the R5.0.3 
release. Customers can manage their Domino Server software under an integrated Tivoli management umbrella. This 
provides customers with the ability to automatically discover, inventory and monitor Domino servers with Tivoli 
Enterprise management products.  

SmartSuite Document Library template (updated)
Beginning in R5.0.2 the SmartSuite Millennium edition document library template was included in the \APPS 
directory.  Now with the release of R5.0.3 the template has been incorporated into the install kits.  See the "Additional 
items on Notes and Domino CD-ROMs" topic in the Things you need to know chapter for more details.

cc:Mail MTA (updated)
To help administrators ease the upgrade from cc:Mail to Notes, we have included an updated release of the cc:Mail 
MTA (R5.0.3) in the APPS directory of the R5.0.3 CD. Please refer to the Release Notes for more information or visit  
the migration web site at http://www.lotus.com/products/migration.nsf.
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Fonts (updated)
The self extracting fonts file contains an updated MTSANS_W.TTF which improves the spacing of the font.  
MTSANS_W.TTF covers the WGL4 character set. This font is suitable for use with most uses of the Latin alphabet 
(including all diacritical marks), as well as Greek, Cyrillic, Slavic, Turkish, Arabic and Hebrew languages.

Dictionaries (updated)
The self extracting dictionaries file contains a new dictionary file called DEUTSCH2.DIC, which allows the spell-checker 
to support additional German dialects. Note that this is unavailable for the Macintosh at this time, but it is present in 
the Notes Windows-based client.

Sametime (new)
Beginning in R5.0.2, Notes mail supports the ability to see if the sender and recipients of a mail message are online 
when you read that message.  One of the prerequisites for getting the "Who Is Online" button to work is that the 
Sametime administrator must set up the Sametime server to support "Who is Online". The files necessary to 
accomplish that step are found in the \APPS\SAMETIME subdirectory of the Notes/Domino/Domino Designer 
CD-ROM.

Domino Global Workbench (updated)
Domino Global Workbench has been updated for the R5.0.3 release. New features include: HTML support - text in 
pages marked 'Treat contents as HTML' is now tagged as HTML; JavaScript is supported; Build Options dialog  
contains a new check box, 'Disable LotusScript Recompilation'.  See the What's new in Domino Global WorkBench Release 
5.0.3 document for further details.

 Actioneer (updated)
New for Lotus Notes R5.0.3! Actioneer for Lotus Notes is now speech-enabled with IBM's ViaVoice technology!
Actioneer for Lotus Notes is an intelligent, quick-capture tool that lets you quickly and easily save information to your 
Notes Calendar, To Do list, and Journal database.  

Server.Load (updated)
Our Domino server capacity tool has been updated for the R5.0.3 release, as we continue to strive for constant 
improvement.  

Client

Restore Bookmark Defaults
With Release 5.0.3, if you inadvertently remove any of your default bookmarks (i.e., replicator, designer, workspace), 
you can now retrieve them without deleting your bookmark.nsf file.  To do this, open one of your bookmark folders 
(i.e., Databases or Favorites), select the drop down arrow at the top of the frame, and select Restore Bookmark 
Defaults. 

Also, new default bookmarks added to the template will be automatically added to the user's set of bookmarks (no 
user intervention required).

Client, Designer

TeamRoom contains migration utility for 4.x to 5.0
The R5 Client comes with a new template called TeamRoom (teamrm50.ntf). This template is not compatible with the 
R4.x version of TeamRoom developed by the Lotus Institute.

There is a utility built into the 5.0.3 TeamRoom which migrates the design of the R4.x TeamRoom to the new 5.0+ 
design.  Follow these steps to ensure compatibility with R4.x TeamRoom databases:

Replace the design of the R4.x TeamRoom with the 5.0.3 TeamRoom template.1.

Open the database and select Actions->Convert TeamRoom 4.1 to new 5.0 Design.2.

Administrator Client

User's internet address is not changed when registering users migrated from an LDIF file
When registering users migrated from an LDIF file, the domain name portion of the user's Internet address remains 
intact, that is, exactly as it was in the LDIF file. The administrator can change the user's Internet address by modifying 
the entry in the Internet address field. When registering users not migrated from an LDIF file, the Internet address is 
changed to reflect the default domain name as displayed in the Internet Domain field on the Basics pane of the User 
Registration dialog box.
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Release 5.0.4

Administrator Client, Client, Designer, Server

New features and enhancements in Release 5.0.4

Client

Calendaring and Scheduling - Location change notification
Lotus now provides the ability for the Chairperson of a meeting to add a room or change the location of a meeting and 
have it automatically send a reschedule notification to all invitees.

Directories  

Directory Assistance
Beginning in R5.0.4, directory assistance can now failover to an alternate replica of a secondary directory without a 
server restart.  For further details, refer to New Features in the What's New section of the R5.0.4 Release Notes.

Directory Catalogs
R5.0.4 brings improvement in the area of Directory Catalogs by supporting the use of selection formulas to use only a 
subset of documents from secondary directories.  Server directory catalogs now support full functionality for R4.6 
clients.   For further details, refer to New Features in the What's New section of these R5.0.4 Release Notes.

LDAP
LDAP services are enhanced by providing support of more name formats for members of external LDAP directory 
groups, providing more flexibility in the storage of telephone numbers, returning the base entry on subtree searches, 
and LDAP recognition of group membership changes in a Domino Directory.  Additional enhancements include the 
removal of case-sensitivity when searching the mail attribute as well as returning better results when doing wildcard 
searches on the mail attribute.  For further details, refer to New Features in the What's New section of these R5.0.4 
Release Notes.

Java

JVM Upgrade in Domino for AIX and Linux
The Java Virtual Machine in Domino for AIX has been upgraded to 1.1.8-6 and the JVM in Domino for Linux has been 
upgraded to 1.1.8-2.

Remote access to Domino back-end objects from WebSphere
A new jar file called NCSOW (Notes Client-side Objects for WebSphere) is provided which allows an IBM WebSphere 
application to access the resources of a Domino server which is on a separate machine using the Domino back-end 
objects.  Previously, WebSphere could only access Domino resources if they were running on the same machine.

Programmability

Additional parameter for LotusScript OpenView method
The OpenView method of NotesUIDatabase has a new, fourth parameter called replaceView.  For additional 
information, refer to the Domino 5 Designer Help section of the Documentation Updates chapter in these Release Notes.

Security

Notes and Domino consolidated to a Global encryption
Beginning in Release 5.0.4, the Domino server, Notes client, Administrator client, and Designer client products have 
all consolidated three encryption strengths, North American, International English, and French editions, into one 
strong encryption level resulting in a single "Global" release of the products. The R5.0.4 Global release adopts the 
encryption characteristics previously known as North American. This change is a result of the relaxation of U.S. 
Government export restrictions which allows for export of strong encryption technology outside of North America. 
Therefore, the strong encryption in the Global products can be used worldwide, except in countries whose import laws 
prohibit it. More detailed information can be found in the Security section of the Things you need to know chapter of 
these Release Notes.
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Server

Webmail performance improvements  
The Domino server has been enhanced to yield improved performance of Webmail on all platforms. Some 
enhancements have yielded further performance improvements on the Unix platforms.

Partitioning Enhancements
Beginning in R5.0.4, support is added for a new notes.ini variable called "PercentAvailSysResources".  This parameter 
allows administrators to limit the amount of physical memory allocated to each partition on the server.  It is also 
applicable to client partitions running on a Citrix MetaFrame server or Windows Terminal Server.  For further details, 
refer to New Features in the What's New section of the R5.0.4 Release Notes.

Administrator Client, Client, Designer, Server

Value-add applications on the CD-ROM
In addition to the new features found in the Notes and Domino products, the \APPS directory of the R5.0.4 CD-ROM 
contains applications which enrich the capabilities of Notes, Designer, and Domino. Additional information about 
these applications can be found in the "Additional items on Notes and Notes/Domino/Domino Designer CD-ROMs" and 
"Additional items on the Domino CD-ROM" documents in the Directory Install and CD-ROM Structure section of the Things 
you need to know chapter. Updated applications found on the R5.0.4 CD-ROM include:

Domino "Tivoli Ready" (updated)
The files which make the Domino Server for AIX and Solaris (Sparc) "Tivoli Ready" have been updated for the R5.0.4 
release. Customers can manage their Domino Server software under an integrated Tivoli management umbrella. This 
provides customers with the ability to automatically discover, inventory and monitor Domino servers with Tivoli 
Enterprise management products.  

Lotus Translation Components (new)
The Lotus Translation Components (LTC's) enable businesses to rapidly add on-demand machine translation 
capability to Domino-based Web applications via the Domino Translation Object (DTO) and Translation Connectors.  
With the DTO, now a component of the LTC's, Domino can drive a wide range of popular Machine Translation (MT) 
engines using the complete control and flexibility of a structured programming language: LotusScript and Java.

cc:Mail MTA (updated)
To help administrators ease the upgrade from cc:Mail to Notes, we have included an updated release of the cc:Mail 
MTA (R5.0.4) in the APPS directory of the R5.0.4 CD. Please refer to the Release Notes for more information or visit  
the migration web site at http://www.lotus.com/products/migration.nsf.

Release 5.0.5

Administrator Client, Client, Designer, Server

New features and enhancements in 5.0.5
Administration

Administration Process now supports updates to Private Design Elements

Notes and Domino supports the renaming of private design elements in Administration Process rename user requests 
beginning in R5.0.5. Before this enhancement, the rename user request was unable to rename private design elements 
and sign them. Now, the server builds the list of design elements when the user authenticates and signs the elements 
after the rename has taken place. 

For more information, see the Release Note entitled "AdminP now supports updates to Private Design Elements."  
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Client

Calendar Printing for International Formats 
Calendar and Scheduling printing now supports international formats and characters. For localized language versions 
of Notes, users can print calendars in the same format as they appear on screen. 

Terra Added as Welcome Page Option 

The Welcome page for the Notes client now includes access to Terra, a Spanish-language news and entertainment 
portal. This Welcome page has three frames: the user inbox in the top left frame, a calendar in the bottom left frame, 
and the Terra portal in the right frame.

For more details on setting up Terra, see the Release Note entitled "Headlines with Terra."

New "By Author" View in TeamRoom Template 
The TeamRoom template included with Notes and Domino has been enhanced to include a "By Author" view, so that 
team room participants can view all documents categorized by author.

New User Preference, "Show in-line MIME images as attachments"
A new setting called "Show in-line MIME images as attachments" has been added to the User Preferences (basics) 
dialog box, listed under Additional Options. When this setting is checked, all multi-part/mixed in-line images will 
display as attachment icons. When this option is not checked, multi-part/mixed in-line images will be embedded in a 
Notes document. The setting corresponds to a NOTES.INI variable called "ShowIMIMEImagesAsAttachments".  

Directories

Support Added for LDAP Search References 

Prior to this release, the Notes Client was unable to correctly handle LDAP search references, which are more correctly 
known as LDAP Continuation References as defined in RFC 2251 Paragraph 4.5.3.  Starting in Release 5.0.5,  the 
Notes client has been enhanced to correctly process these returns (which contain a mix of search results from the 
responding directory and referrals to other directories that may contain additional results).

For more information regarding LDAP search references, see the Release Note entitled "Client Support for LDAP 
continuation references".

Extended Directory Catalog 

The Extended Directory Catalog combines advantages of the Domino Directory and the standard Directory Catalog by 
aggregating entries from multiple Domino directories into a single directory database.  This is similar to the 
construction of a standard Directory Catalog but retains the full set of indexed views and other features of the Domino 
directory.  This enables the enterprise to maintain a single consolidated server-based directory structure that 
responds rapidly to a variety of search patterns and can contribute to enhanced mail router performance.  

For more details on the capabilities and configuration of the Extended Directory Catalog,  see the Release Note 
entitled "Extended Directory Catalog". 

Programmability

TrimTrailingSpaces property added for ODBCResultSet

ODBCResultSet has added a new property in 5.0.5, TrimTrailingSpaces, which will indicate whether trailing spaces are 
trimmed from character values upon retrieval.   

For more details on using the TrimTrailingSpaces property, see the Release Note entitled "TrimTrailingSpaces 
property for ODBCResultSet".

AddressBooks property of NotesSession now returns directory catalogs

As of 5.0.5, the AddressBooks property of NotesSession returns directory catalogs. The (already available) 
IsDirectoryCatalog property of NotesDatabase is True for a database retrieved through AddressBooks if it is a directory 
catalog and False if it is not. The database must be explicitly opened to see this property. This property always is 
False for a database retrieved through a means other than AddressBooks.
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Search
New GTR Search Engine Now On by Default

In R5.0.3 and R5.0.4, Lotus included with Notes and Domino a new search engine designated GTR-34 (in addition to 
the engine that originally shipped with Notes and Domino R5). The GTR-34 engine was not turned on by default in 
these releases, however. 

Beginning in R5.0.5, the newer GTR-34 engine has become the default search engine. It is automatically turned on 
when you upgrade to R5.0.5. Using the new GTR-34 engine, unicode support becomes available for all searches. You 
will also see significant improvements in search response time. GTR-34 reduces the size of indices up to a factor of 5. 
It also delivers query lookup performance that is significantly faster than the original engine. 

Note that Domino will re-build indices for all databases that are currently indexed, unless your administrators already 
activated the GTR-34 engine and allowed it to rebuild all indices when GTR-34 was first released in R5.0.3/R5.0.4. 
Domino will rebuild indices on both the 5.0.5 server and on Notes client machines which access the 5.0.5 server. The 
original search engine can be retained by placing the following parameter in your NOTES.INI file. The parameter must 
be present on any client or server where you want to retain the old search engine and prevent the rebuilding of indices:

FT_LIBNAME = ftgtr

Security
Workstation ECL Refresh Button
The Workstation Security: Execution Control List dialog box has been updated to include a Refresh button that 
automatically updates the workstation ECL with settings from the Administration ECL on the user's home server. You 
can use the new Refresh button in place of the previous method that required administrators to create a button with a 
formula and insert it in a mail message to roll out updated ECLs to users' workstations. 

For more details on using the Workstation ECL Refresh button, see the Release Note entitled "Using the Workstation 
ECL Refresh Button". 

Server
Templates Enabled for DOLS 

Domino Off-Line Services (DOLS) provides a way for browser users to utilize Domino Web applications offline. Using a 
browser, the user can take a Domino application offline, make changes, and synchronize those changes with the online 
version. Beginning in R5.0.5, Webmail (mail50ex.ntf--extended mail template) and the Web Discussion templates are 
enabled to work with DOLS. For more information about DOLS, refer to the Lotus Web site at:

http://www.lotus.com/developers/offlineservices

DOLS 1.0.1 Incorporated into the Domino Server 
Domino Off-Line Services (DOLS) 1.0.1 has been incorporated into the Domino kit as of 5.0.5. DOLS enables Web 
browser users to use Domino applications while disconnected from the network. These applications can be replicated 
later, either on-demand or on a scheduled basis. As of 5.0.5, DOLS 1.0.1 is also supported on the OS/2, AIX, and 
Solaris server platforms.  Users should refer to the DOLS topics in the Admin and Designer help files for complete 
information about how to implement and use DOLS.

iNotes Access for Microsoft Outlook - Calendaring and Scheduling and DOLS Support  

iNotes Access for Microsoft Outlook now allows Microsoft Outlook users to access their mail, calendaring, and 
scheduling information using a Domino server instead of Exchange. With iNotes Access for Outlook, organizations can 
take advantage of the Domino capabilities, such as reliability, scalability and expanded platform coverage, for their 
messaging infrastructure without changing clients. Additionally, as of 5.0.5, iNotes Access for Microsoft Outlook now  
utilizes the Domino Off-Line Services (DOLS) technology to not only help in the delivery of the client code to the end 
users, but by enabling end users to access their mail while disconnected. Users should refer to the iNotes Access for 
Microsoft Outlook and DOLS topics in the Admin and Designer help files for additional information.
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WebMail   

Several new features have been added to WebMail, including client performance improvements, off-line capability 
enablement, support for server-based Directory Catalogs, and overall user interface improvements.

To improve client performance, the Outline and View Domino Java applets have been removed and replaced with l
corresponding HTML-based elements. The implementation of the Rich Text editor applet has also been changed.  
Creating a new mail message now generates a standard HTML field as the mail message body field, with an 
option for the user to switch to the Rich Text editor Java applet.

Users can now select multiple documents in an HTML view, something not possible with regular Domino HTML l
views. The new HTML view is used in place of the Java view applet (which until now,  was the only way users could 
select multiple documents from a view, on the web). HTML views load faster than Java applet views, hence 
Webmail performance is improved.

The mail component of WebMail has been enabled for off-line use. This enablement was based on Domino l
Off-Line Services, using the mail50ex.ntf template.  (The Calendar and To-do sections of WebMail of  have not 
been enabled for off-line use.)

In addition to the user's Personal Address Book, and Domino Directories, server-based Directory Catalogs have l
been added as a supported address directory type.

User interface polishes included improved alignment of the Action Bar Java applet, treatment of navigation ll
folders, and other minor touch-ups throughout the product.

Websphere and Domino Integration  

Several improvements have been introduced in Domino R5.0.5 to better integrate with IBM WebSphere software.

Single sign-on across Domino Web servers

A Web user can now log on once to a Domino server, then access any other Domino server in the same domain without 
logging on again. This is accomplished with a new "multi-server" option in the Server record for session-based 
authentication, along with a new configuration document in the Domino Directory called the Web SSO document. Note 
that all Domino servers participating in multi-server session authentication must be at the Domino R5.0.5 level or 
above, and users' Web browsers must have cookies enabled. For more details about deploying this feature, see the 
Release Note entitled "Enabling Single Sign-on for Domino and WebSphere servers". 

Single sign-on with WebSphere Application Server 3.5

A Web user can now log on once to a Domino server, then access any WebSphere Application Server 3.5 without 
logging on again. This is accomplished by setting up the new "multi-server" option for session-based authentication 
and importing the secret key from a WebSphere server rather than generating it in Domino. The WebSphere server(s) 
must be configured in secure mode and use WebSphere's LTPA (Lightweight Third-Party Authentication) protocols. 
The WebSphere server(s) may use the Domino Directory as the repository for user definitions and passwords or 
certificates, via Domino's LDAP service.  Note that all servers participating in a single sign-on domain must be at the 
Domino 5.0.5 and/or WebSphere Application Server 3.5 level. For more details about deploying this feature, see the 
Release Note entitled "Enabling Single Sign-on for Domino and WebSphere servers". 

New Java API options for authenticated invocation

New options in the Notes APIs for Java allow sessions between Domino servers, or calls between Domino and 
WebSphere 3.5 Java code, to carry a user's authenticated identity. The servers must be set up to utilize the "single 
sign-on" features introduced in Domino R5.0.5 and WebSphere 3.5. For more details about these API changes, see the 
Release Note entitled "Enabling Java API options for authenticated invocation". 
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Release 5.0.6

Administrator Client, Client, Designer, Server

New features and enhancements in 5.0.6
iNotes Access For Microsoft Outlook

Password Management and Mail Delegation Options for iNotes Access For Microsoft Outlook users
A new properties panel has been added, which will allow iNotes users to change their password, delegate access to 
their mail file, and easily configure an Outlook profile to access a mail file that has been delegated to them.  This new 
feature is accessed through the Outlook properties panel.  Previous to Release 5.0.6, Administrator intervention was 
required in order to change user passwords and/or to set up mail delegation for users of iNotes Access for Microsoft 
Outlook.  

Please refer to the Release Notes entitled "Instructions for using Delegation (Managed Calendar) with iNotes" and 
"Changing passwords with iNotes Access for Microsoft Outlook" for more detailed information.

Messaging 

SMTP exceptions to authenticated hosts
With R5.0.6, a new feature is added, allowing for an exception list of hosts and/or IP addresses that are not required 
to authenticate when SMTP authentication is required (when Anonymous SMTP Access is turned off ). This is enabled 
via a new NOTES.INI parameter, SMTPAllowConnectionsAnonymous=1.  Prior to this release, authentication was 
required when Anonymous SMTP Access was turned off in the server document.

By adding the new NOTES.INI variable, particular hosts or TCP/IP Addresses (for example, Domino Servers, sub-nets) 
can be excluded from being required to authenticate. For details on enabling this feature, see the Release Note 
entitled, "Information on enabling SMTP exceptions to authenticated hosts". 

Release 5.0.7

Administrator Client, Client, Designer, Server

New features and enhancements in 5.0.7
Full Text Search

Ichitaro file format support
In Release 5.0.7, Full Text Search supports attachments in the Ichitaro file format.

Please refer to the Release Notes entitled "Instructions for enabling Ichitaro format in full-text search"  for more 
detailed information.

iNotes Access for Microsoft Outlook

Language Selection options for iNotes Access for Microsoft Outlook
iNotes Access for Microsoft Outlook now allows Microsoft Outlook users to install the preferred language files directly 
from the download page.  Prior to Release 5.0.7, the language selected in your operating system's Regional Settings 
were always installed by default; and other language options were not configurable from the download page. 

Please refer to the Release Note entitled, "Using Language Selection options for iNotes Access for Microsoft Outlook"  
for implementation details. 

Java

JVM Upgrade in Domino for OS/2
The Java Virtual Machine in Domino for OS/2 has been upgraded to 1.1.8.

Domino Off Line Services

Cross certificate support for DOLS synchronization 
The iNotes Sync Manager will now automatically copy and configure an offline cross certificate, from the host server (if 
available), when the synchronization ID is certified with a public key different than the host server.
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Release 5.0.8

Administrator Client, Client, Designer, Server

New features and enhancements in 5.0.8
Upgrade by Mail

Enhanced upgrade by Mail for 5.0x to Rnext upgrade
The enhanced Upgrade-by-Mail feature provides a wizard-like interface to allow Domino administrators to create and 
mail a customized upgrade message to Notes users. At the Administrator's option, recipients can upgrade their Notes 
client code by clicking a single button in the memo, or run setup automatically upon opening memo.

Administration

Ability for Administrators to create New Replicas of Mail Files
The new Create and Move Database Replica feature allows administrators to create and move database replicas 
regardless of whether they have access to the database. Administrators can create a replica without opening the 
database and obtaining the replica ID. The three administration process requests that formerly checked for the replica 
ID no longer do so. These requests are Check Access for Create Replica, Check Access for Move Replica, and Check 
Access for Non-cluster Replica Move.

The primary benefits derived from this new feature are ease of administration 
for load-leveling applications and more consistent delegation of 
administration duties. Application load leveling is more available because 
administrators can easily move applications from overloaded servers to 
less-utilized servers. Delegation of duties is more consistent because 
administrators alone can move applications to other servers while application 
designers can concentrate on designing applications.

DOLS

CD Level 1 support (pre pack of DOLS file sets and application replicas)
DOLS Client CD can be configured to pre pack application replicas.

iNotes Web Access

New iNotes Web Access feature
iNotes Web Access is a next-generation Web client that delivers leading Domino messaging, collaboration, and PIM 
(Personal Information Management) capabilities to Web browsers. For the first time ever, browser users will be able to 
take full advantage of Domino services through an ultra-intuitive, easy-to-use interface -- both on- and off-line, 
seamlessly.

iNotes Web Access offers:

A leading edge Web client: iNotes Web Access combines the simplicity and universality of a Web browser with the ll
power of an enterprise-class, full-featured application.
All the advantages of Domino: Extend your enterprise or e-business by delivering Domino to customers, business ll
partners and end users through a sophisticated Web client.
On-line and off-line access: For the first time, give Web browser users access to e-mail, calendar, group ll
scheduling, to do list and personal contacts-whether they're on-line or disconnected.
Rapid, no-touch deployment: Instantly deliver Domino collaborative services to all your browser users.ll
Instant messaging and collaboration: iNotes Web Access integrates with Lotus Sametime and DOLS, letting ll
browser users see who's on-line, send instant messages, chat with colleagues in realtime and collaborate over the 
Web.

Browser support for Linux

Netscape supported on Red Hat 6.x
Beginning with Release 5.0.8, Netscape Communicator 4.7 is a supported browser on a Red Hat 6.x Linux client when 
used in conjunction with a Domino server.

Windows 2000 Advanced Server and Windows 2000 Datacenter support

Windows 2000 Advanced Server and Windows 2000 Datacenter editions supported
Beginning with R5.0.7, Windows 2000 Advanced Server and Windows 2000 Datacenter editions are supported 
platforms for the Domino server.   

Support for Windows 2000 Server and Windows 2000 Professional for the Domino server and Notes client respectively 
began with R5.0.3 and continues forward.
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Release 5.0.9

Administrator Client, Client, Designer, Server

New features and enhancements in 5.0.9
DECS

Lotus Connector for DB2 2.0
Release 5.0.9 includes the Lotus Connector for DB2 2.0.  This version has the following features:

It is certified for use with DB2 UDB version 6.x and 7.1.l

It has the ability to handle output parameters from stored procedures.l

It includes support for BIGINT and XML data type, support for scrollable cursors in LotusScript and LC Java and l
improved response time for operations involving the DB2 timestamp feature.

For more information, please see the Lotus Connectors and Connectivity Guide for LEI 3.2 on 
http://www.lotus.com/ldd.  This version of the Lotus Connectors and Connectivity Guide contains the Lotus Connector 
for DB2 version 2.0 information.

DOLS

DOLS Compact/Full Text Search Configuration Settings
DOLS Compact/Full Text Search Configuration Setting allows administrators to turn on and off the Database 
compaction and full-text search indexing process of their users from within the DOLS configuration form.  The default 
setting will remain "On" as this has been the past behavior.  These processes currently occur during the DOLS 
synchronization process.

DOLS local encryption support
Local encryption of databases within downloaded subscriptions to a DOLS client machine is now supported through 
new settings within the DOLS configuration document.

Off-line Directory Catalog support
Off-line Directory Catalogs can be utilized for DOLS-enabled applications for directory lookups, addressing, etc.  The 
feature is available through a new settings within the DOLS configuration document.

Domino Upgrade Services (DUS)
The Exchange DUS now includes a "convert mail only" option that allows the DUS to write to an existing Notes mail file, 
rather than creating a new mail file.

iNotes for Web Access (IWA)
Full Alternative name support for iNotes Web Access
IWA has been enhanced to fully support alternative names, just as Notes/Domino provides ability to set 'Alternate 
Name' for Notes users in Notes/Domino R5.  This ability enables users to use alternate representation as their user 
names in their native language other than the ordinary Domino primary user name to display user names.  Notes R5 
provides ability to turn on/off the alternate name display and also provides capability to display the alternate name in 
many places.  

Name resolution when sending mail
This allows an IWA end-user to check the names of recipients of an e-mail for accuracy before sending with the click of 
a button. It prevents mail from being misdirected or not received because the recipient's name was misspelled. This 
provides the similar type of functionality that Notes users have with the type-ahead feature in memo addressing. Lotus 
has opted not to enable type-ahead addressing in IWA because of performance considerations; however, users can 
now, with a single click of button, resolve incorrectly spelled names in an address field from a pop-up list of 
alternatives when no match is found.

Roll back to the HTML file upload/download control if ActiveX controls are not permitted
Some companies restrict the use of ActiveX controls by users for security purposes. IWA leverages an ActiveX control 
for the file upload/download control. This new feature will allow for the "roll back" to a non-ActiveX control that will still 
provide users the ability to upload or download file attachments. It will however, not provide some of the drag and 
drop capabilities that the ActiveX control does, but the basic feature will now be available to users who can't use 
ActiveX controls. 

Support for personal group names
IWA has added the ability for users to create and manage personal groups, similar to the personal groups in the Notes 
client Personal Address Book. These personal groups are stored in the user's mail file and can be used for all mail and 
C&S features. 
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iNotes Access for Microsoft Outlook
Local DB encryption support
Users can now set local encryption of a mail database within the download page.

Off-line Directory Catalog support
Users can now use a company address book ( Domino Directory Catalog) while off-line.

Security
Support for Domino to issue Single Sign-On cookies when authenticating a user name via a DSAPI filter
In R5.0.9, the Single Sign On feature introduced in R5.0.5 has been enhanced to support user authentication using a 
DSAPI filter.   After the DSAPI filter authenticates the user, the Domino server will issue a session token for the user if 
multi-server session authentication is enabled on the server.  For more details on configuring your Domino web server 
for single sign on, please refer to the Release Note titled "Enabling Single Sign-On for Domino and Websphere".

Notes URL Support
The Notes URL (notes://) allows a web page developer to add links to Notes documents, views, and databases into a 
web page.  This functionality allows a web browser user to launch a Notes URL like it was a Notes doclink, view link, or 
database link.  When a browser user clicks on a Notes URL link, it will launch the Notes client (if it wasn't already 
running) and will open the appropriate document, view, or database.  

The feature already works in Notes 5.0 but the Notes install program does not add the entry in the Windows registry 
for the notes protocol handler.  A customer must add this manually.  In release 5.0.9, the Notes client installer will 
automatically add the Notes protocol handler information to the registry.

Release 5.0.10

Administrator Client, Client, Designer, Server

New features and enhancements in 5.0.10
Client

Windows XP Professional supported for Client

Beginning in Release 5.0.10, Lotus Notes adds support for the new Windows XP platform. It is important to note that 
this support is for the XP Professional only.

Systematic replicating by NotesMinder when mail replica is local and Notes Client is not active

In R5.0.10, NotesMinder will use the server mail replica to replicate with the local mail file, using polling interval 
defined in the NotesMinder Preferences dialog box. This will be done only when:

Notes client is not currently running, and;l

The active location record is set to use a local mail file.l

This is MS-Windows only.

This feature uses the time-tested Notes Client DLL to replicate, and is incorporated into the failover code of 
NotesMinder for reliability.

If the current location record uses a local mail file and while the Notes client is not running, NotesMinder will replicate 
in one direction, from the server to the local file, with the server replica designated in the personal location. The user 
will not have to manually replicate to see the new mail on their client system. 

NotesMinder will do its polling systematically on the server mail replica, thus bypassing whatever is referenced as 
"MailFile" in the Notes.Ini or personal location document. 

With this feature, the user would no longer have to agree to have polling done on the server replica and have to 
replicate manually to see the mail arrive in its local mail database. This is also true if the user wants to look at the 
header of the messages (he would always look at header of messages on the server replica).
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Client - International

GB18030 support

R5.0.10 supports GB18030-2000 (the new Chinese character set) for the first phase of the Chinese Government 
conformance requirements, which includes the characters in CJK Unified Ideographs Extension A and 4 scripts 
(Uygur, Tibetan, Mongolian and Yi).  Characters in CJK Unified Ideographs Extension B are not supported in this 
release.  Please contact operating system venders to verify which versions or patches support GB18030. The 
supporting levels of the new characters could differ by function.  Please refer to the Release Note entitled "Settings for 
GB18030 support" for more details.

All - Install

Install screen contains version number

Customers installing R5.0.10 can now see the release number of the version that they are installing. The version 
number appears in the Title Bar of the installation screen.

Release 5.0.11

Administrator Client, Client, Designer, Server

New features and enhancements in R5.0.11
Client

Microsoft Office XP supported for Client

Beginning in Release 5.0.11, Lotus Notes adds support for the Microsoft Office XP platform in the following areas:

Office Libraryl

OLE Objectl

Active Docl

Drag and Dropl

Word as NotesMail Editorl

Send mail from Officel

Internet integrated browsel

Platforms

End of Life for Domino Windows NT Alpha starting with 5.0.11

Domino for Microsoft Windows NT Alpha will no longer be updated starting with 5.0.11.  The last version of Domino for 
Windows NT Alpha is 5.0.10, and no subsequent versions will be developed.  Existing deployments of Domino 5.0.10 
and Domino versions prior to 5.0.10 will continue to be fully supported on Windows NT Alpha.  There is no plan or 
intent to support Windows NT Alpha in future versions of Domino.

End of Life for Domino Solaris Intel x.86 starting with 5.0.11

Domino for Solaris Intel x.86 will no longer be updated starting with 5.0.11.  The last version of Domino for Solaris 
Intel x.86 is 5.0.10, and no subsequent versions will be developed.  Existing deployments of Domino 5.0.10 and 
Domino versions prior to 5.0.10 will continue to be fully supported on Solaris Intel x.86.  There is no plan or intent to 
support Solaris Intel x.86 in future versions of Domino.  We will continue support Domino for Solaris SPARC for 
Domino R5.0x and Domino 6.

Ending support for these platforms does not signify a change in the Lotus platform strategy.  The Software Group at 
IBM and the Lotus team have long acknowledged that a heterogeneous platform strategy offers our customers the 
flexibility to deploy Domino within a complex, cross-platform infrastructure.  This flexibility is valued by our 
customers, who frequently wrestle with the challenges of integrating applications on an infrastructure that spans 
multiple hardware and server operating system platforms.  The cross-platform support that we will continue to deliver 
with Domino is a powerful message that differentiates Lotus and Domino from Microsoft and Exchange.
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Server

Updated Domino SNMP Agents for Domino R5.0.11
Updated Domino SNMP Agents as of Domino R5.0.11
As of Domino R5.0.11, on Domino Server media, the directory apps/sysmgmt/agents contains a revised version of the 
Lotus Domino SNMP Agents Release 5.01.  The Lotus Domino SNMP Agents themselves are unchanged, but the 
Domino MIB (Management Information Base) has been updated.  Syntax errors in the Domino MIB (file domino.mib), 
which were revealed by modern MIB compilers, have been corrected.  The MIB object hierarchy is unchanged, as are 
all other components of the Lotus Domino SNMP Agents.

Updated Domino SNMP Agents as of Domino R5.0.10
As of Domino R5.0.10, the PEER Master agent and PEER Encapsulator agent have been updated to not fault on certain 
malformed SNMP PDUs.  If you use the PEER agents on HP-UX or Solaris you should re-install them to get these 
updates.  See below for additional information.

In a separate change, the Domino SNMP Agents install procedure for AIX has been modified to automatically set the 
number of data segments used by the Domino SNMP Agent executables to the same number used by Domino.  This 
fixes initialization errors that would produce the following message on the server console:

0x01FE:This process "add-in-name" is unable to map the required amount of shared memory. Please refer to the 
documentation on how to fix this.

These revisions do not affect other components or platforms in any way.

To verify you are running an updated PEER Master agent type the following:

/etc/peer.snmpd -v

If you see the response "OptiMaster Release 1.8a" then you have already installed the update.  If the command is "not 
found" then you are not using the PEER Master agent.  If you see a "Usage" message then you should install the 
update.

To verify you are running an updated PEER Encapsulator agent type the following:

/etc/peer.encaps -v

If you see the response "OptiMate Encapsulator Release 1.8a" then you have already installed the update.  If the 
command is "not found" then you are not using the PEER Encapsulator agent.  If you see a "Usage" message then you 
should install the update.

See the apps/sysmgmt/agents/nvagents.nsf database for additional information and installation instructions.

Release 5.0.12

Administrator Client, Client, Designer, Server

New features and enhancements in R5.0.12
Browser

Mozilla supported on OS/2
Beginning with R5.0.12, Mozilla is a supported web browser for IBM OS/2.

Netscape 7/Mozilla supported on Linux
Beginning with R5.0.12, Netscape 7 (Mozilla) is a supported web browser for Linux.

Calendar and Scheduling

Better functionality using Repeating events in a mixed R5 and Notes 6 environment
The Repeating event model has been updated to provide better functionality in a mixed Notes R5.0.x and 
Notes/Domino 6 user environment.  For example, reschedules of Repeating meetings in Notes 6 and later will work 
seamlessly with R5 users.
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DECS

Access to Microsoft SQLServer data for DECS, via OLE-DB
The Lotus Connector for OLE-DB provides native connectivity to Microsoft SQL 2000 and Microsoft Access 2000.  The 
OLE-DB Connector is certified on Windows NT and Windows 2000, and can be used with DECS 5.0.12. You may also 
use the OLE-DB Connector with the Lotus Connector LSX.

DOLS

Install and Configuration Support for Multi-server SSO/DSAPI environment
Users authenticated in Multi-server SSO or DSAPI external authentication configurations can now install and configure 
DOLS-enabled applications for offline use.

Subscription download support for Reverse Proxy server configurations
DOLS subscriptions can be downloaded and installed offline in Reverse Proxy server configurations, including iPlanet.

Subscription configuration support for dual TCPIP addresses, for Notes RPC connection to Domino servers
Administrators can configure a Domino server to support DOLS subscriptions from intranet and extranet environments 
where unique TCPIP addresses are used to connect via Notes RPC.

Platforms

Citrix Metaframe XP FR2 support
Beginning with R5.0.12, the Notes client is supported on Citrix Metaframe XP FR2 servers.  As with any MultiWin 
Server solution, performance considerations should be taken into account to ensure proper resource allocation.  We 
tested Citrix Metaframe XP FR2 server with Notes 5.0.12, and found that up to 15 Notes users could utilize the Citrix 
server simultaneously, but the performance hit was high (performance started to downgrade after 10 users).

Results will vary widely depending on RAM and processor speed of the Citrix server and tuning parameters in effect.  
The system used for our test had 524 MB of RAM and two Pentium II processors (450 MHz).  The Notes client resided 
on a drive with two physical disks of 34GB each.  The notes.ini parameter PercentAvailSysResources was not used; 
PercentAvailSysResources can be used to limit system resources allocated to individual users.

Details of Feature Changes

Administrator Client, Client, Designer, Server

Details of feature changes - overview
The documents that directly follow (in the online database, the items in the "Details of feature changes" section of the 
"History of changes" chapter) discuss details of prominent feature changes since the original R5 product release. Not 
all features are discussed in this section. 

The specific revision number in the "History of changes" chapter contains a complete historical listing of feature 
changes, in the "New features and enhancements for R5.0.x". Those documents are grouped according to the release 
in which they were first documented. 

This "Details of feature changes" section gives you a view of all the details of feature changes that went into the product 
since R5 -- without having to sort through each revision number. (In Release Notes before R5.0.10, many of these had 
been in the "Feature changes" section of the "Things you need to know" chapter.)

Refer to the "New Features" section of the "What's new?" chapter for a listing of all new features for this particular 
Maintenance Release.

Client, Designer, Server

Domino Applet architecture changes (R5.0.1)
Starting in R5.0.1, the four Java-based Domino Applets (Editor, View, Outline, and Action Bar) are now compiled with 
JDK 1.1.6 which makes them smaller and faster. In addition, the applets now rely on Java to JavaScript 
communication (often called LiveConnect) to get data from Domino servers.
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Refer to the "Minimum browser support for Domino Java Applets" table in the "General Certifications and 
Requirements" section of the Release Notes for baseline browser requirements.

NOTE: The applets will no longer work on browsers that do not support Java to JavaScript communications. Since 
Microsoft Internet Explorer 3.0x and Netscape Navigator 3.0x are based on older technology, they do not support JDK 
1.1.  The Domino Applets no longer work on these browsers.

Editor Applet Enhancements
The Editor Applet now supports external cut/copy/paste.  You can now copy data from the Editor Applet and paste it 
into another program.  You can also paste data into the editor applet from another product. The only limitation is that 
plain text data is copied and pasted, rather than rich text.  This is due to a fault in the JDK that limits data exchanged 
with the system clipboard to only plain text strings.  Cut/copy/paste within the editor applet itself will continue to 
support rich text data and images.

In order for the editor applet to access the system clipboard and perform cut/copy/paste with other applications, the 
editor applet is now signed by Lotus Development Corporation.  Signing is needed so the user is aware that the applet 
intends to operate outside of the Java Security sandbox and access the system clipboard.  When using Internet 
Explorer you will be prompted by the security manager before the editor applet is loaded.  You must trust and accept 
the editor applet in order to use it on your system.  If you can elect to trust all content signed by Lotus Development 
Corporation, you will not be prompted again the next time the editor applet is loaded.

In Netscape, you are only prompted by the browser's security manager when you perform a cut/copy/paste operation.  
If you accept the applet's request for access to the system clipboard, the external cut/copy/paste operation will 
complete.  If you do not accept the request, only internal cut/copy/paste will be allowed.  When accepting the request, 
you can check the box, "Remember this decision" so that you will not be prompted the next time the editor applet is 
loaded and cut/copy/paste is performed.

Designer, Server

CORBA-enabled lotus.domino Java classes (R.5.0.1)
In 5.0.1, the new NOTES.INI parameter DIIOP_IOR_HOST was added to configure the DIIOP server for firewall support. 
When there is a firewall between your Domino server and your Java Applets/Applications that need to use the 
CORBA-enabled lotus.domino classes, you will need to set this parameter to the Public IP address or hostname of the 
Domino server (as it is known outside the firewall). The Java Applets/Applications will thereafter be able to go through 
an appropriately configured firewall to allow the IIOP ports a connection to the hidden Domino server.

Client

IMAP and NNTP: Improved message cache for newsgroups (R5.0.1)
If you created an IMAP or NNTP account with Notes R5, the design of your proxy database is not automatically 
updated when you install 5.0.1.  The simplest way to make sure you have the latest design is to follow these steps:

Install R5.0.1.  This will add the latest IMAP and NNTP templates to your data directory.1.

Open your local address book and switch to the Accounts view.2.

Delete your current IMAP or NNTP account.  Be sure to refresh the view to force the account to be deleted.3.

Use the Add Account action to recreate the account.4.

How Caching Works

When you open an IMAP or NNTP account, Notes retrieves the message summaries. But now the message summaries 
are stored in a local cache (actually in the proxy database itself).   When you open the same mailbox or newsgroup a 
second time, Notes does not retrieve the summaries again.  The status line at the bottom of Notes will tell you such 
information as: 

"Loaded n messages summaries from cache"

If any new messages have arrived since the last time you visited the mailbox or newsgroup, you should also see:
"Retrieved n message summaries."

If any of the messages have expired since the last time you visited the mailbox or newsgroup, you will see:

"Removed n expired/deleted messages from cache"
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Limitations

When you have worked with an IMAP mailbox or NNTP newsgroup for several days, the message summary cache will 
occasionally get out of synchronization with the remote server.  If you suspect this is the case, you can force a 
complete refresh of the message summaries.  For IMAP, click the Refresh action and select the Summaries option.  
For NNTP, click the Refresh Summaries action.

Designer, Server

LDAP Schema database - enhanced in R5.0.1
Beginning in Release 5.0.1, you can use the command tell ldap exportschema to build/update the Domino LDAP 
Schema database (SCHEMA50.NSF) in the Domino data directory. This database provides information about the 
directory schema in a user-friendly format and can reflect any changes you make if you extend the directory schema. 
If you extend the directory schema, use the command tell ldap reloadschema, which loads the updated schema into 
memory, before using tell ldap exportschema.

When the Designer task runs it also reloads the schema into memory and then creates or updates the Domino LDAP 
Schema database.

For each attribute in the schema, the Domino LDAP Schema database provides the LDAP name, OID, corresponding 
Domino field, LDAP schema the attribute originated from, and the syntax type. 

Tip: To determine the form or forms which use an attribute, switch to the "LDAP ObjectClasses" view, do a full-text 
search on the attribute, then look at the "Notes Name" column in the view.

For each object class in the schema, the database provides the LDAP name, OID, Domino Directory form that 
corresponds to the object class, LDAP schema the object class originated from. The database also provides the object 
class type (abstract, structural, auxiliary), the relative superior and auxiliary object classes, and the associated 
mandatory and optional attributes.

For each syntax, the database provides the LDAP name (and alternate name), OID, the data type mapping in Notes, 
and the schema from which the syntax originated.

Client, Designer

Button width options added in R5.0.1
In R5.0.1, users can now choose from the following four options when editing the width of a button (forms, pages and 
documents):

Maximum widthl

Minimum widthl

Fixed widthl

Fit contentl

Maximum Width acts exactly the same as prior versions of Notes. This was left in for complete backwards 
compatibility.  

Fixed Width means the button is n inches wide regardless of the size of the label.  If wrap is turned on and the label 
does not fit in the specified width, the label's text will wrap to a new line(s).  If wrap is not turned on and the label does 
not fit in the specified width, the label's text will be truncated.  Truncation will occur on pixel boundaries (not word 
boundaries).  Minimum allowed value is .25 inches.

Minimum Width means the button is n inches wide, however,  if wrap is turned off, it will expand the button's width to 
fit the text if it otherwise would not fit.  If wrap is turned on, this is the same as fixed width. Text is centered in the 
button.  Minimum allowed value is .25 inches.

Fit Content means the button is as wide as is needed for the text.   When set, both the "width field" (the inches/cms 
field) and the "Wrap label text" field are disabled.  
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Designer

Domino Designer enhancements in R5.0.1
Several improvements and enhancements have been made to Domino Designer to make it even easier to use.  Key 
improvements since the initial release are detailed below.

Release 5.0.1

Usability:

Launching Domino Global Workbench (DGW) from Designer is now an option.l

Right mouse click on a window tab in the client gives a new option to "Open this database in the Designer". l

Ability to bookmark a database in the open database dialog of the Designer is included.l

A better message is given when saving a design element before using Preview in Web Browser.l

Now go-to-client, go-to-DGW, go-to-admin buttons are available.l

A double-click on a database opens the database properties infobox.l

The bookmark folder drop down menu (upper left button) now has "Create New Folder" as found on the client.l

Expanded size of drop down box in the Reference tab of the Programmer's pane.l

In the Borders combobox of a field infobox, added words for "none" choice to avoid confusion.l

Added a "Do not display this message again" check box to the "Can't Debug @Dialog Box ..." message box.l

When adding a new shared image to an existing list, the list is scrolled and the new addition is displayed as l
the selected item.  This avoids confusing the user into thinking the image was not added because it appears 
somewhere else in the list.

When navigating from field to field in the Programming pane, Designer continues to display the same event l
the user initially selected rather than switching to the first populated event after each field change.

In the Find dialog box of the IDE, Designer lists the last few values searched so they can be selected rather l
re-entered.

Allow the Formula Window dialog box to be a resizable window.l

The default navigator pane will display only the preferred language rather than all available languages.l

Removed Design menu option when on the Designer Welcome page to avoid the accidental creation of design l
elements in bookmarks.nsf.

Designer options

In a Hotspot Button infobox, provide width options of "Fit-to-Content" and "Fixed Width".l

Allow forms, pages, and documents to have "System" as a background color option.l

Client

Mail integration support with Microsoft applications (R5.0.1)
Notes R5 registers itself as an available default mail application for Microsoft Windows. This allows Notes R5 mail 
messaging to be integrated within products such as Microsoft Office and Microsoft Internet Explorer, so that Notes is 
launched as the mail client from these types of applications.

In order for this support to work with Microsoft Office 97 applications, you will need to enable a preference in the l
Notes client.  Select File, Preferences, User Preferences, and in the additional options window select "Enable MS 
Office 97 SendTo Notes."  Choose OK, and you are ready to work.  Keep in mind that you will need to restart any 
Microsoft Office application after making this change in Notes.

If you are using Microsoft Office 2000 applications, the preference "Enable MS Office 97 SendTo Notes" will not l
be available since you Office 2000 is installed.  However, in order for this support to work properly you must 
ensure Notes is the default e-mail program in Windows. Verify this by opening the Control Panel in Windows, 
selecting Internet Options, then selecting the Programs tab and verifying Notes is the default e-mail program.

In order for Notes mail integration to work with Microsoft Internet Explorer you must ensure Notes is the default l
e-mail program in Windows too. Verify this by opening the Control Panel in Windows, selecting Internet Options, 
then selecting the Programs tab and verifying Notes is the default e-mail program.
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Server

Directories enhancements in R5.0.1
New directory catalog configuration options
There are additional options available under the "Group types" configuration field for a directory catalogs. The options 
now available are:

"Mail and Multi-purpose" (default) to include only these two types of groups from all the directories listed in l
the "Directories to include" field.

"All" to include all types of groups from all the directories listed in the "Directories to include" field. l

"All in first directory only" to include all types of groups but only those from the first directory listed in the l
"Directories to include" field.  

"None" to exclude all groups.l

You can change the name of the Users view in the Directory Catalog
You can now change the name of the Users view in a directory catalog as long as you keep the name Users as an alias. 

Field configuration for anonymous LDAP access applies to a directory catalog 

When you use a directory catalog on a server that runs the LDAP service, the anonymous access field configuration 
carries over to LDAP searches of the directory catalog. If a field an anonymous LDAP user is attempting to search is 
part of the directory catalog configuration, the LDAP service always refers to the list of fields in the "Choose fields that 
anonymous users can query via LDAP" setting for the primary Domino Directory to determine whether the user can 
search the field in a particular directory entry.  If a field the user is attempting to search is not part of the directory 
catalog configuration, then the LDAP service refers to the anonymous setting for the Domino Directory from which an 
entry is derived to determine if an LDAP user can search a field in a particular entry.  

For example, suppose the following is true:

The "Choose fields that anonymous users can query via LDAP" setting for the primary Domino Directory allows l
anonymous access to the Location and CompanyName fields.

The same setting in a secondary Domino Directory does not allow access to either of these fields.l

The Location field is included in the directory catalog but the CompanyName field is not in the catalog. l

When an LDAP user searches for the Location field, the LDAP service returns the value for the field for entries in both 
the primary and secondary Domino directories. When the user searches for the CompanyName field, the LDAP service 
returns the value for the field for entries from the primary Domino Directory but not for entries from the secondary 
Domino Directory. 

LDAPSEARCH utility
The LDAP search utility is now available on all supported platforms. See the release note "LDAP search utility 
corrections" under the category Documentation Updates for corrections to the instructions on using this utility.

Domino LDAP Schema database
You can use the new command tell ldap exportschema to build/update the Domino LDAP Schema database 
(SCHEMA50.NSF) in the Domino data directory. This database provides information about the directory schema in a 
user-friendly format and can reflect any changes you make if you extend the directory schema. If you extend the 
directory schema, use the command tell ldap reloadschema, which loads the updated schema into memory, before 
using tell ldap exportschema.

When the Designer task runs it also reloads the schema into memory and then creates or updates the Domino LDAP 
Schema database.

Changes to LDAP attribute searches
In R5.0 if you searched for a binary attribute without using the syntax attribute;binary, the LDAP service would 
nevertheless return a value for the attribute. If you do this in R5.0.1, the LDAP service doesn't return a value. For 
example, if there's a binary attribute in the directory called photo, the LDAP service won't return the contents if you 
search for photo, only if you search for photo;binary or all attributes.

In R5.0.1 the LDAP service supports the certificate syntax, a kind of binary attribute. R5.0 supported userCertificate 
attribute if you used the syntax  ;binary.  R5.01 supports all certificate attributes and regardless if you specify ;binary. 
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LDAP searches of groups have changed
In Release 5.0.1, LDAP searches of all types of groups except "Mail only" groups are generally quicker because by 
default the LDAP service uses a view in the Domino Directory to search these groups rather than using full-text 
searching as it did in R5.0.

Searches of "Mail only" groups are handled differently, however. By default, the LDAP service does not return results 
for "Mail only" groups if all of the following is true:

1. A search query uses the equality filter objectclass=value, where value is one of these object classes: 
groupOfNames, groupOfUniqueNames, dominoGroup, or group.

2. A search query uses an equality filter with one of these attributes: member, uniqueMember, or members.

3. The two filters above are concatenated using the AND operator.

Since queries that meet all of the above criteria are typically used for authentication, this default behavior helps to 
prevent "Mail only" groups from being used for authentication. The LDAP service still returns results for "Mail only" 
groups when search queries are used that do not meet all of the above criteria and in these cases full-text indexing is 
used to search the "Mail only" groups. 

For example, by default the LDAP service does not return results for "Mail only" groups if queries such as these are 
used:

(&(objectclass=dominoGroup)(member=cn=jack brown,o=acme))

(|(&(objectclass=groupOfUniqueNames)(uniqueMember=cn=jack 
brown,o=acme))(&(objectclass=groupOfNames)(member=cn=jack brown,o=acme)))

It does return results for "Mail only" groups when queries such as these are used, however:

(&(objectclass=dominoGroup)(member=*br*))

(member=cn=jack brown,o=acme)

(|(objectclass=dominoGroup)(member=cn=jack brown,o=acme))

(|(&(objectclass=dominoGroup)(member=cn=jack brown,o=acme))(cn=*groupname*))

Use the NOTES.INI setting LDAP_MailOnlyGroupOption to change the way the LDAP service handles searches of  "Mail 
only" groups.

Use LDAP_MailOnlyGroupOption=1 to always return results for searches of "Mail only" groups
Use LDAP_MailOnlyGroupOption=2 to always exclude results for searches of "Mail only" groups

UTF-8 character encoding is used to return search results to LDAP V2 clients
In Release 5.0.1, the LDAP service by default uses UTF-8 character encoding when returning results using 
international characters to LDAP V2 clients even though LDAP V2 RFC doesn't support the use of UTF-8. This has been 
done to be compatible with LDAP V2 clients that also use UTF-8 such as Netscape Communicator and EudoraPro 4.1. 

Use the NOTES.INI setting LDAP_UTF8Results=0 if you want to change this default behavior in order to support LDAP 
V2 clients that don't use UTF-8. (The setting LDAP_UTF8Results=1 indicates the default behavior.) If you use 
LDAP_UTF8Results=0,  then any LDAP V2 clients that use UTF-8 may sometimes be unable to receive results returned 
using international characters. 

Note that this issue is relevant for only LDAP V2 clients and not LDAP V3 clients such as Microsoft Outlook Express or 
the Notes R5 client. 

Administrator Client

Generating passwords for users during migration (R.5.0.1)
This release note discusses changes introduced in R5.0.1 in the way that the migration tools generate random 
passwords for users; it replaces information in "Overview of Migrating Users to Notes and Domino" in Moving to Notes 
and Domino Release 5.

The R5.0.1 migration tools now provide a new option for overwriting users' imported password with randomly 
generated passwords. In addition, the R5 option "Generate random passwords" has been changed to "Generate random 
passwords for users with no passwords." 
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For user registration to complete successfully, the password specified for the user must meet the minimum password 
quality requirements set in the registration preferences. If a user's password does not conform to the requirements, 
you must modify it before you can register the user. 

By default, most of the Domino migration tools automatically set the Notes password to a user's existing password. 
The migration tools for Windows NT, Novell GroupWise, and Netscape Messaging Server do not import a user's 
existing password. 

The migration tools provide the following options to automatically create passwords for migrating users who either do 
not have passwords, or for whom you prefer not to import existing passwords:

Generate random passwords for users with no passwordsl

Overwrite existing passwords with random passwordsl

Users for whom you create new Notes passwords can change their password using the Notes client. The password they 
create must conform to the quality scale set at registration.

Generating random passwords for users with no passwords
For users who have no existing password to import, or whose passwords cannot be imported (Windows NT users, for 
example), the migration tools provide an option to generate a random password conforming to the specified password 
quality scale. The default setting for this option differs for each of the migration tools. When using this option, 
passwords are only generated for users if the password field is empty; generated passwords do not overwrite 
passwords imported from the legacy system. 

This option and the option "Overwrite existing with random passwords" are mutually exclusive. If you select one of the 
options and then attempt to select the other, an error message appears.

Note The current version of the Domino migration tool for cc:Mail does not support the option "Generate random 
passwords." To successfully migrate a user's cc:Mail mail box, you must provide a cc:Mail password for the user. Use 
the cc:Mail administration tool to create passwords for users before migration

Overwriting existing passwords with random passwords
Select this option to generate new random passwords for all migrating users, regardless of whether they already have 
a password available for import from the legacy directory. The migration tool generates passwords that conform to the 
password quality scale specified in the current registration preferences. If a migrating user already has a password 
imported from the legacy system, the new password overwrites it.

Administrator Client, Server

Adding administrator to mail file ACL during migration (R5.0.1)
The following describes a new selection available in the Migration options list of the R5.0.1 People and Groups 
Migration dialog box:

When you create a mail file for a user during migration, by default, your Administrator ID is temporarily placed in the 
Access Control List (ACL) of the new mail file and is assigned Manager access. After the migration completes and the 
migrated user is successfully registered in Notes, the Administrator ID is then removed from the ACL and replaced 
with the name of the mail file owner. At this point, only the mail file owner can open the mail file.

Note: If you are migrating user mail boxes and choose to retain the default mail file ACL during migration, should the 
mail box conversion fail, the Administrator ID remains in the ACL as Manager.

In some cases, you may need to convert additional messages for users after you migrate them to Notes and create 
their Notes mail files. However, under the default mail file ACLs, you as the administrator do not have the level of 
access needed, and must ask the owner to restore your name in the ACL.

To save time later, if you can anticipate needing to perform such a secondary migration: when you first select users to 
migrate, also select the migration option "Add administrator to mail file access control list" from this list on the People 
and Groups Migration dialog box. This option changes the default mail file ACL so that the administrator retains 
Manager access to the mail file. The owner of the mail file also remains in the ACL with the default Manager access.

Note: This option adds the Administrator ID to the ACL of every mail file you create during the migration process, 
regardless of whether any messages are migrated.
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Server

Management of DIIOP sessions - enhanced in R5.0.1
Beginning in R5.0.1, the parameter "Idle Session Timeout" on the Internet Protocols - IIOP tab of the Server document 
is used by the DIIOP task to determine the amount of time that a session can stay idle before it is forced to close by 
the server.

Additionally, the DIIOP task recognizes the following two new tell commands:

tell diiop show usersl

The DIIOP task reports the list of users connected to the DIIOP server. For example:

User Name               Host Address             Minutes since last used
Anonymous               91.195.71.93                        0

tell diiop drop alll

The DIIOP server drops all active connections. This command should be used sparingly because active sessions 
may be forced to discard unsaved data.

Designer

New lotus.domino class extends applet functions (R5.0.1)
Starting in Release 5.0.1, the class NotesAppletContext has been added to the lotus.domino package. Applets that 
extend AppletBase may get the NotesAppletContext to determine the source of the applet. Applets may use this class 
to write applets that work in the Notes Client and in a Web Browser.

The new operation on AppletBase and JAppletBase is:

NotesAppletContext getContext(Session s)

returns the NotesAppletContext

The properties on NotesAppletContext are:

getServer()

returns the String name of the server where the applet was downloaded from

getDatabase()

returns the Database object of the database

getDocument()

returns the Document object the applet lives in if it lives in a document. Returns null if applet does not exist 
in a document (e.g. exists on a Page)

Example:

public void notesAppletStart()
{
try {

NotesAppletContext ap = getContext(session);
System.out.println("Server: " + ap.getServer());
System.out.println("Db    : " + ap.getDatabase().getFileName());

}
}
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Administrator Client

Retaining cc:Mail MTA routing info: deferred migration (R5.0.1)
This Release Note explains the use of a new option on the cc:Mail Upgrade Advanced Settings dialog box that you use 
when you want to register cc:Mail MTA users from their existing Person documents, but defer migration of their 
cc:Mail mail boxes.  This feature is new beginning in Release 5.0.1.

Retaining cc:Mail MTA routing information for deferred mailbox migration
The migration tool provides an option that lets you migrate cc:Mail MTA users in two phases, rather than all at once. 
To use this option, complete the migration as follows:

Phase 1 -- Register users from the existing Person documents created by the cc:Mail MTA and create Notes mail 
files

Phase 2 -- Migrate mail messages

Completing the first phase of the migration
During the first phase of the migration,  you:

1. From the People and Groups Migration dialog box, select cc:Mail MTA users to migrate from the Available 
people/groups list.

2. In the Migration options list:

Select "Add administrator to mail file access control list"l

De-select "Convert mail"l

3. Click Advanced to open Conversions Settings pane of the cc:Mail Upgrade Advanced Settings dialog box and select 
"Retain cc:Mail MTA routing information for deferred mailbox migration." 

4. Click Migrate and then Done to add the users to the Registration Queue.

5. From the Register Person dialog box, select the users to register in the Registration queue.

6. Select the Mail pane and then select Lotus Notes in the Mail system field.

7. Click Register.

After you complete Phase 1, each user's Person document is updated to indicate they are registered Notes users with 
Notes IDs and mail files. However, users continue to receive messages in their cc:Mail mailboxes and access their mail 
using the cc:Mail client, because their Notes Person documents retain cc:Mail MTA routing information.

The migration tool saves the mail system setting you specify in the Register Person dialog ( Lotus Notes), but the 
setting is saved in the background, and is not put into effect. Instead, the Mail system field in the Person document 
remains set to cc:Mail and other cc:Mail routing information is retained. As a result, routing support for the cc:Mail 
MTA is maintained, and the Notes user is prevented from using the Notes mail system. Users only receive mail 
through the cc:Mail MTA router. The cc:Mail Automatic Directory Exchange (ADE) facility continues to propagate the 
users' cc:Mail directory information to other cc:Mail post offices.

Completing the second phase of the migration
During the second phase of the migration, you:

1. Select the same users you migrated in the first phase.

2. In the Migration options list of the People and Groups Migration dialog box, select "Convert mail only." 

The migration tool removes the cc:Mail MTA settings and replaces them with the saved settings. In short, all of the 
registration settings are retained, regardless of the request to defer the mail migration.  This includes the creation of 
the Notes mail file.

Administrator Client, Server

Auto-restart for Domino R5 on UNIX platforms (R5.0.1)
Domino R5 on UNIX platforms includes an auto-restart capability that was introduced in R4.6. If you enable 
auto-restart, you can shut down the server with greater ease in the event of a failure and restart the server 
automatically at a time you specify.

In R5, auto-restart is faster if you utilize transaction logging. Transaction logging allows auto-restart to skip some 
restart steps after a crash. Third-party clustering software can use auto-restart to provide enhanced uptime and 
reliability.
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You can use auto-restart to notify you of a failure, to restart the server, or to perform both functions. Administrators 
can configure auto-restart to set the server to restart immediately or to wait for a specified interval before restarting. 
Third-party clustering software can modify the auto-restart script to further customize this feature.

For more information on Domino R5 and clustering, see Domino 5 Administration Help or the printed book 
Administering Domino Clusters.

Client, Server

Change in creating export certificates (R5.0.1)
When creating a certificate for temporary export, for foreign travel, note that the Temporary Export Certificate is now 
located in the Personal Address Book instead of the mail file. (This was introduced in R5.0.1.) To create a certificate 
for temporary export, open your Personal Address Book and select the menu option for Create->Advanced->Temporary 
Export Certificate.

Server

Environment variables are now set in NOTES.INI (R5.0.1)
Starting in R5.0, any environment variables that were required at the operating system level are obsolete and should 
be replaced with NOTES.INI settings. For example, to enable automatic fault recovery in R4, the environment variable 
"FaultRecovery=1" was set. In R5.x, the setting "FaultRecovery=1" should be added to NOTES.INI. 

The operating system environment variables still work, although they now require the prefix "Notes_" For example: 

Notes_FaultRecovery=1

Note: If an existing operating system environment variable already starts with "Notes_", you do not need an additional 
"Notes_" prefix.

Client, Designer, Server

HTTP task always loads the Java Virtual Machine (R5.0.1)
Beginning in 5.0.1, the HTTP task always loads the Java Virtual Machine (JVM) when the HTTP task is started. 
Previously, the JVM was not loaded if the "Java servlet support" setting in the Server record was set to None. This 
change has been made to fix a potential memory leakage problem running Java agents and servlets from web 
browsers.

Client

Keyboard access for embedded controls (R5.0.1)
In any form, page, or document there could be any number of embedded controls (the date picker in the Calendar is 
an example of an embedded control). Beginning in Release 5.0.1, using keyboard shortcuts, you can navigate to any 
embedded control, give focus within the embedded control, and then remove the focus to continue navigating through 
the form, page, or document. 

Press the SPACE bar to give focus to the embedded control (when focus is in the embedded control, the thin black 
frame around it disappears). Press ESC to remove focus from the embedded control (the thin black frame re-appears) 
and continue navigating through the form, page, or document.

Once focus is in an embedded control, the following keyboard shortcuts can help you navigate:

To do this Procedure
Navigate through an embedded control arrow keys
Navigate to next unread document in an embedded view TAB
Select an item in an embedded view ENTER
Expand a folder in an embedded outline + key
Collapse a folder in an embedded outline - key
Select an item in an embedded outline ENTER
Navigate to next month in an embedded date picker HOME
Navigate to previous month in an embedded date picker END
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Server

Time zone and DST values on UNIX and OS/2 platforms (R5.0.1)
Domino R5 will now get time zone and Daylight Savings Time (DST) information from the operating system on UNIX 
and OS/2 platforms.

On OS/2, it is important that the TZ variable be set in the config.sys file. If you do not observe Daylight Savings Time, 
do not put a Daylight Savings abbreviation in the TZ variable.  On UNIX, Domino will use the difference between 
localtime & gmttime, and the value of the isdst field from localtime, to determine the time zone.  On both platforms, 
localtime should always be correct before installing or starting a server.

Client

Integration with Sametime from the Notes Welcome Page (R5.0.2)
The Notes 5.0.2 Welcome Page now contains a link to www.Sametime.com, so that you can see and experience 
real-time collaboration.  There is also a new icon in the bookmark bar to launch Sametime Connect. This Sametime 
Connect application icon appears if you have the Sametime Connect client installed on your client computer. This 
allows you to launch Connect from within Notes.

If you do not have Sametime Connect installed on your computer, but you do have a Sametime server listed in your 
current location record, clicking the Sametime Connect icon launches a browser that takes you to the Welcome to 
Sametime web page. From there, you can download Sametime Connect. 

The Sametime connect application icon will not appear if you are upgrading from 5.0 or 5.0.1 to 5.0.2. To make it 
appear, you must rename or delete the bookmark.nsf and then restart the Notes client. Please note that deleting the 
bookmark.nsf will remove all previous bookmarks you had, and you will need to re-insert your previous bookmarks 
manually.

Client, Server

Mail Enabled with Sametime "Who Is Online" (R5.0.2)
Beginning in Release 5.0.2 of Notes mail, you will now be able to see if the sender and recipients of a mail message 
are online when you read that message. If they are online, you can send them instant messages. 

Sametime Connect must be installed for Sametime "Who Is Online" to work.

You will see this feature on the Memo, Reply and Reply with History forms. Specifically, there is a new button in the 
action bar (near the top of the screen) named "Who is Online."

 If anyone in the From, To, or cc list is logged on to Sametime Connect, or if they have the "Who is Online" window 
open, they will appear in the "Who is Online" window.
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Select a name and click "Message..." to send that person an instant message. Unlike mail, an instant message appears 
on a person's computer screen almost instantly, on top of any other windows the user might have open. 

You can also send an instant message to everyone in the list who is online by clicking "Message to All..."

System Administrators: Setting up the Sametime Server to Support "Who is Online"

Overview:  On the Sametime server, you must install a new Java applet and a new database. The source files for the 
instructions below are found in the APPS\SAMETIME directory of the Notes/Domino/Domino Designer CD-ROM.  To 
install the Java applet, follow these steps:

Create a directory on the Sametime server (under sametime\data\domino\html) called sametimeapplets.1.

Copy the two jar files (MailApplet.jar and VPApi.jar) into this directory.2.

To install the new database, follow these steps:

Copy the template STDomino.ntf into the sametime\data directory on the Sametime server.1.

Login in as the Administrator on your Sametime server.2.

Create STDomino.nsf by doing the following:3.

      a) Choose File->Database->New.

      b) Select the Sametime server using the server pull-down list.

      c) In the Title field, type STDomino (This will populate the filename STDomino.nsf).

      d) Click "Template Server"

      e) Select the Sametime server and click OK.

       f) Select the template "Sametime Domino Template."

       g) Click OK.

      h) Close the STDomino.nsf database.

System Administrators: Setting up the Domino Mail Server to Support "Who Is Online"

Overview: You must install release 5.0.2 (or later) of the Domino server. To make installation simpler, add a Setup 
Profile record to the directory. This will add the name of the Sametime server to the location record in the Notes 
Client.  Follow these steps: 

Upgrade your Domino server to R5.0.2.1.

To add a Setup Profile record, log in as the Administrator on your mail server.2.

Open the Address Book.3.

Open the Server folder.4.
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Open the Setup Profiles sub-folder.5.

Click "Add a Setup profile"6.

Type in a profile name for your Sametime server (for example, "Acme Associates Profile")7.

Type in the name of your Sametime server (for example, sametime.acme.com/Acme)8.

Click "Save and Close "9.

Then, write an agent that will update the person records in the directory with the setup profile you added:10.

        a) Select Create->Agent.
        b) Name the agent (for example, "Add Sametime Setup Profile")
        c) Click "Add Action" 
        d) In the Action pulldown, select "Modify field"
        e) In the Field pulldown, select "Profiles"
       f) In the Value field, type in the value of the Setup Profile (for example, "Acme Associates Profile" )
        g) Choose "Append value."
        h) Click OK.
         i) Select File->Save.
       j) Close the agent.

11.   Open the People folder.

12.   Select the names of people who will use the Setup Profile record you created. If all people will use the same 
Sametime server, select Edit->Select All.

13.   From the Action menu, choose the agent you created (for example, "Add Sametime Setup Profile"). This agent 
modifies all the people you have selected.

Setting Up The Notes Client to Support Mail with "Who Is Online"

Overview:  You must use release 5.0.2 of the Notes Client. 

If a Setup Profile record is not set up, perform the following steps:

Upgrade the Notes Client to 5.0.2. 1.

Put the name of the Sametime server into the location record of the Notes Client:2.

a)  Edit your current location record.
b)  Click on the Servers tab.
c)  Enter the name of your Sametime server (for example, sametime.acme.com/Acme)
d) Click "Save and Close"
e) Open your mail file.
f)  Refresh the mail template if needed.

Setting Up Sametime Connect
Sametime Connect must be installed on the client computer for "Who Is Online" to work.

Client

Organizer migration utility (R5.0.2)
For those users running with an Organizer 4.1 GS/Notes R4.x setup, there is a utility available to move the Organizer 
Calls and Notepad entries into Notes. Organizer 4.1 GS/Notes R4.x already share the Organizer Calendar, Address 
Book, Anniversary, and To Do information.

The migration utility introduced in Notes 5.0.2 converts Calls and Notepad entries from an Organizer format within 
the Notes data store (.NSF) to a Notes format. Converted entries appear in the R5.0.2 To Do view and the Notes 
Journal database. The Organizer Calls entries will be displayed in the Notes To Do view and will be identified with the 
header "Call Entry." The Organizer Notepad section will get mapped into the Notes Journal database (JOURNAL.NSF). 
The title of the Organizer Notepad entry is what will appear in the Notes Journal view, and within this document will be 
the original content from the Notepad page.

NOTE: Due to a software limitation, linked or embedded applications on the converted Notepad page will not be 
accessible. Please create copies of the applications on your file system should you wish to continue to use the 
embedded application.
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To invoke this utility, follow these steps:

Install a Notes 5.0.2 or later client.1.

Open your Organizer 4.1 GS/Notes R4.x mail file and select File->Database->Replace Design and select 2.
"Mail50.ntf".

Close and reopen your mail file.3.

Go to the To Do view.4.

Select Tools->Migrate Org 97 GS.5.

This migration is meant to be a one-time operation and is not intended for interoperability back and forth with 
Organizer GS and Notes. However, the Organizer data is saved in the .NSF datastore after migration in case the 
migration utility needs to be used again.  NOTE: For problems with the migration utility, see the Release Note titled 
"Issues in migrating from Organizer to Notes" under Troubleshooting/Migration.

Client, Designer

TeamRoom 4.x to 5.0 Migration Utility is available (R5.0.2)
NOTE: This has been changed beginning in R5.0.3, so that the utility is now part of the design. The information below 
applies to pre-R5.0.3 releases only.

The R5 Client comes with a new template called TeamRoom (teamrm50.ntf). This template is not compatible with the 
R4.x version of TeamRoom developed by the Lotus Institute.

If you want to use the new TeamRoom template with a 4.1 TeamRoom database, Iris has developed a utility which 
migrates the design of the R4.x TeamRoom to the new 5.0 design. This utility can be found at the Lotus Developer 
Domain website, in the Iris Sandbox. Browse this URL on the Internet for further details:

http://www-10.lotus.com/ldd/sandbox.nsf/e7425656e0c80508852567540065d7f9/72060cf530af6db6852567a900
620355?OpenDocument&ExpandSection=1

Designer, Server

Support for Image Wells on the Web (R5.0.2)
Domino R5.0.2 now supports Image Wells (multi-state images) on the web.  The maximum number of images 
supported by Domino Designer is four.  The image can contain an image for normal state, mouse-over state, selected 
state, and clicked state.  

If an image well is more than one image wide, the image resource is Web Browser compatible by default.  The Web 
Browser Compatible check box on the Image Resource information box is  visible only when "Images across" is greater 
than one.  The Web Server handles Web Compatible Wells as follows:

Image Wells on a form, page, or any rich text support normal state, and mouse-over.l

Image Wells in HTML Outlines and HTML Action Bars show only the first default image, that is, normal state.  l
Mouse-over is not supported in HTML Outlines and HTML Action Bars.

Note: Existing Image Wells are not be affected by this enhancement.

Server

Performance Monitoring Stats (NT Intel/Solaris Sparc) (R5.0.2)
Domino will track performance metrics of the operating system and output the results to the server. Type "show stat 
platform" at the server console to display them. This feature is disabled by default in R5.0.2. You can enable it by 
setting the parameter:

PLATFORM_STATISTICS_ENABLED=1 

...in the NOTES.INI file and restarting your server. On Windows NT, the following registry setting:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\notestat\Performance\Library 

...must be set to NNOTES.DLL in your executable directory. Otherwise performance monitoring will not run. Also on 
Windows NT, diskperf needs to be enabled for disk metrics to be captured. 
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Metrics are collected continuously, unless disabled or reset (see commands below), or unless the server is brought 
down. The server resets this information each time it is started. This feature also expects certain Notes processes to 
be present. Performance counters for absent Notes processes will have zero values. This is normal behavior.

The server monitors the following metrics:

Performance Metric Description
Platform.Memory.KBFree The amount in kilobytes of virtual memory available on the system. This is 

equivalent to Memory/AvailableBytes in Windows NT Performance Monitor 
divided by 1024.

Platform.Memory.PagesPerSec The number of pages read to or written from the disk. Equivalent to 
Memory/Pages/second in NT Perfmon.

Platform.System.TotalUtil The average percent CPU utilization of all CPU's on the system. Equivalent 
to System/% Total Processor Time in NT Perfmon.

Platform.System.TotalPrivUtil The average percent CPU utilization in privileged mode of all CPU's on the 
system. Equivalent to System/% Total Privileged Time in NT Perfmon.

Platform.System.TotalUserUtil The average percent CPU utilization in user mode of all CPU's on the 
system. Equivalent to System/% Total User Time in NT Perfmon.

Platform.LogicalDisk._Total.1._Total.1.PctTi
me

The percentage of the sampling interval that all logical disks on all 
physical disks are servicing read or write requests. Equivalent to 
LogicalDisk/% Disk Time in NT Perfmon.  As in NT Perfmon, the first 
"_Total" refers to all physical disks, and the second "_Total" refers to all 
logical disks.

Platform.LogicalDisk._Total.1._Total.1.AvgQ
ueueLength (NT only)

The average number of both read and write requests that were queued for 
all logical disks on all physical disks during the sample interval. Equivalent 
to LogicalDisk/Avg. Disk Queue Length in NT Perfmon.

Platform.LogicalDisk._Total.1._Total.1.Servic
eTime (Solaris only)

The amount of time in milliseconds for a read or write command to 
complete.

Platform.Process.nserver.1.Util (NT only) The CPU utilization of the first server process. This is the percentage of 
the sample interval that the process used the CPU. Equivalent to 
Process/% Processor Time in NT Perfmon.

Platform.Process.nrouter.1.Util (NT only) The CPU utilization of the first router process.
Platform.Process.nreplica.1.Util (NT only) The CPU utilization of the first replica process.
Platform.Process.nreplica.2.Util (NT only) The CPU utilization of the second replica process.
Platform.Process.nreplica.3.Util (NT only) The CPU utilization of the third replica process.
Platform.Process.nreplica.4.Util (NT only) The CPU utilization of the fourth replica process.
Platform.Process.nupdate.1.Util (NT only) The CPU utilization of the first update process.
Platform.Process.nupdate.2.Util (NT only) The CPU utilization of the second update process.
Platform.Process.nupdate.3.Util (NT only) The CPU utilization of the third update process.
Platform.Process.nupdate.4.Util (NT only) The CPU utilization of the fourth update process.
Platform.Process.nadminp.1.Util (NT only) The CPU utilization of the first adminp process.
Platform.Process.nadminp.2.Util (NT only) The CPU utilization of the second adminp process.
Platform.Process.nadminp.3.Util (NT only) The CPU utilization of the third adminp process.
Platform.Process.nadminp.4.Util (NT only) The CPU utilization of the fourth adminp process.
Platform.Process.nhttp.1.Util (NT only) The CPU utilization of the first http process.

For non-process metrics (those not starting with "Platform.Process"), average, minimum, and maximum statistics are 
also reported. For example, in addition to Platform.Memory.KBFree, there are the following secondary statistics:

Platform.Memory.KBFree.avg The average of all KBFree samplings for a session. This is calculated by 
summing all the KBFree samplings, and dividing by the number of 
samplings.

Platform.Memory.KBFree.min The smallest KBFree sampling for a session
Platform.Memory.KBFree.max The largest KBFree sampling for a session

If a process is removed, the metric for that process will go to 0.

The PLATFORM command allows you to control this feature at the console. It has the following form:
PLATFORM <main argument> [<optional arguments>]
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These are the main arguments:

Argument(s) Description
TIME [<sampling rate>] With an optional argument, changes the sampling rate to the specified 

value in minutes. Otherwise displays the current sampling rate. The 
default is 1 minute.

RESET Initiates the beginning of a new statistics monitoring session; resets 
secondary metrics.

WAIT Pauses the collection of performance data
RUN Resumes the collection of performance data

For example, to start a new performance data monitoring session with a sampling rate of 5 minutes, type the following 
commands at the console:

platform time 5 - The server collects performance data every 5 minutes.
platform reset - Statistic values sampled before this command was issued are not used in calculating average, 
maximum, or minimum.

Changes have also been made to the Stats and Events database so these statistics can be treated like any other stat 
(i.e. thresholds, etc. They can be viewed through the Admin client.

Client, Server

Decoding of inbound Internet messages (R5.0.2)
In previous R5 releases, Internet messages containing data encoded in the UUENCODE format and received by a 
Notes client were sometimes not decoded properly. This problem has been corrected in R5.0.2.

Client

Changes in ECL permission defaults for R5.0.2
Changes in ECL permission defaults starting in R5.0.2

The ECL entries for -Default- and -No signature- have been changed in R5.0.2. These entries now have no l
permissions checked.

The ECL dialog has been changed. You will no longer be prompted to trust everybody in the organization of l
the user whose signature you are about to trust. 

If you have already implemented Execution Control Lists (ECLs) and your Administration ECL has been configured in 
the Domino Directory, these changes should not affect your existing Security infrastructure when setting up a new 
Notes Client from the Domino Server. 

You will be affected if you are setting up the Notes client without being configured from the Domino Server. In this 
case you are running client setup in a Island (disconnected) location. You will need to modify your ECL entries to 
conform with your existing ECL Security model. This can be done manually or automatically in several ways. 

You could also be affected if you are using your Notes ID for the very first time in a shared workstation environment. 
This is applicable when more than one user shares the same Notes Client on the same workstation. The very first time 
a Notes ID is used, Security Options in the form of ECL entries are generated for that user and stored in the file 
desktop5.dsk, if the options do not already exist. All the standard ECL rules apply.

Regardless of how you deploy ECLs, Lotus recommends you see the Release Notes document "Recommendations for 
deploying tighter ECLs" for more details.

Client

Setting the maximum number of articles to replicate (R5.0.2)
The default behavior of NNTP/IMAP replication is to replicate every article/message in all selected 
newsgroups/folders. Beginning in 5.0.2 you can now limit the number of messages to be retrieved by editing the 
NNTP/IMAP account document located in your personal Name and Address book (NAB). Before you can do this you 
will have to refresh the design of your address book using the 5.0.2 version of the pernames.ntf template. To do this:

Open your local NABl

Choose File->Database->Refresh Design (or you can use Replace Design, but please consult manual/online help, l
or your administrator, if unsure of the differences between the two.)
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To set a value for the maximum number of articles to download during NNTP/IMAP replication:

Edit an existing internet account document (Open local NAB, select View->Advanced->Accounts)l

Go to the Advanced tabl

Enter a number into the "Maximum messages/articles to return" fieldl

Save and close the documentl

The next time you replicate this account, the new setting should take effect.

NOTE: This value is the number of articles per newsgroup to download. For example, if you set this value to 100 and 
you are subscribed to 5 newsgroups, Notes will try to pull 100 articles from each newsgroup. Also note that setting 
this field to 0 or null (leaving it blank) will cause Notes to pull all articles from all newsgroups.

Client

Typeahead now favors personal address book (R5.0.2)
Typeahead behavior has been modified in R5.0.2 to favor, in the following order:

A match in the personal NAB that has a matching organization to the current user.1.

A match in the personal NAB.2.

A match outside the personal NAB that has a matching organization to the current user.3.

The first match.4.

Client

Webmail enhancements (R5.0.2)
Webmail now has a personal address book of its own. You can save information about contacts in this address book. 
You can also create groups of contacts for mailing lists. This new feature in R5.0.2 allows web users to create contact 
and group information for use from a web browser only. The address book documents are stored in the user's mail file, 
and are in no way connected to the traditional Personal NAB found on the regular Notes Client. This feature was added 
to allow web users some minor contact management only. Contacts and groups created in the Web Address Book are 
not updated into the user's Personal Address Book, and vice-versa.  This feature is designed for users who access their 
mail through a browser only.

Also beginning in R5.0.2, you can specify text to be added as a signature block to a memo or reply. Choose 
Actions->Tools->Preferences and click the Signature tab.

Administrator Client, Client, Designer, Server

Feature Note: COM features added in R5.0.2b
Although features are seldom added in Notes and Domino Quarterly Maintenance Updates (QMUs), you should take 
note of an important exception in the R5.0.2b release. New Component Object Model (COM) interfaces have been 
added to the Notes and Domino product beginning in R5.0.2b.

Client

Default behavior for typeahead feature is exact match (R5.0.3)
The typeahead feature in R5 releases would display an ambiguous names dialog when the user pressed a delimiter 
and the typeahead completed name was a subset of another name.  For example:

The user types "John F".1.

The typeahead feature completes the name as "John Foo".2.

The user hits a delimiter such as a comma (","), Enter, or F9.3.

An ambiguous names dialog appears containing "John Foo" and "John Foobar".4.
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The new behavior eliminates the ambiguous names dialog and accepts the completed name if it is a unique exact 
match.  The only instance when an ambiguous names dialog will appear is when the typeahead completed name is 
found in multiple organizations.  For example:

The user types "John F".1.

The typeahead feature completes the name as "John Foo".2.

The presses a delimiter such as a comma (","), Enter, or F9.3.

An ambiguous names dialog appears containing "John Foo/CompanyA" and "John Foo/CompanyB".4.

The typeahead feature behavior can be reverted to the pre-5.0.3 behavior by setting the NOTES.INI variable 
"TypeaheadDoExactMatch" to 0.

Administrator Client, Server

Simple-search filter with LDAP enabled (R5.0.3)
Beginning in R5.0.3, the LDAP account record has a new setting to turn on simple searches. This new setting is 
provided for LDAP servers that do not properly support the default Notes LDAP search. The default Notes LDAP search 
filter OR's five LDAP attributes. These attributes are "cn", "mail", "rfc822mailbox", "givenname", and "sn". Some LDAP 
servers fail to return any results if one or more of the OR'ed attributes are not contained in their schema. Turning on 
simple searches compensates for these servers by simplifying the search filter to the one LDAP attribute "cn".

Server

Last-Modified header supported for Domino URLs (R5.0.3)
Domino R5 now sends a Last-Modified header with most Domino responses. This often results in a performance 
enhancement, since it enables many Web browsers or proxy servers to cache Domino pages.

The HTTP Last-Modified header indicates the date and time that the information in the server response was last 
modified. For traditional Web servers that store HTML pages and images in the file systems, the Last-Modified time is 
the last modification time of the file. 

Browsers use Last-Modified HTTP header to manage the browser's local cache, depending the user's chosen 
configuration. Typically, when a user requests a page that is in the browser's cache, the browser sends the page 
request to the server along with the HTTP header If-Modified-Since, indicating the modification time of the cached 
page. The server checks the If-Modified-Since header against the time of the page on disk. If the page has not been 
updated since that time, the server sends back a "Not modified" status code, which informs the browser that it can 
redisplay the cached page. If the page has been modified, the server sends back the entire new page.

Domino calculates the Last-Modified time for different kinds of requests as follows:

Files in the file system Last-Modified is set to the modification time of the file according to 
the operating system. This is also supported by Domino R4.5x and 
R4.6x.

File attachments and other 
embedded objects in a Domino 
database

Last-Modified is set to the modification time of the document to which 
the object is attached.

Other Domino database requests Last-Modified is set to the "database modification time", which is the 
last time that the database was modified (which is essentially the last 
time any document or design element in the database was modified). 
The database modification time is displayed in the database 
properties box. 

For these requests, Last-Modified headers are most effective for 
databases which do not change often such as a help-desk or 
product-catalog database.
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Domino does not send Last-Modified headers in response to the following types of requests:

Pages whose content is dependent on the current time (such a field formula that uses @Now) or whose time l
dependencies cannot be efficiently determined (for example, a field formula that uses a @DbColumn which 
references another database)

OpenAgentl

OpenNavigatorl

CreateDocumentl

EditDocumentl

SaveDocumentl

DeleteDocumentl

Client

Calendar and Scheduling Printing Enhancements for 5.0.3

Work Week View
A new calendar view has been added for 5.0.3 allowing users to customize the work week view to their own specified 
work week. To allow the week to be self customized, open the calendar and go to Tools->Preferences from the action 
bar. Then go to the Calendar tab and then to the Display tab. In the advanced section of that pane you are able to 
choose your week day choices by simply placing a checkmark before the day that you wish to add to your work week.  
When you finish, click OK and close that dialog box. Then close the Calendar and reopen it to refresh and bring into 
focus the new work week days that you selected. When reopened the numbers in the upper right corner will be 1, 2, 7, 
14, 31 and whatever the amount of days specified in Tools->Preferences (5 is the default).

Printing of this view is not any different then printing another calendar view except when you have a calendar open and 
you go to File->Print, you select the work week view from the content menu. If the work week view is displayed on the 
screen, when you go into File->Print, that view will automatically be brought up as the content type. If after choosing 
the work week view content type you click the Customize button, the dialog box should look similar to daily style. Font 
sizes, paper types and hours to print are exactly the same as daily, weekly and monthly style.

New Paper Types
Three new paper types were added in 5.0.3. They can be found in File->Print. After choosing a content type, click the 
Customize button. The list of paper types contains the following paper types:

Full page (8 1/2" X 11")l

Day Runner Classic (5 1/2" X 8 1/2")   Added in 5.0.3l

Day Runner Entrepreneur (8 1/2" X 11")   Added in 5.0.3l

Day Runner Running Mate (3 3/4" X 6 3/4")   Added in 5.0.3l

Day Timer Senior Desk (8 1/2" X 11")l

Day Timer Senior Portable (3 3/4" X 6 3/4")l

Day Timer Junior Desk (5 1/2" X 8 1/2")l

Day Timer Junior Portable (3" X 5")l

Franklin Day Planner Monarch (8 1/2" X 11")l

Franklin Day Planner Classic (5 1/2" X 8 1/2")l

Avery Index Cards (3" X 5")l

Paper Sizes
The following paper sizes are supported in 5.0.3:

A4l

A5l

B4l

B5l

366



Lotus Notes, Domino, and Domino Designer 5.0.13 Release Notes Chapter 6 - History of changes

Date added in weekly and work week views
Numeric date has been added to weekly and work week views, directly next to the day of the week listed.

Designer

New option added for SearchView URL command (R5.0.3)
With R5.0.3, the URL command SearchView now supports a SearchOrder value of 4, which returns a resulting set of 
documents listed in the order in which they appear in the view being searched.

For more information, see the topic "URL commands for searching for text" in Application Development with Domino 
Designer.

Client

NNTP replication efficiency has been greatly improved in 5.0.3
NNTP replication efficiency has been greatly improved in 5.0.3. In order to benefit from the improvements you must 
either create new NNTP accounts or replace the design of your existing NNTP accounts using the new nntpcl5.ntf 
template (included in 5.0.3). To replace the design of the NNTP account, follow these steps:

Open the NNTP proxy db.1.

Select File->Database->Replace Design from the menu.2.

At the Replace Database Design dialog, check "Show Advanced Templates" option.3.

Select "News Articles (NNTP)" template from the list of templates and then click the "Replace" button.4.

Click "Yes" at the next dialog warning. 5.

The next time you replicate you should notice a speed increase of at least two to three times faster than prior identical 
replication scenarios. (Performance depends on newsserver, newsgroups etc.). In some cases performance has 
increased by almost tenfold.

Administrator Client, Client, Designer, Server

Release 5.0.3 contains a new ccStr build
Domino and Notes Release 5.0.3 contains ccStr Build B5721.

Server

Server-side imagemaps are no longer supported (R5.0.4)
Support for server-side imagemaps has been dropped from the Domino web server, beginning in Release 5.0.4.

Server-side imagemaps were a feature of the open-source HTTPD server project coordinated by CERN and W3C (
http://www.w3.org). Lotus and other web server vendors supported server-side imagemaps by including versions of 
the original CERN code. W3C is no longer maintaining this project, and recently a number of serious security 
vulnerabilities have been discovered in the CERN code and reported to the Buqtraq mailing list maintained by 
SecurityFocus.com (http://www.securityfocus.com). In response, Lotus is dropping support for this largely obsolete 
feature. Most site designers now prefer to use more efficient client-side maps, supported by current browsers, rather 
than server-side maps.

In R5.0.4, the directives in the HTTPD.CNF file that activated the imagemap feature have been removed. The Domino 
install program will not modify an existing HTTPD.CNF, but existing imagemap directives will have no effect. Any 
request that invokes such a directive will be rejected and a generic "Error 500..." message will be returned to the 
browser.
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Unsupported Workaround:

If you still have a requirement to support server-side imagemaps on your web site, you can obtain the original CERN 
source code from:

http://www.w3.org/Daemon/Implementation/HTImage.c

You can try to compile this code yourself and place the executable into your site's CGI-BIN directory. Of course, if you 
do this you may expose your site to security attacks. Review the documentation at http://www.securityfocus.com for 
more information.

Client, Server

Allocating resources for partitions (R5.0.4)
Beginning in R5.0.4, a new NOTES.INI variable called "PercentAvailSysResources" is provided.* This parameter limits 
the physical memory used to a percent of the system's physical memory size. For example, say an administrator of a 
Domino server with two partitions wanted to control resources allocated to each partition: partition 1 to use 75% of 
the system resources and partition 2 to use 25% of system resources. In this case, the NOTES.INI of partition 1 would 
contain "PercentAvailSysResources=75" and the NOTES.INI of partition 2 would contain 
"PercentAvailSysResources=25".

The range for the variable is auto limited between 2 to 100. If this parameter is used then the 
NSF_BUFFER_POOL_SIZE and NSF_BUFFER_POOL_SIZE_MB should not be used unless so advised by Lotus Support. 

Another use for "PercentAvailSysResources" would be on the Citrix MetaFrame or Windows Terminal Server. For 
example, if there are 20 data directories on the terminal server then the NOTES.INI files in each client data directory 
would contain the parameter "PercentAvailSysResources=5".* 

* Post-5.0.4 release update:  The "PercentAvailSysResources" parameter is working as expected in Domino partitions 
for non-Windows platforms such as AIX, Solaris, Linux, HP-UX, and OS/2.  However, late testing revealed that the 
parameter does not work as expected in Domino partitions on the Windows platform.  Unfortunately, this problem also 
extends to the use of the parameter on Citrix MetaFrame and Windows Terminal Server so the parameter is ineffective 
on those platforms.  The problem is expected to be fixed in an upcoming release of Domino.

Client, Designer, Server

Information about directory improvements starting in R5.0.4

Selection formulas supported for directory catalogs
In R5.0.4, the Advanced tab of a directory catalog Configuration document includes a new field, "Selection Formula."  
Use this field to enter a selection formula to aggregate only documents defined by the formula. For more information, 
see the Release Note titled "Selection Formula in a Directory Catalog Configuration document."

If you add a selection formula to a directory catalog Configuration document created prior to R5.0.4, the dircat task 
entirely rebuilds the directory catalog the first time it runs on the R5.0.4 server.

Server directory catalogs now support full functionality for R4.6 clients
R4.6 clients can use typeahead and F9 lookups against an R5.0.4 server directory catalog. In addition, an R5.0.4 
server that uses a directory catalog correctly resolves the mail addresses of groups for R4.6 clients. Pre-R5.04 server 
directory catalogs don't completely support these features for R4.6 clients. 

More name formats supported for members of external LDAP directory groups
If you use the group expansion feature in an LDAP Directory Assistance document so that you can use external LDAP 
directory groups in Notes database ACLs, the names of the members of the LDAP directory groups can now be in any 
standard X.500 or LDAP format. Previously, the distinguished names of the group members had to have formats 
similar to  "cn=xxx, ou=xxx, o=xxx" or "uid=xxx, ou=xxx, ou=xxx o=xxx."  Names with formats such as "mail=xxx, l=xxx, o=
xxx" and "cn=xxx, dc=xxx, dc=xxx" are two examples of acceptable name formats for the members of external LDAP 
groups in R5.0.4. 
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Currently, naming rules specified in a Directory Assistance document must still correspond to the Notes naming 
model, however. So to represent in a directory assistance naming rule a distinguished name format that doesn't 
conform to the Notes model, we recommend that you use an all-asterisk rule, even if some name components 
correspond to those used in Notes. 

For example, given names formatted as "mail=xxx, l=atlanta, o=acme," we recommend that you use an all-asterisk 
rule. Although a rule such as the following might also work, you should use such a rule with caution:

OrgUnit4 OrgUnit3 OrgUnit2 OrgUnit1 Organization Country
* acme *

LDAP telephone numbers no longer converted to international format 
In R5.0.4 values for LDAP telephone number attributes in the Domino Directory remain in the format in which you add 
them to the directory. Previously, telephone numbers were normalized to an international format. In R5.0.4 an entry 
with a telephone number will be searched if the search filter specifies either the stored format or the internationalized 
format of the number. For example, if an entry has the telephone number 1 (800) 123-4567, the filter 
"telephoneNumber= 1 (800) 123-4567" and the filter "telephoneNumber=+1 800 123 4567 both search the entry. 

Searches of LDAP "mail" attribute no longer case-sensitive
In R5.0.2 and R5.0.3 only, it was necessary to use the exact case when searching for a specific value for the mail 
attribute. For example, if a mail attribute value for an entry was JDoe@acme.com, then the search filter 
mail=jdoe@acme.com would not return results for that entry. R5.0.4 corrects this problem.

LDAP subtree searches now return the base entry 
R5.0.4 corrects a problem in which the LDAP service didn't return a base entry as part of the results of a subtree 
search. For example, in R5.04 if you do a subtree search that specifies o=acme as the base, the LDAP service now 
returns the entry for o=acme as part of the results. 

Domino LDAP service recognizes changes in group membership
In R5.0.2 and R5.0.3 only, if you changed the members of a group in the Domino Directory, the LDAP service would 
not recognize the change unless you rebuilt a specific view after making the change. R5.0.4 corrects this problem. 

LDAP searches of the Domino Directory using the filter mail=* now work correctly 
Prior to R5.0.4 if you used mail=* as a search filter, the LDAP service included in the results entries that didn't have 
mail attributes defined for them. For example, if you added the object "Printer" without a mail attribute, the mail=* 
search filter nevertheless returned printer entries. This problem is corrected in R5.0.4.  

Directory assistance failover improvement
In R5.0.4 directory assistance failover to an alternate replica of a secondary directory works when server availability 
conditions change after server startup. Prior to R5.0.4, directory assistance failover didn't work consistently because 
directory assistance didn't dynamically update its internal tables of available replicas to reflect changed server 
availability. 

Note that if you use database links to configure failover replicas, and none of the servers referenced by the links for a 
specific domain are available at the time you start up a server that uses the Directory Assistance database, directory 
assistance doesn't have the information it needs to locate a replica for a domain. As a result, if one of these servers 
later becomes available, directory assistance still cannot failover to that server until you restart the directory 
assistance server. When you start up a server, and a server referenced by a database link is unavailable, you see the 
console message: "Could not access Public Address Book on Server xxx, error is Server not responding."

Client

Internet Mail Address field's name tracking improved (R5.0.4)
Changes have been made in R5.0.4 to the way the Internet Mail Address field is administered in Location documents.

Previously, on computers where users with separate IDs and Location documents shared a single physical machine 
and Notes client installation, switching user IDs could cause mail for a specified Internet user to be return-addressed 
for a different Notes Mail user on the same computer. When Person A sent Internet mail from their proper 'Person A' 
location, Person B on the same machine would receive all the replies to that e-mail.

The Notes Dynamic Configurator's automatic update of these user-specific fields has been altered in R5.0.4. When 
switching user IDs, The Notes Dynamic Configurator would sometimes change the "Internet mail address" stored in the 
Location document. With this code change, the Configurator overwrites the address only if the address was previously 
set by the current user.
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Administrator Client, Server

AdminP now supports updates to Private Design Elements (R5.0.5)
Prior to Domino R5.0.5, when a user name expired due to a name change, the user lost access to any private design 
elements (agents, views, and folders) that the user had created. This was true for any database on any server on which 
the user created a private design element. When the old user name expired, the private design elements were not 
updated with the user's new name. This prevented the user from accessing those design elements because those 
elements contained the user's old name.

In Domino R5.0.5, interaction between the administration process (AdminP) and the Notes 5.0.5 client  supports the 
renaming of private design elements due to a user name change. The user's old name is replaced with the new name 
so that the user can access those design elements. The update of the user name in private design elements does 
require limited action by the administrator and the user as explained below.

If the administration server and all clients are running Domino R5.0.5, the administrator can send the user an e-mail 
containing database links for the databases in which the user has private design elements. Opening the databases, via 
the database links in the e-mail, updates the fields with the user's new name. No other action is required. (The agent 
that generates these automatic e-mails is called the "AdminP Mail Notification Agent.")

To enable the AdminP Mail Notification Agent: 

From the Domino Administrator R5.0.5, open admin4.nsf.1.

Open Rename user request. The Administrator Process Log for the request displays.2.

Choose Actions->Enable/Disable User Notification. The following message appears: "Notification is now enabled. 3.
Users will receive e-mail notification about Notes databases in which they created or modified design elements 
such as folders or views."

Click OK.4.

NOTE: If you are using a Domino R5.0.5 server and have at least one R5.0.5 client, you can still use the agent by 
having users open their databases via the 5.0.5 client as described above. If they open and close their databases with 
an R5.0.5 client, you will not have to perform the procedure below for users who do not have R5.0.5 clients.

If all clients are not running Domino R5.0.5, the administrator can do the following:

From the Domino Administrator R5.0.5, open admin4.nsf.1.

Open Rename user request. The Administration Process Log for the request displays. Take note of the information 2.
in these fields:
Old name
New name
Private Agents belonging to this user
Shared Agents belonging to this user
Private Views belonging to this user
Private Folders belonging to this user

Send an e-mail to each user listing each database, with the server name, that contains a private design element 3.
and that needs updating due to a user rename. The user must open the Domino Designer, open the item, and 
then save and close the item. This updates the private design elements.

Client

Changes to file listing in Import/Export dialog box (R5.0.5)
With R5.0.5, the listing of the available choices for Import/Export dialog boxes has changed. The file format options 
are still the same, however, some may appear differently in the list box (for example, the addition or removal of a 
space).

NOTE: These changes may cause some LotusScript commands not to work. If the changed formats are used by 
programs, users should update their LotusScript to reflect the change.
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The altered choices for Import are now:

Lotus Ami Prol

Lotus PICl

Microsoft Excell

Microsoft Wordl

Lotus Word Prol

WordPerfectl

The altered choices in the Export box are now:

Microsoft RTFl

Lotus Ami Prol

Microsoft Wordl

Client

Headlines with Terra (5.0.5)
Along with the ability to create a Welcome Page with AOL My News or My Lycos, starting in Release 5.0.5 you can also 
create a Welcome Page with Terra, which gives you access to Terra's Spanish language news and entertainment 
portal.

To create a Welcome Page with Terra
Click the Welcome task button to bring up your Welcome Page (if you have something other than the Welcome 1.
Page set as your Home Page, open your Favorite Bookmarks folder on the Bookmark bar and click Welcome). 
Note If you do not see the Welcome bookmark in your Favorite Bookmarks folder, choose File->Database->Open, 
select bookmark.nsf and click OK. Then drag the bookmark.nsf task button to your Favorite Bookmarks folder.

Choose "Headlines with Terra" from the Welcome Page list in the upper right corner of the Welcome Page.2.

Click "Configurar" at the right top of the Terra page on the Welcome Page.3.

Follow the instructions Terra provides to personalize your Terra page.4.

Administrator Client, Client, Designer, Server

Product Registration Tool for international customers (R5.0.5)
An international version of the Product Registration Tool (LotusProductRegistration.exe) will begin shipping in the 
R5.0.5 Global English Windows 32-bit client kits. This tool will also ship in the localized Windows 32-bit client kits. 
(This is the product registration screen that appears following a client installation.)  The Product Registration tool was 
disabled in R5.0.4 because R5.0.4 was the first Global English kit to be distributed world wide and the earlier version 
of the registration tool was for North America only.

Bypassing the tool

Because the LotusProductRegistration Tool now includes several files to support localization, it  is no longer stored at  
the root of the Install CD, but is compressed in the .CAB files. Thus, the procedure for bypassing the tool has been 
changed. To bypass the product registration tool, which is normally launched at the completion of install, use the 
"/noreg" switch in the following manner:

setup /noreg

In addition to this change in registration, users that did not use the /noreg switch, will have the option to run or not 
run the registration tool in the last dialog box of the installation.

Additionally, the user can skip the registration process when the registration checkbox on the final install screen 
comes up.
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Administrator Client, Client, Server

Enabling SMTP exceptions to authenticated hosts (R5.0.6)
Typically, when Anonymous SMTP Access is turned off in the server document, Authentication is required. This is 
configured in the server document via  Ports -> Internet Ports -> Mail -> SMTP InBound (Authentication Options: 
Name & Password = Yes AND Anonymous = No). With R5.0.6, a new feature is added, allowing for an exception list of 
hosts and/or IP addresses that are not required to Authenticate when SMTP authentication is required (Anonymous 
SMTP Access is turned off ). This is enabled via a new NOTES.INI parameter, SMTPAllowConnectionsAnonymous=1.  

This Exceptions List is maintained in the Server Configuration document (Router/SMTP -> Restrict. & Controls -> 
SMTP InBound Controls), in the field "Allow connections only from the following SMTP internet hosts/IP addresses".

Because of Microsoft WINS/DNS issues on NT 4.0, it is recommended that you use IP Addresses in the form 
[nnn.nnn.nnn.nnn], instead of host names.

Client, Designer, Server

Changes in preparation for Domino Everyplace (R5.0.6)
The following changes (for future product implementation of Domino Everyplace) have been implemented in Release 
5.0.6.  However these items were inadvertently left out of the 5.0.6 Release Notes.  The changes will not be viewable 
by the user and/or administrator unless the Domino Everyplace product has been installed.  Please check the 
following web site for availability of the Domino Everyplace servers, http://www.lotus.com/home.nsf/welcome/mobile.

New Mobile Services subform in Server Document [Domino Everyplace Access Server]
Allows administrator to configure components (e.g., security, concurrent wireless users) specific to Domino Everyplace 
servers.

New Mobile Services subform in Person Document [Domino Everyplace Access Server]
Allows administrators to configure options (e.g., which handheld devices they use, where their Personal Address Book 
is located) specific to users accessing Domino Everyplace servers.

Designer Client is Now 'Mobile Domino Designer' Aware [Domino Everyplace Enterprise Server]
When the Mobile Domino Designer software is installed, an icon to launch it will now appears on the Notes Designer 
client bookmark bar. Clicking the icon will launch the Mobile Domino Designer. 

Administrator Client, Client, Server

iNotes Access for Microsoft Outlook language selection (R5.0.7)
iNotes Access for Microsoft Outlook now allows Microsoft Outlook users to install localized language files directly from 
the download page.  If "OS language" is selected, the language selected in the Regional Settings of your operating 
system will be installed.  The Regional Settings can be found in the following Windows menu: Start -> Settings -> 
Control Panel -> Regional Settings.  After installing the language files, the user can then proceed with the installation 
of iNotes Access for Microsoft Outlook.

Client, Server

Enabling Ichitaro format in full-text search (R5.0.7)
As of Release 5.0.7, Full Text Search supports attachments in the Ichitaro file format.

To enable Ichitaro attachment document full text search, set the following NOTES.INI variable: ft_use_altfltr=1.

The user must also set two values in the ftaf.ncf file: aftaro6 and aftaro9. (The ftaf.ncf file is in your Notes program 
directory. It is not automatically installed with Notes; the file will not exist unless the user or administrator has 
created it.)

Supported platforms for this feature are: Win32 Intel, Sun Solaris Sparc, AIX, HP-UX, Linux, and OS/2.

Server

New Database.NameLookupCacheMaxSize stat (R5.0.8)
R5.0.8 contains a new stat (Database.NAMELookupCacheMaxSize), which displays the maximum size of the 
NAMELookup cache.
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Server

New feature to prevent replication conflict (R5.0.8)
R5.0.8 contains a feature intended to handle the general case of not creating a replication conflict. If any note has a 
$ConflictAction item with a value of "2" in it, the replicator now will NOT create a conflict document. This mechanism 
is now also being used for profile notes and extended ACL notes. Use the NSFItemAppend API to add a field of 
TYPE_TEXT to the note.  The value should be "2".

Server

New Mail Server Notes.ini parameter (R5.0.8)
R5.0.8 includes a new Notes.ini parameter (MTCDailyTasksHour). This allows administrators to control the time when 
the message tracking store is compacted daily.  The default value is 2AM.

Server

Added support for the Japanese code (R5.0.8)
R5.0.8 includes support for the Japanese code pages 943 and 5039.

Administrator Client, Server

Alias dereferencing for LDAP directory assistance (R5.0.9)
An alias entry in an LDAP directory is an entry that points to another entry. Following an alias pointer is known as 
dereferencing an alias. In R5.0.9, there is a new field in Directory Assistance documents for LDAP directories called 
"Dereference Alias on search." This field has the following options that control searching of aliases in an LDAP 
directory.

Option Description
Never Never dereference alias entries. Choose this option to 

improve search performance if there are no alias 
entries in the directory that require dereferencing. 

InSearching Dereference alias entries subordinate to a specified 
search base, but do not dereference an alias search 
base entry. 

FindingBase Deference an alias entry for a specified search base, 
but do not dereference alias entries subordinate to the 
search base. 

Always Always dereference aliases. This selection is the 
default, and the behavior prior to R5.0.9. 
Note: the field popup help incorrectly states that the 
default selection is Never.

Note that dereferencing aliases by choosing InSearching, FindingBase, or Always can result in poor search 
performance with some LDAP directories. 

Examples
Suppose:
A)   an LDAP directory has the following entries:

o=Acme1
o=Acme2 (alias entry that points to o=Acme1)
cn=John Doe, o=Acme1
cn=John Doe, o=Acme2 (alias entry that points to cn=John Doe, o=Acme1)

B) Directory assistance has to process a subtree search with the base o=Acme2 (a search of o=Acme2 and its 
subordinate entries).
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Given A) and B), the following table describes the search results each " Dereference Alias on search" option returns.
Option selected Entries returned
Never o=Acme2

cn=John Doe, o=Acme2
InSearching o=Acme2

cn=John Doe, o=Acme1
FindingBase o=Acme1

cn=John Doe, o=Acme2
Always o=Acme1

cn=John Doe, o=Acme1

Administrator Client

DB2 connector version upgraded to 2.0 (R5.0.9)
In R5.0.9 the Lotus Connector for DB2 version 2.0 has been added to the core build for use with DECS and LC LSX.  
Previous versions contained version 1.0 of the Lotus Connector for DB2; this version of the connector worked only with 
DB2 5.2. The 2.0 version of the connector supports DB2 6.x and 7.1.

Designer

Fixed @ReplaceSubstring function (R5.0.9)
In R5.0.9, the behavior of the @ReplaceSubstring was changed, to prevent crashes caused by large 
@ReplaceSubstring formulas and by recursive calls.  The following example shows the change in behavior for 
@ReplaceSubstring("nnnn";"nn";"12345")

Source String

"nnnn"

Old substring

"nn"

New substring

"12345"

The old behavior (using a character by character scan) would result in "123451234512345" where "nn" is found and 
replaced three times.  The new behavior will find the next match after the first match, resulting in "1234512345" which 
"nn" is found and replaced twice.

Server

New directory naming scheme for UNIX installs (R5.0.9)
Starting with the R5.0.9 release, the directory naming scheme for UNIX installs will change from four digits (i.e., 
5080) to five digits (50090).  This is being done to provide for future expansion in our Maintenance Releases (such as 
5.0.10).
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Administrator Client, Client

The To field in user certificate renewal requests (R5.0.9)
In releases of Notes prior to R5.0.9, users often did not know how to address requests for certificate renewal.  When a 
user's Notes certificate is due to expire, the user is prompted to request a new certificate from File -> Tools -> User ID 
-> Certificates -> Request Certificate.  This option presents the user with a Mail Certificate Request, in which the 
subject field is completed but the To field is not. As a result, users have to go through the time-consuming and often 
frustrating process of determining the correct e-mail address to which to send the request. 

Beginning in R5.0.9, Notes will use the following process to determine the mail address for the user's certifier.  First, 
it extracts the certifier name from the user name. Notes then does a name lookup for that certifier. If it finds an entry, 
it will check the certifier's MailAddress field first, and then the LocalAdmin field, for an address or name to which to 
send the certificate request. If neither of those two are present, it looks for the person record in the Domino Directory 
and looks in the LocalAdmin group for any matches for that user. If none are present, then the field remains blank.  
Note: If a user attempts to create a certificate request while in disconnected mode, the To field will remain blank, as 
Notes will be unable to do a name lookup on the server. 

In order for the name lookup process to work, there needs to be a designated destination for certificate requests. It is 
strongly recommended that administrators should designate mail addresses, or mail-in databases, for handling 
certification requests. In addition, all certifier documents in the Domino Directory should be updated with that 
information.

Administrator Client, Server

Bi-di text wrapping measured at document loading (R5.0.10)
R5.0.10 added the optional Notes.ini setting, "OptimizeBiDiWraping", for bidirectional text to be measured at 
document loading time without calls to the Windows API GetCharacterPlacement.  This fix is enabled when 
OptimizeBiDiWraping is set to 1 (OptimizeBiDiWraping=1"). Otherwise, Arabic and Hebrew documents that are created 
with multilingual fonts may appear to open slower on Win 95 and 98 machines.

Administrator Client, Client, Designer, Server

Improvements in the Release Notes (R5.0.10)
The R5.0.10 contains some changes that reduce their size, and streamline them, making them easier to use.

Fix Lists removed - Previously, the Release Notes had contained all the R5 Fix Lists, through R5.0.5. After R5.0.5 ll
(in December 2000) we started publishing the Fix Lists on the Lotus Developer Domain (LDD).  Since all R5 Fix 
Lists are available on LDD, they have been removed from these Release Notes, reducing their size. For more 
information about Fix Lists and their availability, see the Release Notes "R5 Web Fix Lists on Lotus Developer 
Domain" and "Enhancement reporting - SPR Fix Lists." 

Details of New Features documents moved into History of Changes - The Release Notes for every Maintenance ll
Release contains a "New features and enhancements for R5.0..x" for that release. This is a summary of any new 
features in that Maintenance Release. Details of those new features are all listed in Release Notes below it in the 
same section (Chapter 1, "What's new?", "New features"). With the following Maintenance Release, the "New 
features" document is moved into the "History of Changes" chapter; any supporting documents are moved into 
same chapter, in a "Details of new features" section. This gives you a chance to see details of all new features in 
the R5 code stream. See the Release Note "Overview - new features and enhancements" for more details.

Fixed SPR-related Release Notes deleted - In Release Notes prior to R5.0.10, SPR-related Release Notes ll
containing issues that had been fixed remained in the Release Notes, as a matter of record. (Customers could 
look track the history of fixes through the code stream, and see when the issues were fixed.) As this information is 
available on the Fix Lists, we felt that there was no need to carry it forward through all future Release Notes once 
fixed.
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Administrator Client, Server

Increased default size of listen queue in DIIOP task (R5.0.10)
The default size of the listen queue at the transport layer of the DIIOP task has been increased in R5.0.10 to 5. Under 
heavy use, the DIIOP task may fail to respond to connect requests. To increase the size of the listen queue at the 
transport layer, set the Notes.ini value ORB_LISTEN_QLEN to a larger value. 

Administrator Client, Server

New C API function returns runtime version of Domino (R5.0.10)
R5.0.10 includes a new C API function -- NSFDbGetMajMinVersion -- which will return the version of Notes/Domino on 
a machine at runtime.  This is different from NSFDbGetBuildVersion in that it will allow the API developer more 
granularity (as 5.07 can be distinguished from 5.07a, for example).

Administrator Client, Server

New Notes.ini variable for maximum folder pool size (5.0.10)
This fix allows the maximum folder pool size to be customized via a Notes.ini parameter.  In cases where the error 
"Insufficient memory NSF Folder Pool is full" appears, administrators will be able to specify a value (in Megabytes) to 
set it to.  Note that the current pool limit is 20MB.  The Notes.ini parameter is NSF_FOLDER_POOL_SIZE_MB.

Administrator Client, Server

Notes.ini filters statistic facilities from reports (R5.0.10)
R5.0.10 fixes an event problem in which part of a message was missing from the beginning of the event.  A new 
capability was added, allowing the user to filter out statistic facilities from stat reports. Use the Notes.ini parameter:  
COLLECT_FACILITY_FILTER='Facility'.

Administrator Client, Server

Notes.ini permits storing of failed Domain lookups (R5.0.10)
A new Notes.ini parameter in R5.0.10 implements the storing of names of failed Domain lookups in the router cache. 
You can set the specified time by setting the parameter, MailDomainNoHitCacheTimeToLive=seconds.

Administrator Client, Server

Notes.ini variable allows cluster quota overrides (R5.0.10)
In R5.0.10, the new Notes.ini variable CLREPL_OVERRIDE_QUOTAS=1 allows the cluster replicator to override 
database quotas when synchronizing databases. This Notes.ini variable should be set on all cluster members.

Administrator Client, Server

POP 3 servers and corrupted messages (R5.0.10)
A new Notes.ini variable fixes a problem where the POP3 server would stop downloading new messages when it 
encountered a corrupt message that it could not export.  The corrupt message will be deleted like other downloaded 
messages unless the Notes.ini parameter POP3_SAVE_CORRUPTED=1 is specified.

Administrator Client, Client, Server

Updated message for conflicting Calendar entries (R5.0.10)
Updated the message which appears after selecting "Enable for non-office hours based on free time settings" from the 
User Preferences dialog box to:  "This entry conflicts with an existing entry or your free time preferences. Create 
anyway?".
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Administrator Client, Client, Designer, Server

Java GB18030 Font Support (R5.0.11)
Support for display of GB18030 glyphs has been added to Java for the zh locale.  The 1.1.8 JRE in use by 
Notes/Domino does not itself support GB18030 natively, but if you have the GB18030 OS support installed on 
Windows 2000 or Windows XP (i.e., the Simsun-18030.ttc font),  and your Java agents and applets use GB18030 
Unicode glyphs, you will see the proper symbols.

We've also provided the older font.properties.zh file for use if you don't have the OS-level GB18030 font support 
installed.  In some very rare circumstances involving server agents that have GUI's or use of the JRE in Notes/Domino 
by an external app, you may see messages like "Font xxx specified in font.properties was not found".  These messages 
are benign and can be safely ignored, but if you want to get rid of them, just replace the 
[notesbin]\jvm\lib\font.properties.zh file with one named font.properties.zh.non_gb18030.

Administrator Client, Designer, Server

New APIs - SECVerifyPassword and SECHashPassword (R5.0.11)
The new API functions SECVerifyPassword and SECHashPassword have been added to support the "More Secure 
Internet Password" format for storing Internet Passwords in the Domino Directory.
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